How to Contact MathWorks

Latest news: www.mathworks.com
Sales and services: www.mathworks.com/sales_and_services
User community: www.mathworks.com/matlabcentral
Technical support: www.mathworks.com/support/contact_us

Phone: 508-647-7000

The MathWorks, Inc.
3 Apple Hill Drive
Natick, MA 01760-2098

Stateflow® User’s Guide


The software described in this document is furnished under a license agreement. The software may be used or copied only under the terms of the license agreement. No part of this manual may be photocopied or reproduced in any form without prior written consent from The MathWorks, Inc.

FEDERAL ACQUISITION: This provision applies to all acquisitions of the Program and Documentation by, for, or through the federal government of the United States. By accepting delivery of the Program or Documentation, the government hereby agrees that this software or documentation qualifies as commercial computer software or commercial computer software documentation as such terms are used or defined in FAR 12.212, DFARS Part 227.72, and DFARS 252.227-7014. Accordingly, the terms and conditions of this Agreement and only those rights specified in this Agreement, shall pertain to and govern the use, modification, reproduction, release, performance, display, and disclosure of the Program and Documentation by the federal government (or other entity acquiring for or through the federal government) and shall supersede any conflicting contractual terms or conditions. If this License fails to meet the government’s needs or is inconsistent in any respect with federal procurement law, the government agrees to return the Program and Documentation, unused, to The MathWorks, Inc.

Trademarks

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. See www.mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may be trademarks or registered trademarks of their respective holders.

Patents

MathWorks products are protected by one or more U.S. patents. Please see www.mathworks.com/patents for more information.
## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Event</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>May 1997</td>
<td>First printing</td>
<td>New</td>
</tr>
<tr>
<td>January 1999</td>
<td>Second printing</td>
<td>Revised for Version 2.0 (Release 11)</td>
</tr>
<tr>
<td>September 2000</td>
<td>Third printing</td>
<td>Revised for Version 4.0 (Release 12)</td>
</tr>
<tr>
<td>June 2001</td>
<td>Fourth printing</td>
<td>Revised for Version 4.1 (Release 12.1)</td>
</tr>
<tr>
<td>July 2002</td>
<td>Fifth printing</td>
<td>Revised for Version 5.0 (Release 13)</td>
</tr>
<tr>
<td>January 2003</td>
<td>Online only</td>
<td>Revised for Version 5.1 (Release 13SP1)</td>
</tr>
<tr>
<td>June 2004</td>
<td>Online only</td>
<td>Revised for Version 6.0 (Release 14)</td>
</tr>
<tr>
<td>October 2004</td>
<td>Online only</td>
<td>Revised for Version 6.1 (Release 14SP1)</td>
</tr>
<tr>
<td>March 2005</td>
<td>Online only</td>
<td>Revised for Version 6.21 (Release 14SP2)</td>
</tr>
<tr>
<td>September 2005</td>
<td>Online only</td>
<td>Revised for Version 6.3 (Release 14SP3)</td>
</tr>
<tr>
<td>March 2006</td>
<td>Online only</td>
<td>Revised for Version 6.4 (Release 2006a)</td>
</tr>
<tr>
<td>September 2006</td>
<td>Online only</td>
<td>Revised for Version 6.5 (Release 2006b)</td>
</tr>
<tr>
<td>March 2007</td>
<td>Online only</td>
<td>Revised for Version 6.6 (Release 2007a)</td>
</tr>
<tr>
<td>September 2007</td>
<td>Online only</td>
<td>Revised for Version 7.0 (Release 2007b)</td>
</tr>
<tr>
<td>March 2008</td>
<td>Online only</td>
<td>Revised for Version 7.1 (Release 2008a)</td>
</tr>
<tr>
<td>October 2008</td>
<td>Online only</td>
<td>Revised for Version 7.2 (Release 2008b)</td>
</tr>
<tr>
<td>March 2009</td>
<td>Online only</td>
<td>Revised for Version 7.3 (Release 2009a)</td>
</tr>
<tr>
<td>September 2009</td>
<td>Online only</td>
<td>Revised for Version 7.4 (Release 2009b)</td>
</tr>
<tr>
<td>March 2010</td>
<td>Online only</td>
<td>Revised for Version 7.5 (Release 2010a)</td>
</tr>
<tr>
<td>September 2010</td>
<td>Online only</td>
<td>Revised for Version 7.6 (Release 2010b)</td>
</tr>
<tr>
<td>April 2011</td>
<td>Online only</td>
<td>Revised for Version 7.7 (Release 2011a)</td>
</tr>
<tr>
<td>September 2011</td>
<td>Online only</td>
<td>Revised for Version 7.8 (Release 2011b)</td>
</tr>
<tr>
<td>March 2012</td>
<td>Online only</td>
<td>Revised for Version 7.9 (Release 2012a)</td>
</tr>
<tr>
<td>September 2012</td>
<td>Online only</td>
<td>Revised for Version 8.0 (Release 2012b)</td>
</tr>
<tr>
<td>March 2013</td>
<td>Online only</td>
<td>Revised for Version 8.1 (Release 2013a)</td>
</tr>
<tr>
<td>September 2013</td>
<td>Online only</td>
<td>Revised for Version 8.2 (Release 2013b)</td>
</tr>
<tr>
<td>March 2014</td>
<td>Online only</td>
<td>Revised for Version 8.3 (Release 2014a)</td>
</tr>
<tr>
<td>October 2014</td>
<td>Online only</td>
<td>Revised for Version 8.4 (Release 2014b)</td>
</tr>
<tr>
<td>March 2015</td>
<td>Online only</td>
<td>Revised for Version 8.5 (Release 2015a)</td>
</tr>
<tr>
<td>September 2015</td>
<td>Online only</td>
<td>Revised for Version 8.6 (Release 2015b)</td>
</tr>
<tr>
<td>October 2015</td>
<td>Online only</td>
<td>Rereleased for Version 8.5.1 (Release 2015aSP1)</td>
</tr>
<tr>
<td>March 2016</td>
<td>Online only</td>
<td>Revised for Version 8.7 (Release 2016a)</td>
</tr>
<tr>
<td>September 2016</td>
<td>Online only</td>
<td>Revised for Version 8.8 (Release 2016b)</td>
</tr>
<tr>
<td>March 2017</td>
<td>Online only</td>
<td>Revised for Version 8.9 (Release 2017a)</td>
</tr>
<tr>
<td>September 2017</td>
<td>Online only</td>
<td>Revised for Version 9.0 (Release 2017b)</td>
</tr>
<tr>
<td>March 2018</td>
<td>Online only</td>
<td>Revised for Version 9.1 (Release 2018a)</td>
</tr>
</tbody>
</table>
# Stateflow Chart Concepts

## Finite State Machine Concepts

- What Is a Finite State Machine? .................................................. 1-2
- Finite State Machine Representations ......................................... 1-2
- Stateflow Chart Representations ............................................... 1-2
- Notation .................................................................................. 1-3
- Semantics ................................................................................ 1-3

## Stateflow Charts and Simulink Models

- The Simulink Model and the Stateflow Machine ......................... 1-4
- Overview of Defining Stateflow Block Interfaces to Simulink Models ........................................... 1-4

## Stateflow Chart Objects .......................................................... 1-6

## Stateflow Hierarchy of Objects ................................................. 1-7

## Bibliography ........................................................................... 1-9

# Stateflow Chart Notation

## Overview of Stateflow Objects ................................................. 2-2

- Graphical Objects .................................................................. 2-2
- Nongraphical Objects ............................................................ 2-3

## Rules for Naming Stateflow Objects ...................................... 2-4

- Characters You Can Use ......................................................... 2-4
- Restriction on Name Length ..................................................... 2-4
- Keywords to Avoid When Naming Chart Objects ..................... 2-4
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>States</td>
<td>2-7</td>
</tr>
<tr>
<td>What Is a State?</td>
<td>2-7</td>
</tr>
<tr>
<td>State Hierarchy</td>
<td>2-7</td>
</tr>
<tr>
<td>State Decomposition</td>
<td>2-9</td>
</tr>
<tr>
<td>State Labels</td>
<td>2-10</td>
</tr>
<tr>
<td>State Hierarchy</td>
<td>2-15</td>
</tr>
<tr>
<td>State Hierarchy Example</td>
<td>2-15</td>
</tr>
<tr>
<td>Objects That a State Can Contain</td>
<td>2-16</td>
</tr>
<tr>
<td>State Decomposition</td>
<td>2-17</td>
</tr>
<tr>
<td>Exclusive (OR) State Decomposition</td>
<td>2-17</td>
</tr>
<tr>
<td>Parallel (AND) State Decomposition</td>
<td>2-17</td>
</tr>
<tr>
<td>Transitions</td>
<td>2-19</td>
</tr>
<tr>
<td>What Is a Transition?</td>
<td>2-19</td>
</tr>
<tr>
<td>Transition Hierarchy</td>
<td>2-20</td>
</tr>
<tr>
<td>Transition Label Notation</td>
<td>2-21</td>
</tr>
<tr>
<td>Valid Transitions</td>
<td>2-23</td>
</tr>
<tr>
<td>Transition Connections</td>
<td>2-25</td>
</tr>
<tr>
<td>Transitions to and from Exclusive (OR) States</td>
<td>2-25</td>
</tr>
<tr>
<td>Transitions to and from Junctions</td>
<td>2-25</td>
</tr>
<tr>
<td>Transitions to and from Exclusive (OR) Superstates</td>
<td>2-26</td>
</tr>
<tr>
<td>Transitions to and from Substates</td>
<td>2-27</td>
</tr>
<tr>
<td>Self-Loop Transitions</td>
<td>2-29</td>
</tr>
<tr>
<td>Inner Transitions</td>
<td>2-31</td>
</tr>
<tr>
<td>Before Using an Inner Transition</td>
<td>2-31</td>
</tr>
<tr>
<td>After Using an Inner Transition to a Connective Junction</td>
<td>2-32</td>
</tr>
<tr>
<td>Using an Inner Transition to a History Junction</td>
<td>2-33</td>
</tr>
<tr>
<td>Default Transitions</td>
<td>2-35</td>
</tr>
<tr>
<td>What Is a Default Transition?</td>
<td>2-35</td>
</tr>
<tr>
<td>Drawing Default Transitions</td>
<td>2-35</td>
</tr>
<tr>
<td>Label Default Transitions</td>
<td>2-35</td>
</tr>
<tr>
<td>Default Transition Examples</td>
<td>2-36</td>
</tr>
<tr>
<td>Connective Junctions</td>
<td>2-39</td>
</tr>
<tr>
<td>What Is a Connective Junction?</td>
<td>2-39</td>
</tr>
<tr>
<td>Flow Chart Notation with Connective Junctions</td>
<td>2-39</td>
</tr>
<tr>
<td>Change Connective Junction Size</td>
<td>2-44</td>
</tr>
</tbody>
</table>
Use history junctions to record state history
Do not use history junctions in states with parallel (AND) decomposition
Use explicit ordering to control the execution order of parallel (AND) states

Modeling Rules That Stateflow Detects During Edit Time
Object contains a syntax error
Dangling transitions
Unreachable state
Transition shadowing
Invalid default transition path
Unconditional path out of state with during actions or child states
Graphical function contains a state
Default transition is missing
No unconditional default transitions
Unexpected backtracking
Transition loops outside natural parent
Transition action precedes a condition action along this path
Transition crosses, ends or begins in a parallel state
Monitoring leaf or child state activity of parallel states
Invalid transitions crossing into graphical function
Invalid transitions crossing out of graphical function

Types of Chart Execution
Lifecycle of a Stateflow Chart
Execution of an Inactive Chart
Execution of an Active Chart
Execution of a Chart at Initialization

Execution of a Stateflow Chart
Workflow for Stateflow Chart Execution
During Actions
Outgoing Transition
Inner Transitions
Chart Execution with a Valid Transition
Chart Execution Without a Valid Transition

Enter a Chart or State
Workflow for Entering a Chart or State
Chart Entry
State Entry
Entry Actions ........................................... 3-54
Enter a Stateflow Chart ................................. 3-54
Entering a State by Using History Junctions .......... 3-56
Entering a State by Using Supertransitions .......... 3-58

Exit a State ........................................... 3-60
Workflow for Exiting a State ............................ 3-60
Exit Actions ............................................ 3-61
Exit a State Example .................................... 3-62
Exit a State by Using Supertransitions ................ 3-63

Evaluate Transitions .................................. 3-65
Workflow for Evaluating Transitions .................. 3-66
Transition Evaluation Order ............................ 3-67
Outgoing Transition Example ........................... 3-68
Outgoing Transition Example with Backtracking ...... 3-69
Condition and Transition Actions ...................... 3-72

Super Step Semantics ................................ 3-75
Maximum Number of Iterations ......................... 3-75
Enable Super Step Semantics ............................ 3-75
Super Step Example ..................................... 3-77
How Super Step Semantics Works with Multiple Input Events ................................................. 3-79
Detection of Infinite Loops in Transition Cycles .... 3-81

How Events Drive Chart Execution ..................... 3-83
How Stateflow Charts Respond to Events ............... 3-83
Sources for Stateflow Events ........................... 3-83
How Charts Process Events ............................... 3-84

Process for Grouping and Executing Transitions .......... 3-86
Transition Flow Chart Types ............................ 3-86
Order of Execution for a Set of Flow Charts .......... 3-87

Execution Order for Parallel States ...................... 3-89
Ordering for Parallel States ............................ 3-89
Explicit Ordering of Parallel States .................... 3-90
Implicit Ordering of Parallel States .................... 3-91
Order Maintenance for Parallel States .................. 3-92
Execution Priorities in Restored States ................. 3-94
Switching Between Explicit and Implicit Ordering .... 3-95
Execution Order of Parallel States in Boxes and Subcharts ... 3-95
Early Return Logic for Event Broadcasts ................................................. 3-97
Guidelines for Proper Chart Behavior ................................................. 3-97
How Early Return Logic Works ...................................................... 3-97
Example of Early Return Logic ...................................................... 3-98

Create Stateflow Charts

4

Basic Approach for Modeling Event-Driven Systems .................. 4-2
Identify System Attributes .......................................................... 4-2
Select a State Machine Type ........................................................ 4-2
Specify State Actions and Transition Conditions ...................... 4-3
Define Persistent Data to Store State Variables ......................... 4-3
Simplify State Actions and Transition Conditions with Function
Calls .......................................................................................... 4-4
Check That Your System Representation Is Complete .............. 4-4

Represent Operating Modes Using States ................................. 4-6
Create a State ............................................................................. 4-6
Move and Resize States ............................................................... 4-7
Create Substates and Superstates ........................................... 4-7
Group States .............................................................................. 4-7
Specify Substate Decomposition .............................................. 4-9
Specify Activation Order for Parallel States ....................... 4-10
Change State Properties ............................................................. 4-10
Label States .................................................................................. 4-16

Transition Between Operating Modes ....................................... 4-19
Create a Transition ................................................................. 4-19
Label Transitions ................................................................. 4-20
Move Transitions ................................................................. 4-21
Change Transition Arrowhead Size ....................................... 4-22
Create Self-Loop Transitions .................................................. 4-23
Create Default Transitions ..................................................... 4-23
Change Transition Properties .................................................. 4-23

Stateflow Editor Operations ....................................................... 4-27
Stateflow Editor ................................................................. 4-27
Undo and Redo Editor Operations .......................................... 4-31
Specify Colors and Fonts in a Chart ..................................... 4-32
# Model Logic Patterns and Iterative Loops Using Flow Charts

## Flow Charts in Stateflow
- Draw a Flow Chart ................................ 5-2
- Best Practices for Creating Flow Charts .......... 5-3

## Create Flow Charts with the Pattern Wizard
- Why Use the Pattern Wizard? ........................ 5-6
- How to Create Reusable Flow Charts ............... 5-6
- Insert a Logic Pattern Using the Pattern Wizard .. 5-8
- Save and Reuse Flow Chart Patterns ................. 5-10
- MAAB-Compliant Patterns from the Pattern Wizard . 5-13
- Create and Reuse a Custom Pattern with the Pattern Wizard ........................................ 5-22

# Simulink Subsystems as Stateflow States

## Simulink Subsystems as States
- When to Use Simulink Based States ................ 6-2
- Model a Pole Vaulter by Using Simulink Based States .. 6-3

## Create and Edit Simulink Based States
- Create a Simulink Based State ...................... 6-11
- Create Inports and Outports ....................... 6-16
## Access Block State Data
- Textual Access ........................................ 6-22
- Graphical Access ...................................... 6-24

## Map Variables for Simulink Based States
- Map Variables in a Simulink Based State ............ 6-28

## Set Simulink Based State Properties ................. 6-31

## Limitations ............................................ 6-33

## Build Mealy and Moore Charts

### Overview of Mealy and Moore Machines
- Semantics of Mealy and Moore Machines ............. 7-2
- Model with Mealy and Moore Machines ............... 7-3
- Default State Machine Type .......................... 7-3
- Availability of Output ................................ 7-3
- Advantages of Mealy and Moore Charts .............. 7-3

### Create Mealy and Moore Charts ...................... 7-5

### Model a Vending Machine Using Mealy Semantics
- Open the Model ........................................ 7-6
- Logic of the Mealy Vending Machine .................. 7-6
- Design Rules in Mealy Vending Machine .............. 7-7

### Design Considerations for Mealy Charts .......... 7-8
- Mealy Semantics ........................................ 7-8
- Design Rules for Mealy Charts ....................... 7-8

### Design Considerations for Moore Charts .......... 7-11
- Moore Semantics ........................................ 7-11
- Design Rules for Moore Charts ....................... 7-11

### Model a Traffic Light Using Moore Semantics ..... 7-16
- Open the Model ........................................ 7-16
- Logic of the Moore Traffic Light ..................... 7-16
- Design Rules in Moore Traffic Light ................. 7-18
Effect of Changing the Chart Type ........................................ 7-19

Debug Mealy and Moore Charts .................................. 7-20

Techniques for Streamlining Chart Design

Record State Activity Using History Junctions ............. 8-2
  What Is a History Junction? .................................. 8-2
  Create a History Junction .................................. 8-2
  Change History Junction Size ................................ 8-3
  Change History Junction Properties .................... 8-3

Encapsulate Modal Logic Using Subcharts .................. 8-5
  What Is a Subchart? ........................................ 8-5
  Create a Subchart ........................................ 8-6
  Rules of Subchart Conversion ................................ 8-6
  Convert a State to a Subchart ............................... 8-6
  Manipulate Subcharts as Objects ......................... 8-7
  Open a Subchart .......................................... 8-8
  Edit a Subchart .......................................... 8-8
  Navigate Subcharts ....................................... 8-8

Move Between Levels of Hierarchy Using Supertransitions . 8-10
  What Is a Supertransition? ................................. 8-10
  Draw a Supertransition Into a Subchart ................. 8-13
  Draw a Supertransition Out of a Subchart ............. 8-15
  Label Supertransitions ................................... 8-17

Define a Graphical Function ................................. 8-18
  Create a Graphical Function .............................. 8-18
  Program a Graphical Function ............................ 8-19
  Define Graphical Function Data ............................ 8-19

Manage Large Graphical Functions .......................... 8-22

Call Graphical Functions in States and Transitions ........ 8-23
  Syntax ...................................................... 8-23
  Example ................................................... 8-23
Specify Graphical Function Properties .................. 8-24

Reuse Logic Patterns Using Graphical Functions .......... 8-26
  What Is a Graphical Function? ....................... 8-26
  Why Use a Graphical Function in a Stateflow Chart? .... 8-26
  Where to Use a Graphical Function ................... 8-26
  Limitations Using Events in Graphical Functions ...... 8-27

Export Stateflow Functions for Reuse .................... 8-28
  Why Export Chart-Level Functions? ................... 8-28
  How to Export Chart-Level Functions ................ 8-28
  Rules for Exporting Chart-Level Functions .............. 8-29
  Export Chart-Level Functions ......................... 8-29

Group Chart Objects Using Boxes ......................... 8-35
  When to Use Boxes .................................. 8-35
  Semantics of Stateflow Boxes .......................... 8-35
  Rules for Using Boxes ............................... 8-36
  Draw and Edit a Box ................................ 8-36
  Examples of Using Boxes .............................. 8-38

Reuse Functions with an Atomic Box ....................... 8-41
  What Is an Atomic Box? ................................ 8-41
  Rationale for Using an Atomic Box .................... 8-41
  How to Reuse Functions with an Atomic Box ............. 8-41
  Example of Reusing a Timer Function Multiple Times .... 8-42

Add Descriptive Comments in a Chart ..................... 8-47
  Create Notes ........................................ 8-47
  Change Note Properties ............................. 8-47
  Change Note Font and Color ........................... 8-47
  TeX Instructions .................................... 8-48

Define Data

Add Stateflow Data ........................................ 9-2
  Add Data by Using the Stateflow Editor Menu .......... 9-2
  Add Data Through the Symbols Window .................. 9-3
  Add Data Through the Model Explorer .................. 9-3
Detect Unused Data in the Symbols Window ................................. 9-5

Set Data Properties ........................................................................ 9-7
Stateflow Data Properties ............................................................. 9-7
Set Properties in the Logging Section ........................................... 9-21
Set Properties in the Description Pane .......................................... 9-22
Enter Expressions and Parameters for Data Properties .............. 9-23

Share Data with Simulink and MATLAB Workspace ................. 9-26
Share Input Data with Simulink ................................................... 9-26
Share Output Data with Simulink ................................................. 9-26
Share Simulink Parameters with Charts ....................................... 9-27
Initialize Data from the MATLAB Base Workspace ................. 9-28
Save Data to the MATLAB Workspace ........................................ 9-29

About Data Stores ........................................................................ 9-30

Configure Charts to Use Data Stores ......................................... 9-31

Access Data Store Memory from a Chart ...................................... 9-32
Bind a Stateflow Data Object to Data Store Memory .................. 9-32
Use the Stateflow Editor to Bind a Data Object ......................... 9-32
Use the Model Explorer to Bind a Data Object ......................... 9-33
Resolve Data Store Bindings ....................................................... 9-33
Read and Write Global Data Programmatically .......................... 9-33

Chart and Block Data Diagnostics ............................................... 9-35
Errors to Check For ..................................................................... 9-35
When to Enable Diagnostics ....................................................... 9-35
When to Disable Diagnostics ....................................................... 9-35
How to Set Diagnostics for Shared Data ..................................... 9-36

Create a Global Data Store Across Multiple Models .................. 9-37

Best Practices for Using Data Stores ........................................... 9-38
When Binding to Data Stores in Charts ....................................... 9-38
When Enforcing Writes Before Reads in Unconnected Blocks ........ 9-38

Use Data Types in Stateflow ........................................................ 9-39
What Is Data Type? ..................................................................... 9-39
Specify Data Type with the Property Inspector .......................... 9-39
Specify Data Type with the Data Type Assistant ....................... 9-39
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built-In Data Types</td>
<td>9-42</td>
</tr>
<tr>
<td>Inherit Data Types from Simulink Objects</td>
<td>9-43</td>
</tr>
<tr>
<td>Derive Data Types from Previously Defined Data</td>
<td>9-44</td>
</tr>
<tr>
<td>Type Data by Using an Alias</td>
<td>9-45</td>
</tr>
<tr>
<td>Strong Data Typing with Simulink I/O</td>
<td>9-45</td>
</tr>
<tr>
<td><strong>Size Stateflow Data</strong></td>
<td>9-47</td>
</tr>
<tr>
<td>Methods for Sizing Stateflow Data</td>
<td>9-47</td>
</tr>
<tr>
<td>How to Specify Data Size</td>
<td>9-48</td>
</tr>
<tr>
<td>Inherit Input or Output Size from Simulink Signals</td>
<td>9-48</td>
</tr>
<tr>
<td>Guidelines for Sizing Data with Numeric Values</td>
<td>9-48</td>
</tr>
<tr>
<td>Guidelines for Sizing Data with MATLAB Expressions</td>
<td>9-49</td>
</tr>
<tr>
<td>Examples of Valid Data Size Expressions</td>
<td>9-50</td>
</tr>
<tr>
<td>Name Conflict Resolution for Variables in Size Expressions</td>
<td>9-50</td>
</tr>
<tr>
<td>Best Practices for Sizing Stateflow Data</td>
<td>9-50</td>
</tr>
<tr>
<td><strong>Handle Integer Overflow for Chart Data</strong></td>
<td>9-52</td>
</tr>
<tr>
<td>When Integer Overflow Can Occur</td>
<td>9-52</td>
</tr>
<tr>
<td>Support for Handling Integer Overflow in Charts</td>
<td>9-52</td>
</tr>
<tr>
<td>Effect of Integer Promotion Rules on Saturation</td>
<td>9-54</td>
</tr>
<tr>
<td>Impact of Saturation on Error Checks</td>
<td>9-55</td>
</tr>
<tr>
<td><strong>Define Temporary Data</strong></td>
<td>9-56</td>
</tr>
<tr>
<td>When to Define Temporary Data</td>
<td>9-56</td>
</tr>
<tr>
<td>How to Define Temporary Data</td>
<td>9-56</td>
</tr>
<tr>
<td><strong>Identify Data Using Dot Notation</strong></td>
<td>9-57</td>
</tr>
<tr>
<td>What Is Dot Notation?</td>
<td>9-57</td>
</tr>
<tr>
<td>Resolution of Qualified Data Names with Dot Notation</td>
<td>9-57</td>
</tr>
<tr>
<td>Best Practices for Using Dot Notation in Qualified Data Names</td>
<td>9-59</td>
</tr>
<tr>
<td><strong>Resolve Data Properties from Simulink Signal Objects</strong></td>
<td>9-62</td>
</tr>
<tr>
<td>About Explicit Signal Resolution</td>
<td>9-62</td>
</tr>
<tr>
<td>Inherited Properties</td>
<td>9-62</td>
</tr>
<tr>
<td>Enable Signal Resolution</td>
<td>9-63</td>
</tr>
<tr>
<td>A Simple Example</td>
<td>9-63</td>
</tr>
<tr>
<td><strong>Best Practices for Using Data in Charts</strong></td>
<td>9-66</td>
</tr>
<tr>
<td>Avoid inheriting output data properties from Simulink blocks</td>
<td>9-66</td>
</tr>
<tr>
<td>Restrict use of machine-parented data</td>
<td>9-66</td>
</tr>
</tbody>
</table>
Transfer Data Across Models ........................................ 9-68
Copy Data Objects ...................................................... 9-68
Move Data Objects ...................................................... 9-68

Define Events

How Events Work in Stateflow Charts ............................ 10-2
  What Is an Event? .............................................. 10-2
  When to Use Events ........................................ 10-2
  Types of Events .............................................. 10-3
  Where You Can Use Events ................................ 10-3
  Diagnostic for Detecting Unused Events .................... 10-3

Define Events .......................................................... 10-5
  Add Events with the Stateflow Editor ....................... 10-5
  Add Events with the Model Explorer ....................... 10-5

Set Properties for an Event ........................................ 10-7
  Access Event Properties .................................. 10-7
  Property Fields .............................................. 10-7

Activate a Stateflow Chart Using Input Events ............... 10-9
  What Is an Input Event? .................................... 10-9
  Activate a Stateflow Chart Using Edge Triggers ........ 10-9
  Activate a Stateflow Chart Using Function Calls .......... 10-10
  Association of Input Events with Control Signals ...... 10-11

Control States When Function-Call Inputs Reenable Charts ... 10-14
  Set Behavior for a Reenabled Chart ....................... 10-14
  Behavior When the Parent Is the Model Root ............ 10-14
  Behavior When the Chart Is Inside a Model Block ...... 10-18

Activate a Simulink Block Using Output Events ............... 10-22
  What Is an Output Event? .................................. 10-22
  Activate a Simulink Block Using Edge Triggers .......... 10-22
  Activate a Simulink Block Using Function Calls ........ 10-30
  Association of Output Events with Output Ports ........ 10-33
  Access Simulink Subsystems Triggered By Output Events 10-34
Control Chart Execution Using Implicit Events .......................................................... 10-35
What Are Implicit Events? ............................................................................................... 10-35
Keywords for Implicit Events ......................................................................................... 10-35
Transition Between States Using Implicit Events ......................................................... 10-36
Execution Order of Transitions with Implicit Events ..................................................... 10-37

Count Events .................................................................................................................. 10-40
When to Count Events .................................................................................................... 10-40
How to Count Events ..................................................................................................... 10-40
Collect and Store Input Data in a Vector ........................................................................ 10-40

Best Practices for Using Events in Stateflow Charts ..................................................... 10-42

Messages

How Messages Work in Stateflow Charts ...................................................................... 11-2

View Differences Between Stateflow Messages, Events, and Data ............................... 11-4

Stateflow Message Syntax in Charts .............................................................................. 11-13
Access the Data in a Message ......................................................................................... 11-13
Send a Message .............................................................................................................. 11-13
Guard a Transition or Action with a Message ............................................................... 11-14
Receive a Message .......................................................................................................... 11-15
Discard a Message ......................................................................................................... 11-16
Forward a Message ........................................................................................................ 11-17
Determine if a Message Is Valid ..................................................................................... 11-18
Check the Length of the Queue ...................................................................................... 11-19

Queuing Behavior of Stateflow Messages ................................................................... 11-21

Lifetime of a Stateflow Message .................................................................................... 11-23

Limitations for Messages ............................................................................................... 11-25

Define Messages in a Stateflow Chart .......................................................................... 11-26
Types of Messages in a Chart ......................................................................................... 11-26
Define Message Inputs and Outputs .............................................................................. 11-26
Set Message Properties ........................................ 11-28

Work with Sequence Viewer ................................. 11-31
  Visualize Messages ........................................ 11-32
  View State Activity and Transitions ....................... 11-39
  Redisplay of Information in Sequence Viewer ............ 11-41
  Time in Sequence Viewer .................................. 11-41
  Navigation in Sequence Viewer ............................. 11-42
  Function Calls in Sequence Viewer ....................... 11-43

Use Actions in Charts

12

State Action Types .............................................. 12-2
  Entry Actions ............................................. 12-4
  Exit Actions .............................................. 12-4
  During Actions .......................................... 12-4
  Bind Actions .............................................. 12-4
  On Actions ............................................... 12-6

Transition Action Types .................................... 12-7
  Event or Message Triggers ................................. 12-8
  Conditions ................................................. 12-8
  Condition Actions ....................................... 12-9
  Transition Actions ..................................... 12-9

Execution of Actions in States and Transitions .......... 12-11

Combine State Actions to Eliminate Redundant Code .... 12-15
  State Actions You Can Combine ............................. 12-15
  Why Combine State Actions ................................ 12-15
  How to Combine State Actions .............................. 12-15
  Order of Execution of Combined Actions .................. 12-16
  Rules for Combining State Actions ......................... 12-17

Supported Operations on Chart Data ....................... 12-19
  Binary and Bitwise Operations ............................. 12-19
  Unary Operations .......................................... 12-22
  Unary Actions ............................................. 12-22
  Assignment Operations ................................... 12-22
Supported Symbols in Actions ................................................. 12-27
  Boolean Symbols, true and false ......................................... 12-27
  Comment Symbols, %, //, /* ........................................... 12-28
  Hexadecimal Notation Symbols, 0xFF ..................................... 12-28
  Infinity Symbol, inf ....................................................... 12-28
  Line Continuation Symbol, ... ............................................ 12-29
  Literal Code Symbol, $ ..................................................... 12-29
  MATLAB Display Symbol, ; ................................................ 12-29
  Single-Precision Floating-Point Number Symbol, F .................... 12-29
  Time Symbol, t ................................................................ 12-29

Call C Functions in C Charts .................................................. 12-31
  Call C Library Functions .................................................... 12-31
  Call the abs Function ....................................................... 12-32
  Call min and max Functions ................................................. 12-32
  Replacement of Math Library Functions with Application
  Implementations ............................................................... 12-33
  Call Custom C Code Functions .............................................. 12-33

Access Built-In MATLAB Functions and Workspace Data ............ 12-38
  Call MATLAB Functions in Stateflow .................................. 12-38
  ml Namespace Operator ..................................................... 12-38
  ml Function .................................................................... 12-39
  ml Expressions .................................................................. 12-41
  Which ml Should I Use? ...................................................... 12-41
  ml Data Type ................................................................... 12-43
  How Charts Infer the Return Size for ml Expressions ............... 12-45

Use Arrays in Actions ............................................................ 12-50
  Array Notation .................................................................. 12-50
  Arrays and Custom Code .................................................... 12-50

Broadcast Events to Synchronize States .................................... 12-52
  Directed Event Broadcasting ............................................... 12-52
  Directed Local Event Broadcast Using send .......................... 12-52
  Directed Local Event Broadcast Using Qualified
  Event Names .................................................................... 12-53
  Diagnostic for Detecting Undirected Local Event
  Broadcasts .................................................................... 12-54
Control Chart Execution Using Temporal Logic ................. 12-55
  What Is Temporal Logic? ........................................ 12-55
  Rules for Using Temporal Logic Operators .................... 12-55
  Operators for Event-Based Temporal Logic .................... 12-56
  Examples of Event-Based Temporal Logic ..................... 12-58
  Notations for Event-Based Temporal Logic .................... 12-60
  Operators for Absolute-Time Temporal Logic ................ 12-62
  Define Time Delays with Temporal Logic ....................... 12-64
  Examples of Absolute-Time Temporal Logic ................... 12-66
  Run a Model That Uses Absolute-Time Temporal Logic ........ 12-67
  Absolute-Time Temporal Logic in Conditionally Executed
  Subsystems ....................................................... 12-67
  How Sample Time Affects Chart Execution ..................... 12-70
  Best Practices for Absolute-Time Temporal Logic ............ 12-71

Detect Changes in Data Values .................................. 12-74
  Types of Data Value Changes That You Can Detect ............ 12-74
  Run a Model That Uses Change Detection ....................... 12-75
  How Change Detection Works .................................... 12-77
  Change Detection Operators .................................... 12-79
  Chart with Change Detection ..................................... 12-84

Check State Activity ............................................ 12-86
  When to Check State Activity .................................. 12-86
  How to Check State Activity .................................... 12-86
  The in Operator .................................................. 12-86
  How Checking State Activity Works ............................. 12-87
  State Resolution for Identically Named Substates ............ 12-89
  Best Practices for Checking State Activity ................... 12-91

Control Function-Call Subsystems Using Bind Actions .......... 12-95
  What Are Bind Actions? .......................................... 12-95
  Bind a Function-Call Subsystem to a State .................... 12-95
  Model That Binds a Function-Call Subsystem to a State ...... 12-100
  Behavior of a Bound Function-Call Subsystem .................. 12-103
  Why Avoid Muxed Trigger Events with Binding ................ 12-109

Simplify Stateflow Chart Using the duration Operator ....... 12-112
  Control Oscillation with Parallel State Logic ............... 12-112
  Control Oscillation with the duration Operator .............. 12-113
## Reduce the Compilation Time of a Chart
- Goal of the Tutorial
- Edit a Model to Use Atomic Subcharts

## Divide a Chart into Separate Units
- Goal of the Tutorial
- Edit a Model to Use Atomic Subcharts

## Generate Reusable Code for Unit Testing
- Goal of the Tutorial
- Convert a State to an Atomic Subchart
- Specify Code Generation Parameters
- Generate Code for Only the Atomic Subchart

## Save and Restore Simulations with SimState

### What Is a SimState?

### Benefits of Using a Snapshot of the Simulation State
- Division of a Long Simulation into Segments
- Test of a Chart Response to Different Settings

### Divide a Long Simulation into Segments
- Goal of the Tutorial
- Define the SimState
- Load the SimState
- Simulate the Specific Segment

### Test a Unique Chart Configuration
- Goal of the Tutorial
- Define the SimState
- Load the SimState and Modify Values
- Test the Modified SimState

### Test a Chart with Fault Detection and Redundant Logic
- Goal of the Tutorial
- Define the SimState
- Modify SimState Values for One Actuator Failure
- Test the SimState for One Failure
Vectors and Matrices in Stateflow Charts

17

How Vectors and Matrices Work in Stateflow Charts .............. 17-2
  When to Use Vectors and Matrices ........................ 17-2
  Where You Can Use Vectors and Matrices ................ 17-2

Define Vectors and Matrices in Stateflow ....................... 17-4
  Define a Vector ........................................... 17-4
  Define a Matrix .......................................... 17-4

Scalar Expansion for Converting Scalars to Nonscalars ..... 17-6
  What Is Scalar Expansion? ............................... 17-6
  How Scalar Expansion Works for Functions ................. 17-6

Assign and Access Stateflow Vector and Matrix Values ....... 17-8
  Notation for Vectors and Matrices ....................... 17-8
  Assign and Access Values of Vectors ...................... 17-8
  Assign and Access Values of Matrices ..................... 17-9
  Assign Values of a Vector or Matrix Using Scalar Expansion ........................................ 17-9
### Operations For Vectors and Matrices in Stateflow Charts

- **Binary Operations** .............................................................. 17-11
- **Unary Operations and Actions** .......................................... 17-11
- **Assignment Operations** ..................................................... 17-12

### Rules for Vectors and Matrices in Stateflow Charts

- **Best Practices for Vectors and Matrices in Stateflow Charts** ........... 17-14
  - Perform Matrix Multiplication and Division Using MATLAB Functions ... 17-14
  - Index a Vector Using the temporalCount Operator ..................... 17-15

### Find Pattern in Data Transmission Using Vectors

- Storage of Complex Data in a Vector ........................................ 17-18
- Scalar Expansion of a Vector ................................................. 17-18

### Calculate Motion Using Matrices

- How the Model Works ............................................................ 17-19
- Storage of Two-Dimensional Data in Matrices .............................. 17-19
- Calculation of Two-Dimensional Dynamics of Each Ball ............... 17-20
- Run the Model ......................................................................... 17-22

---

### Variable-Size Data in Stateflow Charts

#### What Is Variable-Size Data?

- .......................................................... 18-2

#### How Charts Implement Variable-Size Data

- .......................................................... 18-3

#### Enable Support for Variable-Size Data

- .......................................................... 18-4

#### Declare Variable-Size Inputs and Outputs

- .......................................................... 18-5

#### Compute Output Based on Size of Input Signal

- About the Model ................................................................. 18-7
- Chart: VarSizeSignalSource .................................................. 18-8
- Chart: size_based_processing .............................................. 18-11
- Simulate the Model .............................................................. 18-14

---

xxvii
## Enumerated Data in Charts

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference Values by Name by Using Enumerated Data</td>
<td>19-2</td>
</tr>
<tr>
<td>Example of Enumerated Data</td>
<td>19-2</td>
</tr>
<tr>
<td>Computation with Enumerated Data</td>
<td>19-3</td>
</tr>
<tr>
<td>Notation for Enumerated Values</td>
<td>19-3</td>
</tr>
<tr>
<td>Where to Use Enumerated Data</td>
<td>19-4</td>
</tr>
<tr>
<td>Define Enumerated Data Types</td>
<td>19-5</td>
</tr>
<tr>
<td>Elements of an Enumerated Data Type Definition</td>
<td>19-5</td>
</tr>
<tr>
<td>Define an Enumerated Data Type</td>
<td>19-5</td>
</tr>
<tr>
<td>Specify Data Type in the Property Inspector</td>
<td>19-8</td>
</tr>
<tr>
<td>Best Practices for Using Enumerated Data</td>
<td>19-9</td>
</tr>
<tr>
<td>Guidelines for Defining Enumerated Data Types</td>
<td>19-9</td>
</tr>
<tr>
<td>Guidelines for Referencing Enumerated Data</td>
<td>19-10</td>
</tr>
<tr>
<td>Guidelines and Limitations for Enumerated Data</td>
<td>19-12</td>
</tr>
<tr>
<td>Assign Enumerated Values in a Chart</td>
<td>19-14</td>
</tr>
<tr>
<td>Chart Behavior</td>
<td>19-14</td>
</tr>
<tr>
<td>Build the Chart</td>
<td>19-15</td>
</tr>
<tr>
<td>View Simulation Results</td>
<td>19-16</td>
</tr>
<tr>
<td>Model Media Player by Using Enumerated Data</td>
<td>19-19</td>
</tr>
<tr>
<td>Run the Media Player Model</td>
<td>19-20</td>
</tr>
<tr>
<td>UserRequest Chart</td>
<td>19-23</td>
</tr>
<tr>
<td>CdPlayerModeManager Chart</td>
<td>19-24</td>
</tr>
<tr>
<td>CdPlayerBehaviorModel Chart</td>
<td>19-27</td>
</tr>
</tbody>
</table>

## Continuous-Time Systems in Stateflow Charts

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Continuous-Time Modeling in Stateflow</td>
<td>20-2</td>
</tr>
<tr>
<td>What Is Continuous-Time Modeling?</td>
<td>20-2</td>
</tr>
</tbody>
</table>
When to Use Stateflow Charts for Continuous-Time Modeling ................................ 20-3
Model Continuous-Time with Zero-Crossing Detection ......................... 20-3
When to Disable Zero-Crossing Detection .................................................. 20-4

Model Hybrid Systems with Model Logic ........................................... 20-6

Configure a Stateflow Chart to Update in Continuous Time .................. 20-7

Define Continuous-Time Variables ....................................................... 20-9
Purpose of Continuous-Time Variables .................................................. 20-9
Implicit Time Derivatives ........................................................................ 20-9
Rules for Using Continuous-Time Variables ......................................... 20-9
How to Define Continuous-Time Variables ............................................ 20-10
Expose Continuous States to a Simulink Model .................................... 20-10

Model a Bouncing Ball in Continuous Time ........................................... 20-11
Dynamics of a Bouncing Ball ................................................................. 20-11
Model the Bouncing Ball ........................................................................ 20-12

Design Considerations for Continuous-Time Modeling in Stateflow Charts ............................................... 20-21
Rationale for Design Considerations ....................................................... 20-21
Summary of Rules for Continuous-Time Modeling .................................. 20-21

Fixed-Point Data in Stateflow Charts

What Is Fixed-Point Data? ....................................................................... 21-2
Before You Begin ..................................................................................... 21-2
Fixed-Point Numbers ............................................................................... 21-2
Fixed-Point Operations ........................................................................... 21-3

How Fixed-Point Data Works in Stateflow Charts .................................. 21-5
How Stateflow Software Defines Fixed-Point Data .................................... 21-5
Specify Fixed-Point Data .......................................................................... 21-6
Rules for Specifying Fixed-Point Word Length ....................................... 21-6
Fixed-Point Context-Sensitive Constants ............................................... 21-7
Tips for Using Fixed-Point Data ............................................................... 21-8
Detect Overflow for Fixed-Point Types .................................. 21-9
Share Fixed-Point Data with Simulink Models ..................... 21-10

Use Fixed-Point Chart Inputs .............................................. 21-11
Run the Fixed-Point "Bang-Bang Control" Model .................. 21-11
Explore the Fixed-Point "Bang-Bang Control" Model ........... 21-12

Use Fixed-Point Parameters and Local Data ..................... 21-16
Goal of the Tutorial ...................................................... 21-16
Build the Fixed-Point Butterworth Filter ......................... 21-16
Define the Model Callback Function ............................... 21-17
Add Other Blocks to the Model ...................................... 21-18
Set Model Configuration Parameters ............................ 21-19
Run the Model ............................................................. 21-20

Operations with Fixed-Point Data .................................... 21-22
Supported Operations with Fixed-Point Operands ............... 21-22
Promotion Rules for Fixed-Point Operations .................... 21-24
Assignment (=, :=) Operations ..................................... 21-29
Fixed-Point Conversion Operations ............................... 21-36
Automatic Scaling of Stateflow Fixed-Point Data ............. 21-37

Complex Data in C Charts

How Complex Data Works in C Charts .............................. 22-2
What Is Complex Data? .................................................. 22-2
When to Use Complex Data ........................................... 22-2
Where You Can Use Complex Data ................................ 22-2
How You Can Use Complex Data ................................... 22-3

Define Complex Data Using the Editor ............................ 22-4

Complex Data Operations for Charts That Support C
Expressions ..................................................................... 22-7
Binary Operations ....................................................... 22-7
Unary Operations and Actions ................................. 22-7
Assignment Operations .............................................. 22-8
Define Complex Data Using Operators ........................................ 22-9
  Why Use Operators for Complex Numbers? .................. 22-9
  Define a Complex Number ........................................ 22-9
  Access Real and Imaginary Parts of a Complex Number ... 22-10
  Work with Vector Arguments .................................... 22-11

Rules for Using Complex Data in C Charts ................................. 22-12

Best Practices for Using Complex Data in C Charts .................. 22-15
  Perform Math Function Operations with a MATLAB Function .... 22-15
  Perform Complex Division with a MATLAB Function ........... 22-16

Detect Valid Transmission Data Using Frame Synchronization .......... 22-19

Measure Frequency Response Using a Spectrum Analyzer ............. 22-23

Define Interfaces to Simulink Models and the MATLAB Workspace  
                                                                                     23

Overview of Stateflow Block Interfaces .................................. 23-2
  Stateflow Block Interfaces ...................................... 23-2

Specify Chart Properties .............................................. 23-3
  About Chart Properties ......................................... 23-3
  Set Properties for a Single Chart .............................. 23-3
  Set Properties for All Charts in the Model .................... 23-9

Set Stateflow Block Update Method .................................. 23-11

Implement Interfaces to Simulink Models ............................... 23-13
  Define a Triggered Stateflow Block ............................ 23-13
  Define a Sampled Stateflow Block .............................. 23-14
  Define an Inherited Stateflow Block ........................... 23-15
  Define a Continuous Stateflow Block ......................... 23-15
  Define Function-Call Output Events ............................ 23-15
  Define Edge-Triggered Output Events ............................ 23-16
Reuse Charts in Models with Chart Libraries .................. 23-18

Create Specialized Chart Libraries for Large-Scale Modeling ................................. 23-19

Customize Properties of Library Blocks ........................................ 23-20

Limitations of Library Charts ...................................................... 23-21

MATLAB Workspace Interfaces .................................................. 23-22
  About the MATLAB Workspace .................................................. 23-22
  Examine the MATLAB Workspace .............................................. 23-22
  Interface the MATLAB Workspace with Charts ........................... 23-22

About Masks ........................................................................ 23-23

Mask Parameters ..................................................................... 23-24

Look Under a Mask ................................................................. 23-26

Mask a Stateflow Block ......................................................... 23-27
  Create Mask ........................................................................... 23-27
  Change the Icon ...................................................................... 23-27
  Add a Parameter ..................................................................... 23-27
  View the New Mask ............................................................... 23-28
  Edit the Mask ....................................................................... 23-29

About Active State Data ......................................................... 23-31
  State Activity Type ................................................................. 23-31
  Active State Data Type ........................................................... 23-31
  Leaf State Activity and Parallel States ....................................... 23-32

When to Use Active State Output Data ...................................... 23-35

Set Active State Data as Local ................................................. 23-36

View State Activity Using the Simulation Data Inspector .......... 23-37
  Log to the Simulation Data Inspector from Stateflow ......... 23-37

Limitations for Active State Data .............................................. 23-41

Use Active State Output Data ................................................... 23-42
Change the Active State Port Name ................................. 23-45

Define State Activity Enum Name and Type .................... 23-46

Units in Stateflow ................................................... 23-48
Units for Input and Output Data ................................ 23-48
Consistency Checking ................................................. 23-48
Units for Stateflow Limitations ................................. 23-48

Structures and Bus Signals in Stateflow Charts

About Stateflow Structures ........................................... 24-2
What Is a Stateflow Structure? ...................................... 24-2
What You Can Do with Structures ................................ 24-2

Connect Structures in Charts to External Bus Signals ........ 24-3
Structure Definitions in sfbus_demo Stateflow Chart .......... 24-4
Structure Definitions in sfbus_demo Stateflow
Graphical Function ................................................... 24-5
Simulink Bus Objects Define Stateflow Structures .......... 24-5

Rules for Defining Structure Data Types in Charts .......... 24-8

Define Stateflow Structures ......................................... 24-9
Define Structure Inputs and Outputs .............................. 24-9
Define Local Structures ........................................... 24-12
Define Structures of Parameter Scope ......................... 24-13
Define Temporary Structures ...................................... 24-14
Define Structure Types with Expressions ...................... 24-15

Structure Operations .................................................. 24-17
Index Sub-Structures and Fields ................................. 24-17
Guidelines for Assignment of Values ......................... 24-19
Get Addresses ......................................................... 24-20

Integrate Custom Structures in Stateflow Charts .......... 24-22

Debug Structures ....................................................... 24-26
Reduce Transient Signals with Debounce Logic .................... 25-2
Why Debounce Signals ........................................ 25-2
How to Debounce a Signal ...................................... 25-2
Debounce Signals with the duration Operator ................... 25-2
Debounce Signals with Fault Detection ......................... 25-7
Use Event-Based Temporal Logic ............................... 25-11

Schedule Function Calls ........................................ 25-12

Schedule Execution of Simulink Subsystems ..................... 25-13
When to Implement Schedulers .................................. 25-13
Types of Schedulers .............................................. 25-13

Schedule Multiple Subsystems in a Single Step ................. 25-14
Key Behaviors of Ladder Logic Scheduler ....................... 25-15
Run the Ladder Logic Scheduler ................................. 25-16

Schedule One Subsystem in a Single Step ....................... 25-18
Key Behaviors of Loop Scheduler ............................... 25-19
Run the Loop Scheduler ......................................... 25-20

Schedule Subsystems to Execute at Specific Times ............. 25-22
Key Behaviors of Temporal Logic Scheduler .................... 25-23
Run the Temporal Logic Scheduler .............................. 25-23

Implement Dynamic Test Vectors ............................... 25-25
When to Implement Test Vectors ................................ 25-25
A Dynamic Test Vector Chart ................................... 25-27
Key Behaviors of the Chart and Model .......................... 25-29
Run the Model with Stateflow Test Vectors .................... 25-31

Map Fault Conditions to Actions in Truth Tables .............. 25-34

Design for Isolation and Recovery in a Chart .................... 25-38
Mode Logic for the Elevator Actuators ......................... 25-38
States for Failure and Isolation ................................ 25-39
Transitions for Recovery ........................................ 25-40
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What Is a Truth Table?</td>
<td>26-2</td>
</tr>
<tr>
<td>Where to Use a Truth Table</td>
<td>26-3</td>
</tr>
<tr>
<td>Language Options for Stateflow Truth Tables</td>
<td>26-4</td>
</tr>
<tr>
<td>C Truth Tables</td>
<td>26-4</td>
</tr>
<tr>
<td>MATLAB Truth Tables</td>
<td>26-4</td>
</tr>
<tr>
<td>Select a Language for Stateflow Truth Tables</td>
<td>26-5</td>
</tr>
<tr>
<td>Migration from C to MATLAB Truth Tables</td>
<td>26-5</td>
</tr>
<tr>
<td>Represent Combinatorial Logic Using Truth Tables</td>
<td>26-6</td>
</tr>
<tr>
<td>Build Model with Stateflow Truth Table</td>
<td>26-7</td>
</tr>
<tr>
<td>Add a Stateflow Block that Calls a Truth Table Function</td>
<td>26-7</td>
</tr>
<tr>
<td>Program a Truth Table</td>
<td>26-19</td>
</tr>
<tr>
<td>Open a Truth Table for Editing</td>
<td>26-19</td>
</tr>
<tr>
<td>Select an Action Language</td>
<td>26-20</td>
</tr>
<tr>
<td>Enter Truth Table Conditions</td>
<td>26-20</td>
</tr>
<tr>
<td>Enter Truth Table Decisions</td>
<td>26-22</td>
</tr>
<tr>
<td>Enter Truth Table Actions</td>
<td>26-25</td>
</tr>
<tr>
<td>Assign Truth Table Actions to Decisions</td>
<td>26-33</td>
</tr>
<tr>
<td>Add Initial and Final Actions</td>
<td>26-39</td>
</tr>
<tr>
<td>Debug a Truth Table</td>
<td>26-42</td>
</tr>
<tr>
<td>Check Truth Tables for Errors</td>
<td>26-42</td>
</tr>
<tr>
<td>Debug a Truth Table During Simulation</td>
<td>26-42</td>
</tr>
<tr>
<td>Correct Overspecified and Underspecified Truth Tables</td>
<td>26-58</td>
</tr>
<tr>
<td>Example of an Overspecified Truth Table</td>
<td>26-58</td>
</tr>
<tr>
<td>Example of an Underspecified Truth Table</td>
<td>26-62</td>
</tr>
<tr>
<td>How Stateflow Generates Content for Truth Tables</td>
<td>26-69</td>
</tr>
<tr>
<td>Types of Generated Content</td>
<td>26-69</td>
</tr>
<tr>
<td>View Generated Content</td>
<td>26-69</td>
</tr>
<tr>
<td>How Stateflow Software Generates Graphical Functions for Truth Tables</td>
<td>26-69</td>
</tr>
<tr>
<td>How Stateflow Software Generates MATLAB Code for Truth Tables</td>
<td>26-74</td>
</tr>
</tbody>
</table>
## Truth Table Operations
- Append Rows and Columns
- Diagnose the Truth Table
- View Auto-generated Content
- Edit Tables
- Move Rows and Columns
- Select and Deselect Table Elements
- Undo and Redo Edit Operations
- View the Stateflow Chart for the Truth Table

## MATLAB Functions in Stateflow Charts

### MATLAB Functions in a Chart
- Where to Use a MATLAB Function
- When to Use Reusable Functions in Charts
- Build Model with MATLAB Function in a Chart

### MATLAB Functions in a Stateflow Chart

### Specify MATLAB Function Properties in a Chart
- Set MATLAB Function Properties

### Program a MATLAB Function in a Chart

### Debug a MATLAB Function in a Chart
- Check MATLAB Functions for Syntax Errors
- Run-Time Debugging for MATLAB Functions in Charts
- Check for Data Range Violations

### Connect Structures in MATLAB Functions to Bus Signals in Simulink
- About Structures in MATLAB Functions
- Define Structures in MATLAB Functions

### Define Data in MATLAB Functions
- Define Enumerated Data in MATLAB Functions
- Declare Variable-Size Data in MATLAB Functions
- Define Temporary Data
Simulink Functions in Stateflow Charts

**Simulink Functions in Stateflow** ........................................... 28-2
  - What Is a Simulink Function? ........................................... 28-2
  - Where to Define a Simulink Function in a Chart .................. 28-2
  - Rules for Using Simulink Functions in Stateflow Charts ....... 28-3

**Share Functions Across Simulink and Stateflow** ................. 28-6

**Why Use a Simulink Function in a Stateflow Chart?** ........... 28-8
  - Advantages of Using Simulink Functions in a Stateflow Chart .......................................................... 28-8
  - Benefits of Using a Simulink Function to Access Simulink Blocks .......................................................... 28-8
  - Benefits of Using a Simulink Function to Schedule Execution of Multiple Controllers .................................. 28-11

**Basic Approach to Defining Simulink Functions in Stateflow Charts** ........................................... 28-15
  - Task 1: Add a Function to the Chart ................................. 28-15
  - Task 2: Define the Subsystem Elements of the Simulink Function .......................................................... 28-16
  - Task 3: Configure the Function Inputs ............................... 28-17

**How a Simulink Function Binds to a State** ....................... 28-18
  - Bind Behavior of a Simulink Function .............................. 28-18
  - Control Subsystem Variables When the Simulink Function Is Disabled .......................................................... 28-19
  - Example of Binding a Simulink Function to a State ............. 28-20

**How a Simulink Function Behaves When Called from Multiple Sites** .................................................. 28-25

**Define a Function That Uses Simulink Blocks** ................... 28-27
  - Goal of the Tutorial ..................................................... 28-27
  - Edit a Model to Use a Simulink Function ........................... 28-28
Run the New Model ........................................ 28-35

Schedule Execution of Multiple Controllers ............. 28-37
Goal of the Tutorial ..................................... 28-37
Edit a Model to Use Simulink Functions .................. 28-38
Run the New Model ........................................ 28-44

Build Targets

29

Code Generation for Stateflow Blocks .................... 29-2
Code Generation for Rapid Prototyping and Production Code Deployment ............................. 29-2

Choose a Procedure to Simulate a Model ................. 29-3
Guidelines for Simulation ................................ 29-3
Choose the Right Procedure for Simulation ................ 29-3

Integrate Custom C/C++ Code for Simulation .......... 29-6
Integrate Custom C++ Code for Simulation .............. 29-6
Integrate Custom C Code for Nonlibrary Charts for Simulation .............................................. 29-7
Integrate Custom C Code for Library Charts for Simulation ...................................................... 29-10
Integrate Custom C Code for All Charts for Simulation .... 29-12
Call External Functions in Charts with MATLAB as the Action Language ...................................... 29-14

Speed Up Simulation ...................................... 29-15
Improve Model Update Performance ...................... 29-15
Disable Simulation Target Options That Impact Execution Speed .............................................. 29-16
Keep Charts Closed to Speed Up Simulation ............ 29-16
Keep Scope Blocks Closed to Speed Up Simulation .... 29-16
Use Library Charts in Your Model ....................... 29-16

Generate C/C++ Code for Rapid Prototyping or Production Deployment ....................................... 29-17

Optimize Generated Code ................................ 29-18
What You Can Log During Chart Simulation .......................... 30-47
See Also ........................................................................ 30-47

Basic Approach to Logging States and Data ........................ 30-48
Enable Signal Logging ...................................................... 30-48
Configure States and Data for Logging ............................... 30-49
Limitations on Logging Data ............................................ 30-52

Access Signal Logging Data ............................................. 30-54
Signal Logging Object ..................................................... 30-54
Access Logged Data ....................................................... 30-54

View Logged Data ......................................................... 30-58

Log Data in Library Charts ............................................. 30-59
How Library Log Settings Influence Linked Instances ........ 30-59
Override Logging Properties in Chart Instances ............... 30-59
Override Logging Properties in Atomic Subcharts .......... 30-59

How Stateflow Logs Multidimensional Data ....................... 30-64

Commenting Stateflow Objects in a Chart ....................... 30-65
Comment Out a Stateflow Object ..................................... 30-65
How Commenting Affects the Chart and Model ............... 30-65
Add Text to a Commented Object ................................... 30-67
Limitations on Commenting Objects ............................... 30-67

Explore and Modify Charts

Manage Stateflow Data, Events, and Messages in the Symbols
Window ................................................................. 31-2

Add and Modify Data, Events, and Messages in the Symbols
Window ................................................................. 31-5
Symbols Window Limitations ........................................ 31-5

Trace Data, Events, and Messages Through the Symbols
Window ................................................................. 31-7

xli
Use the Model Explorer with Stateflow Objects ........... 31-11
  View Stateflow Objects in the Model Explorer .......... 31-11
  Edit Chart Objects in the Model Explorer .............. 31-13
  Add Data and Events in the Model Explorer .......... 31-13
  Rename Objects in the Model Explorer ................. 31-13
  Set Properties for Chart Objects in the Model Explorer . 31-13
  Move and Copy Data and Events in the Model Explorer ... 31-14
  Change the Port Order of Input and Output Data and Events .................................................. 31-15
  Delete Data and Events in the Model Explorer .......... 31-16

Use the Search & Replace Tool .................................. 31-17
  Open the Search & Replace Tool ......................... 31-17
  Refine Searches ........................................ 31-19
  Specify the Search Scope ................................ 31-21
  Use the Search Button and View Area ................... 31-22
  Specify the Replacement Text .............................. 31-25
  Use Replace Buttons ..................................... 31-26
  Search and Replace Messages ............................. 31-26

Semantic Rules Summary

A

Summary of Chart Semantic Rules .............................. A-2
  Enter a Chart ............................................ A-2
  Execute an Active Chart ................................ A-2
  Enter a State ........................................... A-2
  Execute an Active State ................................ A-3
  Exit an Active State .................................... A-3
  Execute a Set of Flow Charts ............................ A-4
  Execute an Event Broadcast .............................. A-5

Semantic Examples

B

Categories of Semantic Examples ............................. B-2
Transition to and from Exclusive (OR) States ............ B-4
Label Format for a State-to-State Transition .......... B-4
Transition from State to State with Events .......... B-5
Transition from a Substate to a Substate with Events B-8

Control Chart Execution Using Condition Actions ...... B-10
Condition Action Behavior ................................ B-10
Condition and Transition Action Behavior .............. B-11
Create Condition Actions Using a For-Loop ............ B-12
Broadcast Events to Parallel (AND) States Using Condition Actions ................................ B-13
Avoid Cyclic Behavior .................................... B-14

Control Chart Execution Using Default Transitions ...... B-16
Default Transition in Exclusive (OR) Decomposition ... B-16
Default Transition to a Junction ......................... B-17
Default Transition and a History Junction ................ B-18
Labeled Default Transitions ................................ B-19

Process Events Using Inner Transitions ................. B-22
Process Events with an Inner Transition in an Exclusive (OR) State ........................................ B-22
Process Events with an Inner Transition to a Connective Junction ........................................ B-25
Inner Transition to a History Junction .................... B-27

Use Connective Junctions to Represent Multiple Paths ... B-29
Label Format for Transition Segments .................. B-29
If-Then-Else Decision Construct ......................... B-30
Self-Loop Transition .................................... B-31
For-Loop Construct ..................................... B-32
Flow Chart Notation ..................................... B-34
Transition from a Common Source to Multiple Destinations ........................................ B-35
Resolve Equally Valid Transition Paths .................. B-36
Transition from Multiple Sources to a Common Destination ........................................ B-38
Transition from a Source to a Destination Based on a Common Event .................................... B-39
Backtrack in Flow Charts ................................ B-39

Control Chart Execution Using Event Actions in a Superstate ........................................ B-42
Broadcast Events in Parallel (AND) States ................. B-43
  Broadcast Events in Parallel States ...................... B-43
  Broadcast Events in a Transition Action with a Nested Event
    Broadcast ............................................ B-45
  Broadcast Condition Action Event in Parallel State ........ B-48

Directly Broadcast Events ....................................... B-52
  Directed Event Broadcast Using Send ....................... B-52
  Directed Event Broadcast Using Qualified Event Name .... B-53

Glossary
Stateflow Chart Concepts

• “Finite State Machine Concepts” on page 1-2
• “Stateflow Charts and Simulink Models” on page 1-4
• “Stateflow Chart Objects” on page 1-6
• “Stateflow Hierarchy of Objects” on page 1-7
• “Bibliography” on page 1-9
Finite State Machine Concepts

What Is a Finite State Machine?

Stateflow charts can contain sequential decision logic based on state machines. A finite state machine is a representation of an event-driven (reactive) system. In an event-driven system, the system makes a transition from one state (mode) to another, if the condition defining the change is true.

For example, you can use a state machine to represent the automatic transmission of a car. The transmission has these operating states: park, reverse, neutral, drive, and low. As the driver shifts from one position to another, the system makes a transition from one state to another, for example, from park to reverse.

Finite State Machine Representations

Traditionally, designers used truth tables to represent relationships among the inputs, outputs, and states of a finite state machine. The resulting table describes the logic necessary to control the behavior of the system under study. Another approach to designing event-driven systems is to model the behavior of the system by describing it in terms of transitions among states. The occurrence of events under certain conditions determine the state that is active. State-transition charts and bubble charts are graphical representations based on this approach.

Stateflow Chart Representations

A Stateflow chart can contain sequential and combinatorial logic in the form of state transition diagrams, flow charts, state transition tables, and truth tables. A state transition diagram is a graphical representation of a finite state machine. States and
transitions form the basic building blocks of a sequential logic system. Another way to represent sequential logic is a state transition table, which allows you to enter the state logic in tabular form. You can also represent combinatorial logic in a chart with flow charts and truth tables.

You can include Stateflow charts as blocks in a Simulink® model. The collection of these blocks in a Simulink model is the Stateflow machine.

A Stateflow chart enables the representation of hierarchy, parallelism, and history. You can organize complex systems by defining a parent and offspring object structure. For example, you can organize states within other higher-level states. A system with parallelism can have two or more orthogonal states active at the same time. You can also specify the destination state of a transition based on historical information.

Notation

Notation defines a set of objects and the rules that govern the relationships between those objects. Stateflow chart notation provides a way to communicate the design information in a Stateflow chart.

Stateflow chart notation consists of these elements:

- A set of graphical objects
- A set of nongraphical text-based objects
- Defined relationships between those objects

Semantics

Semantics describe how to interpret chart notation. A typical Stateflow chart contains actions associated with transitions and states. The semantics describe the sequence of these actions during chart execution.
Stateflow Charts and Simulink Models

In this section...

“The Simulink Model and the Stateflow Machine” on page 1-4
“Overview of Defining Stateflow Block Interfaces to Simulink Models” on page 1-4

The Simulink Model and the Stateflow Machine

A Stateflow chart functions as a finite state machine within a Simulink model. The Stateflow machine is the collection of Stateflow blocks in a Simulink model. The Simulink model and the Stateflow machine work seamlessly together. Running a simulation automatically executes both the Simulink blocks and the Stateflow charts of the model.

A Simulink model can consist of combinations of Simulink blocks, toolbox blocks, and Stateflow blocks (charts). A chart consists of graphical objects (states, boxes, functions, notes, transitions, connective junctions, and history junctions) and nongraphical objects (events, messages, and data).

There is a one-to-one correspondence between the Simulink model and the Stateflow machine. Each Stateflow block in the Simulink model appears as a single Stateflow chart. Each Stateflow machine has its own object hierarchy. The Stateflow machine is the highest level in the Stateflow hierarchy. The object hierarchy beneath the Stateflow machine consists of combinations of graphical and nongraphical objects. See “Stateflow Hierarchy of Objects” on page 1-7.

Overview of Defining Stateflow Block Interfaces to Simulink Models

Each Stateflow block corresponds to a single Stateflow chart. The Stateflow block interfaces to its Simulink model. The Stateflow block can interface to code sources external to the Simulink model (data, events, custom code).

Stateflow charts are event-driven. Events can be local to the Stateflow block or can propagate to and from the Simulink model. Data can be local to the Stateflow block or can pass to and from the Simulink model and external code sources.

Defining the interface for a Stateflow block can involve some or all these tasks:
• Defining the Stateflow block update method
• Defining **Output to Simulink** events
• Adding and defining nonlocal events and nonlocal data within the Stateflow chart
• Defining relationships with any external sources

In the following example, the Simulink model consists of a Sine Wave block, a Scope block, and a single Stateflow block, titled `On_off`.
Stateflow Chart Objects

Stateflow charts consist of graphical and nongraphical objects:

To learn how these objects interact, see “How Chart Constructs Interact During Execution” on page 3-6.
Stateflow Hierarchy of Objects

Stateflow machines arrange Stateflow objects in a hierarchy based on containment. That is, one Stateflow object can contain other Stateflow objects.

The highest object in Stateflow hierarchy is the Stateflow machine. This object contains all other Stateflow objects in a Simulink model. The Stateflow machine contains all the charts in a model. In addition, the Stateflow machine for a model can contain its own data.
Similarly, charts can contain state, box, function, data, event, message, transition, junction, and note objects. Continuing with the Stateflow hierarchy, states can contain all these objects as well, including other states. You can represent state hierarchy with superstates and substates.

A transition out of a superstate implies transitions out of any of its active substates. Transitions can cross superstate boundaries to specify a substate destination. If a substate becomes active, its parent superstate also becomes active.

You can organize complex charts by defining a containment structure. A hierarchical design usually reduces the number of transitions and produces neat, manageable charts.

• To manage graphical objects, use the Stateflow Editor.
• To manage nongraphical objects, use the Symbols window or Model Explorer.
Bibliography

Stateflow Chart Notation

- “Overview of Stateflow Objects” on page 2-2
- “Rules for Naming Stateflow Objects” on page 2-4
- “States” on page 2-7
- “State Hierarchy” on page 2-15
- “State Decomposition” on page 2-17
- “Transitions” on page 2-19
- “Transition Connections” on page 2-25
- “Self-Loop Transitions” on page 2-29
- “Inner Transitions” on page 2-31
- “Default Transitions” on page 2-35
- “Connective Junctions” on page 2-39
- “History Junctions” on page 2-46
- “Boxes” on page 2-48
- “When to Use Reusable Functions in Charts” on page 2-49
Overview of Stateflow Objects

In this section...

“Graphical Objects” on page 2-2
“Nongraphical Objects” on page 2-3

Graphical Objects

The following table lists each type of graphical object you can draw in a chart and the toolbar icon to use for drawing the object.

<table>
<thead>
<tr>
<th>Type of Graphical Object</th>
<th>Toolbar Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Transition</td>
<td>Not applicable</td>
</tr>
<tr>
<td>History junction</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Default transition</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Connective junction</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Truth table function</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Graphical function</td>
<td>![Icon]</td>
</tr>
<tr>
<td>MATLAB® function</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Box</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Simulink based state</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
Nongraphical Objects

You can define data, event, and message objects that do not appear graphically in the Stateflow Editor. However, you can see them in the Symbols window and the Model Explorer. See “Use the Model Explorer with Stateflow Objects” on page 31-11.

Data Objects

A Stateflow chart stores and retrieves data that it uses to control its execution. Stateflow data resides in its own workspace, but you can also access data that resides externally in the Simulink model or application that embeds the Stateflow machine. You must define any internal or external data that you use in a Stateflow chart.

Event Objects

An event is a Stateflow object that can trigger a whole Stateflow chart or individual actions in a chart. Because Stateflow charts execute by reacting to events, you specify and program events into your charts to control their execution. You can broadcast events to every object in the scope of the object sending the event, or you can send an event to a specific object. You can define explicit events that you specify directly, or you can define implicit events to take place when certain actions are performed, such as entering a state.

Message Objects

Stateflow message objects are queued objects that can carry data. You can send a message from one Stateflow chart to another to communicate between charts. You can also send local messages within a chart. You define the type of message data. You can view the lifeline of a message in the Sequence Viewer block. For more information, see “How Messages Work in Stateflow Charts” on page 11-2.
Rules for Naming Stateflow Objects

Characters You Can Use

You can name Stateflow objects with any combination of alphanumeric and underscore characters. Names cannot begin with a numeric character or contain embedded spaces.

Restriction on Name Length

Name length should comply with the maximum identifier length enforced by Simulink Coder™ software. You can set the Maximum identifier length parameter. The default is 31 characters and the maximum length you can specify is 256 characters.

Keywords to Avoid When Naming Chart Objects

You cannot use reserved keywords to name chart objects. These keywords are part of the action language syntax.

<table>
<thead>
<tr>
<th>Usage in Action Language Syntax</th>
<th>Keywords</th>
<th>Syntax References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean symbols</td>
<td>• true</td>
<td>“Boolean Symbols, true and false” on page 12-27</td>
</tr>
<tr>
<td></td>
<td>• false</td>
<td></td>
</tr>
<tr>
<td>Change detection</td>
<td>• hasChanged</td>
<td>“Detect Changes in Data Values” on page 12-74</td>
</tr>
<tr>
<td></td>
<td>• hasChangedFrom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• hasChangedTo</td>
<td></td>
</tr>
<tr>
<td>Complex data</td>
<td>• complex</td>
<td>“Define Complex Data Using Operators” on page 22-9</td>
</tr>
<tr>
<td></td>
<td>• imag</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• real</td>
<td></td>
</tr>
<tr>
<td><strong>Usage in Action Language Syntax</strong></td>
<td><strong>Keywords</strong></td>
<td><strong>Syntax References</strong></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Data types</td>
<td>• boolean</td>
<td>“Set Data Properties” on page 9-7</td>
</tr>
<tr>
<td></td>
<td>• double</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• int8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• int16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• int32</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• single</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• uint8</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• uint16</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• uint32</td>
<td></td>
</tr>
<tr>
<td>Data type operations</td>
<td>• cast</td>
<td>“Type Cast Operations” on page 12-24</td>
</tr>
<tr>
<td></td>
<td>• fixdt</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• type</td>
<td></td>
</tr>
<tr>
<td>Explicit events</td>
<td>• send</td>
<td>“Broadcast Events to Synchronize States” on page 12-52</td>
</tr>
<tr>
<td>Implicit events</td>
<td>• change</td>
<td>“Control Chart Execution Using Implicit Events” on page 10-35</td>
</tr>
<tr>
<td></td>
<td>• chg</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• tick</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• wakeup</td>
<td></td>
</tr>
<tr>
<td>Messages</td>
<td>• send</td>
<td>“Stateflow Message Syntax in Charts” on page 11-13</td>
</tr>
<tr>
<td></td>
<td>• forward</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• discard</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• isvalid</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• length</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• receive</td>
<td></td>
</tr>
<tr>
<td>Literal symbols</td>
<td>• inf</td>
<td>“Supported Symbols in Actions” on page 12-27</td>
</tr>
<tr>
<td></td>
<td>• t (C charts only)</td>
<td></td>
</tr>
</tbody>
</table>
### Usage in Action Language Syntax

<table>
<thead>
<tr>
<th>Syntax</th>
<th>Keywords</th>
<th>Syntax References</th>
</tr>
</thead>
</table>
| MATLAB functions and data | • matlab  
• ml | “ml Namespace Operator” on page 12-38 |
| State actions | • bind  
• du  
• during  
• en  
• entry  
• ex  
• exit  
• on | “State Action Types” on page 12-2 |
| State activity | • in | “Check State Activity“ on page 12-86 |
| Temporal logic | • after  
• at  
• before  
• every  
• sec  
• msec  
• usec  
• temporalCount  
• elapsed  
• t  
• duration | “Control Chart Execution Using Temporal Logic” on page 12-55 |
What Is a State?

A state describes an operating mode of a reactive system. In a Stateflow chart, states are used for sequential design to create state transition diagrams.

States can be active or inactive. The activity or inactivity of a state can change depending on events and conditions. The occurrence of an event drives the execution of the state transition diagram by making states become active or inactive. At any point during execution, active and inactive states exist.

State Hierarchy

To manage multilevel state complexity, use hierarchy in your Stateflow chart. With hierarchy, you can represent multiple levels of subcomponents in a system.

State Hierarchy Example

In the following example, three levels of hierarchy appear in the chart. Drawing one state within the boundaries of another state indicates that the inner state is a substate (or child) of the outer state (or superstate). The outer state is the parent of the inner state.
In this example, the chart is the parent of the state Car_done. The state Car_done is the parent state of the Car_made and Car_shipped states. The state Car_made is also the parent of the Parts_assembled and Painted states. You can also say that the states Parts_assembled and Painted are children of the Car_made state.

To represent the Stateflow hierarchy textually, use a slash character (/) to represent the chart and use a period (.) to separate each level in the hierarchy of states. The following list is a textual representation of the hierarchy of objects in the preceding example:

- /Car_done
- /Car_done.Car_made
- /Car_done.Car_shipped
- /Car_done.Car_made.Parts_assembled
- /Car_done.Car_made.Painted

**Objects That a State Can Contain**

States can contain all other Stateflow objects. Stateflow chart notation supports the representation of graphical object hierarchy in Stateflow charts with containment. A state is a *superstate* if it contains other states. A state is a *substate* if it is contained by another state. A state that is neither a superstate nor a substate of another state is a state whose parent is the Stateflow chart itself.
States can also contain nongraphical data, event, and message objects. The hierarchy of this containment appears in the Model Explorer. You define data, event, and message containment by specifying the parent object.

**State Decomposition**

Every state (or chart) has a *decomposition* that dictates what type of substates the state (or chart) can contain. All substates of a superstate must be of the same type as the superstate decomposition. State decomposition can be exclusive (OR) or parallel (AND).

**Exclusive (OR) State Decomposition**

Substates with solid borders indicate exclusive (OR) state decomposition. Use this decomposition to describe operating modes that are mutually exclusive. When a state has exclusive (OR) decomposition, only one substate can be active at a time.

In the following example, either state A or state B can be active. If state A is active, either state A1 or state A2 can be active at a given time.

**Parallel (AND) State Decomposition**

Substates with dashed borders indicate parallel (AND) decomposition. Use this decomposition to describe concurrent operating modes. When a state has parallel (AND) decomposition, all substates are active at the same time.

In the following example, when state A is active, A1 and A2 are both active at the same time.
The activity within parallel states is essentially independent, as demonstrated in the following example.

In the following example, when state A becomes active, both states B and C become active at the same time. When state C becomes active, either state C1 or state C2 can be active.

**State Labels**

The label for a state appears on the top left corner of the state rectangle with the following general format:

```
name/
entry:entry actions
during:during actions
```
exit: exit actions
on event_name: on event_name actions
on message_name: on message_name actions
bind: events

The following example demonstrates the components of a state label.

Each action in the state label appears in the subtopics that follow. For more information on state actions, see:

- “Execution of a Stateflow Chart” on page 3-46 — Describes how and when chart execution occurs.
- “State Action Types” on page 12-2 — Gives more detailed descriptions of each type of state action, entry, during, exit.

**State Name**

A state label starts with the name of the state followed by an optional / character. In the preceding example, the state names are On and Off. Valid state names consist of alphanumeric characters and can include the underscore (_) character. For more information, see “Rules for Naming Stateflow Objects” on page 2-4.
Hierarchy provides some flexibility in naming states. The name that you enter on the state label must be unique when preceded by ancestor states. The name in the Stateflow hierarchy is the text you enter as the label on the state, preceded by the names of parent states separated by periods. Each state can have the same name appear in the label, as long as their full names within the hierarchy are unique. Otherwise, the parser indicates an error.

The following example shows how unique naming of states works.

Each of these states has a unique name because of its location in the chart. The full names for the states in FAN1 and FAN2 are:

- PowerOn.FAN1.On
- PowerOn.FAN1.Off
- PowerOn.FAN2.Off
• PowerOn.FAN2.On
• PowerOn.FAN2.Off

**State Actions**

After the name, you enter optional action statements for the state with a keyword label that identifies the type of action. You can specify none, some, or all of them. The colon after each keyword is required. The slash following the state name is optional as long as it is followed by a carriage return.

For each type of action, you can enter more than one action by separating each action with a carriage return, semicolon, or a comma. You can specify actions for more than one event or message by adding additional on event_name or on message_name lines.

If you enter the name and slash followed directly by actions, the actions are interpreted as entry action(s). This shorthand is useful if you are specifying only entry actions.

**Entry Action**

Preceded by the prefix entry or en for short. In the preceding example, state On has entry action on_count=0. This means that the value of on_count is reset to 0 whenever state On becomes active (entered).

**During Action**

Preceded by the prefix during or du for short. In the preceding label example, state On has two during actions, light_on() and on_count++. These actions are executed whenever state On is already active and any event occurs.

**Exit Action**

Preceded by the prefix exit or ex for short. In the preceding label example, state Off has the exit action light_off(). If the state Off is active, but becomes inactive (exited), this action is executed.

**On Action**

Preceded by the prefix on event_name, or on message_name. In the preceding label example, state On has an on power_outage action. If state On is active and the event power_outage occurs, the action handle_outage() is executed.
**Bind Action**

Preceded by the prefix `bind`. Events bound to a state can only be broadcast by that state or its children.
State Hierarchy

To manage multilevel state complexity, use hierarchy in your Stateflow chart. With hierarchy, you can represent multiple levels of subcomponents in a system.

State Hierarchy Example

In the following example, three levels of hierarchy appear in the chart. Drawing one state within the boundaries of another state indicates that the inner state is a substate (or child) of the outer state (or superstate). The outer state is the parent of the inner state.

In this example, the chart is the parent of the state Car_done. The state Car_done is the parent state of the Car_made and Car_shipped states. The state Car_made is also the parent of the Parts_assembled and Painted states. You can also say that the states Parts_assembled and Painted are children of the Car_made state.

To represent the Stateflow hierarchy textually, use a slash character (/) to represent the chart and use a period (.) to separate each level in the hierarchy of states. The following list is a textual representation of the hierarchy of objects in the preceding example:
Objects That a State Can Contain

States can contain all other Stateflow objects. Stateflow chart notation supports the representation of graphical object hierarchy in Stateflow charts with containment. A state is a superstate if it contains other states. A state is a substate if it is contained by another state. A state that is neither a superstate nor a substate of another state is a state whose parent is the Stateflow chart itself.

States can also contain nongraphical data, event, and message objects. The hierarchy of this containment appears in the Model Explorer. You define data, event, and message containment by specifying the parent object.
State Decomposition

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Exclusive (OR) State Decomposition” on page 2-17</td>
</tr>
<tr>
<td>“Parallel (AND) State Decomposition” on page 2-17</td>
</tr>
</tbody>
</table>

Every state (or chart) has a decomposition that dictates what type of substates the state (or chart) can contain. All substates of a superstate must be of the same type as the superstate decomposition. State decomposition can be exclusive (OR) or parallel (AND).

**Exclusive (OR) State Decomposition**

Substates with solid borders indicate exclusive (OR) state decomposition. Use this decomposition to describe operating modes that are mutually exclusive. When a state has exclusive (OR) decomposition, only one substate can be active at a time.

In the following example, either state A or state B can be active. If state A is active, either state A1 or state A2 can be active at a given time.

**Parallel (AND) State Decomposition**

Substates with dashed borders indicate parallel (AND) decomposition. Use this decomposition to describe concurrent operating modes. When a state has parallel (AND) decomposition, all substates are active at the same time.
In the following example, when state A is active, A1 and A2 are both active at the same time.

The activity within parallel states is essentially independent, as demonstrated in the following example.

In the following example, when state A becomes active, both states B and C become active at the same time. When state C becomes active, either state C1 or state C2 can be active.
Transitions

What Is a Transition?

A transition is a line with an arrowhead that links one graphical object to another. In most cases, a transition represents the passage of the system from one mode (state) object to another. A transition typically connects a source and a destination object. The source object is where the transition begins and the destination object is where the transition ends. The following chart shows a transition from a source state, B, to a destination state, A.

Junctions divide a transition into transition segments. In this case, a full transition consists of the segments taken from the origin to the destination state. Each segment is evaluated in the process of determining the validity of a full transition.

The following example has two segmented transitions: one from state On to state Off, and the other from state On to itself:
A default transition is a special type of transition that has no source object. See “Default Transitions” on page 2-35 for details.

**Transition Hierarchy**

Transitions cannot contain other objects the way that states can. However, transitions are contained by states. The hierarchy for a transition is described in terms of its parent, source, and destination states. The parent is the lowest level that contains the source and destination of the transition. Consider the parents for the transitions in the following example:
The following table resolves the parentage of each transition in the preceding example. The / character represents the chart. Each level in the hierarchy of states is separated by the period (.) character.

<table>
<thead>
<tr>
<th>Transition Label</th>
<th>Transition Parent</th>
<th>Transition Source</th>
<th>Transition Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>switch_off</td>
<td>/</td>
<td>/Power_on.Low.Heat</td>
<td>/Power_off</td>
</tr>
<tr>
<td>switch_high</td>
<td>/Power_on</td>
<td>/Power_on.Low.Heat</td>
<td>/Power_on.High</td>
</tr>
<tr>
<td>switch_cold</td>
<td>/Power_on.Low</td>
<td>/Power_on.Low.Heat</td>
<td>/Power_on.Low.Cold</td>
</tr>
</tbody>
</table>

**Transition Label Notation**

A *transition label* can consist of an event or message, a condition, a condition action, and a transition action. Each part of the label is optional. The ? character is the default transition label. Transition labels have this overall format:

`event_or_message[condition]{condition_action}/transition_action`

This example illustrates the parts of a transition label.
**Event or Message Trigger**

Specifies an event or message that causes the transition to occur when the condition is true. Specify multiple events using the OR logical operator (|). Specifying an event or message is optional. The absence of an event or message indicates that the transition takes place on the occurrence of any event. For more information, see “How Events Work in Stateflow Charts” on page 10-2 and “How Messages Work in Stateflow Charts” on page 11-2.

In the previous example, the broadcast of event $E$ triggers the transition from $On$ to $Off$ if the condition $[off\_count==0]$ is true.

**Condition**

Specifies a Boolean expression that, when true, validates a transition for the specified event or message trigger. Enclose the condition in square brackets ([ ]). If no condition is specified, an implied condition evaluates to true. For more information, see “Conditions” on page 12-8.

In the previous example, when the event $E$ occurs, the condition $[off\_count==0]$ must evaluate as true for the transition from $On$ to $Off$ to be valid.

**Condition Action**

Executes after the condition for the transition is evaluated as true, but before the transition to the destination is determined to be valid. Enclose the condition action in curly braces ({}), following the condition. For more information, see “Condition Action Behavior” on page B-10.
In the previous example, if the event \( E \) occurs and the condition \([\text{off\_count}==0]\) is true, then the condition action \( \{\text{off\_count} = \text{off\_count} + 1\} \) is immediately executed.

**Transition Action**

Executes after the transition to the destination is determined to be valid. If the transition consists of multiple segments, then the transition action is executed when the entire transition path to the final destination is determined to be valid. Transition actions occur after the exit actions of the source state and before the entry actions of the destination state. Precede the transition action with a `/`. For more information, see “Condition and Transition Action Behavior” on page B-11.

In the preceding example, if the event \( E \) occurs and the condition \([\text{off\_count}==0]\) is true, then the transition action \( \{\text{Light\_off()}\} \) is executed when the transition from \( \text{On} \) to \( \text{Off} \) is determined to be valid. The transition action occurs after \( \text{On} \) becomes inactive, but before \( \text{Off} \) becomes active.

**Valid Transitions**

Usually, a transition is valid when the source state of the transition is active and the transition label is valid. Default transitions are different because there is no source state. Validity of a default transition to a substate is evaluated when there is a transition to its superstate, assuming the superstate is active. This labeling criterion applies to both default transitions and general case transitions. The following table lists possible combinations of valid transition labels.

<table>
<thead>
<tr>
<th>Transition Label</th>
<th>Is Valid If...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event only</td>
<td>That event occurs</td>
</tr>
<tr>
<td>Event and condition</td>
<td>That event occurs and the condition is true</td>
</tr>
<tr>
<td>Message only</td>
<td>That message occurs</td>
</tr>
<tr>
<td>Message and condition</td>
<td>That message occurs and the condition is true</td>
</tr>
<tr>
<td>Condition only</td>
<td>Any event occurs and the condition is true</td>
</tr>
<tr>
<td>Action only</td>
<td>Any event occurs</td>
</tr>
<tr>
<td>Not specified</td>
<td>Any event occurs</td>
</tr>
</tbody>
</table>
See Also

More About
- “Default Transitions” on page 2-35
- “Transition Action Types” on page 12-7
- “Control Chart Execution Using Condition Actions” on page B-10
- “How Events Work in Stateflow Charts” on page 10-2
- “How Messages Work in Stateflow Charts” on page 11-2

See Also
Transition Connections

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Transitions to and from Exclusive (OR) States” on page 2-25</td>
</tr>
<tr>
<td>“Transitions to and from Junctions” on page 2-25</td>
</tr>
<tr>
<td>“Transitions to and from Exclusive (OR) Superstates” on page 2-26</td>
</tr>
<tr>
<td>“Transitions to and from Substates” on page 2-27</td>
</tr>
</tbody>
</table>

Transitions to and from Exclusive (OR) States

This example shows simple transitions to and from exclusive (OR) states.

The following transition... | Is valid when...
---|---
B to A | State B is active and the event E1 occurs.
A1 to A2 | State A1 is active and event E2 occurs.

See “Transition to and from Exclusive (OR) States” on page B-4 for more information on the semantics of this notation.

Transitions to and from Junctions

The following chart shows transitions to and from connective junctions.
The chart uses temporal logic to determine when the input \( u \) equals 1.

<table>
<thead>
<tr>
<th>If the input equals 1...</th>
<th>A transition occurs from...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before ( t = 2 )</td>
<td>Start to Fast</td>
</tr>
<tr>
<td>Between ( t = 2 ) and ( t = 5 )</td>
<td>Start to Good</td>
</tr>
<tr>
<td>After ( t = 5 )</td>
<td>Start to Slow</td>
</tr>
</tbody>
</table>

For more information about temporal logic, see “Control Chart Execution Using Temporal Logic” on page 12-55. For more information on the semantics of this notation, see “Transition from a Common Source to Multiple Destinations” on page B-35.

**Transitions to and from Exclusive (OR) Superstates**

This example shows transitions to and from an exclusive (OR) superstate and the use of a default transition.
The chart has two states at the highest level in the hierarchy, `Power_off` and `Power_on`. By default, `Power_off` is active. The event `Switch` toggles the system between the `Power_off` and `Power_on` states. `Power_on` has three substates: `First`, `Second`, and `Third`. By default, when `Power_on` becomes active, `First` also becomes active. When `Shift` equals 1, the system transitions from `First` to `Second`, `Second` to `Third`, `Third` to `First`, for each occurrence of the event `Switch`, and then the pattern repeats.

For more information on the semantics of this notation, see “Control Chart Execution Using Default Transitions” on page B-16.

**Transitions to and from Substates**

The following example shows transitions to and from exclusive (OR) substates.
For details on how this chart works, see “Debounce Signals with Fault Detection” on page 25-7. For information on the semantics of this notation, see “Transition from a Substate to a Substate with Events” on page B-8.
Self-Loop Transitions

A transition that originates from and terminates on the same state is a self-loop transition. The following chart contains four self-loop transitions:
See these sections for more information about the semantics of this notation:

- “Self-Loop Transition” on page B-31
- “For-Loop Construct” on page B-32
Inner Transitions

An *inner transition* is a transition that does not exit the source state. Inner transitions are powerful when defined for superstates with exclusive (OR) decomposition. Use of inner transitions can greatly simplify a Stateflow chart, as shown by the following examples:

- “Before Using an Inner Transition” on page 2-31
- “After Using an Inner Transition to a Connective Junction” on page 2-32
- “Using an Inner Transition to a History Junction” on page 2-33

**Before Using an Inner Transition**

This chart is an example of how you can simplify logic using an inner transition.
Any event occurs and awakens the Stateflow chart. The default transition to the connective junction is valid. The destination of the transition is determined by \([c_1 > 0]\) and \([c_2 > 0]\). If \([c_1 > 0]\) is true, the transition to A1 is true. If \([c_2 > 0]\) is true, the transition to A2 is valid. If neither \([c_1 > 0]\) nor \([c_2 > 0]\) is true, the transition to A3 is valid. The transitions among A1, A2, and A3 are determined by \(E\), \([c_1 > 0]\), and \([c_2 > 0]\).

**After Using an Inner Transition to a Connective Junction**

This example simplifies the preceding example using an inner transition to a connective junction.

An event occurs and awakens the chart. The default transition to the connective junction is valid. The destination of the transitions is determined by \([c_1 > 0]\) and \([c_2 > 0]\).

You can simplify the chart by using an inner transition in place of the transitions among all the states in the original example. If state A is already active, the inner transition is used to reevaluate which of the substates of state A is to be active. When event E occurs, the inner transition is potentially valid. If \([c_1 > 0]\) is true, the transition to A1 is valid. If \([c_2 > 0]\) is true, the transition to A2 is valid. If neither \([c_1 > 0]\) nor \([c_2 > 0]\) is true, the transition to A3 is valid. This chart design is simpler than the previous one.
**Note** When you use an inner transition to a connective junction, an active substate can exit and reenter when the transition condition for that substate is valid. For example, if substate $A_1$ is active and $[c_1 > 0]$ is true, the transition to $A_1$ is valid. In this case:

1. Exit actions for $A_1$ execute and complete.
2. $A_1$ becomes inactive.
3. $A_1$ becomes active.
4. Entry actions for $A_1$ execute and complete.

See “Process the First Event with an Inner Transition to a Connective Junction” on page B-25 for more information on the semantics of this notation.

**Using an Inner Transition to a History Junction**

This example shows an inner transition to a history junction.

State $Power_{on}.High$ is initially active. When event $Reset$ occurs, the inner transition to the history junction is valid. Because the inner transition is valid, the currently active state, $Power_{on}.High$, is exited. When the inner transition to the history junction is
processed, the last active state, \texttt{Power\_on.High}, becomes active (is reentered). If \texttt{Power\_on.Low} was active under the same circumstances, \texttt{Power\_on.Low} would be exited and reentered as a result. The inner transition in this example is equivalent to drawing an outer self-loop transition on both \texttt{Power\_on.Low} and \texttt{Power\_on.High}.

See “Use of History Junctions Example” on page 2-46 for another example using a history junction.

See “Inner Transition to a History Junction” on page B-27 for more information on the semantics of this notation.
Default Transitions

What Is a Default Transition?

A default transition specifies which exclusive (OR) state to enter when there is ambiguity among two or more neighboring exclusive (OR) states. A default transition has a destination but no source object. For example, a default transition specifies which substate of a superstate with exclusive (OR) decomposition the system enters by default, in the absence of any other information, such as a history junction. A default transition can also specify that a junction should be entered by default.

Drawing Default Transitions

Click the Default transition button in the toolbar, and click a location in the drawing area close to the state or junction you want to be the destination for the default transition. Drag the mouse to the destination object to attach the default transition. In some cases, it is useful to label default transitions.

A common programming mistake is to create multiple exclusive (OR) states without a default transition. In the absence of the default transition, there is no indication of which state becomes active by default. Note that this error is flagged when you simulate the model with the State Inconsistencies option enabled.

Label Default Transitions

You can label default transitions as you would other transitions. For example, you might want to specify that one state or another should become active depending upon the event that has occurred. In another situation, you might want to have specific actions take place that are dependent upon the destination of the transition.
Tip When labeling default transitions, ensure that there is at least one valid default transition. Otherwise, a chart can transition into an inconsistent state.

Default Transition Examples

The following examples show the use of default transitions in Stateflow charts:

- “Default Transition to a State Example” on page 2-36
- “Default Transition to a Junction Example” on page 2-37
- “Default Transition with a Label Example” on page 2-37

Default Transition to a State Example

This example shows a default transition to a state.
Without the default transition to state `PowerOff`, when the Stateflow chart wakes up, none of the states becomes active. A state inconsistency error is reported at run time.

See “Control Chart Execution Using Default Transitions” on page B-16 for information on the semantics of this notation.

**Default Transition to a Junction Example**

This example shows a default transition to a connective junction.

The default transition to the connective junction defines that upon entering the chart, the destination depends on the condition of each transition segment.

See “Default Transition to a Junction” on page B-17 for information on the semantics of this notation.

**Default Transition with a Label Example**

This example shows a default transition with a label.
When the chart wakes up, the data \( p \) and \( v \) initialize to 10 and 15, respectively.

See “Labeled Default Transitions” on page B-19 for more information on the semantics of this notation.
Connective Junctions

What Is a Connective Junction?

The connective junction enables representation of different possible transition paths for a single transition. Connective junctions are used to help represent the following:

- Variations of an if-then-else decision construct, by specifying conditions on some or all of the outgoing transitions from the connective junction
- A self-loop transition back to the source state if none of the outgoing transitions is valid
- Variations of a for loop construct, by having a self-loop transition from the connective junction back to itself
- Transitions from a common source to multiple destinations
- Transitions from multiple sources to a common destination
- Transitions from a source to a destination based on common events

Note An event cannot trigger a transition from a connective junction to a destination state.

See “Use Connective Junctions to Represent Multiple Paths” on page B-29 for a summary of the semantics of connective junctions.

Flow Chart Notation with Connective Junctions

Flow chart notation uses connective junctions to represent common code structures like for loops and if-then-else constructs without the use of states. And by reducing the number of states in your Stateflow charts, flow chart notation produces efficient simulation and generated code that helps optimize memory use.

Flow chart notation uses combinations of the following:

- Transitions to and from connective junctions
- Self-loops to connective junctions
- Inner transitions to connective junctions
Flow chart notation, states, and state-to-state transitions coexist in the same Stateflow chart. The key to representing flow chart notation is in the labeling of transitions, as shown in the following examples.

**Connective Junction with All Conditions Specified Example**

```
MATLAB Function
y = expenses(x)

Check_in

Front_desk

click_in

Checked_in on room_service:
  service = service + 1;
  fee = expenses(service);

{service=0;}

[room_type == 1] {fee = 1500;}

[room_type == 2] {fee = 1000;}

[room_type == 3] {fee = 500;}

Executive_suite

Bedroom

Dining_area

Family_suite

Master_bedroom

Second_bedroom

Single_room

fire_alarm

all_clear

Waiting_area
```
A transition from the `Front_desk` state to a connective junction is labeled by the `check_in` event. Transitions from the connective junction to the destination states are labeled with conditions. If `Front_desk` is active when `check_in` occurs, the transition from `Front_desk` to the connective junction occurs first. The transition from the connective junction to a destination state depends on which of the `room_type` conditions is true. If none of the conditions is true, no transition occurs and `Front_desk` remains active.

For more information about this chart, see “Phases of Chart Execution” on page 3-10. For more information on the semantics of this notation, see “If-Then-Else Decision Construct” on page B-30.

**Connective Junction with One Unconditional Transition Example**

The chart uses temporal logic to determine when the input `u` equals 1.

<table>
<thead>
<tr>
<th>If the input equals 1...</th>
<th>A transition occurs from...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before <code>t = 2</code></td>
<td>Start to Fast</td>
</tr>
<tr>
<td>Between <code>t = 2</code> and <code>t = 5</code></td>
<td>Start to Good</td>
</tr>
<tr>
<td><code>After t = 5</code></td>
<td>Start to Slow</td>
</tr>
</tbody>
</table>

For more information about temporal logic, see “Control Chart Execution Using Temporal Logic” on page 12-55. For more information on the semantics of this notation, see “If-Then-Else Decision Construct” on page B-30.

**Connective Junction and For Loops Example**

This example shows a combination of flow chart notation and state transition notation. Self-loop transitions to connective junctions can represent `for` loop constructs. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
See “For-Loop Construct” on page B-32 for information on the semantics of this notation.

**Flow Chart Notation Example**

This example shows the use of flow chart notation. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
See “Flow Chart Notation” on page B-34 for information on the semantics of this notation.

**Connective Junction from a Common Source to Multiple Destinations Example**

This example shows transition segments from a common source to multiple conditional destinations using a connective junction. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

See “Transition from a Common Source to Multiple Destinations” on page B-35 for information on the semantics of this notation.

**Connective Junction Common Events Example**

This example shows transition segments from multiple sources to a single destination based on the same event using a connective junction.
See “Transition from a Source to a Destination Based on a Common Event” on page B-39 for information on the semantics of this notation.

**Change Connective Junction Size**

1. Select one or more connective junctions.
2. Right-click one of the selected junctions and select **Junction Size** from the drop-down menu.
3. From the menu, select a junction size.

**Modify Connective Junction Properties**

1. Right-click a connective junction and select **Properties** from the drop-down menu.
2. In the **Connective Junction** dialog box, edit the fields in the dialog box according to your requirements.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Parent</strong></td>
<td>Parent of the connective junction (read-only). To bring the parent to the foreground, click the hypertext link.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Textual description or comment.</td>
</tr>
<tr>
<td><strong>Document link</strong></td>
<td>Link to other information. Enter a URL address or a general MATLAB command. Examples are <a href="http://www.mathworks.com">www.mathworks.com</a>, mailto:email_address, and edit/spec/data/speed.txt.</td>
</tr>
</tbody>
</table>
To save changes, click **Apply**.
History Junctions

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“What Is a History Junction?” on page 2-46</td>
</tr>
<tr>
<td>“History Junctions and Inner Transitions” on page 2-47</td>
</tr>
</tbody>
</table>

What Is a History Junction?

A history junction represents historical decision points in the Stateflow chart. The decision points are based on historical data relative to state activity. Placing a history junction in a superstate indicates that historical state activity information is used to determine the next state to become active. The history junction applies only to the level of the hierarchy in which it appears.

Use of History Junctions Example

The following example uses a history junction:

Superstate `Power_on` has a history junction and contains two substates. If state `Power_off` is active and event `switch_on` occurs, the system can enter `Power_on.Low` or `Power_on.High`. The first time superstate `Power_on` is entered, substate `Power_on.Low` is entered because it has a default transition. At some point afterward, if state `Power_on.High` is active and event `switch_off` occurs, superstate `Power_on` is
exited and state Power_off becomes active. Then event switch_on occurs. Because Power_on.High was the last active substate, it becomes active again. After the first time Power_on becomes active, the history junction determines whether to enter Power_on.Low or Power_on.High.

See “Default Transition and a History Junction” on page B-18 for more information on the semantics of this notation.

**History Junctions and Inner Transitions**

By specifying an inner transition to a history junction, you can specify that, based on a specified event or condition, the active state is to be exited and then immediately reentered.

See “Using an Inner Transition to a History Junction” on page 2-33 for an example of this notation.

See “Inner Transition to a History Junction” on page B-27 for more information on the semantics of this notation.
Boxes

What Is a Box?

A box is a graphical object that organizes other objects in your chart, such as functions and states.

Example of Using a Box

In this example, the box Heater groups together related states Off and On.

For rules of using boxes and other examples, see “Group Chart Objects Using Boxes” on page 8-35.
When to Use Reusable Functions in Charts

State actions and transition conditions can be complicated enough that defining them inline on the state or transition is not feasible. In this case, express the conditions or actions using one of the following types of Stateflow functions:

- Flow chart — Encapsulate flow charts containing if-then-else, switch-case, for, while, or do-while patterns.
- MATLAB — Write matrix-oriented algorithms; call MATLAB functions for data analysis and visualization.
- Simulink — Call Simulink function-call subsystems directly to streamline design and improve readability.
- Truth table — Represent combinational logic for decision-making applications such as fault detection and mode switching.

Use the function format that is most natural for the type of calculation required in the state action or transition condition.

If the four standard types of Stateflow functions do not work, you can write your own C or C++ code for integration with your chart. For more information about custom code integration, see “Share Data Using Custom C Code” on page 29-26.
Stateflow Semantics

• “Stateflow Semantics” on page 3-2
• “How Chart Constructs Interact During Execution” on page 3-6
• “Modeling Guidelines for Stateflow Charts” on page 3-26
• “Modeling Rules That Stateflow Detects During Edit Time” on page 3-29
• “Types of Chart Execution” on page 3-43
• “Execution of a Stateflow Chart” on page 3-46
• “Enter a Chart or State” on page 3-52
• “Exit a State” on page 3-60
• “Evaluate Transitions” on page 3-65
• “Super Step Semantics” on page 3-75
• “How Events Drive Chart Execution” on page 3-83
• “Process for Grouping and Executing Transitions” on page 3-86
• “Execution Order for Parallel States” on page 3-89
• “Early Return Logic for Event Broadcasts” on page 3-97
Stateflow Semantics

In Stateflow, semantics describe the execution behavior of your Stateflow chart. Various factors can affect how your chart executes, including:

- Explicit or implicit ordering of states
- Transition ordering between states
- Events sent by parallel or superstates

As you build your chart, you expect it to behave in a certain way. By knowing how these factors affect your chart, you can create a chart that behaves with intentional interaction of the graphical and nongraphical constructs. Graphical and nongraphical constructs are the building blocks for all Stateflow charts.

Stateflow Constructs

Chart contracts are the building blocks of Stateflow charts. These chart constructs can be categorized as either graphical or nongraphical. Graphical constructs consist of objects that appear graphically in a chart. Nongraphical constructs appear textually in a chart and often refer to data, events, and messages. This chart shows a variety of both graphical and nongraphical constructs.
Graphical Constructs

To build graphical constructs, use the object palette in the Stateflow Editor (see “Stateflow Editor Operations” on page 4-27).

<table>
<thead>
<tr>
<th>Graphical Constructs</th>
<th>Types</th>
<th>References</th>
</tr>
</thead>
</table>
| Flow charts          | • Decision logic patterns  
                       • Loop logic patterns | “Flow Charts in Stateflow” on page 5-2 |
| Functions            | • Graphical functions  
                       • MATLAB functions  
                       • Truth table functions  
                       • Simulink functions | • “What Is a Graphical Function?” on page 8-26  
                       • “MATLAB Functions in a Stateflow Chart” on page 27-8  
                       • “What Is a Truth Table?” on page 26-2  
                       • “Simulink Functions in Stateflow” on page 28-2 |
| Junctions            | • Connective junctions  
                       • History junctions | • “Connective Junctions” on page 2-39  
                       • “History Junctions” on page 2-46 |
## Graphical Constructs

<table>
<thead>
<tr>
<th>States</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>States</td>
<td>• States with exclusive (OR) decomposition</td>
</tr>
<tr>
<td></td>
<td>• States with parallel (AND) decomposition</td>
</tr>
<tr>
<td></td>
<td>• Substates and superstates</td>
</tr>
<tr>
<td></td>
<td>• “Exclusive (OR) State Decomposition” on page 2-9</td>
</tr>
<tr>
<td></td>
<td>• “Parallel (AND) State Decomposition” on page 2-9</td>
</tr>
<tr>
<td></td>
<td>• “Create Substates and Superstates” on page 4-7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transitions</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transitions</td>
<td>• Default transitions</td>
</tr>
<tr>
<td></td>
<td>• Object-to-object transitions</td>
</tr>
<tr>
<td></td>
<td>• Inner transitions</td>
</tr>
<tr>
<td></td>
<td>• Self-loop transitions</td>
</tr>
<tr>
<td></td>
<td>• “Default Transitions” on page 2-35</td>
</tr>
<tr>
<td></td>
<td>• “Transition Connections” on page 2-25</td>
</tr>
</tbody>
</table>

## Nongraphical Constructs

You create nongraphical constructs textually in your chart. See “Add Stateflow Data” on page 9-2, “Define Events” on page 10-5, and “Define Messages in a Stateflow Chart” on page 11-26 for details. Examples of nongraphical constructs include:

<table>
<thead>
<tr>
<th>Chart Construct</th>
<th>Description</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition</td>
<td>Boolean expression that specifies that a transition path is valid if the expression is true; part of a transition label</td>
<td>“Transition Label Notation” on page 2-21 and “Conditions” on page 12-8</td>
</tr>
<tr>
<td>Condition action</td>
<td>Action that executes as soon as the condition evaluates to true; part of a transition label</td>
<td>“Transition Label Notation” on page 2-21 and “Condition Actions” on page 12-9</td>
</tr>
<tr>
<td>State actions</td>
<td>Expressions that specify actions to take when a state is active, such as initializing or updating data; part of a state label</td>
<td>“State Labels” on page 2-10 and “State Action Types” on page 12-2</td>
</tr>
<tr>
<td>Function calls</td>
<td>Expression used to activate a specific function within a chart.</td>
<td>“MATLAB Functions in a Chart” on page 27-2 and “Simulink Functions in Stateflow” on page 28-2</td>
</tr>
<tr>
<td>Chart Construct</td>
<td>Description</td>
<td>Reference</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------</td>
</tr>
<tr>
<td>Temporal logic statements</td>
<td>Operators that are used to control chart actions.</td>
<td>“Control Chart Execution Using Temporal Logic” on page 12-55</td>
</tr>
</tbody>
</table>

**See Also**

**More About**
- “Graphical Objects” on page 2-2
- “Nongraphical Objects” on page 2-3
- “Types of Chart Execution” on page 3-43
How Chart Constructs Interact During Execution

During execution, chart constructs interact with each other to simulate real-world behavior. In the following model, different chart constructs are shown and their interactions are explained.

Overview of the Example Model

The example model shows how common graphical and nongraphical constructs in a chart interact during execution. These constructs include:

- Conditions and condition actions
- Exclusive (OR) states
- Flow charts
- Function calls
- History junctions
- Parallel (AND) states
- State actions
- Transitions guarded by input events

For details of the chart semantics, see “Phases of Chart Execution” on page 3-10.

Model of the Check-In Process for a Hotel

This example uses the hotel check-in process to explain Stateflow chart semantics. To open the model, type sf_semantics_hotel_checkin at the MATLAB command prompt.

The model consists of four Manual Switch blocks, one Mux block, one Multiport Switch block, a Hotel chart, and a Display block.
The model uses this block... | To... | Because...
---|---|---
Manual Switch | Enable toggling between two settings during simulation without having to pause or restart. | During simulation, you can interactively trigger the chart by sending one of these input events:
- Checking in to a hotel
- Calling room service
- Triggering a fire alarm
- Sending an all-clear signal after a fire alarm
The model uses this block... | To... | Because...
---|---|---
Mux | Combine multiple input signals into a vector. | A chart can support multiple input events only if they connect to the trigger port of a chart as a vector of inputs.
Multiport Switch | Enable selection among more than two inputs. | This block provides a value for the chart input data `room_type`, where each room type corresponds to a number (1, 2, or 3).
A Manual Switch block cannot support more than two inputs, but a Multiport Switch block can.
Display | Show up-to-date numerical value for input signal. | During simulation, any change to the chart output data `fee` appears in the display.

The Hotel chart contains graphical constructs, such as states and history junctions, and nongraphical constructs, such as conditions and condition actions.
How Chart Constructs Interact During Execution

For a mapping of constructs to their locations in the chart, see “Stateflow Constructs” on page 3-2.
How the Chart Interacts with Simulink Blocks

Chart Initialization

When simulation starts, the chart wakes up and executes its default transitions because the Execute (enter) Chart At Initialization option is on (see “Execution of a Chart at Initialization” on page 3-44). Then the chart goes to sleep.

Note If this option is off, the chart does not wake up until you toggle one of the Manual Switch blocks. You can verify the setting for this option in the Chart properties dialog box. Right-click inside the top level of the chart and select Properties from the context menu.

Chart Interaction with Other Blocks

The chart wakes up again only when an edge-triggered input event occurs: check_in, room_service, fire_alarm, or all_clear. When you toggle a Manual Switch block for an input event during simulation, the chart detects a rising or falling edge and wakes up. While the chart is awake:

• The Multiport Switch block provides a value for the chart input data room_type.
• The Display block shows any change in value for the chart output data fee.

Chart Inactivity

After completing all possible phases of execution, the chart goes back to sleep.

Phases of Chart Execution

The following sections explain chart execution for each shaded region of the Hotel chart.
Phase: Chart Initialization

This section describes what happens in the Front_desk state just after the chart wakes up.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Hotel Scenario</th>
<th>Chart Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Your first stop is at the front desk of the hotel.</td>
<td>At the chart level, the default transition to Check_in occurs, making that state active. Then, the default transition to Front_desk occurs, making that state active. For reference, see “Enter a Chart or State” on page 3-52.</td>
</tr>
</tbody>
</table>
### Stage 2
**Hotel Scenario:** You leave the front desk after checking in to the hotel.

**Chart Behavior:** The `check_in` event guards the outgoing transition from `Front_desk`. When the chart receives an event broadcast for `check_in`, the transition becomes valid. For reference, see “How Charts Process Events” on page 3-84.

### Stage 3
**Hotel Scenario:** Just before you leave the front desk, you pick up your bags to move to your room.

**Chart Behavior:** Just before the transition occurs, the exit action of `Front_desk` sets the `move_bags` local data to 1. Then, `Front_desk` becomes inactive. For reference, see “Exit a State” on page 3-60.

---

---

**Modeling Guidelines for Chart Initialization.** The following guidelines apply to chart initialization.

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
</table>
| Use exclusive (OR) decomposition when no two states at a level of the hierarchy can be active at the same time. | This guideline ensures proper chart execution. For example, `Check_in` and `Waiting_area` are exclusive (OR) states, because you cannot be inside and outside the hotel at the same time. | • “State Decomposition” on page 2-9  
• “Specify Substate Decomposition” on page 4-9 |
| Use a default transition to mark the first state to become active among exclusive (OR) states. | This guideline prevents state inconsistency errors during chart execution. | • “Default Transitions” on page 2-35  
• “State Inconsistencies in a Chart” on page 30-26 |
| Use events, instead of conditions, to guard transitions that depend on occurrences without inherent numerical value. | Since you cannot easily quantify the numerical value of checking into a hotel, model such an occurrence as an event. | • “Activate a Stateflow Chart Using Input Events” on page 10-9 |
### Modeling Guideline

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use an exit action to execute a statement once, just before a state becomes inactive.</td>
<td>Other types of state actions execute differently and do not apply:</td>
<td>• “State Action Types” on page 12-2</td>
</tr>
<tr>
<td></td>
<td>• Entry actions execute once, just after a state becomes active.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• During actions execute at every time step (except the first time step after a state becomes active). Execution continues as long as the chart remains in that state and no valid outgoing transitions exist.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• On <code>event_name</code> actions execute only after receiving an event broadcast.</td>
<td></td>
</tr>
</tbody>
</table>

**Phase: Evaluation of Outgoing Transitions from a Single Junction**

This section describes what happens after exiting the `Front_desk` state: the evaluation of a group of outgoing transitions from a single junction.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Hotel Scenario</th>
<th>Chart Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>You can move to one of three types of rooms.</td>
<td>After the check_in event triggers a transition out of Front_desk, three transition paths are available based on the type of room you select with the Multiport Switch block. Transition testing occurs based on the priority you assign to each path. For reference, see “Order of Execution for a Set of Flow Charts” on page 3-87.</td>
</tr>
<tr>
<td>2</td>
<td>If you choose an executive suite, the base fee is 1500.</td>
<td>If the room_type input data equals 1, the top transition is valid. If this condition is true, the condition action executes by setting the fee output data to 1500. <strong>Note</strong> If the top transition is not valid, control flow backtracks to the central junction so that testing of the next transition can occur. This type of backtracking is intentional. To learn about unintentional backtracking and how to avoid it, see “Backtrack in Flow Charts” on page B-39 and “Best Practices for Creating Flow Charts” on page 5-3.</td>
</tr>
<tr>
<td>3</td>
<td>If you choose a family suite, the base fee is 1000.</td>
<td>If room_type equals 2, the middle transition is valid. If this condition is true, the condition action executes by setting fee to 1000.</td>
</tr>
<tr>
<td>4</td>
<td>If you choose a single room, the base fee is 500.</td>
<td>If room_type equals 3, the bottom transition is valid. If this condition is true, the condition action executes by setting fee to 500.</td>
</tr>
</tbody>
</table>
What happens if `room_type` has a value other than 1, 2, or 3?

Because the Multiport Switch block outputs only 1, 2, or 3, `room_type` cannot have any other values. However, if `room_type` has a value other than 1, 2, or 3, the chart stays in the `Front_desk` state. This behavior applies because no transition path out of that state is valid.

**Modeling Guidelines for Evaluation of Outgoing Transitions.** The following guidelines apply to transition syntax.

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use conditions, instead of events, to guard transitions that depend on occurrences with numerical value.</td>
<td>Because you can quantify a type of hotel room numerically, express the choice of room type as a condition.</td>
<td>“Flow Charts in Stateflow” on page 5-2</td>
</tr>
<tr>
<td>Use condition actions instead of transition actions whenever possible.</td>
<td>Condition actions execute as soon as the condition evaluates to true. Transition actions do not execute until after the transition path is complete, to a terminating junction or a state. Unless an execution delay is necessary, use condition actions instead of transition actions.</td>
<td>“Transition Action Types” on page 12-7</td>
</tr>
<tr>
<td>Use explicit ordering to control the testing order of a group of outgoing transitions.</td>
<td>You can specify <em>explicit</em> or <em>implicit</em> ordering of transitions. By default, a chart uses explicit ordering. If you switch to implicit ordering, the transition testing order can change when graphical objects move.</td>
<td>“Transition Evaluation Order” on page 3-67</td>
</tr>
</tbody>
</table>

**Phase: Execution of State Actions for a Superstate**

This section describes what happens after you enter the `Checked_in` state, regardless of which substate becomes active.
Stage | Hotel Scenario | Chart Behavior
--- | --- | ---
1 | After reaching your desired room, you finish moving your bags. | The entry action executes by setting the move_bags local data to 0.
2 | If you order room service, your hotel bill increases by a constant amount. | If the chart receives an event broadcast for room_service, these actions occur:
   1. The counter for the service local data increments by 1.
   2. A function call to expenses occurs, which returns the value of the hotel bill stored by the fee output data.

For reference, see “How Charts Process Events” on page 3-84.

**Modeling Guidelines for Execution of State Actions.** The following guidelines apply to state actions.

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
</table>
| Use an entry action to execute a statement once, right after a state becomes active. | Other types of state actions execute differently and do not apply:
   • During actions execute at every time step until there is a valid transition out of the state. | “State Action Types” on page 12-2 |
**Modeling Guideline**

<table>
<thead>
<tr>
<th>Use an On <code>event_name</code> or On <code>message_name</code> action to execute a statement only after receiving an event broadcast or a message.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Why This Guideline Applies</strong></td>
</tr>
<tr>
<td>• Exit actions execute once, just before a state becomes inactive.</td>
</tr>
<tr>
<td><strong>Reference</strong></td>
</tr>
<tr>
<td>“Create Substates and Superstates” on page 4-7</td>
</tr>
</tbody>
</table>

**Phase: Function Call from a State Action**

This part of the chart describes how you can perform function calls while a state is active.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Hotel Scenario</th>
<th>Chart Behavior</th>
</tr>
</thead>
</table>
| 1     | Based on your room type and the total number of room service requests, you can track your hotel bill. | expenses is a MATLAB function that takes the total number of room service requests as an input and returns the current hotel bill as an output. If you double-click the function box, you see this script in the function editor:  
function y = expenses(x)  
if (room_type == 1)  
y = 1500 + (x*50);  
else  
  if (room_type == 2)  
    y = 1000 + (x*25);  
  else  
    y = 500 + (x*5);  
  end  
end |}

**Modeling Guidelines for Function Calls.** The following guidelines apply to function calls.

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use MATLAB functions for performing numerical computations in a chart.</td>
<td>MATLAB functions are better at handling numerical computations than graphical functions, truth tables, or Simulink functions.</td>
<td>“MATLAB Functions in a Chart” on page 27-2</td>
</tr>
<tr>
<td>Use descriptive names in function signatures.</td>
<td>Descriptive function names enhance readability of chart objects.</td>
<td></td>
</tr>
</tbody>
</table>

**Phase: Execution of State with Exclusive Substates**

This part of the chart shows how a state with exclusive (OR) decomposition executes.
### Stage 1

When you reach the executive suite, you enter the bedroom first.

**Note** The executive suite has separate bedroom and dining areas. Therefore, you can be in only one area of the suite at any time.

When the condition `room_type == 1` is true, the condition action `fee = 1500` executes. Completion of that transition path triggers these state initialization actions:

1. `Checked_in` becomes active and executes its entry action.
2. `Executive_suite` becomes active.
3. The default transition to `Bedroom` occurs, making that state active.

For reference, see “Enter a Chart or State” on page 3-52.

### Stage 2

When you order room service, you enter the dining area to eat.

When the `room_service` event occurs, the transition from `Bedroom` to `Dining_area` occurs.

### Stage 3

When you want the food removed from the dining area, you order room service again and then return to the bedroom.

When the `room_service` event occurs, the transition from `Dining_area` to `Bedroom` occurs.
If you leave the executive suite because of a fire alarm, you return to your previous room after the all-clear signal. If a transition out of Executive_suite occurs, the history junction records the last active substate, Bedroom or Dining_area. For details on how this transition can occur, see “Phase: Events Guard Transitions Between States” on page 3-23.

**Modeling Guidelines for Execution of Exclusive (OR) States.** The following guidelines apply to exclusive (OR) states.

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
</table>
| Use exclusive (OR) decomposition when no two states at that level of the hierarchy can be active at the same time. | This guideline ensures proper chart execution. For example, Bedroom and Dining_area are exclusive (OR) states, because you cannot be in both places at the same time. | • “State Decomposition” on page 2-9  
  • “Specify Substate Decomposition” on page 4-9 |
| If reentry to a state with exclusive (OR) decomposition depends on the previously active substate, use a history junction. This type of junction records the active substate when the chart exits the state. | If you do not record the previously active substate, the default transition occurs and the wrong substate can become active upon state reentry. For example, if you were eating when a fire alarm sounded, you would return to the bedroom instead of the dining room. | • “History Junctions” on page 2-46 |

**Phase: Execution of State with Parallel Substates**

This part of the chart shows how a state with parallel (AND) decomposition executes.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Hotel Scenario</th>
<th>Chart Behavior</th>
</tr>
</thead>
</table>
| 1     | When your family reaches the suite, family members can be in both bedrooms (for example, parents in the master bedroom and children in the second bedroom). A default room choice does not apply. | When the condition room_type == 2 is true, the condition action fee = 1000 executes. Completion of that transition path triggers these state initialization actions:  
1. Checked_in becomes active and executes its entry action.  
2. Family_suite becomes active.  
3. The parallel states wake up in the order given by the number in the upper right corner of each state: Master_bedroom, then Second_bedroom.  
   **How do I specify the order?**  
To specify the order:  
   a. Verify that the chart uses explicit ordering.  
      In the Chart properties dialog box, select the User specified state/transition execution order check box.  
   b. Right-click in a parallel state and select a number from the Execution Order menu.  
For reference, see “Enter a Chart or State” on page 3-52. |
| 2     | You can occupy both rooms at the same time. | Master_bedroom and Second_bedroom remain active at the same time. |

**Modeling Guidelines for Execution of Parallel (AND) States.** The following guidelines apply to parallel (AND) states.
**Modeling Guideline**

| Use parallel (AND) decomposition when all states at that level of the hierarchy can be active at the same time. | This guideline ensures proper chart execution. For example, Master_bedroom and Second_bedroom are parallel states, because you can occupy both rooms at the same time. | “State Decomposition” on page 2-9
| “Specify Substate Decomposition” on page 4-9 |

| Use no history junctions in states with parallel (AND) decomposition. | This guideline prevents parsing errors. Since all parallel states at a level of hierarchy are active at the same time, history junctions have no meaning. | “History Junctions” on page 2-46 |

| Use explicit ordering to control the execution order of parallel (AND) states. | You can specify explicit or implicit ordering of parallel states. By default, a chart uses explicit ordering. If you switch to implicit ordering, the execution order can change when parallel states move. | “Execution Order for Parallel States” on page 3-89 |

**Phase: Events Guard Transitions Between States**

This part of the chart describes how events can guard transitions between exclusive (OR) states.
<table>
<thead>
<tr>
<th>Stage</th>
<th>Hotel Scenario</th>
<th>Chart Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>If a fire alarm sounds, you leave the hotel and move to a waiting area outside.</td>
<td>When the chart receives an event broadcast for <code>fire_alarm</code>, a transition occurs from a substate of <code>Check_in</code> to <code>Waiting_area</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>How does this transition occur?</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Suppose that <code>Check_in</code>, <code>Checked_in</code>, <code>Executive_suite</code>, and <code>Dining_area</code> are active when the chart receives <code>fire_alarm</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 States become inactive in <em>ascending</em> order of hierarchy:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a  Dining_area</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b  Executive_suite</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c  Checked_in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d  Check_in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 Waiting_area becomes active.</td>
</tr>
<tr>
<td>2</td>
<td>If an all-clear signal occurs, you can leave the waiting area and return to your previous location inside the hotel.</td>
<td>When the chart receives an event broadcast for <code>all_clear</code>, a transition from <code>Waiting_area</code> to the previously active substate of <code>Check_in</code> occurs.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The history junction at each level of hierarchy in <code>Check_in</code> enables the chart to remember which substate was previously active before the transition to <code>Waiting_area</code> occurred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>How does this transition occur?</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Suppose that <code>Check_in</code>, <code>Checked_in</code>, <code>Executive_suite</code>, and <code>Dining_area</code> were active when the chart received <code>fire_alarm</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 Waiting_area becomes inactive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 States become active in <em>descending</em> order of hierarchy:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>a  Check_in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>b  Checked_in (The default transition does not apply.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c  Executive_suite</td>
</tr>
<tr>
<td></td>
<td></td>
<td>d  Dining_area (The default transition does not apply.)</td>
</tr>
</tbody>
</table>
**Modeling Guidelines for Guarding Transitions.** The following guideline discusses the use of events versus conditions.

<table>
<thead>
<tr>
<th>Modeling Guideline</th>
<th>Why This Guideline Applies</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use events, instead of conditions, to guard transitions that depend on occurrences without numerical value.</td>
<td>Because you cannot easily quantify the numerical value of a fire alarm or an all-clear signal, model such an occurrence as an event.</td>
<td>“Activate a Stateflow Chart Using Input Events” on page 10-9</td>
</tr>
</tbody>
</table>
Modeling Guidelines for Stateflow Charts

<table>
<thead>
<tr>
<th>In this section…</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Use signals of the same data type for input events” on page 3-26</td>
<td></td>
</tr>
<tr>
<td>“Use a default transition to mark the first state to become active among exclusive (OR) states” on page 3-26</td>
<td></td>
</tr>
<tr>
<td>“Use condition actions instead of transition actions whenever possible” on page 3-27</td>
<td></td>
</tr>
<tr>
<td>“Use explicit ordering to control the testing order of a group of outgoing transitions” on page 3-27</td>
<td></td>
</tr>
<tr>
<td>“Verify intended backtracking behavior in flow charts” on page 3-27</td>
<td></td>
</tr>
<tr>
<td>“Use a superstate to enclose substates that share the same state actions” on page 3-27</td>
<td></td>
</tr>
<tr>
<td>“Use MATLAB functions for performing numerical computations in a chart” on page 3-27</td>
<td></td>
</tr>
<tr>
<td>“Use descriptive names in function signatures” on page 3-28</td>
<td></td>
</tr>
<tr>
<td>“Use history junctions to record state history” on page 3-28</td>
<td></td>
</tr>
<tr>
<td>“Do not use history junctions in states with parallel (AND) decomposition” on page 3-28</td>
<td></td>
</tr>
<tr>
<td>“Use explicit ordering to control the execution order of parallel (AND) states” on page 3-28</td>
<td></td>
</tr>
</tbody>
</table>

Use these guidelines to efficiently model charts with events, states, and transitions.

Use signals of the same data type for input events

When you use multiple input events to trigger a chart, verify that all input signals use the same data type. Otherwise, simulation stops and an error message appears. For more information, see “Data Types Allowed for Input Events” on page 10-11.

Use a default transition to mark the first state to become active among exclusive (OR) states

This guideline prevents state inconsistency errors during chart execution.
Use condition actions instead of transition actions whenever possible

Condition actions execute as soon as the condition evaluates to true. Transition actions do not execute until after the transition path is complete, to a terminating junction or a state. Unless an execution delay is necessary, use condition actions instead of transition actions.

Use explicit ordering to control the testing order of a group of outgoing transitions

You can specify explicit or implicit ordering of transitions. By default, a chart uses explicit ordering. If you switch to implicit ordering, the transition testing order can change when graphical objects move.

Verify intended backtracking behavior in flow charts

If your chart contains unintended backtracking behavior, a warning message appears with instructions on how to avoid that problem. For more information, see “Best Practices for Creating Flow Charts” on page 5-3.

Use a superstate to enclose substates that share the same state actions

When you have multiple exclusive (OR) states that perform the same state actions, group these states in a superstate and define state actions at that level.

This guideline enables reuse of state actions that apply to multiple substates. You write the state actions only once, instead of writing them separately in each substate.

**Note** You cannot use boxes for this purpose because boxes do not support state actions.

Use MATLAB functions for performing numerical computations in a chart

MATLAB functions are better at handling numerical computations than graphical functions, truth tables, or Simulink functions.
Use descriptive names in function signatures

Descriptive function names enhance readability of chart objects.

Use history junctions to record state history

If reentry to a state with exclusive (OR) decomposition depends on the previously active substate, use a history junction. This type of junction records the active substate when the chart exits the state. If you do not record the previously active substate, the default transition occurs and the wrong substate can become active upon state reentry.

Do not use history junctions in states with parallel (AND) decomposition

This guideline prevents parsing errors. Since all parallel states at a level of hierarchy are active at the same time, history junctions have no meaning.

Use explicit ordering to control the execution order of parallel (AND) states

You can specify explicit or implicit ordering of parallel states. By default, a chart uses explicit ordering. If you switch to implicit ordering, the execution order can change when parallel states move.
## Modeling Rules That Stateflow Detects During Edit Time

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Object contains a syntax error” on page 3-31</td>
</tr>
<tr>
<td>“Dangling transitions” on page 3-31</td>
</tr>
<tr>
<td>“Unreachable state” on page 3-31</td>
</tr>
<tr>
<td>“Transition shadowing” on page 3-32</td>
</tr>
<tr>
<td>“Invalid default transition path” on page 3-33</td>
</tr>
<tr>
<td>“Unconditional path out of state with during actions or child states” on page 3-33</td>
</tr>
<tr>
<td>“Graphical function contains a state” on page 3-34</td>
</tr>
<tr>
<td>“Default transition is missing” on page 3-35</td>
</tr>
<tr>
<td>“No unconditional default transitions” on page 3-36</td>
</tr>
<tr>
<td>“Unexpected backtracking” on page 3-37</td>
</tr>
<tr>
<td>“Transition loops outside natural parent” on page 3-38</td>
</tr>
<tr>
<td>“Transition action precedes a condition action along this path” on page 3-39</td>
</tr>
<tr>
<td>“Transition crosses, ends or begins in a parallel state” on page 3-41</td>
</tr>
<tr>
<td>“Monitoring leaf or child state activity of parallel states” on page 3-41</td>
</tr>
<tr>
<td>“Invalid transitions crossing into graphical function” on page 3-42</td>
</tr>
<tr>
<td>“Invalid transitions crossing out of graphical function” on page 3-42</td>
</tr>
</tbody>
</table>

The Stateflow editor displays potential errors and warnings by highlighting objects in red or orange. By fixing these issues when you design your charts, you avoid potential compile or run-time warnings and errors. To see details and possible fixes, place your cursor over the object and click the badge.

To turn off the edit-time checking, clear **Display > Error & Warnings**. When you change the diagnostic level of a corresponding configuration parameter, the edit-time diagnostic level also changes. For example, if you set the **Unreachable execution path** configuration parameter on the **Diagnostics > Stateflow** pane in the Configuration Parameters dialog box to none, then Stateflow does not highlight transition shadowing in the editor. Not all edit-time checks have corresponding configuration parameters.
<table>
<thead>
<tr>
<th><strong>Edit-Time Check Issue</strong></th>
<th><strong>Diagnostic Configuration Parameter</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Object contains a syntax error</td>
<td>No configuration parameter. Always an error.</td>
</tr>
<tr>
<td>Dangling transitions</td>
<td>Unreachable execution path</td>
</tr>
<tr>
<td>Unreachable state</td>
<td>Unreachable execution path</td>
</tr>
<tr>
<td>Transition shadowing</td>
<td>Unreachable execution path</td>
</tr>
<tr>
<td>Invalid default transition path</td>
<td>No configuration parameter. Always an error.</td>
</tr>
<tr>
<td>Unconditional path out of state with during actions or child states</td>
<td>Transition outside natural parent</td>
</tr>
<tr>
<td>Graphical function contains a state</td>
<td>No configuration parameter. Always an error.</td>
</tr>
<tr>
<td>Default transition is missing</td>
<td>No configuration parameter. Always an error.</td>
</tr>
<tr>
<td>No unconditional default transitions</td>
<td>No unconditional default transitions</td>
</tr>
<tr>
<td>Unexpected backtracking</td>
<td>Unexpected backtracking</td>
</tr>
<tr>
<td>Transition loops outside natural parent</td>
<td>Transition outside natural parent</td>
</tr>
<tr>
<td>Transition action precedes a condition action along this path</td>
<td>Transition action specified before condition action</td>
</tr>
<tr>
<td>Parallel state is destination of incoming transition path</td>
<td>No configuration parameter. Always a warning.</td>
</tr>
<tr>
<td>Monitoring leaf or child state activity of parallel states</td>
<td>No configuration parameter. Always a warning.</td>
</tr>
<tr>
<td>Invalid transitions crossing into graphical function</td>
<td>No configuration parameter. Always an error.</td>
</tr>
<tr>
<td>Invalid transitions crossing out of graphical function</td>
<td>No configuration parameter. Always an error.</td>
</tr>
</tbody>
</table>

The editor highlights these potential issues.
Object contains a syntax error

The notation for an action or condition in a state or transition does not follow the syntax rules. Violations are highlighted as errors. See “Transition Label Notation” on page 2-21 and “State Labels” on page 2-10.

Note Subcharts with syntax errors appear red in the parent chart with a badge indicating a syntax issue. In the subchart editor, the object is highlighted in red, however there is no badge indicating the issue.

Dangling transitions

A dangling transition is not connected to a destination object. Transitions must have a valid source state or junction and a valid destination state or junction. See “Transitions” on page 2-19.

Control the level of diagnostic action by setting the Diagnostics > Stateflow > Unreachable execution path parameter in the Model Configuration Parameters dialog box.

Unreachable state

If there is not a valid execution path leading to a state, it is unreachable. Make this state a reachable destination by connecting the state with a transition from a reachable state or junction.
Control the level of diagnostic action by setting the **Diagnostics > Stateflow > Unreachable execution path** parameter in the Model Configuration Parameters dialog box.

**Transition shadowing**

Transition shadowing occurs when a chart contains an unconditional transition originating from a source that prevents other transitions from the same source from executing.

To avoid transition shadowing, create no more than one unconditional transition for each group of outgoing transitions from a state or junction. Explicitly specify an unconditional transition as a lower evaluation order than any transitions with conditions. See “Transition Evaluation Order” on page 3-67.

To control the level of diagnostic action, set the **Diagnostics > Stateflow > Unreachable execution path** parameter in the Model Configuration Parameters dialog box.
When possible, click **Fix** for Stateflow to switch the execution orders for the transitions. You can undo the applied fix from the **Edit** menu.

**Invalid default transition path**

An invalid default transition occurs when the execution path for the default transition exits the parent state. Create a default transition that contains the execution path within the parent state.

![Diagram showing invalid default transition path](image)

**Unconditional path out of state with during actions or child states**

Unconditional transitions from a state prevent Stateflow from executing the during actions of that state or taking default transitions to child state.
To control the level of diagnostic action, set the Diagnostics > Stateflow > Transition outside natural parent parameter in the Model Configuration Parameters dialog box.

**Graphical function contains a state**

When called, graphical functions must execute completely. Therefore, graphical functions can not contain states.
**Default transition is missing**

Charts or states with exclusive (OR) decomposition require a default transition to indicate which state or junction enters execution by default. See “Default Transitions” on page 2-35.
When you click Fix, Stateflow adds a default transition to the upper-left state or junction.

**No unconditional default transitions**

In charts or states with exclusive (OR) decomposition, there must be one unconditional default transition. You can include multiple junctions and transitions, if one path along the transition remains unconditional.
To control the level of diagnostic action, set the **Diagnostics > Stateflow > No unconditional default transitions** parameter in the Model Configuration Parameters dialog box.

**Unexpected backtracking**

Unintended backtracking of control flow can occur at a junction under these conditions:

- The junction does not have an unconditional transition path to a state or terminating junction.
- Multiple transition paths that share a source lead to the junction.

See “Backtrack in Flow Charts” on page B-39.
Control the level of diagnostic action by setting the **Diagnostics > Stateflow > Unexpected backtracking** parameter in the Model Configuration Parameters dialog box.

When you click **Fix**, Stateflow adds a transition from the backtracking junction to a terminating junction. You can undo the applied fix from the **Edit** menu.

### Transition loops outside natural parent

When a transition loops outside of the parent state between the source and destination, the exit and entry actions of the parent state execute before the destination state becomes active. Often, this behavior is not the behavior that you want. For example:

1. State B is initially active.
2. State B exit actions execute.
3. State A exit actions execute.
4. State A entry actions execute.
5. State C entry actions execute.
To have execution move from state B to state C without exiting and reentering state A, move the transition so that it is contained within state A.

Control the level of diagnostic action by setting the Diagnostics > Stateflow > Transition outside natural parent parameter in the Model Configuration Parameters dialog box.

**Transition action precedes a condition action along this path**

When there is a transition action on a path with a condition action on a following transition, the actions do not execute in the order of the transitions. The condition action executes before the preceding transition action. Condition actions execute when the
associated condition is evaluated as true, whereas transition actions execute only when the transition path is fully executed.

In this diagram, if ConditionA and ConditionB are true, ConditionAction2 executes before TransitionAction1.

![Diagram showing execution order]

**Execution order:**

1. Evaluate ConditionA.
2. If true, evaluate ConditionB.
3. If true, execute ConditionAction2.
4. Exit state A.
5. Execute TransitionAction1.
6. Enter state B.

To improve clarity, place the transition action after the last condition action on the path.

![Diagram showing improved execution order]
Control the level of diagnostic action by setting the **Diagnostics > Stateflow > Transition action specified before condition action** parameter in the Model Configuration Parameters dialog box.

**Transition crosses, ends or begins in a parallel state**

Transitions leading to or from a parallel state cause all sibling parallel states to become active or inactive. To avoid unintentional behavior, do not create a transition into or out of a parallel state.

**Monitoring leaf or child state activity of parallel states**

State activity is not logged for parallel states. Therefore this warning appears when you choose to stream leaf or child state activity for states that contain parallel states.
Invalid transitions crossing into graphical function

Transitions cannot have a graphical function as the destination. Call graphical functions from state actions or transitions.

Invalid transitions crossing out of graphical function

Transitions cannot have a graphical function as the destination. Call graphical functions from state actions or transitions.

See Also

More About

• “Stateflow Semantics” on page 3-2
• “Modeling Guidelines for Stateflow Charts” on page 3-26
• “Stateflow Editor Operations” on page 4-27
Types of Chart Execution

In this section...

| “Lifecycle of a Stateflow Chart” on page 3-43 |
| “Execution of an Inactive Chart” on page 3-43 |
| “Execution of an Active Chart” on page 3-44 |
| “Execution of a Chart at Initialization” on page 3-44 |

Lifecycle of a Stateflow Chart

Stateflow charts go through several stages of execution:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactive</td>
<td>Chart has no active states</td>
</tr>
<tr>
<td>Active</td>
<td>Chart has active states</td>
</tr>
<tr>
<td>Sleeping</td>
<td>Chart has active states, but no events to process</td>
</tr>
</tbody>
</table>

When a Simulink model first triggers a Stateflow chart, the chart is inactive and has no active states. After the chart executes and completely processes its initial trigger event from the Simulink model, it transfers control back to the model and goes to sleep. At the next Simulink trigger event, the chart changes from the sleeping to active stage.

See “How Events Drive Chart Execution” on page 3-83.

Execution of an Inactive Chart

When a chart is inactive and first triggered by an event from a Simulink model, it first executes its set of default flow charts (see “Order of Execution for a Set of Flow Charts” on page 3-87). If this action does not cause an entry into a state and the chart has parallel decomposition, then each parallel state becomes active (see “Enter a Chart or State” on page 3-52).

If executing the default flow paths does not cause state entry, a state inconsistency error occurs.
Execution of an Active Chart

After a chart has been triggered the first time by the Simulink model, it is an active chart. When the chart receives another event from the model, it executes again as an active chart. If the chart has no states, each execution is equivalent to initializing a chart. Otherwise, the active substates execute. Parallel states execute in the same order that they become active.

Execution of a Chart at Initialization

By default, the first time a chart wakes up, it executes the default transition paths. At this time, the chart can access inputs, write to outputs, and broadcast events. If you want your chart to begin executing from a known configuration, you can enable the option to execute at initialization. When you turn on this option, the state configuration of a chart initializes at time 0 instead of the first occurrence of an input event. The default transition paths of the chart execute during the model initialization phase at time 0, corresponding to the mdlInitializeConditions() phase for S-functions.

You select the **Execute (enter) Chart At Initialization** check box in the Chart properties dialog box, as described in “Specify Chart Properties” on page 23-3.

**Note** If an output of this chart connects to a SimEvents® block, do not select this check box. To learn more about using Stateflow charts and SimEvents blocks together in a model, see the SimEvents documentation.

Due to the transient nature of the initialization phase, do not perform certain actions in the default transition paths of the chart — and associated state entry actions — which execute at initialization. Follow these guidelines:

- Do not access chart input data, because blocks connected to chart input ports might not have initialized their outputs yet.
- Do not call exported graphical functions from other charts, because those charts might not have initialized yet.
- Do not broadcast function-call output events, because the triggered subsystems might not have initialized yet.

You can control the level of diagnostic action for invalid access to chart input data in the **Diagnostics > Stateflow** pane of the Configuration Parameters dialog box. For more
information, see the documentation for the “Invalid input data access in chart initialization” (Simulink) diagnostic.

Execute at initialization is ignored in Stateflow charts that do not contain states.

**See Also**

**More About**

- “Execution of a Stateflow Chart” on page 3-46
- “Exit a State” on page 3-60
- “Evaluate Transitions” on page 3-65
Execution of a Stateflow Chart

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Workflow for Stateflow Chart Execution” on page 3-46</td>
</tr>
<tr>
<td>“During Actions” on page 3-48</td>
</tr>
<tr>
<td>“Outgoing Transition” on page 3-48</td>
</tr>
<tr>
<td>“Inner Transitions” on page 3-48</td>
</tr>
<tr>
<td>“Chart Execution with a Valid Transition” on page 3-48</td>
</tr>
<tr>
<td>“Chart Execution Without a Valid Transition” on page 3-49</td>
</tr>
</tbody>
</table>

When a Stateflow chart wakes up, the chart follows a workflow and executes actions. A Stateflow chart wakes up:

- At each time step according to the Simulink solver.
- When the Stateflow chart receives an event.

When a chart wakes up for the first time, the chart is initialized and becomes active. See “Chart Entry” on page 3-54. Once the chart is active but with no more actions to take, the chart goes to sleep until it is triggered by a new time step or an event.

Workflow for Stateflow Chart Execution

This flow chart shows the progression of events that Stateflow takes for executing a chart or state. In this flow chart, the current state refers to the state in which a decision or a process is taking place.
Execution of a Stateflow Chart

1. Chart wakes up.
2. Does the chart or state have an active child?
   - no: Chart goes to sleep.
   - yes: The child state becomes the current state. Are there any outgoing transitions?
     - no: Perform any during actions.
     - yes: Go to Workflow for Evaluating Transitions. Are there any valid transitions?
       - no: Go to Workflow for Evaluating Transitions. Are there any inner transitions?
         - yes: Mark destination state for entry. Mark current state for exit. Go to Workflow for Exiting a State.
         - no: Go to Workflow for Evaluating Transitions. Are there any valid transitions?
           - yes: Mark destination state for entry. Mark current state for exit. Go to Workflow for Exiting a State.
           - no: Go to Workflow for Evaluating Transitions.
**During Actions**

During actions for a state execute when:

- The state is active, a new time step occurs, and no valid transition to another state is available.
- The state is active, an event occurs, and no valid transition to another state is available.

During actions are preceded by the prefix *during* or *du*, and then followed by a required colon (:), followed by one or more actions. Separate multiple actions with a carriage return, semicolon (;), or a comma (,). If you do not specify the state action type explicitly for a statement, the chart treats that statement as an *entry*, *during* action.

A state performs its *during* actions (if specified) when the chart wakes up. The preceding flow chart depicts the process of state execution and shows when *during* actions occur.

If your Stateflow chart does not contain states, each time the chart is executed, Stateflow always evaluates the default transition path.

**Outgoing Transition**

Stateflow marks outgoing transitions for evaluation as a part of the execution of a Stateflow chart. Once an outgoing transition is marked for evaluation, follow the “Workflow for Evaluating Transitions” on page 3-66. For more information about how Stateflow evaluates outgoing transitions, see “Evaluate Transitions” on page 3-65.

**Inner Transitions**

Stateflow marks inner transitions for evaluation as a part of the execution of a Stateflow chart. Once an inner transition is marked for evaluation, follow the “Workflow for Evaluating Transitions” on page 3-66. For more information about how Stateflow evaluates inner transitions, see “Evaluate Transitions” on page 3-65.

**Chart Execution with a Valid Transition**

In this example, the Stateflow chart is initialized and the *entry* actions are performed for StateA and StateA1. A new time step occurs and the chart wakes up.

At this time step, $x = 5$, $y = 2$, and $z = 0$. 
By following the “Workflow for Stateflow Chart Execution” on page 3-46, the execution steps for chart execution are in this order:

1. The chart has an active substate, StateA.
2. StateA has an outgoing transition to StateB. By following the “Workflow for Evaluating Transitions” on page 3-66, the transition is determined to be valid.
3. StateB is marked for entry and StateA is marked for exit.

To complete the time step, follow the “Workflow for Exiting a State” on page 3-60 for StateA and the “Workflow for Entering a Chart or State” on page 3-52 for StateB.

**Chart Execution Without a Valid Transition**

In this example, the Stateflow chart is initialized and the entry actions are performed for StateA and StateA1. A new time step occurs and the chart wakes up.

At this time step, x = 3, y = 0, and z = 0.
By following the “Workflow for Stateflow Chart Execution” on page 3-46 until the chart goes to sleep, the execution steps for chart execution are in this order:

1. The chart has an active substate, StateA.
2. StateA has an outgoing transition to StateB. By following the “Workflow for Evaluating Transitions” on page 3-66, the transition is determined to be invalid.
3. Perform the during actions for StateA. Now y = 1.
4. StateA does not have any inner transitions.
5. The active substate of StateA is StateA1.
6. StateA1 has an outgoing transition to StateA2. By following the “Workflow for Evaluating Transitions” on page 3-66, the transition is determined to be invalid.
8. StateA1 does not have any active substates.
9. The chart goes to sleep.

Steps 1 through 9 take place in the second time step.
See Also

More About

• “Enter a Chart or State” on page 3-52
• “Exit a State” on page 3-60
• “Evaluate Transitions” on page 3-65
Enter a Chart or State

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Workflow for Entering a Chart or State” on page 3-52</td>
</tr>
<tr>
<td>“Chart Entry” on page 3-54</td>
</tr>
<tr>
<td>“State Entry” on page 3-54</td>
</tr>
<tr>
<td>“Entry Actions” on page 3-54</td>
</tr>
<tr>
<td>“Enter a Stateflow Chart” on page 3-54</td>
</tr>
<tr>
<td>“Entering a State by Using History Junctions” on page 3-56</td>
</tr>
<tr>
<td>“Entering a State by Using Supertransitions” on page 3-58</td>
</tr>
</tbody>
</table>

Chart and state entry occurs when:

- A chart is activated for the first time. This is called chart initialization.
- A valid transition into a state exists. See “Evaluate Transitions” on page 3-65.

**Workflow for Entering a Chart or State**

This flow chart shows the progression of events that Stateflow takes for entry into a chart or a state. In this flow chart, the current state refers to the state in which a decision or a process is taking place.
Chart or state has been marked for entry and as the current chart or state.

Is the current state the child of an inactive parent?

- no: Perform any entry actions for the current state.
- yes: Mark parent as active and as the current state.

Is this the state that was initially marked for entry?

- no: Active child of this state becomes the current state.
- yes: Are there any history junctions?

Are there any history junctions?

- yes: Previously active child becomes the current state. Perform any entry actions.
- no: Chart goes to sleep.

Is there a single child state without a default transition?

- no: Are there any default transitions?
  - yes: Go to Workflow for Evaluating a Transition.
  - no: Mark child state as active and as the current state.
Chart Entry

The first time that your Stateflow chart becomes active is called initialization. When initialization of your chart occurs, the chart is entered and Stateflow executes any default transitions for exclusive (OR) states. If the states at the top level of your chart are parallel (AND), they become active based on their order number.

If you want your chart to take any default transitions at time $t = 0$, in the Chart Properties dialog box, select the **Execute (enter) Chart At Initialization** check box. The default transition paths of the chart then execute during the model initialization phase.

State Entry

When a state is marked for entry, entry actions for a state execute. Once your chart is active and has gone through initialization, the top-level state becomes active. A state is marked for entry in one of these ways:

- An incoming transition crosses state boundaries.
- An incoming transition ends at the state boundary.
- The state is a parallel state child of an active state.

Entry Actions

Entry actions are preceded by the prefix `entry` or `en` for short, followed by a required colon `:`), and then followed by one or more actions. You separate multiple actions by using a carriage return, a semicolon `;`, or a comma `,`. If you do not specify the state action type explicitly for a statement, the chart treats that statement as an `entry` during action.

Enter a Stateflow Chart

In this example, the first time the chart becomes active, chart initialization occurs.
By following the “Workflow for Entering a Chart or State” on page 3-52 until the chart goes to sleep, the steps for chart initialization are in this order:

1. The default transition actions are executed, and $x = 0$, $y = 0$, and $z = 0$.
2. StateA is marked for entry.
3. StateA is not a substate of an inactive parent. Perform the entry actions for StateA. Now $x = 1$.
4. StateA is the state that was initially marked for entry.
5. StateA does not contain any history junctions.
6. There is a default transition to the substate, StateA1. Go to the Evaluate Transitions flow chart.
7. By following the Evaluate Transitions flow chart, mark StateA1 for entry. Go to the Exit Actions flow chart.
8. The current state, StateA, is a superstate of the destination state, StateA1. Return to the Entry Actions flow chart.
10. StateA1 is the state that was initially marked for entry.
11. StateA1 does not contain any history junctions.
12. StateA1 does not contain any default transitions.
13. StateA1 does not contain any single substates.
The chart goes to sleep.

Steps 1 through 14 take place in the initial time step. This completes the chart initialization process.

**Entering a State by Using History Junctions**

If you want your Stateflow chart to remember and return to a substate that was previously active, regardless of a default transition, use a history junction. Placing a history junction within a state overrides the default transition leading to exclusive (OR) substates. After placing a history junction within a state, upon entry, your Stateflow chart remembers and enters the previously active substate. The history junction applies only to the level of the hierarchy in which it appears.

In this example, a light can be on or off. These options are indicated by the states `Power_on` and `Power_off`. The options are controlled by the input events `switch_on` and `switch_off`. When the light is on, it can be dim or bright. These options are indicated by the states `Low` and `High` and are controlled by the input events `switch_low` and `switch_high`.

Initially, the chart is asleep. The state `Power_off` is active. When the state `Power_on` was last active, `High` was the previously active substate. The event `switch_on` occurs and the state `Power_on` is marked for entry. At this time $p = 0$. 

By following the “Workflow for Entering a Chart or State” on page 3-52 until the chart goes to sleep, the execution steps for entering the state \texttt{Power\_on} are in this order:

1. \texttt{Power\_on} is not the child of an inactive parent.
2. There are no entry actions for \texttt{Power\_on}.
3. \texttt{Power\_on} is the state that was initially marked for entry.
4. There are history junctions in \texttt{Power\_on}.
5. \texttt{High} was the previously active substate. Now \( p = 2 \).
6. \texttt{High} does not contain any history junctions.
7. \texttt{High} does not contain any default transitions.
8. \texttt{High} does not contain any single substates.
9. The chart goes to sleep.

This completes the entry actions for \texttt{Power\_on} and \texttt{High}.
Entering a State by Using Supertransitions

A supertransition is a transition between different levels in a chart. A supertransition can be between a state in a top-level chart and a state in one of its subcharts, or between states residing in different subcharts at the same or different levels in a chart. You can create supertransitions that span any number of levels in your chart.

When a state is entered through a supertransition, before the entry actions for the final destination are executed, its superstates must be marked active and their entry actions must be executed. In this example, StateB1 has been marked for entry from StateA2. At this point, \( x = 5, y = 5, \) and \( z = 1. \)

By following the “Workflow for Entering a Chart or State” on page 3-52 until the chart goes to sleep, the execution steps for entering the state StateB1 are in this order:

1. StateB1 is the substate of an inactive parent (StateB).
2. StateB is marked as active.
3. StateB is not the substate of an inactive parent.
4. Perform the entry actions for StateB. Now \( x = 4. \)
5. StateB is not the state that was initially marked for entry.
6. Perform the entry actions for StateB1. Now \( x = 3. \)
7. StateB1 is the state that was initially marked for entry.
8 StateB1 has no history junctions.
9 StateB1 does not contain any default transitions.
10 StateB1 does not contain any single substates.
11 The chart goes to sleep.

This completes the entry actions for StateB and StateB1.

See Also

More About
- “Execution of a Stateflow Chart” on page 3-46
- “Exit a State” on page 3-60
- “Evaluate Transitions” on page 3-65
Exit a State

When there is a valid transition out of a state, that state is marked for exit. A state is marked for exit in one of these ways:

- The outgoing transition originates at the state boundary.
- The outgoing transition crosses the state boundary.
- The destination state is a parallel state child of an activated state.

**Workflow for Exiting a State**

This flow chart shows the progression of events in Stateflow for exiting a state. In this flow chart, the current state refers to the state in which a decision or a process is taking place.
Exit Actions

Exit actions for a state execute when the state is active and a valid transition from the state exists. A state performs its exit actions before becoming inactive.

Exit actions are preceded by the prefix `exit` or `ex`, followed by a required colon (colon), and then followed by one or more actions. Separate multiple actions with a carriage return, semicolon (`;`), or a comma (`,`).
Exit a State Example

In this example, the Stateflow chart is initialized and the entry actions are performed for StateA and StateA1. For this chart, the during actions for this chart have occurred twice. A new time step occurs, and then the chart wakes up.

By following the “Workflow for Stateflow Chart Execution” on page 3-46 and the “Workflow for Evaluating Transitions” on page 3-66, StateB has been marked for entry. StateA is the source of the transition. At this time step $x = 5$, $y = 2$, and $z = 0$.

By following the flow chart for state exit actions until the chart goes to sleep, the execution steps for this chart are in this order:

1. StateA is not a superstate of StateB.
2. Perform the exit actions of StateA and mark StateA as inactive. Now $z = 1$.
3. StateA does not have a parent state.
4. Go to “Entry Actions” on page 3-54.

These steps complete the exit workflow for StateA. However, the chart is not yet asleep.

Perform the “Workflow for Entering a Chart or State” on page 3-52 for StateB to complete the time step.
Exit a State by Using Supertransitions

A supertransition is a transition between different levels in a chart. A supertransition can be between a state in a top-level chart and a state in one of its subcharts, or between states residing in different subcharts at the same or different levels in a chart. You can create supertransitions that span any number of levels in your chart.

When a state is exited through a supertransition, after the exit actions for the source of the transition are executed, its superstates are marked inactive and exit actions of the superstates are executed. In this example, StateA2 is marked for exit and StateB1 is marked for entry. At this point, $x = 5$, $y = 5$, and $z = 0$.

![Diagram of state transitions]

By following the “Workflow for Entering a Chart or State” on page 3-52 until the chart goes to sleep, the execution steps for exiting the state StateA2 are in this order:

1. **StateA2** is not a superstate of the destination state (StateB1).
2. Perform the exit actions for StateA2 and mark StateA2 as inactive.
3. **StateA2** does have a parent state, StateA.
4. **StateA** is not a superstate of the destination state (StateB1).
5. Perform the exit actions for StateA, and mark StateA as inactive.
6. **StateA** does not have a parent state.

These actions complete the exit workflow for StateA2 and StateA. However, the chart is not yet asleep.

3-63
Perform the “Workflow for Entering a Chart or State” on page 3-52 for StateB and StateB1 to complete the time step.

See Also

More About

• “Execution of a Stateflow Chart” on page 3-46
• “Enter a Chart or State” on page 3-52
• “Evaluate Transitions” on page 3-65
Evaluate Transitions

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Workflow for Evaluating Transitions” on page 3-66</td>
</tr>
<tr>
<td>“Transition Evaluation Order” on page 3-67</td>
</tr>
<tr>
<td>“Outgoing Transition Example” on page 3-68</td>
</tr>
<tr>
<td>“Outgoing Transition Example with Backtracking” on page 3-69</td>
</tr>
<tr>
<td>“Condition and Transition Actions” on page 3-72</td>
</tr>
</tbody>
</table>

Stateflow uses transitions in charts to move from one exclusive (OR) state to another exclusive (OR) state. For the entry and execution workflows of chart execution, Stateflow evaluates transitions to determine if they are valid. A valid transition is a transition whose condition labels are true and whose path ends at a state. If a transition is valid, Stateflow exits from the source state and enters the destination state. To learn about when evaluation occurs during the execution and entry workflows, see “Execution of a Stateflow Chart” on page 3-46 and “Enter a Chart or State” on page 3-52.
Workflow for Evaluating Transitions

- Transition is marked for evaluation.
- Does the transition have a condition?
  - yes
  - Is the condition true?
    - yes
    - Execute any condition actions.
    - no
    - Is the destination a state?
      - yes
      - Valid transition path found. Execute all transition actions for the valid path and return to previous flow chart.
      - no
      - No valid transitions. Return to previous flow chart.
      - no
      - Identify the first transition in the execution order.
        - yes
        - Does the junction have any outgoing transitions?
          - yes
          - No valid transitions. Return to previous flow chart.
          - no
          - Is the last transition in execution order?
            - yes
            - Return to the previous junction or state on the transition path.
            - no
            - Next transition in execution order becomes the current transition.
              - no
              - Is the condition true?
                - yes
                - Execute any condition actions.
                - no
                - Is the last transition in execution order?
                  - yes
                  - Identify the last transition executed. This transition is the current transition.
                  - no
                  - Transition is marked for evaluation.

Transition Evaluation Order

When multiple transitions originate from a single source, such as a state or junction, Stateflow uses evaluation order to determine when to test each transition. Depending on which action language your chart uses, you can create the order of your transitions explicitly or implicitly. Whether explicitly or implicitly ordered, transitions show a number near the source of the transition that designates the transition order.

Note Use explicit ordering to avoid your transitions from changing order while you are editing a chart.

Explicit Ordering

When you open a new Stateflow chart, all outgoing transitions from a source are automatically numbered in the order in which you create them. The order starts with 1 and continues to the next available number for the source.

To change the execution order of a transition, right-click the transition, place your cursor over Execution Order, and select the order in which you want your transition to execute. When you change a transition number, the Stateflow chart automatically renumbers the other outgoing transitions for the source by preserving their relative order.

Implicit Ordering

For C charts in implicit ordering mode, a Stateflow chart evaluates a group of outgoing transitions from a single source based on:

• Hierarchy.
  A chart evaluates a group of outgoing transitions in an order based on the hierarchical level of the parent of each transition.

• Label.
  A chart evaluates a group of outgoing transitions with equal hierarchical priority based on the labels, in the following order of precedence:

  1  Labels with events and conditions
  2  Labels with events
3 Labels with conditions
4 No label

- Angular surface position of transition source.

A chart evaluates a group of outgoing transitions with equal hierarchical and label priority based on angular position on the surface of the source object. The transition with the smallest clock position has the highest priority. For example, a transition with a 2 o'clock source position has a higher priority than a transition with a 4 o'clock source position. A transition with a 12 o'clock source position has the lowest priority.

**Outgoing Transition Example**

In this example, the Stateflow chart is initialized and the entry actions are performed for StateA. A new time step occurs and the chart wakes up. By following the “Workflow for Stateflow Chart Execution” on page 3-46, Stateflow finds multiple outgoing transitions from StateA. At this time step $x = 1$, $y = 1$, and $z = 1$. 
Evaluate Outgoing Transitions

By following the “Workflow for Evaluating Transitions” on page 3-66, the steps for evaluating the transitions of this chart are in this order:

1. Transition 1 from StateA is marked for evaluation.
2. Transition 1 from StateA has a condition.
3. The condition is true.
4. The destination of transition 1 from StateA is not a state.
5. The junction does have outgoing transitions.
6. Transition 1 from the junction is marked for evaluation.
7. Transition 1 from the junction has a condition.
8. The condition is false.
9. Transition 2 from the junction is marked for evaluation.
10. Transition 2 from the junction does not have a condition.
11. The destination of transition 2 from the junction is a state (StateD).
12. StateD is marked for entry, and StateA is marked for exit.

To complete the time step, follow the “Workflow for Exiting a State” on page 3-60 for StateA and the “Workflow for Entering a Chart or State” on page 3-52 for StateE.

Outgoing Transition Example with Backtracking

When all outgoing transitions from a source are invalid or do not end with a terminal junction, but there are previously unevaluated transitions, Stateflow returns to the previous state or junction to evaluate all possible paths.

In this example, the Stateflow chart is initialized and the entry actions are performed for StateA. A new time step occurs, and the chart wakes up. By following the “Workflow for Stateflow Chart Execution” on page 3-46, Stateflow finds multiple outgoing transitions from StateA. At this time step $x = 1$, $y = 1$, and $z = 1$. 

3-69
Evaluate Outgoing Transitions with Backtracking

By following the “Workflow for Evaluating Transitions” on page 3-66, the steps for evaluating the transitions of this chart are in this order:

1. Transition 1 from StateA is marked for evaluation.
2. Transition 1 from StateA has a condition.
3. The condition is true.
4. The destination of transition 1 from StateA is not a state.
5. The junction does have outgoing transitions.
6. Transition 1 from the junction is marked for evaluation.
7. Transition 1 from the junction has a condition.
8. The condition is false.
9. Transition 2 from the junction is marked for evaluation.
10. Transition 2 from the junction has a condition.
11. The condition is false.
Transition 2 from StateA is marked for evaluation.
Transition 2 from StateA does not have a condition.
The destination of transition 2 from StateA is a state (StateE).
StateE is marked for entry, and StateA is marked for exit.

To complete the time step, follow the “Workflow for Exiting a State” on page 3-60 for StateA and the “Workflow for Entering a Chart or State” on page 3-52 for StateE.

**Prevent Backtracking**

In this example, a terminal junction prevents backtracking. The Stateflow chart is initialized and the entry actions are performed for StateA. A new time step occurs and the chart wakes up. By following the “Workflow for Stateflow Chart Execution” on page 3-46, Stateflow finds multiple outgoing transitions from StateA. At this time step $x = 1$, $y = 1$, and $z = 1$.

By following the “Workflow for Evaluating Transitions” on page 3-66, the steps for evaluating the transitions of this chart are in this order:

1. Transition 1 from StateA is marked for evaluation.
Transition 1 from StateA has a condition.
The condition is true.
The destination of transition 1 from StateA is not a state.
The junction does have outgoing transitions.
Transition 1 from the junction is marked for evaluation.
Transition 1 from the junction has a condition.
The condition is false.
Transition 2 from the junction is marked for evaluation.
Transition 2 from the junction has a condition.
The condition is false.
Transition 3 from the junction is marked for evaluation.
Transition 3 from the junction does not have a condition.
The destination is not a state and does not have any outgoing transitions.
Return to “Workflow for Stateflow Chart Execution” on page 3-46.

To complete the time step, follow the “Workflow for Stateflow Chart Execution” on page 3-46 for StateA, starting where you left off.

**Condition and Transition Actions**

**Condition Actions**

In transition label syntax, condition actions follow the transition condition and are enclosed in curly braces ({}). Condition actions are executed when the condition is evaluated as true but before the transition path has been determined to be valid.

**Transition Actions**

In transition label syntax, transition actions are preceded with a forward slash (/) and are enclosed in curly braces ({}). Transition actions execute only after the transition path is determined to be valid.

In this example, both condition actions and transition actions exist. The Stateflow chart is initialized and the entry actions are performed for StateA. A new time step occurs and the chart wakes up. There are multiple outgoing transitions from StateA. At this time step $x = 1$, $y = 1$, and $z = 1$. 

3-72
Evaluate Outgoing Transitions with Condition and Transition Actions

By following the “Workflow for Evaluating Transitions” on page 3-66, the steps for evaluating the transitions of this chart are in this order:

1. Transition 1 from StateA is marked for evaluation.
2. Transition 1 from StateA has a condition (\(y \geq 1\)).
3. The condition is true.
4. There are no condition actions.
5. The destination of transition 1 from StateA is not a state.
6. The junction does have outgoing transitions.
7. Transition 1 from the junction is marked for evaluation.
8. Transition 1 from the junction has a condition (\(x > 2\)).
9. The condition is false.
10. Transition 2 from the junction is marked for evaluation.
11. Transition 2 from the junction has a condition (\(x \geq 1\)).
The condition is true.

There is a condition action ({y = 0;}). Now y = 0.

The junction does have outgoing transitions.

The transition from the junction is marked for evaluation.

Transition 1 from the junction has a condition ([z >= 5]).

The condition is false.

Transition 2 from StateA is marked for evaluation.

Transition 2 from StateA does not have a condition.

The destination of transition 2 from StateA is a state (StateD).

StateD is marked for entry, and StateA is marked for exit. Execute the transition action for this valid path (/{z = 5}). Now z = 5.

To complete the time step, follow the “Workflow for Exiting a State” on page 3-60 for StateA and the “Workflow for Entering a Chart or State” on page 3-52 for StateE.

See Also

More About

• “Execution of a Stateflow Chart” on page 3-46
• “Enter a Chart or State” on page 3-52
• “Exit a State” on page 3-60
Super Step Semantics

By default, Stateflow charts execute once for each input event or time step. If you are modeling a system that must react quickly to inputs, you can enable super step semantics, a Stateflow chart property (see “Enable Super Step Semantics” on page 3-75).

When you enable super step semantics, a Stateflow chart executes multiple times for every active input event or for every time step when the chart has no input events. The chart takes valid transitions until either of these conditions occurs:

- No more valid transitions exist, that is, the chart is in a stable active state configuration.
- The number of transitions taken exceeds a user-specified maximum number of iterations.

In a super step, your chart responds faster to inputs but performs more computations in each time step. Therefore, when generating code for an embedded target, make sure that the chart can finish the computation in a single time step. To achieve this behavior, fine-tune super step parameters by setting an upper limit on the number of transitions that the chart takes per time step (see “Maximum Number of Iterations” on page 3-75).

For simulation targets, specify whether the chart goes to the next time step or generates an error if it reaches the maximum number of transitions prematurely. However, in generated code for embedded targets, the chart always goes to the next time step after taking the maximum number of transitions.

Maximum Number of Iterations

In a super step, your chart always takes at least one transition. Therefore, when you set a maximum number of iterations in each super step, the chart takes that number of transitions plus 1. For example, if you specify 10 as the maximum number of iterations, your chart takes 11 transitions in each super step. To set maximum number of iterations in each super step, see “Enable Super Step Semantics” on page 3-75.

Enable Super Step Semantics

To enable super step semantics:

1 Right-click inside the top level of a chart and select Properties from the context menu.
2 In the Chart properties dialog box, select the **Enable Super Step Semantics** check box.

Two additional fields appear below that check box.

3 Enter a value in the field **Maximum Iterations in each Super Step**.
The chart always takes one transition during a super step, so the value \( N \) that you specify represents the maximum number of additional transitions (for a total of \( N+1 \)). Try to choose a number that allows the chart to reach a stable state within the time step, based on the mode logic of your chart. For more information, see “Maximum Number of Iterations” on page 3-75.

4. Select an action from the drop-down menu in the field **Behavior after too many iterations**.

Your selection determines how the chart behaves during simulation if it exceeds the maximum number of iterations in the super step before reaching a stable state.

<table>
<thead>
<tr>
<th>Behavior</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Proceed</strong></td>
<td>The chart goes back to sleep with the last active state configuration, that is, after updating local data at the last valid transition in the super step.</td>
</tr>
<tr>
<td><strong>Throw Error</strong></td>
<td>Simulation stops and the chart generates an error, indicating that too many iterations occurred while trying to reach a stable state.</td>
</tr>
</tbody>
</table>

**Note** Selecting **Throw Error** can help detect infinite loops in transition cycles (see “Detection of Infinite Loops in Transition Cycles” on page 3-81).

**Note** This option is relevant only for simulation targets. For embedded targets, code generation goes to the next time step rather than generating an error.

**Super Step Example**

The following model shows how super step semantics differs from default semantics:

In this model, a Constant block outputs a constant value of 20 to input \( u \) in a Stateflow chart. Because the value of \( u \) is always 20, each transition in the chart is valid:
By default, the chart takes only one transition in each simulation step, incrementing $y$ each time.

When you enable super step semantics, the chart takes all valid transitions in each time step, stopping at state C with $y = 3$. 
How Super Step Semantics Works with Multiple Input Events

When you enable super step semantics for a chart with multiple active input events, the chart takes all valid transitions for the first active event before it begins processing the next active event. For example, consider the following model:
In this model, the Sum block produces a 2-by-1 vector signal that goes from [0,0] to [1,1] at time \( t = 1 \). As a result, when the model wakes up the chart, events E1 and E2 are both active:

If you enable super step semantics, the chart takes all valid transitions for event E1. The chart takes transitions from state A to B and then from state B to C in a single super step. The scope shows that \( y = 3 \) at the end of the super step:
In a super step, this chart never transitions to state D because there is no path from state C to state D.

**Detection of Infinite Loops in Transition Cycles**

If your chart contains transition cycles, taking multiple transitions in a single time step can cause infinite loops. Consider the following example:
In this example, the transitions between states A and B cycle and produce an infinite loop because the value of $x$ remains constant at 1. One way to detect infinite loops is to configure your chart to generate an error if it reaches a maximum number of iterations in a super step. See “Enable Super Step Semantics” on page 3-75.
How Events Drive Chart Execution

In this section...

“How Stateflow Charts Respond to Events” on page 3-83
“Sources for Stateflow Events” on page 3-83
“How Charts Process Events” on page 3-84

How Stateflow Charts Respond to Events

Stateflow charts execute only in response to an event in a cyclical manner.

Because a chart runs on a single thread, actions that take place based on an event are atomic to that event. All activity caused by the event in the chart finishes before execution returns to the activity that was taking place before receiving the event. Once an event initiates an action, the action completes unless interrupted by an early return.

Sources for Stateflow Events

Simulink events awaken Stateflow charts. You can use events to control the processing of your charts by broadcasting events, as described in “Broadcast Events to Synchronize
States” on page 12-52. For examples using event broadcasting and directed event broadcasting, see:

- Directed Event Broadcasting on page 12-52
- “Broadcast Events to Parallel (AND) States Using Condition Actions” on page B-13
- “Avoid Cyclic Behavior” on page B-14
- “Broadcast Events in Parallel States” on page B-43
- “Broadcast Events in a Transition Action with a Nested Event Broadcast” on page B-45
- “Broadcast Condition Action Event in Parallel State” on page B-48

Events have hierarchy (a parent) and scope. The parent and scope together define a range of access to events. The parent of an event usually determines who can trigger on the event (has receive rights). See the Name and Parent fields for an event in “Set Properties for an Event” on page 10-7 for more information.

How Charts Process Events

Stateflow charts process events from the top down through the chart hierarchy:

1. Executes during and on event_name actions for the active state
2. Checks for valid transitions in substates

All events, except for the output edge trigger to a Simulink block (see the following note), have the following execution in a chart:

1. If the receiver of the event is active, then it executes (see “Execution of a Stateflow Chart” on page 3-46). (The event receiver is the parent of the event unless a directed event broadcast occurs using the send() function.)
2. If the receiver of the event is not active, nothing happens.
3. After broadcasting the event, the broadcaster performs early return logic based on the type of action statement that caused the event.

To learn about early return logic, see “Early Return Logic for Event Broadcasts” on page 3-97.
**Note** Output edge-trigger event execution in a Simulink model is equivalent to toggling the value of an output data value between 1 and 0. It is not treated as a Stateflow event. See “Define Edge-Triggered Output Events” on page 23-16.
Process for Grouping and Executing Transitions

In this section...

“Transition Flow Chart Types” on page 3-86
“Order of Execution for a Set of Flow Charts” on page 3-87

Transition Flow Chart Types

Before executing transitions for an active state or chart, Stateflow software groups transitions by the following types:

- Default flow charts are all default transition segments that start with the same parent.
- Inner flow charts are all transition segments that originate on a state and reside entirely within that state.
- Outer flow charts are all transition segments that originate on the respective state but reside at least partially outside that state.

Each set of flow charts includes other transition segments connected to a qualifying transition segment through junctions and transitions. Consider the following example:

![Diagram of Stateflow state transitions]

In this example, state A has both an inner and a default transition that connect to a junction with outgoing transitions to states A.A1 and A.A2. If state A is active, its set of inner flow charts includes:

- The inner transition
The outgoing transitions from the junction to state A.A1 and A.A2

In addition, the set of default flow charts for state A includes:

- The default transition to the junction
- The two outgoing transitions from the junction to state A.A1 and A.A2

In this case, the two outgoing transition segments from the junction are members of more than one flow chart type.

**Order of Execution for a Set of Flow Charts**

Each flow chart group executes in the order of group priority until a valid transition appears. The default transition group executes first, followed by the outer transitions group and then the inner transitions group. Each flow chart group executes as follows:

1. Order the group's transition segments for the active state.
   
   An active state can have several possible outgoing transitions. The chart orders these transitions before checking them for validity. See “Transition Evaluation Order” on page 3-67.

2. Select the next transition segment in the set of ordered transitions.

3. Test the transition segment for validity.

4. If the segment is invalid, go to step 2.

5. If the destination of the transition segment is a state, do the following:

   a. Testing of transition segments stops and a transition path forms by backing up and including the transition segment from each preceding junction back to the starting transition.

   b. The states that are the immediate substates of the parent of the transition path exit (see “Exit a State” on page 3-60).

   c. The transition action from the final transition segment of the full transition path executes.

   d. The destination state becomes active (see “Enter a Chart or State” on page 3-52).

6. If the destination is a junction with no outgoing transition segments, do the following:

   a. Testing stops without any state exits or entries.
7 If the destination is a junction with outgoing transition segments, repeat step 1 for the set of outgoing segments.

8 After testing all outgoing transition segments at a junction, take the following actions:

   a Backtrack the incoming transition segment that brought you to the junction.
   b Continue at step 2, starting with the next transition segment after the backup segment.

The set of flow charts completes execution when all starting transitions have been tested.
Execution Order for Parallel States

In this section...

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Ordering for Parallel States” on page 3-89</td>
</tr>
<tr>
<td>“Explicit Ordering of Parallel States” on page 3-90</td>
</tr>
<tr>
<td>“Implicit Ordering of Parallel States” on page 3-91</td>
</tr>
<tr>
<td>“Order Maintenance for Parallel States” on page 3-92</td>
</tr>
<tr>
<td>“Execution Priorities in Restored States” on page 3-94</td>
</tr>
<tr>
<td>“Switching Between Explicit and Implicit Ordering” on page 3-95</td>
</tr>
<tr>
<td>“Execution Order of Parallel States in Boxes and Subcharts” on page 3-95</td>
</tr>
</tbody>
</table>

Ordering for Parallel States

Although multiple parallel (AND) states in the same chart execute concurrently, the Stateflow chart must determine when to activate each one during simulation. This ordering determines when each parallel state performs the actions that take it through all stages of execution.

Unlike exclusive (OR) states, parallel states do not typically use transitions. Instead, order of execution depends on:

- Explicit ordering
  
  Specify explicitly the execution order of parallel states on a state-by-state basis (see “Explicit Ordering of Parallel States” on page 3-90).

- Implicit ordering
  
  Override explicit ordering by letting a Stateflow chart use internal rules to order parallel states (see “Implicit Ordering of Parallel States” on page 3-91).

Parallel states are assigned priority numbers based on order of execution. The lower the number, the higher the priority. The priority number of each state appears in the upper right corner.

Because execution order is a chart property, all parallel states in the chart inherit the property setting. You cannot mix explicit and implicit ordering in the same Stateflow chart. However, you can mix charts with different ordering modes in the same Simulink model.
Explicit Ordering of Parallel States

By default, a Stateflow chart orders parallel states explicitly based on execution priorities you set.

How Explicit Ordering Works

When you open a new Stateflow chart — or one that does not yet contain any parallel states — the chart automatically assigns priority numbers to parallel states in the order you create them. Numbering starts with the next available number within the parent container.

When you enable explicit ordering in a chart that contains implicitly ordered parallel states, the implicit priorities are preserved for the existing parallel states. When you add new parallel states, execution order is assigned in the same way as for new Stateflow charts — in order of creation.

You can reset execution order assignments at any time on a state-by-state basis, as described in “Set Execution Order for Parallel States Individually” on page 3-91. When you change execution order for a parallel state, the Stateflow chart automatically renumbers the other parallel states to preserve their relative execution order. For details, see “Order Maintenance for Parallel States” on page 3-92.

Order Parallel States Explicitly

To use explicit ordering for parallel states, perform these tasks:

1  “Enable Explicit Ordering at the Chart Level” on page 3-90
2  “Set Execution Order for Parallel States Individually” on page 3-91

Enable Explicit Ordering at the Chart Level

To enable explicit ordering for parallel states, follow these steps:

1  Right-click inside the top level of the chart and select Properties from the context menu.

   The Chart properties dialog box appears.

2  Select the User specified state/transition execution order check box.

3  Click OK.

   If your chart already contains parallel states that have been ordered implicitly, the existing priorities are preserved until you explicitly change them. When you add new
parallel states in explicit mode, your chart automatically assigns priorities based on
order of creation (see “How Explicit Ordering Works” on page 3-90). However you
can now explicitly change execution order on a state-by-state basis, as described in

Set Execution Order for Parallel States Individually

In explicit ordering mode, you can change the execution order of individual parallel
states. Right-click the parallel state of interest and select a new priority from the
Execution Order menu.

Implicit Ordering of Parallel States

Rules of Implicit Ordering for Parallel States

In implicit ordering mode, a Stateflow chart orders parallel states implicitly based on
location. Priority goes from top to bottom and then left to right, based on these rules:

• The higher the vertical position of a parallel state in the chart, the higher the
execution priority for that state.

• Among parallel states with the same vertical position, the leftmost state receives
highest priority.

The following example shows how these rules apply to top-level parallel states and
parallel substates.
Note  Implicit ordering creates a dependency between design layout and execution priority. When you rearrange parallel states in your chart, you can accidentally change order of execution and affect simulation results. For more control over your designs, use the default explicit ordering mode to set execution priorities.

Order Parallel States Implicitly

To use implicit ordering for parallel states, follow these steps:

1. Right-click inside the top level of the chart and select Properties from the context menu.
2. In the Chart properties dialog box, clear the User specified state/transition execution order check box.
3. Click OK.

Order Maintenance for Parallel States

Whether you use explicit or implicit ordering, a chart tries to reconcile execution priorities when you remove, renumber, or add parallel states. In these cases, a chart reprioritizes the parallel states to:

- Fill in gaps in the sequence so that ordering is contiguous
- Ensure that no two states have the same priority
- Preserve the intended relative priority of execution

How a Chart Preserves Relative Priorities in Explicit Mode

For explicit ordering, a chart preserves the user-specified priorities. Consider this example of explicit ordering:
Because of explicit ordering, the priority of each state and substate matches the order of creation in the chart. The chart reprioritizes the parallel states and substates when you perform these actions:

1. Change the priority of top-level state b to 3.
2. Add a top-level state g.
3. Remove substate e.

The chart preserves the priority set explicitly for top-level state b, but renumbers all other parallel states to preserve their prior relative order.
How a Chart Preserves Relative Priorities in Implicit Mode

For implicit ordering, a chart preserves the intended relative priority based on geometry. Consider this example of implicit ordering:

If you remove top-level state b and substate e, the chart automatically reprioritizes the remaining parallel states and substates to preserve implicit geometric order:

Execution Priorities in Restored States

There are situations in which you need to restore a parallel state after you remove it from a Stateflow chart. In implicit ordering mode, a chart reassigns the execution priority based on where you restore the state. If you return the state to its original location in the chart, you restore its original priority.

However, in explicit ordering mode, a chart cannot always reinstate the original execution priority to a restored state. It depends on how you restore the state.

<table>
<thead>
<tr>
<th>If you remove a state by...</th>
<th>And restore the state by...</th>
<th>What is the priority?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Deleting, cutting, dragging outside the boundaries of the parent state, or dragging so its boundaries overlap the parent state</td>
<td>Using the undo command</td>
<td>The original priority is restored.</td>
</tr>
</tbody>
</table>
If you remove a state by...

<table>
<thead>
<tr>
<th>If you remove a state by...</th>
<th>And restore the state by...</th>
<th>What is the priority?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dragging outside the boundaries of the parent state or so its boundaries overlap the parent state and releasing the mouse button</td>
<td>Dragging it back into the parent state</td>
<td>The original priority is lost. The Stateflow chart treats the restored state as the last created and assigns it the lowest execution priority.</td>
</tr>
<tr>
<td>Dragging outside the boundaries of the parent state or so its boundaries overlap the parent state without releasing the mouse button</td>
<td>Dragging it back into the parent state</td>
<td>The original priority is restored.</td>
</tr>
<tr>
<td>Dragging so its boundaries overlap one or more sibling states</td>
<td>Dragging it to a location with no overlapping boundaries inside the same parent state</td>
<td>The original priority is restored.</td>
</tr>
<tr>
<td>Cutting</td>
<td>Pasting</td>
<td>The original priority is lost. The Stateflow chart treats the restored state as the last created and assigns it the lowest execution priority.</td>
</tr>
</tbody>
</table>

**Switching Between Explicit and Implicit Ordering**

If you switch to implicit mode after explicitly ordering parallel states, the Stateflow chart resets execution order to follow implicit rules of geometry. However, if you switch from implicit to explicit mode, the chart does not restore the original explicit execution order.

**Execution Order of Parallel States in Boxes and Subcharts**

When you group parallel states inside a box, the states retain their relative execution order. In addition, the Stateflow chart assigns the box its own priority based on the explicit or implicit ordering rules that apply. This priority determines when the chart activates the parallel states inside the box.
When you convert a state with parallel decomposition into a subchart, its substates retain their relative execution order based on the prevailing explicit or implicit rules.
Early Return Logic for Event Broadcasts

In this section...

“Guidelines for Proper Chart Behavior” on page 3-97
“How Early Return Logic Works” on page 3-97
“Example of Early Return Logic” on page 3-98

Guidelines for Proper Chart Behavior

These guidelines ensure proper chart behavior in event-driven systems:

- When a state is active, its parent should also be active.
- A state (or chart) with exclusive (OR) decomposition must never have more than one active substate.
- If a parallel state is active, siblings with higher priority must also be active.

How Early Return Logic Works

Stateflow charts run on a single thread. Therefore, charts must interrupt current activity to process events. Activity based on an event broadcast from a state or transition action can conflict with the current activity. Charts resolve these conflicts by using early return logic for event broadcasts as follows:

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Early Return Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry</td>
<td>If the state is no longer active at the end of the event broadcast, the chart does not perform remaining steps for entering a state.</td>
</tr>
<tr>
<td>Exit</td>
<td>If the state is no longer active at the end of the event broadcast, the chart does not perform remaining exit actions or transitions from state to state.</td>
</tr>
<tr>
<td>During</td>
<td>If the state is no longer active at the end of the event broadcast, the chart does not perform remaining steps for executing an active state.</td>
</tr>
<tr>
<td>Condition</td>
<td>If the origin state of the inner or outer flow chart — or parent state of the default flow chart — are no longer active at the end of the event broadcast, the chart does not perform remaining steps for executing the flow chart.</td>
</tr>
</tbody>
</table>
**Action Type** | **Early Return Logic**  
--- | ---  
Transition | If the parent of the transition path is not active — or if that parent has an active substate — the chart does not perform remaining transition actions and state entry actions.  

### Example of Early Return Logic

In this example, assume that state A is initially active. Event E occurs, causing the following behavior:

1. The chart root checks to see if there is a valid transition out of the active state A as a result of event E.
2. A valid transition to state B exists.
3. The condition action of the valid transition executes and broadcasts event F.  

   Event F interrupts the transition from A to B.
4. The chart root checks to see if there is a valid transition out of the active state A as a result of event F.
5. A valid transition to state C exists.
7. State A becomes inactive.
8. State C becomes active.
9. State C executes and completes its entry action.
State C is now the only active substate of its chart. The Stateflow chart cannot return to the transition from state A to state B and continue after the condition action that broadcast event F (step 3). First, its source, state A, is no longer active. Second, if the chart allowed the transition, state B would become the second active substate of the chart. This behavior violates the guideline that a state (or chart) with exclusive (OR) decomposition can never have more than one active substate. Therefore, the chart uses early return logic and halts the transition from state A to state B.

**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the send operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.

You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the Diagnostics > Stateflow pane and set the Undirected event broadcasts diagnostic to none, warning, or error. The default setting is warning.
Create Stateflow Charts

- “Basic Approach for Modeling Event-Driven Systems” on page 4-2
- “Represent Operating Modes Using States” on page 4-6
- “Transition Between Operating Modes” on page 4-19
- “Stateflow Editor Operations” on page 4-27
Basic Approach for Modeling Event-Driven Systems

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Identify System Attributes” on page 4-2</td>
</tr>
<tr>
<td>“Select a State Machine Type” on page 4-2</td>
</tr>
<tr>
<td>“Specify State Actions and Transition Conditions” on page 4-3</td>
</tr>
<tr>
<td>“Define Persistent Data to Store State Variables” on page 4-3</td>
</tr>
<tr>
<td>“Simplify State Actions and Transition Conditions with Function Calls” on page 4-4</td>
</tr>
<tr>
<td>“Check That Your System Representation Is Complete” on page 4-4</td>
</tr>
</tbody>
</table>

Identify System Attributes

Before you build the Stateflow chart, identify your system attributes by answering these questions:

1. What are your interfaces?
   a. What are the event triggers to which your system reacts?
   b. What are the inputs to your system?
   c. What are the outputs from your system?

2. Does your system have any operating modes?
   a. If the answer is yes, what are the operating modes?
   b. Between which modes can you transition? Are there any operating modes that run in parallel?

If your system has no operating modes, the system is *stateless*. If your system has operating modes, the system is *modal*.

Select a State Machine Type

After identifying your system attributes, the first step is to create a new chart. For more information, see `sfnew`. Select one of the following state machine types:

- Classic — The default machine type. Provides the full set of semantics for MATLAB charts and C charts.
• Mealy — Machine type in which output is a function of inputs and state.
• Moore — Machine type in which output is a function of state.

For more information, see “How Chart Constructs Interact During Execution” on page 3-6, “Differences Between MATLAB and C as Action Language Syntax” on page 13-7, and “Overview of Mealy and Moore Machines” on page 7-2.

**Specify State Actions and Transition Conditions**

After you create an empty chart, answer the following questions:

1. For each state, what are the actions you want to perform?
2. What are the rules for transitioning between your states? If your chart has no states, what are the rules for transitioning between branches of your flow logic?

Using your answers to those questions, specify state actions and transition conditions:

1. Draw states to represent your operating modes, if any. See “Represent Operating Modes Using States” on page 4-6.
2. Implement the state actions by adding state labels that use the appropriate syntax. See “State Action Types” on page 12-2.
3. Draw transitions to represent the direction of flow logic, between states or between branches of your flow chart. See “Transition Between Operating Modes” on page 4-19.
4. Implement the transition conditions by adding transition labels that use the appropriate syntax. See “Transition Action Types” on page 12-7.

**Define Persistent Data to Store State Variables**

After adding state actions and transition conditions to your chart, determine if the chart requires any local or persistent data to store state variables. If so, follow these steps:

1. Add local data to the appropriate level of the chart hierarchy. See “Add Stateflow Data” on page 9-2.

   You can also use the Symbol Wizard to add data to your chart. See “Define Chart Symbols with the Symbol Wizard” on page 29-35.

2. Specify the type, size, complexity, and other data properties. See “Set Data Properties” on page 9-7.
Simplify State Actions and Transition Conditions with Function Calls

State actions and transition conditions can be complex enough that defining them inline on the state or transition is not feasible. In this case, express the actions or conditions using one of the following types of Stateflow functions:

- Flow chart — Encapsulate flow charts containing if-then-else, switch-case, for, while, or do-while patterns.
- MATLAB — Write matrix-oriented algorithms; call MATLAB functions for data analysis and visualization.
- Simulink — Call Simulink function-call subsystems directly to streamline design and improve readability.
- Truth table — Represent combinational logic for decision-making applications such as fault detection and mode switching.

Use the function format that is most natural for the type of calculation in the state action or transition condition. For more information on the four types of functions, see:

- “Reuse Logic Patterns Using Graphical Functions” on page 8-26
- “MATLAB Functions in a Chart” on page 27-2
- “Simulink Functions in Stateflow” on page 28-2
- “What Is a Truth Table?” on page 26-2

If the four types of Stateflow functions do not work, you can write your own C or C++ code for integration with your chart. For more information about custom code integration, see “Share Data Using Custom C Code” on page 29-26.

Check That Your System Representation Is Complete

Does your Stateflow chart fully express the logical or event-driven components of your system?

- If the answer is yes, you are done.
- If the answer is no, you can create a separate chart or add hierarchy to your current chart.
  - To create a new chart, repeat all the steps in this basic workflow.
• To add hierarchy, repeat the previous three steps on lower levels of the current chart.
Represent Operating Modes Using States

Create a State

You create states by drawing them in the editor for a particular chart (block). Follow these steps:

1. Select the State tool:

2. Move your pointer into the drawing area.

   In the drawing area, the pointer becomes state-shaped (rectangular with oval corners).

3. Click in a particular location to create a state.

   The created state appears with a question mark (?) label in its upper left-hand corner.

4. Click the question mark.

   A text cursor appears in place of the question mark.

5. Enter a name for the state and click outside of the state when finished.

The label for a state specifies its required name and optional actions. See “Label States” on page 4-16 for more detail.
Move and Resize States

To move a state, do the following:

1. Click and drag the state.
2. Release it in a new position.

To resize a state, do the following:

1. Place your pointer over a corner of the state.
   - When your pointer is over a corner, it appears as a double-ended arrow (PC only; pointer appearance varies with other platforms).
2. Click and drag the state's corner to resize the state and release the left mouse button.

Create Substates and Superstates

A substate is a state that can be active only when another state, called its parent, is active. States that have substates are known as superstates. To create a substate, click the State tool and drag a new state into the state you want to be the superstate. A Stateflow chart creates the substate in the specified parent state. You can nest states in this way to any depth. To change the parentage of a substate, drag it from its current parent in the chart and drop it in its new parent.

Note  A parent state must be graphically large enough to accommodate all its substates. You might need to resize a parent state before dragging a new substate into it. You can bypass the need for a state of large graphical size by declaring a superstate to be a subchart. See “Encapsulate Modal Logic Using Subcharts” on page 8-5 for details.

Group States

When to Group a State

Group a state to move all graphical objects inside a state together. When you group a state, the chart treats the state and its contents as a single graphical unit. This behavior simplifies editing of a chart. For example, moving a grouped state moves all substates and functions inside that state.
How to Group a State

You can group a state by right-clicking it and then selecting **Group & Subchart > Group** in the context menu. The state appears shaded in gray to indicate that it is now grouped.

When to Ungroup a State

You must ungroup a state before performing these actions:

- Selecting objects inside the state
- Moving other graphical objects into the state

If you try to move objects such as states and graphical functions into a grouped state, you see an invalid intersection error message. Also, the objects with an invalid intersection have a red border.

How to Ungroup a State

You can ungroup a state by right-clicking it and then clearing **Group & Subchart > Group** in the context menu. The background of the state no longer appears gray.
Specify Substate Decomposition

You specify whether a superstate contains parallel (AND) states or exclusive (OR) states by setting its decomposition. A state whose substates are all active when it is active has parallel (AND) decomposition. A state in which only one substate is active when it is active has exclusive (OR) decomposition. An empty state's decomposition is exclusive.

To alter a state's decomposition, select the state, right-click to display the state's **Decomposition** context menu, and select **OR (Exclusive)** or **AND (Parallel)** from the menu.

You can also specify the state decomposition of a chart. In this case, the Stateflow chart treats its top-level states as substates. The chart creates states with exclusive decomposition. To specify a chart's decomposition, deselect any selected objects, right-click to display the chart's **Decomposition** context menu, and select **OR (Exclusive)** or **AND (Parallel)** from the menu.

The appearance of the substates indicates the decomposition of their superstate. Exclusive substates have solid borders, parallel substates, dashed borders. A parallel substate also contains a number in its upper right corner. The number indicates the activation order of the substate relative to its sibling substates.
Specify Activation Order for Parallel States

You can specify activation order by using one of two methods: explicit or implicit ordering.

- By default, when you create a new Stateflow chart, *explicit ordering* applies. In this case, you specify the activation order on a state-by-state basis.
- You can also override explicit ordering by letting the chart order parallel states based on location. This mode is known as *implicit ordering*.

For more information, see “Explicit Ordering of Parallel States” on page 3-90 and “Implicit Ordering of Parallel States” on page 3-91.

**Note** The activation order of a parallel state appears in its upper right corner.

Change State Properties

Use the State dialog box to view and change the properties for a state. To access the State dialog box:

1. Right-click the state and select **Properties**.

   The State properties dialog box appears. For descriptions of properties, see “Properties You Can Set in the General Pane” on page 4-10 and “Properties You Can Set in the Logging Pane” on page 4-12.

2. Modify property settings and then click one of these buttons:

   - **Apply** to save the changes and keep the State dialog box open
   - **Cancel** to return to the previous settings
   - **OK** to save the changes and close the dialog box
   - **Help** to display the documentation in an HTML browser window

**Properties You Can Set in the General Pane**

The **General** pane of the State properties dialog box appears as shown.
You can set these properties in the **General** pane.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Stateflow chart name; read-only; click this hypertext link to bring the state to the foreground.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Execution order</strong></td>
<td>Set the execution order of a parallel (AND) state. This property does not appear for exclusive (OR) states. See “Execution Order for Parallel States” on page 3-89.</td>
</tr>
<tr>
<td><strong>Create data for monitoring</strong></td>
<td>Select this option to create state activity data. See “About Active State Data” on page 23-31.</td>
</tr>
<tr>
<td><strong>Function Inline Option</strong></td>
<td>Select one of these options to control the inlining of state functions in generated code:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Auto</strong></td>
</tr>
<tr>
<td></td>
<td>Inlines state functions based on an internal heuristic.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inline</strong></td>
</tr>
<tr>
<td></td>
<td>Always inlines state functions in the parent function, as long as the function is not part of a recursion. See “Inline State Functions in Generated Code” (Simulink Coder)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Function</strong></td>
</tr>
<tr>
<td></td>
<td>Creates separate static functions for each state.</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>The label for the state, which includes the name of the state and its associated actions. See “Label States” on page 4-16.</td>
</tr>
</tbody>
</table>

**Properties You Can Set in the Logging Pane**

The **Logging** pane of the State properties dialog box appears as shown.
You can set these properties in the **Logging** pane.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Log self activity</strong></td>
<td>Saves the self activity value to the MATLAB workspace during simulation.</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Test point</td>
<td>Designates the state as a test point that can be monitored with a floating scope during model simulation. You can also log test point values into MATLAB workspace objects. See “Monitor Test Points in Stateflow Charts” on page 30-43.</td>
</tr>
<tr>
<td>Logging name</td>
<td>Specifies the name associated with the logged self activity. Simulink software uses the signal name as its logging name by default. To specify a custom logging name, select Custom from the list box and enter the new name in the adjacent edit field.</td>
</tr>
<tr>
<td>Limit data points to last</td>
<td>Limits the self activity logged to the most recent samples.</td>
</tr>
<tr>
<td>Decimation</td>
<td>Limits self activity logged by skipping samples. For example, a decimation factor of 2 saves every other sample.</td>
</tr>
</tbody>
</table>

**Properties You Can Set in the Documentation Pane**

The **Documentation** pane of the State properties dialog box appears as shown.
You can set these properties in the **Documentation** pane.

<table>
<thead>
<tr>
<th><strong>Property</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Textual description or comment.</td>
</tr>
<tr>
<td><strong>Document link</strong></td>
<td>Enter a URL address or a general MATLAB command. Examples are <code>www.mathworks.com</code>, <code>mailto:email_address</code>, and edit <code>/spec/data/speed.txt</code>.</td>
</tr>
</tbody>
</table>
Label States

The label for a state specifies its required name for the state and the optional actions executed when the state is entered, exited, or receives an event while it is active.

State labels have the following general format.

```
name/
entry:entry actions
during:during actions
exit:exit actions
bind:data and events
on event_or_message_name:on event_or_message_name actions
```

The italicized entries in this format have the following meanings:

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not applicable</td>
<td>name</td>
<td>A unique reference to the state with optional slash</td>
</tr>
<tr>
<td>entry or en</td>
<td>entry actions</td>
<td>Actions executed when a particular state is entered as the result of a transition taken to that state</td>
</tr>
<tr>
<td>during or du</td>
<td>during actions</td>
<td>Actions that are executed when a state receives an event while it is active with no valid transition away from the state</td>
</tr>
<tr>
<td>exit or ex</td>
<td>exit actions</td>
<td>Actions executed when a state is exited as the result of a transition taken away from the state</td>
</tr>
<tr>
<td>bind</td>
<td>data or events</td>
<td>Binds the specified data or events to this state. Bound data can be changed only by this state or its children, but can be read by other states. Bound events can be broadcast only by this state or its children.</td>
</tr>
<tr>
<td>on</td>
<td>event_or_message_name and on event_name actions</td>
<td>A specified event or message and Actions executed when a state is active and the specified event occurs or message is present. For more information, see “How Events Work in Stateflow Charts” on page 10-2 and “How Messages Work in Stateflow Charts” on page 11-2</td>
</tr>
</tbody>
</table>
**Enter the Name**

Initially, a state's label is empty. The Stateflow chart indicates this by displaying a ? in the state's label position (upper left corner). Begin labeling the state by entering a name for the state with the following steps:

1. **Click the state.**
   - The state turns to its highlight color and a question mark character appears in the upper left-hand corner of the state.

2. **Click the ? to edit the label.**
   - An editing cursor appears. You are now free to type a label.

   Enter the state's name in the first line of the state's label. Names are case sensitive. To avoid naming conflicts, do not assign the same name to sibling states. However, you can assign the same name to states that do not share the same parent.

   After labeling the state, click outside it. Otherwise, continue entering actions. To reedit the label, click the label text near the character position you want to edit.

**Enter Actions**

After entering the name of the state in the label, you can enter actions for any of the following action types:

- **Entry Actions** — begin on a new line with the keyword `entry` or `en`, followed by a colon, followed by one or more action statements on one or more lines. To separate multiple actions on the same line, use a comma or a semicolon.

  You can begin entry actions on the same line as the state's name. In this case, begin the entry action with a forward slash `/` instead of the entry keyword.

- **Exit Actions** — begin on a new line with the keyword `exit` or `ex`, followed by a colon, followed by one or more action statements on one or more lines. To separate multiple actions on the same line, use a comma or a semicolon.

- **During Actions** — begin on a new line with the keyword `during` or `du`, followed by a colon, followed by one or more action statements on one or more lines. To separate multiple actions on the same line, use a comma or a semicolon.

- **Bind Actions** — begin on a new line with the keyword `bind` followed by a colon, followed by one or more data or events on one or more lines. To separate multiple actions on the same line, use a comma or a semicolon.
On Actions — begin with the keyword on, followed by a space and the name of an event or message, followed by a colon, followed by one or more action statements on one or more lines, for example

```
on ev1: exit();
```

To separate multiple actions on the same line, use a comma or a semicolon. If you want different events to trigger different actions, enter multiple on blocks in the state label. Each block specifies the action for a specific event or message, for example:

```
on ev1: action1(); on ev2: action2();
```

The execution of the actions you enter for a state is dependent only on their action type, and not the order in which you enter actions in the label. If you do not specify the action type explicitly for a statement, the chart treats that statement as an entry action.

**Tip** You can also edit the label in the properties dialog box for the state. See “Change State Properties” on page 4-10.
Transition Between Operating Modes

In this section...

| “Create a Transition” on page 4-19       |
| “Label Transitions” on page 4-20        |
| “Move Transitions” on page 4-21         |
| “Change Transition Arrowhead Size” on page 4-22 |
| “Create Self-Loop Transitions” on page 4-23 |
| “Create Default Transitions” on page 4-23 |
| “Change Transition Properties” on page 4-23 |

Create a Transition

Follow these steps to create transitions between states and junctions:

1. Place your pointer on or close to the border of a source state or junction.
   The pointer changes to crosshairs.
2. Click and drag a transition to a destination state or junction.
3. Release on the border of the destination state or junction.

Attached transitions obey the following rules:

- Transitions do not attach to the corners of states. Corners are used exclusively for resizing.
- Transitions exit a source and enter a destination at angles perpendicular to the source or destination surface.
- All transitions have smart behavior.

To delete a transition, click it and select **Edit > Cut**, or press the **Delete** key.

See the following sections for help with creating *self-loop* and *default* transitions:

- “Create Self-Loop Transitions” on page 4-23
- “Create Default Transitions” on page 4-23
Label Transitions

Transition labels contain syntax that accompanies the execution of a transition. The following topics discuss creating and editing transition labels:

- “Edit Transition Labels” on page 4-20
- “Transition Label Format” on page 4-20

For more information on transition concepts, see “Transition Label Notation” on page 2-21.

For more information on transition label contents, see “Transition Action Types” on page 12-7.

Edit Transition Labels

Label unlabeled transitions as follows:

1. Select (left-click) the transition.
   
   The transition changes to its highlight color and a question mark (?) appears on the transition. The ? character is the default empty label for transitions.

2. Left-click the ? to edit the label.
   
   You can now type a label.

To apply and exit the edit, deselect the object. To reedit the label, simply left-click the label text near the character position you want to edit.

Transition Label Format

Transition labels have the following general format:

```plaintext
event_or_message [condition]{condition_action}/transition_action
```

Specify, as appropriate, relevant names for `event_or_message`, `condition`, `condition_action`, and `transition_action`.

<table>
<thead>
<tr>
<th>Label Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>event_or_message</code></td>
<td>The event or message that causes the transition to be evaluated.</td>
</tr>
<tr>
<td>Label Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>condition</td>
<td>Defines what, if anything, has to be true for the condition action and transition to take place.</td>
</tr>
<tr>
<td>condition_action</td>
<td>If the condition is true, the action specified executes and completes.</td>
</tr>
<tr>
<td>transition_action</td>
<td>This action executes after the source state for the transition is exited but before the destination state is entered.</td>
</tr>
</tbody>
</table>

Transitions do not need labels. You can specify some, all, or none of the parts of the label. Rules for writing valid transition labels include:

- Can have any alphanumeric and special character combination, with the exception of embedded spaces
- Cannot begin with a numeric character
- Can have any length
- Can have carriage returns in most cases
- Must have an ellipsis (...) to continue on the next line

**Move Transitions**

You can move transition lines with a combination of several individual movements. These movements are described in the following topics:

- “Bow the Transition Line” on page 4-21
- “Move Transition Attach Points” on page 4-22
- “Move Transition Labels” on page 4-22

In addition, transitions move along with the movements of states and junctions.

**Bow the Transition Line**

You can move or "bow" transition lines with the following procedure:

1. Place your pointer on the transition at any point along the transition except the arrow or attach points.
2. Click and drag your pointer to move the transition point to another location.

Only the transition line moves. The arrow and attachment points do not move.
3 Release the mouse button to specify the transition point location.

The result is a bowed transition line. Repeat the preceding steps to move the transition back into its original shape or into another shape.

**Move Transition Attach Points**

You can move the source or end points of a transition to place them in exact locations as follows:

1 Place your pointer over an attach point until it changes to a small circle.
2 Click and drag your pointer to move the attach point to another location.
3 Release the mouse button to specify the new attach point.

The appearance of the transition changes from a solid to a dashed line when you detach and release a destination attach point. Once you attach the transition to a destination, the dashed line changes to a solid line.

The appearance of the transition changes to a default transition when you detach and release a source attach point. Once you attach the transition to a source, the appearance returns to normal.

**Move Transition Labels**

You can move transition labels to make the Stateflow chart more readable. To move a transition label, do the following:

1 Click and drag the label to a new location.
2 Release the left mouse button.

If you mistakenly click and then immediately release the left mouse button on the label, you will be in edit mode for the label. Press the Esc key to deselect the label and try again. You can also click the mouse on an empty location in the chart to deselect the label.

**Change Transition Arrowhead Size**

The arrowhead size is a property of the destination object. Changing one of the incoming arrowheads of an object causes all incoming arrowheads to that object to be adjusted to the same size. The arrowhead size of any selected transitions, and any other transitions ending at the same object, is adjusted.
To adjust arrowhead size:

1. Select the transitions whose arrowhead size you want to change.
2. Place your pointer over a selected transition and right-click to select *Arrowhead Size*.
3. Select an arrowhead size from the menu.

**Create Self-Loop Transitions**

A self-loop transition is a transition whose source and destination are the same state or junction. To create a self-loop transition:

1. Create the transition by clicking and dragging from the source state or junction.
2. Press the *S* key or right-click your mouse to enable a curved transition.
3. Continue dragging the transition tip back to a location on the source state or junction.

For the semantics of self-loops, see “Self-Loop Transitions” on page 2-29.

**Create Default Transitions**

A default transition is a transition with a destination (a state or a junction), but no apparent source object.

Click the **Default Transition** button in the toolbar and click a location in the drawing area close to the state or junction you want to be the destination for the default transition. Drag your pointer to the destination object to attach the default transition.

The size of the endpoint of the default transition is proportional to the arrowhead size. See “Change Transition Arrowhead Size” on page 4-22.

Default transitions can be labeled just like other transitions. See “Label Default Transitions” on page 2-35 for an example.

**Change Transition Properties**

Use the Transition properties dialog box to view and change the properties for a transition. To access the dialog box for a particular transition:
1  Right-click the transition and select **Properties**.

The Transition properties dialog box appears.
The following transition properties appear in the dialog box:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Source</strong></td>
<td>Source of the transition; read-only; click the hypertext link to bring the transition source to the foreground.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>Destination of the transition; read-only; click the hypertext link to bring the transition destination to the foreground.</td>
</tr>
<tr>
<td><strong>Parent</strong></td>
<td>Parent of this state; read-only; click the hypertext link to bring the parent to the foreground.</td>
</tr>
<tr>
<td><strong>Execution order</strong></td>
<td>The order in which the chart executes the transition.</td>
</tr>
<tr>
<td><strong>Label</strong></td>
<td>The transition's label. See “Transition Label Notation” on page 2-21 for more information on valid label formats.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Textual description or comment.</td>
</tr>
<tr>
<td><strong>Document link</strong></td>
<td>Enter a Web URL address or a general MATLAB command. Examples are <a href="http://www.mathworks.com">www.mathworks.com</a>, mailto:email_address, and edit/spec/data/speed.txt.</td>
</tr>
</tbody>
</table>

2 After making changes, click one of these buttons:

- **Apply** to save the changes and keep the Transition dialog box open.
- **Cancel** to return to the previous settings for the dialog box.
- **OK** to save the changes and close the dialog box.
- **Help** to display Stateflow online help in an HTML browser window.
Stateflow Editor Operations

In this section...

“Stateflow Editor” on page 4-27
“Undo and Redo Editor Operations” on page 4-31
“Specify Colors and Fonts in a Chart” on page 4-32
“Content Preview for Stateflow Objects” on page 4-35
“Intelligent Tab Completion for Stateflow Charts” on page 4-36
“Differentiate Elements of Action Language Syntax” on page 4-37
“Select and Deselect Graphical Objects” on page 4-39
“Cut and Paste Graphical Objects” on page 4-39
“Copy Graphical Objects” on page 4-40
“Comment Out Objects” on page 4-40
“Format Chart Objects” on page 4-40
“Generate a Model Report” on page 4-55

Stateflow Editor

Use the Stateflow Editor to draw, zoom, modify, print, and save a chart shown in the window.

Opening a Stateflow chart displays the chart in the Stateflow Editor.

To open a new Stateflow chart in the Stateflow Editor:

1 At the MATLAB command prompt, enter:

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>sfnew</code></td>
<td>Creates an chart with the default action language. For more information, see <code>sfnew</code>.</td>
</tr>
<tr>
<td><code>sfnew -matlab</code></td>
<td>Creates an empty chart with MATLAB as the action language.</td>
</tr>
<tr>
<td><code>sfnew -C</code></td>
<td>Creates an empty C chart.</td>
</tr>
</tbody>
</table>
Create Stateflow Charts

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>stateflow</td>
<td>Creates an empty chart with the default action language and displays the Stateflow block library.</td>
</tr>
</tbody>
</table>

The Simulink Editor opens, with an empty chart.

2 Double-click the chart object.

The Stateflow Editor opens.

The Stateflow Editor window includes the following sections:

- **Title bar**
The full chart name appears here in *model name/chart name* format. The * character appears on the end of the chart name for a newly created chart or for an existing chart that has been edited but not saved yet.

- **Menu bar** and **toolbar**

Most editor commands are available from the menu bar. The toolbar contains buttons for cut, copy, paste, and other commonly used editor commands. You can identify each tool of the toolbar by placing your pointer over it until an identifying tool tip appears. The toolbar also contains buttons for navigating a chart's subchart hierarchy (see “Navigate Subcharts” on page 8-8).

- **Object palette**
Displays a set of tools for drawing states, transitions, and other chart objects. To add an object, you can use the palette to:

- Click the icon for the object and move the cursor to the spot in the drawing area where you want to place the object.
- Drag the icon for the object into the drawing area.
- Double-click the icon and then click multiple times in the drawing area to make copies of the object.

- **Explorer bar**
The breadcrumb shows the systems that you have open in the editor. Click a system in the breadcrumb to display that system.

- **Model Browser**

Click the double arrows in the bottom left corner to open or close a tree-structured view of the model in the editor.

- **Drawing area** — This area displays an editable copy of a chart.
- **Context menus** (shortcut menus) — These menus pop up from the drawing area when you right-click an object. They display commands that apply only to that object. If you right-click an empty area of the chart, the shortcut menu applies to the chart object.
- **Status information** — Near the top of the editor, you can see (and reset) the simulation time and the simulation mode. The bottom status bar displays the status of the Stateflow processing, tool tips, the zoom factor, and the solver.

**Undo and Redo Editor Operations**

You can undo and redo operations that you perform in a chart. When you undo an operation, you reverse the last edit operation that you performed. After you undo operations in the chart, you can also redo them one at a time.
To undo an operation in the chart, select **Edit > Undo**.
To redo an operation in the chart, select **Edit > Redo**.

You can undo and redo many operations you complete on Stateflow objects in the Symbols or Property Inspector windows.

**Exceptions for Undo**

You can undo or redo all editor operations, with the following exceptions:

- You cannot undo the operation of turning subcharting off for a state previously subcharted.

  To understand subcharting, see “Encapsulate Modal Logic Using Subcharts” on page 8-5.

- You cannot undo the drawing of a supertransition or the splitting of an existing transition.

  Splitting of an existing transition refers to the redirection of the source or destination of a transition segment that is part of a supertransition. For a description of supertransitions, see “Draw a Supertransition Into a Subchart” on page 8-13 and “Draw a Supertransition Out of a Subchart” on page 8-15.

- You cannot undo any changes made to the chart using the Stateflow API.

  For a description of the Stateflow API, see “Stateflow Programmatic Interface”.  

---

**Note** When you perform one of the preceding operations, the undo and redo buttons are disabled from undoing and redoing any prior operations.

**Specify Colors and Fonts in a Chart**

You can specify the color and font for items in a chart, for a single item or all items in the chart.

**Change Fonts for a Single Item**

You can change the font for a single item as follows:

1. Right-click the item.
2 In the context menu, select the font type, style, and size from **Format > Font Style**.

**Colors & Fonts Dialog Box**

The Colors & Fonts dialog box helps you specify a color scheme for the chart as a whole, or colors and label fonts for different types of objects in a chart.

To display the Colors & Fonts dialog box, in the Stateflow Editor, select **File > Stateflow Preferences > Style**.

The drawing area of the dialog box displays examples of the types of objects whose colors and font labels you can specify. The examples use the colors and label fonts specified by the current color scheme for the chart. To choose another color scheme, select the scheme from the dialog box's **Schemes** menu. The dialog box displays the selected color scheme. Click **Apply** to apply the selected scheme to the chart or **OK** to apply the scheme and dismiss the dialog box.
To make the selected scheme the default scheme for all charts, select **Make this the "Default" scheme** from the dialog box's **Options** menu.

To modify the current scheme, position your pointer over the example of the type of object whose color or label font you want to change. Then left-click to change the object's color or right-click to change the object's font. If you left-click, a color chooser dialog box appears.

Use the dialog box to select a new color for the selected object type.

If the selected object is a label and you right-click, a font selection dialog box appears.
Use the font selector to choose a new font for the selected label.

To save changes to the default color scheme, select **Save defaults to disk** from the Colors & Fonts dialog box’s **Options** menu.

**Note**  Choosing **Save defaults to disk** has no effect if the modified scheme is not the default scheme.

**Content Preview for Stateflow Objects**

When a chart is closed, you can preview the content of Stateflow charts in Simulink. You can see an outline of the contents of a chart. During simulation you can see chart animation. When a chart is open, you can preview the content of subcharts and Simulink functions.
For example, the Temporal Logic chart uses content preview. The chart Without Temporal Logic does not.

To turn on content preview for Stateflow charts and subcharts, right-click the chart and select **Format > Content Preview**. For Simulink functions, right-click the function and select **Content Preview**. For details on content preview in Simulink, see “Preview Content of Hierarchical Items” (Simulink).

**Note** In order to see the content preview, you may need to enlarge the Stateflow chart or object.

**Intelligent Tab Completion for Stateflow Charts**

Stateflow tab completion provides context-sensitive editing assistance. Tab completion helps you avoid typographical errors. It also helps you quickly select syntax-appropriate
options for keywords, data, event, messages, and function names, without having to navigate the Model Explorer. In a Stateflow chart, to complete entries:

1. Type the first few characters of the word that you want.
2. Press **Tab** to see the list of possible matches.
3. Use the arrow keys to select a word.
4. Press **Tab** to make the selection.

Additionally, you can:

- Close the list without selecting anything by pressing the **Esc** key.
- Type additional characters onto your original term to narrow the list of possible matches.

If you press **Tab** and no words are listed, then the current word is the only possible match.

**Differentiate Elements of Action Language Syntax**

You can use color highlighting to differentiate the following syntax elements:

- Keyword
- Comment
- Event
- Message
- Function
- String
- Number

Syntax highlighting is a user preference, not a model preference.

**Default Syntax Highlighting**

The following chart illustrates the default highlighting for language elements.
If the parser cannot resolve a syntax element, the chart displays the element in the default text color.

To modify color assignments, see “Edit Syntax Highlighting” on page 4-38. To disable syntax highlighting, see “Enable and Disable Syntax Highlighting” on page 4-38.

**Edit Syntax Highlighting**

1. In the Stateflow Editor, select **File > Stateflow Preferences > Syntax Highlighting**.

   The Syntax Highlight Preferences dialog box appears.

2. Click the color that you want to change, choose an alternative from the color palette, and click **Apply**.

3. Click **OK** to close the Syntax Highlight Preferences dialog box.

**Enable and Disable Syntax Highlighting**

1. In the Stateflow Editor, select **File > Stateflow Preferences > Syntax Highlighting**.

   The Syntax Highlight Preferences dialog box appears.
Select or clear **Enable syntax highlighting** and click **OK**.

**Select and Deselect Graphical Objects**

Once an object is in the drawing area, to make any changes or additions to that object, select it.

- To select an object, click anywhere inside of the object.
- To select multiple adjacent objects, click and drag a selection box so that the box encompasses or touches the objects that you want to select, and then release the mouse button.

All objects or portions of objects within the box become selected.

- To select multiple separate objects, simultaneously press the **Shift** key and click an object or box a group of objects.

This step adds objects to the list of already selected objects unless an object was already selected, in which case, the object is deselected. This type of multiple object selection is useful for selecting objects within a state without selecting the state itself.

- To deselect all selected objects, click in the drawing area, but not on an object.

When an object is selected, it appears highlighted in the color set as the selection color (blue by default; see “Specify Colors and Fonts in a Chart” on page 4-32 for more information).

**Cut and Paste Graphical Objects**

You can cut objects from the drawing area or cut and then paste them as many times as you like. You can cut and paste objects from one chart to another. The chart retains a selection list of the most recently cut objects. The objects are pasted in the drawing area location closest to the current pointer location.

- To cut an object, right-click the object and select **Cut** from the context menu.
- To paste the most recently cut selection of objects, right-click in the chart and select **Paste** from the context menu.
Copy Graphical Objects

To copy and paste an object in the drawing area, select the objects and right-click and drag them to the desired location in the drawing area. This operation also updates the chart's clipboard.

**Note** If you copy and paste a state in the chart, these rules apply:

- If the original state uses the default ? label, then the new state retains that label.
- If the original state does not use the default ? label, then a unique name is generated for the new state.

Alternatively, to copy from one chart to another, select **Copy** and then **Paste** from the right-click context menu.

Comment Out Objects

To Comment Out a Stateflow object, right-click the selected object and select **Comment Out**. For more information, see “Commenting Stateflow Objects in a Chart” on page 30-65.

Format Chart Objects

To enhance readability of objects in a chart, in the Stateflow Editor you can use commands in the **Chart > Arrange** menu. These commands include options for:

- Alignment
- Distribution
- Resizing

You can align, distribute, or resize these chart objects:

- States
- Functions
- Boxes
• Junctions

**Align, Distribute, and Resize Chart Objects**

The basic steps to align, distribute, or resize chart objects are similar.

1. If the chart includes parallel states or outgoing transitions from a single source, make sure that the chart uses explicit ordering.

   To set explicit ordering, in the Chart properties dialog box, select **User specified state/transition execution order**.

   **Note** If a chart uses implicit ordering to determine execution order of parallel states or evaluation order of outgoing transitions, the order can change after you align, distribute, or resize chart objects. Using explicit ordering prevents this change from occurring. For more information, see “Execution Order for Parallel States” on page 3-89 and “Transition Evaluation Order” on page 3-67.

2. Select the chart objects that you want to align, distribute, or resize.

   You can select objects in any order, one-by-one or by drawing a box around them.

3. Decide which object to use as the anchor for aligning, distributing, or resizing other chart objects. This object is the reference object.

   To set an object as the reference, right-click the object. Brackets appear around the reference object. In the following example, the Door and Motion states are selected, and the Door state is the reference.
Note If you select objects one-by-one, the last object that you select acts as the reference.

4 Select an option from the **Chart > Arrange** menu to align, distribute, or resize your chosen objects.

For more information about chart object distribution options, see “Options for Distributing Chart Objects” on page 4-43.
### Options for Distributing Chart Objects

<table>
<thead>
<tr>
<th>This option...</th>
<th>Distributes selected objects so that...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Distribute Horizontally</strong></td>
<td>The center-to-center horizontal distance between any two objects is the same.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The horizontal space for distribution is the distance between the left edge of the leftmost object and the right edge of the rightmost object. If the total width of the objects you select exceeds the horizontal space available, objects can overlap after distribution.</td>
</tr>
<tr>
<td><strong>Distribute Vertically</strong></td>
<td>The center-to-center vertical distance between any two objects is the same.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The vertical space for distribution is the distance between the top edge of the highest object and the bottom edge of the lowest object. If the total height of the objects you select exceeds the vertical space available, objects can overlap after distribution.</td>
</tr>
<tr>
<td><strong>Even Horizontal Gaps</strong></td>
<td>The horizontal white space between any two objects is the same.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The space restriction for <strong>Distribute Horizontally</strong> applies.</td>
</tr>
<tr>
<td><strong>Even Vertical Gaps</strong></td>
<td>The vertical white space between any two objects is the same.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The space restriction for <strong>Distribute Vertically</strong> applies.</td>
</tr>
</tbody>
</table>

### Example of Aligning Chart Objects

Suppose that you open the `sf_pool` model and see a chart with multiple MATLAB functions.
To align the three MATLAB functions on the right:

1. Type `sf_pool` at the MATLAB command prompt to open the model. Double-click the Pool block to open the chart.

   **Tip** Expand the Stateflow Editor to see the entire chart.

2. Click the function `isAnyBallGoingToStop`.
3. Shift-click the function `isAnyBallNewlyPocketed`.
4. Shift-click the function `getBallInteraction`.
This object is the reference (or anchor) for aligning the three functions. Brackets appear around the function.

5 Select **Chart > Arrange > Align Right**.

This step aligns the right edges of the three functions based on the right edge of `getBallInteraction`.  

Example of Distributing Chart Objects

Suppose that you open the `sf_frame_sync_controller` model and see a chart with three states.
To distribute the three states vertically:

1. Type `sf_frame_sync_controller` at the MATLAB command prompt to open the model.

   **Tip**: Double-click the Frame Sync Controller block to open the chart.

2. Select the three states in any order.

   Shift-click to select more than one state.
look_for_sync
en:
corrAbs = 0;
du:
[corr, corrAbs] = correlate(IQ);

MATLAB Function
[y, yabs] = correlate(u)

frame_out

[after(300, tick)]
{frame = 0;}

[after(220, tick)]

get_payload
en:
phasor = get_carrier_phase(corr);
frame[0] = IQ * phasor;
du:
frame[temporalCount(tick)] = IQ * phasor;

[corrAbs > 50]
When you select the three states in any order, your reference object might differ from the one shown. This difference does not affect distribution of vertical white space.

3 Select **Chart > Arrange > Even Vertical Gaps.**

This step ensures that the vertical white space between any two states is the same.

**Example of Resizing Chart Objects**

Suppose that you open the `sf_clutch_enabled_subsystems` model and see a chart with graphical functions of different sizes.

To resize the graphical functions so that they all match the size of `detectSlip`:

1. Type `sf_clutch_enabled_subsystems` at the MATLAB command prompt to open the model.
2. In the Friction Mode chart, select the three graphical functions by drawing a box around them.
3. Set `detectSlip` as the reference object to use for resizing.

   Right-click the function to mark it with brackets.
Select **Chart > Arrange > Match Size**.

This step ensures that the three functions are the same size.
5 Adjust the function boxes to correct the format:

a To align the functions, select **Chart > Arrange > Align Left.**
b To distribute the functions evenly in terms of vertical spacing, select Chart > Arrange > Even Vertical Gaps.
Automatic Chart Formatting

With Arrange Automatically, Stateflow arranges your charts to:

- Expand states and transitions to fit their label strings.
- Resize similar states to be the same size.
- Align states if they were slightly misaligned.
- Straightens transitions.
- Repositions horizontal transition labels to the midpoint.

To format your chart, select **Chart > Arrange > Arrange Automatically**.

In this example, the chart has:

1. State actions that are outside of the boundary for state A.
2. A transition condition that overlaps state B.
3. A transition that is not horizontal.
After the layout has been automatically arranged:

1. The state actions are contained within state A.
2. The transition condition does not overlap into state B.
3. The lower transition is horizontal.
Generate a Model Report

The **Print Details** report is an extension of the **Print Details** report in the Simulink model window. It provides a report of Stateflow and Simulink objects relative to the chart currently in view from which you select the report.

To generate a model report on chart objects:

1. Open the chart or subchart for which you want a report.
2. In the editor, select **File > Print > Print Details**.

   The Print Details dialog box appears.
3 Enter the destination directory of the report file and select options to specify what objects appear in the report.

For details on setting the fields in the **File locations/naming options** section, see “Print Model Reports” (Simulink). For details on the report you receive, see “System Report Options” on page 4-57 and “Report Format” on page 4-57.

4 Click **Print**.

The Print Details dialog box appears and tracks the report generation. See “Print Model Reports” (Simulink) for more details on this window.

The HTML report appears in your default browser.

**Tip** If you have the Simulink Report Generator™ installed, you can generate a detailed report about a system. To do so, in the Simulink Editor, select **File** > **Reports** > **System Design Description**. For more information, see “System Design Description” (Simulink Report Generator).
System Report Options

Reports for the current Stateflow chart vary with your choice of one of the **System reporting options** fields:

- **Current** — Reports on the chart or subchart in the current editor window and its immediate parent Simulink system.
- **Current and above** — This option is grayed out and unavailable for printing chart details.
- **Current and below** — Reports on the chart or subchart in the current editor window and all contents at lower levels of the hierarchy, along with the immediate Simulink system.
- **Entire model** — Reports on the entire model including all charts and all Simulink systems.

If you select this option, you can modify the report as follows:

- **Look under mask dialog** - Includes the contents of masked subsystems in the report.
- **Expand unique library links** - Includes the contents of library blocks that are subsystems in the report.

The report includes a library subsystem only once even if it occurs in more than one place in the model.

Report Format

The general top-down format of the **Print Details** report is as follows:

- The report shows the title of the system in the Simulink model containing the chart or subchart in current view.
- A representation of Simulink hierarchy for the containing system and its subsystems follows. Each subsystem in the hierarchy links to the report of its Stateflow charts.
- The report section for the Stateflow charts of each system or subsystem begins with a small report on the system or subsystem, followed by a report of each contained chart.
- Each chart report includes a reproduction of its chart with links for subcharted states that have reports of their own.
- An appendix tabulates the covered Stateflow and Simulink objects in the report.
Model Logic Patterns and Iterative Loops Using Flow Charts

- “Flow Charts in Stateflow” on page 5-2
- “Create Flow Charts with the Pattern Wizard” on page 5-6
**Flow Charts in Stateflow**

A Stateflow flow chart is a graphical construct that models logic patterns such as decision trees and iterative loops. Flow charts represent combinatorial logic in which one result does not depend on prior results. You build flow charts by combining connective junctions and transitions without using any states. The junctions provide decision branches between different transition paths. Executing a flow chart begins at a default transition and ends at a terminating junction (a junction that has no valid outgoing transitions).

A best practice is to encapsulate flow charts in graphical functions to create modular and reusable logic that you can call anywhere in a chart. For more information about graphical functions, see “Reuse Logic Patterns Using Graphical Functions” on page 8-26.

An example of a flow chart that models simple if-else logic:

```
if u > 0
    y = 1;
else
    y = 0;
end
```

The flow chart models this code:

![Flow Chart Image]

**Draw a Flow Chart**

You can draw and customize flow charts manually by using connective junctions as branch points between alternate transition paths:
1. Open a chart.
2. From the editor toolbar, drag one or more connective junctions into the chart with the **Connective Junction** tool:

3. Add transition paths between junctions.
4. Label the transitions.
5. Add a default transition to the junction where the flow chart execution starts.

### Best Practices for Creating Flow Charts

Follow these best practices to create efficient, accurate flow charts:

**Use only one default transition**

Flows charts have a single entry point.

**Provide only one terminating junction**

Multiple terminating junctions reduce readability of a flow chart.

**Converge all transition paths to the terminating junction**

Execution of a flow chart always reaches the termination point.

**Provide an unconditional transition from every junction except the terminating junction**

If unintended backtracking occurs during simulation, a warning message appears.

You can control the level of diagnostic action for unintended backtracking in the **Diagnostics > Stateflow** pane of the Model Configuration Parameters dialog box. For more information, see the documentation for the “Unexpected backtracking” (Simulink) diagnostic.

Unintended backtracking can occur at a junction under these conditions:

- The junction does not have an unconditional transition path to a state or terminating junction.
• Multiple transition paths lead to that junction.

**Use condition actions to process updates, not transition actions**

Flow charts test transitions, but do not execute them (and, therefore, never execute transition actions).

An example that illustrates these best practices:

![Flow chart diagram](image)

**See Also**

**Related Examples**

• “Create Flow Charts with the Pattern Wizard” on page 5-6
• “How Chart Constructs Interact During Execution” on page 3-6
More About

• “States” on page 2-7
• “Transitions” on page 2-19
Create Flow Charts with the Pattern Wizard

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Why Use the Pattern Wizard?” on page 5-6</td>
</tr>
<tr>
<td>“How to Create Reusable Flow Charts” on page 5-6</td>
</tr>
<tr>
<td>“Insert a Logic Pattern Using the Pattern Wizard” on page 5-8</td>
</tr>
<tr>
<td>“Save and Reuse Flow Chart Patterns” on page 5-10</td>
</tr>
<tr>
<td>“MAAB-Compliant Patterns from the Pattern Wizard” on page 5-13</td>
</tr>
<tr>
<td>“Create and Reuse a Custom Pattern with the Pattern Wizard” on page 5-22</td>
</tr>
</tbody>
</table>

Why Use the Pattern Wizard?

The Pattern Wizard is a utility that generates common flow chart patterns for use in graphical functions and charts. Although you can also create flow charts by hand, the Pattern Wizard offers several advantages:

- Generates common logic and iterative loop patterns automatically
- Generates patterns that comply with guidelines from the MathWorks Automotive Advisory Board (MAAB)
- Promotes consistency in geometry and layout across patterns
- Facilitates storing and reusing patterns from a central location
- Provides ability to insert patterns in existing flow charts

Note The Pattern Wizard is only used for flow charts, and cannot be used to save states and subcharts. Atomic subcharts can be used to reuse states and subcharts.

How to Create Reusable Flow Charts

When you create flow charts with the Pattern Wizard, you can save them to a central location where you can retrieve them for reuse. To create reusable flow charts that comply with MAAB guidelines:

1. Open a chart.
**How do I create and open a new Stateflow chart?**

a  Type `sfnew` or `stateflow` at the MATLAB command prompt.

A model opens, containing an empty chart.

b  Double-click the chart to open it.

2  Select a flow chart pattern:

<table>
<thead>
<tr>
<th>To Create:</th>
<th>Select:</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>if decision patterns</td>
<td><strong>Chart &gt; Add Pattern in Chart</strong> &gt; Decision</td>
<td>“Decision Logic Patterns in Flow Charts” on page 5-13</td>
</tr>
<tr>
<td>for-, while-, and do-while-loop patterns</td>
<td><strong>Chart &gt; Add Pattern in Chart</strong> &gt; Loop</td>
<td>“Iterative Loop Patterns in Flow Charts” on page 5-17</td>
</tr>
<tr>
<td>switch patterns</td>
<td><strong>Chart &gt; Add Pattern in Chart</strong> &gt; Switch</td>
<td>“Switch Patterns in Flow Charts” on page 5-18</td>
</tr>
</tbody>
</table>

The Stateflow Patterns dialog box appears.

3  Enter a description of your pattern (optional).

4  Specify conditions and actions (optional).

You can also add or change conditions and actions directly in the chart.

5  Click **OK**.

The pattern appears in your chart. The geometry and layout comply with MAAB guidelines.

6  Customize the pattern as desired.

For example, you may want to add or change flow charts, conditions, or actions. See “Create and Reuse a Custom Pattern with the Pattern Wizard” on page 5-22.

7  Save the pattern to a central location as described in “Save and Reuse Flow Chart Patterns” on page 5-10.

You can now retrieve your pattern directly from the editor to reuse in graphical functions and charts. See “How to Add Flow Chart Patterns in Graphical Functions” on page 5-12 and “How to Add Flow Chart Patterns in Charts” on page 5-12.
Insert a Logic Pattern Using the Pattern Wizard

Using the Pattern Wizard, you can add loop or decision logic extensions to a previously created pattern in a flow chart. Select an eligible vertical transition, and then select Chart > Insert Pattern on Selection. After you select one of the decision or loop patterns, the Pattern Wizard places the new pattern below the action along the transition path.

When you create logic extensions, the following rules apply:

- Select only one exactly vertical transition to extend at a time.
- Select a vertical transition that has a destination junction.
- Extend only a flow chart that was created by the Pattern Wizard.
- Extend only a flow chart that has junctions and transitions in the chart, not other objects.
- Do not extend a pattern that has been custom-created or modified.
- You cannot choose a custom pattern as the extension.

If your selection is not eligible, when you select Chart > Insert Pattern on Selection, you see a message instead of pattern options.

<table>
<thead>
<tr>
<th>Message</th>
<th>Issue</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a vertical transition</td>
<td>You have not selected a vertical transition.</td>
</tr>
<tr>
<td>Selected transition must be exactly vertical</td>
<td>You selected a transition, but it is not vertical.</td>
</tr>
<tr>
<td>Select only one vertical transition</td>
<td>You have selected more than one transition.</td>
</tr>
<tr>
<td>Editor must contain only transitions and</td>
<td>There are other objects, such as states, junctions,</td>
</tr>
<tr>
<td>junctions</td>
<td>functions, or truth tables in the editor.</td>
</tr>
</tbody>
</table>

Insert a Pattern

In this example, you add an if-else pattern into a while-loop body.

1. Open a chart.
2. Select Chart > Add Pattern in Chart > Loop > While.
3. Enter a description of your pattern (optional).
4. Specify conditions and actions (optional).
You can also add or change conditions and actions directly in the chart.

5 Click **OK**.

The *while* pattern appears in your chart.

6 Select the vertical transition labeled `{action1}`.

7 Select **Chart > Insert Pattern on Selection > Decision > If-Else**.

8 Click **OK**.

The *if-else* pattern is added to the *while*-loop below `{action1}`.
Save and Reuse Flow Chart Patterns

Using the Pattern Wizard, you can save flow chart patterns in a central location, then easily retrieve and reuse them in Stateflow graphical functions and charts. The Pattern Wizard lets you access all saved patterns from the editor.

Guidelines for Creating a Pattern Folder

The Pattern Wizard uses a single, flat folder for saving and retrieving flow chart patterns. Follow these guidelines when creating your pattern folder:
• Store all flow charts at the top level of the pattern folder; do not create subfolders.
• Make sure that all flow chart files have a .mdl or .slx extension.

How to Save Flow Chart Patterns for Easy Retrieval

1 Create a folder for storing your patterns according to “Guidelines for Creating a Pattern Folder” on page 5-10.

2 In your chart, select flow charts with the patterns you want to save.

3 Select Chart > Save Pattern.

The Pattern Wizard displays a message that prompts you to choose a folder for storing custom patterns.

The Pattern Wizard stores your flow charts in the pattern folder as a model file. The patterns that you save in this folder appear in a drop-down list when you select Chart > Add Pattern in Chart > Custom, as described in “How to Add Flow Chart Patterns in Graphical Functions” on page 5-12 and “How to Add Flow Chart Patterns in Charts” on page 5-12.

4 Click OK to close the message.

The Browse For Folder dialog box appears.

5 Select the designated folder (or create a new folder) and click OK.

The Save Pattern As dialog box appears.

6 Enter a name for your pattern and click Save.

The Pattern Wizard saves your pattern as a model file in the designated folder.

How to Change Your Pattern Folder

1 Rename your existing pattern folder.

2 Add a pattern as described in “How to Add Flow Chart Patterns in Graphical Functions” on page 5-12 or “How to Add Flow Chart Patterns in Charts” on page 5-12.

The Pattern Wizard prompts you to choose a folder.

3 Follow the instructions in “How to Save Flow Chart Patterns for Easy Retrieval” on page 5-11.
How to Add Flow Chart Patterns in Graphical Functions

1 Add a graphical function to your chart.
   See “Create a Graphical Function” on page 8-18.
2 Make the graphical function into a subchart by right-clicking in the function box and selecting Group & Subchart > Subchart.
   The function box turns gray.
3 Double-click the subcharted graphical function to open it.
4 In the menu bar, select Chart > Add Pattern in Function > Custom.
   The Select a Custom Pattern dialog box appears, displaying all of your saved patterns.

Why does my dialog box not display any patterns?

You have not saved any patterns for the Pattern Wizard to retrieve. See “Save and Reuse Flow Chart Patterns” on page 5-10.
5 Select a pattern from the list in the dialog box and click OK.
   The pattern appears in the graphical function, which expands to fit the flow chart.
6 Define all necessary inputs, outputs, and local data in the graphical function and the chart that calls it.

How to Add Flow Chart Patterns in Charts

1 In the menu bar, select Chart > Add Pattern in Chart > Custom.
   The Select a Custom Pattern dialog box appears, displaying all of your saved patterns.
2 Select a pattern from the list in the dialog box and click OK.
   The pattern appears in the chart.
3 Adjust the chart by hand to:
   • Connect the flow charts to the appropriate transitions.
   • Ensure that there is only one default transition for exclusive (OR) states at each level of hierarchy.
• Define all necessary inputs, outputs, and local data.

**MAAB-Compliant Patterns from the Pattern Wizard**

The Pattern Wizard generates MAAB-compliant flow charts.

**Decision Logic Patterns in Flow Charts**

The Pattern Wizard generates the following MAAB-compliant decision logic patterns:

- `if`

- `if-else`
if-elseif
if-elseif-else
if-elseif-elseif-else
Nested if

Iterative Loop Patterns in Flow Charts

The Pattern Wizard generates the following MAAB-compliant iterative loop patterns:
Switch Patterns in Flow Charts

The Pattern Wizard generates the following MAAB-compliant switch patterns:

**while**

**do-while**

Switch Patterns in Flow Charts

The Pattern Wizard generates the following MAAB-compliant switch patterns:
switch with two cases and default
switch with three cases and default
switch with four cases and default
Create and Reuse a Custom Pattern with the Pattern Wizard

This example shows how to create, modify, and save a custom flow chart pattern for iterating over the upper triangle of a two-dimensional matrix. In the upper triangle, the row index \( i \) is always less than or equal to column index \( j \). This flow chart pattern uses nested \texttt{for}-loops to ensure that \( i \) never exceeds \( j \).

Create the Upper Triangle Iterator Pattern

1. Open a new (empty) chart.
2. Select \texttt{Chart > Add Pattern in Chart > Loop > For}.
3. In the Stateflow Patterns dialog box, enter the initializer, loop test, and counting expressions for iterating through the first dimension of the matrix, as follows:

![Stateflow Patterns dialog box](image)

   Do not specify an action yet. You will add another loop for iterating the second dimension of the matrix.
4. Click \texttt{OK}.

   The Pattern Wizard generates the first iterative loop in your chart.
This pattern:

- Conforms to all best practices for creating flow charts, as described in “Best Practices for Creating Flow Charts” on page 5-3.
- Provides the correct syntax for conditions and condition actions.

5 Add the second loop:

a. Expand the editor window so the chart can accommodate a second pattern.
b. Select the vertical transition labeled \( \{\text{action1}\} \).
c. Select Chart > Insert Pattern on Selection > Loop > For.
d. Enter the initializer, loop test, and counting expressions for the second iterator \( j \), and a placeholder for an action to retrieve each element in the upper triangle as follows:
e Click **OK**. The Pattern Wizard adds the second loop to the first loop.
6  Save your chart.

Save your pattern to a central location for reuse (see “Save the Upper Triangle Iterator Pattern for Reuse” on page 5-25).

**Save the Upper Triangle Iterator Pattern for Reuse**

1  Create a folder for storing flow chart patterns, as described in “Guidelines for Creating a Pattern Folder” on page 5-10.
2  Open the chart that contains the custom pattern.
3  In the chart, select the flow chart with the pattern that you want to save.
4  In the editor, select **Chart > Save Pattern** and take one of these actions.
If you have... | Then Pattern Wizard... | Action
---|---|---
Not yet designated the pattern folder | Prompts you to create or select a pattern folder | Select the folder you just created. See “How to Save Flow Chart Patterns for Easy Retrieval” on page 5-11.
Already designated the pattern folder | Prompts you to save your pattern to the designated folder | Name your pattern and click Save.

The Pattern Wizard automatically saves your pattern as a model file under the name that you specify.

**Add the Upper Triangle Iterator Pattern to a Graphical Function**

1. Open a new chart.
2. Drag a graphical function into the chart from the object palette.
3. Enter the following function signature:
   
   function y = ut_iterator(u, numrow, numcol)

   The function takes three inputs.

<table>
<thead>
<tr>
<th>Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>u</td>
<td>2-D matrix</td>
</tr>
<tr>
<td>numrow</td>
<td>Number of rows in the matrix</td>
</tr>
<tr>
<td>numcol</td>
<td>Number of columns in the matrix</td>
</tr>
</tbody>
</table>

4. Right-click inside the function and select **Group & Subchart > Subchart**.

The function looks like this graphic.

![Function y = ut_iterator(u, numrow, numcol)](function_y_ut_iterator_u_numrow_numcol)
Double-click to open the subcharted function and select **Chart > Add Pattern in Function > Custom**.

The Select a Custom Pattern dialog box opens, listing all the patterns that you have saved in your pattern folder.

Select your upper triangle iterator pattern and click **OK**.

The Pattern Wizard adds your custom pattern to the graphical function.
Before calling this function from a chart, be sure to modify data names, types, and sizes as necessary and substitute an appropriate action.
Simulink Subsystems as Stateflow States

- “Simulink Subsystems as States” on page 6-2
- “Create and Edit Simulink Based States” on page 6-11
- “Access Block State Data” on page 6-20
- “Map Variables for Simulink Based States” on page 6-28
- “Set Simulink Based State Properties” on page 6-31
- “Limitations” on page 6-33
Simulink Subsystems as States

**In this section...**

“When to Use Simulink Based States” on page 6-2
“Model a Pole Vaulter by Using Simulink Based States” on page 6-3

By using a Simulink subsystem within a Stateflow state, you can model hybrid dynamic systems or systems that switch between periodic or continuous time dynamics. In your Stateflow chart, you can use Simulink based states to model a periodic or continuous dynamic system combined with switching logic that uses transitions. You can access inputs and outputs from your chart within each Simulink based state.

To initialize Simulink blocks when switching between Simulink based states, use Stateflow textual notation or Simulink State Reader and State Writer blocks.

To create linked Simulink based states, use libraries to save action subsystems. When you copy an action subsystem from a library model into a Stateflow chart, it appears as a linked Simulink based state. When you update the library block, the changes are reflected in all Stateflow charts containing the block.

Using Simulink based states means that you do not have to use complex textual syntax in Stateflow to model hybrid systems.

**When to Use Simulink Based States**

Use Simulink based states when:

- You want to model hybrid dynamic systems that include continuous or periodic dynamics.
- The structure of the system dynamics change substantially between the various modes of operation, for example, modeling PID controllers.

For systems where you call logic intermittently, use Simulink functions.

When the structure of the Simulink algorithm remains substantially unchanged, but certain gains or parameters switch between various models, use Simulink logic outside of Stateflow. An example of this type of algorithm is gain scheduling. See “Model Gain-Scheduled Control Systems in Simulink” (Simulink Control Design).
Model a Pole Vaulter by Using Simulink Based States

This Stateflow chart models a person moving through the stages of pole vaulting by using Simulink based states. The first stage is the approach run of the vaulter, which is modeled in the Simulink based state Run_up. In the second stage, the vaulter plants the pole and takes off, which is modeled by the Simulink based state Take_off. The final stage happens when the vaulter clears the bar and releases the pole, which is modeled by the Simulink based state Fly.

The Stateflow chart contains this logic:

The states Run_up and Fly are easier to model by using Cartesian coordinates. The state Take_off is easier to model by using polar coordinates. To switch from one coordinate system to another, use Simulink functions InitTakeOff and InitFly.
Simulink Subsystems as Stateflow States

Run_up

Simulink Function
InitTakeOff

[Run_up.p(1) > -4]
{InitTakeOff();}

Take_off

Simulink Function
InitFly

[Take_off.theta < pi/2]
{InitFly();}

Fly
**Model the Approach of the Pole Vaulter**

The Simulink based state Run_up contains this logic:

The default state in the chart PoleVaulter is Run_up. This state models the pole vaulter traveling along the ground toward the jump. The pole vaulter starts at -10 on the x-axis and runs toward zero. As the pole vaulter moves along the ground, the position of the pole vaulter in the xy-plane is continuously changing, but the state of running remains the same. In this model, the integrator blocks Position and Velocity are state owner blocks for State Reader blocks in the Simulink function InitTakeOff. This subsystem outputs the Cartesian coordinates of the pole vaulter.

![Simulink Diagram](image)

**Convert Cartesian Coordinates to Polar Coordinates**

The Simulink function InitTakeOff contains this logic:

Once the position of the pole vaulter along the x-axis, Run_up.p(1), becomes greater than -4, the transition from Run_up to Take_off occurs. During the transition InitTakeOff is initialized, the State Reader block connects to its owner block, and the function is executed. This function converts the Cartesian coordinates from Position and Velocity to polar coordinates, r, theta, rdot, and theta_dot. These coordinates are output as State Writer blocks, which are connected to owner blocks in the state Take_off.
Model the Take Off of the Pole Vaulter

The Simulink based state Take_off contains this logic:

Once the position of the pole vaulter along the x-axis, Run_up.p(1), becomes greater than -4, the active state becomes Take_off. This Simulink subsystem models the pole vaulter during the take off phase of the jump. The subsystem outputs the Cartesian coordinates of the pole vaulter.
Convert Polar Coordinates to Cartesian Coordinates

The Simulink function InitFly contains this logic:

Once the angle of the pole vaulter, theta, becomes less than \( \pi/2 \), the transition from Take_off to Fly occurs. During the transition InitFly is initialized, the State Reader block connects to its owner block, and the function is executed. This function converts the polar coordinates from \( r \), \( \theta \), and \( \theta_\cdot \) to Cartesian coordinates, \( xy_{\text{integ}} \) and \( xy_{\cdot\cdot} \). These coordinates are output as State Writer blocks, which are connected to owner blocks in the state Fly.
**Model the Free Fall of the Pole Vaulter**

The Simulink based state `Fly` contains this logic:

Once the angle of the pole vaulter, `theta`, is less than `pi/2`, the active state becomes `Fly`. This state models the pole vaulter after the jump has cleared and the pole vaulter is falling to the ground. As the pole vaulter falls, the position of the pole vaulter in the x-y plane is continuously changing, but the state of falling remains the same. In this model, the integrator blocks `xydot` and `xy_integ` are state owner blocks for State Writer blocks in the Simulink function `InitFly`. This subsystem outputs the Cartesian coordinates of the pole vaulter.
The results of this simulation are seen in the XY Graph.
See Also

More About
- “Reuse Charts in Models with Chart Libraries” on page 23-18
- “Custom Libraries and Linked Blocks” (Simulink)
Create and Edit Simulink Based States

In this section...

“Create a Simulink Based State” on page 6-11
“Create Inports and Outports” on page 6-16

To model systems that switch between periodic or continuous time dynamics, use Simulink based states. You can create Simulink based state by using the drawing tool. To reuse systems from separate Simulink models, copy and paste enabled subsystems. To reuse subsystems in multiple Stateflow charts, copy and paste action subsystems that are saved in a library.

Create a Simulink Based State

To create a Simulink based state, do one of the following:

• Create an empty Simulink based state by using the Simulink based state drawing tool.
• Create a Simulink based state from another model by copying an enabled subsystem or an action subsystem to your Stateflow chart.
• Create a linked Simulink based state by copying an action subsystem from a library to your Stateflow chart.

Create an Empty Simulink Based State

1 Add a Stateflow chart block to a Simulink model. To open the Stateflow editor, double-click the block.

2 On the object palette, click the Simulink based state drawing tool. Move your cursor onto your chart.

3 To place the new Simulink based state, click the Stateflow canvas. A shaded state appears.
4  Enter the state label. In this example, the state models a pole vaulter running along a flat surface, so the state label is Run_up. Simulink based states are action subsystems, so an Action Port appears with your new state.

5  Build your Simulink subsystem. This subsystem outputs the Cartesian coordinates of the pole vaulter. For more information about this model, see “Access Block State Data” on page 6-20.
Create a Simulink Based State from an Enabled Subsystem

To create a Simulink based state in your Stateflow chart, copy enabled subsystems from separate Simulink models. You can reuse components from Simulink models in a Stateflow chart without creating a brand new Simulink based state.

1. To open the Stateflow clutch model, at the command prompt type

   `open_system('sf_clutch_enabled_subsystems').`
2. From the model, copy the block *Slipping* to your Stateflow chart.
3 The imports and outputs of your Simulink subsystem appear as undefined symbols in your Stateflow chart. To add corresponding input and output data to your Stateflow chart, click the **Resolve undefined symbols** button.

Create a Linked Simulink Based State

To create a linked Simulink based state in your Stateflow chart, copy an action subsystem from a library to Stateflow. When the library block is updated, the changes are reflected in all Stateflow charts containing the block.

1 To open the model, at the command prompt, type:

   ```
   exPath = fullfile(matlabroot,'help','toolbox','stateflow','examples');
   open_system(fullfile(exPath,'PoleVaultLib'));
   ```

2 Copy and paste the library block Run_up to your Stateflow chart.
3 To display a link in the bottom leftmost corner on a linked subsystem, select **Display** > **Library Links** > **All**.

4 The outports of this Simulink subsystem, $xy$, appears as an undefined symbol in your Stateflow chart. To add a corresponding output data to your Stateflow chart, click the **Resolve undefined symbols** button.

**Create Inports and Outports**

When using Simulink based states, inports and outports for your Simulink subsystem connect to input and output data at the Stateflow chart level. This connection allows the
top-level Simulink model to read data from the subsystem contained within your Simulink based state.

When you create an empty Simulink based state, Stateflow creates inputs and outputs in your Simulink subsystem that correspond to inputs and outputs that exist in the parent Stateflow chart. However, if you add inports and outports to your Simulink based state after it is created, you must create corresponding input and output data for your Stateflow chart.

To create additional inports or outports for a Simulink based state:

1. Open your Simulink based state.
2. Click the Simulink canvas, type in1, and press Enter. An undefined inport is created.
3. The undefined symbol in1 appears in the Symbols window of your Stateflow chart. To resolve the undefined symbol, click the Resolve undefined symbols button.
4. A chart inport named In1 is created.

Create an Additional Outport

In this example, you create an additional outport for the model PoleVaultStateflowExample:

1. To open your model, at the command prompt type:

   ```matlab
   exPath = fullfile(matlabroot,'help','toolbox','stateflow','examples');
   open_system(fullfile(expath,'PoleVaultStateflowExample'));
   ```

2. Open the chart PoleVaulter and double-click Simulink based state Take_off.
3. Click the Simulink based state canvas and type out1 and press Enter. An undefined outport is created. Rename the outport theta_out and connect it to the signal for theta.
4 In the Symbols window of PoleVaulter, an undefined symbol for theta_out appears. To resolve the undefined symbol, click the **Resolve undefined symbols** button. 


Stateflow creates an output in the chart called `theta_out` that corresponds to the outport `theta_out`.

For more information about editing data, see “Add and Modify Data, Events, and Messages in the Symbols Window” on page 31-5.

**See Also**

**More About**
- “Simulink Subsystems as States” on page 6-2
- “Access Block State Data” on page 6-20
- “Map Variables in a Simulink Based State” on page 6-28
- “Reuse Charts in Models with Chart Libraries” on page 23-18
- “Custom Libraries and Linked Blocks” (Simulink)
Access Block State Data

You can read and write the state of blocks within your Simulink based states in transition actions of your Stateflow chart. You can read and write the state of blocks textually on the chart transitions or by using Simulink State Reader and State Writer blocks.

This Stateflow chart models a person moving through the stages of pole vaulting. The first stage is the approach run of the vaulter, which is modeled by the Simulink based state Run_up. In the second stage, the vaulter plants the pole and takes off, which is modeled by the Simulink based state Take_off. The final stage happens when the vaulter clears the bar and releases the pole, which is modeled by the Simulink based state Fly.

The states Run_up and Fly are easier to model by using Cartesian coordinates. The state Take_off is easier to model by using polar coordinates. The Simulink functions InitTakeOff and InitFly are used to switch from one coordinate system to another.

For more details on this chart, see “Model a Pole Vaulter by Using Simulink Based States” on page 6-3.
[Run_up.p(1) > -4]
{InitTakeOff();}

[Take_off.theta < pi/2]
{InitFly();}


**Textual Access**

This subsystem is contained within the Simulink based state Run_up. For the transition from Run_up to Take_off to occur, the position of the pole vaulter along the x-axis, \( p(1) \), must be greater than -4.

By setting the State Name of the integrator block Position to \( \text{'p'} \), you can textually access the state of this block from your Stateflow chart. To access the state of the integrator block in the transition condition, type \([\text{Run}_\text{up}.p(1)>-4]\). When this condition becomes true, the transition is taken and the active state becomes Take_off.
In the Symbols Window, you can see that the state 'p' appears under the state Run_up.
Graphical Access

Stateflow uses State Reader and State Writer blocks to connect the subsystems within a Simulink based state to other Simulink subsystems in your model. State Reader and State Writer blocks display the name of the state owner block that they are connected to. Conversely, the state owner block displays a tag indicating a link to a State Reader or a State Writer block. If you click the label above the tag, a list opens with a link for navigating to the State Writer block.

Connect a State Reader Block to an Owner Block

The following subsystem is contained within the Simulink function InitTakeOff. The function uses State Reader blocks to connect to the state Run_up and reads p and v. The function then converts the Cartesian values for the position of the pole vaulter and velocity into polar coordinates, r and theta and rdot and theta_dot, respectively. These polar coordinates are then accessed by using state owner blocks in the state Take_off.

When the transition action occurs, the State Reader blocks in InitTakeOff read the state of their state owner blocks. Once the Simulink function finishes executing, the State Writer blocks write to the state owner blocks in the Simulink based state Take_off.
To connect a State Reader or a State Writer block to an owner block within a Simulink subsystem:

1. To open the properties, double-click the State Reader.
2. In the **State Owner Selector Tree**, navigate to the block that you want to be the state owner block. In this example, by choosing **Position**, you connect the State Reader block to the integrator **Position** in the state **Run_up**.
3 By connecting the State Reader block to the Position integrator block, this Simulink function can use the state of the integrator Position to execute.

See Also

More About

- “Simulink Subsystems as States” on page 6-2
- State Reader
• State Writer
Map Variables for Simulink Based States

You can access inports or outports of a subsystem within a Simulink based state by using inputs and outputs in Stateflow that have the same name as your inports and outports. For Simulink based states that are created by copying and pasting enabled subsystems and action subsystems from a library, click the **Resolve undefined symbols** button to map your Simulink inports and outports to Stateflow inputs and outputs automatically. See “Create Inports and Outports” on page 6-16.

If you are using a linked Simulink based state where the name of the inport or outport differs from the Stateflow chart input or output, you must ensure that your variables are mapped correctly. You can change your mappings from the Property Inspector or in the Mappings dialog box.

**Map Variables in a Simulink Based State**

To open the mappings dialog box, select **Chart > Mappings**.
Under **Input Mapping**, you can specify which parent chart input maps to an inport in your Simulink subsystem.

Under **Output Mapping**, you can specify which parent chart output maps to an outport in your Simulink subsystem.
See Also

More About

- “Simulink Subsystems as States” on page 6-2
- “Create and Edit Simulink Based States” on page 6-11
- “Access Block State Data” on page 6-20
- “Resolve Undefined Data in the Symbols Window” on page 29-35
Set Simulink Based State Properties

Set and modify the properties of a Simulink based state in the Property Inspector or in a Simulink based state properties dialog box.

For a Simulink based state, you can set these properties.

<table>
<thead>
<tr>
<th>Simulink Based State Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create data for monitoring self activity</td>
<td>Creates a data output port on the Stateflow block for this self-activity of the state.</td>
</tr>
<tr>
<td>Log self activity</td>
<td>Logs the state self-activity. View the activity of the state in the Simulink Data Inspector.</td>
</tr>
<tr>
<td>Logging name</td>
<td>Specify the signal logging name. To create a signal logging name that is different from the state name, choose Custom, and add the name.</td>
</tr>
<tr>
<td>Limit data points to last</td>
<td>Maximum number of data points to log. Default value is 5000, which means the chart logs the last 5000 data points generated by the simulation.</td>
</tr>
<tr>
<td>Decimation</td>
<td>Decimation interval limits the amount of data logged by skipping samples. Default value is 2, which means the chart logs every other sample.</td>
</tr>
<tr>
<td>Test point</td>
<td>Sets the Simulink based state as a Stateflow test point. See “Monitor Test Points in Stateflow Charts” on page 30-43.</td>
</tr>
</tbody>
</table>
### Simulink Based State Properties | Description
--- | ---
Function packaging | Specify the code format generated for a Simulink based state. You can set the format to one of these options:
- **Auto** — Simulink Coder software chooses the optimal format for you based on the type and number of instances of the subsystem that exist in the model.
- **Inline** — Simulink Coder software inlines the subsystem unconditionally.
- **Nonreusable function** — Simulink Coder software explicitly generates a separate function in a separate file.
- **Reusable function** — Simulink Coder software generates a function with arguments that allows reuse of Simulink based state code when a model includes multiple instances of the Simulink based state.

See “Function packaging” (Simulink).

### See Also
**More About**
- “Rules for Naming Stateflow Objects” on page 2-4
- “Watch Stateflow Data Values” on page 30-34
- “Size Stateflow Data” on page 9-47
- “Use Data Types in Stateflow” on page 9-39
Limitations

You cannot use Simulink based states with:

- Moore charts
- Discrete Event charts
- HDL Coder
- PLC Coder
- Simulink Code Inspector
- Superstep transitions

Simulink based states do not support debugging.

See Also

More About

- “Simulink Subsystems as States” on page 6-2
- “Create a Simulink Based State” on page 6-11
Build Mealy and Moore Charts

- “Overview of Mealy and Moore Machines” on page 7-2
- “Create Mealy and Moore Charts” on page 7-5
- “Model a Vending Machine Using Mealy Semantics” on page 7-6
- “Design Considerations for Mealy Charts” on page 7-8
- “Design Considerations for Moore Charts” on page 7-11
- “Model a Traffic Light Using Moore Semantics” on page 7-16
- “Effects of Changing the Chart Type” on page 7-19
- “Debug Mealy and Moore Charts” on page 7-20
Overview of Mealy and Moore Machines

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Semantics of Mealy and Moore Machines” on page 7-2</td>
</tr>
<tr>
<td>“Model with Mealy and Moore Machines” on page 7-3</td>
</tr>
<tr>
<td>“Default State Machine Type” on page 7-3</td>
</tr>
<tr>
<td>“Availability of Output” on page 7-3</td>
</tr>
<tr>
<td>“Advantages of Mealy and Moore Charts” on page 7-3</td>
</tr>
</tbody>
</table>

Semantics of Mealy and Moore Machines

Mealy and Moore are often considered the basic, industry-standard paradigms for modeling finite-state machines. Generally in state machine models, the next state is a function of the current state and its inputs, as follows:

\[ X(n + 1) = f(X(n), u) \]

In this equation:

- \( X(n) \) represents the state at time step \( n \)
- \( X(n+1) \) represents the state at the next time step \( n+1 \)
- \( u \) represents inputs

State is a combination of local data and chart activity. Therefore, computing state means updating local data and making transitions from a currently active state to a new state. State persists from one time step to another.

In this context, Mealy and Moore machines each have well-defined semantics.

<table>
<thead>
<tr>
<th>Type of Machine</th>
<th>Semantics</th>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mealy</td>
<td>Output is a function of inputs and state: ( y = g(X, u) )</td>
<td>Clocked synchronous machines where state transitions occur on clock edges</td>
</tr>
<tr>
<td>Type of Machine</td>
<td>Semantics</td>
<td>Applications</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>Moore</td>
<td>Output is a function only of state: $y = g(X)$</td>
<td>Clocked synchronous machines where outputs are modified at clock edges</td>
</tr>
</tbody>
</table>

You can create charts that implement pure Mealy or Moore semantics as a subset of Stateflow chart semantics (see “Create Mealy and Moore Charts” on page 7-5). Mealy and Moore charts can be used in simulation and code generation with Embedded Coder®, Simulink Coder, and HDL Coder™ software, which are available separately.

**Model with Mealy and Moore Machines**

Stateflow software ships with a model that shows how to use Mealy and Moore machines for sequence recognition in signal processing. To open the model, enter `sf_seqrec` at the MATLAB prompt.

**Default State Machine Type**

When you create a Stateflow chart, the default type is a hybrid state machine model that combines the semantics of Mealy and Moore charts with the extended Stateflow chart semantics. This default chart type is called *Classic*.

**Availability of Output**

Mealy machines compute output on transitions, while Moore machines compute outputs in states. Therefore, Mealy charts can compute output earlier than Moore charts — that is, at the time the chart’s default path executes. If you enable the chart property **Execute (enter) Chart At Initialization** for a Mealy chart, this computation occurs at $t = 0$ (first time step); otherwise, it occurs at $t = 1$ (next time step). By contrast, Moore machines can compute outputs only *after* the default path executes. Until then, outputs take the default values.

**Advantages of Mealy and Moore Charts**

Mealy and Moore charts offer the following advantages over Classic Stateflow charts:
• You can verify the Mealy and Moore charts you create to ensure that they conform to their formal definitions and semantic rules. Error messages appear at compile time (not at design time).
• Moore charts provide a more efficient implementation than Classic charts, both for C/C++ and HDL targets.
• You can use a Moore chart to model a feedback loop. In Moore charts, inputs do not have direct feedthrough. Therefore, you can design a loop with feedback from the output port to the input port without introducing an algebraic loop. Mealy and Classic charts have direct feedthrough and error with an algebraic loop.

See Also

More About
• “Design Considerations for Mealy Charts” on page 7-8
• “Design Considerations for Moore Charts” on page 7-11
To create a new Mealy or Moore chart, follow these steps:

1. Add a new Chart block to a Simulink model. Then double-click the block to open the Stateflow Editor.
2. Right-click in an empty area of the chart and select Properties. The Chart Properties dialog box opens.
3. From the State Machine Type drop-down menu, select Mealy or Moore.
4. Click OK. The chart icon updates to display the selected chart type:

<table>
<thead>
<tr>
<th>Mealy</th>
<th>Moore</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Mealy]</td>
<td>![Moore]</td>
</tr>
</tbody>
</table>

5. Design your chart according to the guidelines for the chart type (see “Design Considerations for Mealy Charts” on page 7-8 and “Design Considerations for Moore Charts” on page 7-11.)
Model a Vending Machine Using Mealy Semantics

The following chart uses Mealy semantics to model a vending machine.

Open the Model

To open the model of a Mealy vending machine, type `sf_mealy_vending_machine` at the MATLAB command prompt.

Logic of the Mealy Vending Machine

In this example, the vending machine requires 15 cents to release a can of soda. The purchaser can insert a nickel or a dime, one at a time, to purchase the soda. The chart behaves like a Mealy machine because its output `soda` depends on both the input `coin` and current state, as follows:

**When initial state `got_0` is active.**  No coin has been received or no coins are left.

- If a nickel is received (`coin == 1`), output `soda` remains 0, but state `got_nickel` becomes active.
• If a dime is received (coin == 2), output soda remains 0, but state got_dime becomes active.

• If input coin is not a dime or a nickel, state got_0 stays active and no soda is released (output soda = 0).

In active state got_nickel. A nickel was received.

• If another nickel is received (coin == 1), state got_dime becomes active, but no can is released (soda remains at 0).

• If a dime is received (coin == 2), a can is released (soda = 1), the coins are banked, and the active state becomes got_0 because no coins are left.

• If input coin is not a dime or a nickel, state got_nickel stays active and no can is released (output soda = 0).

In active state got_dime. A dime was received.

• If a nickel is received (coin == 1), a can is released (soda = 1), the coins are banked, and the active state becomes got_0 because no coins are left.

• If a dime is received (coin == 2), a can is released (soda = 1), 15 cents is banked, and the active state becomes got_nickel because a nickel (change) is left.

• If input coin is not a dime or a nickel, state got_dime stays active and no can is released (output soda = 0).

**Design Rules in Mealy Vending Machine**

This example of a Mealy vending machine illustrates the following Mealy design rules:

• The chart computes outputs in condition actions.

• There are no state actions or transition actions.

• The chart defines chart inputs (coin) and outputs (soda).

• The value of the input coin determines the output — whether or not soda is released.
Design Considerations for Mealy Charts

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Mealy Semantics” on page 7-8</td>
</tr>
<tr>
<td>“Design Rules for Mealy Charts” on page 7-8</td>
</tr>
</tbody>
</table>

Mealy Semantics

To ensure that output is a function of input and state, Mealy state machines enforce the following semantics:

- Outputs never depend on previous outputs.
- Outputs never depend on the next state.
- Chart wakes up periodically based on a system clock.

**Note** A chart provides one time base for input and clock (see “Calculate Output and State Using One Time Base” on page 7-10).

- Chart must compute outputs whenever there is a change on the input port.
- Chart must compute outputs only in transitions, not in states.

Design Rules for Mealy Charts

To conform to the Mealy definition of a state machine, you must ensure that a Mealy chart computes outputs every time there is a change on the input port. As a result, you must follow a set of design rules for Mealy charts.

- “Compute Outputs in Condition Actions Only” on page 7-9
- “Do Not Use State Actions or Transition Actions” on page 7-9
- “Restrict Use of Data” on page 7-9
- “Restrict Use of Events” on page 7-9
- “Calculate Output and State Using One Time Base” on page 7-10
Compute Outputs in Condition Actions Only

You can compute outputs only in the condition actions of outer and inner transitions. A common modeling style for Mealy machines is to test inputs in conditions and compute outputs in the associated action.

Do Not Use State Actions or Transition Actions

You cannot use state actions or transition actions in Mealy charts. This restriction enforces Mealy semantics by:

- Preventing you from computing output without considering changes on the input port
- Ensuring that output depends on current state and not next state

Restrict Use of Data

You can define inputs, outputs, local data, parameters, and constants in Mealy charts, but other data restrictions apply:

- “Restrict Machine-Parented Data” on page 7-9
- “Do Not Define Data Store Memory” on page 7-9

Restrict Machine-Parented Data

Machine-parented data is data that you define for a Stateflow machine, which is the collection of all Stateflow blocks in a Simulink model. The Stateflow machine is the highest level of the Stateflow hierarchy. When you define data at this level, every chart in the machine can read and modify the data. To ensure that Mealy charts do not access data that can be modified unpredictably outside the chart, do not use machine-parented data.

Do Not Define Data Store Memory

You cannot define data store memory (DSM) in Mealy charts because DSM objects can be modified by objects external to the chart. A Stateflow chart uses data store memory to share data with a Simulink model. Data store memory acts as global data that can be modified by other blocks and models in the Simulink hierarchy that contains the chart. Mealy charts should not access data that can change unpredictably.

Restrict Use of Events

Limit the use of events in Mealy charts as follows:
<table>
<thead>
<tr>
<th><strong>Do:</strong></th>
<th><strong>Do Not:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Use input events to trigger the chart</td>
<td>Broadcast any type of event</td>
</tr>
<tr>
<td>Use event-based temporal logic to guard transitions</td>
<td>Use local events to guard transitions</td>
</tr>
</tbody>
</table>
| You can use event-based temporal logic in Mealy charts because it behaves synchronously (see “Operators for Event-Based Temporal Logic” on page 12-56). Think of the change in value of a temporal logic condition as an event that the chart schedules internally. Therefore, at each time step, the chart retains its notion of state because it knows how many ticks remain before the temporal event executes. | You cannot use local events in Mealy charts because they are not deterministic. These events can occur while the chart computes outputs and, therefore, violate Mealy semantics that require charts to compute outputs whenever input changes. Use implicit events such as \texttt{chg(data\_name)}, \texttt{en(state\_name)}, or \texttt{ex(state\_name)}.

**Note** In Mealy charts, the base event for temporal logic operators must be a predefined event such as \texttt{tick} or \texttt{wakeup} (see “Keywords for Implicit Events” on page 10-35). |

**Calculate Output and State Using One Time Base**

You can use one time base for clock and input, as determined by the Simulink solver (see “Solvers” (Simulink)). The Simulink solver sets the clock rate to be fast enough to capture input changes. As a result, a Mealy chart commonly computes outputs and changes states in the same time step.
Design Considerations for Moore Charts

In this section...

"Moore Semantics” on page 7-11
"Design Rules for Moore Charts” on page 7-11

Moore Semantics

In Moore charts, output is a function of current state only. At every time step, a Moore chart wakes up, computes its outputs, and then evaluates its inputs to reconfigure itself for the next time step. For example, after evaluating its inputs, the Moore chart might take transitions to a new configuration of active states, also called next state. However, the Moore chart must always compute its outputs before changing state.

To ensure that output is a function only of state, Moore state machines enforce the following semantics:

- Outputs depend only on the current state, not inputs.
- Outputs do not depend on previous outputs.
- Chart must compute outputs only in states, not in transitions.
- Chart must compute outputs before updating state.

Design Rules for Moore Charts

To conform to the Moore definition of a state machine, you must ensure that every time a Moore chart wakes up, it computes outputs from the current set of active states without regard to input. Therefore, you must follow a set of design rules for Moore charts.

- “Compute Outputs in State Actions, Not on Transitions” on page 7-12
- “Restrict Data Scope” on page 7-12
- “Do Not Use Inputs to Compute Outputs” on page 7-13
- “Do Not Use coder.extrinsic to Call Extrinsic Functions” on page 7-13
- “Do Not Use Actions on Transitions” on page 7-13
- “Do Not Use a Pure Flow Graph” on page 7-14
- “Do Not Use Simulink Functions” on page 7-14
Compute Outputs in State Actions, Not on Transitions

To ensure that outputs depend solely on current state, you must compute outputs in state actions, subject to the following restrictions:

- “Combine Actions” on page 7-12
- “Do Not Label State Actions” on page 7-12

You cannot define actions on transitions because transitions almost always depend on inputs. For example, if you compute outputs in a condition action on a transition, the chart updates outputs whenever there is a change on the input, which is a violation of Moore semantics.

Combine Actions

For Classic charts, you can define different types of actions in states (see “State Action Types” on page 12-2). In Moore charts, you can include only one action per state. The action for a state can consist of multiple command statements. Stateflow evaluates states in Moore charts from the top level down. Active states in Moore charts execute the state action before evaluating the transitions. Therefore, outputs are computed at each time step whether an outer transition is valid or not.

Do Not Label State Actions

Do not label state actions in Moore charts with any keywords, such as en, du, or ex.

Restrict Data Scope

In Moore charts, these data restrictions apply:

- “Restrict Machine-Parented Data” on page 7-13
- “Do Not Define Data Store Memory” on page 7-13
Restrict Machine-Parented Data

Machine-parented data is data that you define for a Stateflow machine. The Stateflow machine is the highest level of the Stateflow hierarchy. When you define data at this level, every chart in the machine can read and modify the data. To ensure that Moore charts do not access data that can be modified unpredictably outside the chart, do not use machine-parented data.

Do Not Define Data Store Memory

You cannot define data store memory (DSM) in Moore charts because objects external to the chart modify DSM objects. A Stateflow chart uses data store memory to share data with a Simulink model. Data store memory acts as global data. Other blocks and models in the Simulink hierarchy that contains the chart can modify DSM. Moore charts must not access data that can change unpredictably.

Do Not Use Inputs to Compute Outputs

In Moore charts, outputs cannot depend on inputs. Therefore, using an input to contribute directly or indirectly to the computation of an output triggers an error.

Do Not Use coder.extrinsic to Call Extrinsic Functions

When calling extrinsic functions with `coder.extrinsic`, it is not possible to enforce that the outputs depend only on the current state. Therefore, calling an extrinsic function with `coder.extrinsic` in a Moore chart triggers an error.

Do Not Use Actions on Transitions

You cannot define condition actions or transition actions in Moore charts.

These transitions are not valid in a Moore chart.

![Diagram of transitions in Moore charts](image)
Here, each transition tests input $u$ in a condition, but modifies output $y$ in a condition action, based on the value of the input. This construct violates Moore semantics and triggers an error. Similarly, you cannot use transition actions in Moore charts.

**Do Not Use a Pure Flow Graph**

Because Moore charts cannot have condition or transition actions, use states to produce actions.

**Do Not Use Simulink Functions**

You cannot use Simulink functions in Moore charts. This restriction prevents violations of Moore semantics during chart execution.

**Do Not Export Functions**

You cannot exports functions in a Moore chart.

**Do Not Disable Inlining**

Moore chart semantics require inlining. Do not force inlining off.

**Do Not Enable Super Step Semantics**

You cannot use super step semantics in a Moore chart.

**Do Not Use Messages**

You cannot use messages in a Moore chart.

**Restrict Use of Events**

Limit the use of events in Moore charts:

<table>
<thead>
<tr>
<th>Valid:</th>
<th>Invalid:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use only one input event to trigger the chart.</td>
<td>You cannot broadcast any type of event.</td>
</tr>
<tr>
<td><strong>Valid:</strong></td>
<td><strong>Invalid:</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Use event-based temporal logic to guard transitions.</td>
<td>You cannot use local events to guard transitions.</td>
</tr>
<tr>
<td>You can use event-based temporal logic in Moore charts because the logic behaves synchronously (see “Operators for Event-Based Temporal Logic” on page 12-56). Think of the change in value of a temporal logic condition as an event that the chart schedules internally. Therefore, at each time step, the chart retains its notion of state because it knows how many ticks remain before the temporal event executes.</td>
<td>You cannot use local events in Moore charts because they are not deterministic. These events can occur while the chart computes outputs and, therefore, violate Moore semantics.</td>
</tr>
</tbody>
</table>

**Note** In Moore charts, the base event for temporal logic operators must be a predefined event such as `tick` or `wakeup` (see “Keywords for Implicit Events” on page 10-35). | You cannot use implicit events such as `chg(data_name)`, `en(state_name)`, or `ex(state_name)`.

---

**Do Not Use Moore Charts for Modeling Systems with Continuous-Time**

In Moore charts, you cannot set the update method to Continuous. For modeling systems with continuous-time in Stateflow, use Classic or Mealy charts.
Model a Traffic Light Using Moore Semantics

The following chart uses Moore semantics to model a traffic light:

![Traffic Light Model Diagram](image)

**Open the Model**

To open the model of a Moore traffic light, type `sf_moore_traffic_light` at the MATLAB command prompt.

**Logic of the Moore Traffic Light**

In this example, the traffic light model contains a Moore chart called `Light_Controller`, which operates in five traffic states. Each state represents the color of the traffic light in two opposite directions — North-South and East-West — and the duration of the current color. The name of each state represents the operation of the light viewed from the North-South direction.

This chart uses temporal logic to regulate state transitions. The `after` operator implements a countdown timer, which initializes when the source state is entered. By default, the timer provides a longer green light in the East-West direction than in the North-South direction because the volume of traffic is greater on the East-West road. The
green light in the East-West direction stays on for at least 20 clock ticks, but it can remain
green as long as no traffic arrives in the North-South direction. A sensor detects whether
cars are waiting at the red light in the North-South direction. If so, the light turns green
in the North-South direction to keep traffic moving.

The Light_Controller chart behaves like a Moore machine because it updates its outputs
based on current state before transitioning to a new state, as follows:

**When initial state Stop is active.** Traffic light is red for North-South, green for East-
West.

- Sets output \( y_1 = \text{RED} \) (North-South) based on current state.
- Sets output \( y_2 = \text{GREEN} \) (East-West) based on current state.
- After 20 clock ticks, active state becomes StopForTraffic.

**In active state StopForTraffic.** Traffic light has been red for North-South, green for
East-West for at least 20 clock ticks.

- Sets output \( y_1 = \text{RED} \) (North-South) based on current state.
- Sets output \( y_2 = \text{GREEN} \) (East-West) based on current state.
- Checks sensor.
- If sensor indicates cars are waiting ([sens] is true) in the North-South direction,
  active state becomes StopToGo.

**In active state StopToGo.** Traffic light must reverse traffic flow in response to sensor.

- Sets output \( y_1 = \text{RED} \) (North-South) based on current state.
- Sets output \( y_2 = \text{YELLOW} \) (East-West) based on current state.
- After 3 clock ticks, active state becomes Go.

**In active state Go.** Traffic light has been red for North-South, yellow for East-West for 3
clock ticks.

- Sets output \( y_1 = \text{GREEN} \) (North-South) based on current state.
- Sets output \( y_2 = \text{RED} \) (East-West) based on current state.
- After 10 clock ticks, active state becomes GoToStop.

**In active state GoToStop.** Traffic light has been green for North-South, red for East-
West for 10 clock ticks.
• Sets output $y_1 = \text{YELLOW (North-South)}$ based on current state.
• Sets output $y_2 = \text{RED (East-West)}$ based on current state.
• After 3 clock ticks, active state becomes \text{Stop}.

Design Rules in Moore Traffic Light

This example of a Moore traffic light illustrates the following Moore design rules:

• The chart computes outputs in state actions.
• The chart tests inputs in conditions on transitions.
• The chart uses temporal logic, but no asynchronous events.
• The chart defines chart inputs (sens) and outputs ($y_1$ and $y_2$).
Effects of Changing the Chart Type

The best practice is to not change from one Stateflow chart type to another in the middle of development. You cannot automatically convert the semantics of the original chart to conform to the design rules of the new chart type. Changing type usually requires you to redesign your chart to achieve equivalent behavior — that is, where both charts produce the same sequence of outputs given the identical sequence of inputs. To assist you, diagnostic messages appear at compile time (see “Debug Mealy and Moore Charts” on page 7-20). In some cases, however, there may be no way to translate specific behaviors without violating chart definitions.

Here is a summary of what happens when you change chart types mid-design.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mealy</td>
<td>Classic</td>
<td>Mealy charts retain their semantics when changed to Classic type.</td>
</tr>
<tr>
<td>Classic</td>
<td>Mealy</td>
<td>If the Classic chart confirms to Mealy semantic rules, the Mealy chart exhibits equivalent behavior, provided that output is defined at every time step.</td>
</tr>
<tr>
<td>Moore</td>
<td>Classic</td>
<td>State actions in the Moore chart behave as entry actions because they are not labeled. Therefore, the Classic chart will not exhibit behavior that is equivalent to the original Moore chart. Requires redesign.</td>
</tr>
<tr>
<td>Classic</td>
<td>Moore</td>
<td>Actions that are unlabeled in the Classic chart (entry actions by default) behave as during and exit actions. Therefore, the Moore chart will not exhibit behavior that is equivalent to the original Classic chart. Requires redesign.</td>
</tr>
<tr>
<td>Mealy</td>
<td>Moore</td>
<td>Converting between these two types does not produce equivalent behavior because Mealy and Moore rules about placement of actions are mutually exclusive. Requires redesign.</td>
</tr>
<tr>
<td>Moore</td>
<td>Mealy</td>
<td></td>
</tr>
</tbody>
</table>
Debug Mealy and Moore Charts

At compile time, informative diagnostic messages appear to help you:

• Design Mealy and Moore charts from scratch
• Redesign legacy Classic charts to conform to Mealy and Moore semantics
• Redesign charts to convert between Mealy and Moore types

For example, recall the Mealy vending machine chart described in “Model a Vending Machine Using Mealy Semantics” on page 7-6.

If you change the chart type to **Moore** and rebuild, you get the following diagnostic message:

*Stateflow Moore chart cannot have condition or transition actions.*

This message indicates that you cannot define actions on transitions. Without actions, you cannot compute outputs on transitions in Moore charts (see “Do Not Use Actions on Transitions” on page 7-13). According to Moore semantics, you must instead compute outputs in state actions (see “Design Rules for Moore Charts” on page 7-11).

In the Mealy chart, each condition action computes output (*whether or not soda is released*) based on input (*the coin received*). Each state represents one of the three
possible coin inputs: nickel, dime, or no coin. The Mealy chart computes the output as it transitions to the next state. When you move this logic out of transitions and into state actions in the Moore chart, you need more states. The reason is that in the Moore chart, each state must represent not only coins received, but also the soda release condition. The Moore chart must compute output according to the active state before considering input. As a result, there will be a delay in releasing soda, even if the machine receives enough money to cover the cost.

The equivalent vending machine, designed as a Moore chart, is as follows.

The semantics of the two charts differ as follows:

<table>
<thead>
<tr>
<th>Mealy Vending Machine</th>
<th>Moore Vending Machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>Uses 3 states</td>
<td>Uses 5 states</td>
</tr>
<tr>
<td>Computes outputs in condition actions</td>
<td>Computes outputs in state actions</td>
</tr>
</tbody>
</table>
For this vending machine, Mealy is a better modeling paradigm because there is no delay in releasing soda once sufficient coins are received. By contrast, the Moore vending machine requires an extra time step to pass before producing soda. Since the Moore vending machine accepts a nickel, a dime, or no coin in a given time step, it is possible that the soda will be produced in a time step in which a coin is accepted toward the next purchase. In this situation, the delivery of a soda may appear to be in response to this coin, but actually occurs because the vending machine received the purchase price in previous time steps.
Techniques for Streamlining Chart Design

• “Record State Activity Using History Junctions” on page 8-2
• “Encapsulate Modal Logic Using Subcharts” on page 8-5
• “Move Between Levels of Hierarchy Using Supertransitions” on page 8-10
• “Define a Graphical Function” on page 8-18
• “Manage Large Graphical Functions” on page 8-22
• “Call Graphical Functions in States and Transitions” on page 8-23
• “Specify Graphical Function Properties” on page 8-24
• “Reuse Logic Patterns Using Graphical Functions” on page 8-26
• “Export Stateflow Functions for Reuse” on page 8-28
• “Group Chart Objects Using Boxes” on page 8-35
• “Reuse Functions with an Atomic Box” on page 8-41
• “Add Descriptive Comments in a Chart” on page 8-47
Record State Activity Using History Junctions

What Is a History Junction?

A history junction records the activity of substates inside superstates. Use a history junction in a chart or superstate to indicate that its last active substate becomes active when the chart or superstate becomes active.

Create a History Junction

To create a history junction, do the following:

1. In the editor toolbar, click the History Junction icon:

   ![History Junction Icon](image)

2. Move your pointer into the chart.
3. Click to place a history junction inside the state whose last active substate it records.

To create multiple history junctions, do the following:

1. In the editor toolbar, double-click the History Junction icon.
   The button is now in multiple-object mode.
2. Click anywhere in the drawing area to place a history junction.
3. Move to and click another location to create an additional history junction.
4. Click the History Junction icon or press the Esc key to cancel the operation.

To move a history junction to a new location, click and drag it to the new position.
**Change History Junction Size**

To change the size of junctions:

1. Select the history junctions whose size you want to change.
2. Right-click one of the junctions and select **Junction Size**.
3. Select a size from the list of junction sizes.

**Change History Junction Properties**

To edit the properties for a junction:

1. Right-click a junction and select **Properties**.

   The History Junction dialog box appears.

2. Edit the fields in the properties dialog box.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>Parent of this history junction; read-only; click the hypertext link to bring the parent to the foreground.</td>
</tr>
<tr>
<td>Description</td>
<td>Textual description/comment.</td>
</tr>
<tr>
<td>Document Link</td>
<td>Enter a URL address or a general MATLAB command. Examples are <a href="http://www.mathworks.com">www.mathworks.com</a>, mailto:email_address, and edit/spec/data/speed.txt.</td>
</tr>
</tbody>
</table>

3 When finished editing, click one of the following buttons:

- **Apply** to save the changes
- **Cancel** to cancel any changes
- **OK** to save the changes and close the dialog box
- **Help** to display the Stateflow online help in an HTML browser window
Encapsulate Modal Logic Using Subcharts

What Is a Subchart?

A subchart is a graphical object that can contain anything a top-level chart can, including other subcharts. A subchart, or a subcharted state, is a superstate of the states that it contains. You can nest subcharts to any level in your chart design.

Using subcharts, you can reduce a complex chart to a set of simpler, hierarchically organized units. This design makes the chart easier to understand and maintain, without changing the chart behavior. Subchart boundaries do not apply during simulation and code generation.

The subchart appears as a block with its name in the block center. However, you can define actions and default transitions for subcharts just as you can for superstates. You can also create transitions to and from subcharts just as you can create transitions to and from superstates. You can create transitions between states residing outside a subchart and any state within a subchart. The term supertransition refers to a transition that crosses subchart boundaries in this way. See “Move Between Levels of Hierarchy Using Supertransitions” on page 8-10 for more information.

Subcharts define a containment hierarchy within a top-level chart. A subchart or top-level chart is the parent of the states it contains at the first level and an ancestor of all the subcharts contained by its children and their descendants at lower levels.

Some subcharts can become atomic units if they meet certain modeling requirements. For more information, see “Restrictions for Converting to Atomic Subcharts” on page 15-39.
Create a Subchart

You create a subchart by converting an existing state, box, or graphical function into the subchart. The object to convert can be one that you create for making a subchart or an existing object whose contents you want to turn into a subchart.

To convert a new or existing state, box, or graphical function to a subchart:

1. Right-click the object and select **Group & Subchart > Subchart**.
2. Confirm that the object now appears as a subchart.

To convert the subchart back to its original form, right-click the subchart. In the context menu, select **Group & Subchart > Subchart**.

Rules of Subchart Conversion

When you convert a box to a subchart, the subchart retains the attributes of a box. For example, the position of the resulting subchart determines its activation order in the chart if implicit ordering is enabled (see “Group Chart Objects Using Boxes” on page 8-35 for more information).

You cannot undo the operation of converting a subchart back to its original form. When you perform this operation, the undo and redo buttons are disabled from undoing and redoing any prior operations.

Convert a State to a Subchart

Suppose that you have the following chart:
1 To convert the On state to a subchart, right-click the state and select **Group & Subchart > Subchart**.

2 Confirm that the On state now appears as a subchart.

**Manipulate Subcharts as Objects**

Subcharts also act as individual objects. You can move, copy, cut, paste, relabel, and resize subcharts as you would states and boxes. You can also draw transitions to and from
a subchart and any other state or subchart at the same or different levels in the chart hierarchy (see “Move Between Levels of Hierarchy Using Supertransitions” on page 8-10).

**Open a Subchart**

Opening a subchart allows you to view and change its contents. To open a subchart, do one of the following:

- Double-click anywhere in the box that represents the subchart.
- Select the box representing the subchart and press the **Enter** key.

**Edit a Subchart**

After you open a subchart (see “Open a Subchart” on page 8-8), you can perform any editing operation on its contents that you can perform on a top-level chart. This means that you can create, copy, paste, cut, relabel, and resize the states, transitions, and subcharts in a subchart. You can also group states, boxes, and graphical functions inside subcharts.

You can also cut and paste objects between different levels in your chart. For example, to copy objects from a top-level chart to one of its subcharts, first open the top-level chart and copy the objects. Then open the subchart and paste the objects into the subchart.

Transitions from outside subcharts to states or junctions inside subcharts are called **supertransitions**. You create supertransitions differently than you do ordinary transitions. See “Move Between Levels of Hierarchy Using Supertransitions” on page 8-10 for information on creating supertransitions.

**Navigate Subcharts**

The Stateflow Editor toolbar contains a set of buttons for navigating the subchart hierarchy of a chart.
<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Up Arrow]</td>
<td>If the Stateflow Editor is displaying a subchart, clicking this button replaces the subchart with the parent of the subchart in the Stateflow Editor. If the Stateflow Editor is displaying a top-level chart, clicking this button replaces the chart with the Simulink model window containing that chart.</td>
</tr>
<tr>
<td>![Left Arrow]</td>
<td>Clicking this button shows the chart that you visited before the current chart, so that you can navigate up the hierarchy.</td>
</tr>
<tr>
<td>![Right Arrow]</td>
<td>Clicking this button shows the chart that you visited after visiting the current chart, so that you can navigate down the hierarchy.</td>
</tr>
</tbody>
</table>

**Note** You can also use the *Escape* key to navigate up to the parent object for a subcharted state, box, or function.
Move Between Levels of Hierarchy Using Supertransitions

**What Is a Supertransition?**

A *supertransition* is a transition between different levels in a chart, for example, between a state in a top-level chart and a state in one of its subcharts, or between states residing in different subcharts at the same or different levels in a chart. You can create supertransitions that span any number of levels in your chart, for example, from a state at the top level to a state that resides in a subchart several layers deep in the chart.

The point where a supertransition enters or exits a subchart is called a *slit*. Slits divide a supertransition into graphical segments. For example, the sf_boiler model shows a supertransition leaving the On subchart:
The same supertransition appears inside the subchart as follows:
In this example, supertransition `[Heater.On.warm()]` goes from NORM in the On subchart to the Off state in the parent chart. Both segments of the supertransition have the same label.
**Draw a Supertransition Into a Subchart**

Use the following steps to draw a supertransition from an object outside a subchart to an object inside the subchart.

**Note** You cannot undo the operation of drawing a supertransition. When you perform this operation, the undo and redo buttons are disabled from undoing and redoing any prior operations.

1. Position your cursor over the border of the state.
   
   The cursor assumes the crosshairs shape.

   ![Crosshairs Cursor](image1)

2. Drag the mouse just inside the border of the subchart.
   
   A supertransition appears, extending from the source state into the subchart with its arrowhead penetrating a slit in the subchart.

   ![Supertransition](image2)

If you are not happy with the initial position of the slit, you can continue to drag the slit around the inside edge of the subchart to the desired location.
3 Double-click the subchart to open it.

The tip of the arrowhead of the supertransition appears highlighted in red, entering the subchart.

4 Position your cursor over the arrowhead.

The cursor becomes an arrow.

5 Drag the cursor to the desired position in the subchart.

6 Release the cursor.

The supertransition terminates in the desired location.
Draw a Supertransition Out of a Subchart

Use the following steps to draw a supertransition out of a subchart.

1. Draw an inner transition segment from the source object anywhere just outside the border of the subchart

   A slit appears as shown.

2. Navigate up to the parent object by selecting View > Navigate > Up to Parent.

   The tip of the arrowhead of the supertransition appears highlighted in red, exiting the subchart.
3 Position your cursor over the arrowhead.
   The cursor becomes an arrow.
4 Drag the cursor to the desired position in the chart.
   The parent of the subchart appears.

5 Release the cursor to complete the connection.
**Note** If the parent chart is itself a subchart and the terminating object resides at a higher level in the subchart hierarchy, repeat these steps until you reach the desired parent. In this way, you can connect objects separated by any number of layers in the subchart hierarchy.

**Label Supertransitions**

A supertransition is displayed with multiple resulting transition segments for each layer of containment traversed. For example, if you create a transition between a state outside a subchart and a state inside a subchart of that subchart, you create a supertransition with three segments, each displayed at a different containment level.

You can label any one of the transition segments constituting a supertransition using the same procedure used to label a regular transition (see “Label Transitions” on page 4-20). The resulting label appears on all the segments that constitute the supertransition. Also, if you change the label on any one of the segments, the change appears on all segments.
Define a Graphical Function

Create a Graphical Function

Use these steps to create a graphical function in your chart:

1. Click the graphical function icon in the editor toolbar:

2. Move your pointer to the location for the new graphical function in your chart and click to insert the function box.

3. Enter the function signature.

   The function signature specifies a name for your function and the formal names for its arguments and return values. A signature has this syntax:

   \[ [r_1, r_2, \ldots, r_n] = \text{func}(a_1, a_2, \ldots, a_n) \]

   where `func` is the name of your function, \( a_1, a_2, \ldots, a_n \) are formal names for its arguments, and \( r_1, r_2, \ldots, r_n \) are formal names for its return values.

   **Note** You can define arguments and return values as scalars, vectors, or 2-D matrices of any data type.

4. Click outside of the function box.

   The following signature is for a graphical function that has the name `f1`, which takes three arguments (\( a, b, \) and \( c \)) and returns three values (\( x, y, \) and \( z \)).

   **Note** In the chart, you can change the signature of your graphical function at any time. After you edit the signature, the Model Explorer updates to reflect the changes.
Program a Graphical Function

To program a graphical function, follow these steps:

1. Click the default transition icon in the editor toolbar:

   ![transition_icon]

2. Move your pointer inside the function box in your chart and click to insert the default transition and its terminating junction.

3. Enter transition conditions and actions for your graphical function. If necessary, add connective junctions and transitions to your function.

   **Note**  Connective junctions and transitions are the only graphical elements you can use in a graphical function. Because a graphical function must execute completely when you call it, you cannot use states.

This function box shows a flow chart that returns different products of its arguments.

![function_diagram]

Define Graphical Function Data

You must define the data in your graphical function:

1. Open the Model Explorer.

2. Expand the chart object in the Model Explorer, so that you can see the return values and arguments of the function signature as data items that belong to your graphical function.
The **Scope** column in the Model Explorer indicates the role of each argument or return value. Arguments have the scope **Input**, and return values have the scope **Output**.

3 For each function argument and return value, right-click the data row in the Model Explorer and select **Properties** from the context menu.

4 In the Data properties dialog box for each argument and return value, specify the data properties.

These rules apply:

- Each argument and return value can be a scalar or matrix of values.
- Arguments cannot have initial values.

5 Create any additional data items that your function must have to process its programming.

Your function can access its own data or data belonging to parent states or the chart. The data items that you create for the function itself can have one of these scopes:

- **Local**
  
  Local data persists from one function call to the next. Valid for C charts only.

- **Temporary**
  
  Temporary data initializes at the start of every function call. Valid for C charts only. In charts that use MATLAB as the action language, you do not need to define
temporary function data in the Model Explorer. If a variable is used and not
previously defined, then it is automatically created. The variable is available to the
rest of the function.

• Constant

Constant data retains its initial value through all function calls.

**Note** You can initialize your function data (other than arguments and return values)
from the MATLAB workspace. However, you can save only local items to this
workspace.
Manage Large Graphical Functions

You can make your graphical function as large as you want, as shown below.

![Diagram of enqueue function](image)

However, if your function grows too large, you can hide its contents by right-clicking inside the function box and selecting **Group & Subchart** > **Subchart** from the context menu. This option makes your graphical function opaque.

![Subcharted function box](image)

To access the programming of your subcharted graphical function, double-click the function box. This action dedicates the entire chart window to programming your function.

To access your original chart, click the Back button.
Call Graphical Functions in States and Transitions

Syntax

Syntax for a function call is the same as that of a function signature, with actual arguments replacing the formal ones specified in a signature. If the data types of the actual and formal argument differ, a function casts the actual argument to the type of the formal argument. See “Create a Graphical Function” on page 8-18 for information about syntax for a function signature.

Tip If the formal arguments of a function signature are scalars, verify that inputs and outputs of function calls follow the rules of scalar expansion. For more information, see “How Scalar Expansion Works for Functions” on page 17-6.

Example

In this example, a state entry action calls a graphical function that returns three products.

![Graphical representation of a function call with inputs and outputs]
Specify Graphical Function Properties

You can set general properties for your graphical function through its properties dialog box:

1. Right-click your graphical function box.
2. Select **Properties** from the context menu.

The properties dialog box for your graphical function appears.

![Function enqueue properties dialog box]

The fields in the General tab of the properties dialog box are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Click this read-only function name to bring your function to the foreground in its native chart.</td>
</tr>
</tbody>
</table>
### Field: Function Inline Option

Select one of these options to control the inlining of your function in generated code:

- **Auto**
  Decides whether or not to inline your function based on an internal calculation.

- **Inline**
  Inlines your function as long as you do not export it to other charts, and it is not part of a recursion. (A recursion exists if your function calls itself directly or indirectly through another function call.)

- **Function**
  Does not inline your function.

### Field: Label

Specify the signature label for your function in this field. See “Create a Graphical Function” on page 8-18 for more information.

The fields in the Documentation tab of the properties dialog box are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Enter a textual description or comment.</td>
</tr>
<tr>
<td><strong>Document link</strong></td>
<td>Enter a URL address or a general MATLAB command. Examples are <a href="http://www.mathworks.com">www.mathworks.com</a>, <a href="mailto:email_address">mailto:email_address</a>, and <a href="edit/spec/data/speed.txt">edit/spec/data/speed.txt</a>.</td>
</tr>
</tbody>
</table>
Reuse Logic Patterns Using Graphical Functions

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“What Is a Graphical Function?” on page 8-26</td>
</tr>
<tr>
<td>“Why Use a Graphical Function in a Stateflow Chart?” on page 8-26</td>
</tr>
<tr>
<td>“Where to Use a Graphical Function” on page 8-26</td>
</tr>
<tr>
<td>“Limitations Using Events in Graphical Functions” on page 8-27</td>
</tr>
</tbody>
</table>

What Is a Graphical Function?

A graphical function in a Stateflow chart is a graphical element that helps you reuse control-flow logic and iterative loops. This function is a program you write with flow charts using connective junctions and transitions. You create a graphical function, fill it with a flow chart, and call the function in the actions of states and transitions.

Why Use a Graphical Function in a Stateflow Chart?

This function helps you to:

- Create modular, reusable logic that you can call anywhere in your chart.
- Track simulation behavior visually during chart animation.

Where to Use a Graphical Function

A graphical function can reside anywhere in a chart, state, or subchart. The location of a function determines its scope, that is, the set of states and transitions that can call the function. Follow these guidelines:

- If you want to call the function only within one state or subchart and its substates, put your graphical function in that state or subchart. That function overrides any other functions of the same name in the parents and ancestors of that state or subchart.
- If you want to call the function anywhere in that chart, put your graphical function at the chart level.
- If you want to call the function from any chart in your model, put your graphical function at the chart level and enable exporting of chart-level graphical functions. For instructions, see “Export Stateflow Functions for Reuse” on page 8-28.
Limitations Using Events in Graphical Functions

If an event broadcast inside a graphical function causes the active state to change, do not broadcast the event inside of the graphical function. The behavior of broadcasting an event in a graphical function that causes an exit from the active state is unpredictable.
Export Stateflow Functions for Reuse

In this section...

“Why Export Chart-Level Functions?” on page 8-28
“How to Export Chart-Level Functions” on page 8-28
“Rules for Exporting Chart-Level Functions” on page 8-29
“Export Chart-Level Functions“ on page 8-29

Why Export Chart-Level Functions?

When you export chart-level functions, you extend the scope of your functions to other parts of the model. For an example, see “Share Functions Across Simulink and Stateflow” on page 28-6. You can export these functions:

- Graphical
- Truth table
- MATLAB

How to Export Chart-Level Functions

1. Open the chart where your function resides.
2. In the Property Inspector, open the Advanced section.
3. Select Export Chart Level Functions.
4. If your function resides in a library chart, link that chart to your main model.

When you select Export Chart Level Functions, you can call exported functions by using Simulink Caller blocks with dot notation, chartName.functionName. To call the exported functions throughout the model from any Stateflow or Simulink Caller block, select Treat Exported Functions as Globally Visible. Do not use dot notation to call these functions. You cannot export functions with the same name.

Simulink functions can also be defined directly in the Simulink canvas. For more information, see Simulink Function.
Rules for Exporting Chart-Level Functions

Link library charts to your main model to export chart-level functions from libraries

You must perform this step to export functions from library charts. Otherwise, a simulation error occurs.

Do not export chart-level functions that contain unsupported inputs or outputs

You cannot export a chart-level function when inputs or outputs have any of the following properties:

- Fixed-point data type with word length greater than 32 bits
- Variable size

Do not export Simulink functions

If you try to export Simulink functions, an error appears when you simulate your model. To avoid this behavior, clear the Export Chart Level Functions check box in the Chart properties dialog box.

Do not export functions across model reference boundaries

You cannot export functions from a referenced model and call the functions from a parent model.

Export Chart-Level Functions

This example describes how to export functions in library charts to your main model.

1 Create these objects:
   - Add a model named main_model, with a chart named modChart.
• Add a library model named lib1, with a chart named lib1Chart.

![lib1Chart](image)

• Add a library model named lib2, with a chart named lib2Chart.

![lib2Chart](image)

2 Create these graphical functions in the library charts:

• For lib1Chart, add this graphical function.

![Function c = lib1_func(a, b)
{c = lib2_func(a, b);}](image)

• For lib2Chart, add this graphical function.

![Function c = lib2_func(a, b)
{c = mod_func(a, b);}](image)

• In the Model Explorer, for each of the function inputs and outputs, a, b, and c, set these properties:
  • Size to 1
  • Complexity to Off
3 For modChart, add a graphical function and a default transition with a `lib1_func` action.

4 For each chart, follow these steps:
   a In the Model Explorer, for each of the function inputs and outputs, a, b, and c, set:
      • Size to 1
      • Complexity to Off
      • Type to double
   b Open the Chart properties dialog box.
   c In the Chart properties dialog box, select **Export Chart Level Functions**.
   d Click **OK**.

5 Drag `lib1Chart` and `lib2Chart` into main_model from lib1 and lib2, respectively. Your main model should look something like this:

Each chart now defines a graphical function that any chart in main_model can call.

6 Open the Model Explorer.
7 In the **Model Hierarchy** pane of the Model Explorer, navigate to `main_model`.

8 Add the data `x` and `y` to the Stateflow machine:

   a. Select **Add > Data**.
   b. In the **Name** column, enter `x`.
   c. In the **Initial Value** column, enter `0`.
   d. Use the default settings for other properties of `x`.
   e. Select **Add > Data**.
   f. In the **Name** column, enter `y`.
   g. In the **Initial Value** column, enter `1`.
   h. Use the default settings for other properties of `y`.

This step ensures that input and output data are defined globally to support exported graphical functions.

9 Open the Model Configuration Parameters dialog box.

10 In the Model Configuration Parameters dialog box, go to the **Solver** pane.

11 In the **Solver selection** section, make these changes:

   a. For **Type**, select **Fixed-step**.
   b. For **Solver**, select **Discrete (no continuous states)**.

12 In the **Solver details** section, make these changes:

   a. For **Fixed-step size**, enter `1`.
   b. Click **OK**.

This step ensures that when you simulate your model, a discrete solver is used. For more information, see “Solvers” (Simulink).

**What Happens During Simulation**

When you simulate the model, these actions take place during each time step.

<table>
<thead>
<tr>
<th>Phase</th>
<th>The object...</th>
<th>Calls the graphical function...</th>
<th>Which...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td><code>modChart</code></td>
<td><code>lib1_func</code></td>
<td>Reads two input arguments <code>x</code> and <code>y</code></td>
</tr>
</tbody>
</table>
### Phase 2

- **The object…**
  - lib1_func
- **Calls the graphical function…**
  - lib2_func
- **Which…**
  - Passes the two input arguments

### Phase 3

- **The object…**
  - mod_func
- **Which…**
  - Adds x and y and assigns the sum to x

### How to View the Simulation Results

To view the simulation results, add a scope to your model. Follow these steps:

1. Open the Simulink Library Browser.
2. From the Simulink/Sinks Library, select the Scope block and add it to main_model.
3. Open the Model Explorer.
4. In the **Model Hierarchy** pane, navigate to modChart.
5. Add the output data z to the chart:
   - Select **Add > Data**.
   - In the **Name** column, enter z.
   - In the **Scope** column, select **Output**.
   - Use the default settings for other properties.
6. For modChart, update the default transition action to read as follows:
   ```
   \{ x = lib1_func(x,y); z = x; \}
   ```
7. In the model, connect the output from modChart to the inport of the Scope block.
Double-click the Scope block to open the display.
Start simulation.
After the simulation ends, right-click in the scope display and select **Autoscale**.

The results look something like this:
Group Chart Objects Using Boxes

In this section...

“When to Use Boxes” on page 8-35
“When Semantics of Stateflow Boxes” on page 8-35
“Rules for Using Boxes” on page 8-36
“Draw and Edit a Box” on page 8-36
“Examples of Using Boxes” on page 8-38

When to Use Boxes

Use a Stateflow box to organize graphical objects in your chart.

Semantics of Stateflow Boxes

Visibility of Graphical Objects in Boxes

Boxes add a level of hierarchy to Stateflow charts. This property affects visibility of functions and states inside a box to objects that reside outside of the box. If you refer to a box-parented function or state from a location outside of the box, you must include the box name in the path. See “Group Functions Using a Box” on page 8-38.

Activation Order of Parallel States

Boxes affect the implicit activation order of parallel states in a chart. If your chart uses implicit ordering, parallel states within a box wake up before other parallel states that are lower or to the right in that chart. Within a box, parallel states wake up in top-down, left-right order. See “Group States Using a Box” on page 8-39.

Note To specify activation order explicitly on a state-by-state basis, select User specified state/transition execution order in the Chart properties dialog box. This option is selected by default when you create a new chart. For details, see “Explicit Ordering of Parallel States” on page 3-90.
Rules for Using Boxes

When you use a box, these rules apply:

- Include the box name in the path when you use dot notation to refer to a box-parented function or state from a location outside of the box.
- You can move or draw graphical objects inside a box, such as functions and states.
- You can add data to a box so that all the elements in the box can share the same data.
- You can group a box and its contents into a single graphical element. See “Group States” on page 4-7.
- You can subchart a box to hide its elements. See “Encapsulate Modal Logic Using Subcharts” on page 8-5.
- You cannot define action statements for a box, such as entry, during, and exit actions.
- You cannot define a transition to or from a box. However, you can define a transition to or from a state within a box.

Draw and Edit a Box

Create a Box

You create boxes in your chart by using the box tool shown below.
1 Click the Box tool.
2 Move your pointer into the drawing area.
3 Click in any location to create a box.
The new box appears with a question mark (?) name in its upper left corner.

4 Click the question mark label.
5 Enter a name for the box and then click outside of the box.

Delete a Box

To delete a box, click to select it and press the Delete key.

Examples of Using Boxes

Group Functions Using a Box

This chart shows a box named Status that groups together MATLAB functions.

Note Because the MATLAB function resides inside a box, the path of the function call must include the box name Status. If you omit this prefix, an error message appears.
3 If the value of the input data `temp` exceeds 80, a transition to the state `Warm` occurs.
4 Upon entry, the state `Warm` invokes the function `Status.msgWarm`.
   This function displays a status message that the temperature is warm.

   **Note** Because the MATLAB function resides inside a box, the path of the function call must include the box name `Status`. If you omit this prefix, an error message appears.

5 If the value of the input data `temp` drops below 60, a transition to the state `Cold` occurs.
6 Steps 2 through 5 repeat until the simulation ends.

**Group States Using a Box**

This chart shows a box named `Status` that groups together related states. The chart uses implicit ordering for parallel states, instead of the default explicit mode. (For details, see “Implicit Ordering of Parallel States” on page 3-91.)

The main ideas of this chart are:
• The state Temp wakes up first, followed by the state Wind_Chill. Then, the state Monitor wakes up.

**Note** This implicit activation order occurs because Temp and Wind_Chill reside in a box. If you remove the box, the implicit activation order changes, as shown, to: Temp, Monitor, Wind_Chill.

Based on the input data temp, transitions between substates occur in the parallel states Status.Temp and Status.Wind_Chill.

• When the transition from Status.Temp.Cold to Status.Temp.Warm occurs, the transition condition in(Status.Temp.Warm) becomes true.

• When the transition from Status.Temp.Warm to Status.Temp.Cold occurs, the transition condition in(Status.Temp.Cold) becomes true.

**Note** Because the substates Status.Temp.Cold and Status.Temp.Warm reside inside a box, the argument of the in operator must include the box name Status. If you omit this prefix, an error message appears. For information about the in operator, see “Check State Activity” on page 12-86.
Reuse Functions with an Atomic Box

In this section...

| “What Is an Atomic Box?” on page 8-41 |
| “Rationale for Using an Atomic Box” on page 8-41 |
| “How to Reuse Functions with an Atomic Box” on page 8-41 |
| “Example of Reusing a Timer Function Multiple Times” on page 8-42 |

What Is an Atomic Box?

An atomic box behaves in the same way as a regular Stateflow box but with a few differences:

- You can reuse an atomic box across multiple charts and models.
- An atomic box cannot contain states, only functions (graphical, truth table, MATLAB, and Simulink).

Use an atomic box to reuse functions in the same way that you use an atomic subchart to reuse states. For more information about atomic subcharts, see “What Is an Atomic Subchart?” on page 15-2.

Rationale for Using an Atomic Box

Suppose that you have a library model that contains a set of functions for use in multiple charts in a model. The functions reside in the library model to enable easier configuration management.

Models that use these functions can appear as referenced blocks in a top model. However, when the functions are exported functions of a Stateflow chart, you can use only one instance of that referenced block per top model. For a complete list of model referencing limitations, see “Model Referencing Limitations” (Simulink).

With atomic boxes, you can avoid the limitation due to exported functions. You can reuse models with these functions multiple times as referenced blocks in a top model.

How to Reuse Functions with an Atomic Box

To reuse functions across multiple models:
1. Create a library model with an atomic box that contains the function you want to reuse.

2. Create a separate model with multiple charts.
   a. In each chart that calls the function, add a linked atomic box.
   b. Write each call to the function using the full path:

   \[
   \text{linked\_box\_name.function\_name}
   \]

   Using the full path for the function call has the following advantages:
   - Makes clear the dependency on the function in the linked atomic box
   - Avoids pollution of the global namespace
   - Does not affect efficiency of the generated code

3. Reuse that model multiple times as referenced blocks in a top model.

   Because there are no exported functions in the charts, you can use more than one instance of that referenced block in the top model.

**Example of Reusing a Timer Function Multiple Times**

Suppose that you want to reuse a timer function that returns the simulation time in C charts. The following procedure shows how you can:

- Call the timer function from multiple locations in a model.
- Reuse that model multiple times in another model.

**Note**: For charts that use MATLAB as the action language, use the function `getSimulationTime()`.

1. Store the timer function you want to reuse in a library model.
   a. Create a new library named `libTimerUtils`.
   b. Add a chart named `TimerUtils` to the library:
c In your chart, add the following graphical function:

```
function tout = GetTime
{ tout = t; }
```

The function `GetTime` returns one output `tout` that corresponds to simulation time `t`. For more information about literal symbols you can use in your chart, see “Supported Symbols in Actions” on page 12-27.

d Save `libTimerUtils`.

2 Develop a separate model with multiple charts that use the timer function.

a Create a new model named `ex_timer_function_calls`.
b Add two charts, `Chart1` and `Chart2`, to the model.
c In each chart, add two states, two transitions, and a linked atomic box:

To add the linked atomic box, copy the `TimerUtils` library chart and paste it below state A. Name the linked atomic box as `Time`. 
When you copy and paste a library chart that contains only functions and no states, you get a linked atomic box. If the library chart contains any states, you get a linked atomic subchart.

d  In Chart 1, add the following state action and transition condition:

\[
t_0 = \text{Time.GetTime}(); \quad \text{[Time.GetTime()} - t_0 > 5]
\]

Upon entry to state A, the call to \text{GetTime} returns the simulation time. The transition from state A to B occurs when more than 5 seconds of simulation time passes.

e  In Chart 2, add the following state action and transition condition:

\[
t_0 = \text{Time.GetTime}(); \quad \text{[Time.GetTime()} - t_0 > 7]
\]

Upon entry to state A, the call to \text{GetTime} returns the simulation time. The transition from state A to B occurs when more than 7 seconds of simulation time passes.

f  In each chart, add local data with the following properties:
In each chart, open the State properties dialog box for B and select **Create data for monitoring**: Click **OK**.

This step adds an output data named B that is Boolean. The value is 1 when state B is active and 0 otherwise. For more information, see “About Active State Data” on page 23-31.

In your model, add two Outport blocks, Out1 and Out2. Then connect each block to the corresponding output of each chart.

Your model should look something like this:

![Diagram](image)

Save `ex_timer_function_calls`.

3 Reuse the timer function in multiple referenced blocks of a top model.

a Create a new model named `ex_modelref_utility_functions`.

b Add two Model blocks that reference `ex_timer_function_calls`.

c Add four Outport blocks and connect them as follows:
d Save ex_modelref_utility_functions.
Add Descriptive Comments in a Chart

In this section...

“Create Notes” on page 8-47
“Change Note Properties” on page 8-47
“Change Note Font and Color” on page 8-47
“TeX Instructions” on page 8-48

Create Notes

You can enter comments or notes in any location on the chart.

1 Double-click in the desired location of the chart and start typing your comments.
2 Press the Return key to start a new line.
3 After you finish typing, click outside the note text.

Change Note Properties

You can use the Note properties dialog box to edit note properties.

You can specify the layout of the note, including:

• Borders
• Text alignment and word wrap
• Text color and background color
• Margins between the text and the borders of the note

Change Note Font and Color

To change font and color for your chart notes, follow the procedures described in the section “Specify Colors and Fonts in a Chart” on page 4-32.

You can also change your note text to bold or italic:

1 Right-click the note text and select Font Style.
In the submenu, select **Bold** or **Italic**.

**TeX Instructions**

In your notes, you can embed a subset of TeX commands to produce special characters. For example, you can embed Greek letters and mathematical symbols.

1. Right-click the text of a note and select **Enable TeX Commands**.
2. Click the note text.
3. Replace the existing note text with the following expression.

   \( \textit{\omega_N} = e^{(-2\pi i)/N} \)

4. Click outside the note.

   The note in your chart looks something like this:

   \[
   \omega_N = e^{(-2\pi i)/N}
   \]
Define Data

- “Add Stateflow Data” on page 9-2
- “Detect Unused Data in the Symbols Window” on page 9-5
- “Set Data Properties” on page 9-7
- “Share Data with Simulink and MATLAB Workspace” on page 9-26
- “About Data Stores” on page 9-30
- “Configure Charts to Use Data Stores” on page 9-31
- “Access Data Store Memory from a Chart” on page 9-32
- “Chart and Block Data Diagnostics” on page 9-35
- “Create a Global Data Store Across Multiple Models” on page 9-37
- “Best Practices for Using Data Stores” on page 9-38
- “Use Data Types in Stateflow” on page 9-39
- “Size Stateflow Data” on page 9-47
- “Handle Integer Overflow for Chart Data” on page 9-52
- “Define Temporary Data” on page 9-56
- “Identify Data Using Dot Notation” on page 9-57
- “Resolve Data Properties from Simulink Signal Objects” on page 9-62
- “Best Practices for Using Data in Charts” on page 9-66
- “Transfer Data Across Models” on page 9-68
Add Stateflow Data

When you want to store values that are visible at a specific level of the Stateflow hierarchy, add data to your chart.

Data defined in a Stateflow chart is visible by multiple Stateflow objects in the chart, including states, transitions, MATLAB functions, and truth tables. To determine what data is used in a state or transition, right-click the state or transition and select Explore. A context menu lists the names and scopes of all resolved symbols in the state or transition. Selecting a symbol from the context menu displays its properties in the Model Explorer. Selecting an output event from the context menu opens the destination of the event in the Stateflow Editor.

**Note** Stateflow data is not available to Simulink functions within a Stateflow chart.

You can add data by using the Chart menu in the Stateflow Editor, through the Symbols window, or through the Model Explorer.

### Add Data by Using the Stateflow Editor Menu

1. In the Stateflow Editor, select the menu option corresponding to the scope of the data that you want to add.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Chart &gt; Add Inputs &amp; Outputs &gt; Data Input From Simulink</td>
</tr>
<tr>
<td>Output</td>
<td>Chart &gt; Add Inputs &amp; Outputs &gt; Data Output To Simulink</td>
</tr>
<tr>
<td>Local</td>
<td>Chart &gt; Add Other Elements &gt; Local Data</td>
</tr>
<tr>
<td>Constant</td>
<td>Chart &gt; Add Other Elements &gt; Constant</td>
</tr>
</tbody>
</table>
2 In the Data dialog box, specify data properties. For more information, see “Stateflow Data Properties” on page 9-7.

**Add Data Through the Symbols Window**

1 To open the Symbols window, select View > Symbols.
2 Click the **Create Data** icon.
3 In the row for the new data, under **TYPE**, click the icon and choose:
   - Input Data
   - Local Data
   - Output Data
   - Constant
   - Data Store Memory
   - Parameter
   - Temporary
4 Edit the name of the data.
5 For input and output data, click the **PORT** field and choose a port number.
6 To specify properties for data, open the Property Inspector. In the Symbols window, right-click the row for the symbol and select **Explore**. For more information, see “Stateflow Data Properties” on page 9-7.

**Add Data Through the Model Explorer**

Add machine or state-parented data through the Model Explorer:

1 In the Stateflow Editor, select View > Model Explorer.
2 In the **Model Hierarchy** pane, select the object in the Stateflow hierarchy where you want to make the new data visible. The object that you select becomes the parent of the new data.
3 In the Model Explorer menu, select Add > Data. The new data with a default definition appears in the Contents pane of the Model Explorer.

4 In the Data properties pane, specify the properties of the data. For more information, see “Stateflow Data Properties” on page 9-7.

See Also

More About

• “Set Data Properties” on page 9-7
• “Detect Unused Data in the Symbols Window” on page 9-5
• “Resolve Undefined Symbols in Your Chart” on page 29-34
• “Use Data Types in Stateflow” on page 9-39
Detect Unused Data in the Symbols Window

The Symbols window indicates unused data, messages, functions, and events with a yellow warning icon. To delete unused objects, right-click the object in the Symbols window and select Delete. By removing objects that have no effect on simulation, you can reduce the size of your model. In this chart, after you add data, it first appears as unused. After you reference data in the chart, the warning sign disappears.

The following types of unused data are not detected:

- Machine-parented data
- Inputs and outputs of MATLAB functions
- Data of parameter scope in a chart that contains atomic subcharts
See Also

More About
• “Trace Data, Events, and Messages Through the Symbols Window” on page 31-7
• “Unused data, events, messages, and functions” (Simulink)
• “Resolve Undefined Data in the Symbols Window” on page 29-35
• “Set Data Properties” on page 9-7
Set Data Properties

In this section...

“Stateflow Data Properties” on page 9-7
“Set Properties in the Logging Section” on page 9-21
“Set Properties in the Description Pane” on page 9-22
“Enter Expressions and Parameters for Data Properties” on page 9-23

You can specify data properties in either the Property Inspector or the Data properties dialog box in the Model Explorer.

• Property Inspector

  1. Open the Symbols window by selecting View > Symbols.
  2. Open the Property Inspector by selecting View > Property Inspector.
  3. Select the data in the Symbols window.
  4. Edit the data properties in the Property Inspector window.

• Model Explorer

  1. Open the Model Explorer by selecting View > Model Explorer.
  2. Double-click the data object in the Contents pane.
  3. Edit the data properties in the data properties dialog box.

Properties vary according to the scope and type of the data object. For many data properties, you can enter expressions or parameter values. Using parameters to set properties for many data objects simplifies maintenance of your model because you can update multiple properties by changing a single parameter.

Stateflow Data Properties

Name

Name of the data object. For more information, see “Rules for Naming Stateflow Objects” on page 2-4.
## Scope

Location where data resides in memory, relative to its parent. You can set scope to one of these values.

<table>
<thead>
<tr>
<th>Scope Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Data defined in the current chart only.</td>
</tr>
<tr>
<td>Constant</td>
<td>Read-only constant value that is visible to the parent Stateflow object and its children.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Constant whose value is defined in the MATLAB workspace, or derived from a Simulink block parameter that you define and initialize in the parent masked subsystem. The Stateflow data object must have the same name as the parameter. To learn how to use Simulink block parameters with charts, see “Share Simulink Parameters with Charts” on page 9-27.</td>
</tr>
<tr>
<td>Input</td>
<td>Input argument to a function if the parent is a graphical function, truth table, or MATLAB function. Otherwise, the Simulink model provides the data to the chart through an input port on the Stateflow block. See “Share Input Data with Simulink” on page 9-26.</td>
</tr>
<tr>
<td>Output</td>
<td>Return value of a function if the parent is a graphical function, truth table, or MATLAB function. Otherwise, the chart provides the data to the Simulink model through an output port on the Stateflow block. See “Share Output Data with Simulink” on page 9-26.</td>
</tr>
<tr>
<td>Data Store Memory</td>
<td>Data object that binds to a Simulink data store, which is a signal that functions like a global variable. All blocks in a model can access that signal. This binding allows the chart to read and write the Simulink data store, sharing global data with the model. The Stateflow object must have the same name as the Simulink data store. See “Access Data Store Memory from a Chart” on page 9-32.</td>
</tr>
<tr>
<td>Temporary</td>
<td>Data that persists during only the execution of a function. For C charts, you can define temporary data only for a graphical function, truth table, or MATLAB function, as described in “Define Temporary Data” on page 9-56.</td>
</tr>
<tr>
<td>Scope Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Exported</td>
<td>Data from the Simulink model that is made available to external code defined in the Stateflow hierarchy. You can define exported data only for a Stateflow machine.</td>
</tr>
<tr>
<td>Imported</td>
<td>Data parented by the Simulink model that you define in external code embedded in the Stateflow machine. You can define imported data only for a Stateflow machine.</td>
</tr>
</tbody>
</table>

**Port**

Index of the port associated with the data object. This property applies only to input and output data. See “Share Output Data with Simulink” on page 9-26.

**Data must resolve to signal object**

Option that specifies that output or local data explicitly inherits properties from Simulink.Signal objects of the same name in the MATLAB base workspace or the Simulink model workspace. The data can inherit these properties:

- Size
- Complexity
- Type
- Unit
- Minimum value
- Maximum value
- Initial value
- Storage class
- Sampling mode (for Truth Table block output data)

For more information, see “Resolve Data Properties from Simulink Signal Objects” on page 9-62.

This option appears only if you set the model configuration parameter **Signal resolution** to a value other than **None**.

**Size**

Size of the data object. The size can be a scalar value or a MATLAB vector of values. To specify a scalar, set the **Size** property to 1 or leave it blank. To specify a MATLAB vector...
use a multidimensional array. The number of dimensions equals the length of the vector and the size of each dimension that corresponds to the value of each vector element.

The scope of the data object determines what sizes you can specify. Stateflow data store memory inherits all its properties, including its size, from the Simulink data store to which it is bound. For all other scopes, size can be scalar, vector, or a matrix of n-dimensions.

For more information, see “Size Stateflow Data” on page 9-47.

**Variable size**

Option that specifies whether the data object changes dimensions during simulation. When you enable the chart property **Support variable-size arrays**, this option is available only for input and output data. For more information, see “Variable-Size Data”.

**Complexity**

Option that specifies whether the data object accepts complex values. You can choose one of these settings.

<table>
<thead>
<tr>
<th>Complexity Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Data object does not accept complex values.</td>
</tr>
<tr>
<td>On</td>
<td>Data object accepts complex values.</td>
</tr>
<tr>
<td>Inherited</td>
<td>Data object inherits the complexity setting from a Simulink block.</td>
</tr>
</tbody>
</table>

For more information, see “How Complex Data Works in C Charts” on page 22-2.

**Type**

Type of data object. To specify the data type:

- From the **Type** drop-down list, select a built-in type.
- In the Data properties dialog box, use the Data Type Assistant to specify a data **Mode** and then specify the data type based on that mode. To display the Data Type Assistant, click the **Show data type assistant** button. The Data Type Assistant is available only in the Data properties dialog box. It is not available in the Symbols window.
• In the **Type** field, enter an expression that evaluates to a data type.

**Note** If you enter an expression for a fixed-point data type, you must specify scaling explicitly. For example, you cannot enter an incomplete specification such as `fixdt(1,16)` in the **Type** field. If you do not specify scaling explicitly, an error appears when you try to simulate your model.

To ensure that a data type definition is valid for fixed-point data, use one of the two options.

For more information, see “Use Data Types in Stateflow” on page 9-39.

**Lock data type against Fixed-Point tools**

Prevents replacement of the current fixed-point type with a type that the “Fixed-Point Tool” (Fixed-Point Designer) or “Fixed-Point Advisor” (Fixed-Point Designer) chooses. For methods on autoscaling fixed-point data, see “Choosing a Range Collection Method” (Fixed-Point Designer).

**Unit (e.g., m, m/s^2, N*m)**

For input and output data, you can specify physical units. See “Units in Stateflow” on page 23-48.

**Initial value**

Initial value of the data object. If you do not specify a value, the default is 0.0. The options for initializing values depend on the scope of the data object.

<table>
<thead>
<tr>
<th>Scope</th>
<th>What to Specify for Initial Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Expression or parameter defined in the Stateflow hierarchy, MATLAB workspace, or Simulink masked subsystem</td>
</tr>
<tr>
<td>Constant</td>
<td>Constant value or expression. The expression is evaluated when you update the chart. The resulting value is used as a constant for running the chart.</td>
</tr>
<tr>
<td>Parameter</td>
<td>You cannot enter a value. The chart inherits the initial value from the parameter.</td>
</tr>
<tr>
<td>Input</td>
<td>You cannot enter a value. The chart inherits the initial value from the Simulink input signal on the designated port.</td>
</tr>
</tbody>
</table>
**Scope** | **What to Specify for Initial Value**
--- | ---
Output | Expression or parameter defined in the Stateflow hierarchy, MATLAB workspace, or Simulink masked subsystem.
Data Store Memory | You cannot enter a value. The chart inherits the initial value from the Simulink data store to which it resolves.

For more information, see “Initialize Data from the MATLAB Base Workspace” on page 9-28 and “Share Simulink Parameters with Charts” on page 9-27.

**Allow initial value to resolve to a parameter**

For local data, you can set the initial value to be resolved to a Simulink parameter in your MATLAB workspace. Before you initialize local data to a Simulink parameter, click **Allow initial value to resolve to a parameter** in the Property Inspector. See “Block Parameters and Properties in Simulink” (Simulink).

**Limit range properties**

Range of acceptable values for this data object. Stateflow software uses this range to validate the data object during simulation. To establish the range, specify these properties:

- **Minimum** — The smallest value allowed for the data item during simulation. You can enter an expression or parameter that evaluates to a numeric scalar value.
- **Maximum** — The largest value allowed for the data item during simulation. You can enter an expression or parameter that evaluates to a numeric scalar value.

The smallest value that you can set for **Minimum** is \(-\infty\). The largest value that you can set for **Maximum** is \(\infty\).

**Note** A Simulink model uses the **Limit range** properties to calculate best-precision scaling for fixed-point data types. Before you select **Calculate Best-Precision Scaling** in the **General** pane, specify a minimum or maximum value. See “Calculate Best-Precision Scaling” on page 9-17.

For more information on entering values for **Limit range** properties, see “Enter Expressions and Parameters for Data Properties” on page 9-23.
**Add to Watch Window**

Option for watching the data values in the Stateflow Breakpoints and Watch window (see “Watch Stateflow Data Values” on page 30-34).

**Fixed-Point Data Properties**

Properties that apply to fixed-point data. These fixed-point properties are available only in the Data properties dialog box.

When the Data Type Assistant **Mode** is **Fixed point**, the Data Type Assistant displays fields for specifying additional information about your fixed-point data.

If the **Scaling** is **Slope and bias** rather than **Binary point**, the Data Type Assistant displays a **Slope** field and a **Bias** field rather than a **Fraction length** field.
You can use the Data Type Assistant to set these fixed-point properties:
**Signedness**

Specify whether you want the fixed-point data to be Signed or Unsigned. Signed data can represent positive and negative values, but unsigned data represents positive values only. The default setting is Signed.

**Word length**

Specify the bit size of the word that holds the quantized integer. Large word sizes represent large values with greater precision than small word sizes. The default bit size is 16.

- For chart-level data of the following scopes, word length can be any integer from 0 through 128.
  - Input
  - Output
  - Parameter
  - Data Store Memory
- For other Stateflow data, word length can be any integer from 0 through 32.

**Scaling**

Specify the method for scaling your fixed-point data to avoid overflow conditions and minimize quantization errors. The default method is Binary point scaling. You can select one of two scaling modes.
### Scaling Mode | Description
---|---
**Binary point** | If you select this mode, the Data Type Assistant displays the **Fraction length** field, which specifies the binary point location.

Binary points can be positive or negative integers. A positive integer moves the binary point left of the rightmost bit by that amount. For example, an entry of two sets the binary point in front of the second bit from the right. A negative integer moves the binary point further right of the rightmost bit by that amount, as in this example:

![Binary point diagram](image)

The default binary point is 0.

**Slope and bias** | If you select this mode, the Data Type Assistant displays fields for entering the **Slope** and **Bias**.

Slope can be any positive real number. The default slope is 1.0. Bias can be any real number. The default bias is 0.0. You can enter slope and bias as expressions that contain parameters you define in the MATLAB workspace.

**Note** Whenever possible, use binary-point scaling to simplify the implementation of fixed-point data in generated code. Operations with fixed-point data that use binary-point scaling are performed with simple bit shifts and eliminate expensive code implementations required for separate slope and bias values.

For more information about fixed-point scaling, see “Scaling” (Fixed-Point Designer).

**Data type override**

Specify whether to inherit the data type override setting of the Fixed-Point Tool that applies to this model. If the data does not inherit the model-wide setting, the specified data type applies. For more information about the Fixed-Point Tool, see `fxptdlg`. 
**Calculate Best-Precision Scaling**

Calculate the best-precision values for Binary point and Slope and bias scaling, based on the Limit range properties that you specify in the General tab of the Data properties dialog box.

To calculate best-precision scaling values:

1. In the Data properties dialog box, click the General tab.
2. Specify Limit range properties.
3. Click Calculate Best-Precision Scaling.

Simulink software calculates the scaling values and displays them in the Fraction length field or the Slope and Bias fields. For more information, see “Constant Scaling for Best Precision” (Fixed-Point Designer).

**Note** The Limit range properties do not apply to Constant and Parameter scopes. For Constant, Simulink software calculates the scaling values based on the Initial value setting. The software cannot calculate best-precision scaling for data of Parameter scope.

**Show Fixed-Point Details**

Option in the Data properties dialog box when you specify a fixed-point data type. To see information about the fixed-point data type that is defined in the Data Type Assistant, use the Fixed-point details section. Click the expander next to Fixed-point details in the Data Type Assistant.
The rows labeled Minimum and Maximum show the same values that appear in the corresponding Minimum and Maximum fields in the Limit range section. See “Signal Ranges” (Simulink) and “Specify Minimum and Maximum Values for Block Parameters” (Simulink).

The rows labeled Representable minimum, Representable maximum, and Precision show the minimum value, maximum value, and precision that can be represented by the fixed-point data type currently displayed in the Data Type Assistant.

The values displayed by the Fixed-point details subpane do not automatically update if you click Calculate Best-Precision Scaling, or change the range limits, the values that define the fixed-point data type, or anything elsewhere in the model. To update the values shown in the Fixed-point details subpane, click Refresh Details. The Data Type Assistant then updates or recalculates all values and displays the results.

Clicking Refresh Details does not change anything in the model; it changes only the display. To apply the displayed values, click OK or Apply. If the value of a field cannot be known without first compiling the model, the Fixed-point details subpane shows the value as Unknown. If errors occur when you click Refresh Details, the subpane shows an error flag on the left of the applicable row and a description of the error on the right. For example, the next figure shows two errors.
The row labeled Minimum shows the error Cannot evaluate because evaluating the expression MySymbol, specified in the Minimum field of the Limit range section, cannot
return a numeric value. When an expression does not evaluate successfully, the **Fixed-point details** subpane shows the unevaluated expression (truncating to 10 characters as needed) in place of the unavailable value.

To correct this error, define MySymbol in the base workspace to provide a numeric value. If you click **Refresh Details**, the value of MySymbol appears in place of the unevaluated text. The error indicator and description are deleted.

To correct the overflow error for **Maximum**, change the fixed-point data type so that it can represent the maximum value you specify.

- Decrease the value in the **Maximum** field of the **Limit range** section.
- Increase **Word length**.
- Decrease **Fraction length**.

**Set Properties in the Logging Section**

You can set these properties in the **Logging** section.

**Log signal data**

Saves the data value to the MATLAB workspace during simulation.

**Test point**

Designates the data as a test point. A test point is a signal that you can observe in a Floating Scope block in a model (see “Test Points” (Simulink)). Data objects can be test points if:

- Scope is **Local**.
- Parent is not a Stateflow machine.
- Data type is not **ml**.

**Logging name**

Specifies the name associated with logged signal data. Simulink software uses the signal name as its logging name by default. To specify a custom logging name, select **Custom** from the list box and enter the new name in the adjacent edit field.
Limit data points to last

Limits the amount of data logged to the most recent samples.

Decimation

Limits the amount of data logged by skipping samples. For example, a decimation factor of 2 saves every other sample.

Set Properties in the Description Pane

For C charts, in the Data properties dialog box, you can set these properties in the Description pane.

Save final value to base workspace

Option that assigns the value of the data item to a variable of the same name in the base workspace at the end of simulation (see “Model Workspaces” (Simulink)).

First index

Index of the first element of the data array. The default value is 0.

Units

Units of measurement that you want to associate with the data object. The unit in this field resides with the data object in the Stateflow hierarchy.

Description

Description of the data object.

Document link

Link to online documentation for the data object. You can enter a web URL address or a MATLAB command that displays documentation in a suitable online format, such as an HTML file or text in the MATLAB Command Window. When you click the Document link hyperlink at the bottom of the properties dialog box, Stateflow software evaluates the link and displays the documentation.
Enter Expressions and Parameters for Data Properties

In the Data properties dialog box, you can enter expressions as values for these properties:

- “Size” on page 9-9
- “Type” on page 9-10
- “Initial value” on page 9-11
- Minimum and Maximum (see “Limit range properties” on page 9-12)
- “Fixed-Point Data Properties” on page 9-13

Expressions can contain a mix of parameters, constants, arithmetic operators, and calls to MATLAB functions.

Default Data Property Values

When you leave an expression or parameter field blank, Stateflow software assumes a default value.

<table>
<thead>
<tr>
<th>Field</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial value</td>
<td>0.0</td>
</tr>
<tr>
<td>Maximum</td>
<td>inf</td>
</tr>
<tr>
<td>Minimum</td>
<td>-inf</td>
</tr>
<tr>
<td>Word length</td>
<td>16</td>
</tr>
<tr>
<td>Slope</td>
<td>1.0</td>
</tr>
<tr>
<td>Bias</td>
<td>0.0</td>
</tr>
<tr>
<td>Binary point</td>
<td>0</td>
</tr>
<tr>
<td>First index</td>
<td>0</td>
</tr>
</tbody>
</table>
| Size         | • –1 (inherited), for inputs, parameters, and function outputs  
               • 1 (scalar), for other data objects |

Use Parameters in Expressions

You can include parameters in expressions. A parameter is a constant that you can:
• Define in the MATLAB workspace (see “Initialize Data from the MATLAB Base Workspace” on page 9-28)
• Derive from a Simulink block parameter that you define and initialize in the parent masked subsystem (see “Share Simulink Parameters with Charts” on page 9-27)

You can mix both types of parameters in an expression.

**Use Constants in Expressions**

For expressions in the Data properties dialog box, you can use numeric constants of the appropriate type and size. Do not use Stateflow constants in these expressions.

**Use Arithmetic Operators in Expressions**

In the Data properties dialog box, you can use these arithmetic operators in expressions:

- +
- –
- *
- /

**Call Functions in Expressions**

In fields that accept expressions, you can call functions that return property values of other variables defined in the Stateflow hierarchy, MATLAB workspace, or Simulink masked subsystem. For example, these functions can return appropriate values for specified fields in the Data properties dialog box.

<table>
<thead>
<tr>
<th>Function</th>
<th>Returns</th>
<th>For Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stateflow function type on page 12-25</td>
<td>Type of input data</td>
<td>Data type</td>
</tr>
<tr>
<td>MATLAB function min</td>
<td>Smallest element or elements of input array</td>
<td>Minimum</td>
</tr>
<tr>
<td>MATLAB function max</td>
<td>Largest element or elements of input array</td>
<td>Maximum</td>
</tr>
<tr>
<td>Function</td>
<td>Returns</td>
<td>For Field</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Simulink function</td>
<td>Simulink.NumericType object that describes a fixed-point or floating-point data type</td>
<td>Data type</td>
</tr>
<tr>
<td>fixdt</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**See Also**

**More About**

- “Use Data Types in Stateflow” on page 9-39
- “Size Stateflow Data” on page 9-47
- “Identify Data Using Dot Notation” on page 9-57
- “Best Practices for Using Data in Charts” on page 9-66
Share Data with Simulink and MATLAB Workspace

In this section...

“Share Input Data with Simulink” on page 9-26
“Share Output Data with Simulink” on page 9-26
“Share Simulink Parameters with Charts” on page 9-27
“Initialize Data from the MATLAB Base Workspace” on page 9-28
“Save Data to the MATLAB Workspace” on page 9-29

Share Input Data with Simulink

Data flows from Simulink into a chart via input ports on the chart.

To add input data to a chart:

1 Add a data object to the chart, as described in “Add Data by Using the Stateflow Editor Menu” on page 9-2.

   Note Add the data to the chart itself, not to any other object in the chart.

2 In the Symbols window, set the TYPE to Input Data.

   An input port appears on the block in the model.

   You can change port assignments by editing the value in the PORT field.

3 Set the data type of the input data, as described in “Use Data Types in Stateflow” on page 9-39.

4 Set the size of the input data, as described in “Size Stateflow Data” on page 9-47.

   Note You cannot type or size Stateflow input data to accept frame-based data from Simulink.

Share Output Data with Simulink

Data flows from a chart into Simulink via output ports on the chart.
To add output data to a chart:

1. Add a data object to the chart, as described in “Add Data by Using the Stateflow Editor Menu” on page 9-2.

   **Note** Add data to the chart itself, not to any other object in the chart.

2. In the Symbols window, set the TYPE property to Output Data.

   An output port appears on the block in the model.

   You assign outputs to ports in the order in which you add the data. For example, you assign the third output to output port 3. You can change port assignments by editing the value in the PORT field.

3. Set the type of the output data, as described in “Use Data Types in Stateflow” on page 9-39.

4. Set the size of the output data, as described in “Size Stateflow Data” on page 9-47.

**Share Simulink Parameters with Charts**

**When to Share Simulink Parameters**

Share Simulink parameters with charts to maintain consistency with your Simulink model. By using parameters, you can also avoid hard-coding data sizes and types.

You can use parameters defined in a Stateflow chart in multiple Stateflow objects in the chart, such as states, MATLAB functions and truth tables.

**How to Share Simulink Parameters**

To share Simulink parameters for a masked subsystem with a chart, follow these steps:

1. In the Simulink mask editor for the parent subsystem, define and initialize a Simulink parameter.

2. In the Stateflow hierarchy, define a data object with the same name as the parameter (see “Add Stateflow Data” on page 9-2).

3. Set the scope of the data object to Parameter.

When simulation starts, Simulink tries to resolve the Stateflow data object to a parameter at the lowest level masked subsystem. If unsuccessful, Simulink moves up the model hierarchy to resolve the data object to a parameter at higher level masked subsystems.
Initialize Data from the MATLAB Base Workspace

For C charts, you can initialize data from the MATLAB base workspace. Initialization requires that you define data in both the MATLAB base workspace and the Stateflow hierarchy as follows:

1. Define and initialize a variable in the MATLAB workspace.
2. In the Stateflow hierarchy, define a data object with the same name as the MATLAB variable (see “Add Stateflow Data” on page 9-2).
3. Set the scope of the Stateflow data object to Parameter.

When simulation starts, data resolution occurs. During this process, the Stateflow data object gets its initial value from the associated MATLAB variable. For example, if the variable is an array, each element of the Stateflow array initializes to the same value as the corresponding element of the MATLAB array.

One-dimensional Stateflow arrays are compatible with MATLAB row and column vectors of the same size. For example, a Stateflow vector of size 5 is compatible with a MATLAB row vector of size [1,5] or column vector of size [5,1].

Time of Initialization

Data parent and scope control initialization time for Stateflow data objects.

<table>
<thead>
<tr>
<th>Data Parent</th>
<th>Scope</th>
<th>When Initialized</th>
</tr>
</thead>
<tbody>
<tr>
<td>Machine</td>
<td>Local, Exported</td>
<td>Start of simulation</td>
</tr>
<tr>
<td></td>
<td>Imported</td>
<td>Not applicable</td>
</tr>
<tr>
<td>Chart</td>
<td>Input</td>
<td>Not applicable</td>
</tr>
<tr>
<td></td>
<td>Output, Local</td>
<td>Start of simulation or when chart reinitializes as part of an enabled Simulink subsystem</td>
</tr>
<tr>
<td>State with History Junction</td>
<td>Local</td>
<td>Start of simulation or when chart reinitializes as part of an enabled Simulink subsystem</td>
</tr>
<tr>
<td>State without History Junction</td>
<td>Local</td>
<td>State activation</td>
</tr>
<tr>
<td>Function (graphical, truth table, and MATLAB functions)</td>
<td>Input, Output</td>
<td>Function-call invocation</td>
</tr>
<tr>
<td>Data Parent</td>
<td>Scope</td>
<td>When Initialized</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>Local</td>
<td>Start of simulation or when chart reinitializes as part of an enabled Simulink subsystem</td>
</tr>
</tbody>
</table>

**Save Data to the MATLAB Workspace**

For C charts, you can instruct the chart to save the final value of a data object at the end of simulation in the MATLAB base workspace (not as a masked subsystem parameter) for all scopes except **Constant** and **Parameter**.

Use one of these techniques:

- In the **Description** pane of the Data properties dialog box, select **Save final value to base workspace**.
- In the **Contents** pane of the Model Explorer, follow these steps:
  1. Select the row of the data object.
  2. Select the check box in the **SaveToWorkspace** column.
About Data Stores

You can use an interface to direct charts to access global variables in Simulink models. A Simulink model implements global variables as data stores, created either as data store memory blocks or as instances of Simulink.Signal objects. Data stores enable multiple Simulink blocks to share data without the need for explicit I/O connections to pass data from one block to another. Stateflow charts share global data with Simulink models by reading from and writing to data store memory symbolically.

You can use data stores with buses, but not with arrays of buses. For more information about using data stores with buses, see "Using Data Stores with Buses and Arrays of Buses" (Simulink).
Configure Charts to Use Data Stores

Charts can interface with local and global data stores. Local data stores, often implemented as data store memory blocks, are visible to all blocks in one model. To interact with local data stores, a chart must reside in the model where you define the local data store:

![Diagram showing local data store interaction]

Global data stores have a broader scope, which crosses model reference boundaries. To interact with global data stores, a chart must reside either in the top model — where the global data store is defined — or in any model that the top model references. You implement global data stores as Simulink signal objects.
Access Data Store Memory from a Chart

To access global data in a Simulink model from a chart, you must bind a Stateflow data object to a Simulink data store — either a data store memory block or a signal object. After you create the binding, the Stateflow data object becomes a symbolic representation of Simulink data store memory. You can then use this symbolic object to store and retrieve global data.

Bind a Stateflow Data Object to Data Store Memory

To bind a Stateflow data object to Simulink data store memory, you must create a data object in the Stateflow hierarchy with the same name as the data store and with scope set to Data Store Memory. The Stateflow data object inherits all properties from the data store to which you bind the object. Follow guidelines for specifying data store properties in “Best Practices for Using Data Stores” on page 9-38.

Note You cannot edit properties that the data object inherits from the data store.

Use the Stateflow Editor to Bind a Data Object

In the Stateflow Editor, follow these steps:

1. Select Chart > Add Other Elements > Data Store Memory.
   - The properties dialog box for the new data object appears with scope property set to Data Store Memory.

2. In the Name field of the Data properties dialog box, enter the name of the Simulink data store to which you want to bind.
3 Click OK.

**Use the Model Explorer to Bind a Data Object**

In the Model Explorer, follow these steps:

1 Select **Add > Data**.

   The Model Explorer adds a data object to the chart.

2 Double-click the new data object to open its properties dialog box, and enter the following information in the **General** pane:

<table>
<thead>
<tr>
<th>Field</th>
<th>What to Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the name of the Simulink data store memory block to which you want to bind.</td>
</tr>
<tr>
<td>Scope</td>
<td>Select <strong>Data Store Memory</strong> from the drop-down menu.</td>
</tr>
</tbody>
</table>

3 Click OK.

**Resolve Data Store Bindings**

Multiple local and global data stores with the same name can exist in the same model hierarchy. In this situation, the Stateflow data object binds to the data store that is the nearest ancestor.

**Read and Write Global Data Programmatically**

You can use the Stateflow data object that you bind to Simulink data store memory to store and retrieve global data in states and transitions. Think of this object as a global variable that you reference by its symbolic name — the same name as the data store to which you bind the object. When you store numeric values in this variable, you are writing to Simulink data store memory. Similarly, when you retrieve numeric values from this variable, you are reading from the data store memory.

The following chart reads from and writes to a data store memory block called *myglobal*. 
Define Data

A
entry: myglobal = 0;
during:
myglobal = myglobal+1;
y = myglobal;
[u < 0]
[u >= 0]

B
entry: myglobal = 0;
during:
myglobal--;
y = myglobal;
Chart and Block Data Diagnostics

In this section...

“Errors to Check For” on page 9-35
“When to Enable Diagnostics” on page 9-35
“When to Disable Diagnostics” on page 9-35
“How to Set Diagnostics for Shared Data” on page 9-36

Errors to Check For

Multiple reads and writes can occur unintentionally in the same time step. To detect these situations, you can configure data store memory blocks to generate errors or warnings for these conditions:

- Read before write
- Write after write
- Write after read

Note These diagnostics are available only for data store memory blocks used within a single Simulink model, not for data stores created from Simulink signal objects. In other words, these diagnostics do not work for global data stores that cross model reference boundaries.

When to Enable Diagnostics

Enable diagnostics on data store memory blocks to ensure the validity of data that multiple unconnected blocks share while running at different rates. In this scenario, you can detect conditions when writes do not occur before reads in the same time step. To prevent these violations, see “Best Practices for Using Data Stores” on page 9-38.

When to Disable Diagnostics

If you use a data store memory block as a persistent global storage area for accumulating values across time steps, disable diagnostics to avoid generating unnecessary warnings.
How to Set Diagnostics for Shared Data

To set diagnostics on data store memory blocks, follow these steps:

1. Double-click the data store memory block in your Simulink model to open its Block Parameters dialog box.
2. Click the Diagnostics tab.
3. Enable diagnostics by selecting warning or error from the drop-down menu for each condition you want to detect.
4. Click OK.
Create a Global Data Store Across Multiple Models

To create read/write references to a global data store that you can share across multiple models:

1. Define data store memory objects that reside in each chart that shares the data.
   a. Use the Model Explorer to add a data object to each chart, as described in “Add Data Through the Model Explorer” on page 9-3.
   b. Give each data object the same name.
   c. Set the scope of each data object to Data Store Memory.

2. Verify that your models do not contain any Data Store Memory blocks. However, you can include Data Store Read and Data Store Write blocks.

3. Create a Simulink.Signal object in the MATLAB base workspace.
   a. In the Model Explorer, navigate to Simulink Root > Base Workspace in the Model Hierarchy pane.
   b. Select Add > Simulink Signal.
   c. Give the object the same name as the data store memory objects in your charts.

4. Verify that these settings apply to the Simulink.Signal object:
   a. Set Data type to an explicit data type.
      The data type cannot be auto.
   b. Set Dimensions to be fully specified.
      The signal dimensions cannot be -1, or inherited.
   c. Set Complexity to be fully specified.
      The complexity cannot be Auto.
   d. Set Storage class to ExportedGlobal.
Best Practices for Using Data Stores

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“When Binding to Data Stores in Charts” on page 9-38</td>
</tr>
<tr>
<td>“When Enforcing Writes Before Reads in Unconnected Blocks” on page 9-38</td>
</tr>
</tbody>
</table>

When Binding to Data Stores in Charts

When you bind a Stateflow data object to a data store, the Stateflow object inherits all properties from the data store. To ensure that properties propagate correctly when you access data stores, follow these guidelines to create data stores:

- Specify a data type other than auto.
- Minimize the use of automatic-mode properties.

When Enforcing Writes Before Reads in Unconnected Blocks

To enforce writes before reads when unconnected blocks share global data in charts, follow these guidelines:

- Segregate reads into separate blocks from writes.
- Assign priorities to blocks so that your model invokes write blocks before read blocks.

For instructions on how to set block execution order, see “Control and Display the Sorted Order” (Simulink).
Use Data Types in Stateflow

In this section...

“What Is Data Type?” on page 9-39
“Specify Data Type with the Property Inspector” on page 9-39
“Specify Data Type with the Data Type Assistant” on page 9-39
“Built-In Data Types” on page 9-42
“Inherit Data Types from Simulink Objects” on page 9-43
“Derive Data Types from Previously Defined Data” on page 9-44
“Type Data by Using an Alias” on page 9-45
“Strong Data Typing with Simulink I/O” on page 9-45

What Is Data Type?

The term *data type* refers to how computers represent numbers in memory. The data type determines the amount of storage allocated to data, the method of encoding a data value as a pattern of binary digits, and the operations available for manipulating the data.

Specify Data Type with the Property Inspector

To specify the data type in the editor:

1. From the View menu, open the Symbols and Property Inspector windows.
2. In the Symbols window, select the data object row.
3. In the Property Inspector, enter the data type directly in the **Type** field, or select it from the **Type** drop-down list.

Specify Data Type with the Data Type Assistant

To specify the *type* of a Stateflow data object by using the Data Type Assistant:

1. Open the Data properties dialog box.
2. Click the **Data Type Assistant** button.
3. Choose a **Mode** in the Data Type Assistant section of the dialog box.
For each scope, you can choose from these modes.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Inherit</th>
<th>Built in</th>
<th>Fixed point</th>
<th>Enumerated</th>
<th>Expression</th>
<th>Bus Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td></td>
<td></td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td></td>
<td>For charts that use MATLAB as the action language, yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Constant</td>
<td>no</td>
<td>yes</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Parameter</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Input</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Output</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Data Store Memory</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

**4** Based on the mode you select, specify a data type.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inherit</td>
<td>You cannot specify a value. You inherit the data type based on the scope that you select for the data object:</td>
</tr>
<tr>
<td></td>
<td>• For charts that use MATLAB as the action language, if scope is <strong>Local</strong>, you infer the data type from the context of the MATLAB code in the chart.</td>
</tr>
<tr>
<td></td>
<td>• If the scope is <strong>Input</strong>, you inherit the data type from the Simulink input signal on the designated input port (see “Share Output Data with Simulink” on page 9-26).</td>
</tr>
<tr>
<td></td>
<td>• If the scope is <strong>Output</strong>, you inherit the data type from the Simulink output signal on the designated output port (see “Share Output Data with Simulink” on page 9-26).</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Avoid inheriting data types from output signals. See “Avoid inheriting output data properties from Simulink blocks” on page 9-66.</td>
</tr>
<tr>
<td></td>
<td>• If the scope is <strong>Parameter</strong>, you inherit the data type from the associated parameter, which you can define in a Simulink model or in the MATLAB workspace (see “Share Data with Simulink and MATLAB Workspace” on page 9-26).</td>
</tr>
<tr>
<td></td>
<td>• If the scope is <strong>Data Store Memory</strong>, you inherit the data type from the Simulink data store to which you bind the data object (see “Access Data Store Memory from a Chart” on page 9-32).</td>
</tr>
<tr>
<td>Built in</td>
<td>Select a data type from the drop-down list of supported data types, as described in “Built-In Data Types” on page 9-42.</td>
</tr>
<tr>
<td>Fixed point</td>
<td>Specify this information about the fixed-point data:</td>
</tr>
<tr>
<td></td>
<td>• Whether the data is signed or unsigned</td>
</tr>
<tr>
<td></td>
<td>• Word length</td>
</tr>
<tr>
<td></td>
<td>• Scaling mode</td>
</tr>
<tr>
<td></td>
<td>For information on how to specify these fixed-point data properties, see “Fixed-Point Data Properties” on page 9-13.</td>
</tr>
<tr>
<td>Enumerated</td>
<td>Specify the class name for the enumerated data type. For more information, see “Define Enumerated Data Types” on page 19-5.</td>
</tr>
</tbody>
</table>
Mode | Specify
---|---
Expression | In the **Type** field, enter an expression that evaluates to a data type. You can use these expressions:
- Alias type from the MATLAB workspace, as described in “Type Data by Using an Alias” on page 9-45
- `type` on page 12-25 operator to specify the type of previously defined data, as described in “Derive Data Types from Previously Defined Data” on page 9-44
- `fixdt` function to create a `Simulink.NumericType` object that describes a fixed-point or floating-point data type
For more information on how to build expressions in the Data properties dialog box, see “Enter Expressions and Parameters for Data Properties” on page 9-23.

Bus object | In the **Bus object** field, enter the name of a `Simulink.Bus` object to associate with the Stateflow bus object structure. You must define the bus object in the base workspace. If you have not yet defined a bus object, click **Edit** to create or edit a bus object in the Bus Editor. You can also inherit bus object properties from Simulink signals.

5 To save the data type settings, click **Apply**.

The Data Type Assistant is available only through the Data Properties dialog box. It is not available in the Symbols window. For more information on data properties, see “Stateflow Data Properties” on page 9-7.

**Built-In Data Types**

You can choose from these built-in data types:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>double</code></td>
<td>64-bit double-precision floating point</td>
</tr>
<tr>
<td><code>single</code></td>
<td>32-bit single-precision floating point</td>
</tr>
<tr>
<td><code>int32</code></td>
<td>32-bit signed integer</td>
</tr>
<tr>
<td><code>int16</code></td>
<td>16-bit signed integer</td>
</tr>
<tr>
<td><code>int8</code></td>
<td>8-bit signed integer</td>
</tr>
</tbody>
</table>
### Data Type

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>uint32</td>
<td>32-bit unsigned integer</td>
</tr>
<tr>
<td>uint16</td>
<td>16-bit unsigned integer</td>
</tr>
<tr>
<td>uint8</td>
<td>8-bit unsigned integer</td>
</tr>
<tr>
<td>boolean</td>
<td>Boolean (1 = true; 0 = false)</td>
</tr>
<tr>
<td>ml</td>
<td>Typed internally with the MATLAB array mxArray. The ml data type provides Stateflow data with the benefits of the MATLAB environment, including the ability to assign the Stateflow data object to a MATLAB variable or pass it as an argument to a MATLAB function. See “ml Data Type” on page 12-43. ml data cannot have a scope outside the Stateflow hierarchy; that is, it cannot have a scope of <strong>Input to Simulink</strong> or <strong>Output to Simulink</strong>.</td>
</tr>
</tbody>
</table>

### Inherit Data Types from Simulink Objects

Stateflow data objects of scope **Input**, **Output**, **Parameter**, and **Data Store Memory** can inherit their data types from Simulink objects, as follows:

<table>
<thead>
<tr>
<th>Scope:</th>
<th>Inherits type from:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Simulink input signal connected to corresponding input port in chart</td>
</tr>
<tr>
<td>Output</td>
<td>Simulink output signal connected to corresponding output port in chart. Avoid inheriting data types from output signals. See “Avoid inheriting output data properties from Simulink blocks” on page 9-66.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Corresponding MATLAB workspace variable or Simulink parameter in a masked subsystem</td>
</tr>
<tr>
<td>Data Store Memory</td>
<td>Corresponding Simulink data store</td>
</tr>
</tbody>
</table>

To configure these objects to inherit data types, create the corresponding objects in the Simulink model, and then select **Inherit: Same as Simulink** from the **Type** drop-
down list in the Data properties dialog box. See “Specify Data Type with the Data Type Assistant” on page 9-39.

To determine the data types that the objects inherit, build the Simulink model and look at the Compiled Type column to find each Stateflow data object in the Model Explorer.

Derive Data Types from Previously Defined Data

You can use the type operator to derive data types from previously defined Stateflow data. In this example, the expression type(inbus) specifies the data type of the Stateflow structure counterbus_struct. The Simulink.Bus object COUNTERBUS defines the inbus. Therefore, the structure counterbus_struct also derives its data type from the bus object COUNTERBUS.

After you build your model, the Compiled Type column of the Model Explorer shows the type of each data object in the compiled simulation application. See “type Operator” on page 12-25.
**Type Data by Using an Alias**

You can specify the type of Stateflow data by using a Simulink data type alias (see `Simulink.AliasType` in the Simulink Reference documentation). Suppose that you define a data type alias named `MyFloat`:

```matlab
MyFloat = Simulink.AliasType;
MyFloat.BaseType = 'single';
```

In this example, the data `y` has the same type as `MyFloat`.

After you build your model, the **Compiled Type** column of the Model Explorer shows the type used in the compiled simulation application.

**Strong Data Typing with Simulink I/O**

By default, inputs to and outputs from charts are of type `double`. Input signals from Simulink models convert to the type of the corresponding input data objects in charts.
Before they are exported as output signals to Simulink models, the data output objects convert to `double`.

In C charts, to interface directly with signals of data types other than `double` without conversion, select **Use Strong Data Typing with Simulink I/O**. This option appears in chart properties from the Model Explorer. The chart accepts input signals of any data type that Simulink supports, if the data type of the input signal matches the type of the corresponding Stateflow data object. Otherwise, you receive a type mismatch error.

**Note** For fixed-point data, select **Use Strong Data Typing with Simulink I/O** to flag mismatches between input or output fixed-point data in charts and their counterparts in Simulink models.

**See Also**

**More About**

- “Specify Chart Properties” on page 23-3
- “About Data Types in Simulink” (Simulink)
Size Stateflow Data

In this section...

“Methods for Sizing Stateflow Data” on page 9-47
“How to Specify Data Size” on page 9-48
“Inherit Input or Output Size from Simulink Signals” on page 9-48
“Guidelines for Sizing Data with Numeric Values” on page 9-48
“Guidelines for Sizing Data with MATLAB Expressions” on page 9-49
“Examples of Valid Data Size Expressions” on page 9-50
“Name Conflict Resolution for Variables in Size Expressions” on page 9-50
“Best Practices for Sizing Stateflow Data” on page 9-50

Methods for Sizing Stateflow Data

You can specify the size of Stateflow data by:

• Inheriting the size from a Simulink signal
• Using numeric values
• Using MATLAB expressions

Support for a sizing method depends on the scope of your data:

<table>
<thead>
<tr>
<th>Scope of Data</th>
<th>Method for Sizing Data</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Inherit the Size</td>
</tr>
<tr>
<td>Local</td>
<td>No</td>
</tr>
<tr>
<td>Constant</td>
<td>No</td>
</tr>
<tr>
<td>Parameter</td>
<td>No</td>
</tr>
<tr>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>Output</td>
<td>Yes</td>
</tr>
<tr>
<td>Data store memory</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Stateflow data store memory inherits all data properties, including size, from the Simulink data store to which it resolves. You cannot specify any properties explicitly for data store memory.

**How to Specify Data Size**

Specify the size of Stateflow data by setting the `Size` property in the Property Inspector or the Data properties dialog box. To specify the size of Stateflow data using API commands, set the `Props.Array.Size` property to a numeric value or a MATLAB expression that represents a scalar, vector, matrix, or n-dimensional array. For more information on using the API, see “Stateflow.Data Properties”.

**Inherit Input or Output Size from Simulink Signals**

To configure Stateflow input and output data to inherit size from the corresponding Simulink input and output signals, enter -1 in the `Size` field of the data properties. This default setting applies to input and output data that you add to your chart. After you build your model, the Compiled Size column of the Model Explorer displays the actual size that the compiled simulation application uses.

The equivalent API command for specifying an inherited data size is:

```matlab
data_handle.Props.Array.Size = '-1';
```

Chart actions that store values in the specified output infer the inherited size of output data. If the expected size in the Simulink signal matches the inferred size, inheritance is successful. Otherwise, a mismatch occurs during build time.

**Note** Charts cannot inherit frame-based data sizes from Simulink signals.

**Guidelines for Sizing Data with Numeric Values**

When you specify data size using numeric values in the `Size` field of the Data properties dialog box, follow these guidelines:
### Dimensionality

<table>
<thead>
<tr>
<th>Dimensionality</th>
<th>What to Specify in the Dialog Box</th>
<th>Equivalent API Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scalar</td>
<td>1 (or leave the field blank)</td>
<td><code>data_handle.props.array.size = '1';</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><code>data_handle.props.array.size = '';</code></td>
</tr>
<tr>
<td>Vector</td>
<td>The number of elements in the row or column vector</td>
<td><code>data_handle.props.array.size = 'number_of_elements';</code></td>
</tr>
<tr>
<td>Matrix</td>
<td>An expression of the format <code>[r c]</code>, where:</td>
<td><code>data_handle.props.array.size = ['[r c]';</code></td>
</tr>
<tr>
<td></td>
<td>• <code>r</code> is the number of rows</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <code>c</code> is the number of columns</td>
<td></td>
</tr>
</tbody>
</table>
| N-dimensional array | An expression of the format `[Size_of_dim1
|                     | Size_of_dim2 ... Size_of_dimN]`, where:               | `data_handle.props.array.size = ['[Size_of_dim1
|                     |                                                     | Size_of_dim2 ... Size_of_dimN]';`                       |
|                     | • `Size_of_dim1` is the size of the first dimension    |                                                             |
|                     | • `Size_of_dim2` is the size of the second dimension   |                                                             |
|                     | • `Size_of_dimN` is the size of the N-th dimension     |                                                             |

One-dimensional Stateflow vectors are compatible with Simulink row or column vectors of the same size. For example, Stateflow input or output data of size 3 is compatible with a Simulink row vector of size `[1 3]` or column vector of size `[3 1]`.

### Guidelines for Sizing Data with MATLAB Expressions

When you specify data size using MATLAB expressions, follow the same guidelines that apply to sizing with numeric values (see “Guidelines for Sizing Data with Numeric Values” on page 9-48). The following guidelines also apply:

- Expressions that specify the size of a dimension:
  - Can contain a mix of numeric values, variables, arithmetic operators, parameters, and calls to MATLAB functions.
• Must evaluate to a positive integer value.
• To specify inherited data size, you must enter –1 in the Size field or set the Props.Array.Size property for the data to –1. Expressions cannot evaluate to a value of –1.
• If the expression contains an enumerated value, you must include the type prefix for consistency with MATLAB naming rules.
  
  For example, Colors.Red is valid but Red is not.
• You cannot size Stateflow input data with an expression that accepts frame-based data from Simulink.

Examples of Valid Data Size Expressions

The following examples are valid MATLAB expressions for sizing data in your chart:

• K+3, where K is a chart-level Stateflow data
• N/2, where N is a variable in the MATLAB base workspace
• 2*Colors.Red, where Red is an enumerated value of type Colors
• [fi(2,1,16,2) fi(4,1,16,2)], which specifies a data size of [2 4] using a signed fixed-point type with word length of 16 and fraction length of 2

Name Conflict Resolution for Variables in Size Expressions

When multiple variables with identical names exist in a model, the variable with the highest priority applies:

1. Mask parameters
2. Model workspace
3. MATLAB base workspace
4. Stateflow data

Best Practices for Sizing Stateflow Data

Avoid use of variables that can lead to naming conflicts

For example, if a variable named off exists in the MATLAB base workspace and as local chart data, do not use off in the Size field of the data properties.
Avoid use of size(u) expressions

Instead of using a size(u) expression, use a MATLAB expression that evaluates directly to the size of Stateflow data.

See Also

More About
• “Stateflow Data Properties” on page 9-7
Handle Integer Overflow for Chart Data

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“When Integer Overflow Can Occur” on page 9-52</td>
</tr>
<tr>
<td>“Support for Handling Integer Overflow in Charts” on page 9-52</td>
</tr>
<tr>
<td>“Effect of Integer Promotion Rules on Saturation” on page 9-54</td>
</tr>
<tr>
<td>“Impact of Saturation on Error Checks” on page 9-55</td>
</tr>
</tbody>
</table>

**When Integer Overflow Can Occur**

For some arithmetic operations, a processor might need to take an $n$-bit fixed-point value and store it in $m$ bits, where $m \neq n$. If $m < n$, the reduced range of the value can cause an overflow for an arithmetic operation. Some processors identify this overflow as Inf or NaN. Other processors, especially digital signal processors (DSPs), handle overflows by saturating or wrapping the value.

For more information about saturation and wrapping for integer overflow, see “Saturation and Wrapping” (Fixed-Point Designer).

**Support for Handling Integer Overflow in Charts**

For charts, you can control whether or not saturation occurs for integer overflow. Use the chart property, **Saturate on integer overflow**, to control overflow handling.
Check Box | When to Use This Setting | Overflow Handling | Example of the Result
--- | --- | --- | ---
Selected | Overflow is possible for data in your chart and you want explicit saturation protection in the generated code. | Overflows saturate to either the minimum or maximum value that the data type can represent. | An overflow associated with a signed 8-bit integer saturates to -128 or +127 in the generated code.
Cleared | You want to optimize efficiency of the generated code. | The handling of overflows depends on the C compiler that you use for generating code. | The number 130 does not fit in a signed 8-bit integer and wraps to -126 in the generated code.

Arithmetic operations for which you can enable saturation protection are:
• Unary minus: \(-a\)
• Binary operations: \(a + b, a - b, a \times b, a / b, a ^ b\)
• Assignment operations: \(a += b, a -= b, a *= b, a /= b\)
• In C charts, increment and decrement operations: ++, --

When you select **Saturate on integer overflow**, be aware that:

• Saturation applies to all intermediate operations, not just the output or final result.
• The code generator can detect some cases when overflow is not possible. In these cases, the generated code does not include saturation protection.

To determine whether clearing the **Saturate on integer overflow** check box is a safe option, perform a careful analysis of your logic, including simulation if necessary. If saturation is necessary in only some sections of the logic, encapsulate that logic in atomic subcharts or MATLAB functions and define a different set of saturation settings for those units.

**Effect of Integer Promotion Rules on Saturation**

Charts use ANSI® C rules for integer promotion.

• All arithmetic operations use a data type that has the same word length as the target word size. Therefore, the intermediate data type in a chained arithmetic operation can be different from the data type of the operands or the final result.
• For operands with integer types smaller than the target word size, promotion to a larger type of the same word length as the target size occurs. This implicit cast occurs before any arithmetic operations take place.

For example, when the target word size is 32 bits, an implicit cast to `int32` occurs for operands with a type of `uint8`, `uint16`, `int8`, or `int16` before any arithmetic operations occur.

Suppose that you have the following expression, where \(y, u1, u2,\) and \(u3\) are of `uint8` type:

\[y = (u1 + u2) - u3;\]

Based on integer promotion rules, that expression is equivalent to the following statements:
uint8_T u1, u2, u3, y;
int32_T tmp, result;
tmp = (int32_T) u1 + (int32_T) u2;
result = tmp - (int32_T) u3;
y = (uint8_T) result;

For each calculation, the following data types and saturation limits apply.

<table>
<thead>
<tr>
<th>Calculation</th>
<th>Data Type</th>
<th>Saturation Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>tmp</td>
<td>int32</td>
<td>(MIN_INT32, MAX_INT32)</td>
</tr>
<tr>
<td>result</td>
<td>int32</td>
<td>(MIN_INT32, MAX_INT32)</td>
</tr>
<tr>
<td>y</td>
<td>uint8</td>
<td>(MIN_UINT8, MAX_UINT8)</td>
</tr>
</tbody>
</table>

Suppose that u1, u2, and u3 are equal to 200. Because the saturation limits depend on the intermediate data types and not the operand types, you get the following values:

- tmp is 400.
- result is 200.
- y is 200.

**Impact of Saturation on Error Checks**

Suppose that you set **Wrap on overflow** in the **Diagnostics: Data Validity** pane of the Model Configuration Parameters dialog box to **error** or **warning**. When you select **Saturate on integer overflow**, Stateflow does not flag cases of integer overflow during simulation. However, Stateflow continues to flag the following situations:

- Out-of-range data violations based on minimum and maximum range checks
- Division-by-zero operations
Define Temporary Data

In this section...

| “When to Define Temporary Data” on page 9-56 |
| “How to Define Temporary Data” on page 9-56 |

When to Define Temporary Data

In C charts, define temporary data when you want to use data that is only valid while a function executes. In charts that use MATLAB as the action language, you do not need to define temporary function data in the Model Explorer. If a variable is used and not previously defined, then it is automatically created. The variable is available to the rest of the function.

You can define temporary data in graphical, truth table, and MATLAB functions in your chart. For example, you can designate a loop counter to have Temporary scope if the counter value does not need to persist after the function completes.

How to Define Temporary Data

To define temporary data for a Stateflow function, follow these steps:

1. Open the Model Explorer.
2. In the Model Explorer, select the graphical, truth table, or MATLAB function that will use temporary data.
3. Select Add > Data.

   The Model Explorer adds a default definition for the data in the Stateflow hierarchy, with a scope set to Temporary by default.
4. Change other properties of the data if necessary, as described in “Set Data Properties” on page 9-7.
Identify Data Using Dot Notation

What Is Dot Notation?

Dot notation is a way to identify data and functions at a specific level of the chart hierarchy. A qualified data or function name uses dot notation to specify the path to the parent state for that data or function.

For example, you can specify qualified data names in state actions and transitions by using dot notation.

In this chart, data resides in the state aa. The qualified data names in state actions and transitions use dot notation to refer to this data.

- In state a, the entry action contains the qualified data name aa.data.
- In state b, the entry action contains the qualified data name a.aa.data.
- In the default transition, the action contains the qualified data name a.aa.data.

Resolution of Qualified Data Names with Dot Notation

During simulation, the chart searches for data that matches the qualified data name with dot notation. These rules apply:
The chart does not do an exhaustive search of all data. The chart does not stop searching after finding one match. The search continues until it reaches the chart level.

**Process for Resolving Qualified Data Names**

The flow chart describes the following search process.
### Stage | Action
---|---
1 | The search begins at the level of the hierarchy where the qualified data name appears.
   - For a state action, that state is the starting point.
   - For a transition label, the parent of the source object is the starting point.
2 | The chart searches at that level of the hierarchy for a path to the data. If the chart finds a match, it adds that path to the list of possible matches.
3 | The chart moves up to the next highest level of the hierarchy. At that level, the chart searches for a path to the data. If the chart finds a match, it adds that path to the list of possible matches.
4 | The previous step repeats until the search reaches the chart level.
5 | At the chart level, one more search occurs for a path to the data. If a match exists, that path becomes part of the list of possible matches. Then, the search ends.
6 | After the search ends, one of the following occurs:
   - If a unique match exists, the statement containing the qualified data name executes.
   - If no matches or multiple matches exist, an error message appears.

### Best Practices for Using Dot Notation in Qualified Data Names

These examples show how to avoid problems when using dot notation in qualified data names.

**Use a Specific Path in the Qualified Data Name**

Be specific when defining the path to the data.
Suppose that state aa contains data. In state b, the entry action contains aa.data, a qualified data name that the chart cannot resolve. The following search process occurs:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Action</th>
<th>Finds a Match?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chooses state b as the starting point and searches at that level for an object aa that contains data.</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Moves up to the next level of the hierarchy and searches at the chart level for an object aa that contains data.</td>
<td>No</td>
</tr>
</tbody>
</table>

The search ends, and an error message appears because no match exists for aa.data.

To avoid this error, use a specific path for the qualified data name in the entry action of state b:

en: a.aa.data+=1;

**Use Unique State Names**

Use unique names when you name the states in a chart.
Suppose that both states named `aa` contain a data object named `data`. In state `a`, the entry action contains two instances of `aa.data` that the chart cannot resolve. The following search process occurs:

<table>
<thead>
<tr>
<th>Stage</th>
<th>Action</th>
<th>Finds a Match?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chooses state <code>a</code> as the starting point and searches at that level for an object <code>aa</code> that contains <code>data</code>.</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Moves up to the next level of the hierarchy and searches at the chart level for an object <code>aa</code> that contains <code>data</code>.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The search ends, and an error message appears because multiple matches exist for `aa.data`.

To avoid this error, perform one of these corrective actions:

- Rename one of the two states named `aa`.
- Use a more specific path for the qualified data names in the entry action of state `a`:
  
  ```
  en: y+=a.aa.data, a.aa.data+=1;
  ```
- Enclose the outer state `aa` in a box or another state. Adding an enclosure prevents the search process from detecting that outer state.
Resolve Data Properties from Simulink Signal Objects

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“About Explicit Signal Resolution” on page 9-62</td>
</tr>
<tr>
<td>“Inherited Properties” on page 9-62</td>
</tr>
<tr>
<td>“Enable Signal Resolution” on page 9-63</td>
</tr>
<tr>
<td>“A Simple Example” on page 9-63</td>
</tr>
</tbody>
</table>

About Explicit Signal Resolution

Stateflow local and output data in charts can explicitly inherit properties from Simulink.Signal objects in the model workspace or base workspace. This process is called signal resolution and requires that the resolved signal have the same name as the chart output or local data.

For information about Simulink signal resolution, see “Symbol Resolution” (Simulink) and “Symbol Resolution Process” (Simulink).

Inherited Properties

When Stateflow local or output data resolve to Simulink signal objects, they inherit these properties:

- Size
- Complexity
- Type
- Minimum value
- Maximum value
- Initial value
- Storage class

Storage class controls the appearance of chart data in the generated code. See “Apply Custom Storage Classes to Individual Signal, State, and Parameter Data Elements” (Embedded Coder).
Enable Signal Resolution

To enable explicit signal resolution, follow these steps:

1. Set Configuration Parameters > Diagnostics > Data Validity > Signal resolution to a value other than None. For more information about the other options, see “Signal resolution” (Simulink).

2. In the model workspace, base workspace, or data dictionary, define a Simulink.Signal object with the properties you want your Stateflow data to inherit.

   For more information about creating Simulink signals, see Simulink.Signal.

3. Add output or local data to a chart.

4. Enter a name for your data that matches the name of the Simulink.Signal object.

5. In the data properties, select the Data must resolve to signal object check box.

   After you select this check box, the dialog box removes or grays out the properties that your data inherits from the signal. For a list of properties that your data can inherit during signal resolution, see “Inherited Properties” on page 9-62.

A Simple Example

The following model shows how a chart resolves local and output data to Simulink.Signal objects.

In the base workspace, there are three Simulink.Signal objects with these properties:
The chart contains three data objects — two outputs and a local variable — that will resolve to a signal with the same name, as follows:

When you build the model, each data object inherits the properties of the identically named signal:
The generated code declares the data based on the storage class that the data inherits from the associated Simulink signal. For example, the header file below declares `local` to be an exported global variable:

```c
/*
 * Exported States
 * 
 * Note: Exported states are block states with an exported
 * global storage class designation.
 * 
 */
extern real32_T local;          /* '<Root>/Chart' */
```
Best Practices for Using Data in Charts

In this section...

“Avoid inheriting output data properties from Simulink blocks” on page 9-66
“Restrict use of machine-parented data” on page 9-66

Avoid inheriting output data properties from Simulink blocks

Stateflow output data should not inherit properties from output signals, because the values back propagate from Simulink blocks and can be unpredictable.

Restrict use of machine-parented data

Avoid using machine-parented data. The presence of machine-parented data in a model prevents reuse of generated code and other code optimizations. This type of data is also incompatible with many Simulink and Stateflow features.

For example, the following features do not support machine-parented data:

- Enumerated data
- Simulink functions
- Chart SimState
- Implicit change events
- Detection of unused data
- Model referencing (see “Model Referencing Limitations” (Simulink))
- Analysis by Simulink Design Verifier™ software
- Code generation by Simulink PLC Coder™ software
- Parameters binding to a Simulink.Parameter object in the base workspace

To make Stateflow data accessible to other charts and blocks in a model, use data store memory. For details, see “Access Data Store Memory from a Chart” on page 9-32.
See Also

More About

- “Simulink Functions in Stateflow” on page 28-2
- “Reference Values by Name by Using Enumerated Data” on page 19-2
- “What Is a SimState?” on page 16-2
- “Keywords for Implicit Events” on page 10-35
- “Detect Unused Data in the Symbols Window” on page 9-5
Transfer Data Across Models

In this section...

| “Copy Data Objects” on page 9-68 |
| “Move Data Objects” on page 9-68 |

Copy Data Objects

When you copy a chart from one Simulink model to another, all data objects in the chart hierarchy are copied except those that the Stateflow machine parents. However, you can use the Model Explorer to transfer individual data objects from machine to machine.

To copy a data object, follow these steps:

1. In the Contents pane of the Model Explorer, right-click the data object you want to copy and select Copy from the context menu.
2. In the Model Hierarchy pane, right-click the destination Stateflow machine and select Paste from the context menu.

Move Data Objects

To move a data object, click the object in the Contents pane of the Model Explorer and drag it to the destination Stateflow machine in the Model Hierarchy pane.
Define Events

• “How Events Work in Stateflow Charts” on page 10-2
• “Define Events” on page 10-5
• “Set Properties for an Event” on page 10-7
• “Activate a Stateflow Chart Using Input Events” on page 10-9
• “Control States When Function-Call Inputs Reenable Charts” on page 10-14
• “Activate a Simulink Block Using Output Events” on page 10-22
• “Control Chart Execution Using Implicit Events” on page 10-35
• “Count Events” on page 10-40
• “Best Practices for Using Events in Stateflow Charts” on page 10-42
How Events Work in Stateflow Charts

In this section...

| “What Is an Event?” on page 10-2 |
| “When to Use Events” on page 10-2 |
| “Types of Events” on page 10-3 |
| “Where You Can Use Events” on page 10-3 |
| “Diagnostic for Detecting Unused Events” on page 10-3 |

What Is an Event?

An event is a Stateflow object that can trigger actions in one of these objects:

- A Simulink triggered subsystem
- A Simulink function-call subsystem
- A Stateflow chart

When to Use Events

Use events when you want to:

- Activate a Simulink triggered subsystem (see “Activate a Simulink Block Using Edge Triggers” on page 10-22)
- Activate a Simulink function-call subsystem (see “Activate a Simulink Block Using Function Calls” on page 10-30)
- Trigger actions in parallel states of a Stateflow chart (see “Broadcast Events to Synchronize States” on page 12-52)

Although Stateflow software does not limit the number of events you can use in a chart, the underlying C compiler enforces a theoretical limit of \(2^{31}-1\) events for the generated code.

When should I use conditions instead of events?

Use conditions on transitions when you want to:
• Represent conditional statements, for example, \( x < 1 \) or \( x == 0 \)
• Represent a change of input value from a Simulink block

For more information about using conditions on transitions, see “Transition Action Types” on page 12-7.

**Types of Events**

An explicit event is an event that you define and can have one of the following scopes.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local</td>
<td>Event that can occur anywhere in a Stateflow machine but is visible only in the parent object (and descendants of the parent). See “Directed Event Broadcasting” on page 12-52.</td>
</tr>
<tr>
<td>Input from Simulink</td>
<td>Event that occurs in a Simulink block but is broadcast to a Stateflow chart. See “Activate a Stateflow Chart Using Input Events” on page 10-9.</td>
</tr>
<tr>
<td>Output to Simulink</td>
<td>Event that occurs in a Stateflow chart but is broadcast to a Simulink block. See “Activate a Simulink Block Using Output Events” on page 10-22.</td>
</tr>
</tbody>
</table>

An implicit event is a built-in event that broadcasts automatically during chart execution (see “Control Chart Execution Using Implicit Events” on page 10-35).

**Where You Can Use Events**

You can define explicit events at these levels of the Stateflow hierarchy.

<table>
<thead>
<tr>
<th>An event you define in a...</th>
<th>Is visible to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>The chart and all states and substates</td>
</tr>
<tr>
<td>Subchart</td>
<td>The subchart and all states and substates</td>
</tr>
<tr>
<td>State</td>
<td>The state and all substates</td>
</tr>
</tbody>
</table>

**Diagnostic for Detecting Unused Events**

If you have unused events in your chart, a warning message appears during simulation with a list of events you can remove. By removing objects that have no effect on
simulation, you can reduce the size of your model. This diagnostic checks for usage of Stateflow events, except for the following types:

- Function-call input events
- Edge-triggered input events

After you select an event for removal, a dialog box confirms your choice. In this dialog box, you can specify that other deletions occur without confirmation. If you prevent the confirmation dialog box from appearing, you can reenable it at any time by typing at the command prompt:

```
  sfpref('showDeleteUnusedConfGui', 1)
```

You can control the level of diagnostic action for unused events in the **Diagnostics > Stateflow** pane of the Model Configuration Parameters dialog box. For more information, see the documentation for the “Unused data, events, messages, and functions” (Simulink) diagnostic.
Define Events

In this section...

“Add Events with the Stateflow Editor” on page 10-5
“Add Events with the Model Explorer” on page 10-5

Add Events with the Stateflow Editor

From the Stateflow editor, you can add events via the Symbols window or through menus.

To open the Symbols window, select View > Symbols. To add events in the Symbols window:

1. Click the Create Event icon.
2. In the row for the new event, under TYPE, click the icon and choose:
   - Input Event
   - Local Event
   - Output Event
3. Edit the name of the event.
4. For input and output event, click the PORT field and choose a port number.

To add events through menus, select one of these scopes.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Chart &gt; Add Inputs &amp; Outputs &gt; Event Input From Simulink</td>
</tr>
<tr>
<td>Output</td>
<td>Chart &gt; Add Inputs &amp; Outputs &gt; Event Output To Simulink</td>
</tr>
<tr>
<td>Local</td>
<td>Chart &gt; Add Other Elements &gt; Local Event</td>
</tr>
</tbody>
</table>

Specify properties for the new event as described in “Set Properties for an Event” on page 10-7.

Add Events with the Model Explorer

1. In the Stateflow Editor, select View > Model Explorer.
2 In the Model Explorer, on the **Model Hierarchy** pane, select the object in the Stateflow hierarchy where you want the new event to be visible.

The object you select becomes the parent of the event.

3 In the Model Explorer, select **Add > Event**.

The Model Explorer adds a default definition for the new event in the hierarchy and displays an entry row for the new event in the **Contents** pane.

4 Change the properties of the event that you add in one of these ways:

   • Right-click the event row and select **Properties** to open the Event properties dialog box.

   • To set specific properties such as **Name**, **Scope**, and **Port**, click individual cells in the entry row.

**See Also**

**More About**

   • “Set Properties for an Event” on page 10-7

   • “How Events Work in Stateflow Charts” on page 10-2
Set Properties for an Event

In this section...

“Access Event Properties” on page 10-7
“Property Fields” on page 10-7

Access Event Properties

You can specify event properties in either the Property Inspector or the Event properties dialog box in the Model Explorer.

• Property Inspector
  1. Open the Symbols window by selecting View > Symbols.
  2. In the Symbols window, right-click the event and select Inspect.
  3. In the Property Inspector window, edit the event properties.

• Model Explorer
  1. Double-click the event in the Contents pane.
  2. Edit the event properties in the Model Explorer Event properties dialog box.

Property Fields

Name

Name of the event. Actions reference events by their names. Names must begin with an alphabetic character, cannot include spaces, and cannot be shared by sibling events.

Scope

Scope of the event. The scope specifies where the event occurs relative to the parent object. For information about types of scope, see “Types of Events” on page 10-3.

Port

Property that applies to input and output events.

• For input events, port is the index of the input signal that triggers the event.
• For output events, port is the index of the signal that outputs this event.

You assign input and output events to ports in the order in which you add the events. For example, you assign the first input event to input port 1 and the third output event to output port 3.

You can change port assignments in the Model Explorer or the Event properties dialog box. When you change the number of one port, the numbers of other ports adjust automatically to preserve the relative order. See “Association of Input Events with Control Signals” on page 10-11 and “Association of Output Events with Output Ports” on page 10-33.

**Trigger**

Type of signal that triggers an input or output event. See “Activate a Stateflow Chart Using Input Events” on page 10-9 or “Activate a Simulink Block Using Output Events” on page 10-22.

**Debugger Breakpoints**

Option for setting debugger breakpoints at the start or end of an event broadcast. Available breakpoints depend on the scope of the event.

<table>
<thead>
<tr>
<th>Scope of Event</th>
<th>Available Breakpoints</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Start of Broadcast</td>
</tr>
<tr>
<td>Local</td>
<td>Yes</td>
</tr>
<tr>
<td>Input</td>
<td>Yes</td>
</tr>
<tr>
<td>Output</td>
<td>No</td>
</tr>
</tbody>
</table>

**Description**

Description of this event. You can enter brief descriptions of events in the hierarchy.

**Document Link**

Link to online documentation for events in a Stateflow chart. To document a particular event, set the Document Link property to a web URL address or MATLAB expression that displays documentation in a suitable online format (for example, an HTML file or text in the MATLAB Command Window). When you click the blue Document Link text, the chart evaluates the expression.
Activate a Stateflow Chart Using Input Events

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“What Is an Input Event?” on page 10-9</td>
</tr>
<tr>
<td>“Activate a Stateflow Chart Using Edge Triggers” on page 10-9</td>
</tr>
<tr>
<td>“Activate a Stateflow Chart Using Function Calls” on page 10-10</td>
</tr>
<tr>
<td>“Association of Input Events with Control Signals” on page 10-11</td>
</tr>
</tbody>
</table>

What Is an Input Event?

An input event occurs outside a chart but is visible only in that chart. This type of event allows other Simulink blocks, including other Stateflow charts, to notify a specific chart of events that occur outside it.

You can activate a Stateflow chart via a change in control signal (an edge-triggered input event) or a function call from a Simulink block (a function-call input event). The sections that follow describe when and how to use each type of input event.

Note You cannot mix edge-triggered and function-call input events in a Stateflow chart. If you try to mix these input events, an error message appears during simulation.

Activate a Stateflow Chart Using Edge Triggers

An edge-triggered input event causes a Stateflow chart to execute during the current time step of simulation. This type of input event works only when a change in control signal acts as a trigger.

When to Use an Edge-Triggered Input Event

Use an edge-triggered input event to activate a chart when your model requires chart execution at regular (or periodic) intervals.

How to Define an Edge-Triggered Input Event

To define an edge-triggered input event:

1. Add an event to the Stateflow chart, as described in “Define Events” on page 10-5.
Note You must add an input event to the chart and not to one of its objects.

2 Set the **Scope** property for the event to **Input from Simulink**.

A single trigger port appears at the top of the Stateflow block in the Simulink model.

3 Set the **Trigger** property to one of these edge triggers.

<table>
<thead>
<tr>
<th>Edge Trigger Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rising</td>
<td>Rising edge trigger, where the control signal changes from either zero or a negative value to a positive value.</td>
</tr>
<tr>
<td>Falling</td>
<td>Falling edge trigger, where the control signal changes from a positive value to either zero or a negative value.</td>
</tr>
<tr>
<td>Either</td>
<td>Either rising or falling edge trigger.</td>
</tr>
</tbody>
</table>

In all cases, the signal must cross 0 to be a valid edge trigger. For example, a signal that changes from -1 to 1 is a valid rising edge, but a signal that changes from 1 to 2 is not valid.

**Example of Using an Edge-Triggered Input Event**

The model `sf_loop_scheduler` shows how to use an edge-triggered input event to activate a Stateflow chart at regular intervals. For information on running this model and how it works, see “Schedule One Subsystem in a Single Step” on page 25-18.

**Activate a Stateflow Chart Using Function Calls**

A function-call input event causes a Stateflow chart to execute during the current time step of simulation.

Note When you use this type of input event, you must also define a function-call output event for the block that calls the Stateflow chart.

**When to Use a Function-Call Input Event**

Use a function-call input event to activate a chart when your model requires access to output data from the chart in the same time step as the function call.
How to Define a Function-Call Input Event

To define a function-call input event:

1. Add an event to the Stateflow chart, as described in “Define Events” on page 10-5.

   **Note** You must add an input event to the chart and not to one of its objects.

2. Set the **Scope** property for the event to **Input from Simulink**.

   A single trigger port appears at the top of the Stateflow block in the Simulink model.

3. Set the **Trigger** property to **Function call**.

Example of Using a Function-Call Input Event

The model `sf_loop_scheduler` shows how to use a function-call input event to activate a Stateflow chart. For information on running this model and how it works, see “Schedule One Subsystem in a Single Step” on page 25-18.

Association of Input Events with Control Signals

When you define one or more input events for a chart, a single trigger port to the chart block appears. External Simulink blocks can trigger the input events via a signal or vector of signals connected to the trigger port. The **Port** property of an input event associates the event with a specific element of a control signal vector that connects to the trigger port (see “Port” on page 10-7).

The number of the port that you assign to the input event acts as an index into the control signal vector. For example, the first element of the signal vector triggers the input event assigned to input port 1, the fourth element triggers the input event assigned to input port 4, and so on. You assign port numbers in the order in which you add the events. However, you can change these assignments by setting the **Port** property of an event to the index of the signal that you use to trigger the event.

Data Types Allowed for Input Events

For multiple input events to a trigger port, the data types of all signals must be identical. If you use signals of different data types as input events, an error message appears when you try to simulate your model.
For example, you can mux two input signals of type `double` to use as input events to a chart.

![Diagram of input signals](image1)

However, you cannot mux two input signals of different data types, such as `boolean` and `double`.

![Diagram of mixed data types](image2)

**Behavior of Edge-Triggered Input Events**

At any given time step, input events are checked in ascending order based on their port numbers. The chart awakens once per valid event. For edge-triggered input events, multiple edges can occur in the same time step, which wake the chart more than once in that time step. In this situation, events occur (and wake the chart) in an ascending order based on their port numbers.
Behavior of Function-Call Input Events

For function-call input events, only one trigger event exists. The caller of the event explicitly calls and executes the chart. Only one function call can be valid in a single time step.
Control States When Function-Call Inputs Reenable Charts

**Set Behavior for a Reenabled Chart**

If you define a function-call input event for a chart, you can control the behavior of states when this event reenables the chart:

1. Open the Chart properties dialog box.
2. For **States When Enabling**, select one of these options:
   - **Held** — Maintain most recent values of the states.
   - **Reset** — Revert to the initial values of the states.
   - **Inherit** — Inherit this setting from the parent subsystem.

<table>
<thead>
<tr>
<th>If...</th>
<th>The inherited setting is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The parent of the chart is the model root</td>
<td>Held</td>
</tr>
<tr>
<td>The chart is inside a Model block</td>
<td>Reset</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Model Reference” (Simulink).</td>
</tr>
</tbody>
</table>

For new charts, the default setting is **Held**.

**Behavior When the Parent Is the Model Root**

When the parent of your chart is the model root, the following types of behavior can occur when a function-call input event reenables the chart.
The chart... | When you set the States When Enabling property to...
--- | ---
Maintains the most recent values of the states | Inherit or Held
Reverts to the initial values of the states | Reset

**What Happens When the Setting Is Inherit or Held**

In the following model, the **Caller** chart uses the event **E** to wake up and execute the **Callee** chart.

![Diagram](image)

The **Caller** chart contains two states, **A** and **B**.

![Diagram](image)

When you bind **E** to **A**:

- Entering **A** enables the **Callee** chart.
- Exiting **A** disables the **Callee** chart.
- Reentering **A** reenables the **Callee** chart.

Each time the **Callee** chart executes, the output data **y** increments by one.
In the Chart properties dialog box for Callee, **States When Enabling** is Inherit. Because the parent of this chart is the model root, the chart maintains the most recent values of all states when reenabled.

During simulation, Callee maintains the most recent value of its state when the function-call input event reenables the chart at t = 20 and 40.

The key behaviors are:
<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Caller Chart</th>
<th>Callee Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 – 10</td>
<td>State A is active and enables Callee.</td>
<td>State A executes by incrementing y.</td>
</tr>
<tr>
<td>10 – 20</td>
<td>State B is active and disables Callee.</td>
<td>State A does not execute.</td>
</tr>
<tr>
<td>20 – 30</td>
<td>State A is active and reenables Callee.</td>
<td>State A executes by incrementing y.</td>
</tr>
<tr>
<td>30 – 40</td>
<td>State B is active and disables Callee.</td>
<td>State A does not execute.</td>
</tr>
<tr>
<td>40 – 50</td>
<td>State A is active and reenables Callee.</td>
<td>State A executes by incrementing y.</td>
</tr>
</tbody>
</table>

If **States When Enabling** is Held, the output is the same.

**What Happens When the Setting Is Reset**

Suppose that the **States When Enabling** property is Reset for Callee. During simulation, Callee reverts to the initial value of its state when the function-call input event reenables the chart at $t = 20$ and 40.
Behavior When the Chart Is Inside a Model Block

When your chart is inside a Model block, the following types of behavior can occur when a function-call input event reenables the chart.

<table>
<thead>
<tr>
<th>The chart...</th>
<th>When you set the States When Enabling property to...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintains the most recent values of the states</td>
<td>Held</td>
</tr>
<tr>
<td>Reverts to the initial values of the states</td>
<td>Inherit or Reset</td>
</tr>
</tbody>
</table>

What Happens When the Setting Is Inherit or Reset

The following model contains a Model block and a scope. (For more information about using Model blocks, see For more information, see “Model Reference” (Simulink).)
The Model block contains the Caller and Callee charts from “Behavior When the Parent Is the Model Root” on page 10-14.

In the Chart properties dialog box for Callee, **States When Enabling** is Inherit. Because this chart is inside a Model block, the chart reverts to the initial values of all states when reenabled.

During simulation, Callee reverts to the initial value of its state when the function-call input event reenables the chart at $t = 20$ and $40$. 
The key behaviors are:

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Caller Chart</th>
<th>Callee Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 – 10</td>
<td>State A is active and enables Callee.</td>
<td>State A executes by incrementing y.</td>
</tr>
<tr>
<td>10 – 20</td>
<td>State B is active and disables Callee.</td>
<td>State A does not execute.</td>
</tr>
<tr>
<td>20 – 30</td>
<td>State A is active and reenables Callee.</td>
<td>State A executes by incrementing y.</td>
</tr>
<tr>
<td>30 – 40</td>
<td>State B is active and disables Callee.</td>
<td>State A does not execute.</td>
</tr>
<tr>
<td>40 – 50</td>
<td>State A is active and reenables Callee.</td>
<td>State A executes by incrementing y.</td>
</tr>
</tbody>
</table>

If **States When Enabling** is Reset, the output is the same.
What Happens When the Setting Is Held

Suppose that the **States When Enabling** property is Held for Callee. During simulation, Callee maintains the most recent value of its state when the function-call input event reenables the chart at $t = 20$ and $40$. 
Activate a Simulink Block Using Output Events

What Is an Output Event?

An output event is an event that occurs in a Stateflow chart but is visible in Simulink blocks outside the chart. This type of event allows a chart to notify other blocks in a model about events that occur in the chart.

You use output events to activate other blocks in the same model. You can define multiple output events in a chart, where each output event maps to an output port (see “Port” on page 10-7).

Note Output events must be scalar.

Activate a Simulink Block Using Edge Triggers

An edge-triggered output event activates a Simulink block to execute during the current time step of simulation. This type of output event works only when a change in control signal acts as a trigger.

When to Use an Edge-Triggered Output Event

Use an edge-triggered output event to activate a Simulink subsystem when your model requires subsystem execution at regular (or periodic) intervals.

How to Define an Edge-Triggered Output Event

To define an edge-triggered output event:
1. Add an event to the Stateflow chart, as described in “Define Events” on page 10-5.
2. Set the **Scope** property for the event to **Output to Simulink**.
   
   For each output event you define, an output port appears on the Stateflow block.
3. Set the **Trigger** property of the output event to **Either Edge**.

**Note** Unlike edge-triggered input events, you cannot specify a *Rising* or *Falling* edge trigger.

**Example of Using an Edge-Triggered Output Event**

The following model shows how to use an edge-triggered output event to activate triggered subsystems at regular intervals.

The chart contains the edge-triggered output event e1 and the local data a, which switches between 0 and 1 during simulation.
In a chart, the **Trigger** property of an edge-triggered output event is always **Either Edge**. However, Simulink triggered subsystems can have a **Rising**, **Falling**, or **Either Edge** trigger. This model shows the difference between triggering a rising edge subsystem and an either edge subsystem.

<table>
<thead>
<tr>
<th>The output event e1 triggers the...</th>
<th>On...</th>
<th>When the data a switches...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Either edge subsystem</td>
<td>Every event broadcast</td>
<td>From 0 to 1, or from 1 to 0</td>
</tr>
<tr>
<td>Rising edge subsystem</td>
<td>Every other event broadcast</td>
<td>From 0 to 1</td>
</tr>
</tbody>
</table>

When you simulate the model, the scope shows these results.

**Queuing Behavior for Broadcasting an Edge-Triggered Output Event Multiple Times**

If a chart tries to broadcast the same edge-triggered output event multiple times in a single time step, the chart dispatches only one of these broadcasts in the present time step. However, the chart *queues up* any pending broadcasts for dispatch — that is, one at
a time in successive time steps. Each time the chart wakes up in successive time steps, if any pending broadcasts exist for the output event, the chart signals the edge-triggered subsystem for execution. Based on the block sorted order of the Simulink model, the edge-triggered subsystem executes. (For details, see “Control and Display the Sorted Order” (Simulink).)

**Note** For information on what happens for function-call output events, see “Interleaving Behavior for Broadcasting a Function-Call Output Event Multiple Times” on page 10-31.

**Queue Edge-Triggered Output Event Broadcasts**

In this model, the chart Caller uses the edge-triggered output event `output_cmd` to activate the chart Callee.

The chart Caller tries to broadcast the same edge-triggered output event four times in a single time step, as shown.

Each time the chart Callee is activated, the output data `y` increments by one.
When you simulate the model, you see this output in the scope.

![Scope diagram]

At $t = 1$, the chart Caller dispatches only one of the four output events. Therefore, the chart Callee executes once during that time step. However, the chart Caller queues up the other three event broadcasts for future dispatch — that is, one at a time for $t = 2$, $3$, and $4$. Each time Caller wakes up in successive time steps, it activates Callee for execution. Therefore, the action $y++$ occurs once per time step at $t = 1$, $2$, $3$, and $4$. During simulation, Callee executes based on the block sorted order of the Simulink model.

**Approximate a Function Call Using Queuing Behavior**

When you cannot use a function-call output event, such as for HDL code generation, you can approximate a function call by using:
- An edge-triggered output event
- An enabled subsystem
- Two consecutive event broadcasts

**Note** While you can approximate a function call, a subtle difference in execution behavior exists. Execution of a function-call subsystem occurs *during* execution of the chart action that provides the trigger. However, execution of an enabled subsystem occurs *after* execution of that chart action is complete.

In the following model, the chart Caller uses the edge-triggered output event `output_cmd` to activate the enabled subsystem. The scope shows the value of the output event during simulation.

The chart Caller broadcasts the edge-triggered output event using a send action.
When you simulate the model, you see the following output in the scope. The simulation runs for 40 seconds.

When simulation starts, the value of `output_cmd` is 0. At $t = 20$, the chart dispatches `output_cmd`. Because this value changes to 1, the enabled subsystem becomes active and executes during that time step. Because no other event broadcasts occur, the enabled
subsystem continues to execute at every time step until simulation ends. Therefore, the Display block shows a final value of 40.

To approximate a function call, add a second event broadcast in the same action.

When you simulate the model, you see the following output in the scope. The simulation runs for 40 seconds.
When simulation starts, the value of `output_cmd` is 0. At \( t = 20 \), the chart dispatches `output_cmd`. Because this value changes to 1, the enabled subsystem becomes active and executes during that time step. The chart also queues up the second event for dispatch at the next time step. At \( t = 21 \), the chart dispatches the second output event, which changes the value of `output_cmd` to 0. Therefore, the enabled subsystem stops executing and the Display block shows a final value of 20.

The queuing behavior of consecutive edge-triggered output events enables you to approximate a function call with an enabled subsystem.

**Activate a Simulink Block Using Function Calls**

A function-call output event activates a Simulink block to execute during the current time step of simulation. This type of output event works only on blocks that you can trigger with a function call.

**When to Use a Function-Call Output Event**

Use a function-call output event to activate a Simulink block when your model requires access to output data from the block in the same time step as the function call.

**How to Define a Function-Call Output Event**

To define a function-call output event:

1. Add an event to the chart, as described in “Define Events” on page 10-5.
2. Set the `Scope` property for the event to `Output to Simulink`.
   
   For each output event you define, an output port appears on the Stateflow block.
3. Set the `Scope` property of the output event to `Function call`.

**Example of Using a Function-Call Output Event**

The model `sf_loop_scheduler` shows how to use a function-call output event to activate a Simulink block. For information on running this model and how it works, see “Schedule One Subsystem in a Single Step” on page 25-18.
The function-call output event... | Of the chart... | Activates...
---|---|---
call | Edge to Function | The chart Looping Scheduler
A1 | Looping Scheduler | The function-call subsystem A1

**Interleaving Behavior for Broadcasting a Function-Call Output Event Multiple Times**

If a chart tries to broadcast the same function-call output event multiple times in a single time step, the chart dispatches all the broadcasts in that time step. Execution of function-call subsystems is *interleaved* with the execution of the function-call initiator so that
output from the function-call subsystem is available right away in the function-call initiator. (For details, see “Using Function-Call Subsystems” (Simulink).)

**Note** For information on what happens for edge-triggered output events, see “Queuing Behavior for Broadcasting an Edge-Triggered Output Event Multiple Times” on page 10-24.

### Interleave Function-Call Output Event Broadcasts

In this model, the chart Caller uses the function-call output event `output_cmd` to activate the chart Callee.

The chart Caller tries to broadcast the same function-call output event four times in a single time step, as shown.

Each time the chart Callee is activated, the output data `y` increments by one.
When you simulate the model, you see this output in the scope.

At $t = 1$, the chart Caller dispatches all four output events. Therefore, the chart Callee executes four times during that time step. Therefore, the action $y++$ also occurs four times in that time step. During simulation, execution of Callee is interleaved with execution of Caller so that output from Callee is available right away.

**Association of Output Events with Output Ports**

The **Port** property associates an output event with an output port on the chart block that owns the event. This property specifies the position of the output port relative to others.

All output ports appear sequentially from top to bottom. Output data ports appear sequentially above output event ports on the right side of a chart block. As you add output
events, their default **Port** properties appear sequentially at the end of the current port list.

You can change the default port assignment of an event by resetting its **Port** property. When you change the **Port** property for an output event, the ports for the remaining output events automatically renumber, preserving the original order. For example, assume you have three output events, OE1, OE2, and OE3, which associate with the output ports 4, 5, and 6, respectively. If you change the **Port** property for OE2 to 6, the ports for OE1 and OE3 renumber to 4 and 5, respectively.

**Access Simulink Subsystems Triggered By Output Events**

To access the Simulink subsystem associated with a Stateflow output event:

1. In your chart, right-click the state or transition that contains the event of interest and select **Explore**.
2. Select the desired event.

   The Simulink subsystem associated with the event appears.
What Are Implicit Events?

Implicit events are built-in events that occur when a chart executes:

- Chart waking up
- Entry into a state
- Exit from a state
- Value assigned to an internal data object

These events are *implicit* because you do not define or trigger them explicitly. Implicit events are children of the chart in which they occur and are visible only in the parent chart.

Keywords for Implicit Events

To reference implicit events, action statements use this syntax:

```
event(object)
```

where `event` is the name of the implicit event and `object` is the state or data in which the event occurs.

Each keyword below generates implicit events in the action language notation for states and transitions.
### Implicit Event

<table>
<thead>
<tr>
<th>Implicit Event</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>change(data_name) or</td>
<td>Specifies and implicitly generates a local event when Stateflow software</td>
</tr>
<tr>
<td>chg(data_name)</td>
<td>writes a value to the variable data_name. The variable data_name cannot</td>
</tr>
<tr>
<td></td>
<td>be machine-parented data. This implicit event works only with data that is</td>
</tr>
<tr>
<td></td>
<td>at the chart level or lower in the hierarchy. For machine-parented data,</td>
</tr>
<tr>
<td></td>
<td>use change detection operators to determine when the data value changes.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Detect Changes in Data Values” on page 12-74.</td>
</tr>
<tr>
<td>enter(state_name) or</td>
<td>Specifies and implicitly generates a local event when the specified</td>
</tr>
<tr>
<td>en(state_name)</td>
<td>state_name is entered.</td>
</tr>
<tr>
<td>exit(state_name) or</td>
<td>Specifies and implicitly generates a local event when the specified</td>
</tr>
<tr>
<td>ex(state_name)</td>
<td>state_name is exited.</td>
</tr>
<tr>
<td>tick</td>
<td>Specifies and implicitly generates a local event when the chart of the</td>
</tr>
<tr>
<td></td>
<td>action being evaluated awakens.</td>
</tr>
<tr>
<td>wakeup</td>
<td>Same as the tick keyword.</td>
</tr>
</tbody>
</table>

If more than one object has the same name, use the dot operator to qualify the name of the object with the name of its parent. These examples are valid references to implicit events:

```
enter(switch_on)
en(switch_on)
change(engine.rpm)
```

**Note** The tick (or wakeup) event refers to the chart containing the action being evaluated. The event cannot refer to a different chart by argument.

### Transition Between States Using Implicit Events

This example illustrates use of implicit tick events.
Fan and Heater are parallel (AND) superstates. The first time that an event awakens the Stateflow chart, the states Fan.Off and Heater.Off become active.

Assume that you are running a discrete-time simulation. Each time that the chart awakens, a tick event broadcast occurs. After four broadcasts, the transition from Fan.Off to Fan.On occurs. Similarly, after three broadcasts, the transition from Heater.Off to Heater.On occurs.

For information about the after operator, see “Control Chart Execution Using Temporal Logic” on page 12-55.

**Execution Order of Transitions with Implicit Events**

Suppose that:

- Your chart contains parallel states.
- In multiple parallel states, the same implicit event is used to guard a transition from one substate to another.

When multiple transitions are valid in the same time step, the transitions execute based on the order in which they were created in the chart. This order does not necessarily match the activation order of the parallel states that contain the transitions. For example, consider the following chart:
When the transition from \texttt{IV.HERE} to \texttt{IV.THERE} occurs, the condition \texttt{ex(IV.HERE)} is valid for the transitions from A to B for the parallel states I, II, and III. The three transitions from A to B execute in the order in which they were created: in state I, then II, and finally III. This order does not match the activation order of those states.

To ensure that valid transitions execute in the same order that the parallel states become active, use the \texttt{in} operator instead of implicit \texttt{enter} or \texttt{exit} events:
With this modification, the transitions from A to B occur in the same order as activation of the parallel states. For more information about the `in` operator, see “Check State Activity” on page 12-86.
Count Events

In this section...

“When to Count Events” on page 10-40
“How to Count Events” on page 10-40
“Collect and Store Input Data in a Vector” on page 10-40

When to Count Events

Count events when you want to keep track of explicit or implicit events in your chart.

How to Count Events

You can count occurrences of explicit and implicit events using the `temporalCount` operator. For information about the syntax of this operator, see “Operators for Event-Based Temporal Logic” on page 12-56.

Collect and Store Input Data in a Vector

The following model collects and stores input data in a vector during chart simulation:

The chart contains two states and one MATLAB function:
**Stage 1: Observation of Input Data**

The chart awakens and remains in the *Observe* state, until the input data \( u \) is positive. Then, the transition to the state *Collect_Data* occurs.

**Stage 2: Storage of Input Data**

After the state *Collect_Data* becomes active, the value of the input data \( u \) is assigned to the first element of the vector \( y \). While this state is active, each subsequent value of \( u \) is assigned to successive elements of \( y \) using the \texttt{temporalCount} operator.

**Stage 3: Display of Data Stored in the Vector**

After 10 ticks, the data collection process ends, and the transition to the state *Observe* occurs. Just before the state *Collect_Data* becomes inactive, a function call to \texttt{status} displays the vector data at the MATLAB prompt.

For more information about ticks in a Stateflow chart, see “Control Chart Execution Using Implicit Events” on page 10-35.
Best Practices for Using Events in Stateflow Charts

Use the send command to broadcast explicit events in actions

In state actions (entry, during, exit, and on event_name) and condition actions, use the send command to broadcast explicit events. Using this command enhances readability of a chart and ensures that explicit events are not mistaken for data. See “Directed Event Broadcasting” on page 12-52 for details.

Do not mix edge-triggered input events and function-call input events in a chart

If you mix input events that use edge triggers and function calls, the chart detects this violation during parsing, or simulation. An error message appears and chart execution stops.

Avoid using the enter implicit event to check state activity

Use the in operator instead of the enter implicit event to check state activity. See “Check State Activity” on page 12-86 for details.
Messages

- “How Messages Work in Stateflow Charts” on page 11-2
- “View Differences Between Stateflow Messages, Events, and Data” on page 11-4
- “Stateflow Message Syntax in Charts” on page 11-13
- “Queuing Behavior of Stateflow Messages” on page 11-21
- “Lifetime of a Stateflow Message” on page 11-23
- “Limitations for Messages” on page 11-25
- “Define Messages in a Stateflow Chart” on page 11-26
- “Set Message Properties” on page 11-28
- “Work with Sequence Viewer” on page 11-31
How Messages Work in Stateflow Charts

In Stateflow, you can use messages to communicate within and between Stateflow charts. From a chart, you send and forward messages that can hold data. After you send a message, an input or local queue for a chart receives it. The message is held in the queue until the chart evaluates the message.

The first time a chart transition or action evaluates a message, the chart determines if the message is present in the queue. If the message is present in the queue, then the chart removes it from the queue. This message is valid until it is forwarded, or until the end of the time step. While the message is valid, other transitions or actions can access the message data. While the message is valid, another transition or action that evaluates the message will not remove another message from the queue. The chart destroys all valid messages at the end of the current time step. You access message data by reading it or writing to it.

When a chart receives a message, it does not trigger the chart to wake up. Events trigger a chart to wake up. If the receiver chart cannot immediately respond to the event, then the event is lost. Messages are queued at the message input port until the chart wakes up. When the chart wakes up, it can respond to the messages in the input queue.

Message lines connect input and output ports in Simulink. You can create local messages. A local message has its own queue with the same queue properties as the message input port.

To visualize the interchange of messages during simulation, view the Sequence Viewer block.

See Also

Related Examples

- “View Differences Between Stateflow Messages, Events, and Data” on page 11-4
- “Work with Sequence Viewer” on page 11-31

More About

- “Lifetime of a Stateflow Message” on page 11-23
• “Stateflow Message Syntax in Charts” on page 11-13
View Differences Between Stateflow Messages, Events, and Data

This example shows the difference in behavior of a Stateflow message compared to events or data.

Sender Charts

This model has three sender charts, DataSender, EventSender, and MessageSender. Each sender chart has one state, A. In the entry action of state A, each chart assigns an output data value to 1, sends a function-call event, or sends a message.
**Receiver Charts**

For each of the sender charts, there is a corresponding receiving chart. Each receiver chart has a state diagram with states A0, A1, A2, and A3. Each receiver chart has a transition from A0 to A1 after 3 seconds. The data, event, or message from the corresponding sender chart guards the transitions between A1, A2, and A3.
**Scope Output**

Each receiver chart has active state output enabled, with the output port connected to a scope. On the scope output, you see which states are active for each time step. This output highlights the difference in behavior between output data, event, and message.
View Differences Between Stateflow Messages, Events, and Data
**Behavior of Data**

In the entry action of chart `DataSender`, the output data `M` is assigned a value of 1. M connects as input to the chart `DataReceiver`. M holds this assigned value throughout the simulation. Because there is no input event, the chart `DataReceiver` executes once every time step. In chart `DataReceiver`, initially state A0 is active. At t=3, the chart takes the transition to A1. On the scope, you see the state change from A0 to A1. In the next time step, t=4, the transition tests if M equals 1. This condition is true, so the chart takes the transition to A2. At t=5, M still equals 1. The chart transitions from A2 to A3.

After data is assigned a value, it remains valid. Therefore, each time a transition evaluates M, you see `DataReceiver` transition to a new state.
Behavior of Event

The chart EventSender uses the syntax `send(M)` to send an event as an entry action in state A. This function-call event is an input event to wake up the chart EventReceiver. The chart EventReceiver executes only when the input event M wakes the chart up. When event M wakes up chart EventReceiver, state A₀ is active. The chart checks for a valid transition from state A₀. The transition from A₀ is based on absolute-time temporal logic, and is not valid at t=0. A₀ remains as the active state, and the chart goes back to sleep. The chart EventReceiver does not wake up again, because chart EventSender only sends event M once. On the scope, you see that EventReceiver never transitions out of A₀.

Because events do not remain valid across time steps, the chart has only one chance to respond to the event. When EventSender sent the event, EventReceiver was not in a state to respond to it. The ability for EventReceiver to transition in response to the event is lost.
Behavior of Message

The chart MessageSender uses the syntax send(M) to send one message through the message output port. The message goes in the message input receiving queue for the chart, MessageReceiver. The message waits until MessageReceiver evaluates it. Because there is no input event, the chart MessageReceiver executes once every time step. In MessageReceiver, initially, state A0 is active. The chart transitions to state A1 at t=3. In the next time step, t=4, the transition determines if M is present. The chart removes M from the receiver input queue. Because M is valid, the chart takes the transition to A2. The chart destroys M at the end of the time step t=4. At t=5, another message is not present in the queue, so the chart does not transition to A3. A2 remains the active state.
Unlike events, messages are queued. The receiving chart can choose to respond to a message anytime after it was sent. Unlike data, the message does not remain valid across time steps. If the number of messages the chart receives overflows the input queue, then a message overflow error occurs.

See Also

More About

- “How Messages Work in Stateflow Charts” on page 11-2
- “Queuing Behavior of Stateflow Messages” on page 11-21
- “Stateflow Message Syntax in Charts” on page 11-13
Stateflow Message Syntax in Charts

In this section...

| Access the Data in a Message “Access the Data in a Message” on page 11-13 |
| “Send a Message” on page 11-13 |
| “Guard a Transition or Action with a Message” on page 11-14 |
| “Receive a Message” on page 11-15 |
| “Discard a Message” on page 11-16 |
| “Forward a Message” on page 11-17 |
| “Determine if a Message Is Valid” on page 11-18 |
| “Check the Length of the Queue” on page 11-19 |

Access the Data in a Message

Stateflow messages have a data field. You can read or write to the message data of a valid message with dot notation syntax. For example, for message M, access the data with this syntax:

M.data

Set the data type in the Message properties dialog box.

Do not access message data for messages that are still in the queue. See “Lifetime of a Stateflow Message” on page 11-23.

Send a Message

To send a message, use this syntax:

send(message_name)

If the message scope is Output, then the chart sends the message through the output port to the input message queue of the receiving chart. If the message is local, then the message goes in the local message queue.

In this example, M is a message with scope Output. On entry to state A, the chart sends a message from message output port M, with a data value of 3.
In a single time step, you can send multiple messages through an output port or to a local queue. If you send a message without assigning a value to the message data, Stateflow initializes the message data to 0.

**Guard a Transition or Action with a Message**

The first time the chart evaluates a transition that a message guards or a message on action, the chart determines if the message is present in the message input or local queue. If the message is present, the chart removes the message from the queue. This message is valid until the chart forwards it, until it is discarded, or until the end of the time step. While the message is valid, another transition or action that evaluates the message does not remove another message from the queue. While the message is valid, other transitions or actions can access the message data.

This example demonstrates a message guard M on a transition. The transition first checks the message queue M. If there is a message present in the queue, the chart removes it from the queue. If the data value of the valid message is equal to 3, then the chart takes the transition from state A to state B. If there was no message present, or if the data value is not equal to 3, then the chart does not take the transition.

**Note** The message is removed from the queue whether the transition is taken or not.
In this example, when the chart executes state A, the chart checks the message queue M. If there is a message present, the chart removes it from the queue. If the message data value is equal to 3, then the chart executes the if statement action. If there is no message present, the chart does not execute the if statement.

**Receive a Message**

To receive a message, use this syntax:

```plaintext
receive(message_name)
```

This keyword is equivalent to on M or message guard M on transitions. If a valid message M exists, receive(M) returns true. If a valid message does not exist, the chart removes a message from its associated queue, and receive(M) returns true. If receive(M)
removes a message from the queue, the length of the queue drops by one. If there are no messages in the queue, receive(M) returns false.

In this example, when the chart executes state A, the chart checks the message queue M. If there is a message present, the chart removes it from the queue. If the message data value is equal to 3, then the chart executes the if statement action. If there is no message present, the chart does not execute the if statement.

**Discard a Message**

To discard a message, use this syntax:

`discard(message_name)`

To discard a message, it must be valid. After you discard a message, you can remove the next message from the queue within the same time step. Once a message is discarded, you will not be able to access the message data.

In this example, when the chart executes state A, on entry the chart checks the message queue M. If there is a message present, the chart removes it from the queue. The chart then checks if a message was received. If receive(M) returns true, the chart then checks if the message data value is equal to 3. If the message data value is equal to 3, the message is discarded.
Forward a Message

Forward an Input Message

You can forward a message from an input message queue to an output port. A message line connects the output port to a receiving chart input port in Simulink.

In this example, in state A, Stateflow determines if a message is present at input port M_in. If a message is present, then the chart removes the message from the queue and forwards it to the output port M_out. After the chart forwards the message, the message is no longer valid in state A. If there is another reference to the message queue, the chart determines whether there is another message available for use in the queue.
After a chart forwards a message, if there is another reference to the same message queue, then the chart looks for another message on the queue.

**Forward a Local Message**

You can forward messages to and from local message queues. In this example, if a message is present at input port \( M_{\text{in}} \), then in state \( A \), Stateflow forwards the message to the local message queue, \( M_{\text{local}} \). After a 0.3 sec delay, on the transition from state \( A \) to \( B \), the chart determines if a message is present on \( M_{\text{local}} \). The chart removes the message from the \( M_{\text{local}} \) message queue and forwards it to the output port \( M_{\text{out}} \).

**Determine if a Message Is Valid**

To determine if a message is valid, use this syntax:

\[
\text{isvalid}(message\_name)
\]
A message is valid if the chart had removed it from the queue, but it has not been forwarded or discarded. Use isValid(M) to check if a message is valid in a Simulink model that contains more than one Stateflow chart.

In this example, the chart first executes state A. When the chart executes state B, it first checks to see if message M is valid using isValid(M). If message M is valid, then the chart executes the if statement action. If message M is not valid, the chart does not execute the if statement.

![Stateflow chart](image)

**Check the Length of the Queue**

To check the length of a message queue, use this syntax:

```
length(message_name)
```

Use length(M) to determine the number of messages in the queue associated with M.

In this example, the chart first executes state A. The queue associated with message M has been set to a number larger than 75. Once the length of the message queue associated with M becomes equal to 75, an action within the second if statement is taken.
See Also

Related Examples
- “Define Messages in a Stateflow Chart” on page 11-26
- “Set Message Properties” on page 11-28
Queuing Behavior of Stateflow Messages

When you send a message, the message goes into the Input or Local message queue. The queue type determines the order in which messages are removed from the queue. In the Message properties dialog box, set the queue type for each input and local message object to:

- FIFO (First In, First Out) (default)
- LIFO (Last In, First Out)
- Priority

If Queue type is Priority, choose:

- Ascending — The order of the message removed is based on an ascending order of the message data value.
- Descending — The order of the message removed is based on a descending order of the message data value.

Messages of scope Input and Local have a queue capacity. If the number of incoming messages exceeds the queue capacity, then a message overflow occurs. Set the diagnostic action by setting the message queue property Queue overflow diagnostic.

- Error (default)
- Warning
- None

Set the queue capacity high enough so that incoming messages do not overflow the queue. To check the length of the queue, use length.

**Note** The maximum queue length is $2^{16}-1$.

To add messages to the Stateflow Breakpoints and Watch window, select Add to Watch Window while viewing the message in the Property Inspector. When the simulation pauses, you can view message queues and message data values. To visualize the interchange of messages, use a Sequence Viewer block in your model.
See Also

Related Examples

- “Work with Sequence Viewer” on page 11-31
- “Lifetime of a Stateflow Message” on page 11-23
- “View Differences Between Stateflow Messages, Events, and Data” on page 11-4
- “Watch Stateflow Data Values” on page 30-34
Lifetime of a Stateflow Message

A Stateflow message has a finite lifetime. The lifetime begins when you send a message with the syntax `send(message_name)`. An input or local message queue receives the message. The message remains in the queue until the first time that a transition or action evaluates it, or it is evaluated with `receive(M)`. When the message is evaluated or received, it becomes valid. The message is valid until:

- The chart forwards it to another queue.
- The end of the current time step.
- The message is discarded.

While a message is valid, other transitions and actions can guard conditions with the message and access the message data. When you forward a message, the message continues its lifetime in the receiving queue.

At the end of a time step, a chart destroys any remaining valid messages. You can destroy a message during a time step by using `discard`. To check if a message is valid, use `isvalid`.

If the receiving queue is full, a message overflow occurs. Set the diagnostic action by setting the message queue property `Queue overflow diagnostic`.

To view the interchange of messages during simulation, add a Sequence Viewer block. In this block, you see when messages for a model are:

- Sent
- Received
- Forwarded
- Dropped
- Destroyed
- Discarded
See Also

Related Examples
- “Work with Sequence Viewer” on page 11-31
- “Stateflow Message Syntax in Charts” on page 11-13
Limitations for Messages

You cannot use messages in:

- Moore charts
- Atomic subcharts
- Breakpoint condition expressions
- Model reference inputs and outputs

See Also

More About

- “Stateflow Message Syntax in Charts” on page 11-13
- “How Messages Work in Stateflow Charts” on page 11-2
Define Messages in a Stateflow Chart

In this section...

| “Types of Messages in a Chart” on page 11-26 |
| “Define Message Inputs and Outputs” on page 11-26 |

Types of Messages in a Chart

From the Stateflow editor, you can define three scopes for a message.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input from Simulink</td>
<td>Message that is received from another Stateflow chart through Simulink. Each input message has a receiving queue.</td>
</tr>
<tr>
<td>Output to Simulink</td>
<td>Message that is sent from a Stateflow through an output port in Simulink to another chart.</td>
</tr>
<tr>
<td>Local</td>
<td>Message that is local to the Stateflow chart. A local message has a receiving queue with the same properties as a message input. When you send a local message, a transition or action in the same chart can evaluate the local message. You cannot send a local message outside the chart.</td>
</tr>
</tbody>
</table>

To learn about message properties, see .

Define Message Inputs and Outputs

From the Stateflow editor, you can add messages via the Symbols window or through menus. To open the Symbols window, select View > Symbols. To add messages in the Symbols window:

1. Click the Create Message icon 📄.
2. In the row for the new message, under TYPE, click the icon and choose:
   - Input Message
   - Local Message
   - Output Message
3 Edit the name of the message.

4 For input and output messages, click the **PORT** field and choose a port number.

To add messages through menus, select one of these options:

<table>
<thead>
<tr>
<th>Scope</th>
<th>Menu Option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td><strong>Chart &gt; Add Inputs &amp; Outputs</strong> &gt; Message Input from Simulink</td>
</tr>
<tr>
<td>Output</td>
<td><strong>Chart &gt; Add Inputs &amp; Outputs</strong> &gt; Message Output to Simulink</td>
</tr>
<tr>
<td>Local</td>
<td><strong>Chart &gt; Add Other Elements</strong> &gt; Local Message</td>
</tr>
</tbody>
</table>

Connect message input and output ports in Simulink with a message line.

See Also

More About

- “Set Message Properties” on page 11-28
- “How Messages Work in Stateflow Charts” on page 11-2
Set Message Properties

Set and modify the properties of a message in the Property Inspector, or a Message properties dialog box.

You can set these properties on a message.

<table>
<thead>
<tr>
<th>Message Input Port Properties</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the message object.</td>
</tr>
<tr>
<td>Scope</td>
<td>You can set scope to one of these values:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Local</strong>—Message is defined in the current chart only.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Input</strong>—Message is defined as an input port on the chart. You can send a message from another chart through this input port.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Output</strong>—Message is defined as an output port on the chart. You can send a message from this chart through this output port.</td>
</tr>
<tr>
<td>Port</td>
<td>Index of the port associated with an input or output message queue.</td>
</tr>
<tr>
<td>Size</td>
<td>Size of the message data.</td>
</tr>
<tr>
<td>Complexity</td>
<td>Specifies if the message data accepts complex values. You can choose one of these settings:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Off</strong>—Does not accept complex values.</td>
</tr>
<tr>
<td></td>
<td>• <strong>On</strong>—Accepts complex values.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inherited</strong>—Inherits the complexity setting from Simulink.</td>
</tr>
</tbody>
</table>
### Message Input Port Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Type of message data.</td>
</tr>
<tr>
<td></td>
<td>• Select a built-in type from the <strong>Type</strong> drop-down list.</td>
</tr>
<tr>
<td></td>
<td>• In the Messages properties dialog box, use the Data Type Assistant to specify a data <strong>Mode</strong>. Then specify the data type based on that mode.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Click the <strong>Show data type assistant</strong> button to display the Data Type Assistant.</td>
</tr>
<tr>
<td><strong>Add to Watch Window</strong></td>
<td>Watch the message in the Stateflow Breakpoints and Watch window. You can view message queues and message data values when simulation is paused.</td>
</tr>
<tr>
<td><strong>Queue capacity</strong></td>
<td>For messages of scope Input and Local. Set the length of the queue high enough so that incoming messages do not overflow the queue and to prevent message from being dropped.</td>
</tr>
<tr>
<td><strong>Queue overflow diagnostic</strong></td>
<td>Set the diagnostic action for a queue overflow:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Error</strong> (default)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Warning</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>None</strong></td>
</tr>
</tbody>
</table>
### Message Input Port Properties

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Queue type</strong> &lt;br&gt; For messages of scope Input and Local. Choose the type of queue. The order of messages received is:</td>
</tr>
</tbody>
</table>
| *FIFO* — First in, first out.  
*LIFO* — Last in, first out.  
**Priority** — This queue type enables the **Priority order** property parameter. |
| **Priority order** <br> If **Queue type** is **Priority order**, choose: |
| *Ascending* — Order of message received is based on an ascending order of the message data value.  
*Descending* — Order of message received is based on a descending order of the message data value. |

### See Also

### More About

- “Rules for Naming Stateflow Objects” on page 2-4
- “Watch Stateflow Data Values” on page 30-34
- “Size Stateflow Data” on page 9-47
- “Use Data Types in Stateflow” on page 9-39
Work with Sequence Viewer

To see the interchange of messages and events between Stateflow charts during simulation, as well as view state activity and transitions, add a Sequence Viewer block to your Simulink model. You can visualize the movement of entities between blocks when simulating SimEvents models. The Sequence Viewer block also displays function calls and calls from MATLAB Function blocks. For more information on function calls, see “Function Calls in Sequence Viewer” on page 11-43.

You can view event data related to Stateflow chart execution and the exchange of messages between Stateflow charts. The Sequence Viewer shows where messages are created and sent, forwarded, received, and destroyed at different times during model execution. You can also view the movement of entities between SimEvents blocks. All SimEvents blocks that can store entities appear as lifelines in the Sequence Viewer. Entities moving between these blocks appear as lines with arrows. You can view calls to Simulink Function blocks and Stateflow MATLAB functions.

The Sequence Viewer window has:

• A navigation toolbar, which contains:
  • The model hierarchy path.
  • A toggle button to select an automatic or manual layout.
  • A toggle button to show or hide inactive lifelines.
  • Buttons for saving and restoring information in the viewer, setting parameters on the block, and accessing the Sequence Viewer documentation.
• A header pane, which contains the lifeline headers.
• A message pane, which displays the messages.

You can add a Sequence Viewer block to the top level of a model or any subsystem. If you place a Sequence Viewer block in a subsystem that does not have messages, events, or state activity, the Sequence Viewer informs you that nothing is available to display.

To show you how to use the Sequence Viewer, the Stateflow example sf_msg_traffic_light is used.
Visualize Messages

Consider this subsystem, Traffic Light1:
Traffic Light 1 contains two Stateflow charts.

- Controller
- Ped Button Sensor

The charts in these subsystems use messages to exchange data. As messages pass through the system, you can view them in a Sequence Viewer.

Add a Sequence Viewer block to a subsystem or model whose messages you want to see. When you open a Sequence Viewer block and simulate the model:

1. Observe the contents of the Sequence Viewer.
The header (top) pane of a Sequence Viewer shows the lifeline headers. In this example, the lifelines are the two Traffic Light blocks and the GUI block. Lifeline headers show the name of the corresponding blocks in the model that generate or act on messages. The top of the lifeline is a header, which corresponds to a block in the model. Gray headers with straight edges correspond to subsystems. Yellow headers with rounded edges correspond to Stateflow charts. In the header pane, the lifeline hierarchy corresponds to the model hierarchy. When the model is paused or stopped, you can expand and close lifelines.

In the message pane, a thick, gray lifeline indicates that you can expand the lifeline to see the children. Clicking a lifeline name opens the corresponding block in the model.

Messages between lifelines are displayed in the message pane. Message lines are arrows from the sender to the receiver. For more information on navigation in the message pane, see “Navigation in Sequence Viewer” on page 11-42.

To show the children of a lifeline, click the expander under a parent lifeline 🔄.
3 Lifelines are hidden by double-clicking their headers.

4 Make a lifeline the root of focus for the viewer. Place your cursor over the bottom left corner of the lifeline header and click the arrow. Alternatively, use the navigation toolbar at the top of a Sequence Viewer. The Sequence Viewer displays the current root lifeline path and shows its child lifelines.
Any external sending and receiving events are displayed as vertical bars (slots) in the diagram gutter. To highlight the associated block in the model, click the corresponding slot.
Use the navigation toolbar to move the current root up and down the lifeline hierarchy. To move up the current root one level, hit the Esc key.

This graphic also illustrates how the Sequence Viewer displays masked subsystems. The Traffic Lamp 1, Ped Lamp 1, Traffic Lamp 2, and Ped Lamp 2 are masked subsystems. The Sequence Viewer displays masked subsystems as white blocks.

To show the children of a masked subsystem, place your cursor over the bottom left corner of the masked and subsystem and click the arrow.

The child lifeline is displayed.
Activations, which correspond to executions of the lifeline, are at the start and end of each message line.

If a message line is not completely shown, place your cursor over the line. You can also, place your cursor over a truncated message label to see it in its entirety. In this example, the send time of the commIn message line is not visible. To see it, place your cursor over the message line.

If you place your cursor over an activation that represents a function call, the function prototype is displayed in the tooltip.

If you place your cursor over partially shown activation symbols, the times for any truncated activations also appear.

A Sequence Viewer shows the interactions (hops) that a message or function call goes through in its lifetime. It also shows message and function call payloads. To highlight the hops for a message or function call and display its payload, click the corresponding message line. See the result in the property inspector to the right. Use **Search Up** and **Down** buttons to move through the hops.
View State Activity and Transitions

Use the Sequence Viewer to view state activity. From the Model Explorer in the Filter tab, click Show States and Transitions.
To see state activity and transitions, expand the state hierarchy until you have reached the lowest child state. In this example, you can see the transition from PrepareToStop to Stop occurs after 1 second. The vertical yellow bar shows which state is active. The blue horizontal arrow denotes the transition.

You can view the full transition label from the Property Inspector. Click the Property Inspector button to bring up the Property Inspector within the Sequence Viewer. To
show the full transition label, click on the transition. The full transition label of the highlighted transition appears in the **Transition Label** section of the **Property Inspector**.

### Redisplay of Information in Sequence Viewer

A Sequence Viewer block saves the order and states of lifelines between simulation runs. When you close and reopen a Sequence Viewer, it preserves the last open lifeline state. To save a particular viewer state with the block, click in the navigation toolbar. Saving the model then saves that state information across sessions. Use to load the saved settings.

### Time in Sequence Viewer

A Sequence Viewer shows events vertically, ordered in time. Multiple events in Simulink can happen at the same time. Conversely, there can be long periods of times during simulation with no events. As a consequence, time in the Simulink Viewer pane is nonlinear. Each time grid row, bordered by two blue lines, contains events that occur at the same simulation time. The time strip gives the times of the events in that grid row.

The time ruler shows linear simulation time. To show events in that simulation time range, use the scroll wheel or drag the time slider up and down the time ruler. When using a variable step solver, you can adjust the precision of the time ruler. From the **Model Explorer** in the **Main** tab, adjust the number under **Time Precision for Variable Step**.
• To navigate to the beginning and end of the simulation, click the **Go to first event** and **Go to last event** buttons.

• To zoom the ruler, hold the space bar and use the mouse wheel. This action increases and decreases the amount of time ruler space that the slider occupies.

• To see the entire simulation duration on the time ruler, click the **Fit to view** button.

• To reset the zoom to 100%, press **Ctrl + 0**.

**Navigation in Sequence Viewer**

To scroll in the header and message panes, use the mouse wheel.

• The header pane has a vertical scroll bar.
• The message pane has a horizontal scroll bar at the bottom that scrolls both panes.

To pan in the message pane, move the mouse while holding down either the middle mouse button or space bar. This action moves both panes.

You can scale the view in two ways:

• **Fit all lifeline headers to window** — Press the space bar.
• **Zoom by a fixed increment to a predefined minimum or maximum value** — Press **Ctrl-** or **Ctrl+**. Alternatively, hold the space bar and use the mouse wheel.
Zooming does not scale the navigation toolbar or time ruler.

**Function Calls in Sequence Viewer**

The Sequence Viewer block displays function calls and replies.

<table>
<thead>
<tr>
<th>Function Call Type</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calls to Simulink Function blocks</td>
<td>Fully supported</td>
</tr>
<tr>
<td>Calls to Stateflow graphical or Stateflow MATLAB functions</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Scoped — Select the <strong>Export chart level functions</strong> chart option. Use the <code>chartName.functionName</code> dot notation.</td>
</tr>
<tr>
<td></td>
<td>• Global — Select the <strong>Treat exported functions as globally visible</strong> chart option. You do not need the dot notation.</td>
</tr>
</tbody>
</table>

The Sequence Viewer block does not display function calls that are connected to function-call subsystems.

For an example of function calls in the Sequence Viewer, see `slexPrinterExample`. The Sequence Viewer displays function calls with solid lines terminated with solid arrows and a label with the format `function_name(argument_list)`. Replies to function calls are displayed as dashed lines with open arrows and a label with the format `[argument_list]=function_name`.

**See Also**

Sequence Viewer
More About

• “How Messages Work in Stateflow Charts” on page 11-2
Use Actions in Charts

• “State Action Types” on page 12-2
• “Transition Action Types” on page 12-7
• “Execution of Actions in States and Transitions” on page 12-11
• “Combine State Actions to Eliminate Redundant Code” on page 12-15
• “Supported Operations on Chart Data” on page 12-19
• “Supported Symbols in Actions” on page 12-27
• “Call C Functions in C Charts” on page 12-31
• “Access Built-In MATLAB Functions and Workspace Data” on page 12-38
• “Use Arrays in Actions” on page 12-50
• “Broadcast Events to Synchronize States” on page 12-52
• “Control Chart Execution Using Temporal Logic” on page 12-55
• “Detect Changes in Data Values” on page 12-74
• “Check State Activity” on page 12-86
• “Control Function-Call Subsystems Using Bind Actions” on page 12-95
• “Simplify Stateflow Chart Using the duration Operator” on page 12-112
State Action Types

States can have different action types, including entry, during, exit, bind, and, on actions. You specify the actions for a state by using a state action label with this overall format:

name/
entry: entry actions
during: during actions
exit: exit actions
bind: data_name, event_name
on event_name: on event_name actions
on message_name: on message_name actions

Enter actions of different types on separate lines after the name of the state. You can enter these actions in any order. If you do not specify the action type explicitly for a statement, the chart treats that statement as a combined entry, during action.

For example, this chart contains various state action types.

This table summarizes the different state action types.
<table>
<thead>
<tr>
<th>State Action</th>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>entry</td>
<td>en</td>
<td>Executes when the state becomes active</td>
</tr>
<tr>
<td>exit</td>
<td>ex</td>
<td>Executes when the state is active and a transition out of the state occurs</td>
</tr>
<tr>
<td>during</td>
<td>du</td>
<td>Executes when the state is active and a specific event occurs</td>
</tr>
<tr>
<td>bind</td>
<td>none</td>
<td>Binds an event or data object so that only that state and its children can broadcast the event or change the data value</td>
</tr>
<tr>
<td>on event_name</td>
<td>none</td>
<td>Executes when the state is active and it receives a broadcast of event_name</td>
</tr>
<tr>
<td>on message_name</td>
<td>none</td>
<td>Executes when a message message_name is available</td>
</tr>
<tr>
<td>on after(n, event_name)</td>
<td>none</td>
<td>Executes when the state is active and after it receives n broadcasts of event_name</td>
</tr>
<tr>
<td>on before(n, event_name)</td>
<td>none</td>
<td>Executes when the state is active and before it receives n broadcasts of event_name</td>
</tr>
<tr>
<td>on at(n, event_name)</td>
<td>none</td>
<td>Executes when the state is active and it receives exactly n broadcasts of event_name</td>
</tr>
<tr>
<td>on every(n, event_name)</td>
<td>none</td>
<td>Executes when the state is active and upon receipt of every n broadcasts of event_name</td>
</tr>
</tbody>
</table>

For more information about the after, before, at, and every temporal logic operators, see “Control Chart Execution Using Temporal Logic” on page 12-55.

**Note** You can call the temporal logic operators after and before by using the absolute-time keywords sec, msec, and usec. For details, see “Operators for Absolute-Time Temporal Logic” on page 12-62.
Entry Actions

Entry actions are executed when a state becomes active. Entry actions consist of the prefix `entry` (or the abbreviation `en`) followed by a colon (`:`) and one or more actions. To separate multiple entry actions, use semicolons or commas. You can also enter the actions on separate lines.

In the preceding example, the entry action `id = x+y` executes when the chart takes the default transition and state A becomes active. See “Enter a Chart or State” on page 3-52.

Exit Actions

Exit actions are executed when a state is active and a transition out of the state occurs. Exit actions consist of the prefix `exit` (or the abbreviation `ex`) followed by a colon (`:`) and one or more actions. To separate multiple exit actions, use semicolons or commas. You can also enter the actions on separate lines.

In the preceding example, the exit action `time_out` executes when the chart takes one of the transitions from state A to state B or C. See “Exit a State” on page 3-60.

During Actions

During actions are executed when a state is active, an event occurs, and no valid transition to another state is available. During actions consist of the prefix `during` (or the abbreviation `du`) followed by a colon (`:`) and one or more actions. To separate multiple during actions, use semicolons or commas. You can also enter the actions on separate lines.

In the preceding example, the during action `switch_on()` executes whenever the state C is active because there are no valid transitions to another state. See “Execution of a Stateflow Chart” on page 3-46.

Bind Actions

Bind actions bind the specified data and events to a state. Bind actions consist of the prefix `bind` followed by a colon (`:`) and one or more events or data. To separate multiple events and data, use semicolons or commas. You can also enter the events and data on separate lines.
Only a state and its children can change data or broadcast events bound to that state. Other states can read the bound data or listen for the bound event, but they cannot change the bound data or send the bound events.

Bind actions apply to a chart whether the binding state is active or not. In the preceding example, the bind action `bind: id, time_out` for state A binds the data `id` and the event `time_out` to state A. This binding prevents any other state (or its children) in the chart from changing `id` or broadcasting event `time_out`.

If another state includes actions that change data or broadcast events that bind to another state, a parsing error occurs. This chart contains two state actions that produce parsing errors.

<table>
<thead>
<tr>
<th>State Action</th>
<th>Reason for Parse Error</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>bind: id</code> in state B</td>
<td>Only one state can change the data <code>id</code>, which is bound to state A</td>
</tr>
<tr>
<td><code>entry: time_out</code> in state C</td>
<td>Only one state can broadcast the event <code>time_out</code>, which is bound to state A</td>
</tr>
</tbody>
</table>

Binding a function-call event to a state also binds the function-call subsystem that it calls. The function-call subsystem is enabled when the binding state is entered and disabled when the binding state is exited. For more information about this behavior, see “Control Function-Call Subsystems Using Bind Actions” on page 12-95.
On Actions

On actions are executed when the state is active and it receives an event or message. On actions consist of the prefix on followed by a unique event `event_name` or message `message_name`, a colon (`:`), and one or more actions. To separate multiple on actions, use semicolons or commas. You can also enter the actions on separate lines.

You can specify actions for more than one event or message. For example, if you want different events to trigger different actions, enter multiple on action statements in the state action label:

```
on ev1: action1();
on ev2: action2();
```

If multiple events occur at the same time, the corresponding on actions execute in the order that they appear in the state action label. For instance, in the previous example, if events `ev1` and `ev2` occur at the same time, then `action1()` executes first and `action2()` executes second. See “Execution of a Stateflow Chart” on page 3-46.

See Also

Related Examples

- “Execution of a Stateflow Chart” on page 3-46
- “Enter a Chart or State” on page 3-52
- “Exit a State” on page 3-60
- “Combine State Actions to Eliminate Redundant Code” on page 12-15
- “Control Function-Call Subsystems Using Bind Actions” on page 12-95
- “Operators for Absolute-Time Temporal Logic” on page 12-62
Transition Action Types

In “State Action Types” on page 12-2, you attach actions to the label for a state. You can also attach actions to a transition on its label. Transitions can have different action types, which include event or message triggers, conditions, condition actions, and transition actions. The action types follow the label notation with this general format:

```
event_or_message trigger[condition]{condition_action}/{transition_action}
```

The following example shows typical transition label syntax:

<table>
<thead>
<tr>
<th>Transition</th>
<th>Event Trigger</th>
<th>Condition</th>
<th>Condition Action</th>
<th>Transition Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>State A to state C</td>
<td>event1</td>
<td>temp &gt; 50</td>
<td>func1()</td>
<td>None</td>
</tr>
<tr>
<td>State A to state B</td>
<td>event2</td>
<td>None</td>
<td>None</td>
<td>data1 = 5</td>
</tr>
</tbody>
</table>
Event or Message Triggers

In transition label syntax, event or message triggers appear first as the name of an event or message. They have no distinguishing special character to separate them from other actions in a transition label. In the example in “Transition Action Types” on page 12-7, both transitions from state A have event triggers. The transition from state A to state B has the event trigger event2 and the transition from state A to state C has the event trigger event1.

Event triggers specify an event that causes the transition to be taken, provided the condition, if specified, is true. Specifying an event is optional. Message triggers specify the transition to be taken if the message is present in the message queue. The absence of an event or message indicates that the transition is taken upon the occurrence of any event. Multiple events or messages are specified using the OR logical operator (|).

Conditions

In transition label syntax, conditions are Boolean expressions enclosed in square brackets ([ ]). In the example in “Transition Action Types” on page 12-7, the transition from state A to state C has the condition temp > 50.

A condition is a Boolean expression to specify that a transition occurs given that the specified expression is true. Follow these guidelines for defining and using conditions:

- The condition expression must be a Boolean expression that evaluates to true (1) or false (0).
- The condition expression can consist of any of the following:
  - Boolean operators that make comparisons between data and numeric values
  - A function that returns a Boolean value
  - An in(state_name) condition that evaluates to true when the state specified as the argument is active (see “Check State Activity” on page 12-86)

Note A chart cannot use the in condition to trigger actions based on the activity of states in other charts.

- Temporal logic conditions (see “Control Chart Execution Using Temporal Logic” on page 12-55)
- The condition expression can call a graphical function, truth table function, or MATLAB function that returns a numeric value.
For example, \([\text{test\_function}(x, y) < 0]\) is a valid condition expression.

**Note** If the condition expression calls a function with multiple return values, only the first value applies. The other return values are not used.

- The condition expression should not call a function that causes the chart to change state or modify any variables.
- Boolean expressions can be grouped using & for expressions with AND relationships and | for expressions with OR relationships.
- Assignment statements are not valid condition expressions.
- Unary increment and decrement actions are not valid condition expressions.

**Condition Actions**

In transition label syntax, condition actions follow the transition condition and are enclosed in curly braces ({}). In the example in “Transition Action Types” on page 12-7, the transition from state A to state C has the condition action `func1()`, a function call.

Condition actions are executed as soon as the condition is evaluated as true, but before the transition destination has been determined to be valid. If no condition is specified, an implied condition evaluates to true and the condition action is executed.

**Note** If a condition is guarded by an event, it is checked only if the event trigger is active. If a condition is guarded by a message, it is checked only if the message is present.

**Transition Actions**

In transition label syntax, transition actions are preceded with a forward slash (/) and are enclosed in curly braces ({}). In the example in “Transition Action Types” on page 12-7, the transition from state A to state B has the transition action `data1 = 5`. In C charts, transition actions are not required to be enclosed in curly braces. In charts that use MATLAB as the action language, the syntax is auto corrected if the curly braces are missing from the transition action. See “Action Language Auto Correction” on page 13-6.

Transition actions execute only after the complete transition path is taken. They execute after the transition destination has been determined to be valid, and the condition, if
specified, is true. If the transition consists of multiple segments, the transition action executes only after the entire transition path to the final destination is determined to be valid.
Execution of Actions in States and Transitions

The following chart shows how different constructs interact during simulation:

When you simulate the model, you get the following results:
The following actions occur in the TransAction state:
Time | What Happens in the TransAction State
---|---
0.0 | State TA becomes active.
In TA, the entry action executes by setting the value of outVal to 0.
---|---
0.1 | The transition from TA to junction J1 occurs, because the path is unconditional.
Evaluation of the condition between J1 and J2 occurs, which returns true.
The transition action does not execute, because the full transition path from J1 to TB is not complete.
Evaluation of the condition between J2 and TB occurs, which returns false. Therefore, execution returns to J1.
---|---
0.1 | The transition from J1 to J3 occurs, because the path is unconditional.
Evaluation of the condition between J3 and TB occurs, which returns false. Therefore, execution returns to TA.
In TA, the during action executes by decrementing the value of outVal by 1.
---|---
0.2 - 1.0 | The execution pattern from t = 0.1 repeats for each time step.
---|---
1.1 | The transition from TA to junction J1 occurs, because the path is unconditional.
Evaluation of the condition between J1 and J2 occurs, which returns true.
The transition action does not execute, because the full transition path from J1 to TB is not complete.
Evaluation of the condition between J2 and TB occurs, which returns false. Therefore, execution returns to J1.
---|---
1.1 | The transition from J1 to J3 occurs, because the path is unconditional.
Evaluation of the condition between J3 and TB occurs, which returns true.
State TB becomes active.
Because the transition from J3 to TB is now complete, the transition action executes by setting the value of outVal to 0.

The following actions occur in the CondAction state:

Time | What Happens in the CondAction State
---|---
0.0 | State CA becomes active.
In CA, the entry action executes by setting the value of outVal_2 to 0.
<table>
<thead>
<tr>
<th>Time</th>
<th>What Happens in the CondAction State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>The transition from CA to junction J1 occurs, because the path is unconditional.</td>
</tr>
<tr>
<td></td>
<td>Evaluation of the condition between J1 and J2 occurs, which returns true.</td>
</tr>
<tr>
<td></td>
<td>The condition action executes by decrementing the value of outVal_2 by 2.</td>
</tr>
<tr>
<td></td>
<td>Evaluation of the condition between J2 and CB occurs, which returns false. Therefore, execution returns to J1.</td>
</tr>
<tr>
<td></td>
<td>The transition from J1 to J3 occurs, because the path is unconditional.</td>
</tr>
<tr>
<td></td>
<td>Evaluation of the condition between J3 and CB occurs, which returns false. Therefore, execution returns to CA.</td>
</tr>
<tr>
<td></td>
<td>In CA, the during action executes by decrementing the value of outVal_2 by 1.</td>
</tr>
<tr>
<td>0.2 –</td>
<td>The execution pattern from t = 0.1 repeats for each time step.</td>
</tr>
<tr>
<td>0.3</td>
<td>The transition from CA to junction J1 occurs, because the path is unconditional.</td>
</tr>
<tr>
<td></td>
<td>Evaluation of the condition between J1 and J2 occurs, which returns true.</td>
</tr>
<tr>
<td></td>
<td>The condition action executes by decrementing the value of outVal_2 by 2.</td>
</tr>
<tr>
<td></td>
<td>Evaluation of the condition between J2 and CB occurs, which returns false. Therefore, execution returns to J1.</td>
</tr>
<tr>
<td></td>
<td>The transition from J1 to J3 occurs, because the path is unconditional.</td>
</tr>
<tr>
<td></td>
<td>Evaluation of the condition between J3 and CB occurs, which returns true.</td>
</tr>
<tr>
<td></td>
<td>The condition action executes by setting the value of outVal_2 to 0.</td>
</tr>
<tr>
<td></td>
<td>State CB becomes active.</td>
</tr>
</tbody>
</table>

**See Also**

**More About**
- “State Action Types” on page 12-2
- “Transition Action Types” on page 12-7
Combine State Actions to Eliminate Redundant Code

State Actions You Can Combine

You can combine entry, during, and exit actions that execute the same tasks in a state.

Why Combine State Actions

By combining state actions that execute the same tasks, you eliminate redundant code. For example:

<table>
<thead>
<tr>
<th>Separate Actions</th>
<th>Equivalent Combined Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>entry:</td>
<td>entry: y = 0;</td>
</tr>
<tr>
<td>y = 0;</td>
<td>entry, during: y=y+1;</td>
</tr>
<tr>
<td>y=y+1;</td>
<td></td>
</tr>
<tr>
<td>during: y=y+1;</td>
<td></td>
</tr>
<tr>
<td>en:</td>
<td>en, du, ex: fcn1();</td>
</tr>
<tr>
<td>fcn1();</td>
<td>en: fcn2();</td>
</tr>
<tr>
<td>fcn2();</td>
<td></td>
</tr>
<tr>
<td>du: fcn1();</td>
<td></td>
</tr>
<tr>
<td>ex: fcn1();</td>
<td></td>
</tr>
</tbody>
</table>

Combining state actions this way produces the same chart execution behavior (semantics) and generates the same code as the equivalent separate actions.

How to Combine State Actions

Combine a set of entry, during, and/or exit actions that perform the same task as a comma-separated list in a state. Here is the syntax:
entry, during, exit: \textit{task}1; \textit{task}2;...\textit{task}N;

You can also use the equivalent abbreviations:

en, du, ex: \textit{task}1; \textit{task}2;...\textit{task}N;

Valid Combinations

You can use any combination of the three actions. For example, the following combinations are valid:

- en, du:
- en, ex:
- du, ex:
- en, du, ex:

You can combine actions in any order in the comma-separated list. For example, \textit{en}, \textit{du} gives the same result as \textit{du}, \textit{en}.

Invalid Combinations

You cannot combine two or more actions of the same type. For example, the following combinations are invalid:

- en, en:
- ex, en, ex:
- du, du, ex:

If you combine multiple actions of the same type, you receive a warning that the chart executes the action only once.

Order of Execution of Combined Actions

States execute combined actions in the same order as they execute separate actions:

1 Entry actions first, from top to bottom in the order they appear in the state
2 During actions second, from top to bottom
3 Exit actions last, from top to bottom
The order in which you combine actions does not affect state execution behavior. For example:

<table>
<thead>
<tr>
<th>This state...</th>
<th>Executes actions in this order...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>1 en: y = 0; 2 en: y = y + 1; 3 du: y = y + 1;</td>
</tr>
<tr>
<td>B</td>
<td>1 en: y = y + 1; 2 en: y = 0; 3 du: y = y + 1;</td>
</tr>
<tr>
<td>C</td>
<td>1 en: y = y + 1; 2 en: y = 0; 3 du: y = y + 1;</td>
</tr>
<tr>
<td>D</td>
<td>1 en: y = y + 1; 2 en: y = 10; 3 du: y = y + 1; 4 ex: y = 10;</td>
</tr>
</tbody>
</table>

**Rules for Combining State Actions**

- Do not combine multiple actions of the same type.
- Do not create data, events, or messages that have the same name as the action keywords: entry, en, during, du, exit, ex.
See Also

More About
• “State Action Types” on page 12-2
Supported Operations on Chart Data

In this section...

“Binary and Bitwise Operations” on page 12-19
“Unary Operations” on page 12-22
“Unary Actions” on page 12-22
“Assignment Operations” on page 12-22
“Pointer and Address Operations” on page 12-23
“Type Cast Operations” on page 12-24
“Replace Operators with Application Implementations” on page 12-25

Binary and Bitwise Operations

The table below summarizes the interpretation of all binary operators in C charts. These operators work with the following order of precedence (0 = highest, 10 = lowest). Logical binary operators with the same precedence evaluate from left to right. The order of evaluation for other operators is unspecified. For example, the order in which foo() and bar() are evaluated is unspecified in the assignment below.

A = foo() > bar();

For more predictable results, it is good coding practice to split expressions that depend on the order of evaluation into multiple statements.

You can specify that the binary operators &, ^, |, &&, and || are interpreted as bitwise operators in Stateflow generated C code for a chart or for all the charts in a model. See these individual operators in the table below for specific binary or bitwise operator interpretations.

<table>
<thead>
<tr>
<th>Example</th>
<th>Precedence</th>
<th>Description</th>
</tr>
</thead>
</table>
| a ^ b   | 0          | Operand a raised to power b
<p>|         |            | Enabled when you clear <strong>Enable C-bit operations</strong> in the Chart properties dialog box. See “Specify Chart Properties” on page 23-3. |
| a * b   | 1          | Multiplication |</p>
<table>
<thead>
<tr>
<th>Example</th>
<th>Precedence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a / b</td>
<td>1</td>
<td>Division</td>
</tr>
<tr>
<td>a %% b</td>
<td>1</td>
<td>Remainder</td>
</tr>
<tr>
<td>a + b</td>
<td>2</td>
<td>Addition</td>
</tr>
<tr>
<td>a - b</td>
<td>2</td>
<td>Subtraction</td>
</tr>
<tr>
<td>a &gt;&gt; b</td>
<td>3</td>
<td>Shift operand a right by b bits. Noninteger operands for this operator are first cast to integers before the bits are shifted.</td>
</tr>
<tr>
<td>a &lt;&lt; b</td>
<td>3</td>
<td>Shift operand a left by b bits. Noninteger operands for this operator are first cast to integers before the bits are shifted.</td>
</tr>
<tr>
<td>a &gt; b</td>
<td>4</td>
<td>Comparison of the first operand greater than the second operand</td>
</tr>
<tr>
<td>a &lt; b</td>
<td>4</td>
<td>Comparison of the first operand less than the second operand</td>
</tr>
<tr>
<td>a &gt;= b</td>
<td>4</td>
<td>Comparison of the first operand greater than or equal to the second operand</td>
</tr>
<tr>
<td>a &lt;= b</td>
<td>4</td>
<td>Comparison of the first operand less than or equal to the second operand</td>
</tr>
<tr>
<td>a == b</td>
<td>5</td>
<td>Comparison of equality of two operands</td>
</tr>
<tr>
<td>a ~= b</td>
<td>5</td>
<td>Comparison of inequality of two operands</td>
</tr>
<tr>
<td>a != b</td>
<td>5</td>
<td>Comparison of inequality of two operands</td>
</tr>
<tr>
<td>a &lt;&gt; b</td>
<td>5</td>
<td>Comparison of inequality of two operands</td>
</tr>
<tr>
<td>Example</td>
<td>Precedence</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| a & b   | 6          | One of the following:  
  • Bitwise AND of two operands  
   Enabled when you select **Enable C-bit operations** in the Chart properties dialog box (default). See “Specify Chart Properties” on page 23-3.  
  • Logical AND of two operands  
   Enabled when you clear **Enable C-bit operations** in the Chart properties dialog box. |
| a ^ b   | 7          | Bitwise XOR of two operands  
   Enabled when you select **Enable C-bit operations** in the Chart properties dialog box (default). See “Specify Chart Properties” on page 23-3. |
| a | b  | 8          | One of the following:  
  • Bitwise OR of two operands  
   Enabled when you select **Enable C-bit operations** in the Chart properties dialog box (default). See “Specify Chart Properties” on page 23-3.  
  • Logical OR of two operands  
   Enabled when you clear **Enable C-bit operations** in the Chart properties dialog box. |
| a && b  | 9          | Logical AND of two operands |
| a || b   | 10         | Logical OR of two operands |
## Unary Operations

The following unary operators are supported in C charts. Unary operators have higher precedence than the binary operators, except for the power operator $a ^ b$. The power operator has the highest level of precedence. The operators are evaluated right to left (right associative).

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~a</td>
<td>Logical NOT of a</td>
</tr>
<tr>
<td></td>
<td>Complement of a (if bitops is enabled)</td>
</tr>
<tr>
<td>!a</td>
<td>Logical NOT of a</td>
</tr>
<tr>
<td>-a</td>
<td>Negative of a</td>
</tr>
</tbody>
</table>

## Unary Actions

The following unary actions are supported in C charts.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a++</td>
<td>Increment a</td>
</tr>
<tr>
<td>a--</td>
<td>Decrement a</td>
</tr>
</tbody>
</table>

## Assignment Operations

The following assignment operations are supported in C charts.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a = expression</td>
<td>Simple assignment</td>
</tr>
<tr>
<td>a := expression</td>
<td>Used primarily with fixed-point numbers. See “Assignment (=, :=) Operations” on page 21-29 for a detailed description.</td>
</tr>
<tr>
<td>a += expression</td>
<td>Equivalent to $a = a + expression$</td>
</tr>
<tr>
<td>a -= expression</td>
<td>Equivalent to $a = a - expression$</td>
</tr>
<tr>
<td>a *= expression</td>
<td>Equivalent to $a = a * expression$</td>
</tr>
<tr>
<td>a /= expression</td>
<td>Equivalent to $a = a / expression$</td>
</tr>
</tbody>
</table>
The following assignment operations are supported in C charts when **Enable C-bit operations** is selected in the properties dialog box for the chart. See “Specify Chart Properties” on page 23-3.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>`a</td>
<td>= expression`</td>
</tr>
<tr>
<td><code>a &amp;= expression</code></td>
<td>Equivalent to <code>a = a &amp; expression</code> (bit operation). See operation <code>a &amp; b</code> in “Binary and Bitwise Operations” on page 12-19.</td>
</tr>
<tr>
<td><code>a ^= expression</code></td>
<td>Equivalent to <code>a = a ^ expression</code> (bit operation). See operation <code>a ^ b</code> in “Binary and Bitwise Operations” on page 12-19.</td>
</tr>
</tbody>
</table>

### Pointer and Address Operations

The address operator (`&`) is available in C charts for use with both Stateflow and custom code variables. The pointer operator (`*`) is available for use only with custom code variables.

**Note**  The parser uses a relaxed set of restrictions and does not catch syntax errors until compile time.

The following examples show syntax that is valid for both Stateflow and custom code variables. The prefix `cc_` shows the places where you can use only custom code variables, and the prefix `sfcc_` shows the places where you can use either Stateflow or custom code variables.

```c
cc_varPtr = &sfcc_var;
cc_ptr = &sfcc_varArray[<expression>];
cc_function(&sfcc_varA, &sfcc_varB, &sfcc_varC);
cc_function(&sfcc_sf.varArray[<expression>]);
```

The following examples show syntax that is valid only for custom code variables.

```c
varStruct.field = <expression>;
(*varPtr) = <expression>;
```
Type Cast Operations

You can use type cast operators to convert a value of one type to a value that can be represented in another type. Normally, you do not need to use type cast operators in actions because Stateflow software checks whether the types involved in a variable assignment differ and compensates by inserting the required type cast operator of the target language (typically C) in the generated code. However, external (custom) code might require data in a different type from those currently available. In this case, Stateflow software cannot determine the required type casts, and you must explicitly use a type cast operator to specify the target language type cast operator to generate.

For example, you might have a custom code function that requires integer RGB values for a graphic plot. You might have these values in Stateflow data, but only in data of type double. To call this function, you must type cast the original data and assign the result to integers, which you use as arguments to the function.

Stateflow type cast operations have two forms: the MATLAB type cast form and the explicit form using the `cast` operator. These operators and the special `type` operator, which works with the explicit `cast` operator, are described in the topics that follow.

**MATLAB Form Type Cast Operators**

The MATLAB type casting form has the general form

```
<type_op>(<expression>)
```

where `type_op` is a conversion type operator that can be `double`, `single`, `int32`, `int16`, `int8`, `uint32`, `uint16`, `uint8`, or `boolean`. `<expression>` is the expression to be converted. For example, you can cast the expression `x+3` to a 16-bit unsigned integer and assign its value to the data `y` as follows:

```
y = uint16(x+3)
```

**Explicit Type Cast Operator**

You can also type cast with the explicit `cast` operator, which has the following general form:

```matlab
myVar = cast(varPtr->field, 'int16');
```
cast(<expression>,<type>)

As in the preceding example, the statement

\[ y = \text{cast}(x+3, 'uint16') \]

will cast the expression \( x+3 \) to a 16-bit unsigned integer and assign it to \( y \), which can be of any type.

**type Operator**

To make type casting more convenient, you can use a type operator that works with the explicit type cast operator `cast` to let you assign types to data based on the types of other data.

The type operator returns the type of an existing Stateflow data according to the general form

\[ \text{type(<data>)} \]

where \(<data>\) is the data whose type you want to return.

The return value from a type operation can be used only in an explicit cast operation. For example, if you want to convert the data \( y \) to the same type as that of data \( z \), use the following statement:

\[ \text{cast}(y, \text{type}(z)) \]

In this case, the data \( z \) can have any acceptable Stateflow type.

**Replace Operators with Application Implementations**

You can configure the code generator to change the code that it generates for operators such that the code meets application requirements. To do this you configure the code generator to apply a code replacement library (CRL) during code generation. If you have an Embedded Coder license, you can develop and apply custom code replacement libraries.

Operator entries of the code replacement library can specify integral or fixed-point operand and result patterns. Operator entries can be used for the following built-in operators:

+
For example, you can replace an expression such as \( y = u_1 + u_2 \) with a target-specific implementation, as long as \( u_1 \), \( u_2 \), and \( y \) have types that permit a match with an addition entry in the code replacement library.

C chart semantics might limit operator entry matching because the chart uses the target integer size as its intermediate type in arithmetic expressions. For example, suppose a Stateflow action contains this arithmetic expression:

\[
y = (u_1 + u_2) \mod 3
\]

This expression computes the intermediate addition into a target integer. If the target integer size is 32 bits, you cannot replace this expression with an addition operator from the code replacement library to produce a signed 16-bit result, without a loss of precision.

For more information about replacing code, using code replacement libraries that MathWorks® provides, see “What Is Code Replacement?” (Simulink Coder) and “Code Replacement Libraries” (Simulink Coder). For information about developing custom code replacement libraries, see “What Is Code Replacement Customization?” (Embedded Coder) and “Code You Can Replace From Simulink Models” (Embedded Coder).
Supported Symbols in Actions

In this section...

<table>
<thead>
<tr>
<th>Supported Symbols in Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Boolean Symbols, true and false” on page 12-27</td>
</tr>
<tr>
<td>“Comment Symbols, %, //, /*” on page 12-28</td>
</tr>
<tr>
<td>“Hexadecimal Notation Symbols, 0xFF” on page 12-28</td>
</tr>
<tr>
<td>“Infinity Symbol, inf” on page 12-28</td>
</tr>
<tr>
<td>“Line Continuation Symbol, ...” on page 12-29</td>
</tr>
<tr>
<td>“Literal Code Symbol, $” on page 12-29</td>
</tr>
<tr>
<td>“MATLAB Display Symbol, ;” on page 12-29</td>
</tr>
<tr>
<td>“Single-Precision Floating-Point Number Symbol, F” on page 12-29</td>
</tr>
<tr>
<td>“Time Symbol, t” on page 12-29</td>
</tr>
</tbody>
</table>

Boolean Symbols, true and false

Use the symbols `true` and `false` to represent Boolean constants. You can use these symbols as scalars in expressions. Examples include:

```matlab
cooling_fan = true;
heating_fan = false;
```

**Tip** These symbols are case-sensitive. Therefore, `TRUE` and `FALSE` are not Boolean symbols.

Do not use `true` and `false` in the following cases. Otherwise, error messages appear.

- Left-hand side of assignment statements
  - `true++;
  - `false += 3;
  - `[true, false] = my_function(x);`
- Argument of the change implicit event (see “Control Chart Execution Using Implicit Events” on page 10-35)
• change(true);
• chg(false);
• Indexing into a vector or matrix (see “Assign and Access Stateflow Vector and Matrix Values” on page 17-8)
  • x = true[1];
  • y = false[1][1];

**Note** If you define true and false as Stateflow data objects, your custom definitions of true and false override the built-in Boolean constants.

**Comment Symbols, %, //, /***

Use the symbols %, //, and /* to represent comments as shown in these examples:

% MATLAB comment line
// C++ comment line
/* C comment line */

You can also include comments in generated code for an embedded target (see “Model Configuration Parameters: Code Generation Comments” (Simulink Coder). C chart comments in generated code use multibyte character code. Therefore, you can have code comments with characters for non-English alphabets, such as Japanese Kanji characters.

**Hexadecimal Notation Symbols, 0xFF**

C charts support C style hexadecimal notation, for example, 0xFF. You can use hexadecimal values wherever you can use decimal values.

**Infinity Symbol, inf**

Use the MATLAB symbol inf to represent infinity in C charts. Calculations like n/0, where n is any nonzero real value, result in inf.

**Note** If you define inf as a Stateflow data object, your custom definition of inf overrides the built-in value.
Line Continuation Symbol, ...

Use the characters ... at the end of a line to indicate that the expression continues on the next line. For example, you can use the line continuation symbol in a state action:

```plaintext
entry: total1 = 0, total2 = 0, ...
    total3 = 0;
```

Literal Code Symbol, $

Use $ characters to mark actions that you want the parser to ignore but you want to appear in the generated code. For example, the parser does not process any text between the $ characters below.

```plaintext
$ ptr -> field = 1.0;
$ 
```

**Note** Avoid frequent use of literal symbols.

MATLAB Display Symbol, ;

Omitting the semicolon after an expression displays the results of the expression in the Diagnostic Viewer. If you use a semicolon, the results do not appear.

Single-Precision Floating-Point Number Symbol, F

Use a trailing F to specify single-precision floating-point numbers in C charts. For example, you can use the action statement `x = 4.56F;` to specify a single-precision constant with the value 4.56. If a trailing F does not appear with a number, double precision applies.

Time Symbol, t

For C charts, use the letter t to represent absolute time that the chart inherits from a Simulink signal in simulation targets. For example, the condition `[t - On_time > Duration]` specifies that the condition is true if the difference between the simulation time t and On_time is greater than the value of Duration.
The letter $t$ has no meaning for nonsimulation targets, since $t$ depends on the specific application and target hardware.

**Note** If you define $t$ as a Stateflow data object, your custom definition of $t$ overrides the built-in value.

For charts that use MATLAB as the action language the letter $t$ is not a reserved symbol. To get the simulation time, use the function `getSimulationTime()`.
Call C Functions in C Charts

In this section...

“Call C Library Functions” on page 12-31
“Call the abs Function” on page 12-32
“Call min and max Functions” on page 12-32
“Replacement of Math Library Functions with Application Implementations” on page 12-33
“Call Custom C Code Functions” on page 12-33

Call C Library Functions

You can call this subset of the C Math Library functions:

<table>
<thead>
<tr>
<th>abs</th>
<th>acos</th>
<th>asin</th>
<th>atan</th>
<th>atan2</th>
<th>ceil</th>
</tr>
</thead>
<tbody>
<tr>
<td>cos</td>
<td>cosh</td>
<td>exp</td>
<td>fabs</td>
<td>floor</td>
<td>fmod</td>
</tr>
<tr>
<td>labs</td>
<td>ldexp</td>
<td>log</td>
<td>log10</td>
<td>pow</td>
<td>rand</td>
</tr>
<tr>
<td>sin</td>
<td>sinh</td>
<td>sqrt</td>
<td>tan</td>
<td>tanh</td>
<td></td>
</tr>
</tbody>
</table>

* The Stateflow abs function goes beyond that of its standard C counterpart with its own built-in functionality. See “Call the abs Function” on page 12-32.

** You can also replace calls to the C Math Library with application-specific implementations for this subset of functions. For more information, see “Replacement of Math Library Functions with Application Implementations” on page 12-33.

When you call these math functions, double precision applies unless all the input arguments are explicitly single precision. When a type mismatch occurs, a cast of the input arguments to the expected type replace the original arguments. For example, if you call the sin function with an integer argument, a cast of the input argument to a floating-point number of type double replaces the original argument.

If you call other C library functions not listed above, include the appropriate #include... statement in the Simulation Target pane of the Configuration Parameters.
Call the abs Function

Interpretation of the Stateflow abs function goes beyond the standard C version to include integer and floating-point arguments of all types as follows:

- If \( x \) is an integer of type int32, the standard C function abs applies to \( x \), or \( \text{abs}(x) \).
- If \( x \) is an integer of type other than int32, the standard C abs function applies to a cast of \( x \) as an integer of type int32, or \( \text{abs}((\text{int32})x) \).
- If \( x \) is a floating-point number of type double, the standard C function fabs applies to \( x \), or \( \text{fabs}(x) \).
- If \( x \) is a floating-point number of type single, the standard C function fabs applies to a cast of \( x \) as a double, or \( \text{fabs}((\text{double})x) \).
- If \( x \) is a fixed-point number, the standard C function fabs applies to a cast of the fixed-point number as a double, or \( \text{fabs}((\text{double})V_x) \), where \( V_x \) is the real-world value of \( x \).

If you want to use the abs function in the strict sense of standard C, cast its argument or return values to integer types. See “Type Cast Operations” on page 12-24.

**Note** If you declare \( x \) in custom code, the standard C abs function applies in all cases. For instructions on inserting custom code into charts, see “Share Data Using Custom C Code” on page 29-26.

Call min and max Functions

You can call min and max by emitting the following macros automatically at the top of generated code.

```c
#define min(x1,x2) ((x1) > (x2) ? (x2):(x1))
#define max(x1,x2) ((x1) > (x2) ? (x1):(x2))
```

To allow compatibility with user graphical functions named min() or max(), generated code uses a mangled name of the following form: `<prefix>_min`. However, if you export min() or max() graphical functions to other charts in your model, the name of these functions can no longer be emitted with mangled names in generated code and conflict occurs. To avoid this conflict, rename the min() and max() graphical functions.
Replacement of Math Library Functions with Application Implementations

You can configure the code generator to change the code that it generates for math library functions such that the code meets application requirements. To do this you configure the code generator to apply a code replacement library (CRL) during code generation. If you have an Embedded Coder license, you can develop and apply custom code replacement libraries.

For more information about replacing code, using code replacement libraries that MathWorks provides, see “What Is Code Replacement?” (Simulink Coder) and “Code Replacement Libraries” (Simulink Coder). For information about developing custom code replacement libraries, see “What Is Code Replacement Customization?” (Embedded Coder) and “Code You Can Replace From Simulink Models” (Embedded Coder).

Call Custom C Code Functions

You can specify custom code functions for use in C charts for simulation and C code generation.

• “Specify Custom C Functions for Simulation” on page 12-33
• “Specify Custom C Functions for Code Generation” on page 12-34
• “Guidelines for Calling Custom C Functions in Your Chart” on page 12-34
• “Guidelines for Writing Custom C Functions That Access Input Vectors” on page 12-34
• “Function Call in Transition Action” on page 12-35
• “Function Call in State Action” on page 12-35
• “Pass Arguments by Reference” on page 12-36

Specify Custom C Functions for Simulation

To specify custom C functions for simulation:

1 Open the Model Configuration Parameters dialog box.
2 Select Simulation Target.
3 Specify your custom C files, as described in “Integrate Custom C Code for Nonlibrary Charts for Simulation” on page 29-7.
Specify Custom C Functions for Code Generation

To specify custom C functions for code generation:

1. Open the Model Configuration Parameters dialog box.
3. Specify your custom C files, as described in “Integrate External Code for All Charts” (Simulink Coder).

Guidelines for Calling Custom C Functions in Your Chart

- Define a function by its name, any arguments in parentheses, and an optional semicolon.
- Pass parameters to user-written functions using single quotation marks. For example, `func('string')`.
- An action can nest function calls.
- An action can invoke functions that return a scalar value (of type `double` in the case of MATLAB functions and of any type in the case of C user-written functions).

Guidelines for Writing Custom C Functions That Access Input Vectors

- Use the `sizeof` function to determine the length of an input vector.
  
  For example, your custom function can include a for-loop that uses `sizeof` as follows:
  ```c
  for(i=0; i < sizeof(input); i++) {
      ......
  }
  ```
- If your custom function uses the value of the input vector length multiple times, include an input to your function that specifies the input vector length.
  
  For example, you can use `input_length` as the second input to a `sum` function as follows:
  ```c
  int sum(double *input, double input_length)
  ```
  Your `sum` function can include a for-loop that iterates over all elements of the input vector:
  ```c
  for(i=0; i < input_length; i++) {
      ......
  }
  ```
**Function Call in Transition Action**

Example formats of function calls using transition action notation appear in the following chart.

A function call to \texttt{fcn1} occurs with \texttt{arg1}, \texttt{arg2}, and \texttt{arg3} if the following are true:

- \( \text{S1} \) is active.
- Event \( e \) occurs.
- Condition \( c \) is true.
- The transition destination \( S2 \) is valid.

The transition action in the transition from \( S2 \) to \( S3 \) shows a function call nested within another function call.

**Function Call in State Action**

Example formats of function calls using state action notation appear in the following chart.
Chart execution occurs as follows:

1. When the default transition into S1 occurs, S1 becomes active.
2. The entry action, a function call to fcn1 with the specified arguments, executes.
3. After 5 seconds of simulation time, S1 becomes inactive and S2 becomes active.
4. The during action, a function call to fcn2 with the specified arguments, executes.
5. After 10 seconds of simulation time, S2 becomes inactive and S1 becomes active again.
6. Steps 2 through 5 repeat until the simulation ends.

**Pass Arguments by Reference**

A Stateflow action can pass arguments to a user-written function by reference rather than by value. In particular, an action can pass a pointer to a value rather than the value itself. For example, an action could contain the following call:

\[ f(&x); \]

where \( f \) is a custom-code C function that expects a pointer to \( x \) as an argument.

If \( x \) is the name of a data item defined in the Stateflow hierarchy, the following rules apply:

- Do not use pointers to pass data items input from a Simulink model.

  If you need to pass an input item by reference, for example, an array, assign the item to a local data item and pass the local item by reference.
• If \( x \) is a Simulink output data item having a data type other than `double`, the chart property **Use Strong Data Typing with Simulink I/O** must be on (see “Specify Chart Properties” on page 23-3).

• If the data type of \( x \) is `boolean`, you must turn off the coder option **Use bitsets for storing state configuration**.

• If \( x \) is an array with its first index property set to 0 (see “Set Data Properties” on page 9-7), then you must call the function as follows.

\[
f(&x[0]);
\]

This passes a pointer to the first element of \( x \) to the function.

• If \( x \) is an array with its first index property set to a nonzero number (for example, 1), the function must be called in the following way:

\[
f(&x[1]);
\]

This passes a pointer to the first element of \( x \) to the function.
Access Built-In MATLAB Functions and Workspace Data

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Call MATLAB Functions in Stateflow” on page 12-38</td>
</tr>
<tr>
<td>“ml Namespace Operator” on page 12-38</td>
</tr>
<tr>
<td>“ml Function” on page 12-39</td>
</tr>
<tr>
<td>“ml Expressions” on page 12-41</td>
</tr>
<tr>
<td>“Which ml Should I Use?” on page 12-41</td>
</tr>
<tr>
<td>“ml Data Type” on page 12-43</td>
</tr>
<tr>
<td>“How Charts Infer the Return Size for ml Expressions” on page 12-45</td>
</tr>
</tbody>
</table>

Call MATLAB Functions in Stateflow

For C charts, you can call MATLAB functions and access MATLAB workspace variables in Stateflow actions, using the ml namespace operator or the ml function.

For charts that use MATLAB as the action language, you can call MATLAB functions supported for code generation directly.

Caution Because MATLAB functions are not available in a target environment, do not use the ml namespace operator and the ml function if you plan to build a code generation target.

ml Namespace Operator

For C charts, the ml namespace operator uses standard dot (.) notation to reference MATLAB variables and functions. For example, the statement a = ml.x returns the value of the MATLAB workspace variable x to the Stateflow data a.

For functions, the syntax is as follows:

\[ [\text{return\_val1, return\_val2, \ldots}] = \text{ml}\text{.matfunc(arg1, arg2, \ldots)} \]

For example, the statement \([a, b, c] = \text{ml}\text{.matfunc}(x, y)\) passes the return values from the MATLAB function matfunc to the Stateflow data a, b, and c.
If the MATLAB function you call does not require arguments, you must still include the parentheses. If you omit the parentheses, Stateflow software interprets the function name as a workspace variable, which, when not found, generates a run-time error during simulation.

**Examples**

In these examples, x, y, and z are workspace variables and d1 and d2 are Stateflow data:

- a = ml.sin(ml.x)
  
  In this example, the MATLAB function sin evaluates the sine of x, which is then assigned to Stateflow data variable a. However, because x is a workspace variable, you must use the namespace operator to access it. Hence, ml.x is used instead of just x.

- a = ml.sin(d1)

  In this example, the MATLAB function sin evaluates the sine of d1, which is assigned to Stateflow data variable a. Because d1 is Stateflow data, you can access it directly.

- ml.x = d1*d2/ml.y

  The result of the expression is assigned to x. If x does not exist prior to simulation, it is automatically created in the MATLAB workspace.

- ml.v[5][6][7] = ml.matfunc(ml.x[1][3], ml.y[3], d1, d2, 'string')

  The workspace variables x and y are arrays. x[1][3] is the (1,3) element of the two-dimensional array variable x. y[3] is the third element of the one-dimensional array variable y. The last argument, 'string', is a character vector.

  The return from the call to matfunc is assigned to element (5,6,7) of the workspace array, v. If v does not exist prior to simulation, it is automatically created in the MATLAB workspace.

**ml Function**

For C charts, you can use the ml function to specify calls to MATLAB functions. The format for the ml function call uses this notation:

```matlab
ml(evalString, arg1, arg2,...);
```

`evalString` is an expression that is evaluated in the MATLAB workspace. It contains a MATLAB command (or a set of commands, each separated by a semicolon) to execute.
along with format specifiers (%g, %f, %d, etc.) that provide formatted substitution of the other arguments (arg1, arg2, etc.) into evalString.

The format specifiers used in ml functions are the same as those used in the C functions printf and sprintf. The ml function call is equivalent to calling the MATLAB eval function with the ml namespace operator if the arguments arg1, arg2, ... are restricted to scalars or literals in the following command:

```matlab
ml.eval(mlsprintf(evalString, arg1, arg2, ...))
```

Stateflow software assumes scalar return values from ml namespace operator and ml function calls when they are used as arguments in this context. See “How Charts Infer the Return Size for ml Expressions” on page 12-45.

**Examples**

In these examples, x is a MATLAB workspace variable, and d1 and d2 are Stateflow data:

- a = ml('sin(x)')

  In this example, the ml function calls the MATLAB function sin to evaluate the sine of x in the MATLAB workspace. The result is then assigned to Stateflow data variable a. Because x is a workspace variable, and sin(x) is evaluated in the MATLAB workspace, you enter it directly in the evalString argument ('sin(x)').

- a = ml('sin(%f)', d1)

  In this example, the MATLAB function sin evaluates the sine of d1 in the MATLAB workspace and assigns the result to Stateflow data variable a. Because d1 is Stateflow data, its value is inserted in the evalString argument ('sin(%f)') using the format expression %f. This means that if d1 = 1.5, the expression evaluated in the MATLAB workspace is sin(1.5).

- a = ml('matfunc(%g, 'abcdefg', x, %f)', d1, d2)

  In this example, the expression 'matfunc(%g, 'abcdefg', x, %f)' is the evalString shown in the preceding format statement. Stateflow data d1 and d2 are inserted into that expression with the format specifiers %g and %f, respectively. 'abcdefg' is a literal enclosed with two single pairs of quotation marks because it is part of the evaluation expression, which is already enclosed in single quotation marks.

- sfmat_44 = ml('rand(4)')
In this example, a square 4-by-4 matrix of random numbers between 0 and 1 is returned and assigned to the Stateflow data `sf_mat44`. Stateflow data `sf_mat44` must be defined as a 4-by-4 array before simulation. If its size is different, a size mismatch error is generated during run-time.

**ml Expressions**

For C charts, you can mix `ml` namespace operator and `ml` function expressions along with Stateflow data in larger expressions. The following example squares the sine and cosine of an angle in workspace variable `X` and adds them:

```ml
ml.power(ml.sin(ml.X),2) + ml('power(cos(X),2)')
```

The first operand uses the `ml` namespace operator to call the `sin` function. Its argument is `ml.X`, since `X` is in the MATLAB workspace. The second operand uses the `ml` function. Because `X` is in the workspace, it appears in the `evalString` expression as `X`. The squaring of each operand is performed with the MATLAB `power` function, which takes two arguments: the value to square, and the power value, 2.

Expressions using the `ml` namespace operator and the `ml` function can be used as arguments for `ml` namespace operator and `ml` function expressions. The following example nests `ml` expressions at three different levels:

```ml
a = ml.power(ml.sin(ml.X + ml('cos(Y)')),2)
```

In composing your `ml` expressions, follow the levels of precedence set out in “Binary and Bitwise Operations” on page 12-19. Use parentheses around power expressions with the `^` operator when you use them in conjunction with other arithmetic operators.

Stateflow software checks expressions for data size mismatches in your actions during parsing of charts and during run time. Because the return values for `ml` expressions are not known until run time, Stateflow software must infer the size of their return values. See “How Charts Infer the Return Size for ml Expressions” on page 12-45.

**Which ml Should I Use?**

In most cases, the notation of the `ml` namespace operator is more straightforward. However, using the `ml` function call does offer a few advantages:

- Use the `ml` function to dynamically construct workspace variables.

The following flow chart creates four new MATLAB matrices:
The for loop creates four new matrix variables in the MATLAB workspace. The default transition initializes the Stateflow counter \( i \) to 0, while the transition segment between the top two junctions increments it by 1. If \( i \) is less than 5, the transition segment back to the top junction evaluates the \texttt{ml} function call \texttt{ml('A%d = rand(%d)',i,i)} for the current value of \( i \). When \( i \) is greater than or equal to 5, the transition segment between the bottom two junctions occurs and execution stops.

The transition executes the following MATLAB commands, which create a workspace scalar (\( A1 \)) and three matrices (\( A2, A3, A4 \)):

\[
\begin{align*}
A1 &= \text{rand}(1) \\
A2 &= \text{rand}(2) \\
A3 &= \text{rand}(3) \\
A4 &= \text{rand}(4)
\end{align*}
\]

- Use the \texttt{ml} function with full MATLAB notation.

You cannot use full MATLAB notation with the \texttt{ml} namespace operator, as the following example shows:

\[
\begin{align*}
\text{ml}.A &= \text{ml}.magic(4) \\
B &= \text{ml}('A + A\prime')
\end{align*}
\]

This example sets the workspace variable \( A \) to a magic 4-by-4 matrix using the \texttt{ml} namespace operator. Stateflow data \( B \) is then set to the addition of \( A \) and its transpose matrix, \( A' \), which produces a symmetric matrix. Because the \texttt{ml} namespace operator cannot evaluate the expression \( A' \), the \texttt{ml} function is used instead. However, you can call the MATLAB function \texttt{transpose} with the \texttt{ml} namespace operator in the following equivalent expression:
\[ B = ml.A + ml.transpose(ml.A) \]

As another example, you cannot use arguments with cell arrays or subscript expressions involving colons with the `ml` namespace operator. However, these can be included in an `ml` function call.

### ml Data Type

Stateflow data of type `ml` is typed internally with the MATLAB type `mxArray` for C charts. You can assign (store) any type of data available in the Stateflow hierarchy to a data of type `ml`. These types include any data type defined in the Stateflow hierarchy or returned from the MATLAB workspace with the `ml` namespace operator or `ml` function.

### Rules for Using ml Data Type

These rules apply to Stateflow data of type `ml`:

- You can initialize `ml` data from the MATLAB workspace just like other data in the Stateflow hierarchy (see “Initialize Data from the MATLAB Base Workspace” on page 9-28).
- Any numerical scalar or array of `ml` data in the Stateflow hierarchy can participate in any kind of unary operation and any kind of binary operation with any other data in the hierarchy.

If `ml` data participates in any numerical operation with other data, the size of the `ml` data must be inferred from the context in which it is used, just as return data from the `ml` namespace operator and `ml` function are. See “How Charts Infer the Return Size for ml Expressions” on page 12-45.

**Note** The preceding rule does not apply to `ml` data storing MATLAB 64-bit integers. You can use `ml` data to store 64-bit MATLAB integers but you cannot use 64-bit integers in C charts.

- You cannot define `ml` data with the scope `Constant`.

This option is disabled in the Data properties dialog box and in the Model Explorer for Stateflow data of type `ml`.
- You can use `ml` data to build a simulation target but not to build an embeddable code generation target.
• If data of type `ml` contains an array, you can access the elements of the array via indexing with these rules:

  a. You can index only arrays with numerical elements.
  b. You can index numerical arrays only by their dimension.

  In other words, you can access only one-dimensional arrays by a single index value. You cannot access a multidimensional array with a single index value.
  c. The first index value for each dimension of an array is 1, and not 0, as in C language arrays.

In the examples that follow, `mldata` is a Stateflow data of type `ml`, `ws_num_array` is a 2-by-2 MATLAB workspace array with numerical values, and `ws_str_array` is a 2-by-2 MATLAB workspace array with character vector values.

```c
mldata = ml.ws_num_array; /* OK */
n21 = mldata[2][1]; /* OK for numerical data of type ml */
n21 = mldata[3]; /* NOT OK for 2-by-2 array data */
mldata = ml.ws_str_array; /* OK */
s21 = mldata[2][1]; /* NOT OK for character vector data of type ml*/
```

• `ml` data cannot have a scope outside a C chart; that is, you cannot define the scope of `ml` data as **Input to Simulink** or **Output to Simulink**.

**Place Holder for Workspace Data**

Both the `ml` namespace operator and the `ml` function can access data directly in the MATLAB workspace and return it to a C chart. However, maintaining data in the MATLAB workspace can present Stateflow users with conflicts with other data already resident in the workspace. Consequently, with the `ml` data type, you can maintain `ml` data in a chart and use it for MATLAB computations in C charts.

As an example, in the following statements, `mldata1` and `mldata2` are Stateflow data of type `ml`:

```c
mldata1 = ml.rand(3);
mldata2 = ml.transpose(mldata1);
```

In the first line of this example, `mldata1` receives the return value of the MATLAB function `rand`, which, in this case, returns a 3-by-3 array of random numbers. Note that `mldata1` is not specified as an array or sized in any way. It can receive any MATLAB workspace data or the return of any MATLAB function because it is defined as a Stateflow data of type `ml`. 
In the second line of the example, \texttt{mldata2}, also of Stateflow data type \texttt{ml}, receives the transpose matrix of the matrix in \texttt{mldata1}. It is assigned the return value of the MATLAB function \texttt{transpose} in which \texttt{mldata1} is the argument.

Note the differences in notation if the preceding example were to use MATLAB workspace data (\texttt{wsdata1} and \texttt{wsdata2}) instead of Stateflow \texttt{ml} data to hold the generated matrices:

\begin{verbatim}
ml.wsdata1 = ml.rand(3);
ml.wsdata2 = ml.transpose(ml.wsdata1);
\end{verbatim}

In this case, each workspace data must be accessed through the \texttt{ml} namespace operator.

\section*{How Charts Infer the Return Size for ml Expressions}

In C charts, Stateflow expressions using the \texttt{ml} namespace operator and the \texttt{ml} function evaluate in the MATLAB workspace at run time. The actual size of the data returned from the following expression types is known only at run time:

\begin{itemize}
  \item MATLAB workspace data or functions using the \texttt{ml} namespace operator or the \texttt{ml} function call

    For example, the size of the return values from the expressions \texttt{ml.var}, \texttt{ml.func()}, or \texttt{ml(evalString, arg1, arg2,...)}, where \texttt{var} is a MATLAB workspace variable and \texttt{func} is a MATLAB function, cannot be known until run-time.
  \item Stateflow data of type \texttt{ml}
  \item Graphical functions that return Stateflow data of type \texttt{ml}
\end{itemize}

When these expressions appear in actions, Stateflow code generation creates temporary data to hold intermediate returns for evaluation of the full expression of which they are a part. Because the size of these return values is unknown until run time, Stateflow software must employ context rules to infer the sizes for creation of the temporary data.

During run time, if the actual returned value from one of these commands differs from the inferred size of the temporary variable that stores it, a size mismatch error appears. To prevent run-time errors, use the following guidelines to write actions with MATLAB commands or \texttt{ml} data:
<table>
<thead>
<tr>
<th>Guideline</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return sizes of MATLAB commands or data in an expression must match return sizes of peer expressions.</td>
<td>In the expression <code>ml.func() * (x + ml.y)</code>, if <code>x</code> is a 3-by-2 matrix, then <code>ml.func()</code> and <code>ml.y</code> are also assumed to evaluate to 3-by-2 matrices. If either returns a value of different size (other than a scalar), an error results during run-time.</td>
</tr>
<tr>
<td>Expressions that return a scalar never produce an error.</td>
<td>In the expression <code>ml.x + y</code>, if <code>y</code> is a 3-by-2 matrix and <code>ml.x</code> returns a scalar, the resulting value is the result of adding the scalar value of <code>ml.x</code> to every member of <code>y</code> to produce a matrix with the size of <code>y</code>, that is, a 3-by-2 matrix. The same rule applies to subtraction (-), multiplication (*), division (/), and any other binary operations.</td>
</tr>
</tbody>
</table>
| MATLAB commands or Stateflow data of type `ml` can be members of these independent levels of expression, for which resolution of return size is necessary: | Arguments  
The expression for each function argument is a larger expression for which the return size of MATLAB commands or Stateflow data of type `ml` must be determined.  
In the expression `z + func(x + ml.y)`, the size of `ml.y` is independent of the size of `z`, because `ml.y` is used at the function argument level. However, the return size for `func(x + ml.y)` must match the size of `z`, because they are both at the same expression level.                                                                                                                  |
| Array indices                                                             |  
Array indices  
The expression for an array index is an independent level of expression that must be scalar in size.  
In the expression `x + array[y]`, the size of `y` is independent of the size of `x` because `y` and `x` are at different levels of expression. Also, `y` must be a scalar.                                                                                                                                                                                               |
| The return size for an indexed array element access must be a scalar.      | The expression `x[1][1]`, where `x` is a 3-by-2 array, must evaluate to a scalar.                                                                                                                                                                                                                                                                                                                                                                                   |
### Guideline

MATLAB command or data elements used in an expression for the input argument of a MATLAB function called through the `ml` namespace operator are resolved for size. This resolution uses the rule for peer expressions (preceding rule 1) for the expression itself, because no size definition prototype is available.

MATLAB command or data elements used for the input argument for a graphical function in an expression are resolved for size by the function prototype.

`ml` function calls can take only scalar or character vector literal arguments. Any MATLAB command or data that specifies an argument for the `ml` function must return a scalar value.

In an assignment, the size of the right-hand expression must match the size of the left-hand expression, with one exception. If the left-hand expression is a single MATLAB variable, such as `ml.x`, or Stateflow data of type `ml`, the right-hand expression determines the sizes of both expressions.

In an assignment, Stateflow column vectors on the left-hand side are compatible with MATLAB row or column vectors of the same size on the right-hand side.

A matrix you define with a row dimension of 1 is considered a row vector. A matrix you define with one dimension or with a column dimension of 1 is considered a column vector.

### Example

In the function call `ml.func(x + ml.y)`, if `x` is a 3-by-2 array, `ml.y` must return a 3-by-2 array or a scalar.

If the graphical function `gfunc` has the prototype `gfunc(arg1)`, where `arg1` is a 2-by-3 Stateflow data array, the calling expression, `gfunc(ml.y + x)`, requires that both `ml.y` and `x` evaluate to 2-by-3 arrays (or scalars) during run-time.

In the expression `a = ml('sin(x)')`, the `ml` function calls the MATLAB function `sin` to evaluate the sine of `x` in the MATLAB workspace. Stateflow data variable `a` stores that result.

In the expression `s = ml.func(x)`, where `x` is a 3-by-2 matrix and `s` is scalar Stateflow data, `ml.func(x)` must return a scalar to match the left-hand expression, `s`. However, in the expression `ml.y = x + s`, where `x` is a 3-by-2 data array and `s` is scalar, the left-hand expression, workspace variable `y`, is assigned the size of a 3-by-2 array to match the size of the right-hand expression, `x+s`, a 3-by-2 array.

In the expression `s = ml.func()`, where `ml.func()` returns a 1-by-3 matrix, if `s` is a vector of size 3, the assignment is valid.
<table>
<thead>
<tr>
<th>Guideline</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you cannot resolve the return size of MATLAB command or data elements in a larger expression by any of the preceding rules, they are assumed to return scalar values.</td>
<td>In the expression $\text{ml.x} = \text{ml.y} + \text{ml.z}$, none of the preceding rules can be used to infer a common size among $\text{ml.x}$, $\text{ml.y}$, and $\text{ml.z}$. In this case, both $\text{ml.y}$ and $\text{ml.z}$ are assumed to return scalar values. Even if $\text{ml.y}$ and $\text{ml.z}$ return matching sizes at run-time, if they return nonscalar values, a size mismatch error results.</td>
</tr>
<tr>
<td>The preceding rules for resolving the size of member MATLAB commands or Stateflow data of type ml in a larger expression apply only to cases in which numeric values are expected for that member. For nonnumeric returns, a run-time error results.</td>
<td>The expression $x + \text{ml.str}$, where $\text{ml.str}$ is a character vector workspace variable, produces a run-time error stating that $\text{ml.str}$ is not a numeric type.</td>
</tr>
</tbody>
</table>

**Note** Member MATLAB commands or data of type ml in a larger expression are limited to numeric values (scalar or array) only if they participate in numeric expressions.

Special cases exist, in which no size checking occurs to resolve the size of MATLAB command or data expressions that are part of larger expressions. Use of the following expressions does not require enforcement of size checking at run-time:

- `ml.var`
- `ml.func()`
- `ml(evalString, arg1, arg2, ...)`
- Stateflow data of type ml
- Graphical function returning a Stateflow data of type ml

In these cases, assignment of a return to the left-hand side of an assignment statement or a function argument occurs without checking for a size mismatch between the two:

- An assignment in which the left-hand side is a MATLAB workspace variable

For example, in the expression $\text{ml.x} = \text{ml.y}$, $\text{ml.y}$ is a MATLAB workspace variable of any size and type (structure, cell array, character vector, and so on).
• An assignment in which the left-hand side is a data of type ml

For example, in the expression \( m_x = \text{ml}.func() \), \( m_x \) is a Stateflow data of type ml.

• Input arguments of a MATLAB function

For example, in the expression \( \text{ml}.func(m_x, \text{ml}\.x, \text{gfunc}()) \), \( m_x \) is a Stateflow data of type ml, \( \text{ml}\.x \) is a MATLAB workspace variable of any size and type, and \( \text{gfunc}() \) is a Stateflow graphical function that returns a Stateflow data of type ml. Although size checking does not occur for the input type, if the passed-in data is not of the expected type, an error results from the function call \( \text{ml}.func() \).

• Arguments for a graphical function that are specified as Stateflow data of type ml in its prototype statement

**Note** If you replace the inputs in the preceding cases with non-MATLAB numeric Stateflow data, conversion to an ml type occurs.
Use Arrays in Actions

In this section...

“Array Notation” on page 12-50
“Arrays and Custom Code” on page 12-50

Array Notation

A Stateflow action in a C chart uses C style syntax and zero-based indexing by default to access array elements. This syntax differs from MATLAB notation, which uses one-based indexing. For example, suppose you define a Stateflow input \( \text{A} \) of size \([3 \ 4]\). To access the element in the first row, second column, use the expression \( \text{A}[0][1] \). Other examples of zero-based indexing in C charts include:

\[
\text{local_array}[1][8][0] = 10;
\]

\[
\text{local_array}[i][j][k] = 77;
\]

\[
\text{var} = \text{local_array}[i][j][k];
\]

**Note** Use the same notation for accessing arrays in C charts, from Simulink models, and from custom code.

As an exception to zero-based indexing, **scalar expansion** is available. This statement assigns a value of 10 to all the elements of the array \( \text{local_array} \).

\[
\text{local_array} = 10;
\]

Scalar expansion is available for performing general operations. This statement is valid if the arrays \( \text{array}_1, \text{array}_2, \) and \( \text{array}_3 \) have the same value for the **Sizes** property.

\[
\text{array}_1 = (3*\text{array}_2) + \text{array}_3;
\]

Arrays and Custom Code

C charts provide the same syntax for Stateflow arrays and custom code arrays.
**Note** Any array variable that is referred to in a C chart but is not defined in the Stateflow hierarchy is identified as a custom code variable.
Broadcast Events to Synchronize States

In this section...

- “Directed Event Broadcasting” on page 12-52
- “Directed Local Event Broadcast Using send” on page 12-52
- “Directed Local Event Broadcast Using Qualified Event Names” on page 12-53
- “Diagnostic for Detecting Undirected Local Event Broadcasts” on page 12-54

Directed Event Broadcasting

You can broadcast events directly from one state to another to synchronize parallel (AND) states in the same chart. The following rules apply:

- The receiving state must be active during the event broadcast.
- An action in one chart cannot broadcast events to states in another chart.

Using a directed local event broadcast provides the following benefits over an undirected broadcast:

- Prevents unwanted recursion during simulation.
- Improves the efficiency of generated code.

For information about avoiding unwanted recursion, see “Guidelines for Avoiding Unwanted Recursion in a Chart” on page 30-32.

Directed Local Event Broadcast Using send

The format of a directed local event broadcast with send is:

```
send(event_name, state_name)
```

where `event_name` is broadcast to `state_name` and any offspring of that state in the hierarchy. The event you send must be visible to both the sending state and the receiving state (`state_name`).

The `state_name` argument can include a full hierarchy path to the state. For example, if the state A contains the state A1, send an event e to state A1 with the following broadcast:
send(e, A.A1)

**Tip** Do not include the chart name in the full hierarchy path to a state.

The following example of a directed local event broadcast uses the send(event_name, state_name) syntax.

In this example, event E_one belongs to the chart and is visible to both A and B. See “Directed Event Broadcast Using Send” on page B-52 for more information on the semantics of this notation.

**Directed Local Event Broadcast Using Qualified Event Names**

The format of a directed local event broadcast using qualified event names is:

send(state_name.event_name)

where event_name is broadcast to its owning state (state_name) and any offspring of that state in the hierarchy. The event you send is visible only to the receiving state (state_name).

The state_name argument can also include a full hierarchy path to the receiving state. Do not use the chart name in the full path name of the state.
The following example shows the use of a qualified event name in a directed local event broadcast.

![Diagram](image)

In this example, event E_one belongs to state B and is visible only to that state. See “Directed Event Broadcast Using Qualified Event Name” on page B-53 for more information on the semantics of this notation.

**Diagnostic for Detecting Undirected Local Event Broadcasts**

If you have undirected local event broadcasts in state actions or condition actions in your chart, a warning appears by default during simulation. Examples of state actions with undirected local event broadcasts include:

- entry: send(E1), where E1 is a local event in the chart
- exit: E2, where E2 is a local event in the chart

You can control the level of diagnostic action for undirected local event broadcasts in the Diagnostics > Stateflow pane of the Model Configuration Parameters dialog box. Set the Undirected event broadcasts diagnostic to none, warning, or error. For more information, see the documentation for the “Undirected event broadcasts” (Simulink) diagnostic.
What Is Temporal Logic?

Temporal logic controls execution of a chart in terms of time. In state actions and transitions, you can use two types of temporal logic: event-based and absolute-time. Event-based temporal logic tracks recurring events, and absolute-time temporal logic defines time periods based on the simulation time of your chart. To operate on these recurring events or simulation time, you use built-in functions called temporal logic operators.

Rules for Using Temporal Logic Operators

These rules apply to the use of temporal logic operators:

- You can use any explicit or implicit event as a base event for a temporal operator. A base event is a recurring event on which a temporal operator operates.
- For a chart with no input events, you can use the tick or wakeup event to denote the implicit event of a chart waking up.
- Temporal logic operators can appear only in:
- State actions
- Transitions that originate from states
- Transition segments that originate from junctions when the full transition path connects two states

**Note** This restriction means that you cannot use temporal logic operators in default transitions or flow chart transitions.

Every temporal logic operator has an associated state: the state in which the action appears or from which the transition originates.

- You must use event notation (see “Notations for Event-Based Temporal Logic” on page 12-60) to express event-based temporal logic in state actions.

### Operators for Event-Based Temporal Logic

For event-based temporal logic, use the operators as described below.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td>after(n, E)</td>
<td>Returns true if the base event E has occurred at least n times since activation of the associated state. Otherwise, the operator returns false. In a chart with no input events, after(n, tick) or after(n, wakeup) returns true if the chart has woken up n times or more since activation of the associated state. Resets the counter for E to 0 each time the associated state reactivates.</td>
</tr>
<tr>
<td>Operator</td>
<td>Syntax</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>before</td>
<td>before(n, E)</td>
<td>Returns true if the base event E has occurred fewer than n times since activation of the associated state. Otherwise, the operator returns false. In a chart with no input events, before(n, tick) or before(n, wakeup) returns true if the chart has woken up fewer than n times since activation of the associated state. Resets the counter for E to 0 each time the associated state reactivates.</td>
</tr>
<tr>
<td>at</td>
<td>at(n, E)</td>
<td>Returns true only at the n\textsuperscript{th} occurrence of the base event E since activation of the associated state. Otherwise, the operator returns false. In a chart with no input events, at(n, tick) or at(n, wakeup) returns true if the chart has woken up for the n\textsuperscript{th} time since activation of the associated state. Resets the counter for E to 0 each time the associated state reactivates.</td>
</tr>
</tbody>
</table>

E is the base event for the before operator and n is either:

- A positive integer.
- An expression that evaluates to a positive integer value.
<table>
<thead>
<tr>
<th>Operator</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>every</td>
<td>every(n, E)</td>
<td>Returns true at every ( n )th occurrence of the base event ( E ) since activation of the associated state. Otherwise, the operator returns false.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In a chart with no input events, every(n, tick) or every(n, wakeup) returns true if the chart has woken up an integer multiple ( n ) times since activation of the associated state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Resets the counter for ( E ) to 0 each time the associated state reactivates. Therefore, this operator is useful only in state actions and not in transitions.</td>
</tr>
<tr>
<td>temporalCount</td>
<td>temporalCount(E)</td>
<td>Increments by 1 and returns a positive integer value for each occurrence of the base event ( E ) that takes place after activation of the associated state. Otherwise, the operator returns a value of 0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Resets the counter for ( E ) to 0 each time the associated state reactivates.</td>
</tr>
</tbody>
</table>

**Examples of Event-Based Temporal Logic**

These examples illustrate usage of event-based temporal logic in state actions and transitions.
<table>
<thead>
<tr>
<th>Operator</th>
<th>Usage</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td>State action</td>
<td><code>on after(5, CLK): status('on');</code></td>
<td>A status message appears during each CLK cycle, starting 5 clock cycles after activation of the state.</td>
</tr>
<tr>
<td></td>
<td>(on after)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>after</td>
<td>Transition</td>
<td><code>ROTATE[after(10, CLK)]</code></td>
<td>A transition out of the associated state occurs only on broadcast of a ROTATE event, but no sooner than 10 CLK cycles after activation of the state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>before</td>
<td>State action</td>
<td><code>on before(MAX, CLK): temp++;</code></td>
<td>The temp variable increments once per CLK cycle until the state reaches the MAX limit.</td>
</tr>
<tr>
<td></td>
<td>(on before)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>before</td>
<td>Transition</td>
<td><code>ROTATE[before(10, CLK)]</code></td>
<td>A transition out of the associated state occurs only on broadcast of a ROTATE event, but no later than 10 CLK cycles after activation of the state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>at</td>
<td>State action</td>
<td><code>on at(10, CLK): status('on');</code></td>
<td>A status message appears at exactly 10 CLK cycles after activation of the state.</td>
</tr>
<tr>
<td></td>
<td>(on at)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Operator  | Usage       | Example                   | Description                                                                                                                                                                                                 |
----------|-------------|---------------------------|-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
at        | Transition  | \text{ROTATE}[\text{at}(10, \text{CLK})] | A transition out of the associated state occurs only on broadcast of a \text{ROTATE} event, at exactly 10 \text{CLK} cycles after activation of the state.                                                              |
every     | State action (on every) | \text{on every}(5, \text{CLK}): \text{status('on');} | A status message appears every 5 \text{CLK} cycles after activation of the state.                                                                                                                            |
temporalCount | State action (during) | \text{du: } y = \text{mm[temporalCount(tick)];} | This action counts and returns the integer number of ticks that have elapsed since activation of the state. Then, the action assigns to the variable \( y \) the value of the \text{mm} array whose index is the value that the \text{temporalCount} operator returns. |

### Notations for Event-Based Temporal Logic

You can use one of two notations to express event-based temporal logic.

**Event Notation**

Use event notation to define a state action or a transition condition that depends only on a base event.

Event notation follows this syntax:

\( tlo(n, E)[C] \)

where
• $tlo$ is a Boolean temporal logic operator (after, before, at, or every)
• $n$ is the occurrence count of the operator
• $E$ is the base event of the operator
• $C$ is an optional condition expression

**Conditional Notation**

Use conditional notation to define a transition condition that depends on base and nonbase events.

Conditional notation follows this syntax:

$$E_1[tlo(n, E_2) \&\& C]$$

where

• $E_1$ is any nonbase event
• $tlo$ is a Boolean temporal logic operator (after, before, at, or every)
• $n$ is the occurrence count of the operator
• $E_2$ is the base event of the operator
• $C$ is an optional condition expression

**Examples of Event and Conditional Notation**

<table>
<thead>
<tr>
<th>Notation</th>
<th>Usage</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event</td>
<td>State action (on after)</td>
<td>on after(5, CLK): temp = WARM;</td>
<td>The temp variable becomes WARM 5 CLK cycles after activation of the state.</td>
</tr>
<tr>
<td>Event</td>
<td>Transition</td>
<td>after(10, CLK)[temp == COLD]</td>
<td>A transition out of the associated state occurs if the temp variable is COLD, but no sooner than 10 CLK cycles after activation of the state.</td>
</tr>
</tbody>
</table>
**Conditional Transition**

ON[after(5, CLK) && temp == COLD]

A transition out of the associated state occurs only on broadcast of an ON event, but no sooner than 5 CLK cycles after activation of the state and only if the temp variable is COLD.

**Note** You must use event notation in state actions, because the syntax of state actions does not support the use of conditional notation.

---

### Operators for Absolute-Time Temporal Logic

For absolute-time temporal logic, use the operators described in this table.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td>after(n, sec)</td>
<td>Returns true if n specified seconds (sec), milliseconds (msec), or microseconds (usec) of simulation time have elapsed since activation of the associated state. Otherwise, the operator returns false.</td>
</tr>
<tr>
<td></td>
<td>after(n, msec)</td>
<td>Resets the counter for sec, msec, and usec to 0 each time the associated state reactivates.</td>
</tr>
<tr>
<td></td>
<td>after(n, usec)</td>
<td></td>
</tr>
<tr>
<td>Operator</td>
<td>Syntax</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>before</td>
<td>before(n, sec)</td>
<td>Returns true if fewer than ( n ) specified seconds (sec), milliseconds (msec), or microseconds (usec) of simulation time have elapsed since activation of the associated state. Otherwise, the operator returns false. Resets the counter for sec, msec, and usec to 0 each time the associated state reactivates.</td>
</tr>
<tr>
<td></td>
<td>before(n, msec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>before(n, usec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>n is any positive number or expression. sec, msec, and usec are keywords that denote the simulation time elapsed since activation of the associated state.</td>
<td></td>
</tr>
<tr>
<td>temporalCount</td>
<td>temporalCount(sec)</td>
<td>Counts and returns the number of specified seconds (sec), milliseconds (msec), or microseconds (usec) of simulation time that have elapsed since activation of the associated state. Resets the counter for sec, msec and usec to 0 each time the associated state reactivates.</td>
</tr>
<tr>
<td></td>
<td>temporalCount(msec)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>temporalCount(usec)</td>
<td></td>
</tr>
<tr>
<td>elapsed</td>
<td>elapsed(sec)</td>
<td>Equivalent to temporalCount(sec). Returns the simulation time in seconds (sec) that has elapsed since the activation of the associated state. Resets the counter for sec to 0 each time the associated state reactivates.</td>
</tr>
</tbody>
</table>
## Define Time Delays with Temporal Logic

Use one of the keywords `sec`, `msec`, or `usec` to define simulation time in seconds, milliseconds, or microseconds that have elapsed since activation of a state. These keywords are valid only in state actions and in transitions that originate from states.

### Example of Defining Time Delays

The following continuous-time chart defines two absolute time delays in transitions.

![Chart Execution Diagram](chart.png)

Chart execution occurs as follows:

1. When the chart awakens, the state `Input` activates first.
After 5.33 milliseconds of simulation time, the transition from Input to Output occurs.

The state Input deactivates, and then the state Output activates.

After 10.5 seconds of simulation time, the transition from Output to Input occurs.

The state Output deactivates, and then the state Input activates.

Steps 2 through 5 are repeated, until the simulation ends.

**Example of Detecting Elapsed Time**

In the following model, the Step block provides a unit step input to the chart.

The chart determines when the input \( u \) equals 1.

<table>
<thead>
<tr>
<th>If the input equals 1...</th>
<th>A transition occurs from...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before ( t = 2 )</td>
<td>Start to Fast</td>
</tr>
<tr>
<td>Between ( t = 2 ) and ( t = 5 )</td>
<td>Start to Good</td>
</tr>
<tr>
<td>After ( t = 5 )</td>
<td>Start to Slow</td>
</tr>
</tbody>
</table>

**Advantages of Using Absolute-Time Temporal Logic for Delays**

Use absolute-time temporal logic instead of the implicit tick event for these reasons:
• Delay expressions that use absolute-time temporal logic are independent of the sample time of the model. However, the tick event is dependent on sample time.
• Absolute-time temporal logic works in charts that have function-call input events. The tick event does not work in charts with function-call inputs.
• Absolute-time temporal logic supports seconds (sec), milliseconds (msec) and microseconds (usec) syntax for the before and after operators.

**Examples of Absolute-Time Temporal Logic**

These examples illustrate absolute-time temporal logic in state actions and transitions.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Usage</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>after</td>
<td>State action (on after)</td>
<td>on after(12.3, sec): temp = LOW;</td>
<td>After 12.3 seconds of simulation time since activation of the state, ( \text{temp} ) variable becomes LOW.</td>
</tr>
<tr>
<td>after</td>
<td>Transition</td>
<td>after(8, msec)</td>
<td>After 8 milliseconds of simulation time have passed since activation of the state, a transition out of the associated state occurs.</td>
</tr>
<tr>
<td>after</td>
<td>Transition</td>
<td>after(5, usec)</td>
<td>After 5 microseconds of simulation time have passed since activation of the state, a transition out of the associated state occurs.</td>
</tr>
</tbody>
</table>
### Operator Table

<table>
<thead>
<tr>
<th>Operator</th>
<th>Usage</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>before</td>
<td>Transition</td>
<td>[\text{temp} &gt; 75 &amp;&amp; \text{before}(12.34, sec)]</td>
<td>If the variable \text{temp} exceeds 75 and fewer than 12.34 seconds have elapsed since activation of the state, a transition out of the associated state occurs.</td>
</tr>
<tr>
<td>temporalCount</td>
<td>State action (exit)</td>
<td>\text{ex: y = temporalCount(sec);}</td>
<td>This action counts and returns the number of seconds of simulation time that pass between activation and deactivation of the state.</td>
</tr>
</tbody>
</table>

### Run a Model That Uses Absolute-Time Temporal Logic

The \text{sf\_boiler} model shows the use of absolute-time temporal logic to implement a bang-bang controller. To run the model:

1. Type \text{sf\_boiler} at the MATLAB command prompt.
2. Start simulation of the model.

### Absolute-Time Temporal Logic in Conditionally Executed Subsystems

You can use absolute-time temporal logic in a chart that resides in a \textit{conditionally executed} subsystem. When the subsystem is disabled, the chart becomes inactive and the temporal logic operator pauses while the chart is asleep. The operator does not continue to count simulation time until the subsystem is reenabled and the chart is awake.

### Model with Absolute-Time Temporal Logic in an Enabled Subsystem

Suppose that your model has an enabled subsystem that contains a chart with the \textit{after} operator. In the subsystem, the \textbf{States when enabling} parameter is set to \textit{held}.  

---

12-67
The Signal Builder block provides the following input signal to the subsystem.

![Signal Builder Block Diagram]

The total time elapsed in an enabled state (both A and B) is as follows.
When the input signal enables the subsystem at time $t = 0$, the state $A$ becomes active, or enabled. While the state is active, the time elapsed increases. However, when the subsystem is disabled at $t = 2$, the chart goes to sleep and state $A$ becomes inactive.

For $2 < t < 6$, the time elapsed in an enabled state stays frozen at 2 seconds because neither state is active. When the chart wakes up at $t = 6$, state $A$ becomes active again and time elapsed starts to increase. The transition from state $A$ to state $B$ depends on the time elapsed while state $A$ is enabled, not on the simulation time. Therefore, state $A$ stays active until $t = 9$, so that the time elapsed in that state totals 5 seconds.

When the transition from $A$ to $B$ occurs at $t = 9$, the output value $y$ changes from 0 to 1.
This model behavior applies only to subsystems where you set the Enable block parameter **States when enabling** to **held**. If you set the parameter to **reset**, the chart reinitializes completely when the subsystem is reenabled. In other words, default transitions execute and any temporal logic counters reset to 0.

**Note** These semantics also apply to the **before** operator.

**How Sample Time Affects Chart Execution**

If a chart has a discrete sample time, any action in the chart occurs at integer multiples of this sample time.
Suppose you have a chart with a discrete sample time of 0.1 seconds:

State A becomes active at time $t = 0$, and the transition to state B occurs at $t = 2.2$ seconds. This behavior applies because the Simulink solver does not wake the chart at exactly $t = 2.15$ seconds. Instead, the solver wakes the chart at integer multiples of 0.1 seconds, such as $t = 2.1$ and 2.2 seconds.

**Note** This behavior also applies to the before operator.

**Best Practices for Absolute-Time Temporal Logic**

**Use the after Operator to Replace the at Operator**

If you use the at operator with absolute-time temporal logic, an error message appears when you try to simulate your model. Use the after operator instead.

Suppose that you want to define a time delay using the transition at $(5.33, \text{ sec})$.

Change the transition to after $(5.33, \text{ sec})$, as shown below.
Use an Outer Self-Loop Transition with the after Operator to Replace the every Operator

If you use the every operator with absolute-time temporal logic, an error message appears when you try to simulate your model. Use an outer self-loop transition with the after operator instead.

Suppose that you want to print a status message for an active state every 2.5 seconds during chart execution, as shown in the state action of Check_status.

Replace the state action with an outer self-loop transition, as shown below.
You must also add a history junction in the state so that the chart remembers the state settings prior to each self-loop transition. (See “Record State Activity Using History Junctions” on page 8-2.)

**Use Charts with Discrete Sample Times for More Efficient Code Generation**

The code generated for discrete charts that are not inside a triggered or enabled subsystem uses integer counters to track time instead of Simulink provided time. This allows for more efficient code generation in terms of overhead and memory, as well as enabling this code for use in Software-in-the-Loop(SIL) and Processor-in-the-Loop(PIL) simulation modes. For more information, see “SIL and PIL Simulations” (Embedded Coder).
Detect Changes in Data Values

In this section...

| “Types of Data Value Changes That You Can Detect” on page 12-74 |
| “Run a Model That Uses Change Detection” on page 12-75 |
| “How Change Detection Works” on page 12-77 |
| “Change Detection Operators” on page 12-79 |
| “Chart with Change Detection” on page 12-84 |

Types of Data Value Changes That You Can Detect

You can detect changes in Stateflow data from one time step to the next time step. All charts can detect changes on chart input data. C charts can also detect changes in chart output data, local chart variables, machine-parented variables, and data store memory data.

For each of these types of data, you can use operators that detect the following changes.

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Operator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data changes value from the beginning of the last time step to the beginning of the current time step.</td>
<td>See “hasChanged Operator” on page 12-80.</td>
</tr>
<tr>
<td>Data changes from a specified value at the beginning of the last time step to a different value at the beginning of the current time step.</td>
<td>See “hasChangedFrom Operator” on page 12-81.</td>
</tr>
<tr>
<td>Data changes to a specified value at the beginning of the current time step from a different value at the beginning of the last time step.</td>
<td>See “hasChangedTo Operator” on page 12-82.</td>
</tr>
</tbody>
</table>

Change detection operators return true if the data value changes or false if there is no change. See “Change Detection Operators” on page 12-79.
Run a Model That Uses Change Detection

Stateflow software ships with a model sf_tetris2 that shows how you can detect asynchronous changes in inputs — in this case, user keystrokes — to manipulate a Tetris shape as it moves through the playing field. The chart TetrisLogic implements this logic:

TetrisLogic contains a subchart called Moving that calls the operator hasChanged to determine when users press any of the Tetris control keys, and then moves the shape accordingly. Here is a look inside the subchart:
To run the model, follow these steps:

1. Open the model by typing `sf_tetris2` at the MATLAB prompt.
2. Start simulation.
How Change Detection Works

A chart detects changes in chart data by evaluating values at time step boundaries. That is, the chart compares the value at the beginning of the previous execution step with the value at the beginning of the current execution step. To detect changes, the chart automatically double-buffers these values in local variables, as follows:

<table>
<thead>
<tr>
<th>Local Buffer:</th>
<th>Stores:</th>
</tr>
</thead>
<tbody>
<tr>
<td>var_name_prev</td>
<td>Value of data at the beginning of the last time step</td>
</tr>
<tr>
<td>var_name_start</td>
<td>Value of data at the beginning of the current time step</td>
</tr>
</tbody>
</table>

**Note** Double-buffering occurs once per time step except if multiple input events occur in the same time step. Then, double-buffering occurs once per input event (see “Handle Changes When Multiple Input Events Occur” on page 12-79).

When you invoke change detection operations in an action, Stateflow software performs the following operations:

1. Double-buffers data values *after* a Simulink event triggers the chart, but *before* the chart begins execution.
2. Compares values in _prev and _start buffers. If the values match, the change detection operator returns `false` (no change); otherwise, it returns `true` (change).

The following diagram places these tasks in the context of the chart life cycle:
Stateflow software double-buffers data

\[ x_{prev} = x_{start} \]
\[ x_{start} = x \]

Simulink event triggers Stateflow chart

Is chart active?

Yes

Make chart active

Initialize chart by executing default transition paths

Chart executes active children hierarchically in top-down order

Chart goes to sleep

No

\[ x_{prev} \] Value of data at beginning of last time step

\[ x_{start} \] Value of data at beginning of current time step

\[ x \] Value of data at end of current time step

\( \text{hasChanged}(x) \) compares \( x_{prev} \) and \( x_{start} \)
The fact that buffering occurs before chart execution has implications for change detection in the following scenarios:

- “Handle Transient Changes in Local Variables” on page 12-79
- “Handle Changes When Multiple Input Events Occur” on page 12-79

**Handle Transient Changes in Local Variables**

Stateflow software attempts to filter out transient changes in local chart variables by evaluating their values only at time boundaries (see “How Change Detection Works” on page 12-77). This behavior means that the software evaluates the specified local variable only once at the end of the execution step and, therefore, returns a consistent result. That is, the return value remains constant even if the value of the local variable fluctuates within a given time step.

For example, suppose that in the current time step a local variable `temp` changes from its value at the previous time step, but then reverts to the original value. In this case, the operator `hasChanged(temp)` returns `false` for the next time step, indicating that no change occurred. For more information, see “Change Detection Operators” on page 12-79.

**Handle Changes When Multiple Input Events Occur**

When multiple input events occur in the same time step, Stateflow software updates the `_prev` and `_start` buffers once per event. In this way, a chart detects changes between input events, even if the changes occur more than once in a given time step.

**Change Detection Operators**

All charts can use change detection operators to check for changes in chart inputs. C charts can also use change detection operators on outputs, local variables, and in Stateflow data that is bound to Simulink data store memory.

You can invoke change detection operators wherever you call built-in functions in a chart — in state actions, transition actions, condition actions, and conditions. There are three change detection operators:

- “hasChanged Operator” on page 12-80
- “hasChangedFrom Operator” on page 12-81
- “hasChangedTo Operator” on page 12-82
hasChanged Operator

The hasChanged operator detects any change in Stateflow data since the last time step, using the following heuristic:

\[
hasChanged(x) = \begin{cases} 
1 & \text{if } x_{prev} \neq x_{start} \\
0 & \text{otherwise,}
\end{cases}
\]

where \(x_{start}\) represents the value at the beginning of the current time step and \(x_{prev}\) represents the value at the beginning of the previous time step.

Syntax

\[
\text{hasChanged ( u )}
\]

C charts can also use:

\[
\text{hasChanged ( m [ expr ] )}
\]
\[
\text{hasChanged ( s [ expr ] )}
\]

where \(u\) is a scalar or matrix variable, \(m\) is a matrix, and \(s\) is a structure.

The arguments \(u, m,\) and \(s\) must be one of the following data types:

- Input in a MATLAB chart
- Input, output, or local variable in a C chart

**Note** If you enable the chart option *Initialize Outputs Every Time Chart Wakes Up*, do not use an output as the argument of the hasChanged operator. With this option enabled, the hasChanged operator always returns \textit{false} (or \textit{false}), so there is no reason to use change detection.

- Stateflow data in a C chart that is bound to Simulink data store memory

The arguments cannot be expressions or custom code variables.

Description

\[\text{hasChanged ( u )}\text{ returns true if } u \text{ changes value since the last time step. If } u \text{ is a matrix, hasChanged returns true if any element of } u \text{ changes value since the last time step.}\]
hasChanged ( \( m \[ \text{expr} \] ) ) returns true if the value at location expr of matrix \( m \) changes value since the last time step. \( \text{expr} \) can be an arbitrary expression that evaluates to a scalar value.

hasChanged ( \( s \[ \text{expr} \] ) ) returns true if the value at location expr of structure \( s \) has changed since the last time step. \( s \) must be a fully qualified name, such as \( u.\text{foo.bar} \), which resolves to a structure. \( \text{expr} \) can be an arbitrary expression that evaluates to a scalar value.

All forms of hasChanged return zero if a chart writes to the data, but does not change its value.

**hasChangedFrom Operator**

The hasChangedFrom operator detects when Stateflow data changes from a specified value since the last time step, using the following heuristic:

\[
\text{hasChangedFrom}(x, x_0) = \begin{cases} 
1 & \text{if } x_{\text{prev}} \neq x_{\text{start}} \text{ and } x_{\text{prev}} = x_0 \\
0 & \text{otherwise},
\end{cases}
\]

where \( x_{\text{start}} \) represents the value at the beginning of the current time step and \( x_{\text{prev}} \) represents the value at the beginning of the previous time step.

**Syntax**

hasChangedFrom ( \( u, v \) )

C charts can also use:

hasChangedFrom ( \( m \[ \text{expr} \], v \) )
hasChangedFrom ( \( s \[ \text{expr} \], v \) )

where \( u \) is a scalar or matrix variable, \( m \) is a matrix, and \( s \) is a structure.

The arguments \( u, m, \) and \( s \) must be one of the following data types:

- Input in a MATLAB chart
- Input, output, or local variable in a C chart

**Note** If you enable the chart option **Initialize Outputs Every Time Chart Wakes Up**, do not use an output as the argument of the hasChanged operator. With this
option enabled, the `hasChanged` operator always returns `false` (or `false`), so there is no reason to use change detection.

- Stateflow data in a C chart that is bound to Simulink data store memory

**Note** The first arguments `u`, `m`, and `s` cannot be expressions or custom code variables. The second argument `v` can be an expression. However, if the first argument is a matrix variable, then `v` must resolve to a scalar value or a matrix value with the same dimensions as the first argument.

**Description**

`hasChangedFrom ( u, v )` returns `true` if `u` changes from the value specified by `v` since the last time step. If `u` is a matrix variable whose elements all equal the value specified by `v`, `hasChangedFrom` returns `true` if one or more elements of the matrix changes to a different value in the current time step.

`hasChangedFrom ( m [ expr ], v )` returns `true` if the value at location `expr` of matrix `m` changes from the value specified by `v` since the last time step. `expr` can be an arbitrary expression that evaluates to a scalar value.

`hasChangedFrom ( s [ expr ], v )` returns `true` if the value at location `expr` of structure `s` changes from the value specified by `v` since the last time step. `s` must be a fully qualified name, such as `u.foo.bar`, which resolves to a structure. `expr` can be an arbitrary expression that evaluates to a scalar value.

**hasChangedTo Operator**

The `hasChangedTo` operator detects when Stateflow data changes to a specified value since the last time step, using the following heuristic:

\[
\text{hasChangedTo}(x, x_0) = \begin{cases} 
1 & \text{if } x_{\text{prev}} \neq x_{\text{start}} \text{ and } x_{\text{start}} = x_0 \\
0 & \text{otherwise,} 
\end{cases}
\]

where \(x_{\text{start}}\) represents the value at the beginning of the current time step and \(x_{\text{prev}}\) represents the value at the beginning of the previous time step.

**Syntax**

\[
\text{hasChangedTo} \ ( \ u \ , \ v \ )
\]
C charts can also use:

\[
\text{hasChangedTo} \left( m \left[ expr \right], v \right)
\]
\[
\text{hasChangedTo} \left( s \left[ expr \right], v \right)
\]

where \( u \) is a scalar or matrix variable, \( m \) is a matrix, and \( s \) is a structure.

**Note** Charts that use MATLAB as the action language can only use scalar variables.

The arguments \( u, m, \) and \( s \) must be one of the following data types:

- Input in a MATLAB chart
- Input, output, or local variable in a C chart

**Note** If you enable the chart option *Initialize Outputs Every Time Chart Wakes Up*, do not use an output as the argument of the `hasChanged` operator. With this option enabled, the `hasChanged` operator always returns `false` (or `false`), so there is no reason to use change detection.

- Stateflow data in a C chart that is bound to Simulink data store memory

**Note** The first arguments \( u, m, \) and \( s \) cannot be expressions or custom code variables. The second argument \( v \) can be an expression. However, if the first argument is a matrix variable, then \( v \) must resolve to either a scalar value or a matrix value with the same dimensions as the first argument.

**Description**

\( \text{hasChangedTo} \left( u, v \right) \) returns `true` if \( u \) changes to the value specified by \( v \) in the current time step. If \( u \) is a matrix variable, \( \text{hasChangedTo} \) returns `true` if any of its elements changes value so that all elements of the matrix equal the value specified by \( v \) in the current time step.

\( \text{hasChangedTo} \left( m \left[ expr \right], v \right) \) returns `true` if the value at location \( expr \) of matrix \( m \) changes to the value specified by \( v \) in the current time step. \( expr \) can be an arbitrary expression that evaluates to a scalar value.

\( \text{hasChangedTo} \left( s \left[ expr \right], v \right) \) returns `true` if the value at location \( expr \) of structure \( s \) changes to the value specified by \( v \) in the current time step. \( s \) must be a fully
qualified name, such as `u.foo.bar`, which resolves to a structure. `expr` can be an arbitrary expression that evaluates to a scalar value.

**Chart with Change Detection**

The following model shows how to use the `hasChanged`, `hasChangedFrom`, and `hasChangedTo` operators to detect specific changes in an input signal. In this example, a Ramp block sends a discrete, increasing time signal to a chart:

![Chart with Change Detection Diagram](chart.png)

The model uses a fixed-step solver with a step size of 1. The signal increments by 1 at each time step. The chart analyzes the input signal for the following changes at each time step:

- Any change from the previous time step
- Change to the value 3
- Change from the value 3

To check the signal, the chart calls three change detection operators in a transition action, and outputs the return values as `y1`, `y2`, and `y3`, as follows:

```matlab
{ y1 = hasChanged(u); y2 = hasChangedFrom(u,3); y3 = hasChangedTo(u,3); }
```
During simulation, the outputs $y_1$, $y_2$, and $y_3$ are shown in this scope.

The ramp input signal $u$ is represented in green, and the $y_1$, $y_2$, and $y_3$ values are represented as yellow, blue, and red respectively. $y_1$ transitions at $T_1$, and stays at a value of 1 because $u$ continues to increase each time step. $y_3$ transitions at $T_3$ when the value of $u$ has reached 3, but then transitions back to 0 at $T_4$ when $u$ increases from 3 to 4. $y_2$ transitions to 1 at $T_4$ when $u$ changes from 3 to 4, and then transitions back to 0 at $T_5$ when $u$ increases from 4 to 5.
Check State Activity

When to Check State Activity

Check state activity when you have substates in parallel states that can be active at the same time. For example, checking state activity helps you synchronize substates in two parallel states.

How to Check State Activity

Use the `in` operator to check if a state is active. You can use this operator in state actions and transitions that originate from states.

The in Operator

Purpose

Checks if a state is active in a given time step during chart execution.

Syntax

\( \text{in}(S) \)

where \( S \) is a fully qualified state name.

Description

The `in` operator is true and returns a value of 1 whenever state \( S \) is active; otherwise, it returns a value of 0.
Example

This example illustrates the use of the in operator in transition conditions.

In this chart, using the in operator to check state activity synchronizes substates in the parallel states Place and Tracker. For example, when the input position u becomes positive, the state transition from Place.L to Place.R occurs. This transition makes the condition \([\text{in(Place.R)}]\) true, and the transition from Tracker.Moved_Left to Tracker.Moved_Right occurs.

How Checking State Activity Works

Checking state activity is a two-stage process. First, the in operator must find the desired state. Then, the operator determines if the desired state is active.

- The in operator does not perform an exhaustive search for all states in a chart that can match the argument. It performs a localized search and stops.
- The in operator does not stop searching after it finds one match. It continues to search until it reaches the chart level.

This diagram shows the detailed process of checking state activity.
When you use the in operator to check state activity, these actions take place:

1  The search begins in the state where you use the in operator.
   • If you use the in operator in a state action, then that state is the starting point.
   • If you use the in operator in a transition label, then the parent of the source state is the starting point.
2  The in operator searches at that level of the hierarchy for a path to a state that matches the desired state. If the operator finds a match, it adds that state to the list of possible matches.
3  The operator moves up to the next highest level of the hierarchy. At that level, the operator searches for a path to a state that matches the desired state. If the operator finds a match, it adds that state to the list of possible matches.
4  The in operator repeats the previous step until it reaches the chart level.
5  At the chart level, the operator searches for a path to a state that matches the desired state. If the operator finds a match, it adds that state to the list of possible matches. Then, the search ends.
6  After the search ends, one of the following occurs:
   • If a unique search result is found, the in operator checks if that state is active and returns a value of 0 or 1.
   • If the operator finds no matches or multiple matches for the desired state, an error message appears.

**State Resolution for Identically Named Substates**

For identically named substates in parallel superstates, the scope of the in operator remains local with respect to its chart-level superstate. When the in operator checks activity of a substate, it does not automatically detect an identically named substate that resides in a parallel superstate.

This example shows how the in operator works in a chart with identically named substates.
• Superstates A and B have identical substates A1 and A2.
• The condition \( \text{in}(A1.Y) \) guards the transition from P to Q in the states A.A2 and B.A2.
• For the state A.A2, the condition \( \text{in}(A1.Y) \) refers to the state A.A1.Y.
• For the state B.A2, the condition \( \text{in}(A1.Y) \) refers to the state B.A1.Y.

For the transition condition of A.A2, the \text{in} operator performs these search actions:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action of the \text{in} Operator</th>
<th>Finds a Match?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Picks A.A2 as the starting point and searches for the state A.A2.A1.Y</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Moves up to the next level of the hierarchy and searches for the state A.A1.Y</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Moves up to the chart level and searches for the state A1.Y</td>
<td>No</td>
</tr>
</tbody>
</table>

The search ends, with the single state A.A1.Y found. The \text{in} operator checks if that state is active and returns a value of 0 or 1.

Localizing the scope of the \text{in} operator produces a unique search result. For example, the \text{in} operator of A.A2 does not detect the state B.A1.Y, because the search algorithm
localizes the scope of the operator. Similarly, the in operator of B.A2 detects only the state B.A1.Y and does not detect the state A.A1.Y.

**Best Practices for Checking State Activity**

**Use a Specific Search Path**

Be specific when defining the path of the state whose activity you want to check. See the examples that follow for details.

**Example of No States Matching the Argument of the in Operator**

![Diagram](image_url)

In the state A.B, the during action invokes the in operator. Assume that you want to check the activity of the state A.B.Other.C.D. The in operator performs these search actions:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action of the in Operator</th>
<th>Finds a Match?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Picks A.B as the starting point and searches for the state A.B.C.D</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Moves up to the next level of the hierarchy and searches for the state A.C.D</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Moves up to the chart level and searches for the state C.D</td>
<td>No</td>
</tr>
</tbody>
</table>

The search ends, and an error appears because no match exists.

To eliminate the error, use a more specific path to check state activity: in(Other.C.D).
Example of the Wrong State Matching the Argument of the in Operator

In the state A.B, the during action invokes the in operator. Assume that you want to check the activity of the state A.B.Other.Q.R. The in operator performs these search actions:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action of the in Operator</th>
<th>Finds a Match?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Picks A.B as the starting point and searches for the state A.B.Q.R</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>Moves up to the next level of the hierarchy and searches for the state A.Q.R</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Moves up to the chart level and searches for the state Q.R</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The search ends, with the single state Q.R found. The in operator checks if that state is active and returns a value of 0 or 1.

In this example, the in operator checks the status of the wrong state. To prevent this error, use a more specific path to check state activity: in(Other.Q.R).

Use Unique State Names

Use unique names when you name the states in a chart.
Example of Multiple States Matching the Argument of the in Operator

In the state A.B, the during action invokes the in operator. Assume that you want to check the activity of the state A.B.P.Q.R. The in operator performs these search actions:

<table>
<thead>
<tr>
<th>Step</th>
<th>Action of the in Operator</th>
<th>Finds a Match?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Picks A.B as the starting point and searches for the state A.B.P.Q.R</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Moves up to the next level of the hierarchy and searches for the state A.P.Q.R</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>Moves up to the chart level and searches for the state P.Q.R</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The search ends, and an error appears because multiple matches exist.

To eliminate the error, perform one of these corrective actions:

- Rename one of the matching states.
- Use a more specific path to the desired state: in(B.P.Q.R).
- Enclose the outer state P.Q.R in a box or another state, as shown below.

Adding an enclosure prevents the in operator of state A.B from detecting that outer state.
Use Actions in Charts
Control Function-Call Subsystems Using Bind Actions

In this section...

“What Are Bind Actions?” on page 12-95
“Bind a Function-Call Subsystem to a State” on page 12-95
“Model That Binds a Function-Call Subsystem to a State” on page 12-100
“Behavior of a Bound Function-Call Subsystem” on page 12-103
“Why Avoid Muxed Trigger Events with Binding” on page 12-109

What Are Bind Actions?

Bind actions in a state bind specified data and events to that state. Events bound to a state can be broadcast only by the actions in that state or its children. You can also bind a function-call event to a state to enable or disable the function-call subsystem that the event triggers. The function-call subsystem enables when the state with the bound event is entered and disables when that state is exited. Execution of the function-call subsystem is fully bound to the activity of the state that calls it.

Bind a Function-Call Subsystem to a State

By default, a function-call subsystem is controlled by the chart in which the associated function call output event is defined. This association means that the function-call subsystem is enabled when the chart wakes up and remains active until the chart goes to sleep. To achieve a finer level of control, you can bind a function-call subsystem to a state within the chart hierarchy by using a bind action (see “Bind Actions” on page 12-4).

Bind actions can bind function-call output events to a state. When you create this type of binding, the function-call subsystem that is called by the event is also bound to the state. In this situation, the function-call subsystem is enabled when the state is entered and disabled when the state is exited.

When you bind a function-call subsystem to a state, you can fine-tune the behavior of the subsystem when it is enabled and disabled, as described in the following sections:

• “Handle Outputs When the Subsystem is Disabled” on page 12-96
• “Control Behavior of States When the Subsystem is Enabled” on page 12-98
**Handle Outputs When the Subsystem is Disabled**

Although function-call subsystems do not execute while disabled, their output signals are available to other blocks in the model. If a function-call subsystem is bound to a state, you can hold its outputs at their values from the previous time step or reset the outputs to their initial values when the subsystem is disabled. Follow these steps:

1. Double-click the outport block of the subsystem to open the Block Parameters dialog box.
2. Select an option for **Output when disabled**:

<table>
<thead>
<tr>
<th>Select:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>held</td>
<td>Maintain most recent output value</td>
</tr>
<tr>
<td>Select:</td>
<td>To:</td>
</tr>
<tr>
<td>---------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>reset</td>
<td>Reset output to its initial value</td>
</tr>
</tbody>
</table>

3 Click **OK** to record the settings.

**Note** Setting **Output when disabled** is meaningful only when the function-call subsystem is bound to a state, as described in “Bind a Function-Call Subsystem to a State” on page 12-95.

**Control Behavior of States When the Subsystem is Enabled**

If a function-call subsystem is bound to a state, you can hold the subsystem state variables at their values from the previous time step or reset the state variables to their initial conditions when the subsystem executes. In this way, the binding state gains full control of state variables for the function-call subsystem. Follow these steps:

1 Double-click the trigger port of the subsystem to open the Block Parameters dialog box.
2. Select an option for **States when enabling**:

<table>
<thead>
<tr>
<th>Select:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>held</td>
<td>Maintain most recent values of the states of the subsystem that contains the trigger port</td>
</tr>
<tr>
<td>Select:</td>
<td>To:</td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>reset</td>
<td>Revert to the initial conditions of the states of the subsystem that contains this trigger port</td>
</tr>
<tr>
<td>inherit</td>
<td>Inherit this setting from the function-call initiator's parent subsystem. If the parent of the initiator is the model root, the inherited setting is held. If the trigger has multiple initiators, the parents of all initiators must have the same setting: either all held or all reset.</td>
</tr>
</tbody>
</table>

3 Click OK to record the settings.

**Note** Setting States when enabling is meaningful only when the function-call subsystem is bound to a state, as described in “Bind a Function-Call Subsystem to a State” on page 12-95.

**Model That Binds a Function-Call Subsystem to a State**

The following model triggers a function-call subsystem with a trigger event E that binds to state A of a chart:

This model specifies a fixed-step solver with a fixed-step size of 1 in the Solver pane of the Model Configuration Parameters dialog box.

The chart contains two states, A and B, and connecting transitions, along with some actions:
Event $E$ binds to state $A$ with the action $\text{bind}:E$. Event $E$ is defined for the chart with a scope of $\text{Output to Simulink}$ and a trigger type of $\text{function-call}$.

The function-call subsystem contains a trigger port block, an input port, an output port, and a simple block diagram. The block diagram increments a counter by 1 at each time step, using a Unit Delay block:

The Block Parameters dialog box for the trigger port appears as follows.
The **States when enabling** parameter uses the setting **reset**. This setting resets the state values for the function-call subsystem to zero when it is enabled.

The **Sample time type** parameter uses the setting **triggered**. This setting sets the function-call subsystem to execute only when it is triggered by a calling event while it is enabled.
Setting **Sample time type** to **periodic** enables the **Sample time** field below it, which defaults to 1. These settings force the function-call subsystem to execute for each time step specified in the **Sample time** field while it is enabled. To accomplish this, the state that binds the calling event for the function-call subsystem must send an event for the time step coinciding with the specified sampling rate in the **Sample time** field. States can send events with **entry** or **during** actions at the simulation sample rate.

- For fixed-step sampling, the **Sample time** value must be an integer multiple of the fixed-step size.
- For variable-step sampling, the **Sample time** value has no limitations.

**Behavior of a Bound Function-Call Subsystem**

To see how a state controls a bound function-call subsystem, begin simulating the model in “Model That Binds a Function-Call Subsystem to a State” on page 12-100. The following steps describe the output of the subsystem.

1. In the chart, the default transition to state A occurs.
2. When state A becomes active, it executes its bind and entry actions. The binding action, **bind:E**, binds event E to state A. This action enables the function-call subsystem and resets its state variables to 0.
State A also executes its entry action, \texttt{en:E}, which sends an event \texttt{E} to trigger the function-call subsystem and execute its block diagram. The block diagram increments a count by 1 each time using a Unit Delay block. Because the previous content of the Unit Delay block is 0 after the reset, the initial output is 0 and the current value of 1 is held for the next call to the subsystem.

3 The next update event from the model tests state A for an outgoing transition.

The temporal operation on the transition to state B, \texttt{after(10, tick)}, allows the transition to be taken only after ten update events are received. For the second update, the during action of state A, \texttt{du:E}, executes, which sends an event to trigger the function-call subsystem. The held content of the Unit Delay block, 1, outputs to the scope.
The subsystem also adds 1 to the held value to produce the value 2, which the Unit Delay block holds for the next triggered execution.

4 The next eight update events increment the subsystem output by 1 at each time step.
On the 11th update event, the transition to state B occurs and state B becomes active. Because the binding to state A is no longer active, the function-call subsystem is disabled, and its output drops to 0.
When the next sampling event occurs, the transition from state B to state A occurs.

Again, the binding action, \texttt{bind: E}, enables the function-call subsystem and resets its output to 0.
The next 10 update events produce the following output.
Why Avoid Muxed Trigger Events with Binding

The example in “Behavior of a Bound Function-Call Subsystem” on page 12-103 shows how binding events gives control of a function-call subsystem to a single state in a chart. This control does not work when you allow other events to trigger the function-call subsystem through a mux. For example, the following model defines two function-call events to trigger a function-call subsystem using a Mux block:
In the chart, E1 binds to state A, but E2 does not. State B sends the triggering event E2 in its entry action:

When you simulate this model, you get the following output:
Broadcasting E2 in state B changes the output, which no longer resets.

**Note** Binding is not recommended when you provide multiple trigger events to a function-call subsystem through a mux. Muxed trigger events can interfere with event binding and cause undefined behavior.
Simplify Stateflow Chart Using the duration Operator

The following example focuses on the gear logic of a car as it shifts from first gear to fourth gear.

When modeling the gear changes of this system, it is important to control the oscillation that occur. The original sf_car model uses parallel state debouncer logic that controls which gear state is active. For more information about how debouncers work in Stateflow, see “Reduce Transient Signals with Debounce Logic” on page 25-2.

You can simplify the debouncer logic with the duration operator. You can see this simplification in the model sf_car_using_duration. The duration operator evaluates a condition expression and outputs the length of time that the expression has been true. When that length of time crosses a known time threshold, the state transitions to a higher or lower gear.

By removing the parallel state logic and using the duration operator, you can control oscillations with simpler Stateflow logic.

Control Oscillation with Parallel State Logic

To open the following model, at the MATLAB command prompt, enter sf_car. While shift_logic is highlighted, select Diagram > Mask > Look Under Mask.

The Stateflow chart shift_logic controls which gear the car is in, given the speed of the car and how much throttle is being applied. Within shift_logic there are two parallel states: gear_state and selection_state. gear_state contains four exclusive states for each gear. selection_state determines whether the car is downshifting, upshifting, or remaining in its current gear.
In this Stateflow chart, for the car to move from first gear to second gear, the event UP must be sent from selection_state to gear_state. The event is sent when the speed crosses the threshold and remains higher than the threshold for the length of time determined by TWAIT. When the event UP is sent, gear_state transitions from first to second.

**Control Oscillation with the duration Operator**

To open the following model, at the MATLAB command prompt, enter sf_car_using_duration. While Gear_Logic is highlighted, select Diagram > Mask > Look Under Mask.

Within Gear_Logic there are four exclusive states for each gear. The local variables up and down guard the transitions between each state.
In this Stateflow chart, for the car to move from first gear to second gear, the condition up must be true. The condition up is defined as true if the length of time that the speed is greater than or equal to the threshold is greater than the length of time that is specified by TWAIT. The condition down is defined as true if the length of time that the speed is less than or equal to the threshold is greater than the length of time that is specified by TWAIT. The operator duration keeps track of the length of time that the speed has been above or below the threshold. When the up condition is met, the active state transitions from first to second.

By replacing the parallel state debouncer logic with the duration operator, you can create a simpler Stateflow chart to model the gear shifting.

**See Also**

**Related Examples**

- “Reduce Transient Signals with Debounce Logic” on page 25-2
- “Control Chart Execution Using Temporal Logic” on page 12-55
MATLAB Syntax Support for States and Transitions

- “Modify the Action Language for a Chart” on page 13-2
- “Action Language Auto Correction” on page 13-6
- “Differences Between MATLAB and C as Action Language Syntax” on page 13-7
- “Model Event-Driven System” on page 13-10
- “Use C Chart to Model Event-Driven System” on page 13-30
Modify the Action Language for a Chart

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Icons for Action Language Syntax” on page 13-2</td>
</tr>
<tr>
<td>“Change the Default Action Language” on page 13-2</td>
</tr>
<tr>
<td>“C to MATLAB Syntax Conversion” on page 13-3</td>
</tr>
<tr>
<td>“Rules for Using MATLAB as the Action Language” on page 13-4</td>
</tr>
</tbody>
</table>

Icons for Action Language Syntax

Charts have an action language property that defines the syntax for state and transition actions. MATLAB is the default action language syntax for new Stateflow charts. These charts have a MATLAB icon in the lower-left corner.

Charts can also use C as the action language syntax. These charts have a C icon in the lower-left corner.

You can change the action language of a chart in the Action Language box of the Chart properties dialog box.

For more information, see “Differences Between MATLAB and C as Action Language Syntax” on page 13-7.

Change the Default Action Language

To change the default action language of new charts, use these commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>sfpref('ActionLanguage','MATLAB')</td>
<td>All new charts created have MATLAB as the action language, unless otherwise specified in sfnew.</td>
</tr>
<tr>
<td>Command</td>
<td>Result</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sfpref('ActionLanguage','C')</td>
<td>All new charts created have C as the action language, unless otherwise specified in sfnw.</td>
</tr>
</tbody>
</table>

For more information, see sfnw.

**C to MATLAB Syntax Conversion**

For nonempty charts, after you change the action language property from C to MATLAB, a notification appears at the top of the chart. The notification provides the option to convert some of the C syntax to MATLAB syntax. In the notification, click the link to have Stateflow convert syntax in the chart. C syntax constructs that are converted include:

- Zero-based indexing
- Binary and bit-wise operations
- C style comments
- Explicit casting for constant assignments

If the chart contains C constructs that cannot be converted to MATLAB, Stateflow shows a message in a dialog box. Click on the warnings link to display the warnings in the Diagnostic Viewer. Choose whether or not to continue with the conversion of supported syntax. C constructs not converted to MATLAB include:

- Explicit type casts with cast and type
- Operators such as &,* and :=
- Custom data
- Access to workspace variables using ml operator
- Functions not supported in code generation
- Hexadecimal and single precision notation
- Context-sensitive constants
Rules for Using MATLAB as the Action Language

Use unique names for data in a chart

Using the same name for data at different levels of the chart hierarchy causes a compile-time error.

Use unique names for functions in a chart

Using the same name for functions at different levels of the chart hierarchy causes a compile-time error.

Include a type prefix for identifiers of enumerated values

The identifier TrafficColors.Red is valid, but Red is not.

Use the MATLAB format for comments

Use % to specify comments in states and transitions for consistency with MATLAB. For example, the following comment is valid:

% This is a valid comment in the style of MATLAB

C style comments, such as // and /* */, are auto-corrected to use %.

Use one-based indexing for vectors and matrices

One-based indexing is consistent with MATLAB syntax.

Use parentheses instead of brackets to index into vectors and matrices

This statement is valid:

a(2,5) = 0;

This statement is not valid:

a[2][5] = 0;

Do not use control flow logic in condition actions and transition actions

If you try to use control flow logic in condition actions or transition actions, you get an error. Use of an if, switch, for, or while statement does not work.
Do not use transition actions in graphical functions

Transition labels in graphical functions do not support transition actions.

Enclose transition actions with braces

The following transition label contains a valid transition action:

E \[ x > 0 \] / \{ x = x+1; \}

The following transition label:

E \[ x > 0 \] / x = x+1;

is incorrect, but is auto-corrected to the valid syntax.

Do not declare global or persistent variables in state actions

The keywords global and persistent are not supported in state actions.

To generate code from your model, use MATLAB language features supported for code generation

Otherwise, use \texttt{coder.extrinsic} to call unsupported functions, which gives the functionality that you want for simulation, but not in the generated code. For a list of supported features and functions, see “MATLAB Language Features Supported for C/C++ Code Generation” (Simulink) and “Functions and Objects Supported for C/C++ Code Generation — Alphabetical List” (Simulink).

Assign an initial value to local and output data

When using MATLAB as the action language, data read without an initial value causes an error.
Action Language Auto Correction

Stateflow charts that use MATLAB as the action language will automatically correct the following syntax in the state transition diagrams.

- Adds brackets [], if missing, to statements that it recognizes as transition conditions.
- Adds braces{}, if missing, to statements that it recognizes as transition actions.
- Converts the following C syntax to MATLAB syntax:
  - Increment and decrement operations, such as a++ and a--. For example, a++ is changed to a=a+1.
  - Assignment operations, such as a+=expr, a-=expr, a*=expr, and a/=expr. For example, a+=b is changed to a=a+b.
  - Evaluation operations, such as a!=expr and !a. For example, a!=b is changed to a~b.
  - Inserts explicit casts for any literal constant assignment. For example, if y is defined as type single, then y=1 is changed to y=single(1).
## Differences Between MATLAB and C as Action Language Syntax

<table>
<thead>
<tr>
<th>Functionality</th>
<th>MATLAB as the Action Language</th>
<th>C as the Action Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>MATLAB syntax in states and transitions</td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Automatic inference of scope, size, type, and complexity for unresolved input, output, and local data</td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Control flow logic in state labels</td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Dot notation for specifying states, local data, message, and local events inside MATLAB functions</td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>C constructs, such as:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Increment and decrement operations <code>a++</code> and <code>a--</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Assignment operations <code>a += expr</code>, <code>a-= expr</code>, <code>a*= expr</code>, and <code>a/= expr</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Evaluation operations <code>a != expr</code> and <code>!a</code></td>
<td>Automatic correction for operators to MATLAB syntax. For example, <code>a++</code> is automatically corrected to <code>a=a+1.</code></td>
<td>Supported</td>
</tr>
<tr>
<td>Array indexing</td>
<td>One-based indexing</td>
<td>Zero-based indexing</td>
</tr>
<tr>
<td>Fixed-point constructs:</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
<tr>
<td>• Assignment operator <code>:=</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Context-sensitive constants, such as <code>3C</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Functionality</strong></td>
<td><strong>MATLAB as the Action Language</strong></td>
<td><strong>C as the Action Language</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>Use of custom code variables in states and transitions</td>
<td>Not supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Use of custom code functions in states and transitions</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Format of transition actions</td>
<td>Automatic correction</td>
<td>Not required to enclose a transition action with braces {}</td>
</tr>
<tr>
<td>Format of transition conditions</td>
<td>Automatic correction</td>
<td>Required to enclose a transition condition with brackets []</td>
</tr>
<tr>
<td>Type cast operations</td>
<td>Use MATLAB form</td>
<td>Use type operator</td>
</tr>
<tr>
<td>Explicit cast required in some situations</td>
<td>Not required for type assignment of constants or constant expressions.</td>
<td>y = 0</td>
</tr>
<tr>
<td>Structure parameters</td>
<td>Both tunable and nontunable</td>
<td>Tunable only</td>
</tr>
<tr>
<td>Specification of <strong>First index</strong>, <strong>Units</strong>, and <strong>Save final value to base workspace</strong> for data of any scope</td>
<td>Not available</td>
<td>Available</td>
</tr>
<tr>
<td>Intermediate data type for arithmetic operations</td>
<td>Follows MATLAB typing rules</td>
<td>Follows C typing rules</td>
</tr>
<tr>
<td>Typing rules for addition</td>
<td>Data of type double added to data of any other type results in data of the non-double type.</td>
<td>Data of type double added to data of any other type results in data of type double.</td>
</tr>
<tr>
<td>Use of global fimath object</td>
<td>Supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Simulation time for the chart</td>
<td>Use the function <code>getSimulationTime()</code></td>
<td>Represented by the symbol t</td>
</tr>
<tr>
<td>Ordering of parallel states</td>
<td>Explicit ordering</td>
<td>Explicit or implicit ordering</td>
</tr>
</tbody>
</table>
## Differences Between MATLAB and C as Action Language Syntax

<table>
<thead>
<tr>
<th>Functionality</th>
<th>MATLAB as the Action Language</th>
<th>C as the Action Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data scopes in functions</td>
<td>Constant, Parameter, Input, Output</td>
<td>Local, Constant, Parameter, Input, Output, Temporary</td>
</tr>
</tbody>
</table>
Model Event-Driven System

In this section...

“Typical Approaches to Chart Programming” on page 13-10
“Design Requirements” on page 13-10
“Identify System Attributes” on page 13-11
“Build the Model Yourself or Use the Supplied Model” on page 13-12
“Add a Stateflow Chart to the Feeder Model” on page 13-12
“Add States to Represent Operating Modes” on page 13-15
“Implement State Actions” on page 13-16
“Specify Transition Conditions” on page 13-18
“Define Data for Your System” on page 13-21
“Verify the System Representation” on page 13-23
“Alternative Approach: Event-Based Chart” on page 13-25
“Feeder Chart Activated by Input Events” on page 13-25

Typical Approaches to Chart Programming

There are two general approaches to programming a chart:

- Identify the operating modes of your system.
- Identify the system interface, such as events to which your system reacts.

This tutorial uses the first approach— that is, start by identifying the operating modes of the system to program the chart.

Design Requirements

This example shows how to build a Stateflow chart using MATLAB as the action language. The model represents a machine on an assembly line that feeds raw material to other parts of the line. This feeder behaves as follows:

- At system initialization, check that the three sensor values are normal.
A positive value means the sensor is working correctly. A zero means that the sensor is not working.

- If all sensor values are normal, transition from "system initialization" to "on".
- If the feeder does not leave initialization mode after 5 seconds, force the feeder into the failure state.
- After the system turns on, it starts counting the number of parts fed.
- At each time step, if any sensor reading is 2 or greater, the part has moved to the next station.
- If the alarm signal sounds, force the system into the failure state.

An alarm signal can occur when an operator opens one of the safety doors on the feeder or a downstream problem occurs on the assembly line, which causes all upstream feeders to stop.

- If the all-clear signal sounds, resume normal operation and reset the number of parts fed to zero.
- The feeder LED changes color to match the system operating mode— orange for "system initialization", green for "on", and red for "failure state".

**Identify System Attributes**

Based on the description of feeder behavior, you can identify the key system attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Characteristic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating modes</td>
<td>• <strong>System initialization</strong>, to perform system checks before turning on the machine</td>
</tr>
<tr>
<td></td>
<td>• <strong>On</strong>, for normal operation</td>
</tr>
<tr>
<td></td>
<td>• <strong>System failure</strong>, for a recoverable machine failure flagged by an alarm</td>
</tr>
<tr>
<td>Transitions</td>
<td>• <strong>System initialization</strong> to <strong>On</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>System initialization</strong> to <strong>Failure state</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>On</strong> to <strong>Failure state</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Failure state</strong> to <strong>System initialization</strong></td>
</tr>
<tr>
<td>Parallel Modes</td>
<td>No operating modes run in parallel. Only one mode can be active at any time.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Characteristic</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Default Mode</td>
<td><strong>System initialization</strong></td>
</tr>
</tbody>
</table>
| Inputs             | • Three sensor readings to detect if a part has moved to a downstream assembly station  
                     • An alarm signal that can take one of two values: 1 for on and 0 for off  |
| Outputs            | • Number of parts that have been detected as fed to a downstream assembly station  
                     • Color of the LED on the feeder                                           |

**Build the Model Yourself or Use the Supplied Model**

In this exercise, you add a Stateflow chart to a Simulink model that contains sensor and alarm input signals to the feeder.

Follow the exercises below to implement the model yourself. Otherwise, to open the supplied model, at the MATLAB command prompt enter:

```matlab
addpath(fullfile(docroot,'toolbox','stateflow','examples'))
ex_feeder
```

**Add a Stateflow Chart to the Feeder Model**

1. Open the partially built model by executing the following at the MATLAB command prompt:
   ```matlab
   addpath(fullfile(docroot,'toolbox','stateflow','examples'))
ex_feeder_exercise
   ```
2. Save the model in your working folder.
3. Double-click the **SensorSignals** block to see the three sensor signals represented by pulse generator blocks.

The **sensors** signal indicates when the assembly part is ready to move to the next station.

4. Double-click the **AlarmSignal** block to see the step blocks that represent the alarm signal.

When the **ALARM** signal is active, the machine turns off.

5. Run the model to see the output of the sensor and alarm signals in the **Scope** block.
The upper axis shows the sensor signals. Only two sensor signals appear because two of the sensors have the same signal. The lower axis shows the alarm signal which turns the feeder off between the simulation time of 45 to 80 seconds.

6 Open the Stateflow Library by executing `sflib` at the MATLAB command prompt.

7 Select Chart and drag it into your model.

**Tip** To create a new model with an empty Stateflow chart which uses MATLAB as the action language, use the command, `sfnew`.

8 Delete the connections from the SensorSignals subsystem to the scope and from the AlarmSignal subsystem to the scope.

9 Rename the label Chart located under the Stateflow chart to Feeder. The model should now look like this:

```
Add States to Represent Operating Modes

Based on the system attributes previously described, there are three operating modes:

- System initialization
- On
- Failure state

To add states for modeling the behavior of these operating modes:

1 Double-click the Feeder Chart to begin adding states.
Note  The MATLAB icon in the lower left corner of the chart indicates that you are using a Stateflow chart with MATLAB syntax.

2  Click the State Tool icon to bring a state into the chart.

3  Click the upper left corner of the state and type the name, InitializeSystem.

4  Repeat steps 2 and 3 to add two more states named On and FailState.

Implement State Actions

Decide the Type of State Action

States perform actions at different phases of their execution cycle from the time they become active to the time they become inactive. Three basic state actions are:

<table>
<thead>
<tr>
<th>Type of Action</th>
<th>When Executed</th>
<th>How Often Executed While State Is Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entry</td>
<td>When the state is entered (becomes active)</td>
<td>Once</td>
</tr>
<tr>
<td>During</td>
<td>While the state is active and no valid transition to another state is available</td>
<td>At every time step</td>
</tr>
<tr>
<td>Exit</td>
<td>Before a transition is taken to another state</td>
<td>Once</td>
</tr>
</tbody>
</table>

For example, you can use entry actions to initialize data, during actions to update data, and exit actions to configure data for the next transition. For more information about other types of state actions, see “Syntax for States and Transitions”.

1  Press return after the InitializeSystem state name and add this text to define the state entry action:

```matlab
echo
Light = ORANGE;
```
An orange LED indicates entry into the `InitializeSystem` state.

**Syntax for an entry action**

The syntax for entry actions is:

```
entry: one or more actions;
```

2. Add the following code after the `FailState` state name to define the entry action:

```
entry:
    Light = RED;
```

A red LED indicates entry in the `FailState`.

3. Add the following code after the `On` state name to define the entry action:

```
entry:
    Light = GREEN;
    partsFed = 0;
```

A green LED indicates entry in the `On` state. The number of parts fed is initialized to 0 each time we enter the `On` state.

4. Add the following code to the `On` state after the entry action to check if there is a strong sensor signal and increment the parts fed to the next station:

```
during:
    if(any(sensors >= 2))
        partsFed = partsFed + 1;
end
```

The `On` state checks the sensor signal to determine if a part is ready to be fed to the next assembly station. If the sensor signal is strong (the number of sensors that are on is greater than or equal to 2), then the chart counts the part as having moved on to the next station.

**Syntax for during actions**

The syntax for during actions is:

```
during: one or more actions;
```

The chart should now look like this figure.
Specify Transition Conditions

Transition conditions specify when to move from one operating mode to another. When the condition is true, the chart takes the transition to the next state, otherwise, the current state remains active. For more information, see “Transitions” on page 2-19.

Based on the description of feeder behavior, specify the rules for transitions between states:

1. Connect a default transition to the `InitializeSystem` state to indicate the chart entry point.
“Default Transitions” on page 2-35 specify where to begin the simulation.

2 Draw a transition from the InitializeSystem state to the On state:
   a Move the mouse over the lower edge of the InitializeSystem state until the pointer shape changes to crosshairs.
   b Click and drag the mouse to the upper edge of the On state. You then see a transition from the InitializeSystem state to the On state.
   c Double-click the transition to add this condition:

   \[ \text{[all(sensors>0)]} \]

   This transition condition verifies if all of the sensors have values greater than zero.

3 Repeat these steps to create these remaining transition conditions.

<table>
<thead>
<tr>
<th>Transition</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>On to FailState</td>
<td>[Alarm == 1]</td>
</tr>
<tr>
<td>FailState to InitializeSystem</td>
<td>[Alarm == 0]</td>
</tr>
</tbody>
</table>

4 Draw another transition from InitializeSystem to FailState. On this transition, type the following to create the transition event:

\[ \text{after(5,sec)} \]

If the sensors have not turned on after 5 seconds, this syntax specifies a transition from InitializeSystem to FailState.

**Note** The syntax on this transition is an event rather than a transition condition. For details, refer to “Control Chart Execution Using Temporal Logic” on page 12-55.

The chart now looks like this figure.
**Note** The outgoing transitions from `InitializeSystem` have a small label 1 and 2 to indicate the order in which transition segments are evaluated. If the numbers from the figure do not match your model, right click the transition and then change it by clicking on **Execution Order**. See “Transition Evaluation Order” on page 3-67 for details.
Define Data for Your System

Verify the Chart Data Properties

Start the simulation of your model. Errors about unresolved symbols appear, along with the Symbol Wizard.

The Symbol Wizard does not automatically add any data to your chart. It identifies the unresolved data and infers the class and scope of that data using the inference rules of MATLAB expressions in Stateflow actions. In the chart:

- Data that is read from but not written to is inferred as input data. However, if the name of the data is in all uppercase letters, the Symbol Wizard infers the data as a parameter
- Data that is written to but not read from is inferred as output data.
• Data that is read from and written to is inferred as *local* data.

The Symbol Wizard infers the scope of the input data in your chart. However, you must fix the data scope for the `partsFed` Output. Follow these steps:

1. For the `partsFed` data: in the **Data Scope** column, select **Output** from the list.

The Symbol Wizard now looks like this figure.

2. To add the data that the Symbol Wizard suggests, click **OK**.
3. Add initial values for the parameters. At the MATLAB command prompt, enter:

   ```matlab
   RED = 0;
   ```

4. Similarly, at the MATLAB command prompt, add the following initial values for the remaining parameters:
5 Return to the model and connect the inputs and outputs to their respective ports.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RED</td>
<td>0</td>
</tr>
<tr>
<td>ORANGE</td>
<td>1</td>
</tr>
<tr>
<td>GREEN</td>
<td>2</td>
</tr>
</tbody>
</table>

**Verify the System Representation**

1 Start the simulation.

Double-click the Scope block to verify that the model captures the expected feeder behavior.
The upper axis shows the LED signal which varies between orange (1), green (2), and red (0) to indicate the current operating mode. The lower axis shows the number of parts fed to the next assembly station, which increases incrementally until the alarm signal turns the machine off and then resets.

**Alternative Approach: Event-Based Chart**

Another approach to programming the chart is to start by identifying parts of the system interface, such as events to which your system reacts.

In the previous example, when you use input data to represent an event, the chart wakes up periodically and verifies whether the conditions on transitions are valid. In this case, if ALARM == 1, then the transition to the failure state happens at the next time step. However, creating a Stateflow chart which reacts to input events allows you to react to the alarm signal when the event is triggered.

For details on when to use an event-based chart, see “How Events Work in Stateflow Charts” on page 10-2.

**Identify System Attributes for Event-Driven Systems**

In the event-based approach, the system attributes to consider first are the events, inputs, and outputs.

In the following table, consider the characteristics of the event-driven Feeder Model that are different from the system based on transition conditions.

<table>
<thead>
<tr>
<th>Attributes</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Events</td>
<td>Two asynchronous events: an alarm signal and an all-clear signal</td>
</tr>
<tr>
<td>Inputs</td>
<td>Three sensor readings to detect if a part has moved to a downstream assembly station</td>
</tr>
</tbody>
</table>

**Feeder Chart Activated by Input Events**

In this example, the Feeder model reacts to input events using a triggered chart. To open this model, at the MATLAB command prompt enter:

```matlab
addpath(fullfile(docroot,'toolbox','stateflow','examples'))
ex_feeder_triggered
```
The chart now has only one input port on the left and an event triggered input on the top. For more information on how to create a Stateflow chart activated by events, see “Activate a Stateflow Chart Using Input Events” on page 10-9.

When the ALARM signal triggers the chart, the chart responds to the trigger in that time step. If the current state is On when the alarm is triggered, then the current state transitions to FailState.
The scope output for the Event-triggered chart is in the following figure.
The upper axis shows the LED signal which varies between red (0), orange (1), and green (2) to indicate the current operating mode. The lower axis shows the number of parts fed
to the next assembly station, which increases incrementally until the alarm signal turns the machine off and then resets. However, the event-based simulation feeds more parts to the next assembly station due to clock and solver differences.
Use C Chart to Model Event-Driven System

Before you start building a chart, you identify system attributes by answering these questions:

1. What are your interfaces?
   a. What are the event triggers to which your system reacts?
   b. What are the inputs to your system?
   c. What are the outputs from your system?

2. Does your system have any operating modes?
   a. If the answer is yes, what are the operating modes?
   b. Between which modes can you transition? Are there any operating modes that can run in parallel?

   If your system has no operating modes, the system is stateless. If your system has operating modes, the system is modal.

After identifying your system attributes, you can follow a basic work flow for building Stateflow charts to model event-driven systems:

1. Define the interface to Simulink.
2. Define the states for modeling each mode of operation.
3. Define state actions and variables.
4. Define the transitions between states.
5. Decide how to trigger the chart.
6. Simulate the chart.
7. Debug the chart.
Tabular Expression of Modal Logic

- “What Is a State Transition Table?” on page 14-2
- “Differences Between State Transition Tables and Charts” on page 14-5
- “Anatomy of a State Transition Table” on page 14-6
- “Create State Transition Table and Specify Properties” on page 14-8
- “Generate Diagrams from State Transition Tables” on page 14-10
- “View State Reactions with State Transition Matrix” on page 14-11
- “Highlight Flow of Logic” on page 14-14
- “State Transition Table Operations” on page 14-16
- “Rules for Using State Transition Tables” on page 14-19
- “State Transition Table Diagnostics” on page 14-20
- “Model Bang-Bang Controller with State Transition Table” on page 14-21
- “Debug Run-Time Errors in a State Transition Table” on page 14-37
What Is a State Transition Table?

A state transition table is an alternative way of expressing sequential modal logic. Instead of drawing states and transitions graphically in a Stateflow chart, you express the modal logic in tabular format.

Benefits of using state transition tables include:

- Ease of modeling train-like state machines, where the modal logic involves transitions from one state to its neighbor
- Concise, compact format for a state machine
- Reduced maintenance of graphical objects

When you add or remove states from a chart, you have to rearrange states, transitions, and junctions. When you add or remove states from a state transition table, you do not have to rearrange any graphical objects.

State transition tables support MATLAB action language. For more information about this action language, see “Rules for Using MATLAB as the Action Language” on page 13-4.

The following state transition table contains the modal logic for maintaining the temperature of a boiler between two set points:
If you create a Stateflow chart to represent the same modal logic, the chart looks something like this:
Tabular Expression of Modal Logic

Requirements:
1. Boiler maintains temperature between two setpoints.
2. The first time that the boiler turns on, it must warm up for 10 seconds.
3. The alarm needs to shut the boiler off.

Normal

Off
entry: boiler = 0;

[temp<=reference_low]

[temp >= reference_high]

On

Warmup
entry: boiler = 2;

after(10, sec)

Normal
entry: boiler = 1;

Alarm
entry: boiler = 0;

ALARM

CLEAR
Differences Between State Transition Tables and Charts

State transition tables support a subset of the most commonly used elements in Stateflow charts. Elements that state transition tables do not support include:

- Supertransitions
- Parallel (AND) decomposition
- Local events
- Flow charts
- Use of chart-level functions (graphical, truth table, MATLAB, and Simulink)
Anatomy of a State Transition Table

A state transition table contains the following components:
Each transition column contains the following state-to-state transition information:

- Condition
- Condition action
- Destination state
Create State Transition Table and Specify Properties

**In this section...**

“How to Create a New State Transition Table” on page 14-8
“Properties for State Transition Tables” on page 14-8

**How to Create a New State Transition Table**

At the MATLAB command prompt, enter:

```
sfnew(' -STT')
```

From the Simulink Library Browser:

1. Select the Stateflow library.
2. Drag a state transition table into your model.

**Properties for State Transition Tables**

To access properties, in the Stateflow editor, select **Chart > Properties**.
These properties are the same as for MATLAB charts. For a description of each property, see “Specify Chart Properties” on page 23-3.
Generate Diagrams from State Transition Tables

Stateflow software automatically generates a read-only state transition diagram from the state transition table you create. As you enter changes to a state transition table, Stateflow incrementally updates the diagram as well. To see the most up-to-date version of the underlying diagram, select Chart > View auto-generated diagram.
View State Reactions with State Transition Matrix

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“What Is a State Transition Matrix?” on page 14-11</td>
</tr>
<tr>
<td>“Create a State Transition Matrix” on page 14-11</td>
</tr>
<tr>
<td>“Filter by State Name” on page 14-13</td>
</tr>
<tr>
<td>“Traceability To State Transition Table” on page 14-13</td>
</tr>
</tbody>
</table>

What Is a State Transition Matrix?

The state transition matrix is an alternative view of a state transition table. In the state transition matrix, you can easily see how the model reacts to each condition and event from the state transition table.

Each row represents a state in the state transition table. Each column represents a condition or event. To see the reaction of a state to each event or condition, scan across the cells in a state row. To see how all states respond to an event or condition, scan down the cells of a column.

Create a State Transition Matrix

To create the matrix view for the state transition table that you build in “Model Bang-Bang Controller with State Transition Table” on page 14-21:

1. At the command prompt, enter:
   ```
   addpath(fullfile(docroot,'toolbox','stateflow','examples'))
ex_stt_boiler
   ```
2. Select Chart > View State Transition Matrix.
The order of the state rows is the same as the state transition table. The order of the columns is based on the number of states that respond to the condition or event. The leftmost column is the condition or event that impacts the highest number of state cells. The rightmost column is the condition or event that impacts the fewest number of states.

The background color of the condition cell is light gray for states that do not react to the condition in the corresponding column. When a state has no further conditions to the right of the condition cell to follow, the condition cell is dark gray.

The execution order appears in the upper-right corner of each transition cell. The execution order is red if it is out of order relative to the event columns. For example, in the state Warmup, the doneWarmup condition is tested before after(10, sec). Because the after(10, sec) column is before the doneWarmup column, the execution order for each corresponding cell is shown in red.

If you change the state transition table, you must regenerate the state transition matrix.
**Filter by State Name**

To see a subset of state rows, you can filter rows based on state names. In the upper-left corner of the state transition matrix, enter a state name in the States search box. Stateflow provides valid state name options as you type.

If you have too many events and conditions to view at once, you can scroll through the window horizontally. When you scroll to the right, you continue to see the state names as an overlay on each row.

**Traceability To State Transition Table**

In the state transition matrix cells, the state names, actions, conditions, and destinations are hyperlinks. Click one of these hyperlinks to see the corresponding state, action, condition, or destination highlighted in the state transition table. To remove the highlighting on the state transition table, select Display > Remove Highlighting.

For more information about traceability and generated C/C++ code, see “Trace Stateflow Elements in Generated Code” (Embedded Coder). For more information about traceability and generated HDL code, see “Navigate Between Simulink Model and HDL Code by Using Traceability” (HDL Coder).

**See Also**

**Related Examples**

- “Create State Transition Table and Specify Properties” on page 14-8
- “Model Bang-Bang Controller with State Transition Table” on page 14-21

**More About**

- “What Is a State Transition Table?” on page 14-2
Highlight Flow of Logic

To visualize a flow of logic, you can highlight one transition cell per row in your state transition table. For example, you might want to highlight the primary flow of logic from one state to another or the flow that represents an error condition.

The highlighting persists across MATLAB sessions and appears in the autogenerated state transition diagram as well as the state transition table.

To highlight transition cells:

1. In the transition table editor, right-click the transition cell and select Mark as primary transition.

   The transition cell appears with a red border.

2. Highlight additional cells, one per row, to complete the flow.

   For example:
To view the flow in the autogenerated state diagram, select **Chart > View autogenerated diagram**.

The transitions that represent the flow appear highlighted in the diagram.
State Transition Table Operations

### Insert Rows and Columns

To insert a row:

1. Select an existing state.
2. Select Chart > Insert Row > and choose one of these options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Row</td>
<td>Inserts a state at the same level of hierarchy.</td>
</tr>
<tr>
<td>Child State Row</td>
<td>Inserts a state as a child of the selected state.</td>
</tr>
<tr>
<td>Default Transition Path Row</td>
<td>Inserts a row for specifying conditional default transition paths.</td>
</tr>
<tr>
<td>Inner Transition Path Row</td>
<td>Inserts a row for specifying inner transitions from the selected parent state to its child states.</td>
</tr>
</tbody>
</table>

To insert a column:

1. Select Chart > Append Transition Column. A new else-if column appears to the right of the last column.
**Move Rows and Cells**

To move a row, click the state cell and drag the row to a new location. As you drag the row, you see a visual indicator of where in the hierarchy the state will appear in its new position.

To move a transition cell, click anywhere in the cell and drag the condition, action, and destination cells as a unit to a new location. The transition cell you displace moves one cell to the right, creating a new column if one doesn’t exist. The state transition table prevents you from moving cells to an invalid destination and alerts you to the problem.

**Copy Rows and Transition Cells**

To copy a row:

1. Right-click the state in the row you want to copy and select **Copy**.
2. Right-click the state in the destination row and select **Paste**.

   The row appears above the destination row.

To copy a transition cell:

1. Right-click a cell and select **Copy**.
2. Right-click a destination cell of the same type and select **Paste**.

   The new content overwrites the existing content at the destination. The state transition table prevents you from copying content to an invalid destination.

**Set Default State**

Right-click the state and select **Set to default**.

**Add History Junction**

You can add history junctions to states that have children. Right-click the state and select **Add history junction**.
Print State Transition Tables

To print a copy of the state transition table, select **File > Print > Print** or press **Ctrl+P (Command+P)**.

Select and Clear Table Elements

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a cell for editing</td>
<td>Click the cell.</td>
</tr>
<tr>
<td>Exit edit mode in a cell</td>
<td>Press <strong>Esc</strong> or click another table, cell, row, or column.</td>
</tr>
</tbody>
</table>

Undo and Redo Edit Operations

To undo the effects of the previous operation, select **Edit + Undo** or press **Ctrl+Z (Command+Z)**.

To redo the effects of the previous operation, select **Edit + Redo** or press **Ctrl+Y (Command+Y)**.

You can undo and redo up to 10 operations.

Zoom

To zoom in and out of your State Transition Table, select **View > Zoom**. You can add new rows to your State Transition Table at the zoom level that is consistent with your chart. When you save your model, the zoom level is saved.
Rules for Using State Transition Tables

- Use MATLAB instead of C as action language syntax.
  For more information, see “Differences Between MATLAB and C as Action Language Syntax” on page 13-7.
- If you specify an action in a transition cell, it must be a condition action.
- State transition tables must have at least one state row and one transition column.
State Transition Table Diagnostics

You can run diagnostic checks on a state transition table. From the Stateflow editor, select **Chart > Run Diagnostics**.

The diagnostics tool statically parses the table to find errors such as:

- States with no incoming transitions
- Transition cells with conditions or actions, but no destination
- Action text in a condition cell
- States that are unreachable from the default transition
- Default transition row without unconditional transition
- Inner transition row execution order mismatches. The inner transition row for a state must specify destination states from left to right in the same order as the corresponding states appear in the table, from top to bottom.

Each error is reported with a hyperlink to the corresponding object causing the error. These checks are also performed during simulation.

See “Diagnostics in State Transition Tables” for an example on using the diagnostics tool for state transition tables.
Why Use State Transition Tables?

A state transition table is an alternative way of expressing modal logic. Instead of drawing states and transitions graphically in a Stateflow chart, you express the modal logic in tabular format. State transition tables use MATLAB as the action language.

Benefits of using state transition tables include:

- Ease of modeling train-like state machines, where the modal logic involves transitions from one state to its neighbor
- Concise, compact format for a state machine
- Reduced maintenance of graphical objects

When you add or remove states from a chart, you have to rearrange states, transitions, and junctions. When you add or remove states from a state transition table, you do not have to rearrange any graphical objects.
Design Requirements

This example shows how to model a bang-bang controller for temperature regulation of a boiler, using a state transition table. The controller must turn the boiler on and off to meet the following design requirements:

• High temperature cannot exceed 25 degrees Celsius.
• Low temperature cannot fall below 23 degrees Celsius.
• Steady-state operation requires a warm-up period of 10 seconds.
• When the alarm signal sounds, the boiler must shut down immediately.
• When the all-clear signal sounds, the boiler can turn on again.

Identify System Attributes

You can identify the operating modes and data requirements for the bang-bang controller based on its design requirements.

Operating Modes

The high-level operating modes for the boiler are:

• Normal operation, when no alarm signal sounds.
• Alarm state, during an alarm signal.

During normal operation, the boiler can be in one of three states:

• Off, when the temperature is above 25 degrees Celsius.
• Warm-up, during the first 10 seconds of being on.
• On, steady-state after 10 seconds of warm-up, when the temperature is below 23 degrees Celsius.

Data Requirements

The bang-bang controller requires the following data.

<table>
<thead>
<tr>
<th>Scope</th>
<th>Description</th>
<th>Variable Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>High temperature set point</td>
<td>reference_high</td>
</tr>
<tr>
<td>Input</td>
<td>Low temperature set point</td>
<td>reference_low</td>
</tr>
<tr>
<td>Scope</td>
<td>Description</td>
<td>Variable Name</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Input</td>
<td>Alarm indicator</td>
<td>ALARM</td>
</tr>
<tr>
<td>Input</td>
<td>All-clear indicator</td>
<td>CLEAR</td>
</tr>
<tr>
<td>Input</td>
<td>Current temperature of the boiler</td>
<td>temp</td>
</tr>
<tr>
<td>Local</td>
<td>Indicator that the boiler completed warm-up</td>
<td>doneWarmup</td>
</tr>
<tr>
<td>Output</td>
<td>Command to set the boiler mode: off, warm-up, or on</td>
<td>boiler_cmd</td>
</tr>
</tbody>
</table>

**Build the Controller or Use the Supplied Model**

To build the bang-bang controller model yourself using a state transition table, work through the exercises, starting with “Create a New State Transition Table” on page 14-23. Otherwise, open the supplied model. At the MATLAB prompt, enter these commands:

```matlab
addpath(fullfile(docroot,'toolbox','stateflow','examples'))
ex_stt_boiler
```

**Create a New State Transition Table**

You use a state transition table to represent the bang-bang controller. Compared to a graphical state transition diagram, the state transition table is a compact way to represent modal logic that involves transitions between neighboring states. State transition tables use MATLAB syntax.

1. Open the partially built boiler plant model by entering these commands:

   ```matlab
   addpath(fullfile(docroot,'toolbox','stateflow','examples'))
ex_stt_boiler
   ```

   This model contains all required Simulink blocks, except for the bang-bang controller.
2. Delete the five output ports and the single input port.

3. Open the Library Browser by selecting View > Library Browser.

4. In the left pane of the Library Browser, select the Stateflow library, then drag a State Transition Table block from the right pane into your boiler model.

Your model should look something like this model.

5. Close the Library Browser.

Now you are ready to add states and hierarchy to the state transition table.
Add States and Hierarchy

To represent the operating modes of the boiler, add states and hierarchy to the state transition table.

1. Open the state transition table.
2. Represent the high-level operating modes, normal and alarm:
   a. Double-click state1 and rename it Normal.
   b. Double-click state2 and rename it Alarm.
3. Represent the three states of normal operation as substates of Normal:
   a. Right-click the Normal state, select Insert Row > Child State Row, and name the new state Off.
   b. Repeat step a two more times to create the child states Warmup and On, in that order.

By default, when there is ambiguity, the top exclusive (OR) state at every level of hierarchy becomes active first. For this reason, the Normal and Off states appear with default transitions. This configuration meets the design requirements for this model.

How do I set a default state?

Right-click the state and select Set to default.

Your state transition table should look like this table.
Now you are ready to specify actions for each state.
Specify State Actions

To describe the behavior that occurs in each state, specify state actions in the table. In this exercise, you initialize modes of operation as the boiler enters normal and alarm states, using the variables `boiler_cmd` and `doneWarmup` (described in “Data Requirements” on page 14-22).

1 In the following states, click after the state name, press Enter, and type the specified entry actions.

<table>
<thead>
<tr>
<th>In State:</th>
<th>Type:</th>
<th>Resulting Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>entry: <code>boiler_cmd = 0; doneWarmup = false;</code></td>
<td>Turns off the boiler and indicates that the boiler has not warmed up.</td>
</tr>
<tr>
<td>Warmup</td>
<td>entry: <code>boiler_cmd = 2;</code></td>
<td>Starts warming up the boiler.</td>
</tr>
<tr>
<td>On</td>
<td>entry: <code>boiler_cmd = 1;</code></td>
<td>Turns on the boiler.</td>
</tr>
<tr>
<td>Alarm</td>
<td>entry: <code>boiler_cmd = 0;</code></td>
<td>Turns off the boiler.</td>
</tr>
</tbody>
</table>

2 Save the state transition table.

Your state transition table should look like this table.
Now you are ready to specify the conditions and actions for transitioning from one state to another state.
Specify Transition Conditions and Actions

To indicate when to change from one operating mode to another, specify transition conditions and actions in the table. In this exercise, you construct statements using variables described in “Data Requirements” on page 14-22.

1  In the Normal state row, enter:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>if</td>
<td></td>
</tr>
<tr>
<td>[ALARM]</td>
<td></td>
</tr>
<tr>
<td>Alarm</td>
<td></td>
</tr>
</tbody>
</table>

During simulation:

a  When first entered, the chart activates the Normal state.

b  At each time step, normal operation cycles through the Off, Warmup, and On states until the ALARM condition is true.

c  When the ALARM condition is true, the boiler transitions to the Alarm state and shuts down immediately.

2  In the Off state row, enter:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>if</td>
<td></td>
</tr>
<tr>
<td>[temp &lt;= reference_low]</td>
<td></td>
</tr>
<tr>
<td>Warmup</td>
<td></td>
</tr>
</tbody>
</table>

During simulation, when the current temperature of the boiler drops below 23 degrees Celsius, the boiler starts to warm up.

3  In the Warmup state row, enter:

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>if</td>
<td>else-if</td>
</tr>
<tr>
<td>[doneWarmup]</td>
<td>[after(10, sec)]</td>
</tr>
<tr>
<td></td>
<td>{doneWarmup = true;}</td>
</tr>
<tr>
<td>On</td>
<td>On</td>
</tr>
</tbody>
</table>
During simulation, the boiler warms up for 10 seconds and then transitions to the On state.

4 In the On state row, enter:

| if [temp >= reference_high] | Off |

During simulation, when the current temperature of the boiler rises above 25 degrees Celsius, the boiler shuts off.

5 In the Alarm state row, enter:

| if [CLEAR] | Normal |

During simulation, when the all-clear condition is true, the boiler returns to normal mode.

6 Save the state transition table.

Your state transition table should look like this table.
Now you are ready to add data definitions using the Symbol Wizard.
Define Data

State transition tables use MATLAB syntax and honor the language requirements for C/C++ code generation. One of these requirements is that you define the size, type, and complexity of all MATLAB variables so that their properties can be determined at compile time. Even though you have not yet explicitly defined the data in your state transition table, you can use the Symbol Wizard. During simulation, the Symbol Wizard alerts you to unresolved symbols, infers their properties, and adds the missing data to your table.

1 In the Simulink model editor menu, select **Simulation > Run**.

Two dialog boxes appear:

- The Diagnostic Viewer indicates that you have unresolved symbols in the state transition table.
- The Symbol Wizard attempts to resolve the missing data. The wizard correctly infers the scope of all data except for the inputs **ALARM** and **CLEAR**.
2 In the Symbol Wizard, correct the scopes of ALARM and CLEAR by selecting **Input** from their Scope drop-down lists.

3 When the Model Explorer opens, verify that the Symbol Wizard added all required data definitions correctly.

Some of the inputs are assigned to the wrong ports.

4 In the Contents pane of the Model Explorer, reassign input ports as follows:

<table>
<thead>
<tr>
<th>Assign:</th>
<th>To Port:</th>
</tr>
</thead>
<tbody>
<tr>
<td>reference_low</td>
<td>2</td>
</tr>
<tr>
<td>reference_high</td>
<td>1</td>
</tr>
<tr>
<td>temp</td>
<td>5</td>
</tr>
<tr>
<td>ALARM</td>
<td>3</td>
</tr>
</tbody>
</table>
Assign: | To Port:  
---|---
CLEAR | 4

5 Save the state transition table.
6 Close the Diagnostic Viewer and the Model Explorer.

In the Simulink model, the inputs and outputs that you just defined appear in the State Transition Table block. Now you are ready to connect these inputs and outputs to the Simulink signals and run the model.

**Connect the Transition Table and Run the Model**

1 In the Simulink model, connect the state transition table to the Simulink inputs and outputs:

2 Save the model.
3 Reopen your state transition table.
4 Start the simulation by selecting **Simulation > Run**.

As the simulation runs, you can watch the animation in the state transition table activate different states.
The following output appears in the Scope block.

If you need to perform interactive debugging, you can set breakpoints on different states and view the data values at different points in the simulation. For more information about debugging, see “Debugging Charts” on page 30-2.

**View the Graphical Representation**

Stateflow automatically generates a read-only graphical representation of the state transition table you created.
1 In the state transition table, select **Chart > View auto-generated diagram**.

The top-level state transition diagram looks like this:

![Diagram](image)

The **Normal** state appears as a subchart.

2 Double-click the **Normal** state to view the states and transitions it contains.
Debug Run-Time Errors in a State Transition Table

Create the Model and the State Transition Table

1. Create a Simulink model with a new State Transition Table (sfnew -stt).
2. Add the following states and transitions to your table:
The table has two states at the highest level in the hierarchy, \texttt{Power\_off} and \texttt{Power\_on}. By default, \texttt{Power\_off} is active. The event \texttt{SWITCH} toggles the system between the \texttt{Power\_off} and \texttt{Power\_on} states. \texttt{Power\_on} has three substates: \texttt{First}, \texttt{Second}, and \texttt{Third}. By default, when \texttt{Power\_on} becomes active, \texttt{First} also becomes active. When \texttt{Shift} equals 1, the system transitions from \texttt{First} to

<table>
<thead>
<tr>
<th>STATES</th>
<th>TRANSITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IF</td>
</tr>
<tr>
<td>Power_off</td>
<td>[SWITCH]</td>
</tr>
<tr>
<td>Power_on</td>
<td></td>
</tr>
<tr>
<td>First</td>
<td>[Shift == 1]</td>
</tr>
<tr>
<td>Second</td>
<td>[Shift == 1]</td>
</tr>
<tr>
<td>Third</td>
<td>[Shift == 1]</td>
</tr>
<tr>
<td>First</td>
<td></td>
</tr>
</tbody>
</table>
Second, Second to Third, and Third to First, for each occurrence of the event SWITCH. Then the pattern repeats.

3 Add two inputs on page 9-2 from Simulink:
   - An event called SWITCH with a scope of **Input from Simulink** and a **Rising** edge trigger.
   - A data called Shift with a scope of **Input from Simulink**.

4 In the model view, connect a Sine Wave block as the SWITCH event and a Step block as the Shift data for your State Transition Table.

In the model, there is an event input and a data input. A Sine Wave block generates a repeating input event that corresponds with the Stateflow event SWITCH. The Step block generates a repeating pattern of 1 and 0 that corresponds with the Stateflow data object Shift. Ideally, the SWITCH event occurs at a frequency that allows at least one cycle through First, Second, and Third.

**Debug the State Transition Table**

To debug the table in “Create the Model and the State Transition Table” on page 14-37, follow these steps:

1. Right-click the Power_off state, and select **Set Breakpoint > On State Entry**.
2. Start the simulation.

   Because you specified a breakpoint on Power_off, execution stops at that point.
3 Move to the next step by clicking the Step In button.

4 Hover your cursor over the different table cells to see the data used and the current values.

Continue clicking the Step In button and watching the animating states. After each step, watch the chart animation to see the sequence of execution. Use the tooltips to see the data values.

Single-stepping shows that the loop from First to Second to Third inside the state Power_on does not occur. The transition from Power_on to Power_off takes priority.

Correct the Run-Time Error

In “Debug the State Transition Table” on page 14-39, you step through a simulation of a state transition table and find an error. The event SWITCH drives the simulation, but the simulation time passes too quickly for the input data object Shift to have an effect.

To correct this error:

1 Stop the simulation so that you can edit the table.
2 Add the condition after(20.0, sec) to the transition from Power_on to Power_off.
Now the transition from `Power_on` to `Power_off` does not occur until 20 seconds have passed.

3 Begin simulation.

4 Click the Step In button repeatedly to observe the fixed behavior.
See Also

Related Examples

- “Debug Run-Time Errors in a Chart” on page 30-22
- “Debug a Truth Table” on page 26-42
Make States Reusable with Atomic Subcharts

- “Convert to and from Atomic Subcharts” on page 15-11
- “Map Variables for Atomic Subcharts” on page 15-15
- “Generate Reusable Code for Atomic Subcharts” on page 15-35
- “Rules for Using Atomic Subcharts” on page 15-37
- “Reuse a State Multiple Times in a Chart” on page 15-42
- “Reduce the Compilation Time of a Chart” on page 15-51
- “Divide a Chart into Separate Units” on page 15-53
- “Generate Reusable Code for Unit Testing” on page 15-55
What Is an Atomic Subchart?

In a Stateflow chart, an atomic subchart is a graphical object that helps you reuse the same state or subchart across multiple charts and models. Atomic subcharts allow:

- Ease of team development for people working on different parts of the same chart
- Faster simulation after making small changes to a chart with many states or levels of hierarchy
- Manual inspection of generated code for a specific state or subchart in a chart
- Ability to animate and debug multiple charts side by side

States, subcharts, and atomic subcharts have these key similarities and differences:

<table>
<thead>
<tr>
<th>Capability</th>
<th>State</th>
<th>Subchart</th>
<th>Atomic Subchart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can behave as a standalone chart</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Can generate reusable code</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Supports access to event broadcasts outside the scope of that object</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Supports access to data at any level of the hierarchy</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Atomic subcharts and atomic subsystems (see Atomic Subsystem in the Simulink documentation) have these key similarities and differences:

<table>
<thead>
<tr>
<th>Capability</th>
<th>Atomic Subchart</th>
<th>Atomic Subsystem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supports generation of reusable code</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Supports usage as a library link</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
The following examples show how to use atomic subcharts for modeling typical applications:

<table>
<thead>
<tr>
<th>Example</th>
<th>Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>sf_atomic_sensor_pair</td>
<td>A redundant sensor pair</td>
</tr>
<tr>
<td>sf_elevator</td>
<td>An elevator system with two identical lifts</td>
</tr>
</tbody>
</table>

**When to Use Atomic Subcharts**

Consider using atomic subcharts when one or more of these scenarios apply:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Reason for Using Atomic Subcharts</th>
<th>Reference</th>
<th>Tutorial</th>
</tr>
</thead>
<tbody>
<tr>
<td>You want to reuse the same state or subchart many times across different charts or models to facilitate large-scale modeling.</td>
<td>You can store an atomic subchart in a library to enable reuse across different charts and models. When you change an atomic subchart in a library, the change propagates to all links.</td>
<td>“Comparison of Modeling Methods” on page 15-4</td>
<td>“Reuse a State Multiple Times in a Chart” on page 15-42</td>
</tr>
<tr>
<td>You want to use simulation to test your changes, one by one, without recompiling the entire chart.</td>
<td>When you modify an atomic subchart, recompilation occurs for only that object and not the entire chart.</td>
<td>“Comparison of Simulation Methods” on page 15-6</td>
<td>“Reduce the Compilation Time of a Chart” on page 15-51</td>
</tr>
</tbody>
</table>
### Scenario

#### Reason for Using Atomic Subcharts

You want to break a chart into standalone parts because multiple people are working on different parts of the chart.

Because atomic subcharts behave as standalone objects, people can work on different parts of a chart without affecting any work that someone else is doing.

#### Reference

“Comparison of Editing Methods” on page 15-6

#### Tutorial

“Divide a Chart into Separate Units” on page 15-53

You want to inspect Simulink Coder or Embedded Coder generated code manually for a specific part of a chart.

You can specify that code for an atomic subchart appears in a separate file for unit testing.

#### Reference

“Comparison of Code Generation Methods” on page 15-7

#### Tutorial

“Generate Reusable Code for Unit Testing” on page 15-55

### Benefits of Using Atomic Subcharts

- “Comparison of Modeling Methods” on page 15-4
- “Comparison of Simulation Methods” on page 15-6
- “Comparison of Editing Methods” on page 15-6
- “Comparison of Code Generation Methods” on page 15-7

### Comparison of Modeling Methods

The following sections compare two ways of modeling similar states in charts.

**Model without Atomic Subcharts**

You create a separate instance of each state in your chart.
In this chart, the only differences between the two states are the names of variables.

**Model with Atomic Subcharts**

You create a single state and convert it to an atomic subchart, which you store in a new library. From that library, you can copy and paste the atomic subchart for use in any chart. Then update the mapping of inputs, outputs, local data, or parameters as needed.

This modeling method minimizes maintenance of similar states. When you modify the atomic subchart in the library, your changes propagate automatically to the links in all charts and models.

For more information, see “Reuse a State Multiple Times in a Chart” on page 15-42.
Comparison of Simulation Methods

The following sections compare two ways of simulating a chart.

Simulation Without Atomic Subcharts

You make a small change to one part of a chart that contains many states or several levels of hierarchy. When you start simulation to test that change, recompilation occurs for the entire chart.

Because recompiling the entire chart takes a long time, you make several changes before testing. However, if you find an error, you must step through all your changes to identify what causes the error.

Simulation With Atomic Subcharts

You make a small change to an atomic subchart in a chart that contains many states or several levels of hierarchy. When you start simulation to test that change, recompilation occurs only for the atomic subchart.

Incremental builds for simulation decrease the time required to recompile the chart. This reduction enables you to test each change, one by one, instead of waiting to test multiple changes. By testing each change individually, you can quickly identify a change that causes an error.

For more information, see “Reduce the Compilation Time of a Chart” on page 15-51.

Comparison of Editing Methods

The following sections compare two ways of editing a chart.

Edit Without Atomic Subcharts

You edit one part of a chart, while someone else edits another part of the same chart. At submission time, you merge your changes.

Edit With Atomic Subcharts

You store one part of a chart as an atomic subchart in a library. You edit that subchart separately, while someone else edits the main chart. At submission time, no merge is necessary because the changes exist in separate models.

For more information, see “Divide a Chart into Separate Units” on page 15-53.
Comparison of Code Generation Methods

The following sections compare two ways of generating code.

**Code Generation Without Atomic Subcharts**

You generate code for the entire model in one file and look through that entire file to find code for a specific part of the chart.
Code Generation With Atomic Subcharts

You specify code generation parameters so that code for an atomic subchart appears in a separate file. This method of code generation enables unit testing for a specific part of a chart. You can avoid searching through unrelated code and focus only on the part that interests you.
What Is an Atomic Subchart?

```c
/* Function for Stateflow: '<S1>/A' */
void ex_reuse_states_A_during(real_t rtu_u1, real_T *xty_v1,
    rtMW_u ex_reuse_states *localDW)
{
    /* During: Chart/A */
    localDW->isStable = TRUE;
    switch (localDW->is_c2_ex_reuse_states) {
    case ex_reuse_states_IN_Neg:
        /* During 'Neg': '<S2>/1' */
        if (rtu_u1 > 0.0) {
            /* Transition: '<S2>/5' */
            localDW->isStable = FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
            /* Entry 'Pos': '<S2>/6' */
            (*xty_v1) = 1.0;
        }
        break;
    case ex_reuse_states_IN_Pos:
        /* During 'Pos': '<S2>/6' */
        if (rtu_u1 < 0.0) {
            /* Transition: '<S2>/4' */
            localDW->isStable = FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
            /* Entry 'Neg': '<S2>/7' */
            (*xty_v1) = -1.0;
        }
        break;
    default:
        if (rtu_u1 > 0.0) {
            /* Transition: '<S2>/2' */
            localDW->isStable = FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Pos;
            /* Entry 'Pos': '<S2>/6' */
            (*xty_v1) = 1.0;
        } else {
            /* Transition: '<S2>/3' */
            localDW->isStable = FALSE;
            localDW->is_c2_ex_reuse_states = ex_reuse_states_IN_Neg;
            /* Entry 'Neg': '<S2>/7' */
            (*xty_v1) = -1.0;
        }
        break;
    }
}
```
Note Unreachable Stateflow states are optimized out and are not included in the generated code.

For more information, see “Generate Reusable Code for Unit Testing” on page 15-55.
Convert to and from Atomic Subcharts

Convert a State or Subchart to an Atomic Subchart

To convert a state or subchart to an atomic subchart, right-click the object in your chart and select **Group & Subchart > Atomic Subchart**.

After you convert a state or subchart to an atomic subchart, local data appears as data store memory in the atomic subchart.

<table>
<thead>
<tr>
<th>Scope of Data Before Conversion</th>
<th>Scope of Data After Conversion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input</td>
</tr>
<tr>
<td>Output</td>
<td>Output</td>
</tr>
<tr>
<td>Local Data store memory</td>
<td>Parameter</td>
</tr>
<tr>
<td>Parameter</td>
<td>Constant</td>
</tr>
</tbody>
</table>

You cannot convert a chart or state containing a message to an atomic subchart.

An atomic subchart looks opaque like a regular subchart but includes the label **(Atomic)** in the upper-left corner. If you use a linked atomic subchart from a library, the label (Link) appears in the upper-left corner.

For example, the following model contains a chart, Air Controller, that uses an atomic subchart:
In the Air Controller chart, **PowerOn** is an atomic subchart, but **PowerOff** is a regular subchart:
Convert an Atomic Subchart to a State or Subchart

When an Atomic Subchart Is a Library Link

To convert a linked atomic subchart back to a state or subchart:

1. Right-click the atomic subchart and select Library Link > Disable Link.

When an Atomic Subchart Is Not a Library Link

<table>
<thead>
<tr>
<th>To convert an atomic subchart back to...</th>
<th>Follow these steps...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A state</td>
<td>1. Right-click the atomic subchart in your chart and clear the Group &amp; Subchart &gt; Atomic Subchart check box.</td>
</tr>
<tr>
<td></td>
<td>2. Right-click the object again and clear the Group &amp; Subchart &gt; Subchart check box. You might need to rearrange graphical objects in your chart after performing this step.</td>
</tr>
<tr>
<td>A regular subchart</td>
<td>1. Right-click the atomic subchart in your chart and clear the Group &amp; Subchart &gt; Atomic Subchart check box.</td>
</tr>
</tbody>
</table>

Restrictions for Converting an Atomic Subchart to a State or Subchart

In the following cases, converting an atomic subchart to a state or subchart does not work:

- Your atomic subchart uses a MATLAB function and does not map a variable to a variable of the same name in the chart.
- A parameter in the atomic subchart maps to something other than a single variable. For example, the following mappings for a parameter named data1 prevent conversion of an atomic subchart to a state or subchart:
• \( \text{data2} + 3 \)
• \( \text{data2.3} \)
• \( \text{data2(3)} \)
• \( 3 \)

For more information, see “Map Variables for Atomic Subcharts” on page 15-15.
Map Variables for Atomic Subcharts

Edit Mappings for Variables in an Atomic Subchart

To ensure that each variable in your atomic subchart maps to the correct variable in the main chart, edit the mapping on the Mappings tab in the Properties dialog box. For each atomic subchart variable, in the Main chart symbol field, you can type the name of the corresponding variable or select a variable name from the drop-down list. If you leave the Main chart symbol field empty, then Stateflow attempts to map the atomic subchart variable to a main chart variable with the same name.

You can map a variable in the atomic subchart to a variable in the main chart that has a different scope. This table lists the possible mappings.

<table>
<thead>
<tr>
<th>Atomic Subchart Symbol Scope</th>
<th>Main Chart Symbol Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Input, Output, Local, Parameter</td>
</tr>
<tr>
<td>Output</td>
<td>Output, Local</td>
</tr>
<tr>
<td>Parameter</td>
<td>Parameter</td>
</tr>
<tr>
<td>Data Store Memory</td>
<td>Data Store Memory, Local</td>
</tr>
<tr>
<td>Input Event</td>
<td>Input Event</td>
</tr>
</tbody>
</table>

You can map a variable in an atomic subchart to an element of a bus in the main chart.

When you map data store memory in an atomic subchart to local data of enumerated type, you have two options for specifying the initial value of the data store memory:

- In the Data Properties dialog box, set the Initial value field for the chart-level local data.
- To apply the default value of the enumerated type, leave the Initial value field empty.

Map Input and Output Data for an Atomic Subchart

Suppose that you have a model with two Sine Wave blocks that supply input signals to a chart.
Your chart contains two linked atomic subcharts from the same library.

Both atomic subcharts contain these objects.

If you simulate the model, the output for y2 is zero.
Because the symbols in atomic subchart A have the same name as the symbols $u_1$ and $y_1$ in the main chart, they map to the correct variables. The symbols in atomic subchart B do not map to the correct variables $u_2$ and $y_2$ in the main chart, so you must edit the mapping.

1. Right-click subchart B and select **Subchart Mappings**.
The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

**Input Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>y1</td>
</tr>
</tbody>
</table>

**Output Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>y1</td>
</tr>
</tbody>
</table>

**Parameter Mapping**

| Atomic subchart symbol | Main chart symbol |

**Data Store Memory Mapping**

| Atomic subchart symbol | Main chart symbol |

**INPUT_EVENT Mapping**

| Atomic subchart symbol | Main chart symbol |
2  Under **Input Mapping**, specify the main chart symbol for \( u_1 \) to be \( u_2 \).
3  Under **Output Mapping**, specify the main chart symbol for \( y_1 \) to be \( y_2 \).
4  Click **OK**.

When you run the model again, you get these results.

![Scope plot](image)

**Map Data Store Memory for an Atomic Subchart**

Suppose that you have a model with two Sine Wave blocks that supply input signals to a chart.
Your chart contains a linked atomic subchart from a library.

The linked atomic subchart contains these objects.

If you simulate the model, you get an error because the data store memory, ds(\text{m}), does not map to any variable in the main chart. To fix the mapping for ds(\text{m}):

1. Right-click subchart A and select Subchart Mappings.
The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

### Input Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>u1</td>
<td>u1</td>
</tr>
</tbody>
</table>

### Output Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>y1</td>
</tr>
</tbody>
</table>

### Parameter Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### Data Store Memory Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>dsm</td>
<td></td>
</tr>
</tbody>
</table>

### INPUT_EVENT Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>
2 Under **Data Store Memory Mapping**, specify the main chart symbol for `dsm` to be `local_for_atomic_subchart`.

3 Click **OK**.

When you run the model now, you get these results.

---

**Map Parameter Data for an Atomic Subchart**

Suppose that you have a model with two Sine Wave blocks that supply input signals to a chart.
Your chart contains a linked atomic subchart from a library:

The linked atomic subchart contains these objects.

If you simulate the model, you get an error because the parameter \( T \) is undefined. To fix this error, specify an expression for \( T \) to evaluate in the mask workspace of the main chart.
1 Right-click subchart A and select **Subchart Mappings**.
Map Variables for Atomic Subcharts

The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

**Input Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>u1</td>
<td>u1</td>
</tr>
</tbody>
</table>

**Output Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>y1</td>
</tr>
</tbody>
</table>

**Parameter Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>T</td>
<td>T</td>
</tr>
</tbody>
</table>

**Data Store Memory Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**INPUT_EVENT Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2 Under Parameter Mapping, as the value for $T$, enter $0.2$. 
### Map Variables for Atomic Subcharts

#### State A

The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

**Input Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>( u_1 )</td>
<td>( u_1 )</td>
</tr>
</tbody>
</table>

**Output Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>( y_1 )</td>
<td>( y_1 )</td>
</tr>
</tbody>
</table>

**Parameter Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>( T )</td>
<td>0.2</td>
</tr>
</tbody>
</table>

**Data Store Memory Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

**INPUT_EVENT Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>
3  Click **OK**.

When you run the model now, you get these results.

![Scope](image)

**Map Input Events for an Atomic Subchart**

The `sf_yoyo` model contains a Mux block that supplies input events to a chart.
The chart contains two superstates: **Active** and **Inactive**. The **Active** state uses input events to guard transitions between different substates.
To convert the Active state to an atomic subchart:

1. Right-click the Active state and select Group & Subchart > Atomic Subchart.
2. Right-click the atomic subchart and select Subchart Mappings.

Under Input Event Mapping, each atomic subchart symbol maps to the correct input event in the main chart.

The default mappings also follow the rules of using input events in atomic subcharts. For more information, see “Rules for Using Atomic Subcharts” on page 15-37.
The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

### Input Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### Output Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReelState</td>
<td>ReelState</td>
</tr>
</tbody>
</table>

### Parameter Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### Data Store Memory Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### INPUT_EVENT Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lmax</td>
<td>Lmax</td>
</tr>
<tr>
<td>Lmin</td>
<td>Lmin</td>
</tr>
<tr>
<td>ThetaDotZero</td>
<td>ThetaDotZero</td>
</tr>
</tbody>
</table>
3 Click **OK**.

**Disable Input Events for Atomic Subcharts**

To use an instance of a library chart as an atomic subchart, but not the entire saved set of input events, you can disable input events.

1 Right-click the atomic subchart and select **Subchart Mappings**.
2 To disable an input event, under **Input Event Mapping**, select `<disabled>` in the **Main chart symbol** drop-down list.
The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

### Input Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### Output Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReelState</td>
<td>ReelState</td>
</tr>
</tbody>
</table>

### Parameter Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### Data Store Memory Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
</table>

### INPUT_EVENT Mapping

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lmax</td>
<td>&lt;disabled&gt;</td>
</tr>
<tr>
<td>Lmin</td>
<td>&lt;disabled&gt;</td>
</tr>
<tr>
<td>ThetaDotZero</td>
<td>EnergyLow</td>
</tr>
<tr>
<td></td>
<td>Lmax</td>
</tr>
<tr>
<td></td>
<td>Lmin</td>
</tr>
<tr>
<td></td>
<td>ThetaDotZero</td>
</tr>
</tbody>
</table>
3  Click **OK**.

**See Also**

**More About**

- “Convert to and from Atomic Subcharts” on page 15-11
- “Basic Approach for Modeling Event-Driven Systems” on page 4-2
Generate Reusable Code for Atomic Subcharts

In this section...

“How to Generate Reusable Code for Linked Atomic Subcharts” on page 15-35
“How to Generate Reusable Code for Unlinked Atomic Subcharts” on page 15-36

How to Generate Reusable Code for Linked Atomic Subcharts

To specify code generation parameters for linked atomic subcharts from the same library:

1. Open the library model that contains your atomic subchart.
2. Unlock the library.
3. Right-click the library chart and select Block Parameters.
4. In the dialog box, specify the following parameters:
   a. On the Main tab, select Treat as atomic unit.
   b. On the Code Generation tab, set Function packaging to Reusable function.
   c. Set File name options to User specified.
   d. For File name, enter the name of the file with no extension.
   e. Click OK to apply the changes.
5. (OPTIONAL) Customize the generated function names for atomic subcharts:
   a. Open the Model Configuration Parameters dialog box.
   c. Navigate to the Code Generation > Symbols pane.
   d. For Subsystem methods, specify the format of the function names using a combination of the following tokens:
      • $R — root model name
      • $F — type of interface function for the atomic subchart
      • $N — block name
      • $H — subsystem index
      • $M — name-mangling text
e  Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for linked atomic subcharts from the same library.

**How to Generate Reusable Code for Unlinked Atomic Subcharts**

To specify code generation parameters for an unlinked atomic subchart:

1  In your chart, right-click the atomic subchart and select Properties.
2  In the dialog box, specify the following parameters:
   a  Set Code generation function packaging to Reusable function.
   b  Set Code generation file name options to User specified.
   c  For Code generation file name, enter the name of the file with no extension.
   d  Click OK to apply the changes.
3  (OPTIONAL) Customize the generated function names for atomic subcharts:
   a  Open the Model Configuration Parameters dialog box.
   b  On the Code Generation pane, set System target file to ert.tlc.
   c  Navigate to the Code Generation > Symbols pane.
   d  For Subsystem methods, specify the format of the function names using a combination of the following tokens:
      • $R — root model name
      • $F — type of interface function for the atomic subchart
      • $N — block name
      • $H — subsystem index
      • $M — name-mangling text
   e  Click OK to apply the changes.

When you generate code for your model, a separate file stores the code for the atomic subchart. For more information, see “Generate Reusable Code for Unit Testing” on page 15-55.
Rules for Using Atomic Subcharts

**Define data in an atomic subchart explicitly**

Be sure to define data that appears in an atomic subchart explicitly in the main chart. For instructions on how to define data in a chart, see “Add Data Through the Model Explorer” on page 9-3.

**Map variables of linked atomic subcharts**

When you use linked atomic subcharts, map the variables so that data in the subchart corresponds to the correct data in the main chart. Map subchart variables manually if, when you add the subchart, the variables do not have the same names as the corresponding symbols in the main chart. For more information, see “Map Variables for Atomic Subcharts” on page 15-15.

**Match size, type, and complexity of variables in linked atomic subcharts**

Verify that the size, type, and complexity of variables in a subchart match the settings of the corresponding variables in the main chart. For more information, see “Map Variables for Atomic Subcharts” on page 15-15.

**Export chart-level functions if called from an atomic subchart**

If your atomic subchart contains a function call to a chart-level function, export that function by selecting **Export Chart Level Functions**. Do not export graphical functions from an atomic subchart that maps variables to variables at the main chart level with a different scope. For more information, see “Export Stateflow Functions for Reuse” on page 8-28.

**Do not mix edge-triggered and function-call input events in the same atomic subchart**

Input events in an atomic subchart must all use edge-triggered type, or they must all use function-call type. This restriction is consistent with the behavior for the container chart. For more information, see “Best Practices for Using Events in Stateflow Charts” on page 10-42.

**Do not map multiple input events in an atomic subchart to the same input event in the container chart**

Each input event in an atomic subchart must map to a unique input event in the container chart. You can verify unique mappings of input events by opening the properties dialog.
box for the atomic subchart and checking the **Input Event Mapping** section of the **Mappings** tab.

**Do not log signals from atomic subcharts that map variables with different scopes**

If an atomic subchart maps variables to variables at the main chart level with a different scope, you cannot log signals for the chart.

**Match the trigger type when mapping input events**

Each input event in an atomic subchart must map to an input event of the same trigger type in the container chart.

**Do not use atomic subcharts in continuous-time Stateflow charts**

Continuous-time charts do not support atomic subcharts.

**Do not use Moore charts as atomic subcharts**

Moore charts do not have the same simulation behavior as Classic Stateflow charts with the same constructs.

**Do not use outgoing transitions when an atomic subchart uses top-level local events**

You cannot use outgoing transitions from an atomic subchart that uses local events at the top level of the subchart. Using this configuration causes a simulation error.

**Avoid using execute-at-initialization with atomic subcharts**

You get a warning when the following conditions are true:

- The chart property **Execute (enter) Chart At Initialization** is enabled.
- The default transition path of the chart reaches an atomic subchart.

If an entry action inside the atomic subchart requires access to a chart input or data store memory, you might get inaccurate results. To avoid this warning, you can disable **Execute (enter) Chart At Initialization** or redirect the default transition path away from the atomic subchart.

For more information about execute-at-initialization behavior, see “Execution of a Chart at Initialization” on page 3-44.
Avoid using the names of subsystem parameters in atomic subcharts

If a parameter in an atomic subchart matches the name of a Simulink built-in subsystem parameter, the only mapping allowed for that parameter is Inherited. Specifying any other parameter mapping in the Mappings tab of the properties dialog box causes an error. You can, however, change the parameter value at the MATLAB prompt so that all instances of that parameter have the same value.

To get a list of Simulink subsystem parameters, enter:

```matlab
param_list = sort(fieldnames(get_param('built-in/subsystem', 'ObjectParameters')));
```

Restrict use of machine-parented data

If your chart contains atomic subcharts, do not use machine-parented data with the following properties:

- Imported or exported
- Is 2-D or higher, or uses fixed-point type

Machine-parented data with these properties prevent reuse of generated code and other code optimizations.

Do not change the first index of local data to a nonzero value

When a data store memory in an atomic subchart maps to chart-level local data, the First index property of the local data must remain zero. If you change First index to a nonzero value, an error occurs when you try to update the diagram.

Use consistent settings for super-step semantics

When you use linked atomic subcharts, verify that your settings for super-step semantics match the settings in the main chart. For more information, see “Super Step Semantics” on page 3-75.

Restrictions for Converting to Atomic Subcharts

Rationale for Restrictions

Atomic subcharts facilitate the reuse of states and subcharts as standalone objects.
Data, Graphical Functions, and Events

To convert a state or subchart to an atomic subchart, access to objects not parented by the state or subchart must be one of the following:

- Chart-level data
- Chart-level graphical functions
- Input events

If the state or subchart accesses a chart-level graphical function, the chart must export that function. For more information, see “Export Stateflow Functions for Reuse” on page 8-28.

Do not export graphical functions from an atomic subchart that maps variables to variables at the main chart level with a different scope.

Event Broadcasts

The state or subchart that you want to convert to an atomic subchart cannot refer to:

- Local events that are outside the scope of that state or subchart
- Output events

The state or subchart you want to convert can refer to input events.

Local Data with a Nonzero First Index

The state or subchart that you want to convert to an atomic subchart cannot access local data where the First index property is nonzero. For the conversion process to work, the First index property of the local data must be zero, which is the default value.

Machine-Parented Data

The state or subchart that you want to convert to an atomic subchart cannot reside in a chart that uses machine-parented data with the following properties:

- Imported or exported
- Is 2-D or higher, or uses a fixed-point type

Machine-parented data with these properties prevent reuse of generated code and other code optimizations.
Strong Data Typing with Simulink Inputs and Outputs

To convert a state or subchart to an atomic subchart, your chart must use strong data typing with Simulink inputs and outputs.

To specify strong data typing:

1. Open the Chart properties dialog box.
2. Select **Use Strong Data Typing with Simulink I/O**. This option appears only for charts that use C as the action language.
3. Click **OK** to close the dialog box.

Supertransitions

The state or subchart that you want to convert to an atomic subchart cannot have any supertransitions crossing the boundary.

Masked Library Chart

You cannot use a masked library chart containing mask parameters as an atomic subchart.
Reuse a State Multiple Times in a Chart

Goal of the Tutorial

Assume that you have the following model:

The top Sine Wave block uses a frequency of 1 radian per second, and the bottom Sine Wave block uses a frequency of 2 radians per second. The blocks use the same amplitude (1) and phase shift (0).

In the chart, each state uses saturator logic to convert the input sine wave to an output square wave of the same frequency. The states perform the same actions and differ only in the names of input and output data:
When you run the model, you get the following results:
Suppose that you want to reuse the contents of state A in the chart. You can convert that state to an atomic subchart and then use multiple linked instances of that subchart in your chart.

**Edit a Model to Use Atomic Subcharts**

The sections that follow describe how to replace states in your chart with atomic subcharts. This procedure enables reuse of the same object in your model while retaining the same simulation results.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Change one of the states into an atomic subchart.</td>
<td>“Convert a State to an Atomic Subchart” on page 15-45</td>
</tr>
<tr>
<td>2</td>
<td>Create a library that contains this atomic subchart.</td>
<td>“Create a Library for the Atomic Subchart” on page 15-45</td>
</tr>
</tbody>
</table>
### Convert a State to an Atomic Subchart

To convert state A to an atomic subchart, right-click the state and select **Group & Subchart > Atomic Subchart**. State A changes to an atomic subchart:

![Atomic Subchart Diagram]

### Create a Library for the Atomic Subchart

To enable reuse of the atomic subchart you created in “Convert a State to an Atomic Subchart” on page 15-45, store the atomic subchart in a library:

1. Create a new library model.
2. Copy the atomic subchart and paste in your library.
The atomic subchart appears as a standalone chart with an input and an output. This standalone property enables you to reuse the contents of the atomic subchart.

3  Save your library model.

**Replace States with Linked Atomic Subcharts**

To replace the states in your chart with linked atomic subcharts:

1  Delete both states from the chart.
2  Copy the atomic subchart in your library and paste in your chart twice.
3  Rename the second instance as B.

Each linked atomic subchart appears opaque and contains the label **Link** in the upper-left corner.

**Edit the Mapping of Input and Output Variables**

If you simulate the model now, the output for y2 is zero:
You also see warnings about unused data. These warnings appear because atomic subchart B uses $u_1$ and $y_1$ instead of $u_2$ and $y_2$. To fix these warnings, you must edit the mapping of input and output variables:

1. Open the properties dialog box for B.
2. Click the **Mappings** tab.
The following tables list the mappings from the subchart symbols (on the left) to the symbols in the main chart (on the right). For every subchart symbol, the drop-down provides the list of available symbols which that subchart symbol can map to.

**Input Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>u1</td>
<td>u1</td>
</tr>
</tbody>
</table>

**Output Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>y1</td>
</tr>
</tbody>
</table>

**Parameter Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Data Store Memory Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**INPUT_EVENT Mapping**

<table>
<thead>
<tr>
<th>Atomic subchart symbol</th>
<th>Main chart symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
3  Under **Input Mapping**, select u2 from the drop-down list.

The input variable in your atomic subchart now maps to the correct input variable in the main chart.

4  Under **Output Mapping**, select y2 from the drop-down list.

The output variable in your atomic subchart now maps to the correct output variable in the main chart.

5  Click **OK**.

**Run the New Model**

When you simulate the new model, the results match those of the original design.

---

**Propagate a Change in the Library Chart**

Suppose that you edit the transition from Pos to Neg in the library chart:
This change propagates to all linked atomic subcharts in your main chart. You do not have to update each state individually.
Reduce the Compilation Time of a Chart

Goal of the Tutorial

Assume that you have the following model, and the chart has two states:

Suppose that you want to reduce the compilation time of the chart for simulation. You can convert state A to an atomic subchart. Then you can make changes, one by one, to state A and see how each change affects simulation results. Making one change requires recompilation of only the atomic subchart and not the entire chart.
Edit a Model to Use Atomic Subcharts

1. Right-click state A and select Group & Subchart > Atomic Subchart.
2. Double-click the atomic subchart.

   The contents of the subchart appear in a separate window.

   Side-by-side animation for the main chart and the atomic subchart occurs.
4. In the atomic subchart, change the state action for Pos to y1 = 2.
5. Restart simulation.

   Recompilation occurs only for the atomic subchart and not the entire chart.
Divide a Chart into Separate Units

Goal of the Tutorial

Assume that you have the following model, and the chart has two states:

Suppose that you want to edit state A separately, while someone else is editing state B. You can convert state A to an atomic subchart for storage in a library model. After replacing state A with a linked atomic subchart, you can make changes separately in the
library. These changes propagate automatically to the chart that contains the linked atomic subchart.

**Edit a Model to Use Atomic Subcharts**

1. Right-click state A and select **Group & Subchart** > **Atomic Subchart**.
2. Create a new library model.
3. Copy the atomic subchart and paste in your library.
4. Save your library model.
5. In your main chart, delete state A.
6. Copy the atomic subchart in your library and paste in your main chart.

You can now edit state A separately from state B without any merge issues.
Generate Reusable Code for Unit Testing

In this section...

“Goal of the Tutorial” on page 15-55
“Convert a State to an Atomic Subchart” on page 15-56
“Specify Code Generation Parameters” on page 15-57
“Generate Code for Only the Atomic Subchart” on page 15-58

Goal of the Tutorial

Assume that you have the following model, and the chart has two states:
Suppose that you want to generate reusable code so that you can perform unit testing on state A. You can convert that part of the chart to an atomic subchart and then specify a separate file to store the generated code.

**Convert a State to an Atomic Subchart**

To convert state A to an atomic subchart, right-click the state and select **Group & Subchart > Atomic Subchart.** State A changes to an atomic subchart:
Specify Code Generation Parameters

Set Up a Standalone C File for the Atomic Subchart

1. Open the properties dialog box for A.
2. Set **Code generation function packaging** to **Reusable function**.
3. Set **Code generation file name options** to **User specified**.
4. For **Code generation file name**, enter **saturator** as the name of the file.
5. Click **OK**.

Set Up the Code Generation Report

1. Open the Model Configuration Parameters dialog box.
2. In the **Code Generation** pane, set **System target file** to **ert.tlc**.
3. In the **Code Generation > Report** pane, select **Create code generation report**.

This step automatically selects **Open report automatically** and **Code-to-model**.
Select **Model-to-code**.

Click **Apply**.

**Customize the Generated Function Names**

1. In the Model Configuration Parameters dialog box, go to the Code Generation > **Symbols** pane.

2. Set **Subsystem methods** to the format scheme $R$N$M$F, where:
   - $R$ is the root model name.
   - $N$ is the block name.
   - $M$ is the mangle token.
   - $F$ is the type of interface function for the atomic subchart.

   For more information, see “Subsystem methods” (Simulink Coder).

3. Click **Apply**.

**Generate Code for Only the Atomic Subchart**

To generate code for your model, press **Ctrl+B**. In the code generation report that appears, you see a separate file that contains the generated code for the atomic subchart.

To inspect the code for `saturator.c`, click the hyperlink in the report to see the following code:
Line 28 shows that the `during` function generated for the atomic subchart has the name `ex_reuse_states_A_during`. This name follows the format scheme `$R$N$M$F` specified for **Subsystem methods**:

- `$R$` is the root model name, `ex_reuse_states`.
- `$N$` is the block name, `A`.
- `$M$` is the mangle token, which is empty.
- `$F$` is the type of interface function for the atomic subchart, `during`.

**Note** The line numbers shown can differ from the numbers that appear in your code generation report.
Save and Restore Simulations with SimState

- “What Is a SimState?” on page 16-2
- “Benefits of Using a Snapshot of the Simulation State” on page 16-4
- “Divide a Long Simulation into Segments” on page 16-5
- “Test a Unique Chart Configuration” on page 16-10
- “Test a Chart with Fault Detection and Redundant Logic” on page 16-19
- “Methods for Interacting with the SimState of a Chart” on page 16-33
- “Rules for Using the SimState of a Chart” on page 16-36
- “Best Practices for Saving the SimState of a Chart” on page 16-39
What Is a SimState?

A SimState is the snapshot of the state of a model at a specific time during simulation. For a Stateflow chart, a SimState includes the following information:

- Activity of chart states
- Values of chart local data
- Values of chart output data
- Values of persistent data in MATLAB functions and Truth Table blocks

A SimState lists chart objects in hierarchical order:

- Graphical objects grouped by type (box, function, or state) and in alphabetical order within each group
- Chart data grouped by scope (block output or local) and in alphabetical order within each group

For example, the following SimState illustrates the hierarchical structure of chart objects.

```plaintext

c =

Block:    "shift_logic"    (handle)    (active)
Path:     sf_car/shift_logic

Contains:

  + gear_state         "State (AND)"          (active)
  + selection_state    "State (AND)"          (active)
    gear               "State output data"    gearType [1, 1]
    down_th            "Local scope data"     double [1, 1]
    up_th              "Local scope data"     double [1, 1]
```

The tree structure maps graphical and nongraphical objects to their respective locations in the chart hierarchy. If name conflicts exist, one or more underscores appear at the end of a name so that all objects have unique identifiers in the SimState hierarchy.

**Note** Stateless flow charts have an empty SimState, because they do not contain states or persistent data.
For information about using a SimState for other blocks in a Simulink model, see “Save and Restore Simulation State as SimState” (Simulink).
Benefits of Using a Snapshot of the Simulation State

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Division of a Long Simulation into Segments” on page 16-4</td>
</tr>
<tr>
<td>“Test of a Chart Response to Different Settings” on page 16-4</td>
</tr>
</tbody>
</table>

**Division of a Long Simulation into Segments**

You can save the complete simulation state of a model at any time during a long simulation. Then you can load that simulation state and run specific segments of that simulation without starting from time \( t = 0 \), which saves time.

For directions, see “Divide a Long Simulation into Segments” on page 16-5.

**Test of a Chart Response to Different Settings**

You can load and modify the simulation state of a chart to test the response to different settings. You can change the value of chart local or output data midway through a simulation or change state activity and then test how a chart responds.

Loading and modifying the simulation state provides these benefits:

- Enables testing of a hard-to-reach chart configuration by loading a specific simulation state, which promotes thorough testing
- Enables testing of the same chart configuration with different settings, which promotes reuse of a simulation state

For directions, see:

- “Test a Unique Chart Configuration” on page 16-10
- “Test a Chart with Fault Detection and Redundant Logic” on page 16-19
Divide a Long Simulation into Segments

In this section...

“Goal of the Tutorial” on page 16-5
“Define the SimState” on page 16-6
“Load the SimState” on page 16-7
“Simulate the Specific Segment” on page 16-8

Goal of the Tutorial

Suppose that you want to simulate the sf_boiler model without starting from \( t = 0 \).

This model simulates for 1400 seconds, but the output that interests you occurs sometime between \( t = 400 \) and 600. You can simulate the model, save the SimState at time \( t = 400 \), and then load that SimState for simulation between \( t = 400 \) and 600.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define the SimState for your chart.</td>
<td>“Define the SimState” on page 16-6</td>
</tr>
<tr>
<td>2</td>
<td>Load the SimState for your chart.</td>
<td>“Load the SimState” on page 16-7</td>
</tr>
<tr>
<td>3</td>
<td>Simulate the specific segment.</td>
<td>“Simulate the Specific Segment” on page 16-8</td>
</tr>
</tbody>
</table>
Define the SimState

1 Open the model.

Type sf_boiler at the command prompt.

2 Enable saving of a SimState.

   a Open the Model Configuration Parameters dialog box and go to the Data Import/Export pane.
   b Select the Final states check box.
   c Enter a name, such as sf_boiler_ctx01.
   d Select the Save complete SimState in final state check box.
   e Click Apply.

Programmatic equivalent

You can programmatically enable saving of a SimState:

```matlab
set_param('sf_boiler','SaveFinalState','on', ...
'FinalStateName', ['sf_boiler_ctx01'], ...
'SaveCompleteFinalSimState','on');
```

For details about setting model parameters, see `set_param`.

3 Define the start and stop times for this simulation segment.

   a In the Model Configuration Parameters dialog box, go to the Solver pane.
   b For Start time, enter 0.
   c For Stop time, enter 400.
   d Click OK.

Programmatic equivalent

You can programmatically set the start and stop times:

```matlab
set_param('sf_boiler','StartTime','0', ...
'StopTime','400');
```

4 Start simulation.

When you simulate the model, you save the complete simulation state at t = 400 in the variable sf_boiler_ctx01 in the MATLAB base workspace.
5 Disable saving of a SimState.

This step prevents you from overwriting the SimState you saved in the previous step.

a Open the Model Configuration Parameters dialog box and go to the Data Import/Export pane.
b Clear the Save complete SimState in final state check box.
c Clear the Final states check box.
d Click OK.

Programmatic equivalent

You can programmatically disable saving of a SimState:

```matlab
set_param('sf_boiler','SaveCompleteFinalSimState','off', ... 'SaveFinalState','off');
```

Load the SimState

1 Enable loading of a SimState.

a Open the Model Configuration Parameters dialog box and go to the Data Import/Export pane.
b Select the Initial state check box.
c Enter the variable that contains the SimState of your chart: sf_boiler_ctx01.
d Click Apply.

Programmatic equivalent

You can programmatically enable loading of a SimState:

```matlab
set_param('sf_boiler','LoadInitialState','on', ... 'InitialState', ['sf_boiler_ctx01']);
```

2 Define the new stop time for this simulation segment.

a In the Model Configuration Parameters dialog box, go to the Solver pane.
b For Stop time, enter 600.
c Click OK.
You do not need to enter a new start time because the simulation continues from where it left off.

**Programmatic equivalent**

You can programmatically set the new stop time:

```matlab
set_param('sf_boiler','StopTime','600');
```

**Simulate the Specific Segment**

When you simulate the model, the following output appears in the Scope block.
Divide a Long Simulation into Segments
Test a Unique Chart Configuration

Goal of the Tutorial

Suppose that you want to test the response of the old_sf_car model to a sudden change in value for gear.

This model simulates for 30 seconds, but you want to see what happens when the value of gear changes at $t = 10$. You can simulate the model, save the SimState at $t = 10$, load and modify the SimState, and then simulate again between $t = 10$ and 20.
<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define the SimState for your chart.</td>
<td>“Define the SimState” on page 16-11</td>
</tr>
<tr>
<td>2</td>
<td>Load the SimState and modify values.</td>
<td>“Load the SimState and Modify Values” on page 16-13</td>
</tr>
<tr>
<td>3</td>
<td>Test the modified SimState by running the model.</td>
<td>“Test the Modified SimState” on page 16-17</td>
</tr>
</tbody>
</table>

**Define the SimState**

1. Open the model.

   Type `old_sf_car` at the command prompt.

2. Enable saving of a SimState.

   a. Open the Model Configuration Parameters dialog box and go to the Data Import/Export pane.
   b. Select the Final states check box.
   c. Enter a name, such as `old_sf_car_ctx01`.
   d. Select the Save complete SimState in final state check box.
   e. Click Apply.

**Programmatic equivalent**

You can programmatically enable saving of a SimState:

```matlab
set_param('old_sf_car','SaveFinalState','on', ... 'FinalStateName', ['old_sf_car_ctx01'], ... 'SaveCompleteFinalSimState','on');
```

For details about setting model parameters, see `set_param`.

3. Define the start and stop times for this simulation segment.

   a. In the Model Configuration Parameters dialog box, go to the Solver pane.
   b. For Start time, enter 0.
   c. For Stop time, enter 10.
   d. Click OK.
Programmatic equivalent

You can programmatically set the start and stop times:

```matlab
set_param('old_sf_car','StartTime','0', ...
'SтопTime','10');
```

4 Start simulation.

When you simulate the model, you save the complete simulation state at $t = 10$ in the variable `old_sf_car_ctx01` in the MATLAB base workspace.

At $t = 10$, the engine is operating at a steady-state value of 2500 RPM.

5 Disable saving of a SimState.

This step prevents you from overwriting the SimState you saved in the previous step.
a Open the Model Configuration Parameters dialog box and go to the **Data Import/Export** pane.

b Clear the **Save complete SimState in final state** check box.

c Clear the **Final states** check box.

d Click **OK**.

**Programmatic equivalent**

You can programmatically disable saving of a SimState:

```matlab
set_param('old_sf_car','SaveCompleteFinalSimState','off', ...
'SaveFinalState','off');
```

### Load the SimState and Modify Values

1 Enable loading of a SimState.

   a Open the Model Configuration Parameters dialog box and go to the **Data Import/Export** pane.

   b Select the **Initial state** check box.

   c Enter the variable that contains the SimState of your chart:
     
     ```matlab
     old_sf_car_ctx01
     ```

   d Click **OK**.

**Programmatic equivalent**

You can programmatically enable loading of a SimState:

```matlab
set_param('old_sf_car','LoadInitialState','on', ...
'InitialState', ['old_sf_car_ctx01']);
```

2 Define an object handle for the SimState values of the `shift_logic` chart.

At the command prompt, type:

```matlab
blockpath = 'old_sf_car/shift_logic';
c = old_sf_car_ctx01.getBlockSimState(blockpath);
```

**Tip** If the chart appears highlighted in the model window, you can specify the block path using `gcb`:
c = old_sf_car_ctx01.getBlockSimState(gcb);

**What does the getBlockSimState method do?**

The `getBlockSimState` method:

- Makes a copy of the SimState of your chart, which is stored in the final state data of the model.
- Provides a root-level handle or *reference* to the copy of the SimState, which is a hierarchical tree of graphical and nongraphical chart objects.

Each node in this tree is also a handle to a state, data, or other chart object.

**Note** Because the entire tree consists of object handles, the following assignment statements do not work:

- `stateCopy = c.state`
- `dataCopy = c.data`
- `simstateCopy = c`

These assignments create copies of the object handles, not SimState values. The only way to copy SimState values is to use the `clone` method. For details, see “Methods for Interacting with the SimState of a Chart” on page 16-33 and “Rules for Using the SimState of a Chart” on page 16-36.

3 Look at the contents of the SimState.

```
c = old_sf_car_ctx01.getBlockSimState(gcb);

Block:    "shift_logic"    (handle)    (active)
Path:     old_sf_car/shift_logic
Contains:
  + gear_state         "State (AND)"          (active)
  + selection_state    "State (AND)"          (active)
    gear               "Block output data"    double [1, 1]
```

The SimState of your chart contains a list of states and data in hierarchical order.
Highlight the states that are active in your chart at t = 10.

At the command prompt, type:

```
c.highlightActiveStates;
```

In the chart, all active states appear highlighted.

**Tip** To check if a single state is active, you can use the `isActive` method. For example, type:

```
c.gear_state.fourth.isActive
```

This command returns true (1) when a state is active and false (0) otherwise. For information on other methods, see “Methods for Interacting with the SimState of a Chart” on page 16-33.

Change the active substate of `selection_state` to `downshifting`.

Use this command:

```
c.selection_state.downshifting.setActive;
```
The newly active substate appears highlighted in the chart.

6 Change the value of output data `gear`.

When you type `c.gear` at the command prompt, you see a list of data properties similar to this:

```matlab
>> c.gear
ans =

    Description: 'Block output data'
    DataType: 'double'
      Size: '[1, 1]'  
    Range: [1x1 struct]
   InitialValue: [1x0 double]
    Value: 4
```

You can change the value of `gear` from 4 to 1 by typing

```matlab
c.gear.Value = 1;
```
However, you cannot change the data type or size of `gear`. Also, you cannot specify a new value that falls outside the range set by the **Minimum** and **Maximum** parameters. For details, see “Rules for Modifying Data Values” on page 16-36.

7 Save the modified SimState.

Use this command:

```matlab
old_sf_car_ctx01 = old_sf_car_ctx01.setBlockSimState(blockpath, c);
```

**Test the Modified SimState**

1 Define the new stop time for the simulation segment to test.
   a In the Model Configuration Parameters dialog box, go to the **Solver** pane.
   b For **Stop time**, enter 20.
   c Click **OK**.

You do not need to enter a new start time because the simulation continues from where it left off.

**Programmatic equivalent**

You can programmatically set the stop time:

```matlab
set_param('old_sf_car','StopTime','20');
```

2 Start simulation.

The engine reacts as follows:
Test a Chart with Fault Detection and Redundant Logic

In this section...

“Goal of the Tutorial” on page 16-19
“Define the SimState” on page 16-22
“Modify SimState Values for One Actuator Failure” on page 16-23
“Test the SimState for One Failure” on page 16-27
“Modify SimState Values for Two Actuator Failures” on page 16-30
“Test the SimState for Two Failures” on page 16-31

Goal of the Tutorial

Suppose that you want to test the response of the sf_aircraft model to one or more actuator failures in an elevator system. (For details of how this model works, see the description for Modeling Fault Management Control Logic in an Aircraft Elevator Control System.)

The Mode Logic chart monitors the status of actuators for two elevators. Each elevator has an outer (primary) actuator and an inner (secondary) actuator. In normal operation, the outer actuators are active and the inner actuators are on standby.
When the four actuators are working correctly, the left and right elevators reach steady-state positions in 3 seconds.
Suppose that you want to see what happens at \( t = 3 \) when at least one actuator fails. You can simulate the model, save the SimState at \( t = 3 \), load and modify the SimState, and then simulate again between \( t = 3 \) and 10.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define the SimState for your chart.</td>
<td>“Define the SimState” on page 16-22</td>
</tr>
</tbody>
</table>
Define the SimState

1. Open the model.
   Type `sf_aircraft` at the command prompt.

2. Enable saving of a SimState.
   a. Open the Model Configuration Parameters dialog box and go to the Data Import/Export pane.
   b. Select the Final states check box.
   c. Enter a name, such as `xFinal`.
   d. Select the Save complete SimState in final state check box.
   e. Click Apply.

Programmatic equivalent

You can programmatically enable saving of a SimState:

```matlab
set_param('sf_aircraft','SaveFinalState','on', ...
          'FinalStateName', 'xFinal', ... 
          'SaveCompleteFinalSimState','on');
```

For details about setting model parameters, see `set_param`.

3. Define the stop time for this simulation segment.
   a. In the Model Configuration Parameters dialog box, go to the Solver pane.
   b. For Stop time, enter 3.
c  Click OK.

**Programmatic equivalent**

You can programmatically set the stop time:

```matlab
set_param('sf_aircraft','StopTime','3');
```

4  Start simulation.

When you simulate the model, you save the complete simulation state at \( t = 3 \) in the variable `xFinal` in the MATLAB base workspace.

5  Disable saving of a SimState.

This step prevents you from overwriting the SimState you saved in the previous step.

a  Open the Model Configuration Parameters dialog box and go to the **Data Import/Export** pane.

b  Clear the **Save complete SimState in final state** check box.

c  Clear the **Final states** check box.

d  Click OK.

**Programmatic equivalent**

You can programmatically disable saving of a SimState:

```matlab
set_param('sf_aircraft','SaveCompleteFinalSimState','off','SaveFinalState','off');
```

### Modify SimState Values for One Actuator Failure

1  Enable loading of a SimState.

a  Open the Model Configuration Parameters dialog box and go to the **Data Import/Export** pane.

b  Select the **Initial state** check box.

c  Enter the variable that contains the SimState of your chart: `xFinal`.

d  Click OK.
**Programmatic equivalent**

You can programmatically enable loading of a SimState:

```matlab
set_param('sf_aircraft','LoadInitialState','on', ... 'InitialState', ['xFinal']);
```

1. Define an object handle for the SimState values of the Mode Logic chart.

   At the command prompt, type:

   ```matlab
   blockpath = 'sf_aircraft/Mode Logic';
   c = xFinal.getBlockSimState(blockpath);
   ```

   **Tip** If the chart appears highlighted in the model window, you can specify the block path using `gcb`:

   ```matlab
   c = xFinal.getBlockSimState(gcb);
   ```

**What does the getBlockSimState method do?**

The `getBlockSimState` method:

- Makes a copy of the SimState of your chart, which is stored in the final state data of the model.
- Provides a root-level handle or *reference* to the copy of the SimState, which is a hierarchical tree of graphical and nongraphical chart objects.

  Each node in this tree is also a handle to a state, data, or other chart object.

**Note** Because the entire tree consists of object handles, the following assignment statements do not work:

- `stateCopy = c.state`
- `dataCopy = c.data`
- `simstateCopy = c`

These assignments create copies of the object handles, not SimState values. The only way to copy SimState values is to use the `clone` method. For details, see “Methods
for Interacting with the SimState of a Chart” on page 16-33 and “Rules for Using the SimState of a Chart” on page 16-36.

3 Look at the contents of the SimState.

\[ c = \]

Block: "Mode Logic" (handle) (active)
Path: sf_aircraft/Mode Logic

Contains:

+ Actuators    "State (OR)" (active)
+ LI_act       "Function"
+ LO_act       "Function"
+ L_switch     "Function"
+ RI_act       "Function"
+ RO_act       "Function"
+ R_switch     "Function"
+ LI_mode      "State output data" sf_aircraft_ModeType [1,1]
+ LO_mode      "State output data" sf_aircraft_ModeType [1,1]
+ RI_mode      "State output data" sf_aircraft_ModeType [1,1]
+ RO_mode      "State output data" sf_aircraft_ModeType [1,1]

The SimState of your chart contains a list of states, functions, and data in hierarchical order.

4 Highlight the states that are active in your chart at \( t = 3 \).

At the command prompt, type:

\[ c \text{.highlightActiveStates;} \]

Active states appear highlighted. By default, the two outer actuators are active and the two inner actuators are on standby.
Tip To check if a single state is active, you can use the `isActive` method. For example, type:

```matlab
c.Actuators.LI.L1.Standby.isActive
```

This command returns true (1) when a state is active and false (0) otherwise. For information on other methods, see “Methods for Interacting with the SimState of a Chart” on page 16-33.

5 Change the state activity in the chart to reflect one actuator failure.

Assume that the left outer (LO) actuator fails. To change the state, use this command:

```matlab
c.Actuators.LO.Isolated.setActive;
```
The newly active substate appears highlighted in the chart.

![Stateflow chart image]

The `setActive` method ensures that the chart exits and enters the appropriate states to maintain state consistency. However, the method does not perform entry actions for the newly active substate. Similarly, the method does not perform exit actions for the previously active substate.

6 Save the modified SimState by using this command:

```java
xFinal = xFinal.setBlockSimState(blockpath, c);
```

**Test the SimState for One Failure**

1 Define the new stop time for the simulation segment to test.
a  Go to the Solver pane of the Model Configuration Parameters dialog box.

b  For Stop time, enter 10.

c  Click OK.

You do not need to enter a new start time because the simulation continues from where it left off.

**Programmatic equivalent**

You can programmatically set the stop time:

```matlab
set_param('sf_aircraft','StopTime','10');
```

2 Start simulation.

Chart animation shows that the other three actuators react appropriately to the failure of the left outer (LO) actuator.
This actuator...  Switches from...  Because...

Left inner (LI)  Standby to active  The left elevator must compensate for the left outer (LO) actuator failure.

Right inner (RI)  Standby to active  The same hydraulic line connects to both inner actuators.

Right outer (RO)  Active to standby  Only one actuator per elevator can be active.

Both elevators continue to maintain steady-state positions.
Modify SimState Values for Two Actuator Failures

1. Change the state activity in the chart to reflect two actuator failures.

Assume that the left inner (LI) actuator also fails. To change the state, use this command:
c.Actuators.LI.Isolated.setActive;

2 Save the modified SimState by using this command:

\[ x\text{Final} = x\text{Final}.\text{setBlockSimState}(\text{blockpath, } c); \]

**Test the SimState for Two Failures**

1 In the Model Configuration Parameters dialog box, verify that the stop time is 10.

2 Restart simulation.

Because of failures in both actuators, the left elevator stops working. The right elevator maintains a steady-state position.
If you modify the SimState of your chart to test the response of the right elevator to actuator failures, you get similar results.
Methods for Interacting with the SimState of a Chart

You can use the following methods to interact with the SimState of a chart. Assume that `ch` is a handle to the SimState of your chart, which you obtain using the `getBlockSimState` method.

<table>
<thead>
<tr>
<th>Type of Object</th>
<th>Method</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>All chart objects</td>
<td>open</td>
<td>For graphical objects, highlights the object in the Stateflow Editor. For nongraphical objects, highlights the object in the Model Explorer.</td>
<td><code>ch.data.open</code></td>
</tr>
</tbody>
</table>

**Note** For persistent data in MATLAB functions, this method opens the function editor and highlights the persistent data at the exact line in the script.
<table>
<thead>
<tr>
<th>Type of Object</th>
<th>Method</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart</td>
<td>checkStateConsistency</td>
<td>Verifies that all states in a chart are consistent.</td>
<td>\texttt{ch.checkStateConsistency}</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If a state is inactive, no substates are active.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If a state with parallel decomposition is active, all substates are active.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If a state with exclusive decomposition is active, only one substate is active.</td>
<td></td>
</tr>
<tr>
<td>Chart</td>
<td>clone</td>
<td>Copies the entire chart simulation state to a new variable.</td>
<td>\texttt{newSimState = ch.clone}</td>
</tr>
<tr>
<td>Chart</td>
<td>highlightActiveStates</td>
<td>Highlights all active states in the Stateflow Editor.</td>
<td>\texttt{ch.highlightActiveStates}</td>
</tr>
<tr>
<td>Chart</td>
<td>isStateConsistent</td>
<td>Returns true (1) if all states pass a consistency check and false (0) otherwise.</td>
<td>\texttt{ch.isStateConsistent}</td>
</tr>
<tr>
<td>Type of Object</td>
<td>Method</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>----------------</td>
<td>----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Chart</td>
<td>removeHighlighting</td>
<td>Removes all highlighting in the Stateflow Editor.</td>
<td><code>ch.removeHighlighting</code></td>
</tr>
<tr>
<td>State</td>
<td>isActive</td>
<td>Returns true (1) if a state is active and false (0) otherwise.</td>
<td><code>ch.state.isActive</code></td>
</tr>
<tr>
<td>State</td>
<td>setActive</td>
<td>Sets a state to be active. This method ensures that no other exclusive states at that level are active.</td>
<td><code>ch.state.substate.setActive</code></td>
</tr>
<tr>
<td>State</td>
<td>getPrevActiveChild</td>
<td>Returns the previously active substate.</td>
<td><code>ch.state.getPrevActiveChild</code></td>
</tr>
<tr>
<td>State</td>
<td>setPrevActiveChild</td>
<td>Sets the previously active substate.</td>
<td><code>ch.state.setPrevActiveChild('B')</code></td>
</tr>
</tbody>
</table>

**Note** The argument must be the name of a substate (in quotes), or the full SimState path to a substate (without quotes).
Rules for Using the SimState of a Chart

In this section...

“Limitations on Values You Can Modify” on page 16-36
“Rules for Modifying Data Values” on page 16-36
“Rules for Modifying State Activity” on page 16-37
“Restriction on Continuous-Time Charts” on page 16-37
“No Partial Loading of a SimState” on page 16-38
“Restriction on Copying SimState Values” on page 16-38
“SimState Limitations That Apply to All Blocks in a Model” on page 16-38

Limitations on Values You Can Modify

A SimState does not include information about these elements:

• Machine-parented data
• Persistent data in custom C code
• Persistent data in external MATLAB code

Therefore, you cannot modify the values of those elements.

Rules for Modifying Data Values

These rules apply when you modify data values:

• You cannot change the data type or size. Scalar data must remain scalar. Vector and matrix data must keep the same dimensions. The only exception to this rule is Stateflow data of ml type (see “ml Data Type” on page 12-43 for details).
• For enumerated data types, you can choose only enumerated values from the type definition. For other data types, new values must fall within the range that you specify in the Minimum and Maximum parameters.
• Use one-based indexing to define rows and columns of a matrix.

Suppose that you want to change the value of an element in a 21-by-12 matrix. To modify the element in the first row and second column, type:
c.state_name.data_name.Value(1,2) = newValue;

Rules for Modifying State Activity

These rules apply when you use the setActive method on an exclusive (OR) leaf state:

- State-parented local data does not reinitialize.
- The newly active state does not execute any entry actions. Similarly, the previously active state does not execute any exit actions.

If you want these state actions to occur, you must execute them separately. For example, if your state actions assign values to data, you must assign the values explicitly.

- The setActive method tries to maintain state consistency by:
  - Updating state activity for parent, grandparent, and sibling states
  - Resetting temporal counters for newly active states
  - Updating values of state output data (read-only)
  - Enabling or disabling function-call subsystems and Simulink functions that bind to states

- The highlightActiveStates method also executes when these conditions are true:
  - The model is open.
  - The chart is visible.
  - The highlightActiveStates method has executed at least once, but not the removeHighlighting method.

Restriction on Continuous-Time Charts

After you load a SimState for a continuous-time chart, you can restart simulation from a nonzero time. However, you cannot modify the state activity or any data values, because the SimState for a continuous-time chart is read-only. For more information, see “Summary of Rules for Continuous-Time Modeling” on page 20-21.
No Partial Loading of a SimState

When you load a SimState, the complete simulation state is available as a variable in the MATLAB base workspace. You cannot perform partial loading of a SimState for a subset of chart objects.

Restriction on Copying SimState Values

Use the clone method to copy an entire SimState to a new variable (see “Methods for Interacting with the SimState of a Chart” on page 16-33). You cannot copy a subset of SimState values, because the clone method works only at the chart level.

Suppose that you obtain a handle to the SimState of your chart using these commands:

```matlab
blockpath = 'model/chart';
c = xFinal.getBlockSimState(blockpath);
```

Assignment statements such as

```matlab
stateCopy = c.state,
dataCopy = c.data,
simstateCopy = c
```

do not work. These assignments create copies of object handles, not SimState values.

SimState Limitations That Apply to All Blocks in a Model

For a list of SimState limitations that apply to all blocks in a Simulink model, see “Limitations of SimState” (Simulink).
Best Practices for Saving the SimState of a Chart

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Use MAT-Files to Save a SimState for Future Use” on page 16-39</td>
</tr>
<tr>
<td>“Use Scripts to Save SimState Commands for Future Use” on page 16-39</td>
</tr>
</tbody>
</table>

Use MAT-Files to Save a SimState for Future Use

To save a SimState from the MATLAB base workspace, save the variable with final state data in a MAT-file.

For example, type at the command prompt:

```
save('sf_car_ctx01.mat', 'sf_car_ctx01')
```

For more information, see `save` in the MATLAB documentation.

Use Scripts to Save SimState Commands for Future Use

To save a list of SimState commands for future use, copy them from a procedure and paste them in a MATLAB script.

For example, to reuse the commands in “Divide a Long Simulation into Segments” on page 16-5, you can store them in a script named `sf_boiler_simstate_commands.m`:

```
% Load the model.
sf_boiler;

% Set parameters to save the SimState at the desired time.
set_param('sf_boiler','SaveFinalState','on','FinalStateName','sf_boiler_ctx01','SaveCompleteFinalSimState','on');

% Specify the start and stop times for the simulation segment.
set_param('sf_boiler','StartTime','0','StopTime','400');

% Simulate the model.
sim('sf_boiler');

% Disable saving of the SimState to avoid overwriting.
set_param('sf_boiler','SaveCompleteFinalSimState','off', ...
'SaveFinalState','off');

% Load the SimState.
set_param('sf_boiler', 'LoadInitialState', 'on', ...
'InitialState', [ 'sf_boiler_ctx01']);

% Specify the new stop time for the simulation segment.
set_param('sf_boiler', 'StopTime', '600');

% Simulate the model.
sim('sf_boiler');
Vectors and Matrices in Stateflow Charts

- “How Vectors and Matrices Work in Stateflow Charts” on page 17-2
- “Define Vectors and Matrices in Stateflow” on page 17-4
- “Scalar Expansion for Converting Scalars to Nonscalars” on page 17-6
- “Assign and Access Stateflow Vector and Matrix Values” on page 17-8
- “Operations For Vectors and Matrices in Stateflow Charts” on page 17-11
- “Rules for Vectors and Matrices in Stateflow Charts” on page 17-13
- “Best Practices for Vectors and Matrices in Stateflow Charts” on page 17-14
- “Find Pattern in Data Transmission Using Vectors” on page 17-17
- “Calculate Motion Using Matrices” on page 17-19
How Vectors and Matrices Work in Stateflow Charts

In this section...

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>“When to Use Vectors and Matrices”</td>
<td>17-2</td>
</tr>
<tr>
<td>“Where You Can Use Vectors and Matrices”</td>
<td>17-2</td>
</tr>
</tbody>
</table>

When to Use Vectors and Matrices

Use vectors and matrices when you want to:

- Process multidimensional input and output signals
- Combine separate scalar data into one signal

For examples, see “Find Pattern in Data Transmission Using Vectors” on page 17-17 and “Calculate Motion Using Matrices” on page 17-19.

Where You Can Use Vectors and Matrices

You can define vectors and matrices at these levels of the Stateflow hierarchy:

- Charts
- Subcharts
- States
- Functions

You can use vectors and matrices to define:

- Input data
- Output data
- Local data
- Function inputs
- Function outputs

You can also use vectors and matrices as arguments for:

- State actions
• Transition actions
• MATLAB functions
• Truth table functions
• Graphical functions
• Simulink functions
• Change detection operators

For more information, see “Operations For Vectors and Matrices in Stateflow Charts” on page 17-11 and “Rules for Vectors and Matrices in Stateflow Charts” on page 17-13.
Define Vectors and Matrices in Stateflow

In this section...

“Define a Vector” on page 17-4
“Define a Matrix” on page 17-4

Define a Vector

Define a vector in a Stateflow chart as follows:

1. Add data to your chart as described in “Add Stateflow Data” on page 9-2.
2. In the General pane of the Data properties dialog box, enter the dimensions of the vector in the Size field.

   For example, enter [4 1] to specify a 4-by-1 vector.
3. Specify the name, base type, and other properties for the new data.

   Note Vectors cannot have the base type ml. See “Rules for Vectors and Matrices in Stateflow Charts” on page 17-13.
4. Set initial values for the vector:
   - If initial values of all elements are the same, enter a real number in the Initial value field. This value applies to all elements of a vector of any size.
   - If initial values differ, enter real numbers in the Initial value field. For example, you can enter:

     [1; 3; 5; 7]

   Tip If you want to initialize all elements of a vector to 0, do nothing. When no values are explicitly defined, all elements initialize to 0.
5. Click Apply.

Define a Matrix

Define a matrix in a Stateflow chart as follows:
1 Add data to your chart as described in “Add Stateflow Data” on page 9-2.

2 In the **General** pane of the Data properties dialog box, enter the dimensions of the matrix in the **Size** field.

   For example, enter \([3 \ 3]\) to specify a 3-by-3 matrix.

3 Specify the name, base type, and other properties for the new data.

   **Note** Matrices cannot have the base type \(m\). See “Rules for Vectors and Matrices in Stateflow Charts” on page 17-13.

4 Set initial values for the matrix.

   - If initial values of all elements are the same, enter a real number in the **Initial value** field. This value applies to all elements of a matrix of any size.
   - If initial values differ, enter real numbers in the **Initial value** field. For example, you can enter:

     \[
     \begin{bmatrix}
     1 & 2 & 3 \\
     4 & 5 & 6 \\
     7 & 8 & 9 \\
     \end{bmatrix}
     \]

   **Tip** If you want to initialize all elements of a matrix to 0, do nothing. When no values are explicitly defined, all elements initialize to 0.

5 Click **Apply**.
Scalar Expansion for Converting Scalars to Nonscalars

<table>
<thead>
<tr>
<th>In this section...</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“What Is Scalar Expansion?” on page 17-6</td>
<td></td>
</tr>
<tr>
<td>“How Scalar Expansion Works for Functions” on page 17-6</td>
<td></td>
</tr>
</tbody>
</table>

What Is Scalar Expansion?

Scalar expansion is a method of converting scalar data to match the dimensions of vector or matrix data. For example, scalar expansion can convert a value of 1 to a vector or matrix where all the elements are 1.

How Scalar Expansion Works for Functions

Suppose that you have a function signature \( y = \text{example}(u) \), where the formal arguments \( y \) and \( u \) are scalars. Assume that you have a function call \( y = \text{example}(u) \). The rules of scalar expansion for function calls with a single output follow.

<table>
<thead>
<tr>
<th>If the output ( y ) is a...</th>
<th>And the input ( u ) is a...</th>
<th>Then...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scalar</td>
<td>Scalar</td>
<td>No scalar expansion occurs.</td>
</tr>
<tr>
<td>Vector or matrix</td>
<td>Scalar</td>
<td>Scalar expansion occurs for ( \text{example}(u) ) to match the dimensions of ( y ).</td>
</tr>
<tr>
<td>Vector or matrix</td>
<td>Vector or matrix</td>
<td>Scalar expansion occurs so that ( y[i] = \text{example}(u[i]) ).</td>
</tr>
<tr>
<td>Scalar</td>
<td>Vector or matrix</td>
<td>An error message alerts you to a size mismatch.</td>
</tr>
</tbody>
</table>

For functions with multiple outputs, the same rules apply except for the case where the outputs and inputs of the function call are all vectors or matrices. In this case, scalar expansion does not occur, and an error message alerts you to a size mismatch.

The rules of scalar expansion apply to all functions that you use in Stateflow charts:

- MATLAB functions
• Graphical functions
• Simulink functions
• Truth table functions
Assign and Access Stateflow Vector and Matrix Values

In this section...

“Notation for Vectors and Matrices” on page 17-8
“Assign and Access Values of Vectors” on page 17-8
“Assign and Access Values of Matrices” on page 17-9
“Assign Values of a Vector or Matrix Using Scalar Expansion” on page 17-9

Notation for Vectors and Matrices

Index notation for vectors and matrices in a Stateflow chart differs from the notation you use in a MATLAB script. You use zero-based indexing for each dimension of a vector or matrix in a chart that uses C as the action language. However, you use one-based indexing in a MATLAB script.

<table>
<thead>
<tr>
<th>To refer to...</th>
<th>In a C chart, use...</th>
<th>In a MATLAB script, use...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The first element of a vector test</td>
<td>test[0]</td>
<td>test(1)</td>
</tr>
<tr>
<td>The (i^{th}) element of a vector test</td>
<td>test[i-1]</td>
<td>test(i)</td>
</tr>
<tr>
<td>The element in row 4 and column 5 of a matrix test</td>
<td>test[3][4]</td>
<td>test(4,5)</td>
</tr>
<tr>
<td>The element in row (i) and column (j) of a matrix test</td>
<td>test[i-1][j-1]</td>
<td>test(i,j)</td>
</tr>
</tbody>
</table>

Assign and Access Values of Vectors

The following examples show how to assign the value of an element in a vector in a Stateflow chart.

<table>
<thead>
<tr>
<th>If you enter...</th>
<th>You assign the value...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>test[0] = 10;</td>
<td>10</td>
<td>The first element</td>
</tr>
<tr>
<td>test[i] = 77;</td>
<td>77</td>
<td>The ((i+1)^{th}) element</td>
</tr>
</tbody>
</table>
The following examples show how to access the value of an element in a vector in a Stateflow chart.

<table>
<thead>
<tr>
<th>If you enter...</th>
<th>You access the value of...</th>
</tr>
</thead>
<tbody>
<tr>
<td>old = test[1];</td>
<td>The second element of a vector test</td>
</tr>
<tr>
<td>new = test[i+5];</td>
<td>The ((i+6))th element of a vector test</td>
</tr>
</tbody>
</table>

**Assign and Access Values of Matrices**

The following examples show how to assign the value of an element in a matrix in a Stateflow chart.

<table>
<thead>
<tr>
<th>If you enter...</th>
<th>You assign the value...</th>
<th>To the element in...</th>
</tr>
</thead>
<tbody>
<tr>
<td>test[0][8] = 10;</td>
<td>10</td>
<td>Row 1, column 9</td>
</tr>
<tr>
<td>test[i][j] = 77;</td>
<td>77</td>
<td>Row (i+1), column (j+1)</td>
</tr>
</tbody>
</table>

The following examples show how to access the value of an element in a matrix in a Stateflow chart.

<table>
<thead>
<tr>
<th>If you enter...</th>
<th>You access the value of...</th>
</tr>
</thead>
<tbody>
<tr>
<td>old = test[1][8];</td>
<td>The matrix test in row 2, column 9</td>
</tr>
<tr>
<td>new = test[i][j];</td>
<td>The matrix test in row (i+1), column (j+1)</td>
</tr>
</tbody>
</table>

**Assign Values of a Vector or Matrix Using Scalar Expansion**

You can use scalar expansion in a Stateflow chart to set all elements of a vector or matrix to the same value. This method works for a vector or matrix of any size.

This action sets all elements of a vector to 10.

```matlab
test_vector = 10;
```

This action sets all elements of a matrix to 20.

```matlab
test_matrix = 20;
```
**Note** You cannot use scalar expansion on a vector or matrix in the MATLAB base workspace. If you try to use scalar expansion, the vector or matrix in the base workspace converts to a scalar.
Operations For Vectors and Matrices in Stateflow Charts

In this section...

“Binary Operations” on page 17-11
“Unary Operations and Actions” on page 17-11
“Assignment Operations” on page 17-12

Binary Operations

You can perform element-wise binary operations on vector and matrix operands of equal dimensions in the following order of precedence (1 = highest, 3 = lowest). For operations with equal precedence, they evaluate in order from left to right.

<table>
<thead>
<tr>
<th>Example</th>
<th>Precedence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a * b</td>
<td>1</td>
<td>Multiplication</td>
</tr>
<tr>
<td>a / b</td>
<td>1</td>
<td>Division</td>
</tr>
<tr>
<td>a + b</td>
<td>2</td>
<td>Addition</td>
</tr>
<tr>
<td>a - b</td>
<td>2</td>
<td>Subtraction</td>
</tr>
<tr>
<td>a == b</td>
<td>3</td>
<td>Comparison, equality</td>
</tr>
<tr>
<td>a != b</td>
<td>3</td>
<td>Comparison, inequality</td>
</tr>
</tbody>
</table>

The multiplication and division operators in a Stateflow chart perform element-wise operations, not standard matrix multiplication and division. For more information, see “Perform Matrix Multiplication and Division Using MATLAB Functions” on page 17-14.

Unary Operations and Actions

You can perform element-wise unary operations and actions on vector and matrix operands.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>~a</td>
<td>Unary minus</td>
</tr>
<tr>
<td>!a</td>
<td>Logical NOT</td>
</tr>
</tbody>
</table>
Example | Description
--- | ---
a++ | Increments all elements of the vector or matrix by 1
a-- | Decrements all elements of the vector or matrix by 1

**Assignment Operations**

You can perform element-wise assignment operations on vector and matrix operands.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
a = expression | Simple assignment |
a += expression | Equivalent to \( a = a + \text{expression} \) |
a -= expression | Equivalent to \( a = a - \text{expression} \) |
a *= expression | Equivalent to \( a = a \times \text{expression} \) |
a /= expression | Equivalent to \( a = a / \text{expression} \) |
Rules for Vectors and Matrices in Stateflow Charts

These rules apply when you use vectors and matrices in Stateflow charts.

Use only operands of equal dimensions for element-wise operations

If you try to perform element-wise operations on vectors or matrices with unequal dimensions, a size mismatch error appears when you simulate your model. See “Operations For Vectors and Matrices in Stateflow Charts” on page 17-11.

Do not define vectors and matrices with ml base type

If you define a vector or matrix with ml base type, an error message appears when you try to simulate your model. This base type supports only scalar data.

For more information about this type, see “ml Data Type” on page 12-43.

Use only real numbers to set initial values of vectors and matrices

When you set the initial value for an element of a vector or matrix, use a real number. If you use a complex number, an error message appears when you try to simulate your model.

Note You can set values of vectors and matrices to complex numbers after initialization.

Do not use vectors and matrices with temporal logic operators

You cannot use a vector or matrix as an argument for temporal logic operators, because time is a scalar quantity.
Best Practices for Vectors and Matrices in Stateflow Charts

In this section...

“Perform Matrix Multiplication and Division Using MATLAB Functions” on page 17-14
“Index a Vector Using the temporalCount Operator” on page 17-15

Perform Matrix Multiplication and Division Using MATLAB Functions

In a Stateflow chart, the multiplication and division operators perform element-wise multiplication and division. Use a MATLAB function to perform standard matrix multiplication and division.

For example, suppose that you want to perform standard matrix operations on two square matrices during simulation. Follow these steps:

1. In your chart, add a MATLAB function with the following signature:

   \[ \text{[y1, y2, y3]} = \text{my_matrix_ops(u1, u2)} \]

2. Double-click the function box to open the editor.

3. In the editor, enter the code below.

   ```matlab
   function \text{[y1, y2, y3]} = \text{my_matrix_ops(u1, u2)}
   \%#codegen
   \n   y1 = u1 * u2;  % matrix multiplication
   y2 = u1 \ u2;  % matrix division from the right
   y3 = u1 / u2;  % matrix division from the left
   ```

   This function computes three values:

   - \( y_1 \) is the product of two input matrices \( u_1 \) and \( u_2 \).
   - \( y_2 \) is the matrix that solves the equation \( u_1 \times y_2 = u_2 \).
   - \( y_3 \) is the matrix that solves the equation \( y_3 \times u_1 = u_2 \).

4. Set properties for the input and output data.
Open the Model Explorer.
In the Model Hierarchy pane, navigate to the level of the MATLAB function.
In the Contents pane, set properties for each data object.

Note To initialize a matrix, see “Define a Matrix” on page 17-4.

Index a Vector Using the temporalCount Operator

When you index a vector, you can use the temporalCount operator to avoid using an extra variable for the index counter. This indexing method works for vectors that contain real or complex data.

For example, suppose that you want to collect input data in a buffer during simulation. Follow these steps:

1. Add this state to your Stateflow chart.

```
Collect_Data
//store first element
entry: y[0] = u;
//index v values into vector
during: y[temporalCount(tick)] = u;
```

The state Collect_Data stores data in the vector y, which is of size 10. The entry action assigns the value of input data u to the first element of y. The during action assigns the next nine values of input data to successive elements of the vector y until you store ten elements.

2. Add the input data u to the chart.
   a. In the Stateflow Editor, select Chart > Add Inputs & Outputs > Data Input From Simulink.
   b. In the Data properties dialog box, enter u in the Name field.
   c. Click OK.

3. Add the output data y to the chart.
a In the Stateflow Editor, select **Chart > Add Inputs & Outputs > Data Output To Simulink**.

b In the Data properties dialog box, enter *y* in the **Name** field.

c Enter **10** in the **Size** field.

d Click **OK**.

**Note** You do not need to set initial values for this output vector. By default, all elements initialize to 0.

For information about the **temporalCount** operator, see “Control Chart Execution Using Temporal Logic” on page 12-55.
Find Pattern in Data Transmission Using Vectors

The model `sf_frame_sync_controller` is an example of using a vector in a Stateflow chart to find a fixed pattern in a data transmission.

For details of how the chart works, see “Detect Valid Transmission Data Using Frame Synchronization” on page 22-19.
Storage of Complex Data in a Vector

The state get_payload stores complex data in the vector frame, which is of size 221. The entry action assigns the value of \((IQ \cdot \text{phasor})\) to the first element of frame. The during action assigns the next 220 values of \((IQ \cdot \text{phasor})\) to successive elements of frame until you store 221 elements. (For more information, see “Index a Vector Using the temporalCount Operator” on page 17-15.)

Scalar Expansion of a Vector

In the second outgoing transition of the state look_for_sync, the transition action frame = 0 resets all elements of the vector frame to 0 via scalar expansion. (For more information, see “Assign Values of a Vector or Matrix Using Scalar Expansion” on page 17-9.)
Calculate Motion Using Matrices

The model `sf_pool` is an example of using matrices in a Stateflow chart to simulate the opening shot on a pool table.

How the Model Works

The model consists of the following blocks.

<table>
<thead>
<tr>
<th>Model Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Init chart</td>
<td>Initializes the position and velocity of the cue ball.</td>
</tr>
<tr>
<td>Pool chart</td>
<td>Calculates the two-dimensional dynamics of each ball on the pool table.</td>
</tr>
<tr>
<td>Plot block</td>
<td>Animates the motion of each ball during the opening shot.</td>
</tr>
<tr>
<td>Vel scope</td>
<td>Displays the velocity of each ball during the opening shot.</td>
</tr>
<tr>
<td>Clock</td>
<td>Provides the instantaneous simulation time to the Plot block.</td>
</tr>
</tbody>
</table>

Storage of Two-Dimensional Data in Matrices

To simulate the opening shot, the Pool chart stores two-dimensional data in matrices.
<table>
<thead>
<tr>
<th>To store values for</th>
<th>The Pool chart uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>The instantaneous position of each ball</td>
<td>The 15-by-2 matrix ( \mathbf{p} )</td>
</tr>
<tr>
<td>The instantaneous velocity of each ball</td>
<td>The 15-by-2 matrix ( \mathbf{v} )</td>
</tr>
<tr>
<td>Friction and interaction forces acting on each ball</td>
<td>The 15-by-2 matrix ( \mathbf{v}_{\text{dot}} )</td>
</tr>
<tr>
<td>Boolean data on whether any two balls are in contact</td>
<td>The 15-by-15 matrix ( \mathbf{ball}_{\text{interaction}} )</td>
</tr>
</tbody>
</table>

**Calculation of Two-Dimensional Dynamics of Each Ball**

The Pool chart calculates the motion of each ball on the pool table using MATLAB functions that perform matrix calculations.
MATLAB Function

frictionForce

Calculates the friction force acting on each ball.

MATLAB Function

initBalls

TotalDynamics
du:
// derivatives
p_dot = v;
v_.dot = frictionForce() + interactionForce();
// chart outputs
p_out = p;
v_out = v;
pocketed_out = pocketed;

// MATLAB Function

yn = isAnyBallOutOfBounds

MATLAB Function

f = interactionForce

MATLAB Function

ball = getBallInteraction

MATLAB Function

resetBallsPosAndVel

MATLAB Function

yn = hasBallInteractionChanged

MATLAB Function

yn = nearHole(pp)

MATLAB Function

yn = isAnyBallNewlyPocketed

MATLAB Function

updateStopFlags

MATLAB Function

f = frictionForce

MATLAB Function

isAnyBallGoingToStop

updateStopFlags();

MATLAB Function

hasBallInteractionChanged();

ball_interaction = getBallInteraction();

updateStopFlags();

MATLAB Function

isAnyBallNewlyPocketed();

pocketNewBalls();

updateStopFlags();

MATLAB Function

isAnyBallOutOfBounds();

resetBallsPosAndVel();

updateStopFlags();
### MATLAB Function

<table>
<thead>
<tr>
<th>MATLAB Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>getBallInteraction</td>
<td>Returns a matrix of Boolean data on whether any two balls are in contact.</td>
</tr>
<tr>
<td>hasBallInteractionChanged</td>
<td>Returns 1 if ball interactions have changed and 0 otherwise.</td>
</tr>
<tr>
<td>initBalls</td>
<td>Initializes the position and velocity of every ball on the pool table.</td>
</tr>
<tr>
<td>interactionForce</td>
<td>Calculates the interaction force acting on each ball.</td>
</tr>
<tr>
<td>isAnyBallGoingToStop</td>
<td>Returns 1 if any ball has stopped moving and 0 otherwise.</td>
</tr>
<tr>
<td>isAnyBallNewlyPocketed</td>
<td>Returns 1 if any ball has been newly pocketed and 0 otherwise.</td>
</tr>
<tr>
<td>isAnyBallOutOfBounds</td>
<td>Returns true if any ball is out of bounds and false otherwise.</td>
</tr>
<tr>
<td>nearHole</td>
<td>Returns true if a ball is near a pocket on the pool table and false otherwise.</td>
</tr>
<tr>
<td>pocketNewBalls</td>
<td>Sets the velocity of a ball to 0 if it has been pocketed.</td>
</tr>
<tr>
<td>resetBallsPosAndVel</td>
<td>Resets the position and velocity of any ball that is out of bounds.</td>
</tr>
<tr>
<td>updateStopFlags</td>
<td>Keeps track of which balls have stopped moving.</td>
</tr>
</tbody>
</table>

### Run the Model

To run the model, follow these steps:

1. Type `sf_pool` at the MATLAB command prompt.
2. Start simulation.
3. Click anywhere in the animated pool table to specify the initial position of the cue ball.
4 Click a different spot to specify the initial velocity of the cue ball.

5 Watch the balls move across the pool table.
Variable-Size Data in Stateflow Charts

• “What Is Variable-Size Data?” on page 18-2
• “How Charts Implement Variable-Size Data” on page 18-3
• “Enable Support for Variable-Size Data” on page 18-4
• “Declare Variable-Size Inputs and Outputs” on page 18-5
• “Compute Output Based on Size of Input Signal” on page 18-7
• “Rules for Using Variable-Size Data in Stateflow Charts” on page 18-15
What Is Variable-Size Data?

Variable-size data is data whose size can change at run time. By contrast, fixed-size data is data whose size is known and locked at compile time and, therefore, cannot change at run time.
How Charts Implement Variable-Size Data

Stateflow charts exchange variable-size data with other charts and blocks in their models through MATLAB functions, Simulink functions, and MATLAB truth tables.

You pass variable-size data to these functions as chart-level inputs and outputs from state actions and transition logic. However, you must perform all computations with variable-size data inside the functions, not directly in states or transitions.

For more information about the functions that interact with variable-size, chart-level inputs and outputs, see:

- “MATLAB Functions in a Chart” on page 27-2
- “Simulink Functions in Stateflow” on page 28-2
- “MATLAB Truth Tables” on page 26-4
Enable Support for Variable-Size Data

Support for variable-size data is enabled by default. To modify this option for individual charts:

1. Right-click an open area of the chart and select Properties.
   
   The Chart properties dialog box opens.

2. Select or clear the Support variable-size arrays check box.

After enabling support at the chart level, declare your variable-size inputs and outputs.
Declare Variable-Size Inputs and Outputs

1. In the Stateflow Editor, select Chart > Add Inputs & Outputs > Data Input From Simulink or Chart > Add Inputs & Outputs > Data Output To Simulink.

The Data properties dialog box opens.

2. Select the Variable size check box.

3. Set Scope as Input or Output.

4. Enter size:

<table>
<thead>
<tr>
<th>Data</th>
<th>What to Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input</td>
<td>Enter -1 to inherit size from Simulink or specify the explicit size and upper bound.</td>
</tr>
<tr>
<td></td>
<td>For example, enter [2 4] to specify a 2-D matrix where the upper bounds are 2 for the first dimension and 4 for the second.</td>
</tr>
<tr>
<td>Output</td>
<td>Specify the explicit size and upper bound.</td>
</tr>
</tbody>
</table>

For example:
Compute Output Based on Size of Input Signal

In this section...

“About the Model” on page 18-7
“Chart: VarSizeSignalSource” on page 18-8
“Chart: size_based_processing” on page 18-11
“Simulate the Model” on page 18-14

About the Model

The model sf_varsize_example shows how MATLAB functions in Stateflow charts exchange variable-size data with other charts and blocks in the model. To open the model, type sf_varsize_example at the MATLAB command prompt.

In this model, one Stateflow chart, VarSizeSignalSource, uses temporal logic to generate a variable-size signal. A second chart, size_based_processing, computes the output based on the size of the signal generated by the first chart:
Chart: VarSizeSignalSource

The VarSizeSignalSource chart works like a source block. It has no input and one variable-size output y:
For variable-size outputs, you must explicitly specify the size and upper bound for each dimension. In this case, $y$ is a vector where the first dimension is assumed to be fixed at size 1 and the second dimension is variable with an upper bound of 16.

This chart uses temporal logic to transition between three states, each generating a different size output:
How the Chart Works with the Variable-Size Output

No states or transitions can read from or write to variable-size data. Therefore, \( y \) does not appear in any state actions or transition logic. All computations involving variable-size data must occur in MATLAB functions in the chart.

How the MATLAB Function Works with the Variable-Size Output

MATLAB functions access variable-size, chart-level data directly. You do not pass the data as inputs or outputs to the functions. In this chart, the `generateOutput` function adds a different number of elements to the variable-size output \( y \), based on how the active state calls it. The function constructs the variable-size vector from a number sequence, then outputs the transpose of the result:

```matlab
function generateOutput(len)
    %#codegen
    assert(len<=16);
    y = (1:len)';
```

MATLAB functions must be able to determine the upper bounds of variable-size data at compile time. In this case, however, the upper bound is \( len \), an input for which the model computes the value at run time. To provide this information, the `assert` function specifies an explicit upper bound for \( len \), one that matches the upper bound for chart output \( y \).

If you do not include the `assert` statement, you get a compilation error:

```
Computed maximum size is not bounded.
Static memory allocation requires all sizes to be bounded.
The computed size is [1 x :?].
```
**Chart: size_based_processing**

The `size_based_processing` chart computes a variable-size output based on the value of a variable-size input:

- **Input** $u$ is the variable-size signal generated by the `VarSizeSignalSource` chart:

  ![Data u dialog box](image)

- **Output** $y$ is a variable-size signal whose size depends on whether $u$ is a scalar or vector:
The chart uses three MATLAB functions to evaluate the size of input $u$ and generate an associated output $y$:
As in the chart `VarSizeSignalSource`, variable-size data does not appear in state actions or transition logic. Instead, states call MATLAB functions to compute the variable-size output. Transitions call a MATLAB function in a conditional statement to evaluate the variable-size input.

**MATLAB Function: is_scalar_input**

This function tests whether chart input `u`, the signal generated by chart `VarSizeSignalSource`, is a scalar or vector value:

```matlab
function isScalar = is_scalar_input
    isScalar = length(u)==1;
```

**MATLAB Function: compute_input**

If input `u` is a vector, this function outputs the sine of each of its values:

```matlab
function compute_output
    y = sin(u);
```

**MATLAB Function: reset_output**

If input `u` is a scalar, this function outputs a value of zero:

```matlab
function reset_output
    y = 0;
```
Simulate the Model

1. Open the model:
   
   ```
   sf_varsize_example
   ```

2. Open the chart `VarSizeSignalSource`, but keep the Simulink display blocks in view.

3. Start simulation from the chart.

   The display blocks periodically show 1, 8, and 16 values from the variable-size vector.
Rules for Using Variable-Size Data in Stateflow Charts

- Declare variable-size data as chart inputs and outputs only, not as local data.
  
  See “Declare Variable-Size Inputs and Outputs” on page 18-5.

- Perform all computations with variable-size data in MATLAB functions, Simulink functions, and truth tables that use MATLAB as the action language.

- Do not perform computations with variable-size data directly in states or transitions.

  You can pass the data as inputs and outputs to MATLAB and Simulink functions in your chart from state actions and transition logic. MATLAB functions can also access the chart-level, variable-size data directly (see “Compute Output Based on Size of Input Signal” on page 18-7).
Enumerated Data in Charts

- “Reference Values by Name by Using Enumerated Data” on page 19-2
- “Define Enumerated Data Types” on page 19-5
- “Best Practices for Using Enumerated Data” on page 19-9
- “Assign Enumerated Values in a Chart” on page 19-14
- “Model Media Player by Using Enumerated Data” on page 19-19
Reference Values by Name by Using Enumerated Data

To enhance the readability of a Stateflow chart, use enumerated data. With enumerated data, you can:

- Create a restricted set of values and refer to those values by name.
- Group related values into separate data types.
- Avoid defining a long list of constants.

Example of Enumerated Data

An enumerated data type is a finite collection of enumerated values consisting of a name and an underlying integer value. For example, this chart uses enumerated data to refer to a set of colors.

![Stateflow chart](image)

The enumerated data output is restricted to a finite set of values. You can refer to these values by their names: Red, Yellow, and Green.

<table>
<thead>
<tr>
<th>Enumerated Value</th>
<th>Name</th>
<th>Integer Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red(0)</td>
<td>Red</td>
<td>0</td>
</tr>
<tr>
<td>Yellow(1)</td>
<td>Yellow</td>
<td>1</td>
</tr>
<tr>
<td>Green(2)</td>
<td>Green</td>
<td>2</td>
</tr>
</tbody>
</table>

This MATLAB file defines the enumerated data type BasicColors referenced by the chart.
classdef BasicColors < Simulink.IntEnumType
    enumeration
        Red(0)
        Yellow(1)
        Green(2)
    end
end

Computation with Enumerated Data

An enumerated data type does not function as a numeric type despite the existence of the underlying integer values. You cannot use enumerated values directly in a mathematical computation. You can use enumerated data to control chart behavior based on assignments and comparisons. To assign or compare enumerated data, use the operations listed in this table.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a = exp</td>
<td>Assignment of a to exp, which must evaluate to an enumerated value</td>
</tr>
<tr>
<td>a == b</td>
<td>Comparison, equality</td>
</tr>
<tr>
<td>a != b</td>
<td>Comparison, inequality</td>
</tr>
</tbody>
</table>

Notation for Enumerated Values

To refer to an enumerated value, use prefixed or nonprefixed identifiers.

Prefixed Identifiers

To prevent name conflicts when referring to enumerated values in Stateflow charts, you can use prefixed identifiers of the form Type.Name. Type is an enumerated data type and Name is an enumerated value name. For example, suppose that you define three data types (Colors, Temp, and Code) that contain the enumerated name Red. By using prefixed notation, you can distinguish Colors.Red from Temp.Red and Code.Red.

Nonprefixed Identifiers

To minimize identifier length when referring to unique enumerated values, you can use nonprefixed enumerated value names. For example, suppose that the enumerated name Red belongs only to the data type Colors. You can then refer to this value with the nonprefixed identifier Red.
If your chart uses data types that contain identical enumerated names (such as Colors.Red and Temp.Red), use prefixed identifiers to prevent name conflicts.

**Where to Use Enumerated Data**

Use enumerated data at these levels of the Stateflow hierarchy:

- Chart
- Subchart
- State

Use enumerated data as arguments for:

- State actions
- Condition and transition actions
- Vector and matrix indexing
- MATLAB functions
- Graphical functions
- Simulink functions
- Truth Table blocks and truth table functions

If you have Simulink Coder installed, you can use enumerated data for simulation and code generation.

### See Also

**More About**

- “Define Enumerated Data Types” on page 19-5
- “Assign Enumerated Values in a Chart” on page 19-14
- “Model Media Player by Using Enumerated Data” on page 19-19
- “Best Practices for Using Enumerated Data” on page 19-9
- “Simulink Enumerations” (Simulink)
- “Use Enumerated Data in Simulink Models” (Simulink)
Define Enumerated Data Types

Before you can add enumerated data to a Stateflow chart, you must define an enumerated data type in a MATLAB class definition file. Create a different file for each enumerated type. See “Reference Values by Name by Using Enumerated Data” on page 19-2.

Elements of an Enumerated Data Type Definition

The enumerated data type definition consists of three sections of code.

<table>
<thead>
<tr>
<th>Section of Code</th>
<th>Required?</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>classdef</td>
<td>Yes</td>
<td>Provides the name of the enumerated data type</td>
</tr>
<tr>
<td>enumeration</td>
<td>Yes</td>
<td>Lists the enumerated values that the data type allows</td>
</tr>
<tr>
<td>methods</td>
<td>No</td>
<td>Provides methods that customize the data type</td>
</tr>
</tbody>
</table>

Define an Enumerated Data Type

1. Open a new file in which to store the data type definition. From the Home tab on the MATLAB toolstrip, select New > Class.

2. Complete the classdef section of the definition.

   ```matlab
   classdef BasicColors < Simulink.IntEnumType
     ...
   end
   ```

   The classdef section defines an enumerated data type with the name BasicColors. Stateflow derives the data type from the built-in type Simulink.IntEnumType. The enumerated data type name must be unique among data type names and workspace variable names.

3. Define enumerated values in an enumeration section.

   ```matlab
   classdef BasicColors < Simulink.IntEnumType
     enumeration
       Red(0)
       Yellow(1)
       Green(2)
     end
   end
   ```
An enumerated type can define any number of values. The enumeration section lists the set of enumerated values that this data type allows. Each enumerated value consists of a name and an underlying integer value. Each name must be unique within its type, but can also appear in other enumerated types. The default value is the first one in the list, unless you specify otherwise in the methods section of the definition.

(Optional) Customize the data type by using a methods section. The section can contain these methods:

- `getDefaultValue` specifies a default enumerated value other than the first one in the list of allowed values.
- `getDescription` specifies a description of the data type for code generated by Simulink Coder.
- `getHeaderFile` specifies custom header file that contains the enumerated type definition in code generated by Simulink Coder.
- `getDataScope` enables exporting or importing the enumerated type definition to or from a header file in code generated by Simulink Coder.
- `addClassNameToEnumNames` enhances readability and prevents name conflicts with identifiers in code generated by Simulink Coder.

For example, this MATLAB file presents a customized definition for the enumerated data type `BasicColors` that:

- Specifies that the default enumerated value is the last one in the list of allowed values.
- Includes a short description of the data type for code generated by Simulink Coder.
- Imports the definition of the data type from a custom header file to prevent Simulink Coder from generating the definition.
- Adds the name of the data type as a prefix to each enumeration member name in code generated by Simulink Coder.

```matlab
classdef BasicColors < Simulink.IntEnumType
    enumeration
        Red(0)
        Yellow(1)
        Green(2)
    end
```

19-6
methods (Static = true)
    function retVal = getDefaultValue()
        % GETDEFAULTVALUE Specifies the default enumeration member.
        % Return a valid member of this enumeration class to specify the default.
        % If you do not define this method, Simulink uses the first member.
        retVal = BasicColors.Green;
    end

    function retVal = getDescription()
        % GETDESCRIPTION Specifies a string to describe this enumerated type.
        retVal = 'This defines an enumerated type for colors';
    end

    function retVal = getHeaderFile()
        % GETHEADERFILE Specifies the file that defines this type in generated code.
        % The method getDataScope determines the significance of the specified file.
        retVal = 'imported_enum_type.h';
    end

    function retVal = getDataScope()
        % GETDATASCOPE Specifies whether generated code imports or exports this type.
        % Return one of these strings:
        % 'Auto': define type in model_types.h, or import if header file specified
        % 'Exported': define type in a generated header file
        % 'Imported': import type definition from specified header file
        % If you do not define this method, DataScope is 'Auto' by default.
        retVal = 'Imported';
    end

    function retVal = addClassNameToEnumNames()
        % ADDCLASSNAMETOENUMNAMES Specifies whether to add the class name
        % as a prefix to enumeration member names in generated code.
        % Return true or false.
        % If you do not define this method, no prefix is added.
        retVal = true;
    end % function
end % methods
end % classdef

5 Save the file on the MATLAB path. The name of the file must match exactly the name
of the data type. For example, the definition for the data type BasicColors must
reside in a file named BasicColors.m.
Tip To add a folder to the MATLAB search path, type `addpath pathname` at the command prompt.

Specify Data Type in the Property Inspector

When you add enumerated data to your chart, specify its type in the Property Inspector.

1. In the **Type** field, select `Enum: <class name>`.  
2. Replace `<class name>` with the name of the data type. For example, you can enter `Enum: BasicColors` in the **Type** field.  
3. (Optional) Enter an initial value for the enumerated data by using a prefixed identifier. The initial value must evaluate to a valid MATLAB expression.

See Also

More About

- “Assign Enumerated Values in a Chart” on page 19-14  
- “Model Media Player by Using Enumerated Data” on page 19-19  
- “Best Practices for Using Enumerated Data” on page 19-9  
- “Use Enumerated Data in Simulink Models” (Simulink)  
- “Customize Simulink Enumeration” (Simulink)  

19 Enumerated Data in Charts
Best Practices for Using Enumerated Data

Guidelines for Defining Enumerated Data Types

Use Unique Name for Each Enumerated Type

To avoid name conflicts, the name of an enumerated data type cannot match the name of another data type or a variable in the MATLAB base workspace.

Use Same Name for Enumerated Type and Class Definition File

To enable resolution of enumerated data types for Simulink models, the name of the MATLAB file that contains the type definition must match the name of the data type.

Apply Changes in Enumerated Type Definition

When you update an enumerated data type definition for an open model, the changes do not take effect immediately. To see the effects of updating a data type definition:

1  Save and close the model.
2  Delete all instances of the data type from the MATLAB base workspace. To find these instances, type whos at the command prompt.
3  Open the model and start simulation or generate code by using SimulinkCoder.

Include Custom Header Information for Enumerated Types

If data uses an enumerated type with a custom header file, include the header information on the Simulation Target pane in the Model Configuration Parameters dialog box. In the Header file section, add this statement:

```c
#include "<custom_header_file_for_enum>.h"
```

For instance, suppose that you have three enumerated types in your model that use custom header files: imported_enum_type1.h, imported_enum_type2.h, and imported_enum_type3.h. If you use the three enumerated types for different data in your chart, you can include the header information by using one of these methods:

- In the Header file section of the Simulation Target pane in the Model Configuration Parameters dialog box, add these statements:
• Create a separate header file, such as `required_types.h`, that consolidates the list of custom header files:

```c
#include "imported_enum_type1.h"
#include "imported_enum_type2.h"
#include "imported_enum_type3.h"
```

Then, in the Header file section on the Simulation Target pane in the Model Configuration Parameters dialog box, add this statement:

```c
#include "required_types.h"
```

Guidelines for Referencing Enumerated Data

Ensure Unique Name Resolution for Nonprefixed Identifiers

If you use nonprefixed identifiers to refer to enumerated values in a chart, ensure that each enumerated name belongs to a unique enumerated data type.

Use Unique Identifiers for Enumerated Values

If an enumerated value uses the same identifier as a data object or a bus field, the chart does not resolve the identifier correctly. For example, this diagram shows the stages in which a chart tries to resolve the identifier `Colors.Red`. 
Given an identifier Colors.Red

Is there a state named Colors with a data object named Red?

No

Is there a bus named Colors that contains the field Red?

No

Is there an enumerated type named Colors with the value Red?

No

Error message appears in the Diagnostic Viewer

Yes

Successful name resolution for identifier Colors.Red
Set Initial Values of Enumerated Data by Using Prefixed Identifiers

If you choose to set an initial value for enumerated data, you must use a prefixed identifier in the Initial value field of the Property Inspector. For example, BasicColors.Red is a valid identifier, but Red is not. The initial value must evaluate to a valid MATLAB expression.

Enhance Readability of Generated Code by Using Prefixed Identifiers

If you add prefixes to enumerated names in the generated code, you enhance readability and avoid name conflicts with global symbols. For details, see “Use Enumerated Data in Generated Code” (Simulink Coder).

Guidelines and Limitations for Enumerated Data

Do Not Enter Minimum or Maximum Values for Enumerated Data

For enumerated data, leave the Minimum and Maximum fields of the Property Inspector empty. The chart ignores any values that you enter in these fields.

Whether these fields appear in the Property Inspector depends on which Type field option you use to define enumerated data.

<table>
<thead>
<tr>
<th>Type Field Option</th>
<th>Appearance of the Minimum and Maximum Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enum: &lt;class name&gt;</td>
<td>Not available</td>
</tr>
<tr>
<td>&lt;data type expression&gt; or Inherit from Simulink</td>
<td>Available</td>
</tr>
</tbody>
</table>

Do Not Assign Enumerated Values to Constant Data

Because enumerated values are constants, assigning these values to constant data is redundant and unnecessary. If you try to assign enumerated values to constant data, an error appears.

Do Not Use ml Namespace Operator to Access Enumerated Data

The ml operator does not support enumerated data.
**Do Not Use Enumerated Data as Input or Output of Exported Functions**

Graphical functions, truth table functions, and Simulink functions do not support enumerated types.

**Do Not Define Enumerated Data at Machine Level of Hierarchy**

Machine-parented data is not supported for enumerated types.

### See Also

#### More About

- “Reference Values by Name by Using Enumerated Data” on page 19-2
- “Define Enumerated Data Types” on page 19-5
- “Assign Enumerated Values in a Chart” on page 19-14
- “Model Media Player by Using Enumerated Data” on page 19-19
Assign Enumerated Values in a Chart

This example shows how to build a chart that uses enumerated values to issue a status keyword. For more information see, “Reference Values by Name by Using Enumerated Data” on page 19-2.

Chart Behavior

During simulation, the chart action alternates between states A and B.

Execution of State A

• At the start of the simulation, state A is entered.
• State A executes the entry action by assigning the value RED to the enumerated data color.
• The data y increments once per time step (every 0.2 seconds) until the condition \( y > 6 \) is true.
• The chart takes the transition from state A to state B.

Execution of State B

• After the transition from state A occurs, state B is entered.
• State B executes the entry action by assigning the value GREEN to the enumerated data color.
• The data $y$ decrements once per time step (every 0.2 seconds) until the condition $[y < 3]$ is true.
• The chart takes the transition from state B back to state A.

**Build the Chart**

**Add States and Transitions to the Chart**

1. To create a Simulink model with an empty chart, at the MATLAB command prompt, enter `sfnew`.
2. In the empty chart, add states A and B. At the text prompt, enter the appropriate action statements.
3. Add a default transition to state A and transitions between states A and B.
4. Double-click each transition. At the text prompt, enter the appropriate condition.

**Define an Enumerated Data Type for the Chart**

1. To create a file in which to store the data type definition, from the Home tab on the MATLAB toolstrip, select New > Class.
2. In the MATLAB Editor, enter:
   ```matlab
classdef TrafficColors < Simulink.IntEnumType
   enumeration
   RED(0)
   GREEN(10)
   end
end
```

   The `classdef` section defines an integer-based enumerated data type named `TrafficColors`. The `enumeration` section contains the enumerated values that this data type allows followed by their underlying numeric value.
3. Save your file as `TrafficColors.m` in a folder on the MATLAB search path.

**Define Chart Data**

1. To resolve the undefined data, in the Symbols window, click the Resolve undefined symbols icon 🔄. The Stateflow Editor assigns an appropriate scope to each symbol in the chart.
<table>
<thead>
<tr>
<th>Symbol</th>
<th>Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>color</td>
<td>Output Data</td>
</tr>
<tr>
<td>y</td>
<td>Local Data</td>
</tr>
<tr>
<td>GREEN</td>
<td>Parameter Data</td>
</tr>
<tr>
<td>RED</td>
<td>Parameter Data</td>
</tr>
</tbody>
</table>

2 To specify `color` as enumerated data, in the Property Inspector:
   - In the `Type` field, select `Enum: <class name>`. Replace `<class name>` with `TrafficColors`, the name of the data type that you defined previously.
   - Under `Logging`, select the `Log signal data` check box.

3 To set the scope and type of `y`, in the Property Inspector:
   - In the `Scope` field, select `Output`.
   - In the `Type` field, select `uint8`.
   - Under `Logging`, select the `Log signal data` check box.

4 In the Symbols window, delete the symbols `GREEN` and `RED`. The Stateflow Editor incorrectly identified these symbols as parameters before you specified `color` as enumerated data.

**View Simulation Results**

1 When you simulate the model, the Simulation Data Inspector icon is highlighted to indicate that it has new simulation data. To open the Simulation Data Inspector, click the icon.

2 In the Simulation Data Inspector, select the check boxes for the `color` and `y` signals so that they are displayed on separate axes.
3 To access the logged data in the MATLAB workspace, call the signal logging object `logsout`. For example, at the command prompt, enter:

```matlab
A = table(logsout.getElement('color').Values.Time, ... 
    logsout.getElement('color').Values.Data); 
A.Properties.VariableNames = {'SimulationTime','Color'}; 
A
```
A =

9×2 table

<table>
<thead>
<tr>
<th>SimulationTime</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>RED</td>
</tr>
<tr>
<td>1.6</td>
<td>GREEN</td>
</tr>
<tr>
<td>2.8</td>
<td>RED</td>
</tr>
<tr>
<td>4</td>
<td>GREEN</td>
</tr>
<tr>
<td>5.2</td>
<td>RED</td>
</tr>
<tr>
<td>6.4</td>
<td>GREEN</td>
</tr>
<tr>
<td>7.6</td>
<td>RED</td>
</tr>
<tr>
<td>8.8</td>
<td>GREEN</td>
</tr>
<tr>
<td>10</td>
<td>RED</td>
</tr>
</tbody>
</table>

See Also

More About

- “Define Enumerated Data Types” on page 19-5
- “Model Media Player by Using Enumerated Data” on page 19-19
- “Best Practices for Using Enumerated Data” on page 19-9
- “Access Signal Logging Data” on page 30-54
- “View Data with the Simulation Data Inspector” (Simulink)
Model Media Player by Using Enumerated Data

In this section...

“Run the Media Player Model” on page 19-20
“UserRequest Chart” on page 19-23
“CdPlayerModeManager Chart” on page 19-24
“CdPlayerBehaviorModel Chart” on page 19-27

Model a media player by using enumerated data in three Stateflow charts.
This model uses two enumerated data types: `RadioRequestMode` and `CdRequestMode`. By grouping related values into separate data types:

- You enhance the readability of data values in each chart.
- You avoid defining a long list of constants and reduce the amount of data in your model.

### Enumerated Data Type

<table>
<thead>
<tr>
<th>RadioRequestMode</th>
<th>Enumerated Values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OFF(0)</td>
</tr>
<tr>
<td></td>
<td>CD(1)</td>
</tr>
<tr>
<td></td>
<td>FM(2)</td>
</tr>
<tr>
<td></td>
<td>AM(3)</td>
</tr>
</tbody>
</table>

### CdRequestMode

<table>
<thead>
<tr>
<th>Enumerated Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMPTY(-2)</td>
</tr>
<tr>
<td>DISCINSERT(-1)</td>
</tr>
<tr>
<td>STOP(0)</td>
</tr>
<tr>
<td>PLAY(1)</td>
</tr>
<tr>
<td>REW(3)</td>
</tr>
<tr>
<td>FF(4)</td>
</tr>
<tr>
<td>EJECT(5)</td>
</tr>
</tbody>
</table>

**Run the Media Player Model**

1. At the MATLAB command prompt, enter `sf_cdplayer`.
2. Start simulation of the model. The CD Player Helper appears.
In the model, the Display blocks show the default settings of the media player.
3 In the **Radio Request** section, click **CD**. The Display blocks for enumerated data **RR** and **CurrentRadioMode** change from **OFF** to **CD**.

4 Click **Insert Disc**. The Display block for enumerated data **CdStatus** changes from **EMPTY** to **DISCINSERT** to **STOP**.

5 In the **CD Request** section, click the **PLAY**. The Display blocks for enumerated data **CR**, **MechCmd**, and **CdStatus** change from **STOP** to **PLAY**.

6 To see other changes in the Display blocks, use the CD Player Helper to select other operating modes for the media player.
UserRequest Chart

This chart reads user inputs from the CD Player Helper and stores the information as output data.

```matlab
{
    RR = RadioRequestMode(ml.sfcdplayerhelper('get_radio_request'));
    CR = CdRequestMode(ml.sfcdplayerhelper('get_cd_request'));
    DiscInsert = ml.sfcdplayerhelper('get_insert_disc');
    DiscEject = ml.sfcdplayerhelper('get_eject_disc');
}
```

Key Features of the Chart

- Enumerated data RR and CR
- `ml` namespace operator to access MATLAB function `sfcdplayerhelper`

Chart Behavior

The chart calls the function `sfcdplayerhelper` on the MATLAB path, reads your interaction with the UI, and stores it as output data.

<table>
<thead>
<tr>
<th>Output Data Name</th>
<th>Data Type</th>
<th>Button Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RR</td>
<td>Enumerated</td>
<td>Buttons in the Radio Request section</td>
<td>Media player subcomponent to activate</td>
</tr>
<tr>
<td>CR</td>
<td>Enumerated</td>
<td>Buttons in the CD Request section</td>
<td>Operating mode of the CD player</td>
</tr>
<tr>
<td>DiscInsert</td>
<td>Boolean</td>
<td>Insert Disc</td>
<td>Setting for CD insertion</td>
</tr>
<tr>
<td>DiscEject</td>
<td>Boolean</td>
<td>Eject Disc</td>
<td>Setting for CD ejection</td>
</tr>
</tbody>
</table>
CdPlayerModeManager Chart

This chart activates the appropriate subcomponent of the media player depending on the inputs received from the UserRequest chart.
Model Media Player by Using Enumerated Data

Standby
entry: CurrentRadioMode = OFF;
MechCmd = STOP;

[RadioReq != OFF]

[hasChanged(RadioReq)]

[RadioReq == CD]
CDMode

[RadioReq == AM]
AMMode

/*RadioReq == FM*/
FMMODE

[DiscEject]

Eject
entry:
Key Features of the Chart

- Enumerated data RadioReq, CdReq, CurrentRadioMode, and MechCmd
- hasChanged operator to detect changes in the value of RadioReq
- Subcharts CdMode, AMMode, and FMMode

Chart Behavior

At the start of simulation, the ModeManager state becomes active. If the Boolean data DiscEject is 1 (or true), a transition to the Eject state occurs, followed by a transition back to the ModeManager state.

When ModeManager is active, the previously active substate (Standby or ON) as recorded by the history junction becomes active. Subsequent transitions between the Standby and ON substates depend on the enumerated data RadioReq:

- If RadioReq is OFF, the Standby substate is activated.
- If RadioReq is not OFF, the ON substate is activated.

In the ON substate, three subcharts represent the operating modes of the media player: CD player, AM radio, and FM radio. Each subchart corresponds to a different value of enumerated data RadioReq. The inner transition inside the ON state continually scans for changes in the value of RadioReq.

<table>
<thead>
<tr>
<th>Value of Enumerated Data RadioReq</th>
<th>Active Subchart</th>
<th>Purpose of Subchart</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD</td>
<td>CDMode</td>
<td>Sets the media player to CD player mode. Outputs PLAY, REW, FF, and STOP commands to the CdPlayerBehaviorModel chart.</td>
</tr>
<tr>
<td>AM</td>
<td>AMMode</td>
<td>Sets the media player to AM radio mode. Outputs a STOP command to the CdPlayerBehaviorModel chart.</td>
</tr>
<tr>
<td>Value of Enumerated Data RadioReq</td>
<td>Active Subchart</td>
<td>Purpose of Subchart</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>FM</td>
<td>FMMode</td>
<td>Sets the media player to FM radio mode. Outputs a STOP command to the CdPlayerBehaviorModel chart.</td>
</tr>
</tbody>
</table>

**CdPlayerBehaviorModel Chart**

This chart activates the appropriate operating mode for the CD player depending on the input received from the CdPlayerBehaviorModel chart.
Key Features of the Chart

- Enumerated data CMD and CdStatus
• after temporal logic operator to control timing of transitions during disc insertion and ejection

**Chart Behavior**

At the start of simulation, the Empty state is activated.

If the Boolean data DiscInsert is 1 (or true), a transition to the Inserting state occurs. After a short time delay, a transition to the DiscPresent state occurs.

The DiscPresent state remains active until the data CMD becomes EJECT. At that point, a transition to the Ejecting state occurs. After a short time delay, a transition to the Empty state occurs.

Whenever a state transition occurs, the enumerated data CdStatus changes value to reflect the status of the CD player.

<table>
<thead>
<tr>
<th>Active State</th>
<th>Value of Enumerated Data CdStatus</th>
<th>Behavior of CD Player</th>
</tr>
</thead>
<tbody>
<tr>
<td>Empty</td>
<td>EMPTY</td>
<td>CD player is empty.</td>
</tr>
<tr>
<td>Inserting</td>
<td>DISCINSERT</td>
<td>CD is being inserted into the player.</td>
</tr>
<tr>
<td>Ejecting</td>
<td>EJECT</td>
<td>CD is being ejected from the player.</td>
</tr>
<tr>
<td>DiscPresent.STOP</td>
<td>STOP</td>
<td>CD is present and stopped.</td>
</tr>
<tr>
<td>DiscPresent.PLAY</td>
<td>PLAY</td>
<td>CD is present and playing.</td>
</tr>
<tr>
<td>DiscPresent.REW</td>
<td>REW</td>
<td>CD is present and rewinding.</td>
</tr>
<tr>
<td>DiscPresent.FF</td>
<td>FF</td>
<td>CD is present and fast forwarding.</td>
</tr>
</tbody>
</table>

**See Also**

**More About**

• “Reference Values by Name by Using Enumerated Data” on page 19-2
- “Define Enumerated Data Types” on page 19-5
- “Assign Enumerated Values in a Chart” on page 19-14
- “Best Practices for Using Enumerated Data” on page 19-9
- “Access Built-In MATLAB Functions and Workspace Data” on page 12-38
- “Detect Changes in Data Values” on page 12-74
- “Control Chart Execution Using Temporal Logic” on page 12-55
Continuous-Time Systems in Stateflow Charts

- “Continuous-Time Modeling in Stateflow” on page 20-2
- “Model Hybrid Systems with Model Logic” on page 20-6
- “Configure a Stateflow Chart to Update in Continuous Time” on page 20-7
- “Define Continuous-Time Variables” on page 20-9
- “Model a Bouncing Ball in Continuous Time” on page 20-11
- “Design Considerations for Continuous-Time Modeling in Stateflow Charts” on page 20-21
Continuous-Time Modeling in Stateflow

In this section...

“What Is Continuous-Time Modeling?” on page 20-2
“When to Use Stateflow Charts for Continuous-Time Modeling” on page 20-3
“Model Continuous-Time with Zero-Crossing Detection” on page 20-3
“When to Disable Zero-Crossing Detection” on page 20-4

What Is Continuous-Time Modeling?

Using continuous-time modeling you can simulate hybrid systems that use mode logic—that is, systems that respond to continuous and discrete mode changes. A simple example of this type of hybrid system is a bouncing ball. The ball moves continuously through the air until it hits the ground, at which point a mode change or discontinuity occurs. As a result, the ball changes direction and velocity due to a sudden loss of energy. A later exercise shows you how to model a bouncing ball in continuous time by using a Stateflow chart (see “Model a Bouncing Ball in Continuous Time” on page 20-11).

When you configure Stateflow charts for continuous-time simulation, they interact with the Simulink solver as follows:

• Maintain mode in minor time steps.

  Stateflow charts do not update mode in minor time steps. The outputs computed in a minor time step are based on the state of the chart during the last major time step.

• Compute the state of the chart at each time step and expose the state derivative to the Simulink solver.

  You can define local continuous variables to hold state information. Stateflow charts provide programmatic access to the derivatives of state variables. Continuous solvers in Simulink models use this data to compute the continuous states at the current time step in the chart, based on values from the previous time steps and the state derivatives. For more information on how solvers work, see “Solvers” (Simulink).

• Register zero crossings on state transitions.

  Stateflow charts register a zero-crossings function with a Simulink model to help determine when a state transition occurs. When the Simulink solver detects a change of mode, it searches forward from the previous major time step to detect when the
zero crossing or state transition occurred. For more information about how a Simulink model uses zero-crossing detection to simulate discontinuities in continuous states, see “Zero-Crossing Detection” (Simulink).

**When to Use Stateflow Charts for Continuous-Time Modeling**

Use Stateflow charts for modeling hybrid systems with modal behavior, that is, systems that transition from one mode to another in response to physical events and conditions. In these systems, continuous time dynamics govern each mode. Be aware that you cannot use Moore charts for continuous time modeling.

In Stateflow charts, you can represent mode logic succinctly and intuitively as a series of states, transitions, and flow charts. You can also easily represent state information as continuous local variables with automatic access to time derivatives, as described in “Purpose of Continuous-Time Variables” on page 20-9.

If your continuous or hybrid system does not contain mode logic, consider using a Simulink model (see “Model a Continuous System” (Simulink)).

**Model Continuous-Time with Zero-Crossing Detection**

You can run the following continuous-time models with zero-crossing detection.

<table>
<thead>
<tr>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sf_abs</td>
<td>Rectifier takes a single (scalar) input and converts it to its absolute value. Shows how Stateflow charts register zero-crossing variables with Simulink models for accurate detection of mode changes.</td>
</tr>
<tr>
<td>sf_bounce</td>
<td>Shows how to model the dynamics of a bouncing ball by defining continuous-time state variables and their derivatives in a Stateflow chart. See “Model a Bouncing Ball in Continuous Time” on page 20-11.</td>
</tr>
<tr>
<td>Model</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sf_newtons_cradle</td>
<td>Shows how to model elastic collisions between balls in Newton's Cradle, a device that conserves momentum and energy. Uses vector assignment to continuous-time state variables.</td>
</tr>
<tr>
<td>sf_clutch_enabled_subsystems</td>
<td>Implements the Simulink clutch example model purely in a Stateflow chart. Represents the modal nature of the clutch by using two states: Locked and Slipping.</td>
</tr>
<tr>
<td>sf_pool</td>
<td>Shows how to model continuous systems that have many discontinuous events, which rapidly (and unpredictably) change the dynamics.</td>
</tr>
</tbody>
</table>

### When to Disable Zero-Crossing Detection

Whether to disable zero-crossing detection on state transitions can be a trade-off between accuracy and performance. When detecting zero crossings, a Simulink model accurately simulates mode changes without unduly reducing step size. For systems that exhibit *chattering*, frequent fluctuations between two modes of continuous operation, zero-crossing detection can potentially impact simulation time. Chattering requires a Simulink model to check for zero crossings in rapid succession, which can slow simulation. In these situations, you can:

- Disable zero-crossing detection.
- Choose a different zero-crossing detection algorithm for your chart.
- Modify parameters that control the frequency of zero crossings in your Simulink model.

### See Also

### More About

- “Model a Bouncing Ball in Continuous Time” on page 20-11
• “Design Considerations for Continuous-Time Modeling in Stateflow Charts” on page 20-21
• “Preventing Excessive Zero Crossings” (Simulink)
## Model Hybrid Systems with Model Logic

Here are the tasks for modeling hybrid systems containing mode logic in continuous time using Stateflow charts.

<table>
<thead>
<tr>
<th>Task</th>
<th>Example in Bouncing Ball Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the chart to update in continuous time on page 20-7.</td>
<td>“Task 1: Configure the Bouncing Ball Chart for Continuous Updating” on page 20-12</td>
</tr>
<tr>
<td>Decide whether to detect zero crossings on page 20-4.</td>
<td>“Task 2: Decide Whether to Enable Zero-Crossing Detection for the Bouncing Ball” on page 20-12</td>
</tr>
<tr>
<td>Choose a solver that supports continuous states (see “Solver Types” (Simulink)).</td>
<td>“Task 4: Choose a Solver for the Bouncing Ball Chart” on page 20-13</td>
</tr>
<tr>
<td>Add system dynamics.</td>
<td>“Task 5: Add Dynamics for a Free-Falling Ball” on page 20-13</td>
</tr>
<tr>
<td>Expose continuous states to a Simulink model on page 20-10.</td>
<td>“Task 6: Expose Ball Position and Velocity to the Simulink Model” on page 20-15</td>
</tr>
<tr>
<td>Validate semantics, based on design considerations for continuous-time simulation on page 20-21.</td>
<td>“Task 7: Validate Semantics of Bouncing Ball Chart” on page 20-15</td>
</tr>
<tr>
<td>Simulate the chart.</td>
<td>“Task 8: Simulate Bouncing Ball Chart” on page 20-15</td>
</tr>
<tr>
<td>Debug and revise.</td>
<td>“Task 9: Check for the Bounce” on page 20-17</td>
</tr>
</tbody>
</table>
Configure a Stateflow Chart to Update in Continuous Time

Continuous updating is a Stateflow chart property. To set this property:

1. Right-click inside a chart and select Properties from the context menu.
2. In the Chart Properties dialog box, set the Update method to Continuous.

When you set the Update method to Continuous, the chart:

• Enables zero-crossing detection
• Disables super step semantics

3 Decide whether to disable zero-crossing detection, based on considerations described in “When to Disable Zero-Crossing Detection” on page 20-4. You can choose from different zero-crossing detection algorithms in the Model Configuration Parameters dialog box, on the Solver pane. For details, see the Simulink documentation.

4 Click OK.
Define Continuous-Time Variables

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Purpose of Continuous-Time Variables” on page 20-9</td>
</tr>
<tr>
<td>“Implicit Time Derivatives” on page 20-9</td>
</tr>
<tr>
<td>“Rules for Using Continuous-Time Variables” on page 20-9</td>
</tr>
<tr>
<td>“How to Define Continuous-Time Variables” on page 20-10</td>
</tr>
<tr>
<td>“Expose Continuous States to a Simulink Model” on page 20-10</td>
</tr>
</tbody>
</table>

**Purpose of Continuous-Time Variables**

To compute a continuous state, you must determine its rate of change, or derivative. You can represent this information using local variables that update in continuous time. In a Stateflow chart, continuous-time variables are always double type. You cannot change the type, but you can change the size.

**Implicit Time Derivatives**

For each continuous variable you define, a Stateflow chart implicitly creates a variable to represent its time derivative. A chart denotes time derivative variables as variable_name_dot. For example, the time derivative of continuous variable x is x_dot. You can write to the time derivative variable in the during action of a state. The time derivative variable does not appear in the Model Explorer.

**Note** Do not explicitly define variables with the suffix _dot in a chart.

**Rules for Using Continuous-Time Variables**

When defining and using continuous-time variables, follow these rules:

- Scope can be Local or Output.
- Define continuous-time variables at the chart level or below in the Stateflow hierarchy.
- Expose continuous state by assigning the local variable to a Stateflow output (see “Expose Continuous States to a Simulink Model” on page 20-10).
How to Define Continuous-Time Variables

1. Configure your chart to update in continuous time, as described in “Configure a Stateflow Chart to Update in Continuous Time” on page 20-7.

2. Add local data to your chart in the Stateflow Editor or Model Explorer.

3. In the properties dialog box for your local data, set Update Method to Continuous.

   In this example, the chart automatically creates the variable mydata_dot to represent the time derivative of this data. When you set a variable to update in continuous time, you cannot bind that data to a Simulink signal.

Expose Continuous States to a Simulink Model

In a Stateflow chart, you represent continuous state by using local variables rather than inputs or outputs (see “Purpose of Continuous-Time Variables” on page 20-9). To expose the continuous states to a Simulink model, you must explicitly assign the local variables to Stateflow outputs in the during action of the state. For an example, see “Model a Bouncing Ball in Continuous Time” on page 20-11.
Model a Bouncing Ball in Continuous Time

In this section...

“Dynamics of a Bouncing Ball” on page 20-11
“Model the Bouncing Ball” on page 20-12

Dynamics of a Bouncing Ball

The dynamics of a bouncing ball describes the ball as it falls, when it hits the ground, and when it bounces back up.

You can specify how the ball falls freely under gravity with the following second-order differential equation:

\[ \dot{p} = -g \]

\( p \) describes the position of the ball as a function of time and \( g = 9.81 m / s^2 \), which is the acceleration due to gravity.

A Stateflow chart requires that you specify system dynamics as first-order differential equations. You can describe the dynamics of the free-falling ball in terms of position \( p \) and velocity \( v \) with the following first-order differential equations.

<table>
<thead>
<tr>
<th>Equation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \dot{p} = v )</td>
<td>Derivative of position is velocity</td>
</tr>
<tr>
<td>( \dot{v} = -9.81 )</td>
<td>Derivative of velocity is acceleration</td>
</tr>
</tbody>
</table>

The bounce occurs after the ball hits the ground at position \( p <= 0 \). Now, you can model the bounce by updating position and velocity as follows:

- Reset position to 0.
- Reset velocity to the negative of its value just before the ball hit the ground.
- Multiply the new velocity by a coefficient of distribution (-0.8) that reduces the speed just after the bounce.
Model the Bouncing Ball

The following steps take you through the workflow for modeling a bouncing ball in continuous time. To view the completed model, open sf_bounce.

**Task 1: Configure the Bouncing Ball Chart for Continuous Updating**

1. Create an empty Stateflow chart and open its properties dialog box.
2. Set the update method to Continuous.

**Task 2: Decide Whether to Enable Zero-Crossing Detection for the Bouncing Ball**

For this example, enable zero-crossing detection (the default) so that the Simulink model can determine exactly when the ball hits the ground at \( p \leq 0 \). Otherwise, the Simulink model might not be able to simulate the physics accurately. For example, the ball might appear to descend below ground.

**Task 3: Define Continuous-Time Variables for Position and Velocity**

1. Define two continuous-time variables, \( p \) for position and \( v \) for velocity. For each variable, follow these steps:
   
   a. In the Stateflow Editor, select Chart > Add Other Elements > Local Data.
   b. Enter the name for the local data.
   c. Set the update method to Continuous.
   d. Leave all other properties at their default values and click OK.

2. For each continuous local variable that you define, the chart implicitly creates its time derivative as a variable of the same name with the suffix \( \_\text{dot} \). In this example, the chart defines \( p\_\text{dot} \) as the derivative of position \( p \) and \( v\_\text{dot} \) as the derivative of velocity \( v \).

3. Define two outputs, \( p\_\text{out} \) and \( v\_\text{out} \) for exposing continuous state to the Simulink model. For each variable, follow these steps:
   
   a. In the Stateflow Editor, select Chart > Add Inputs & Outputs > Data Output To Simulink.
   b. Enter the name for the output data.
   c. Leave all other properties at their default values and click OK.

Your chart contains the following data, as viewed in the Model Explorer.
**Task 4: Choose a Solver for the Bouncing Ball Chart**

For this example, you can use **ode45 (Dormand-Prince)**, the default variable-step solver used by Simulink models with continuous states.

**Task 5: Add Dynamics for a Free-Falling Ball**

1. Add a state named **Falling** with a default transition. In the default transition, set initial position to 10 meters and initial velocity to 15 meters/second.
Add a during action to the Falling state that defines the derivatives of position and velocity.

The derivative of position is velocity and the derivative of velocity is acceleration due to gravity (-g).
Task 6: Expose Ball Position and Velocity to the Simulink Model

In the during action, assign position to the output \( p_{\text{out}} \) and assign velocity to the output \( v_{\text{out}} \).

```
{ 
p = 10;
v = 15;
}
```

Task 7: Validate Semantics of Bouncing Ball Chart

Check semantics against the requirements defined in “Design Considerations for Continuous-Time Modeling in Stateflow Charts” on page 20-21.

This chart meets design requirements by:

- Assigning values to derivatives \( p_{\text{dot}} \) and \( v_{\text{dot}} \) in a during action
- Writing to local variables \( p \) and \( v \) in a transition action
- Initializing local variables on the default transition
- Does not contain events, inner transitions, event-based temporal logic, or change detection operators

Task 8: Simulate Bouncing Ball Chart

1. Attach each output to a scope.
2 Simulate the chart and view the outputs in the scope.
The ball appears to fall below the ground (below position $p = 0$) because the chart does not yet include a check for the bounce.

**Task 9: Check for the Bounce**

1. Add a self-loop transition to state Falling.
The chart uses a self-loop transition so it can model the bounce as an instantaneous mode change — where the ball suddenly reverses direction — rather than as a finite time collision.

2 Add a condition on the transition that indicates when the ball hits the ground.

The condition must check for position p <= 0 and velocity v < 0.
**Why not check for p == 0?**

Physically, the ball hits the ground when position p is exactly zero. By relaxing the condition, you increase the tolerance within which the Simulink model can detect when the continuous variable changes sign (see “How Blocks Work with Zero-Crossing Detection” (Simulink)).

**Why add the second check for v < 0?**

The second check helps maintain the efficiency of the Simulink solver by minimizing the frequency of zero crossings. Without the second check, the condition becomes true immediately following the state transition, resulting in two successive zero crossings.

3. When the ball hits the ground, reset position and velocity in a condition action.

4. Simulate the chart again. This time, the scope shows the expected bounce pattern.
Continuous-Time Systems in Stateflow Charts
Design Considerations for Continuous-Time Modeling in Stateflow Charts

In this section...

| “Rationale for Design Considerations” on page 20-21 |
| “Summary of Rules for Continuous-Time Modeling” on page 20-21 |

Rationale for Design Considerations

To maintain the integrity or smoothness of the results in continuous-time modeling, you must constrain your charts to a restricted subset of Stateflow chart semantics. By restricting the semantics, the inputs do not depend on unpredictable factors or side effects such as:

- Simulink solver's guess for the number of minor intervals in a major time step
- Number of iterations required to stabilize the integration loop or zero crossings loop

By minimizing side effects, a Stateflow chart can maintain its state at minor time steps and, therefore, update state only during major time steps when mode changes occur. Using this heuristic, a Stateflow chart can always compute outputs based on a constant state for continuous time.

To help you correct semantic violations, a Stateflow chart generates informative errors.

Summary of Rules for Continuous-Time Modeling

Here are the rules for modeling continuous-time Stateflow charts:

Update local data only in transition, entry, and exit actions

To maintain precision in continuous-time simulation, update local data (continuous or discrete) only during physical events at major time steps.

In Stateflow charts, physical events cause state transitions. Therefore, write to local data only in actions that execute during transitions:

- State exit actions, which execute before leaving the state at the beginning of the transition
- Transition actions, which execute during the transition
- State entry actions, which execute after entering the new state at the end of the transition
- Condition actions on a transition, but only if the transition directly reaches a state

Consider the following chart.

In this example, the action \{n++\} executes even when conditions c2 and c3 are false. In this case, n gets updated in a minor time step because there is no state transition.

Do not write to local continuous data in during actions because these actions execute in minor time steps.

**Do not call Simulink functions in state during actions or transition conditions**

This rule applies to continuous-time charts because you cannot call functions during minor time steps. You can call Simulink functions in state entry or exit actions and transition actions. If you try to call Simulink functions in state during actions or transition conditions, an error message appears when you simulate your model.

For more information, see “Simulink Functions in Stateflow” on page 28-2.

**Compute derivatives only in during actions**

A Simulink model reads continuous-time derivatives during minor time steps. The only part of a Stateflow chart that executes during minor time steps is the during action. Therefore, compute derivatives in during actions to give your Simulink model the most current calculation.
**Do not read outputs and derivatives in state during actions or transition conditions**

This restriction provides smooth outputs in a major time step by preventing a chart from using values that might no longer be valid in the current minor time step. Instead, a chart computes outputs from local discrete data, local continuous data, and chart inputs.

**Use discrete variables to govern conditions in during actions**

This restriction prevents mode changes from occurring between major time steps. When placed in during actions, conditions that affect control flow must be governed by discrete variables because they do not change between major time steps.

**Do not use input events in continuous-time charts**

The presence of input events makes a chart behave like a triggered subsystem and therefore unable to simulate in continuous time. For example, the following model generates an error if the chart uses a continuous update method.

To model the equivalent of an input event, pass the input signal through a Hit Crossing block as an input to the continuous chart, as in this example.
**Do not use inner transitions**

When a mode change occurs during continuous-time simulation, the entry action of the destination state indicates to the Simulink model that a state transition occurred. If inner transitions are taken, the entry action is never executed.

**Limit use of temporal logic**

Do not use event-based temporal logic. Use only absolute-time temporal logic for continuous-time simulation. See “Operators for Absolute-Time Temporal Logic” on page 12-62.

Event-based temporal logic has no meaning because there is no concept of a tick during a continuous-time simulation.

**The chart must have at least one substate**

In continuous-time simulation, the during action of a state updates the outputs. A chart with no state produces no output. To simulate the behavior of a stateless chart in continuous time, create a single state which calls a graphical function in its during action.

**Do not use change detection operators in continuous charts**

To implement change detection, Stateflow software buffers variables in a way that affects the behavior of charts between a minor time step and the next major time step.

**Do not modify any SimState values for continuous-time charts**

If you load the SimState for a continuous-time chart, you cannot modify the activity of states or any values of chart local or output data. Modifying the SimState of a continuous-time chart is not supported. For more information, see “Rules for Using the SimState of a Chart” on page 16-36.

**See Also**

**More About**

- “Model a Bouncing Ball in Continuous Time” on page 20-11
- “Continuous-Time Modeling in Stateflow” on page 20-2
Fixed-Point Data in Stateflow Charts

- “What Is Fixed-Point Data?” on page 21-2
- “How Fixed-Point Data Works in Stateflow Charts” on page 21-5
- “Use Fixed-Point Chart Inputs” on page 21-11
- “Use Fixed-Point Parameters and Local Data” on page 21-16
- “Operations with Fixed-Point Data” on page 21-22
What Is Fixed-Point Data?

Before You Begin

Fixed-point numbers use integers and integer arithmetic to approximate real numbers. They are an efficient means for performing computations involving real numbers without requiring floating-point support in underlying system hardware.


Fixed-Point Numbers

Fixed-point numbers use integers and integer arithmetic to represent real numbers and arithmetic with the following encoding scheme:

\[ V = \tilde{V} = SQ + B \]

where

- \( V \) is a precise real-world value that you want to approximate with a fixed-point number.
- \( \tilde{V} \) is the approximate real-world value that results from fixed-point representation.
- \( Q \) is an integer that encodes \( \tilde{V} \). This value is the quantized integer.
- \( Q \) is the actual stored integer value used in representing the fixed-point number. If a fixed-point number changes, its quantized integer, \( Q \), changes but \( S \) and \( B \) remain unchanged.
- \( S \) is a coefficient of \( Q \), or the slope.
- \( B \) is an additive correction, or the bias.

Fixed-point numbers encode real quantities (for example, 15.375) using the stored integer \( Q \). You set the value of \( Q \) by solving the equation

\[ \tilde{V} = SQ + B \]
for $Q$ and rounding the result to an integer value as follows:

$$Q = \text{round}((V - B)/S)$$

For example, suppose you want to represent the number 15.375 in a fixed-point type with the slope $S = 0.5$ and the bias $B = 0.1$. This means that

$$Q = \text{round}((15.375 - 0.1)/0.5) = 30$$

However, because $Q$ is rounded to an integer, you lose some precision in representing the number 15.375. If you calculate the number that $Q$ actually represents, you now get a slightly different answer.

$$V = \tilde{V} = SQ + B = 0.5 \times 30 + 0.1 = 15.1$$

Using fixed-point numbers to represent real numbers with integers involves the loss of some precision. However, if you choose $S$ and $B$ correctly, you can minimize this loss to acceptable levels.

**Fixed-Point Operations**

Now that you can express fixed-point numbers as $\tilde{V} = SQ + B$, you can define operations between two fixed-point numbers.

The general equation for an operation between fixed-point operands is as follows:

$$c = a \ <\text{op}\> \ b$$

where $a$, $b$, and $c$ are all fixed-point numbers, and $\text{<op>}$ refers to a binary operation: addition, subtraction, multiplication, or division.

The general form for a fixed-point number $x$ is $S_xQ_x + B_x$ (see “Fixed-Point Numbers” on page 21-2). Substituting this form for the result and operands in the preceding equation yields this expression:

$$(S_cQ_c + B_c) = (S_aQ_a + B_a) \ <\text{op}> \ (S_bQ_b + B_b)$$

The values for $S_c$ and $B_c$ are chosen by Stateflow software for each operation (see “Promotion Rules for Fixed-Point Operations” on page 21-24) and are based on the
values for $S_a$, $S_b$, $B_a$, and $B_b$ that you enter for each fixed-point data (see “Specify Fixed-Point Data” on page 21-6).

**Note** You can be more precise in choosing the values for $S_c$ and $B_c$ when you use the := assignment operator (that is, $c := a <op> b$). See “Assignment (═, :=) Operations” on page 21-29.

Using the values for $S_a$, $S_b$, $S_c$, $B_a$, $B_b$, and $B_c$, you can solve the preceding equation for $Q_c$ for each binary operation as follows:

- The operation $c=a+b$ implies that

$$Q_c = ((S_a/S_c)Q_a + (S_b/S_c)Q_b + (B_a + B_b - B_c)/S_c)$$

- The operation $c=a-b$ implies that

$$Q_c = ((S_a/S_c)Q_a - (S_b/S_c)Q_b - (B_a - B_b - B_c)/S_c)$$

- The operation $c=a*b$ implies that

$$Q_c = ((S_aS_b/S_c)Q_aQ_b + (B_aS_b/S_c)Q_a + (B_bS_a/S_c)Q_b + (B_aB_b - B_c)/S_c)$$

- The operation $c=a/b$ implies that

$$Q_c = ((S_aQ_a + B_a)/(S_c(S_bQ_b + B_b)) - (B_c/S_c))$$

The fixed-point approximations of the real number result of the operation $c = a <op> b$ are given by the preceding solutions for the value $Q_c$. In this way, all fixed-point operations are performed using only the stored integer $Q$ for each fixed-point number and integer operation.
How Fixed-Point Data Works in Stateflow Charts

How Stateflow Software Defines Fixed-Point Data

The preceding example in “What Is Fixed-Point Data?” on page 21-2 does not answer the question of how the values for the slope, $S$, the quantized integer, $Q$, and the bias, $B$, are implemented as integers. These values are implemented as follows:

• Stateflow software defines a fixed-point data type from values that you specify.

You specify values for $S$, $B$, and the base integer type for $Q$. The available base types for $Q$ are the unsigned integer types `uint8`, `uint16`, and `uint32`, and the signed integer types `int8`, `int16`, and `int32`. For specific instructions on how to enter fixed-point data, see “Specify Fixed-Point Data” on page 21-6.

Notice that if a fixed-point number has a slope $S = 1$ and a bias $B = 0$, it is equivalent to its quantized integer $Q$, and behaves exactly as its base integer type.

• Stateflow software implements an integer variable for the $Q$ value of each fixed-point data in generated code.

This is the only part of a fixed-point number that varies in value. The quantities $S$ and $B$ are constant and appear only as literal numbers or expressions in generated code.

• The slope, $S$, is factored into an integer power of two, $E$, and a coefficient, $F$, such that $S = F \times 2^E$ and $1 \leq F < 2$.

The powers of 2 are implemented as bit shifts, which are more efficient than multiply instructions. Setting $F = 1$ avoids the computationally expensive multiply instructions for values of $F > 1$. This binary-point-only scaling is implemented with bit shifts only and is recommended.

• Operations for fixed-point types are implemented with solutions for the quantized integer as described in “Fixed-Point Operations” on page 21-3.

To generate efficient code, the fixed-point promotion rules choose values for $S_c$ and $B_c$ that conveniently cancel out difficult terms in the solutions. See “Addition (+) and Subtraction (-)” on page 21-27 and “Multiplication (*) and Division (/)” on page 21-27.

You can use a special assignment operator (:=) and context-sensitive constants to maintain as much precision as possible in your fixed-point operations. See “Assignment

- Any remaining numbers, such as the fractional slope, $F$, that cannot be expressed as a pure integer or a power of 2, are converted into fixed-point numbers.

These remaining numbers can be computationally expensive in multiplication and division operations. Therefore, using binary-point-only scaling in which $F = 1$ and $B = 0$ is recommended.

- Simulation can detect when the result of a fixed-point operation overflows the capacity of its fixed-point type. See “Detect Overflow for Fixed-Point Types” on page 21-9.

**Specify Fixed-Point Data**

You can specify fixed-point data in a chart as follows:

1. Add data to your chart, as described in “Add Data by Using the Stateflow Editor Menu” on page 9-2.

   Doing so adds a default definition of the new data object to the Stateflow hierarchy, and the Data properties dialog box appears.

2. Click the Show data type assistant button to display the Data Type Assistant.

3. In the **Mode** field of the Data Type Assistant, select **Fixed point**.

4. Specify the fixed-point data properties as described in “Fixed-Point Data Properties” on page 9-13.

5. Specify the name, size, and other properties for the new data object as described in “Set Data Properties” on page 9-7.

**Note** You can also specify a fixed-point constant indirectly in action statements by using a fixed-point context-sensitive constant. See “Fixed-Point Context-Sensitive Constants” on page 21-7.

**Rules for Specifying Fixed-Point Word Length**

- For chart-level data of the following scopes, word length can be any integer between 0 and 128.
• Input
• Output
• Parameter
• Data Store Memory
• For other Stateflow data, word length can be any integer between 0 and 32.
• You can explicitly pass chart-level data with word lengths up to 128 bits as inputs and outputs of the following functions:
  • MATLAB functions
  • Simulink functions
  • Truth table functions that use MATLAB action language

**Fixed-Point Context-Sensitive Constants**

You can use fixed-point constants without using the Data properties dialog box or Model Explorer, by using context-sensitive constants. These constants infer their types from the context in which they occur. They are written like ordinary constants, but have the suffix C or c. For example, the numbers 4.3C and 123.4c are valid fixed-point context-sensitive constants you can use in action statements.

These rules apply to context-sensitive constants:

• If any type in the context is a double, then the context-sensitive constant is cast to type double.
• In an addition or subtraction operation, the type of the context-sensitive constant is the type of the other operand.
• In a multiplication or division operation with a fixed-point number, they obtain the best possible precision for a fixed-point result.

The Fixed-Point Designer™ function fixptbestexp provides this functionality.

• In a cast, the context is the type to which the constant is being cast.
• As an argument in a function call, the context is the type of the formal argument. In an assignment, the context is the type of the left-hand operand.
• You cannot use context-sensitive constants on the left-hand side of an assignment.
• You cannot use context-sensitive constants as both operands of a binary operation.
While you can use fixed-point context-sensitive constants in context with any types (for example, `int32` or `double`), their main use is with fixed-point numbers. The algorithm that computes the type to assign to a fixed-point context-sensitive constant depends on these factors:

- The operator
- The data types in the context
- The value of the constant

The algorithm computes a type that provides maximum accuracy without overflow.

**Tips for Using Fixed-Point Data**

When you use fixed-point numbers, follow these guidelines:

1. Develop and test your application using double- or single-precision floating-point numbers.

   Using double- or single-precision floating-point numbers does not limit the range or precision of your computations. You need this while you are building your application.

2. Once your application works well, start substituting fixed-point data for double-precision data during the simulation phase, as follows:

   a. Set the integer word size for the simulation environment to the integer size of the intended target environment.

   Stateflow generated code uses this integer size to select result types for your fixed-point operations. See “Set the Integer Word Size for a Target” on page 21-25.

   b. Add the suffix `C` to literal numeric constants.

   This suffix casts a literal numeric constant in the type of its context. For example, if `x` is fixed-point data, the expression `y = x/3.2C` first converts the numerical constant `3.2` to the fixed-point type of `x` and then performs the division with a fixed-point result. See “Fixed-Point Context-Sensitive Constants” on page 21-7 for more information.

**Note** If you do not use context-sensitive constants with fixed-point types, noninteger numeric constants (for example, constants that have a decimal point) can force fixed-point operations to produce floating-point results.
When you simulate, use overflow detection.

See “Detect Overflow for Fixed-Point Types” on page 21-9 for instructions on how to set overflow detection in simulation.

If you encounter overflow errors in fixed-point data, you can do one of the following to add range to your data.

- Increase the number of bits in the overflowing fixed-point data.
  
  For example, change the base type for $Q$ from `int16` to `int32`.

- Increase the range of your fixed-point data by increasing the power of 2 value, $E$.
  
  For example, you can increase $E$ from -2 to -1. This action decreases the available precision in your fixed-point data.

If you encounter problems with model behavior stemming from inadequate precision in your fixed-point data, you can do one of the following to add precision to your data:

- Increase the precision of your fixed-point data by decreasing the value of the power of 2 binary point $E$.
  
  For example, you can decrease $E$ from -2 to -3. This action decreases the available range in your fixed-point data.

- If you decrease the value of $E$, you can prevent overflow by increasing the number of bits in the base data type for $Q$.
  
  For example, you can change the base type for $Q$ from `int16` to `int32`.

If you cannot avoid overflow for lack of precision, try using the `:=` assignment operator in place of the `=` operator for assigning the results of multiplication and division operations.

You can use the `:=` operator to increase the range and precision of the result of fixed-point multiplication and division operations at the expense of computational efficiency. See “Assignment Operator :=” on page 21-30.

Detect Overflow for Fixed-Point Types

Overflow occurs when the magnitude of a result assigned to a data exceeds the numeric capacity of that data. To detect overflow during simulation, set Wrap on overflow in the Diagnostics: Data Validity pane of the Model Configuration Parameters dialog box to error or warning.
Share Fixed-Point Data with Simulink Models

To share fixed-point data with Simulink models, use one of these methods:

- Define identically in both Stateflow charts and Simulink models the data that you input from or output to Simulink blocks.

  The values that you enter for the Stored Integer and Scaling fields in the shared data's properties dialog box in a Stateflow chart (see “Specify Fixed-Point Data” on page 21-6) must match similar fields that you enter for fixed-point data in a Simulink model. See “Use Fixed-Point Chart Inputs” on page 21-11 for an example of this method of sharing input data from a Simulink model using a Gateway In block.

  For some Simulink blocks, you can specify the type of input or output data directly. For example, you can set fixed-point output data directly in the block dialog box of the Constant block by using the Output data type parameter.

- Define the data as Input or Output in the Data properties dialog box in the Stateflow chart and instruct the sending or receiving block in the Simulink model to inherit its type from the chart data.

  Many blocks allow you to set their data types and scaling through inheritance from the driving block, or through back propagation from the next block. You can set the data type of a Simulink block to match the data type of the Stateflow port to which it connects.

  For example, you can set the Constant block to inherit its type from the Stateflow Input to Simulink port that it supplies. To do so, select Inherit via back propagation for the Output data type parameter in the block dialog box.
Use Fixed-Point Chart Inputs

Run the Fixed-Point "Bang-Bang Control" Model

Stateflow software includes example models with applications of fixed-point data. For this example, load the model by typing `sf_boiler` at the MATLAB command prompt.

When you simulate the model, you get these results:
Explore the Fixed-Point "Bang-Bang Control" Model

To explore the model, follow these steps:

1. Double-click the Boiler Plant model subsystem block.

   The subsystem appears.
The Boiler Plant model subsystem simulates the temperature reaction of the boiler to periods of heating or cooling dictated by the Stateflow block. Depending on the Boolean value coming from the Controller, a temperature increment (+1 for heating, -0.1 for cooling) is added to the previous boiler temperature. The resulting boiler temperature is sent to the digital thermometer subsystem block.

2 In the Boiler Plant model subsystem, double-click the digital thermometer subsystem block.

The subsystem appears.

The digital thermometer subsystem produces an 8-bit fixed-point representation of the input temperature with the blocks described in the sections that follow.

**sensor Block**

The sensor block converts input boiler temperature \( T \) to an intermediate analog voltage output \( V \) with a first-order polynomial that gives this output:

\[
V = 0.05 \times T + 0.75
\]

**ADC Block**

Double-click the ADC block to reveal these contents:
The ADC subsystem digitizes the analog voltage from the sensor block by multiplying the analog voltage by 256/5, rounding it to its integer floor, and limiting it to a maximum of 255 (the largest unsigned 8-bit integer value). Using the value for the output \( V \) from the sensor block, the new digital coded temperature output by the ADC block, \( T_{\text{digital}} \), is given by this equation:

\[
T_{\text{digital}} = (256/5) \times V = (256 \times 0.05/5) \times T + (256/5) \times 0.75
\]

**Linear fixed point conversion Block**

The Linear fixed point conversion block informs the rest of the model that \( T_{\text{digital}} \) is a fixed-point number with a slope value of \( 5/256/0.05 \) and an intercept value of \( -0.75/0.05 \). The Stateflow block Bang-Bang Controller receives this output and interprets it as a fixed-point number through the Stateflow data \( \text{temp} \), which is scoped as Input from Simulink and set as an unsigned 8-bit fixed-point data with the same values for \( S \) and \( B \) set in the Linear fixed point conversion block.

The values for \( S \) and \( B \) are determined from the general expression for a fixed-point number:

\[
V = SQ + B
\]

Therefore,

\[
Q = (V - B)/S = (1/S) \times V + (-1/S) \times B
\]

Since \( T_{\text{digital}} \) is now a fixed-point number, it is now the quantized integer \( Q \) of a fixed-point type. This means that \( T_{\text{digital}} = Q \) of its fixed-point type, which gives this relation:

\[
(1/S) \times V + (-1/S) \times B = (256 \times 0.05/5) \times T + (256/5) \times 0.75
\]

Since \( T \) is the real-world value for the environment temperature, the above equation implies these relations:

\[
V = T
\]
and

\[ \frac{1}{S} = \frac{(256 \times 0.05)}{5} \]

\[ S = \frac{5}{(256 \times 0.05)} = 0.390625 \]

and

\[ (-1/S) \times B = \frac{(256/5)}{0.75} \]

\[ B = -\frac{(256/5)}{0.75} \times \frac{5}{(256 \times 0.05)} = -\frac{0.75}{0.05} = 15 \]

By setting \( T_{\text{digital}} \) to be a fixed-point data as the output of the Linear fixed point conversion block and the input of the Stateflow block Bang-Bang Controller, the Stateflow chart interprets and processes this data automatically in an 8-bit environment with no need for any explicit conversions.
Use Fixed-Point Parameters and Local Data

Goal of the Tutorial

In the sections that follow, you build a model that uses fixed-point parameters and local data in a Stateflow chart. In this model, the chart acts as a low-pass Butterworth filter:

Building this model requires a Signal Processing Toolbox™ license.

Build the Fixed-Point Butterworth Filter

In this section, you create a stateless flow chart that accepts one input and provides one output.

1. At the MATLAB prompt, type `sfnew` to create a new model with an empty chart.
2. In your chart, add a flow chart with a single branch:

   ```
   { 
   y = x*b0 + x_n1;b1 - y_n1*a1; 
   x_n1 = x; 
   y_n1 = y; 
   }
   ```

   The values b0, b1, and a1 are the coefficients of the low-pass Butterworth filter. For more information about the filter coefficients, see “Define the Model Callback Function” on page 21-17.
3. Add the following data to your chart:
Define the Model Callback Function

In this section, you define a preload callback for the model. This callback function computes the values for $b0$, $b1$, and $a1$ in the chart.

1. Open the Model Properties dialog box by selecting **File > Model Properties > Model Properties** in the model window.
2. In the **Callbacks** tab, select **PreLoadFcn**.
3. Enter the following MATLAB code for the preload function:

   ```matlab
   Fs = 1000;
   Fc = 50;
   [B,A] = butter(1,2*pi*Fc/(Fs/2));
   b0 = B(1);
   b1 = B(2);
   a1 = A(2);
   ```

   In the code:
   
   - The sampling frequency $Fs$ is 1000 Hz.
   - The cutoff frequency $Fc$ is 50 Hz.
   - The `butter` function constructs a first-order low-pass Butterworth filter with a normalized cutoff frequency of $(2\pi Fc/(Fs/2))$ radians per second. The function output $B$ contains the numerator coefficients of the filter in descending powers of $z$. The function output $A$ contains the denominator coefficients of the filter in descending powers of $z$. 

4. Save your model.
4 Click **OK** to close the dialog box.
5 Save your model.

**Add Other Blocks to the Model**

In this section, you add the remaining blocks to the model.

1 Open the Simulink Library Browser.
2 From the Simulink/Sources library, add a Sine Wave block with the following parameter settings to the model:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sine type</td>
<td>Time based</td>
</tr>
<tr>
<td>Time</td>
<td>Use simulation time</td>
</tr>
<tr>
<td>Amplitude</td>
<td>1</td>
</tr>
<tr>
<td>Bias</td>
<td>0</td>
</tr>
<tr>
<td>Frequency</td>
<td>2<em>pi</em>Fc</td>
</tr>
<tr>
<td>Phase</td>
<td>0</td>
</tr>
<tr>
<td>Sample time</td>
<td>1/Fs</td>
</tr>
<tr>
<td>Interpret vector parameters as 1-D</td>
<td>On</td>
</tr>
</tbody>
</table>

The Sine Wave block provides the signal that you want to filter using the Stateflow chart. This block outputs a floating-point signal.

3 From the Simulink/Signal Attributes library, add a Data Type Conversion block with the following parameter settings to the model:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output minimum</td>
<td>[]</td>
</tr>
<tr>
<td>Output maximum</td>
<td>[]</td>
</tr>
<tr>
<td>Output data type</td>
<td>fixdt(1,16,14)</td>
</tr>
<tr>
<td>Lock output data type setting against changes by the fixed-point tools</td>
<td>Off</td>
</tr>
<tr>
<td>Input and output to have equal</td>
<td>Real World Value (RWV)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Setting</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Integer rounding mode</td>
<td>Floor</td>
</tr>
<tr>
<td>Saturate on integer overflow</td>
<td>Off</td>
</tr>
<tr>
<td>Sample time</td>
<td>-1</td>
</tr>
</tbody>
</table>

The Data Type Conversion block converts the floating-point signal from the Sine Wave block to a fixed-point signal. By converting the signal to a fixed-point type, the model can simulate using less memory.

4. From the Simulink/Sinks library, add a Scope block to the model.

5. Connect and label the blocks as follows:

6. Close the Library Browser and save your model.

**Set Model Configuration Parameters**

In this section, you specify solver and diagnostic options for simulation.

1. In the Stateflow Editor, select **Simulation > Model Configuration Parameters**.

2. In the **Solver** pane, set the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop time</td>
<td>0.1</td>
</tr>
<tr>
<td>Type</td>
<td>Fixed-step</td>
</tr>
<tr>
<td>Solver</td>
<td>discrete (no continuous states)</td>
</tr>
<tr>
<td>Fixed-step size (fundamental sample time)</td>
<td>1/Fs</td>
</tr>
</tbody>
</table>
Because none of the blocks in your model have a continuous sample time, a discrete solver is appropriate. For more information, see “Choose a Solver” (Simulink).

3 Click **OK** to close the dialog box.
4 Save and close your model.

**Run the Model**

When you reopen and simulate the model, you see these results in the scope:
The top signal shows the fixed-point version of the sine wave input to the chart. The bottom signal corresponds to the filtered output from the chart. The filter removes high-frequency values from the signal but allows low-frequency values to pass through the chart unchanged.
Operations with Fixed-Point Data

Supported Operations with Fixed-Point Operands

Binary Operations

These binary operations work with fixed-point operands in the following order of precedence (0 = highest, 8 = lowest). For operations with equal precedence, they evaluate in order from left to right:

<table>
<thead>
<tr>
<th>Example</th>
<th>Precedence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a %% b</td>
<td>0</td>
<td>Remainder</td>
</tr>
<tr>
<td>a * b</td>
<td>1</td>
<td>Multiplication</td>
</tr>
<tr>
<td>a / b</td>
<td>1</td>
<td>Division</td>
</tr>
<tr>
<td>a + b</td>
<td>2</td>
<td>Addition</td>
</tr>
<tr>
<td>a - b</td>
<td>2</td>
<td>Subtraction</td>
</tr>
<tr>
<td>a &gt; b</td>
<td>3</td>
<td>Comparison, greater than</td>
</tr>
<tr>
<td>a &lt; b</td>
<td>3</td>
<td>Comparison, less than</td>
</tr>
<tr>
<td>a &gt;= b</td>
<td>3</td>
<td>Comparison, greater than or equal to</td>
</tr>
<tr>
<td>a &lt;= b</td>
<td>3</td>
<td>Comparison, less than or equal to</td>
</tr>
<tr>
<td>a == b</td>
<td>4</td>
<td>Comparison, equality</td>
</tr>
<tr>
<td>a ~= b</td>
<td>4</td>
<td>Comparison, inequality</td>
</tr>
<tr>
<td>a != b</td>
<td>4</td>
<td>Comparison, inequality</td>
</tr>
<tr>
<td>a &lt;&gt; b</td>
<td>4</td>
<td>Comparison, inequality</td>
</tr>
<tr>
<td>Example</td>
<td>Precedence</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| $a \& b$ | 5          | One of the following:  
  - Bitwise AND  
    - Enabled when **Enable C-bit operations** is selected in the Chart properties dialog box. See “Specify Chart Properties” on page 23-3. Operands are cast to integers before the operation is performed.  
  - Logical AND  
    - Enabled when **Enable C-bit operations** is cleared in the Chart properties dialog box. |
| $a \mid b$ | 6          | One of the following:  
  - Bitwise OR  
    - Enabled when **Enable C-bit operations** is selected in the Chart properties dialog box. See “Specify Chart Properties” on page 23-3. Operands are cast to integers before the operation is performed.  
  - Logical OR  
    - Enabled when **Enable C-bit operations** is cleared in the Chart properties dialog box. |
| $a \&\& b$ | 7          | Logical AND |
| $a \mid\mid b$ | 8         | Logical OR |

**Unary Operations and Actions**

These unary operations and actions work with fixed-point operands:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\neg a$</td>
<td>Unary minus</td>
</tr>
<tr>
<td>$! a$</td>
<td>Logical NOT</td>
</tr>
<tr>
<td>$a++$</td>
<td>Increment</td>
</tr>
<tr>
<td>$a--$</td>
<td>Decrement</td>
</tr>
</tbody>
</table>
Assignment Operations

These assignment operations work with fixed-point operands:

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a = expression</td>
<td>Simple assignment</td>
</tr>
<tr>
<td>a += expression</td>
<td>Equivalent to a = a + expression</td>
</tr>
<tr>
<td>a -= expression</td>
<td>Equivalent to a = a - expression</td>
</tr>
<tr>
<td>a *= expression</td>
<td>Equivalent to a = a * expression</td>
</tr>
<tr>
<td>a /= expression</td>
<td>Equivalent to a = a / expression</td>
</tr>
<tr>
<td>a</td>
<td>= expression</td>
</tr>
<tr>
<td>a &amp;^= expression</td>
<td>Equivalent to a = a &amp; expression (bit operation). See operation a &amp; b in “Binary Operations” on page 21-22.</td>
</tr>
</tbody>
</table>

Promotion Rules for Fixed-Point Operations

Operations with at least one fixed-point operand require rules for selecting the type of the intermediate result for that operation. For example, in the action statement c = a + b, where a or b is a fixed-point number, an intermediate result type for a + b must first be chosen before the result is calculated and assigned to c.

The rules for selecting the numeric types used to hold the results of operations with a fixed-point number are called fixed-point promotion rules. The goal of these rules is to maintain computational efficiency and usability.

Note You can use the := assignment operator to override the fixed-point promotion rules and obtain greater accuracy. However, in this case, greater accuracy can require more computational steps. See “Assignment Operator :=” on page 21-30.

The following topics describe the process of selecting an intermediate result type for binary operations with at least one fixed-point operand.
Default Selection of the Number of Bits of the Result Type

A fixed-point number with $S = 1$ and $B = 0$ is treated as an integer. In operations with integers, the C language promotes any integer input with fewer bits than the type int to the type int and then performs the operation.

The type int is the integer word size for C on a given platform. Result word size is increased to the integer word size because processors can perform operations at this size efficiently.

To maintain consistency with the C language, this default rule applies to assigning the number of bits for the result type of an operation with fixed-point numbers:

When both operands are fixed-point numbers, the number of bits in the result type is the maximum number of bits in the input types or the number of bits in the integer word size for the target machine, whichever is larger.

Note The preceding rule is a default rule for selecting the bit size of the result for operations with fixed-point numbers. This rule is overruled for specific operations as described in the sections that follow.

Set the Integer Word Size for a Target

The preceding default rule for selecting the bit size of the result for operations with fixed-point numbers relies on the definition of the integer word size for your target. You can set the integer word size for the targets that you build in Simulink models with these steps:

1. In the Stateflow Editor, select Simulation > Model Configuration Parameters.
2. Select Hardware Implementation in the left navigation panel.
   The right panel displays configuration parameters for production hardware and test hardware.
3. To set integer word size for production hardware, follow these steps:
   - In the drop-down menu for the Device type field, select Custom.
   - In the int field, enter a word size in bits.
4. To set integer word size for test hardware, follow these steps:
   - If no configuration fields appear, clear the None check box.
• In the drop-down menu for the **Device type** field, select **Custom**.
• In the **int** field, enter a word size in bits.

5  Click **OK** to accept the changes.

When you build any target after making this change, the generated code uses this integer size to select result types for your fixed-point operations.

**Note**  Set all available integer sizes because they affect code generation. The integer sizes do not affect the implementation of the fixed-point promotion rules in generated code.

### Unary Promotions

Only the unary minus (-) operation requires a promotion of its result type. The word size of the result is given by the default procedure for selecting the bit size of the result type for an operation involving fixed-point data. See “Default Selection of the Number of Bits of the Result Type” on page 21-25. The bias, \( B \), of the result type is the negative of the bias of the operand.

#### Binary Operation Promotion for Integer Operand with Fixed-Point Operand

Integers as operands in binary operations with fixed-point numbers are treated as fixed-point numbers of the same word size with slope, \( S \), equal to 1, and a bias, \( B \), equal to 0. The operation now becomes a binary operation between two fixed-point operands. See “Binary Operation Promotion for Two Fixed-Point Operands” on page 21-27.

#### Binary Operation Promotion for Double Operand with Fixed-Point Operand

When one operand is of type **double** in a binary operation with a fixed-point type, the result type is **double**. In this case, the fixed-point operand is cast to type **double**, and the operation is performed.

#### Binary Operation Promotion for Single Operand with Fixed-Point Operand

When one operand is of type **single** in a binary operation with a fixed-point type, the result type is **single**. In this case, the fixed-point operand is cast to type **single**, and the operation is performed.
Binary Operation Promotion for Two Fixed-Point Operands

Operations with both operands of fixed-point type produce an intermediate result of fixed-point type. The resulting fixed-point type is chosen through the application of a set of operator-specific rules. The procedure for producing an intermediate result type from an operation with operands of different fixed-point types is summarized in these topics:

- “Addition (+) and Subtraction (-)” on page 21-27
- “Multiplication (*) and Division (/)” on page 21-27
- “Relational Operations (>, <, >=, <=, ==, -=, !=, <>)” on page 21-28
- “Logical Operations (&, |, &&, ||)” on page 21-28

Addition (+) and Subtraction (-)

The output type for addition and subtraction is chosen so that the maximum positive range of either input can be represented in the output while preserving maximum precision. The base word type of the output follows the rule in “Default Selection of the Number of Bits of the Result Type” on page 21-25. To simplify calculations and yield efficient code, the biases of the two inputs are added for an addition operation and subtracted for a subtraction operation.

Note Mixing signed and unsigned operands can yield unexpected results and is not recommended.

Multiplication (*) and Division (/)

The output type for multiplication and division is chosen to yield the most efficient code implementation. You cannot use nonzero biases for multiplication and division in Stateflow charts (see note).

The slope for the result type of the product of the multiplication of two fixed-point numbers is the product of the slopes of the operands. Similarly, the slope of the result type of the quotient of the division of two fixed-point numbers is the quotient of the slopes. The base word type is chosen to conform to the rule in “Default Selection of the Number of Bits of the Result Type” on page 21-25.

Note Because nonzero biases are computationally very expensive, those biases are not supported for multiplication and division.
Relational Operations (> , < , >= , <= , == , -= , != , <>)

You can use the following relational (comparison) operations on all fixed-point types: >, <, >=, <=, ==, -=, !=, <>. See “Supported Operations with Fixed-Point Operands” on page 21-22 for an example and description of these operations. Both operands in a comparison must have equal biases (see note).

Comparing fixed-point values of different types can yield unexpected results because each operand must convert to a common type for comparison. Because of rounding or overflow errors during the conversion, values that do not appear equal might be equal and values that appear to be equal might not be equal.

Note To preserve precision and minimize unexpected results, both operands in a comparison operation must have equal biases.

For example, compare these two unsigned 8-bit fixed-point numbers, a and b, in an 8-bit target environment:

<table>
<thead>
<tr>
<th>Fixed-Point Number a</th>
<th>Fixed-Point Number b</th>
</tr>
</thead>
<tbody>
<tr>
<td>( S_a = 2^{-4} )</td>
<td>( S_b = 2^{-2} )</td>
</tr>
<tr>
<td>( B_a = 0 )</td>
<td>( B_b = 0 )</td>
</tr>
<tr>
<td>( V_a = 43.8125 )</td>
<td>( V_b = 43.75 )</td>
</tr>
<tr>
<td>( Q_a = 701 )</td>
<td>( Q_b = 175 )</td>
</tr>
</tbody>
</table>

By rule, the result type for comparison is 8-bit. Converting b, the least precise operand, to the type of a, the most precise operand, could result in overflow. Consequently, a is converted to the type of b. Because the bias values for both operands are 0, the conversion occurs as follows:

\[
S_b \ (\text{new}Q_a) = S_aQ_a
\]

\[
\text{new}Q_a = (S_aS_b) Q_a = (2^{-4}/2^{-2}) \times 701 = 701/4 = 175
\]

Although they represent different values, a and b are considered equal as fixed-point numbers.

Logical Operations (&, |, &&, ||)

If a is a fixed-point number used in a logical operation, it is interpreted with the equivalent substitution \( a != 0.0C \) where \( 0.0C \) is an expression for zero in the fixed-
point type of \( a \) (see “Fixed-Point Context-Sensitive Constants” on page 21-7). For example, if \( a \) is a fixed-point number in the logical operation \( a \&\& b \), this operation is equivalent to the following:

\[
(a \neq 0.0C) \&\& b
\]

The preceding operation is not a check to see whether the quantized integer for \( a \), \( Q_a \), is not 0. If the real-world value for a fixed-point number \( a \) is 0, this implies that \( V_a = S_a Q_a + B_a = 0.0 \). Therefore, the expression \( a \neq 0 \), for fixed-point number \( a \), is equivalent to this expression:

\[
Q_a \neq -B_a / S_a
\]

For example, if a fixed-point number, \( a \), has a slope of \( 2^{-2} \), and a bias of 5, the test \( a \neq 0 \) is equivalent to the test \( \text{if } Q_a \neq -20. \)

**Assignment (=, :=) Operations**

In charts that use C as the action language, you can use the assignment operations \( \text{LHS} = \text{RHS} \) and \( \text{LHS} := \text{RHS} \) between a left-hand side (LHS) and a right-hand side (RHS). See these topics for examples that contrast the two assignment operations:

- “Assignment Operator =” on page 21-29
- “Assignment Operator :=” on page 21-30
- “When to Use the := Operator Instead of the = Operator” on page 21-30
- “Avoid Overflow Using the := Operator for Addition and Subtraction” on page 21-30
- “Avoid Overflow Using the := Operator for Multiplication” on page 21-33
- “Improve Precision Using the := Operator for Division” on page 21-34
- “:= Assignment and Context-Sensitive Constants” on page 21-36

**Assignment Operator =**

An assignment statement of the type \( \text{LHS} = \text{RHS} \) is equivalent to casting the right-hand side to the type of the left-hand side. For charts that use C as the action language, you can use any assignment between fixed-point types and therefore, implicitly, any cast.

A cast converts the stored integer \( Q \) from its original fixed-point type while preserving its value as accurately as possible using the online conversions (see “Fixed-Point Conversion Operations” on page 21-36). Assignments are most efficient when both types have the same bias, and slopes that are equal or both powers of 2.
Assignment Operator :=

Ordinarily, the fixed-point promotion rules determine the result type for an operation. Using the := assignment operator overrides this behavior by using the type of the LHS as the result type of the RHS operation.

These rules apply to the := assignment operator:

- The RHS can contain at most one binary operator.
- If the RHS contains anything other than an addition (+), subtraction (-), multiplication (*), or division (/) operation, or a constant, then the := assignment behaves like regular assignment (=).
- Constants on the RHS of an LHS := RHS assignment are converted to the type of the left-hand side using offline conversion (see “Fixed-Point Conversion Operations” on page 21-36). Ordinary assignment always casts the RHS using online conversions.

When to Use the := Operator Instead of the = Operator

Use the := assignment operator instead of the = assignment operator in these cases:

- Arithmetic operations where you want to avoid overflow
- Multiplication and division operations where you want to retain precision

Caution Using the := assignment operator to produce a more accurate result can generate code that is less efficient than the code you generate using the normal fixed-point promotion rules.

Avoid Overflow Using the := Operator for Addition and Subtraction

This model contains a Stateflow chart with two inputs and eight outputs.
The chart contains a graphical function that compares the use of the = and := assignment operators.

```plaintext
{  /* Case "=" - general */
    y1 = x1 + x2;
    y2 = x1 - x2;
    y3 = x1 * x2;
    y4 = x1 / x2;

    /* Case ":=" - better computation of the expression*/
    z1 := x1 + x2;
    z2 := x1 - x2;
    z3 := x1 * x2;
    z4 := x1 / x2;
 }
```

If you generate code for this model, you see code similar to this.
/* Exported block signals */
int16_T x1;                /* '<Root>/Input' */
int16_T x2;                /* '<Root>/Input1' */
int32_T y1;                /* '<Root>/Chart' */
int32_T y2;                /* '<Root>/Chart' */
int32_T z1;                /* '<Root>/Chart' */
int32_T z2;                /* '<Root>/Chart' */
int16_T y3;                /* '<Root>/Chart' */
int16_T y4;                /* '<Root>/Chart' */
int16_T z3;                /* '<Root>/Chart' */
int16_T z4;                /* '<Root>/Chart' */
...

/* Model step function */
void doc_sf_colon_equal_step(void)
{
    /* Case "=" - general */
    y1 = x1 + x2;
    y2 = x1 - x2;
    y3 = x1 * x2 >> 3;
    y4 = div_s16_floor(x1, x2) << 3U;

    /* Case ":=" - better computation of the expression */
    z1 = (int32_T)x1 + (int32_T)x2;
    z2 = (int32_T)x1 - (int32_T)x2;
    z3 = (int16_T)((int32_T)x1 * (int32_T)x2 >> 3);
    z4 = (int16_T)(((int32_T)x1 << 3) / (int32_T)x2);
}

The inputs $x_1$ and $x_2$ are signed 16-bit integers with 3 fraction bits. For addition and subtraction, the outputs are signed 32-bit integers with 3 fraction bits.

Assume that the integer word size for production targets is 16 bits. To learn how to change the integer word size for a target, see “Set the Integer Word Size for a Target” on page 21-25.

Because the target int size is 16 bits, you can avoid overflow by using the := operator instead of the = operator. For example, assume that the inputs have these values:

- $x_1 = 2^{15} - 1$
- $x_2 = 1$
Operator | Addition Operation | Result | Overflow
---|---|---|---
= | Adds the inputs in 16 bits before casting the sum to 32 bits | $y_1 = -2^{15}$ | Yes
:= | Casts the inputs to 32 bits before computing the sum | $z_1 = +2^{15}$ | No

Similarly, you can avoid overflow for subtraction if you use the := operator instead of the = operator.

**Avoid Overflow Using the := Operator for Multiplication**

The following example contrasts the := and = assignment operators for multiplication. You can use the := operator to avoid overflow in the multiplication $c = a \times b$, where $a$ and $b$ are two fixed-point operands. The operands and result for this operation are 16-bit unsigned integers with these assignments:

<table>
<thead>
<tr>
<th>Fixed-Point Number $a$</th>
<th>Fixed-Point Number $b$</th>
<th>Fixed-Point Number $c$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$S_a = 2^{-4}$</td>
<td>$S_b = 2^{-4}$</td>
<td>$S_c = 2^{-5}$</td>
</tr>
<tr>
<td>$B_a = 0$</td>
<td>$B_b = 0$</td>
<td>$B_c = 0$</td>
</tr>
<tr>
<td>$V_a = 20.1875$</td>
<td>$V_b = 15.3125$</td>
<td>$V_c = ?$</td>
</tr>
<tr>
<td>$Q_a = 323$</td>
<td>$Q_b = 245$</td>
<td>$Q_c = ?$</td>
</tr>
</tbody>
</table>

where $S$ is the slope, $B$ is the bias, $V$ is the real-world value, and $Q$ is the quantized integer.

$c = a \times b$

In this case, first calculate an intermediate result for $a \times b$ in the fixed-point type given by the rules in the section “Fixed-Point Operations” on page 21-3. Then cast that result to the type for $c$.

The calculation of intermediate value occurs as follows:

$$Q_{iv} = Q_a Q_b = 323 \times 245 = 79135$$
Because the maximum value of a 16-bit unsigned integer is $2^{16} - 1 = 65535$, the preceding result overflows its word size. An operation that overflows its type produces an undefined result.

You can capture overflow errors like the preceding example during simulation. See “Detect Overflow for Fixed-Point Types” on page 21-9.

$c := a*b$

In this case, calculate $a*b$ directly in the type of $c$. Use the solution for $Q_c$ given in “Fixed-Point Operations” on page 21-3 with the requirement of zero bias, which occurs as follows:

\[
Q_c = ((S_a S_b / S_c) Q_a Q_b) = (2^{-4} \times 2^{-4} / 2^{-5}) (323 \times 245) = 79135 / 8 = 9892
\]

No overflow occurs in this case, and the approximate real-world value is as follows:

\[
\bar{V}_c = S_c Q_c = 2^{-5} \times 9892 = 9892 / 32 = 309.125
\]

This value is very close to the actual result of 309.121.

**Improve Precision Using the := Operator for Division**

The following example contrasts the := and = assignment operators for division. You can use the := operator to obtain a more precise result for the division of two fixed-point operands, $a$ and $b$, in the statement $c := a/b$.

This example uses the following fixed-point numbers, where $S$ is the slope, $B$ is the bias, $V$ is the real-world value, and $Q$ is the quantized integer:

<table>
<thead>
<tr>
<th>Fixed-Point Number a</th>
<th>Fixed-Point Number b</th>
<th>Fixed-Point Number c</th>
</tr>
</thead>
<tbody>
<tr>
<td>$S_a = 2^{-4}$</td>
<td>$S_b = 2^{-3}$</td>
<td>$S_c = 2^{-6}$</td>
</tr>
<tr>
<td>$B_a = 0$</td>
<td>$B_b = 0$</td>
<td>$B_c = 0$</td>
</tr>
<tr>
<td>$V_a = 2$</td>
<td>$V_b = 3$</td>
<td>$V_c =$ ?</td>
</tr>
<tr>
<td>$Q_a = 32$</td>
<td>$Q_b = 24$</td>
<td>$Q_c =$ ?</td>
</tr>
</tbody>
</table>
\( c = \frac{a}{b} \)

In this case, first calculate an intermediate result for \( \frac{a}{b} \) in the fixed-point type given by the rules in the section “Fixed-Point Operations” on page 21-3. Then cast that result to the type for \( c \).

The calculation of intermediate value occurs as follows:

\[
Q_{iv} = \frac{Q_a}{Q_b} = \frac{32}{24} = 1
\]

The intermediate value is then cast to the result type for \( c \) as follows:

\[
S_c Q_c = S_{iv} Q_{iv}
\]

\[
Q_c = \frac{S_{iv}}{S_c} Q_{iv}
\]

The calculation for slope of the intermediate value for a division operation occurs as follows:

\[
S_{iv} = \frac{S_a}{S_b} = 2^{-4} / 2^{-3} = 2^{-1}
\]

Substitution of this value into the preceding result yields the final result.

\[
Q_c = 2^{-1} / 2^{-6} = 2^5 = 32
\]

In this case, the approximate real-world value is \( \tilde{V}_c = \frac{32}{64} = 0.5 \), which is not a very good approximation of the actual result of \( \frac{2}{3} \).

\( c := \frac{a}{b} \)

In this case, calculate \( \frac{a}{b} \) directly in the type of \( c \). Use the solution for \( Q_c \) given in “Fixed-Point Operations” on page 21-3 with the simplification of zero bias, which is as follows:

\[
Q_c = \frac{(S_a Q_a)}{(S_c (S_b Q_b))} = \frac{(S_a)}{(S_b S_c)} \times (Q_a / Q_b) = (2^{-4} / (2^{-3} \times 2^{-6})) \times (32 / 24) = 42
\]

In this case, the approximate real-world value is as follows:

\[
\tilde{V}_c = 42 / 64 = 0.6563
\]
This value is a much better approximation to the precise result of 2/3.

**:= Assignment and Context-Sensitive Constants**

In a := assignment operation, the type of the left-hand side (LHS) determines part of the context used for inferring the type of a right-hand side (RHS) context-sensitive constant.

These rules apply to RHS context-sensitive constants in assignments with the := operator:

- If the LHS is a floating-point data (type `double` or `single`), the RHS context-sensitive constant becomes a floating-point constant.
- For addition and subtraction, the type of the LHS determines the type of the context-sensitive constant on the RHS.
- For multiplication and division, the type of the context-sensitive constant is chosen independently of the LHS.

**Fixed-Point Conversion Operations**

Real numbers are converted into fixed-point data during data initialization and as part of casting operations in the application. These conversions compute a quantized integer, $Q$, from a real number input. Offline conversions initialize data, and online conversions perform casting operations in the running application. The topics that follow describe each conversion type and give examples of the results.

**Offline Conversions for Initialized Data**

Offline conversions are performed during code generation and are designed to maximize accuracy. These conversions round the resulting quantized integer to its nearest integer value. If the conversion overflows, the result saturates the value for $Q$.

Offline conversions are performed for these operations:

- Initialization of data (both variables and constants) in the Stateflow hierarchy
- Initialization of constants or variables from the MATLAB workspace

**Online Conversions for Casting Operations**

Online conversions are performed for casting operations that take place during execution of the application. Designed to maximize computational efficiency, they are faster and more efficient than offline conversions, but less precise. Instead of rounding $Q$ to its nearest integer, online conversions round to the floor (with the exception of division,
which can round to 0, depending on the C compiler you have). If the conversion overflows the type to which you convert, the result is undefined.

**Offline and Online Conversion Examples**

The following examples show the difference in the results of offline and online conversions of real numbers to a fixed-point type defined by a 16-bit word size, a slope \( S \) equal to \( 2^{-4} \), and a bias \( B \) equal to 0:

<table>
<thead>
<tr>
<th>( V )</th>
<th>( V/S )</th>
<th>( Q )</th>
<th>( \tilde{V} )</th>
<th>( Q )</th>
<th>( \tilde{V} )</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.45</td>
<td>55.2</td>
<td>55</td>
<td>3.4375</td>
<td>55</td>
<td>3.4375</td>
</tr>
<tr>
<td>1.0375</td>
<td>16.6</td>
<td>17</td>
<td>1.0625</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>2.06</td>
<td>32.96</td>
<td>33</td>
<td>2.0625</td>
<td>32</td>
<td>2</td>
</tr>
</tbody>
</table>

In the preceding example,

- \( V \) is the real-world value represented as a fixed-point value.
- \( V/S \) is the floating-point computation for the quantized integer \( Q \).
- \( Q \) is the rounded value of \( V/S \).
- \( \tilde{V} \) is the approximate real-world value resulting from \( Q \) for each conversion.

**Automatic Scaling of Stateflow Fixed-Point Data**

Automatic scaling tools can change the settings of Stateflow fixed-point data. You can prevent automatic scaling by selecting the **Lock data type setting against changes by the fixed-point tools** check box in the Data properties dialog box for fixed-point data (see “Set Data Properties” on page 9-7 for details). Selecting this check box prevents replacement of the current fixed-point type with a type that the “Fixed-Point Tool” (Fixed-Point Designer) or “Fixed-Point Advisor” (Fixed-Point Designer) chooses. For methods on autoscaling fixed-point data, see “Choosing a Range Collection Method” (Fixed-Point Designer).
Complex Data in C Charts

• “How Complex Data Works in C Charts” on page 22-2
• “Define Complex Data Using the Editor” on page 22-4
• “Complex Data Operations for Charts That Support C Expressions” on page 22-7
• “Define Complex Data Using Operators” on page 22-9
• “Rules for Using Complex Data in C Charts” on page 22-12
• “Best Practices for Using Complex Data in C Charts” on page 22-15
• “Detect Valid Transmission Data Using Frame Synchronization” on page 22-19
• “Measure Frequency Response Using a Spectrum Analyzer” on page 22-23
How Complex Data Works in C Charts

In this section...

“What Is Complex Data?” on page 22-2
“When to Use Complex Data” on page 22-2
“When You Can Use Complex Data” on page 22-2
“How You Can Use Complex Data” on page 22-3

What Is Complex Data?

Complex data is data whose value is a complex number. For example, an input signal with the value $3 + 5i$ is complex. See “Complex Signals” (Simulink).

When to Use Complex Data

Use complex data when you model applications in communication systems and digital signal processing. For example, you can use this design pattern to model a frame synchronization algorithm in a communication system:

1. Use Simulink blocks (such as filters) to process complex signals.
2. Use charts to implement mode logic for frame synchronization.
3. Let the charts access complex input and output data so that nested MATLAB functions can drive the mode logic.

For an example of modeling a frame synchronization algorithm, see “Detect Valid Transmission Data Using Frame Synchronization” on page 22-19.

Note Continuous-time variables of complex type are not supported. For more information, see “Define Continuous-Time Variables” on page 20-9.

Where You Can Use Complex Data

You can define complex data at these levels of the Stateflow hierarchy:

- Charts
• Subcharts
• States
• Functions

How You Can Use Complex Data

You can use complex data to define:

• Complex vectors
• Complex matrices

You can also use complex data as arguments for:

• State actions
• Transition actions
• MATLAB functions (see “MATLAB Functions in a Chart” on page 27-2)
• Truth table functions (see “What Is a Truth Table?” on page 26-2)
• Graphical functions (see “Reuse Logic Patterns Using Graphical Functions” on page 8-26)
• Change detection operators (see “Detect Changes in Data Values” on page 12-74)

Note Exported functions do not support complex data as arguments.

For more information, see “Complex Data Operations for Charts That Support C Expressions” on page 22-7 and “Rules for Using Complex Data in C Charts” on page 22-12.
Define Complex Data Using the Editor

Define complex data in a chart as follows:

1. In the Stateflow Editor, select one of the following options:
   - Chart > Add Inputs & Outputs > Data Input From Simulink
   - Chart > Add Inputs & Outputs > Data Output To Simulink
   - Chart > Add Other Elements > Local Data

A default definition of the new data object appears in the Stateflow hierarchy, and the Data properties dialog box appears.
Note Complex data does not support the scope Constant.

2 In the Complexity field of the Data properties dialog box, select On.
3 Specify the name, size, base type, and other properties for the new data object as described in “Set Data Properties” on page 9-7.

Note Complex data does not support the base types `ml`, `struct`, and `boolean`. See “Built-In Data Types” on page 9-42 for more information.

4 Click **OK**.
Complex Data Operations for Charts That Support C Expressions

In this section...

“Binary Operations” on page 22-7
“Unary Operations and Actions” on page 22-7
“Assignment Operations” on page 22-8

Binary Operations

These binary operations work with complex operands in the following order of precedence (1 = highest, 3 = lowest). For operations with equal precedence, they evaluate in order from left to right.

<table>
<thead>
<tr>
<th>Example</th>
<th>Precedence</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a * b</td>
<td>1</td>
<td>Multiplication</td>
</tr>
<tr>
<td>a + b</td>
<td>2</td>
<td>Addition</td>
</tr>
<tr>
<td>a - b</td>
<td>2</td>
<td>Subtraction</td>
</tr>
<tr>
<td>a == b</td>
<td>3</td>
<td>Comparison, equality</td>
</tr>
<tr>
<td>a != b</td>
<td>3</td>
<td>Comparison, inequality</td>
</tr>
</tbody>
</table>

C charts do not support division of complex operands because this operation requires a numerically stable implementation, especially when the base type of the complex data is fixed-point.

To perform complex division, use a MATLAB function, which provides a numerically accurate and stable result. For details, see “Perform Complex Division with a MATLAB Function” on page 22-16.

Unary Operations and Actions

These unary operations and actions work with complex operands.
Example | Description
--- | ---
\(~a\) | Unary minus
\(!a\) | Logical NOT
\(a++\) | Increment
\(a--\) | Decrement

**Assignment Operations**

These assignment operations work with complex operands.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a = \text{expression})</td>
<td>Simple assignment</td>
</tr>
<tr>
<td>(a += \text{expression})</td>
<td>Equivalent to (a = a + \text{expression})</td>
</tr>
<tr>
<td>(a -= \text{expression})</td>
<td>Equivalent to (a = a - \text{expression})</td>
</tr>
<tr>
<td>(a *= \text{expression})</td>
<td>Equivalent to (a = a * \text{expression})</td>
</tr>
</tbody>
</table>
Define Complex Data Using Operators

In this section...

“Why Use Operators for Complex Numbers?” on page 22-9
“Define a Complex Number” on page 22-9
“Access Real and Imaginary Parts of a Complex Number” on page 22-10
“Work with Vector Arguments” on page 22-11

Why Use Operators for Complex Numbers?

Use operators to handle complex numbers because a C chart does not support complex number notation \((a + bi)\), where \(a\) and \(b\) are real numbers.

Define a Complex Number

To define a complex number based on two real values, use the `complex` operator described below.

**complex Operator**

**Syntax**

`complex(realExp, imagExp)`

where `realExp` and `imagExp` are arguments that define the real and imaginary parts of a complex number, respectively. The two arguments must be real values or expressions that evaluate to real values, where the numeric types of both arguments are identical.

**Description**

The `complex` operator returns a complex number based on the input arguments.

**Example**

`complex(3.24*pi, -9.99)`

This expression returns the complex number \(10.1788 - 9.9900i\).
Access Real and Imaginary Parts of a Complex Number

To access the real and imaginary parts of a complex number, use the operators real and imag described below.

**real Operator**

**Syntax**

real(compExp)

where compExp is an expression that evaluates to a complex number.

**Description**

The real operator returns the value of the real part of a complex number.

**Note** If the input argument is a purely imaginary number, the real operator returns a value of 0.

**Example**

real(frame(200))

If the expression frame(200) evaluates to the complex number 8.23 + 4.56i, the real operator returns a value of 8.2300.

**imag Operator**

**Syntax**

imag(compExp)

where compExp is an expression that evaluates to a complex number.

**Description**

The imag operator returns the value of the imaginary part of a complex number.

**Note** If the input argument is a real number, the imag operator returns a value of 0.
Example

imag(frame(200))

If the expression frame(200) evaluates to the complex number 8.23 + 4.56i, the imag operator returns a value of 4.5600.

Work with Vector Arguments

The operators complex, real, and imag also work with vector arguments.

<table>
<thead>
<tr>
<th>Example</th>
<th>If the input x is...</th>
<th>Then the output y is...</th>
</tr>
</thead>
<tbody>
<tr>
<td>y = real(x)</td>
<td>An n-dimensional vector of complex values</td>
<td>An n-dimensional vector of real values</td>
</tr>
<tr>
<td>y = imag(x)</td>
<td>An n-dimensional vector of real values</td>
<td>An n-dimensional vector of zeros</td>
</tr>
<tr>
<td>y = complex(real(x), imag(x))</td>
<td>An n-dimensional vector of complex or real values</td>
<td>An n-dimensional vector identical to the input argument</td>
</tr>
</tbody>
</table>
Rules for Using Complex Data in C Charts

These rules apply when you use complex data in C charts.

**Do not use complex number notation in actions**

C charts do not support complex number notation \((a + bi)\), where \(a\) and \(b\) are real numbers. Therefore, you cannot use complex number notation in state actions, transition conditions and actions, or any statements in C charts.

To define a complex number, use the `complex` operator described in “Define Complex Data Using Operators” on page 22-9.

**Do not perform math function operations on complex data in C charts**

Math operations such as `sin`, `cos`, `min`, `max`, and `abs` do not work with complex data in C charts. However, you can use MATLAB functions for these operations.

For more information, see “Perform Math Function Operations with a MATLAB Function” on page 22-15.

**Mix complex and real operands only for addition, subtraction, and multiplication**

If you mix operands for any other math operations in C charts, an error appears when you try to simulate your model.

To mix complex and real operands for division, you can use a MATLAB function as described in “Perform Complex Division with a MATLAB Function” on page 22-16.

**Tip** Another way to mix operands for division is to use the `complex`, `real`, and `imag` operators in C charts.

Suppose that you want to calculate \(y = \frac{x_1}{x_2}\), where \(x_1\) is complex and \(x_2\) is real. You can rewrite this calculation as:

\[
y = \text{complex}(\text{real}(x_1)/x_2, \text{imag}(x_1)/x_2)
\]

For more information, see “Define Complex Data Using Operators” on page 22-9.
**Do not define complex data with constant scope**

If you define complex data with Constant scope, an error appears when you try to simulate your model.

**Do not define complex data with ml, struct, or boolean base type**

If you define complex data with ml, struct, or boolean base type, an error appears when you try to simulate your model.

**Use only real values to set initial values of complex data**

When you define the initial value for data that is complex, use only a real value. See “Set Properties in the Description Pane” on page 9-22 for instructions on setting an initial value in the Data properties dialog box.

**Do not enter minimum or maximum values for complex data**

In the Data properties dialog box, do not enter any values in the Minimum or Maximum field when you define complex data. If you enter a value in either field, an error message appears when you try to simulate your model.

**Assign complex values only to data of complex type**

If you assign complex values to real data types, an error appears when you try to simulate your model.

**Note** You can assign both real and complex values to complex data types.

**Do not pass real values to function inputs of complex type**

This restriction applies to the following types of chart functions:

- Graphical functions
- Truth table functions
- MATLAB functions
- Simulink functions

If your C chart passes real values to function inputs of complex type, an error appears when you try to simulate your model.
**Do not use complex data with temporal logic operators**

You cannot use complex data as an argument for temporal logic operators, because you cannot define time as a complex number.
Perform Math Function Operations with a MATLAB Function

Math functions such as \texttt{sin}, \texttt{cos}, \texttt{min}, \texttt{max}, and \texttt{abs} do not work with complex data in C charts. However, you can use a MATLAB function in your chart to perform math function operations on complex data.

A Simple Example

In the following chart, a MATLAB function calculates the absolute value of a complex number:

```matlab
{ comp_num = complex(1,2); answer = myabs(comp_num) }
```

The value of \texttt{comp\_num} is 1+2i. Calculating the absolute value gives an answer of 2.2361.

How to Calculate Absolute Value

Suppose that you want to find the absolute value of a complex number. Follow these steps:

1. Add a MATLAB function to your chart with this signature:
\begin{verbatim}
y = myabs(u)
end
\end{verbatim}

Double-click the function box to open the editor.

In the editor, enter the code below:

\begin{verbatim}
function y = myabs(u)
    y = abs(u);
end
\end{verbatim}

The function \texttt{myabs} takes a complex input \( u \) and returns the absolute value as an output \( y \).

4 Configure the input argument \( u \) to accept complex values.

a Open the Model Explorer.

b In the \textbf{Model Hierarchy} pane of the Model Explorer, navigate to the MATLAB function \texttt{myabs}.

c In the \textbf{Contents} pane of the Model Explorer, right-click the input argument \( u \) and select \textbf{Properties} from the context menu.

d In the Data properties dialog box, select \texttt{On} in the \textbf{Complexity} field and click \texttt{OK}.

You cannot pass real values to function inputs of complex type. For details, see “Rules for Using Complex Data in C Charts” on page 22-12.

**Perform Complex Division with a MATLAB Function**

Division with complex operands is not available as a binary or assignment operation in C charts. However, you can use a MATLAB function in your chart to perform division on complex data.

**A Simple Example**

In the following chart, a MATLAB function performs division on two complex operands:
The values of \( \text{comp\_num} \) and \( \text{comp\_den} \) are \( 1+2i \) and \( 3+4i \), respectively. Dividing these values gives an answer of \( 0.44+0.08i \).

**How to Perform Complex Division**

To divide two complex numbers:

1. Add a MATLAB function to your chart with this function signature:
   
   \[ y = \text{mydiv}(u1, u2) \]

2. Double-click the function box to open the editor.

3. In the editor, enter the code below:

   ```matlab
   function y = mydiv(u1, u2)
   %#codegen
   y = u1 / u2;
   ```

   The function \text{mydiv} takes two complex inputs, \( u1 \) and \( u2 \), and returns the complex quotient of the two numbers as an output \( y \).

4. Configure the input and output arguments to accept complex values.

   a. Open the Model Explorer.
   
   b. In the **Model Hierarchy** pane of the Model Explorer, navigate to the MATLAB function \text{mydiv}.
   
   c. For each input and output argument, follow these steps:
      
      i. In the **Contents** pane of the Model Explorer, right-click the argument and select **Properties** from the context menu.
In the Data properties dialog box, select On in the Complexity field and click OK.

You cannot pass real values to function inputs of complex type. For details, see “Rules for Using Complex Data in C Charts” on page 22-12.
Detect Valid Transmission Data Using Frame Synchronization

This model shows how to process complex data in transmission signals of a communication system.

**What Is Frame Synchronization?**

In communication systems, frame synchronization is a method of finding valid data in a transmission that consists of *data frames*. To aid frame synchronization, the transmitter inserts a fixed data pattern at the start of each data frame to mark the start of valid data. The receiver searches for the fixed pattern in each data frame and achieves frame synchronization when the correlation between the input data and the fixed pattern is high.

**Model Structure**

The model contains the following components.

The C chart contains the following states, transitions, and MATLAB functions.
Key characteristics of the C chart include:

- **Complex input and output signals**
  The chart accepts a complex input signal I/Q. After synchronizing the data frame, the chart stores the valid data in a complex output signal frame.

- **Complex multiplication**
  The output signal frame is a vector of complex products between each valid data point and the phase angle of the carrier wave.

- **Indexing into a complex vector**
The chart uses the `temporalCount` operator to index into the complex vector `frame`.

- MATLAB functions with complex arguments

The MATLAB functions `correlate` and `get_carrier_phase` have complex input and output arguments.

**Simulation Results**

The `sf_frame_sync_controller` model does not produce simulation results. The purpose of this example is to explain how to process complex data in a chart.

**How the C Chart Works**

The chart calculates the correlation between the input signal I/Q and the fixed data pattern `trainSig`. You define `trainSig` by writing and running a MATLAB script before you simulate the model.

- If the correlation exceeds 50 percent, frame synchronization occurs. The chart stores 220 valid data points in the complex vector `frame`.
- If the correlation stays below 50 percent after the chart has evaluated 300 data points, the frame synchronization algorithm resets.

<table>
<thead>
<tr>
<th>Stage</th>
<th>Summary</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Activation of the frame synchronization algorithm</td>
<td>When the chart wakes up, the state <code>look_for_sync</code> activates to start the frame synchronization algorithm.</td>
</tr>
<tr>
<td>2</td>
<td>Calculation of correlation between the input signal and the fixed pattern</td>
<td>The MATLAB function <code>correlate</code> finds the correlation between the input signal I/Q and the fixed data pattern <code>trainSig</code>. Then, the function stores the complex correlation as <code>corr</code>.</td>
</tr>
<tr>
<td>3</td>
<td>Calculation of absolute value of the complex correlation</td>
<td>The MATLAB function <code>correlate</code> also finds the absolute value of <code>corr</code> and stores the output as <code>corrAbs</code>. The value of <code>corrAbs</code> is the correlation percentage, which can range from 0 to 100 percent. At 0 percent, there is no correlation; at 100 percent, there is perfect correlation.</td>
</tr>
<tr>
<td>Stage</td>
<td>Summary</td>
<td>Details</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| 4     | Identification of valid data in a frame     | If corrAbs exceeds 50 percent, the correlation is high and the chart has identified the start of valid data in a data frame. The transition from the state look_for_sync to get_payload occurs.  
If corrAbs stays below 50 percent after the chart has evaluated 300 data points, the frame synchronization algorithm restarts. |
| 5     | Storage of valid data in a complex vector   | When the correlation is high, the state get_payload activates.                                                                                                                                              
The MATLAB function get_carrier_phase finds the phase angle of the carrier wave and stores the value as phasor. Then, the state multiplies the input signal I/Q with the phase angle phasor and stores each complex product in successive elements of the vector frame. |
| 6     | Output of valid frame data                  | After collecting 220 data points, the chart outputs the vector frame to the next block in the model.                                                                                                       |
| 7     | Restart of the frame synchronization algorithm | The state look_for_sync reactivates, and the frame synchronization algorithm restarts for the next data frame.                                                                                           |
Measure Frequency Response Using a Spectrum Analyzer

This model shows measurement of the frequency response of a second-order system driven by a complex sinusoidal signal. A scope displays the measured frequency response as discrete Bode plots.

What Is a Spectrum Analyzer?

A spectrum analyzer is a tool that measures the frequency response (magnitude and phase angle) of a physical system over a range of frequencies.

Model Structure

The model sf_spectrum_analyzer contains the following components.

<table>
<thead>
<tr>
<th>Model Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sinusoid Generator block</td>
<td>Generates a complex sinusoidal signal of increasing frequency and supplies this signal to other blocks.</td>
</tr>
<tr>
<td>Complex to Imaginary block</td>
<td>Extracts the imaginary part of the complex signal from the Sinusoid Generator block so that a sine wave of increasing frequency can drive the Plant block.</td>
</tr>
<tr>
<td><strong>Model Component</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Plant block</td>
<td>Uses a transfer function to describe a second-order system with a natural frequency of 150 Hz (300π radians per second) and a damping ratio of 0.3. Since the ratio is less than 1, this system is underdamped and contains two complex conjugate poles in the denominator of the transfer function. <strong>Note</strong> Typical applications implement the Plant block using a D/A (digital-to-analog) converter on the input signal and an A/D (analog-to-digital) converter on the output signal.</td>
</tr>
<tr>
<td>Analyzer chart</td>
<td>Calculates the frequency response of the second-order system defined by the Plant block.</td>
</tr>
<tr>
<td>Unwrap chart</td>
<td>Processes the phase angle output of the Analyzer chart.</td>
</tr>
</tbody>
</table>

**Simulation Results**

Simulation of the `sf_spectrum_analyzer` model produces discrete Bode plots in the Measured Frequency Response scope.
To adjust the scope display, right-click inside the grid and select **Autoscale** from the context menu.

- In the magnitude plot, the sharp peak is the response of the Plant block to a resonant frequency.
- In the phase plot, the angle changes from 0 to \(-\pi\) radians (-180 degrees). Each complex pole in the Plant block adds \(-\pi/2\) radians to the phase angle.
**How the Sinusoid Generator Block Works**

This block is a masked chart that uses MATLAB as the action language. To access the chart, right-click the Sinusoid Generator block and select **Mask > Look Under Mask**.

Key characteristics of the signal generator chart include:

- Absolute-time temporal logic for controlling changes in frequency
- MATLAB code in the chart that generates a complex signal
- Transition condition that contains complex operands

```plaintext
{ 
  f = fstart; 
  y = 0j; 
}
```

```
A
en, du:
t = temporalCount(sec);
yprev = y;
y = exp(2*pi*f*t*1j);
```

```
[after(delay,sec) & & imag(yprev).*imag(y) <= 0 & & imag(y) > 0]
{
  f = f + fstep;
}
```
<table>
<thead>
<tr>
<th>Stage</th>
<th>Summary</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Signal frequency specification</td>
<td>When the chart awakens, the default transition sets the signal frequency $f$ to $f_{start}$ and activates state A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> To set $f_{start}$, double-click the Sinusoid Generator block and enter a value (in Hz) in the Initial frequency field.</td>
</tr>
<tr>
<td>2</td>
<td>Complex signal generation</td>
<td>While state A is active, the chart generates the complex signal $y$ based on frequency $f$ and simulation time $t$.</td>
</tr>
<tr>
<td>3</td>
<td>Frequency and complex signal updates</td>
<td>If delay seconds have elapsed since activation of state A, the frequency $f$ increases by an amount $f_{step}$ and state A generates a new signal. Updates occur until the frequency $f$ reaches the value $f_{stop}$.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> To set delay, double-click the Sinusoid Generator block and enter a value (in seconds) in the Delay at each frequency field. To set $f_{step}$, enter a value (in Hz) in the Step frequency field.</td>
</tr>
<tr>
<td>4</td>
<td>Complex signal termination</td>
<td>When the frequency $f$ reaches the value $f_{stop}$, the state Stopped becomes active. The complex signal terminates and the simulation ends.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> To set $f_{stop}$, double-click the Sinusoid Generator block and enter a value (in Hz) in the Stop frequency field.</td>
</tr>
</tbody>
</table>

**How the Analyzer Chart Works**

Key characteristics of the Analyzer chart include:

- Change detection of input frequency
- MATLAB code inside that chart that processes complex data
• State during action that contains complex operands

```
A
en:
y = 0j; yn = 0j;
du:
y = y + u.*yp;
yn = yn + u.*imag(u);

{hasChanged(f)}
  mag = abs(y)/abs(yn);
  ang = -angle(y) + pi/2;
```

<table>
<thead>
<tr>
<th>Stage</th>
<th>Summary</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>State A activation</td>
<td>When the chart wakes up, the values of y and yn initialize to zero.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The data y stores the second-order system response to a signal from the Sinusoid Generator block.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The data yn stores an input signal of a given frequency.</td>
</tr>
<tr>
<td>2</td>
<td>Change detection of input frequency</td>
<td>The hasChanged operator detects if the input frequency f has changed since the previous time step. If so, MATLAB code calculates the magnitude and phase angle for the new frequency.</td>
</tr>
</tbody>
</table>

**How the Unwrap Chart Works**

This chart unwraps the phase angle output of the Analyzer chart. Unwrapping means preventing the phase angle from jumping more than π radians or dropping more than −π radians.
• If the phase angle jumps more than \( \pi \) radians, the chart subtracts \( 2\pi \) radians from the angle.
• If the phase angle drops more than \(-\pi\) radians, the chart adds \( 2\pi \) radians to the angle.
Define Interfaces to Simulink Models and the MATLAB Workspace

- “Overview of Stateflow Block Interfaces” on page 23-2
- “Specify Chart Properties” on page 23-3
- “Set Stateflow Block Update Method” on page 23-11
- “Implement Interfaces to Simulink Models” on page 23-13
- “Reuse Charts in Models with Chart Libraries” on page 23-18
- “Create Specialized Chart Libraries for Large-Scale Modeling” on page 23-19
- “Customize Properties of Library Blocks” on page 23-20
- “Limitations of Library Charts” on page 23-21
- “MATLAB Workspace Interfaces” on page 23-22
- “About Masks” on page 23-23
- “Mask Parameters” on page 23-24
- “Look Under a Mask” on page 23-26
- “Mask a Stateflow Block” on page 23-27
- “About Active State Data” on page 23-31
- “When to Use Active State Output Data” on page 23-35
- “Set Active State Data as Local” on page 23-36
- “View State Activity Using the Simulation Data Inspector” on page 23-37
- “Limitations for Active State Data” on page 23-41
- “Use Active State Output Data” on page 23-42
- “Change the Active State Port Name” on page 23-45
- “Define State Activity Enum Name and Type” on page 23-46
- “Units in Stateflow” on page 23-48
Overview of Stateflow Block Interfaces

Stateflow Block Interfaces

Each Stateflow block interfaces to its Simulink model. Each Stateflow block can interface to sources external to the Simulink model (data, events, custom code). Events and data are the Stateflow objects that define the interface from the point of view of the Stateflow block.

Events can be local to the Stateflow block or can be propagated to and from the Simulink model and sources external to it. Data can be local to the Stateflow block or can be shared with and passed to the Simulink model and to sources external to the Simulink model. Messages can be local to the Stateflow block or can be passed through the Simulink to other Stateflow blocks.

The Stateflow interfaces include:

• Physical connections between Simulink blocks and the Stateflow block
• Event and data information exchanged between the Stateflow block and external sources
• Messages exchanged between Stateflow blocks.
• The properties of Stateflow charts
• Graphical functions exported from a chart

See “Export Stateflow Functions for Reuse” on page 8-28 for more details.

• The MATLAB workspace

See “Access Built-In MATLAB Functions and Workspace Data” on page 12-38 for more details.

• Definitions in external code sources
Specify Chart Properties

In this section...

“About Chart Properties” on page 23-3
“Set Properties for a Single Chart” on page 23-3
“Set Properties for All Charts in the Model” on page 23-9

About Chart Properties

Chart properties allow you to specify how your chart interfaces with the Simulink model. You can specify properties for a single chart or all charts in a model.

Set Properties for a Single Chart

To specify properties for a single chart, edit the properties in the Property Inspector or right-click in the chart and select Properties.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Stateflow chart name (read-only).</td>
</tr>
<tr>
<td>Machine</td>
<td>Simulink subsystem name (read-only). Available only in the Chart properties dialog box. Not available in the Symbols window.</td>
</tr>
<tr>
<td>Action Language</td>
<td>Action language for programming the chart. Choices are C or MATLAB. For more information, see “Modify the Action Language for a Chart” on page 13-2.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>State Machine Type</td>
<td>Type of state machine to create. Choices are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Classic</strong>: Default state machine. Provides full set of semantics for MATLAB charts and C charts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Mealy</strong>: State machine in which output is a function of inputs and state.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Moore</strong>: State machine in which output is a function only of state.</td>
</tr>
<tr>
<td></td>
<td>Mealy and Moore charts use a subset of Stateflow chart semantics.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td>Update method</td>
<td>Method by which a simulation updates (wakes up) a chart in a Simulink model (see “Set Stateflow Block Update Method” on page 23-11). You can select Inherited, Discrete, or Continuous. For more information about continuous updating, see “Model Hybrid Systems with Model Logic” on page 20-6.</td>
</tr>
<tr>
<td>Sample Time</td>
<td>If <strong>Update method</strong> is Discrete, enter a sample time.</td>
</tr>
<tr>
<td>Enable zero-crossing detection</td>
<td>If <strong>Update method</strong> is Continuous, zero-crossing detection is enabled by default. See “When to Disable Zero-Crossing Detection” on page 20-4.</td>
</tr>
<tr>
<td>Enable C-bit operations</td>
<td>For C charts only. To interpret the following operators (~, &amp;,</td>
</tr>
<tr>
<td></td>
<td>If you clear this check box, the following occurs:</td>
</tr>
<tr>
<td></td>
<td>• &amp; ,</td>
</tr>
<tr>
<td></td>
<td>• ^ is interpreted as the power operator (for example, 2^3 = 8).</td>
</tr>
<tr>
<td></td>
<td>Other bit operations such as &gt;&gt; and &lt;&lt; are interpreted as bit operations regardless of this setting.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>User specified state/transition execution order</strong></td>
<td>To use explicit ordering of parallel states and transitions (default), select this check box. In this mode, you have complete control of the order in which parallel states are executed and transitions originating from a source are tested for execution. For more information, see “Execution Order for Parallel States” on page 3-89 and “Evaluate Transitions” on page 3-65. In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td><strong>Export Chart Level Functions</strong></td>
<td>To export functions defined at the root level of the chart, select this check box. This allows Simulink Caller blocks to call Stateflow functions in the local hierarchy using qualified notation <code>chartName.functionName</code>. For more information, see “Export Stateflow Functions for Reuse” on page 8-28. In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td><strong>Treat Exported Functions as Globally Visible</strong></td>
<td>To allow Stateflow and Simulink Caller blocks throughout the model to call the Stateflow functions, select this check box. Do not use qualified notation to call these functions. In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td><strong>Execute (enter) Chart At Initialization</strong></td>
<td>Select this check box if you want a chart's state configuration to be initialized at time 0 instead of at the first occurrence of an input event (see “Execution of a Chart at Initialization” on page 3-44).</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| **Initialize Outputs Every Time Chart Wakes Up** | Interprets the initial value of outputs every time a chart wakes up, not only at time 0. When you set an initial value for an output data object, the output will be reset to that value.  
  
  Outputs are reset whenever a chart is triggered, whether by function call, edge trigger, or clock tick.  
  
  Enable this option to:  
  • Ensure all outputs are defined in every chart execution  
  • Prevent latching of outputs (carrying over values of outputs computed in previous executions)  
  • Give all chart outputs a meaningful initial value  
  
  In **Advanced** section of the Property Inspector. |
| **Enable Super Step Semantics**            | Select to enable charts to take multiple transitions in each time step until it reaches a stable state. For more information, see “Super Step Semantics” on page 3-75.  
  
  In **Advanced** section of the Property Inspector. |
| **Maximum Iterations in Each Super Step**  | If you enable super step semantics, specify the maximum number of transitions the chart should take in each time step. The chart always takes one transition during a super step, so the value N that you specify represents the maximum number of *additional* transitions (for a total of N +1). For more information, see “Maximum Number of Iterations” on page 3-75  
  
  Try to choose a number that allows the chart to reach a stable state within the time step, based on the mode logic of your chart.  
  
  In **Advanced** section of the Property Inspector. |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Behavior after too many iterations</td>
<td>If you enable super step semantics, specify how the chart behaves after reaching the maximum number of transitions before taking all valid transitions. Options include:</td>
</tr>
</tbody>
</table>
|                                           | • **Proceed** — Chart execution continues to the next time step  
|                                           | • **Throw Error** — Simulation stops and an error message appears                                                                 |
|                                           | In **Advanced** section of Property Inspector.                                                                                               |
| **Note**                                  | The **Throw Error** option is valid only for simulation. In generated code, chart execution always proceeds.                                  |
| Support variable-size arrays              | Select to support chart input and output data that vary in dimension during simulation. For more information, see “Declare Variable-Size Inputs and Outputs” on page 18-5. |
| Saturate on integer overflow              | Select to specify that integer overflows saturate in the generated code. For more information, see “Handle Integer Overflow for Chart Data” on page 9-52. |
|                                           | In **Advanced** section of the Property Inspector.                                                                                           |
| Create output for monitoring:            | Select to create output to monitor state activity. Choose:                                                                                   |
|                                           | • **Child activity**  
|                                           | • **Leaf state activity**  
|                                           | • **Self activity**  
<p>|                                           | See “About Active State Data” on page 23-31.                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>States When Enabling</strong></td>
<td>If your chart uses function-call input events, specify how states behave when the event reenables the chart. Options include:</td>
</tr>
<tr>
<td></td>
<td>• Held — Maintain most recent values of the states.</td>
</tr>
<tr>
<td></td>
<td>• Reset — Revert to the initial conditions of the states.</td>
</tr>
<tr>
<td></td>
<td>For more information, see “Control States When Function-Call Inputs Reenable Charts” on page 10-14.</td>
</tr>
<tr>
<td><strong>Treat these inherited Simulink signal types as fi objects</strong></td>
<td>For MATLAB charts only. Determines whether to treat inherited fixed-point and integer signals as Fixed-Point Designer fi objects.</td>
</tr>
<tr>
<td></td>
<td>• If set to <strong>Fixed-point</strong> (default), the MATLAB chart treats all fixed-point inputs as fi objects.</td>
</tr>
<tr>
<td></td>
<td>• If set to <strong>Fixed-point &amp; Integer</strong>, the MATLAB chart treats all fixed-point and integer inputs as fi objects.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
<tr>
<td><strong>MATLAB Chart fimath</strong></td>
<td>For MATLAB charts only. Default fimath properties for the MATLAB chart. Otherwise, specify the default fimath properties by constructing the fimath object in the MATLAB or model workspace and setting the property equal to the variable name.</td>
</tr>
<tr>
<td></td>
<td>• If set to <strong>Same as MATLAB Default</strong>, the chart uses the same fimath properties as the current default fimath</td>
</tr>
<tr>
<td></td>
<td>• If set to <strong>Specify Other</strong>, you can specify your own default fimath object. Either construct the fimath object inside the edit box, or create it in the MATLAB or model workspace, and enter its variable name in the edit box.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Advanced</strong> section of the Property Inspector.</td>
</tr>
</tbody>
</table>
### Field & Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Textual description/comment.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Info</strong> tab of Property Inspector.</td>
</tr>
<tr>
<td>Document link</td>
<td>Enter a Web URL address or a general MATLAB command. Examples are <strong><a href="http://www.mathworks.com">www.mathworks.com</a></strong>, <strong>mailto:email_address</strong>, and <strong>edit/spec/data/speed.txt</strong>.</td>
</tr>
<tr>
<td></td>
<td>In <strong>Info</strong> tab of the Property Inspector.</td>
</tr>
</tbody>
</table>

### Set Properties for All Charts in the Model

You can set some properties for all charts in the model by setting properties for the Stateflow machine, which represents all of the Stateflow blocks in a model.

To set properties for the Stateflow machine:

1. In the Chart properties dialog box for a particular chart, select the **Machine** link at the top of the dialog box.

   The Machine properties dialog box appears.

2. Enter information in the fields that appear:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulink Model</td>
<td>Name of the Simulink model that defines this Stateflow machine (read-only). You change the model name in the Simulink window when you save the model under a chosen file name.</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Date on which this machine was created, which is read-only.</td>
</tr>
<tr>
<td>Creator</td>
<td>Name of the person who created this Stateflow machine.</td>
</tr>
<tr>
<td>Modified</td>
<td>Time of the most recent modification of this Stateflow machine.</td>
</tr>
<tr>
<td>Version</td>
<td>Version number of this Stateflow machine.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use C-like bit operations in new charts</strong></td>
<td>For C charts only. Select this check box for all new C charts to interpret the following operators (~, &amp;,</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Brief description of this Stateflow machine, which is stored with the model that defines it.</td>
</tr>
<tr>
<td><strong>Document link</strong></td>
<td>MATLAB expression that, when evaluated, displays documentation for this Stateflow machine.</td>
</tr>
</tbody>
</table>

3 Click one of these buttons:

- **Apply** saves the changes.
- **Cancel** closes the dialog box without making any changes.
- **OK** saves the changes and closes the dialog box.
- **Help** displays the online help in an HTML browser window.
**Set Stateflow Block Update Method**

Stateflow blocks are Simulink subsystems. Simulink events wake up subsystems for execution. To specify a wakeup method, in the Chart properties dialog box set **Update method** (see “Specify Chart Properties" on page 23-3). Select one of the following wakeup methods:

- **Inherited**

  This method is the default update method. It causes input from the Simulink model to determine when the chart wakes up during a simulation.

  If you define input events for the chart, the Stateflow block is explicitly triggered by a signal on its trigger port originating from a connected Simulink block. You can set this trigger input event in the Model Explorer to occur in response to a Simulink signal. The Simulink signal can be **Rising**, **Falling**, or **Either** (rising and falling), or in response to a **Function Call**.

  If you do not define input events, the Stateflow block implicitly inherits triggers from the Simulink model. These implicit events are the discrete or continuous sample times of the Simulink signals providing inputs to the chart. If you define data inputs, the chart awakens at the rate of the fastest data input. If you do not define any data input for the chart, the chart wakes up as defined by its parent subsystem's execution behavior.

- **Discrete**

  The Simulink model awakens (samples) the Stateflow block at the rate that you specify as the block's **Sample Time** property. An implicit event is generated at regular time intervals corresponding to the specified rate. The sample time is in the same units as the Simulink simulation time. Other blocks in the Simulink model can have different sample times.

- **Continuous**

  The Stateflow chart updates its state during major time steps only, though it computes outputs and local continuous variables during major and minor time steps. The chart can register zero crossings, which allows Simulink models to sample Stateflow charts whenever state changes occur. The Stateflow chart is also able to compute derivatives for your local continuous variables.
See Also

More About

- “Activate a Stateflow Chart Using Input Events” on page 10-9
- “Share Output Data with Simulink” on page 9-26
- “Design Considerations for Continuous-Time Modeling in Stateflow Charts” on page 20-21
Implement Interfaces to Simulink Models

**In this section...**

*“Define a Triggered Stateflow Block” on page 23-13*
*“Define a Sampled Stateflow Block” on page 23-14*
*“Define an Inherited Stateflow Block” on page 23-15*
*“Define a Continuous Stateflow Block” on page 23-15*
*“Define Function-Call Output Events” on page 23-15*
*“Define Edge-Triggered Output Events” on page 23-16*

**Define a Triggered Stateflow Block**

Essential conditions that define an edge-triggered Stateflow block are:

- The chart **Update method** (set in the Chart properties dialog box) is **Discrete** or **Inherited**. (See “Specify Chart Properties” on page 23-3.)
- The chart has an **Input from Simulink** event defined and an edge-trigger type specified. (See “Activate a Stateflow Chart Using Input Events” on page 10-9.)

**Triggered Stateflow Block Example**

The following model shows an edge-triggered Stateflow block named Calllee:

The **Input from Simulink** event has an **Either** edge-trigger type. If you define more than one **Input from Simulink** event, the Simulink model determines the sample times to be
consistent with various rates of all the incoming signals. The outputs of a triggered Stateflow block are held after the execution of the block.

**Define a Sampled Stateflow Block**

There are two ways you can define a sampled Stateflow block.

- Set the chart **Update method** (in the Chart properties dialog box) to **Discrete** and enter a **Sample Time** value. (See “Specify Chart Properties” on page 23-3.)
- Alternatively, add and define input data either in the Stateflow Editor by selecting **Chart > Add Inputs & Outputs > Data Input from Simulink** or in the Model Explorer. (See “Share Output Data with Simulink” on page 9-26.)

Simulink determines the chart sample time to be consistent with the rate of the incoming data signal.

The **Sample Time** you set in the Chart properties dialog box takes precedence over the sample time of any input data.

**Sampled Stateflow Block Example**

You specify a discrete sample rate to have Simulink trigger a Stateflow block that does use an explicit trigger port. You can specify a sample time for the chart in the Chart properties dialog box. Simulink then calls the Stateflow block at a defined, regular sample time.

The outputs of a sampled Stateflow block are held after the execution of the block.
Define an Inherited Stateflow Block

Essential conditions that define an inherited trigger Stateflow block are:

- The chart **Update method** (set in the Chart properties dialog box) is **Discrete** or **Inherited**. (See “Specify Chart Properties” on page 23-3)
- The chart has an **Input from Simulink** data object defined using the Stateflow Editor **Add** menu or the Model Explorer. (See “Share Output Data with Simulink” on page 9-26.) Simulink determines the chart sample time to be consistent with the rate of the incoming data signal.

Inherited Stateflow Block Example

Simulink can trigger a Stateflow block that does not use an explicit trigger port or a specified discrete sample time. In this case, the Simulink calls the Stateflow block at a sample time determined by the model.

In this example, the chart contains two **Input from Simulink** data objects. Simulink determines the sample times to be consistent with the rates of both incoming signals.

The outputs of an inherited trigger Stateflow block are held after the execution of the block.

Define a Continuous Stateflow Block

To define a continuous Stateflow block, set the chart **Update method** in the Chart properties dialog box to **Continuous**.

Define Function-Call Output Events

This topic shows you how to trigger a function-call subsystem in a Simulink model with a function-call output event in a Stateflow chart. The procedure assumes that you have a
programmed function-call subsystem and a Stateflow block in the model. Use the following steps to connect the Stateflow block to the function-call subsystem and trigger it during simulation.

1. In your chart, select **Chart > Add Inputs & Outputs > Event Output To Simulink**.
   
   The Event properties dialog box appears with a default name of `event` and a **Scope** of `Output to Simulink`.

2. Set **Trigger** to **Function Call**.

3. Name the event appropriately and click **OK** to close the dialog box.

An output port with the name of the event you add appears on the right side of the Stateflow block.

4. Connect the output port on the Stateflow block for the function-call output event to the input trigger port of the subsystem.

   Avoid placing any other blocks in the connection lines between the Stateflow block and the function-call subsystem.

   **Note** You cannot connect a function-call output event from a chart to a Demux block to trigger multiple subsystems.

5. To execute the function-call subsystem, include an event broadcast of the function-call output event in the actions of the chart.

For examples of using function-call output events, see “Activate a Simulink Block Using Function Calls” on page 10-30.

### Define Edge-Triggered Output Events

Simulink controls the execution of edge-triggered subsystems with output events. Essential conditions that define this use of triggered output events are:

- The chart has an **Output to Simulink** event with the trigger type set to **Either**. See “Activate a Simulink Block Using Output Events” on page 10-22.
- The Simulink block connected to the edge-triggered **Output to Simulink** event has its own trigger type set to the equivalent edge trigger.
For examples of using edge-triggered output events, see “Activate a Simulink Block Using Edge Triggers” on page 10-22.
Reuse Charts in Models with Chart Libraries

In Simulink, you can create your own block libraries as a way to reuse the functionality of blocks or subsystems in one or more models. Similarly, you can reuse a set of Stateflow algorithms by encapsulating the functionality in a chart library.

As with other Simulink block libraries, you can specialize each instance of chart library blocks in your model to use different data types, sample times, and other properties. Library instances that inherit the same properties can reuse generated code.

For more information about Simulink block libraries, see “Libraries” (Simulink).
Create Specialized Chart Libraries for Large-Scale Modeling

1. Add Stateflow charts with polymorphic logic to a Simulink model.
   Polymorphic logic is logic that can process data with different properties, such as type, size, and complexity.
2. Configure the charts to inherit the properties you want to specialize.
   For a list, see “Customize Properties of Library Blocks” on page 23-20.
3. Optionally, customize your charts using masking.
4. Simulate and debug your charts.
5. In Simulink, create a library model by selecting File > New > Library.
6. Copy or drag the charts into a library model.

For an example using MATLAB Function blocks, see “Create Custom Block Libraries” (Simulink).
## Customize Properties of Library Blocks

You can customize instances of Stateflow library blocks by allowing them to inherit any of the following properties from Simulink.

<table>
<thead>
<tr>
<th>Property</th>
<th>Inherits by Default?</th>
<th>How to Specify Inheritance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Yes</td>
<td>Set the data type property to <strong>Inherit: Same as Simulink</strong>.</td>
</tr>
<tr>
<td>Size</td>
<td>Yes</td>
<td>Set the data size property to <strong>-1</strong>.</td>
</tr>
<tr>
<td>Complexity</td>
<td>Yes</td>
<td>Set the data complexity property to <strong>Inherited</strong>.</td>
</tr>
<tr>
<td>Limit range</td>
<td>No</td>
<td>Specify minimum and maximum values as Simulink parameters. For example, if minimum value = aParam and maximum value = aParam + 3, different instances of a Stateflow library block can resolve to different aParam parameters defined in their parent mask subsystems.</td>
</tr>
</tbody>
</table>
| Initial value     | Depends on scope     | For local data, temporary data, and outputs, specify initial values as Simulink parameters. Other data always inherits the initial value:  
  • Parameters inherit the initial value from the associated parameter in the parent mask subsystem.  
  • Inputs inherit the initial value from the Simulink input signal.  
  • Data store memory inherits the initial value from the Simulink data store to which it is bound. |
| Sampling mode     | Yes                  | Stateflow chart input ports always inherit sampling mode.                                 |
| (input)           |                      |                                                                                           |
| Data type override mode for fixed-point data | Yes | Different library instances inherit different data type override modes from their ancestors in the model hierarchy. |
| Sample time       | Yes                  | Set the block sample time property to **-1**.                                              |
| (block)           |                      |                                                                                           |
Limitations of Library Charts

Events parented by a library Stateflow machine are invalid. The parser flags such events as errors.
MATLAB Workspace Interfaces

In this section...

“About the MATLAB Workspace” on page 23-22
“Examine the MATLAB Workspace” on page 23-22
“Interface the MATLAB Workspace with Charts” on page 23-22

About the MATLAB Workspace

The MATLAB workspace is an area of memory normally accessible from the MATLAB command line. It maintains a set of variables built up during a MATLAB session.

Examine the MATLAB Workspace

Two commands, who and whos, show the current contents of the workspace. The who command gives a short list, while whos also gives size and storage information.

To delete all the existing variables from the workspace, enter clear all at the MATLAB command line. See the MATLAB documentation for more information.

Interface the MATLAB Workspace with Charts

A chart has the following access to the MATLAB workspace:

• You can access MATLAB data or MATLAB functions using the ml namespace operator or the ml function.

  See “Access Built-In MATLAB Functions and Workspace Data” on page 12-38 for more information.

• You can use the MATLAB workspace to initialize chart data at the beginning of a simulation.

  See “Enter Expressions and Parameters for Data Properties” on page 9-23.

• You can save chart data to the workspace at the end of a simulation.

  See “Save Data to the MATLAB Workspace” on page 9-29 for more information.
About Masks

Creating a mask for Stateflow charts, state transition tables, and truth tables simplifies using and sharing blocks. The mask encapsulates the block by hiding the underlying logic and creates a user interface for the block. You can customize the block by:

- Changing the appearance with meaningful icons and ports.
- Creating a user interface for parameters.
- Adding customized documentation.

You decide which parameters can be changed through the mask user interface. You can provide meaningful descriptions of these parameters.

You cannot mask atomic subcharts, states, or any other objects within a chart. You can only create masks on Stateflow object blocks you can access from the Simulink library: charts, state transition tables, and truth tables. Masking a Stateflow block is the same as masking other Simulink blocks.

See Also

More About

- “Block Masks” (Simulink)
Mask Parameters

When you create a mask for a Stateflow block, you can define a custom interface for block parameters.

You provide access to the block parameters by defining corresponding parameters with the same name in the Mask Editor. A user interface to these parameters is then provided through a Mask Parameters dialog box.

The mask parameters appear as editable fields in the Mask Parameters dialog box. Stateflow applies these values to the corresponding block parameters during simulation.

For example, in the sf_car model, double-click the shift_logic Stateflow block to see the Mask Parameters dialog box.

This dialog box contains a parameter description Delay before gear change (tick) and a box to edit the value. This value is tied to the parameter TWAIT inside the mask. When you edit the value in this box, Stateflow assigns the new value to TWAIT during simulation.

Before simulation begins, Simulink searches the mask workspace to find values for the parameters. If parameters for the model are not defined in the mask, Simulink continues searching the workspace hierarchy for the definitions and values.

You can create other types of user interfaces for the mask parameters, such as check boxes, context menus, and option buttons.
See Also

More About

• “Mask Editor Overview” (Simulink)
Look Under a Mask

You can view and edit the contents of a masked block by selecting **Diagram > Mask > Look under Mask**. Looking under a mask does not unmask the block.

Stateflow charts provide badges for looking inside a mask. The badge is a downward facing arrow in the lower-left corner of the chart.

See Also

More About

- “About Masks” on page 23-23
- “Mask a Stateflow Block” on page 23-27
Mask a Stateflow Block

In this section...

“Create Mask” on page 23-27
“Change the Icon” on page 23-27
“Add a Parameter” on page 23-27
“View the New Mask” on page 23-28
“Edit the Mask” on page 23-29

You can create masks for Stateflow charts in models. To see a chart already masked, look at shift_logic in the sf_car model that ships with Stateflow.

Create Mask

To create a mask for the Stateflow chart in the model old_sf_car:

1. Open the model old_sf_car.
2. From the Simulink Editor, select the chart shift_logic.
3. Open the Mask Editor by selecting Diagram-> Mask->Create Mask.

Change the Icon

You can customize the appearance of the block icon by using drawing commands, or loading an image.

1. On the Icon & Ports pane, in the edit box under Icon Drawing commands type:
   
   image('shift_logic.svg')

2. Click Apply.

The Mask Editor loads the image file shift_logic.svg to use as the masked block icon. For more information, see “Draw Mask Icon” (Simulink).

Add a Parameter

The chart shift_logic has a parameter TWAIT that is already defined. To add TWAIT as a parameter to the mask:
1 In the Mask Editor, select the **Parameters & Dialog** pane.
2 Double-click the Edit parameter icon.

3 Next to **edit**, under **Prompt**, type

   "Delay before gear change(tick)".

   This text is the prompt for the new mask parameter in the Mask Parameters dialog box.
4 Under **Name**, type "**TWAIT**".

   This name defines the parameter in the mask. The name ties it to the underlying block parameter with the same name, **TWAIT**.
5 Click **Apply**.
6 Click **OK**.

**View the New Mask**

After creating a mask, the new icon for the `shift_logic` chart appears in the Simulink canvas. The name of the block has not changed.
If you double-click the icon, the Mask Parameters dialog box opens. This dialog box has the prompt for the parameter TWAIT. The value in the edit box is assigned to the parameter TWAIT during simulation.

To see the logic in the shift_logic chart, click the **Look inside mask** badge on the chart.

**Edit the Mask**

You can edit a mask by selecting **Diagram > Mask > Edit Mask.**
See Also

More About

• “Mask Editor Overview” (Simulink)
About Active State Data

In this section...

“State Activity Type” on page 23-31
“Active State Data Type” on page 23-31
“Leaf State Activity and Parallel States” on page 23-32

Stateflow can provide active state data through an output port to Simulink or as local data to your chart. You can enable active state data for a Stateflow chart, state, state transition table, or atomic subchart.

Enable active state data by selecting the Create output for monitoring check box in the Properties dialog box of the Stateflow object. The enumerated data is created as scope output by default. You can change the scope to local in the Model Explorer. For more information, see “Set Active State Data as Local” on page 23-36.

State Activity Type

The information in the chart defines the levels of state activity supported for each Stateflow object.

<table>
<thead>
<tr>
<th>Stateflow Object</th>
<th>Self-activity</th>
<th>Child activity</th>
<th>Leaf state activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charts</td>
<td>Not supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>States</td>
<td>Supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Atomic subcharts</td>
<td>Supported at the container level</td>
<td>Supported inside the subchart</td>
<td>Supported inside the subchart</td>
</tr>
<tr>
<td>State transition tables</td>
<td>Not supported</td>
<td>Supported</td>
<td>Supported</td>
</tr>
</tbody>
</table>

Active State Data Type

When you enable active state data, Stateflow creates a Boolean or enumerated data to match the activity mode.
### Activity Mode

<table>
<thead>
<tr>
<th>Activity Mode</th>
<th>Activity Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Self activity</td>
<td>Boolean</td>
<td>Is the state active?</td>
</tr>
<tr>
<td>Child activity</td>
<td>Enumeration</td>
<td>Which child is active?</td>
</tr>
<tr>
<td>Leaf state activity</td>
<td>Enumeration</td>
<td>Which leaf state is active?</td>
</tr>
</tbody>
</table>

For self-activity of a chart or state, the data value is 1 when active and 0 when inactive. For child and leaf state activity, the data is an enumerated type. Stateflow can automatically define the enumeration or you can create the definition. For more information about the enumeration type, see “Define State Activity Enum Name and Type” on page 23-46.

For active state data of scope output, Stateflow creates an output port on the block in Simulink.

**Leaf State Activity and Parallel States**

When you enable leaf state activity, a state with parallel (AND) decomposition is treated as a leaf state. State activity of the parallel substates is not available.

In this example, leaf state activity is enabled for the chart. The leaf states are A1, A2, and B. State B is treated as a leaf state because it has parallel decomposition. The substates B1 and B2 are active at the same time.
The active state output data connected to a scope shows the enumerated values for the leaf states A1, A2, and B.
See Also

Related Examples

- “Use Active State Output Data” on page 23-42
When to Use Active State Output Data

By enabling active state data as an output, the data is made available through an output data port to Simulink. This data signal can be:

- Viewed using a scope.
- Logged for diagnostics.
- Used to drive another subsystem.

Using active state data output can simplify the design in some Stateflow charts. You do not have to update data used to track state activity.

See Also

Related Examples

- “Use Active State Output Data” on page 23-42
Set Active State Data as Local

To access active state data inside a Stateflow chart:

1. In the Properties dialog box, select the check box **Create output for monitoring**.
2. Type the name in the **Data Name** field.
3. In the Symbols window, select the type of the data.
4. Change the scope to **Local**.

You can specify information for code generation by binding the local active state data to a `Simulink.Signal` object. Modify the properties in `CoderInfo`.

**See Also**

`Simulink.Signal` | `Simulink.CoderInfo`

**More About**

- “About Active State Data” on page 23-31
- “Define State Activity Enum Name and Type” on page 23-46
- “Resolve Data Properties from Simulink Signal Objects” on page 9-62
View State Activity Using the Simulation Data Inspector

You can log state activity and data for your Stateflow chart by using the Simulation Data Inspector.

With the Simulation Data Inspector, you can view and compare:

- Data from your chart
- Leaf chart activity
- Child chart activity
- Child state activity
- Self state activity
- Leaf state activity

Log to the Simulation Data Inspector from Stateflow

In this exercise, you use the Simulation Data Inspector to monitor the active state outputs for a Stateflow chart. To open the following model, at the MATLAB command prompt, enter sf_car.

To log a signal with the Simulation Data Inspector, highlight the signal line that you want to log. Right click on the gear signal and choose Log Selected Signals from the context menu. A logging badge appears next to the gear signal, indicating that the data from that signal will be logged when the model is run.
The logging badge marks logged signals in the model.

To log the active state data from `gear_state`:

1. Open the Stateflow chart.
2. To select `gear_state`, click `gear_state`.
3. On the Simulink Editor toolbar, click the **Simulation Data Inspector** drop-down and select **Logging for state gear_state > Child state activity**

To select multiple signals to log at once:
In your Stateflow chart, select the states whose activity you want to log.

On the Simulink Editor toolbar, click the **Simulation Data Inspector** drop-down and select **Logging for selected states** > **Self state activity**.

The logging badge appears on all highlighted states.

After running one or more simulations with signals marked for logging, click **Simulation Data Inspector** button on the Simulink editor toolbar and view your data. Multiple runs show up in the **Inspect** pane and can be viewed together. To choose which signals you want to plot, use the check boxes next to the signal names.
See Also

More About

- “Simulation Data Inspector in Your Workflow” (Simulink)
- “Inspect Simulation Data” (Simulink)
- “Compare Simulation Data” (Simulink)
Limitations for Active State Data

You cannot enable child or leaf state activity in charts or states with parallel decomposition. You can use self activity for states with parallel decomposition.

Do not enable child output for states that have no children. Doing so results in an error at compilation and run time.

Note Do not set the chart property Initialize Outputs Every Time Chart Wakes Up on charts that use output. The behavior is unpredictable.

See Also

More About

• “About Active State Data” on page 23-31
• “Use Active State Output Data” on page 23-42
Use Active State Output Data

This example shows how active state data is used as an output in the model sf_car.

Here is a version of the gear_state state in the Stateflow chart shift_logic that does not use active state data.

The output variable gear has an assignment in each state. The assignment tracks which state, first, second, third, or fourth is active in gear_state.

The following steps show how to enable and use active state output data to simplify the design:

1. Delete the entry: assignments to the output data variable gear for each state in gear_state.
2. In the Symbols window, right-click the output variable gear and select Delete.
3. Right-click inside the state gear_state, and view the Property Inspector.
4. Select the check box for Create output for monitoring.
5. Type the name gear next to Data name.
6. Type the name gearType next to Enum name.

Stateflow now automatically creates the output port, gear, on the shift_logic chart. The output of gear is an enumerated type automatically managed by Stateflow. You can view the output of gear on a scope. The names of the enumerated type match the names of the states in gear_state, with the addition of None to indicate no active child.
Explicitly assigning the value of `gear` is no longer necessary, therefore simplifying the design of `gear_state`.

To see the model `sf_car` with output enabled for `gear_state`, at the MATLAB command prompt, type `sf_car`.
See Also

More About

- “About Active State Data” on page 23-31
- “Limitations for Active State Data” on page 23-41
- “Manage Stateflow Data, Events, and Messages in the Symbols Window” on page 31-2
Change the Active State Port Name

When you enable active state data, Stateflow creates a name for the data. You can change this name by editing the value next to **Data name** in the Properties window. For data of scope **output**, the output port created matches the name.

![Screenshot of Stateflow properties window](image)

### See Also

**More About**

- “Define State Activity Enum Name and Type” on page 23-46
- “Limitations for Active State Data” on page 23-41
- “About Active State Data” on page 23-31
Define State Activity Enum Name and Type

When you enable data to monitor child or leaf state activity, the data type is an enumeration. Stateflow automatically creates this enumeration, or you can customize it.

In the enumeration definition, there must be one literal for each state name plus an extra literal to indicate no active child.

For example, Stateflow automatically creates the enumeration definition for gear_state in the model sf_car.

```matlab
enumeration
    None(0),
    first(1),
    second(2),
    third(3),
    fourth(4)
end
```

You can customize the name and definition for the enumeration output in the Properties window. To customize the name, type the new name in the edit box next to Enum name.

Stateflow automatically creates this enumeration, or you can tell Stateflow to use an existing definition by selecting Define enumerated type manually.

If you select Define enumerated type manually, but no definition exists, then Stateflow provides a link to automatically create a MATLAB definition. Selecting, Create enum definition from template, generates an enumeration definition in a MATLAB file. You can then customize this definition.

In the example, sf_car, the data is named gear, and the enumeration type is gearType.
The base storage type for an automatically created enumeration defaults to Native Integer. You can choose the storage type in Base storage type for automatically created enumerations: on the Optimization pane of the Configuration Parameters dialog box. If you need a smaller memory footprint, use this option.

See Also

More About
- “About Active State Data” on page 23-31
- “Limitations for Active State Data” on page 23-41
Units in Stateflow

In this section...

“Units for Input and Output Data” on page 23-48
“Consistency Checking” on page 23-48
“Units for Stateflow Limitations” on page 23-48

Units for Input and Output Data

Stateflow supports the specification of physical units as properties for data inputs and outputs. Specify units by using the Unit (e.g., m, m/s^2, N*m) parameter for input or output data on charts, state transition tables, or truth tables. When you start typing in the field, this parameter provides matching suggestions for units that Simulink supports. By default, the property is set to inherit the unit from the Simulink signal on the corresponding input or output port. If you select the Data must resolve to signal object property for output data, you cannot specify units. In this case, output data is assigned the same unit type as the Simulink signal connected to the output port.

To display the units on the Simulink lines in the model, select Display > Signals and Ports > Port Units.

Consistency Checking

Stateflow checks the consistency of the signal line unit from Simulink with the unit setting for the corresponding input or output data in the Stateflow block. If the units do not match, Stateflow displays a warning during model update.

Units for Stateflow Limitations

The unit property settings do not affect the execution of the Stateflow block. Stateflow checks only consistency with the corresponding Simulink signal line connected to the input or output. It does not check consistency of assignments inside the Stateflow blocks. For example, Stateflow does not warn against an assignment of an input with unit set to ft to an output with unit set to m. Stateflow does not perform unit conversions.
See Also

More About

- “Unit Specification in Simulink Models” (Simulink)
Structures and Bus Signals in Stateflow Charts

- “About Stateflow Structures” on page 24-2
- “Connect Structures in Charts to External Bus Signals” on page 24-3
- “Rules for Defining Structure Data Types in Charts” on page 24-8
- “Define Stateflow Structures” on page 24-9
- “Structure Operations” on page 24-17
- “Integrate Custom Structures in Stateflow Charts” on page 24-22
- “Debug Structures” on page 24-26
About Stateflow Structures

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“What Is a Stateflow Structure?” on page 24-2</td>
</tr>
<tr>
<td>“What You Can Do with Structures” on page 24-2</td>
</tr>
</tbody>
</table>

What Is a Stateflow Structure?

A Stateflow structure is a data type that you define as a `Simulink.Bus`. The elements of a Stateflow structure data type are called *fields*. The fields can be any combination of individual signals, muxed signals, vectors, and buses. Each field has its own data type, which need not match that of any other field.

What You Can Do with Structures

With the Stateflow structure data type, you can create:

- Inputs and outputs for accessing Simulink bus signals from Stateflow charts, Truth Table blocks, and MATLAB Function blocks (see “Define Structure Inputs and Outputs” on page 24-9)
- Local structure data in Stateflow charts, truth tables, graphical functions, MATLAB functions, and boxes (see “Define Local Structures” on page 24-12)
- Temporary structure data in Stateflow graphical functions, truth tables, and MATLAB functions (see “Define Temporary Structures” on page 24-14)

See Also

`Simulink.Bus`
Connect Structures in Charts to External Bus Signals

The model sfbus_demo provides examples of structures in a Stateflow chart.

The chart contains a graphical function.

In this model, the Stateflow chart receives a bus input signal using the structure inbus at input port 1 and outputs a bus signal from the structure outbus at output port 1. The
input signal comes from the Simulink Bus Creator block `COUNTERBUSCreator`, which bundles signals from two other Bus Creator blocks: `SIGNALBUSCreator` and `LIMITBUSCreator`. The structure `outbus` connects to a Simulink Bus Selector block `BUSSelector`. The Stateflow chart also contains a local structure `counterbus_struct` and a graphical function `get_input_signal` that contains an input structure `u` and output structure `y`.

**Structure Definitions in sfbus_demo Stateflow Chart**

Definitions of structures in the chart of the `sfbus_demo` model appear in the Model Explorer as follows:

![Model Explorer Screenshot](image)

**Note** The local structure `counterbus_struct` is defined using the type operator in an expression, as described in “Define Structure Types with Expressions” on page 24-15.
Structure Definitions in sfbus_demo Stateflow Graphical Function

Definitions of structures in the graphical function get_input_signal appear in the Model Explorer as follows:

Simulink Bus Objects Define Stateflow Structures

Each Stateflow structure must be defined by a Simulink.Bus object in the base workspace. The structure shares the same properties as the bus object, including number, name, and type of fields. For example, the sfbus_demo model defines the following bus objects in the base workspace:
You can find the bus object that defines a Stateflow structure by looking in the Data Type and Compiled Type columns in the Contents pane of the Model Explorer. For example, the structures `inbus`, `outbus`, and `counterbus_struct` are all defined in `sfbus_demo` by the same Simulink bus object, `COUNTERBUS`.

Based on these definitions, `inbus`, `outbus`, and `counterbus_struct` have the same properties as `COUNTERBUS`. For example, these Stateflow structures in `sfbus_demo` reference their fields by the same names as the elements in `COUNTERBUS`, as follows:

<table>
<thead>
<tr>
<th>Structure</th>
<th>First Field</th>
<th>Second Field</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>inbus</code></td>
<td><code>inbus.inputsignal</code></td>
<td><code>inbus.limits</code></td>
</tr>
<tr>
<td><code>outbus</code></td>
<td><code>outbus.inputsignal</code></td>
<td><code>outbus.limits</code></td>
</tr>
<tr>
<td><code>counterbus_struct</code></td>
<td><code>counterbus_struct.inputsignal</code></td>
<td><code>counterbus_struct.limits</code></td>
</tr>
</tbody>
</table>

To learn how to define structures in Stateflow charts using `Simulink.Bus` objects, see “Define Stateflow Structures” on page 24-9.
If you define a custom structure in C for your Stateflow chart, you must make sure that the structure's `typedef` declaration in your header file matches the properties of the `Simulink.Bus` object that defines the structure, as described in “Integrate Custom Structures in Stateflow Charts” on page 24-22.
Rules for Defining Structure Data Types in Charts

Follow these rules when defining structures in Stateflow charts:

- You must define each structure as a Simulink.Bus object in the base workspace.
- You cannot define structures for Stateflow machines.

**Note** The Stateflow machine is the object that contains all other Stateflow objects in a Simulink model (see “Stateflow Hierarchy of Objects” on page 1-7).

- Structures cannot have a constant scope.
- Structures of parameter scope must be tunable.
- Data array objects cannot contain structures.

See Also

More About

- “Structure Operations” on page 24-17
- “Define Stateflow Structures” on page 24-9
Define Stateflow Structures

In this section...

| “Define Structure Inputs and Outputs” on page 24-9 |
| “Define Local Structures” on page 24-12 |
| “Define Structures of Parameter Scope” on page 24-13 |
| “Define Temporary Structures” on page 24-14 |
| “Define Structure Types with Expressions” on page 24-15 |

Define Structure Inputs and Outputs

• “Interface Stateflow Structures with Simulink Bus Signals” on page 24-9  
• “Virtual and Nonvirtual Buses” on page 24-11

Interface Stateflow Structures with Simulink Bus Signals

You can drive Stateflow structure inputs by using any Simulink bus signal that has matching properties. Similarly, Stateflow charts can output structures to Simulink blocks that accept bus signals.

To create inputs and outputs in Stateflow charts:

1. Create a Simulink bus object in the base workspace to define the structure type for your Stateflow chart.
   
   For information about how to create Simulink bus objects, see “Create Bus Objects with the Bus Editor” (Simulink).

2. Open the Model Explorer.

3. In the Model Explorer, add a data object as described in “Add Data Through the Model Explorer” on page 9-3.

   The Model Explorer adds a data object and opens a Properties dialog box in its right-hand Dialog pane.

4. In the Name field of the Properties dialog box, enter the name of the structure data.

5. In the Scope field, select either Input or Output.

6. In the Type field, select Inherit: Same as Simulink, Bus: <object name>, or <data type expression> according to these guidelines:
<table>
<thead>
<tr>
<th>Type</th>
<th>Works with Scope</th>
<th>Requirements</th>
</tr>
</thead>
</table>
| Inherit: Same as Simulink| Input            | You do not need to specify a value. The data type is inherited from previously-defined data, based on the scope you selected for the data object. There must be a Simulink bus signal in your model that connects to the Stateflow structure input. The Simulink bus signal must be a nonvirtual bus (see “Virtual and Nonvirtual Buses” on page 24-11). You must specify a Simulink.Bus object in the base workspace with the same properties as the bus signal in your model that connects to the Stateflow structure input. The following properties must match:  
  • Number, name, and type of inputs  
  • Dimension  
  • Sample Time  
  • Complexity  
  • Sampling Mode  
  If your input signal comes from a Bus Creator block, you must specify an appropriate bus object for **Output data type** in the Bus Creator dialog box. When you specify the bus object, Simulink verifies that the properties of the Simulink.Bus object in the base workspace match the properties of the Simulink bus signal. |
<table>
<thead>
<tr>
<th>Type</th>
<th>Works with Scope</th>
<th>Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bus: <code>&lt;object name&gt;</code></td>
<td>Input or Output</td>
<td>Replace “&lt;object name&gt;” in the Type field with the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure. For example: Bus: inbus.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> You are not required to specify a bus signal in your Simulink model that connects to the Stateflow structure input or output. However, if you do specify a bus signal, its properties must match the Simulink.Bus object that defines the Stateflow structure input or output.</td>
</tr>
<tr>
<td><code>&lt;data type expression&gt;</code></td>
<td>Input or Output</td>
<td>Replace “&lt;data type expression&gt;” in the Type field with an expression that evaluates to a data type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enter the expression according to these guidelines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For structure inputs, you can use the Stateflow type on page 12-25 operator to assign the type of your structure based on the type of another structure defined in the Stateflow chart, as described in “Define Structure Types with Expressions” on page 24-15.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> You cannot use the type operator for structure outputs (structures of scope Output).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• For structure inputs or outputs, you can enter the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure.</td>
</tr>
</tbody>
</table>

7 Click Apply.

**Virtual and Nonvirtual Buses**

Simulink models support virtual and nonvirtual buses. Virtual buses read their inputs from noncontiguous memory. Nonvirtual buses read their inputs from data structures stored in contiguous memory (see “Virtual and Nonvirtual Buses” (Simulink)).

Stateflow charts support nonvirtual buses only. For Stateflow structure inputs, incoming virtual bus signals are converted to nonvirtual buses. Stateflow outputs only nonvirtual buses.
Even though this conversion process allows Stateflow charts to accept virtual and nonvirtual buses as input, Stateflow structures cannot inherit properties from virtual bus input signals. If the input to a chart is a virtual bus, you must set the data type mode of the Stateflow bus input to **Bus Object**.

**Define Local Structures**

To define local structures:

1. Create a Simulink bus object in the base workspace to define the structure type for your Stateflow chart.

   For information about how to create Simulink bus objects, see “Create Bus Objects with the Bus Editor” (Simulink).

2. Open the Model Explorer.

3. In the Model Explorer, add a data object as described in “Add Data Through the Model Explorer” on page 9-3.

   The Model Explorer adds a data object and opens a Properties dialog box in its right-hand Dialog pane.

4. In the **Name** field of the Properties dialog box, enter the name of the structure data.

5. In the **Scope** field, select Local.

6. In the **Type** field, select either **Bus: <object name>**, or **<data type expression>**, and then specify the expression as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>What to Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bus: &lt;object name&gt;</strong></td>
<td>Replace “&lt;object name&gt;” in the Type field with the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure. For example: <strong>Bus: inbus</strong>.</td>
</tr>
<tr>
<td>Type</td>
<td>What to Specify</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>&lt;data type expression&gt;</td>
<td>Replace &quot;&lt;data type expression&gt;&quot; in the Type field with an expression that evaluates to a data type. You can enter any of the following expressions:</td>
</tr>
<tr>
<td></td>
<td>• Use the Stateflow type on page 12-25 operator to assign the type of your structure based on the type of another structure defined in the Stateflow chart, as described in “Define Structure Types with Expressions” on page 24-15</td>
</tr>
<tr>
<td></td>
<td>• Enter the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure.</td>
</tr>
</tbody>
</table>
### What to Specify

<table>
<thead>
<tr>
<th>Type</th>
<th>What to Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;object name&gt;</code></td>
<td>Replace “&lt;object name&gt;” in the Type field with the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure. For example: Bus: inbus.</td>
</tr>
<tr>
<td><code>&lt;data type expression&gt;</code></td>
<td>Replace “&lt;data type expression&gt;” in the Type field with an expression that evaluates to a data type.</td>
</tr>
<tr>
<td></td>
<td>You can enter any of the following expressions:</td>
</tr>
<tr>
<td></td>
<td>• Use the Stateflow type on page 12-25 operator to assign the type of your structure based on the type of another structure defined in the Stateflow chart, as described in “Define Structure Types with Expressions” on page 24-15.</td>
</tr>
<tr>
<td></td>
<td>• Enter the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure.</td>
</tr>
</tbody>
</table>

7. Click **Apply**.

### Define Temporary Structures

You can define temporary structures in truth tables, graphical functions, and MATLAB functions of a Stateflow chart.

To define a temporary structure:

1. Create a Simulink bus object in the base workspace to define the structure type for your chart.

   For information about how to create Simulink bus objects, see “Create Bus Objects with the Bus Editor” (Simulink).

2. Open the Model Explorer.

3. In the Model Explorer, add a data object *to your function* as described in “Add Data Through the Model Explorer” on page 9-3.

   The Model Explorer adds a data object and opens a Properties dialog box in its right-hand Dialog pane.

4. In the **Name** field of the Properties dialog box, enter the name of the structure data.

5. In the **Scope** field, select **Temporary**.
6. In the **Type** field, select either **Bus: <object name>**, or **<data type expression>**, and then specify the expression as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>What to Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bus: &lt;object name&gt;</strong></td>
<td>Replace “&lt;object name&gt;” in the <strong>Type</strong> field with the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure. For example: Bus: inbus.</td>
</tr>
</tbody>
</table>
| **<data type expression>** | Replace “<data type expression>” in the **Type** field with an expression that evaluates to a data type. You can enter any of the following expressions:  
  - Use the Stateflow type on page 12-25 operator to assign the type of your structure based on the type of another structure defined in the Stateflow chart, as described in “Define Structure Types with Expressions” on page 24-15  
  - Enter the name of the Simulink.Bus object in the base workspace that defines the Stateflow structure. |

7. Click **Apply**.

### Define Structure Types with Expressions

You can define structure types with expressions that call the Stateflow type on page 12-25 operator. This operator assigns the type of your structure based on the type of another structure defined in the Stateflow chart. For example, the model sfbus_demo contains a local structure whose type is defined using a type operator expression, as follows:
In this case, the structure `counterbus_struct` derives its type from structure `inbus`, which is defined by the `Simulink.Bus` object `COUNTERBUS`. Therefore, the structure `counterbus_struct` is also defined by the bus object `COUNTERBUS`.

To learn how to use the Stateflow `type` operator, see “Derive Data Types from Previously Defined Data” on page 9-44.

**See Also**

**Related Examples**

- “Connect Structures in Charts to External Bus Signals” on page 24-3

**More About**

- “Rules for Defining Structure Data Types in Charts” on page 24-8
Index Sub-Structures and Fields

You index substructures and fields of Stateflow structures by using dot notation. With dot notation, the first text identifies the parent object, and subsequent text identify the children along a hierarchical path. When the parent is a structure, its children are individual fields or fields that contain other structures (also called substructures). By default, the names of the fields of a Stateflow structure match the names of the elements of the Simulink.Bus object that defines the structure.

Suppose that you have the following model:

In this example, the SubBus and BusObject blocks to the left of the chart are Bus Creator blocks. The BusObject block to the right of the chart is a Bus Selector block.

The following structures are defined in the chart:
The Simulink.Bus objects that define these structures have the following elements:

<table>
<thead>
<tr>
<th>Name of Structure</th>
<th>Scope</th>
<th>Defined By Simulink.Bus Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>in</td>
<td>Input</td>
<td>BusObject</td>
</tr>
<tr>
<td>out</td>
<td>Output</td>
<td>BusObject</td>
</tr>
<tr>
<td>subbus</td>
<td>Local</td>
<td>SubBus</td>
</tr>
</tbody>
</table>

By default, Stateflow structures in and out have the same fields — sb, a, b, and c — as the elements of Simulink.Bus object BusObject. Similarly, the Stateflow structure subbus has the same field ele as the element of Simulink.Bus object SubBus. Based on these specifications, the following table shows how the Stateflow chart resolves symbols in dot notation for indexing fields of the structures in this example:

<table>
<thead>
<tr>
<th>Dot Notation</th>
<th>Symbol Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>in.c</td>
<td>Field c of input structure in</td>
</tr>
</tbody>
</table>
### Dot Notation

<table>
<thead>
<tr>
<th>Symbol Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>in.a[1]</td>
</tr>
<tr>
<td>out.sb</td>
</tr>
<tr>
<td>in.sb.ele[2][3]</td>
</tr>
<tr>
<td>subbus.ele[1][1]</td>
</tr>
</tbody>
</table>

- **in.a[1]**: Second value of the vector field `a` of input structure `in`
- **out.sb**: Substructure `sb` of output structure `out`
- **in.sb.ele[2][3]**: Value in the third row, fourth column of field `ele` of substructure `sb` of input structure `in`
- **subbus.ele[1][1]**: Value in the second row, second column of field `ele` of local structure `subbus`

## Guidelines for Assignment of Values

You can assign values to any Stateflow structure except input structures — that is, a structure with scope equal to `Input`. Here are the guidelines for assigning values to output, local, parameter, and temporary structures:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assign one structure to another structure</td>
<td>You must define both structures with the same <code>Simulink.Bus</code> object in the base workspace.</td>
</tr>
<tr>
<td>Assign one structure to a substructure of a different structure and vice versa</td>
<td>You must define the structure with the same <code>Simulink.Bus</code> object in the base workspace as the substructure.</td>
</tr>
<tr>
<td>Assign a field of one structure to a field of another structure</td>
<td>The fields must have the same type and size.</td>
</tr>
</tbody>
</table>

**Note** In this case, you do not need to define the Stateflow structures with the same `Simulink.Bus` object in the base workspace.

For example, the following table presents valid and invalid structure assignments based on specifications for the `sfbus_demo` model, as described in “Connect Structures in Charts to External Bus Signals” on page 24-3:
<table>
<thead>
<tr>
<th>Assignment</th>
<th>Valid or Invalid?</th>
<th>Rationale</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>outbus = inbus;</code></td>
<td>Valid</td>
<td>Both <code>outbus</code> and <code>inbus</code> are defined by the same Simulink.Bus object, COUNTERBUS.</td>
</tr>
<tr>
<td><code>inbus = outbus;</code></td>
<td>Invalid</td>
<td>You cannot write to input structures.</td>
</tr>
<tr>
<td><code>inbus.limits = outbus.limits;</code></td>
<td>Invalid</td>
<td>You cannot write to fields of input structures.</td>
</tr>
<tr>
<td><code>counterbus_struct = inbus;</code></td>
<td>Valid</td>
<td>Both <code>counterbus_struct</code> and <code>inbus</code> are defined by the same Simulink.Bus object, COUNTERBUS.</td>
</tr>
<tr>
<td><code>counterbus_struct.inputsignal = inbus.inputsignal;</code></td>
<td>Valid</td>
<td>Both <code>counterbus_struct.inputsignal</code> and <code>inbus.inputsignal</code> have the same type and size because they each reference field <code>inputsignal</code>, a substructure of the Simulink.Bus object COUNTERBUS.</td>
</tr>
<tr>
<td><code>outbus.limits.upper_saturation_limit = inbus.inputsignal.input;</code></td>
<td>Valid</td>
<td>The field <code>upper_saturation_limit</code> from <code>limits</code>, a substructure of COUNTERBUS, has the same type and size as the field <code>input</code> from <code>inputsignal</code>, a different substructure of COUNTERBUS.</td>
</tr>
<tr>
<td><code>outbus.limits = inbus.inputsignal;</code></td>
<td>Invalid</td>
<td>The substructure <code>limits</code> is defined by a different Simulink.Bus object than the substructure <code>inputsignal</code>.</td>
</tr>
</tbody>
</table>

**Get Addresses**

When you write custom functions that take structure pointers as arguments, you must pass the structures by address. To get addresses of Stateflow structures and structure fields, use the & operator, as in the following examples:

- `&in` — Address of Stateflow structure `in`
- `&in.b` — Address of field `b` in Stateflow structure `in`
The model sfbus_demo contains a custom C function `counterbusFcn` that takes structure pointers as arguments, defined as follows in a custom header file:

```c
extern void counterbusFcn
    (COUNTERBUS *u1, int u2, COUNTERBUS *y1, int *y2);
```

To call this function, you must pass addresses to two structures defined by the `Simulink.Bus` object `COUNTERBUS`, as in this example:

```c
counterbusFcn(&counterbus_struct, u2, &outbus, &y2);
```

See “Connect Structures in Charts to External Bus Signals” on page 24-3 for a description of the structures defined in sfbus_demo.
Integrate Custom Structures in Stateflow Charts

You can define custom structures in C code, which you can then integrate with your chart for simulation and real-time code generation. For C charts, follow these steps:

1. Define your structure in C, creating custom source and header files.

   The header file must contain the `typedef` statements for your structures. For example, the model `sfbus_demo` uses custom structures, defined in a custom header file as follows:

   ```c
   typedef struct {
       int input;
   } SIGNALBUS;

   typedef struct {
       int upper_saturation_limit;
       int lower_saturation_limit;
   } LIMITBUS;

   typedef struct {
       SIGNALBUS inputsignal;
       LIMITBUS limits;
   } COUNTERBUS;
   ...
   ``

2. Define a `Simulink.Bus` object in the base workspace that matches each custom structure `typedef`.

   For example, the model `sfbus_demo` defines the following `Simulink.Bus` objects to match each `typedef` in the custom header file:
Open the Bus Editor and for each bus object in the base workspace defined in custom code, add the name of the header file that contains the matching `typedef`.

For example, the model `sfbus_demo` specifies the custom header file `counterbus.h` for the bus object `COUNTERBUS`:
Configure your chart to include custom C code, as follows.

<table>
<thead>
<tr>
<th>To Include Custom C Code:</th>
<th>Do This:</th>
</tr>
</thead>
<tbody>
<tr>
<td>In code generated for simulation</td>
<td>Follow these steps:</td>
</tr>
<tr>
<td></td>
<td><strong>a</strong> Open the chart that uses your custom C structures.</td>
</tr>
<tr>
<td></td>
<td><strong>b</strong> Open the Model Configuration Parameters dialog box.</td>
</tr>
<tr>
<td></td>
<td><strong>c</strong> In the Model Configuration Parameters dialog box, select <strong>Simulation Target</strong> in the Select tree.</td>
</tr>
<tr>
<td></td>
<td>Custom code options appear in the right pane.</td>
</tr>
<tr>
<td></td>
<td><strong>d</strong> Specify your custom code as described in “Task 1: Include Custom C Code in the Simulation Target” on page 29-7.</td>
</tr>
<tr>
<td>To Include Custom C Code:</td>
<td>Do This:</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>In code generated for real-time applications</td>
<td>Follow these steps:</td>
</tr>
<tr>
<td></td>
<td><strong>a</strong>  Open the chart that uses your custom C structures.</td>
</tr>
<tr>
<td></td>
<td><strong>b</strong>  Open the Model Configuration Parameters dialog box.</td>
</tr>
<tr>
<td></td>
<td><strong>c</strong>  In the Model Configuration Parameters dialog box, select <strong>Code Generation &gt; Custom Code</strong> in the Select tree.</td>
</tr>
<tr>
<td></td>
<td>Custom code options appear in the right pane.</td>
</tr>
<tr>
<td></td>
<td><strong>d</strong>  Follow instructions in “Integrate External Code by Using Model Configuration Parameters” (Simulink Coder).</td>
</tr>
</tbody>
</table>

5  Build your model and fix errors (see “Debug Structures” on page 24-26).

6  Run your model.
Debug Structures

You debug structures as you would other Stateflow chart data, as described in “Watch Stateflow Data Values” on page 30-34. Using the Stateflow Breakpoints and Watch window, you can examine the values of structure fields during simulation. To view the values of structure fields at the command line, use dot notation to index into the structure, as described in “Index Sub-Structures and Fields” on page 24-17.
Stateflow Design Patterns

- “Reduce Transient Signals with Debounce Logic” on page 25-2
- “Schedule Function Calls” on page 25-12
- “Schedule Execution of Simulink Subsystems” on page 25-13
- “Schedule Multiple Subsystems in a Single Step” on page 25-14
- “Schedule One Subsystem in a Single Step” on page 25-18
- “Schedule Subsystems to Execute at Specific Times” on page 25-22
- “Implement Dynamic Test Vectors” on page 25-25
- “Map Fault Conditions to Actions in Truth Tables” on page 25-34
- “Design for Isolation and Recovery in a Chart” on page 25-38
Reduce Transient Signals with Debounce Logic

### Why Debounce Signals

When a switch opens and closes, the switch contacts can bounce off each other before the switch completely transitions to an on or off state. The bouncing action can produce transient signals that do not represent a true change of state. Therefore, when modeling switch logic, it is important to filter out transient signals by using debouncing algorithms.

If you model a controller in a Stateflow chart, you do not want your switch logic to overwork the controller by turning it on and off in response to every transient signal it receives. To avoid this, design a Stateflow controller that uses temporal logic to debounce your input signals and determine whether a switch is actually on or off.

### How to Debounce a Signal

There are two ways to debounce a signal by using Stateflow:

1. Filter out transient signals by using the `duration` temporal operator.
2. Filter out transient signals by using an intermediate graphical state. Use intermediate graphical state for advanced filtering techniques, such as fault detection.

### Debounce Signals with the duration Operator

- “State Logic” on page 25-4
- “Run the Debouncer” on page 25-5

The model `sf_debouncer_using_duration` illustrates a design pattern that uses the `duration` operator to filter out transient signals.
The Debouncer chart contains this logic.
The debouncer design uses the `duration(n)` statement to implement absolute-time temporal logic.

The initial state for this model is `Off`. Using the `duration` operator, you can control what state the model is in based on how long the switch signal, `sw`, has been greater or less than zero. Once `sw` has been greater than or equal to zero for longer than 0.1 seconds, the switch moves from state `Off` to state `On`. Then, if `sw` has been less than zero for longer than 0.01 seconds, the switch moves from state `On` to state `Off`.

**State Logic**

The debouncer has two states, `On` and `Off`. The `duration` operator controls which state is active. The logic works as described in this table.
<table>
<thead>
<tr>
<th>Input Signal</th>
<th>State</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retains positive value for 0.1 second</td>
<td>On</td>
<td>Switch turns on</td>
</tr>
<tr>
<td>Retains negative value for 0.01 second</td>
<td>Off</td>
<td>Switch turns off</td>
</tr>
</tbody>
</table>

**Run the Debouncer**

To run the `sf_debouncer_using_duration` model, follow these steps:

1. To open the model, at the command prompt, type:

   ```matlab
   exPath = fullfile(matlabroot,'help','toolbox','stateflow','examples');
   open_system(fullfile(exPath,'sf_debouncer_using_duration'));
   ``

2. Open the Stateflow chart Debouncer and the Scope block.
3. Simulate the chart.

The scope shows how the debouncer isolates transient signals from the noisy input signal.
Debounce Signals with Fault Detection

The model sf_debouncer illustrates a design pattern that uses temporal logic and an intermediate state to isolate transient signals. With this design pattern, you can also include logic to detect faults and allow your system time to recover.

The Debouncer chart contains this logic.
The debouncer design uses the `after(n, sec)` statement to implement absolute-time temporal logic. The keyword `sec` defines simulation time that has elapsed since activation of a state.
**State Logic**

The debouncer chart contains an intermediate state called Debounce. The Debounce state isolates transient inputs by checking whether the signals retain their positive or negative values, or fluctuate between zero crossings over a prescribed period. The logic works as shown in this table.

<table>
<thead>
<tr>
<th>Input Signal</th>
<th>State</th>
<th>Transitions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retains positive value for 0.1 second</td>
<td>Debounce.On</td>
<td>On</td>
<td>Switch turns on</td>
</tr>
<tr>
<td>Retains negative value for 0.1 second</td>
<td>Debounce.Off</td>
<td>Off</td>
<td>Switch turns off</td>
</tr>
<tr>
<td>Fluctuates between zero crossings for 0.3 second</td>
<td>Debounce</td>
<td>Off.Fault</td>
<td>Chart isolates the input as a transient signal and gives it time to recover.</td>
</tr>
</tbody>
</table>

**Note** The Debounce to Off.Fault transition comes from a higher level in the chart hierarchy and overrides the transitions from the Debounce.Off and Debounce.On substates.

**Run the Debouncer**

To run the `sf_debouncer` model:

1. To open the model, at the command prompt, type `sf_debouncer` or click .
2. Open the Stateflow chart Debouncer and the Scope block.
3. Simulate the chart.

The scope shows how the debouncer isolates transient signals from the noisy input signal.
Use Event-Based Temporal Logic

As an alternative to absolute-time temporal logic, you can apply event-based temporal logic to determine true state in the Debouncer chart by using the after(n, tick) statement. The keyword tick specifies and implicitly generates a local event when the chart awakens.

The Error Generator block in the sf_debouncer model generates a pulse signal every 0.001 second. Therefore, to convert the absolute-time temporal logic specified in the Debouncer chart to event-based logic, multiply the n argument by 1000, as follows.

<table>
<thead>
<tr>
<th>Absolute Time-Based Logic</th>
<th>Event-Based Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>after ( 0.1, sec )</td>
<td>after ( 100, tick )</td>
</tr>
<tr>
<td>after ( 0.3, sec )</td>
<td>after ( 300, tick )</td>
</tr>
<tr>
<td>after ( 1, sec )</td>
<td>after ( 1000, tick )</td>
</tr>
</tbody>
</table>

See Also

More About

- “Operators for Absolute-Time Temporal Logic” on page 12-62
- “Operators for Event-Based Temporal Logic” on page 12-56
- “Control Chart Execution Using Implicit Events” on page 10-35
Schedule Function Calls

You can schedule calls to Simulink and MATLAB functions by using conditional and time-based logic in Stateflow. You can design logic using temporal operators without requiring timers and counters. Temporal logic can be based on events or elapsed time.

See Also

Related Examples

- “Scheduling Simulink® Algorithms Using Stateflow®”

More About

- “Control Chart Execution Using Temporal Logic” on page 12-55
Schedule Execution of Simulink Subsystems

In this section...

“When to Implement Schedulers” on page 25-13
“When Types of Schedulers” on page 25-13

When to Implement Schedulers

Use Stateflow charts to schedule the order of execution of Simulink subsystems explicitly in a model. Stateflow schedulers extend control of subsystem execution in a Simulink model, which determines order of execution implicitly based on block connectivity via sample time propagation.

Types of Schedulers

You can implement the following types of schedulers using Stateflow charts.

<table>
<thead>
<tr>
<th>Scheduler Design Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ladder logic scheduler on page 25-14</td>
<td>Schedules multiple Simulink subsystems to execute in a single time step</td>
</tr>
<tr>
<td>Loop scheduler on page 25-18</td>
<td>Schedules one Simulink subsystem to execute multiple times in a single time step</td>
</tr>
<tr>
<td>Temporal logic scheduler on page 25-22</td>
<td>Schedules Simulink subsystems to execute at specific times</td>
</tr>
</tbody>
</table>
Schedule Multiple Subsystems in a Single Step

The **ladder logic scheduler** design pattern allows you to specify the order in which multiple Simulink subsystems execute in a single time step. The model `sf_ladder_logic_scheduler` illustrates this design pattern.

The Ladder Logic Scheduler chart contains the following logic:
The key behaviors of the ladder logic scheduler are:

- “Function-Call Output Events Trigger Multiple Subsystems” on page 25-15
- “Flow Chart Determines Order of Execution” on page 25-16

**Function-Call Output Events Trigger Multiple Subsystems**

In a given time step, the Stateflow chart broadcasts a series of function-call output events to trigger the execution of three function-call subsystems — A1, A2, and A3 — in the Simulink model in an order determined by the ladder logic scheduler. Here is the sequence of activities during each time step:

1. The Simulink model activates the Stateflow chart Edge to Function at a rising edge of the 1-millisecond pulse generator.
2. The Edge to Function chart broadcasts the function-call output event call to activate the Stateflow chart Ladder Logic Scheduler.
The Ladder Logic Scheduler chart broadcasts function-call output events to trigger the function-call subsystems A1, A2, and A3, based on the values of inputs u1 and u2 (see “Flow Chart Determines Order of Execution” on page 25-16).

Flow Chart Determines Order of Execution

The Ladder Logic Scheduler chart uses Stateflow flow charting capabilities to implement the logic that schedules the execution of the Simulink function-call subsystems. The chart contains a Stateflow flow chart that resembles a ladder diagram. Each rung in the ladder represents a rule or condition that determines whether to execute one of the Simulink function-call subsystems. The flow logic evaluates each condition sequentially, which has the effect of scheduling the execution of multiple subsystems within the same time step. The chart executes each subsystem by using the send action to broadcast a function-call output event (see “Directed Local Event Broadcast Using send” on page 12-52).

Here is the sequence of activities that occurs in the Ladder Logic Scheduler chart in each time step:

1. Assign output y to input u1.
2. If u1 is positive, send function-call output event A1 to the Simulink model.

   The subsystem connected to A1 executes. This subsystem multiplies its input by a gain of 2 and passes this value back to the Stateflow Ladder Logic Scheduler chart as input u2. Control returns to the next condition in the Ladder Logic Scheduler.

3. If u2 is positive or zero, send function-call output event A2 to the Simulink model.

   The subsystem connected to A2 executes. This subsystem outputs its input value unchanged. Control returns to the next condition in the Ladder Logic Scheduler.

4. If u1 and u2 are positive, send function-call output event A3 to the Simulink model.

   The subsystem connected to A3 executes. This subsystem multiplies its input by a gain of 1.

5. The Ladder Logic Scheduler chart goes to sleep.

Run the Ladder Logic Scheduler

To run the sf_ladder_logic_scheduler model, follow these steps:

1. Open the model by typing sf_ladder_logic_scheduler at the MATLAB command prompt.
2 Open the Scope block.
3 Start simulation.

The scope shows how output $y$ changes, depending on which subsystems the Ladder Logic Scheduler chart calls during each time step.

Tip If you keep the chart closed, the simulation runs much faster. For other tips, see “Speed Up Simulation” on page 29-15.
Schedule One Subsystem in a Single Step

In this section...

“Key Behaviors of Loop Scheduler” on page 25-19
“Run the Loop Scheduler” on page 25-20

With the loop scheduler design pattern, you can schedule one Simulink subsystem to execute multiple times in a single time step. The model sf_loop_scheduler illustrates this design pattern.

The Looping Scheduler chart contains the following logic:
Key Behaviors of Loop Scheduler

The key behaviors of the loop scheduler are:

- “Function-Call Output Event Triggers Subsystem Multiple Times” on page 25-19
- “Flow Chart Implements For Loop” on page 25-19

Function-Call Output Event Triggers Subsystem Multiple Times

In a given time step, the Stateflow chart broadcasts a function-call output event to trigger the execution of the function-call subsystem A1 multiple times in the Simulink model. Here is the sequence of activities during each time step:

1. The Simulink model activates the Stateflow chart Edge to Function at a rising edge of the 1-millisecond pulse generator.
2. The Edge to Function chart broadcasts the function-call output event call to activate the Stateflow chart Looping Scheduler.
3. The Looping Scheduler chart broadcasts a function-call output event from a for loop to trigger the function-call subsystem A1 multiple times (see “Flow Chart Implements For Loop” on page 25-19).

Flow Chart Implements For Loop

The Looping Scheduler chart uses Stateflow flow charting capabilities to implement a for loop for broadcasting an event multiple times in a single time step. The chart contains a Stateflow flow chart that uses a local data variable \( i \) to control the loop. At each iteration, the chart updates output \( y \) and issues the send action to broadcast a function-call output.
event that executes subsystem A1. Subsystem A1 uses the value of y to recompute its output and send the value back to the Looping Scheduler chart.

**Run the Loop Scheduler**

To run the `sf_loop_scheduler` model, follow these steps:

1. Open the model by typing `sf_loop_scheduler` at the MATLAB command prompt.
2. Open the Scope block.

The scope displays the value of y at each time step.

In this example, the Looping Scheduler chart executes the for loop 10 times in each time step. During each iteration:

1. The chart increments y by 1 (the constant value of input u1).
2. The chart broadcasts a function-call output event that executes subsystem A1.
3 Subsystem A1 multiplies y by a gain of 1.
4 Control returns to the chart.
Schedule Subsystems to Execute at Specific Times

In this section...

“Key Behaviors of Temporal Logic Scheduler” on page 25-23
“Run the Temporal Logic Scheduler” on page 25-23

The temporal logic scheduler design pattern allows you to schedule Simulink subsystems to execute at specified times. The model `sf_temporal_logic_scheduler` illustrates this design pattern.

The Temporal Logic Scheduler chart contains the following logic:
Key Behaviors of Temporal Logic Scheduler

The Temporal Logic Scheduler chart contains two states that schedule the execution of the function-call subsystems A1, A2, and A3 at different rates, as determined by the temporal logic operator every (see “Operators for Event-Based Temporal Logic” on page 12-56).

In the FastScheduler state, the every operator schedules function calls as follows:

- Sends A1 every time the function-call output event call wakes up the chart
- Sends A2 at half the base rate
- Sends A3 at one-quarter the base rate

The SlowScheduler state schedules function calls less frequently — at 8, 16, and 32 times slower than the base rate. The chart switches between fast and slow executions after every 100 invocations of the call event.

Run the Temporal Logic Scheduler

To run the sf_temporal_logic_scheduler model, follow these steps:
1. Open the model by typing `sf_temporal_logic_scheduler` at the MATLAB command prompt.
2. Open the Scope block.
4. After the simulation ends, click the **Autoscale** button in the Scope block.

The scope illustrates the different rates of execution.
Implement Dynamic Test Vectors

When to Implement Test Vectors

Use Stateflow charts to create test vectors that change *dynamically* during simulation, based on the state of the system you are modeling.

For example, suppose you want to test an automatic car transmission controller in the situation where a car is coasting. To achieve a coasting state, a driver accelerates until the transmission shifts into the highest gear, then eases up on the gas pedal. To test this scenario, you could generate a signal that represents this behavior, as in the following Signal Builder block.
However, this approach has limitations. The signal changes value based on time, but cannot respond dynamically to changes in the system that are not governed by time alone. For example, how does the signal know when the transmission shifts into the highest gear? In this case, the signal assumes that the shift always occurs at time 5
because it cannot test for other deterministic conditions such as the speed of the vehicle. Moreover, you cannot change the signal based on outputs from the model.

By contrast, you can use Stateflow charts to develop test vectors that use conditional logic to evaluate and respond to changes in system state as they occur. For example, to test the coasting scenario, the chart can evaluate an output that represents the gear range and reduce speed only after the transmission shifts to the highest gear. That is, the car slows down as a direct result of the gear shift and not at a predetermined time. For a detailed look at this type of chart, see “A Dynamic Test Vector Chart” on page 25-27.

**A Dynamic Test Vector Chart**

The following model of an automatic transmission controller uses a Stateflow chart to implement test vectors that represent brake, throttle, and gear shift dynamics. The chart, called Dynamic Test Vectors, interfaces with the rest of the model as shown.

The chart models the dynamic relationship between the brake and throttle to test four driving scenarios. Each scenario is represented by a state.
In some of these scenarios, the throttle changes in response to time; in other cases, it responds to gear selection, an output of the Stateflow chart Shift_logic. The Shift_logic chart determines the gear value based on the speed of the vehicle.

Key Behaviors of the Chart and Model

The key behaviors of the test vector chart and model are:

- “Chart Represents Test Cases as States” on page 25-29
- “Chart Uses Conditional Logic to Respond to Dynamic Changes” on page 25-29
- “Model Provides an Interface for Selecting Test Cases” on page 25-29

Chart Represents Test Cases as States

The Dynamic Test Vectors chart represents each test case as an exclusive (OR) state. Each state manipulates brake and throttle values in a unique way, based on the time and gear inputs to the chart.

The chart determines which test to execute from the value of a constant signal case, output from the Signal Builder block. Each test case corresponds to a unique signal value.

Chart Uses Conditional Logic to Respond to Dynamic Changes

The Dynamic Test Vectors chart uses conditions on transitions to test time and gear level, and then adjusts brake and throttle accordingly for each driving scenario. Stateflow charts provide many constructs for testing system state and responding to changes, including:

- Conditional logic (see “State Action Types” on page 12-2 and “Transition Action Types” on page 12-7)
- Temporal logic (see “Control Chart Execution Using Temporal Logic” on page 12-55)
- Change detection operators (see “Detect Changes in Data Values” on page 12-74)
- MATLAB functions (see “Access Built-In MATLAB Functions and Workspace Data” on page 12-38)

Model Provides an Interface for Selecting Test Cases

The model uses a Signal Builder block to provide an interface for selecting test scenarios to simulate.
Select and Run Test Cases

In the Signal Builder, select and run test cases as follows:
To Test: | Do This:  
---|---
One case | Click the tab that corresponds to the driving scenario you want to test and click the **Start simulation** button:  

All cases and produce a model coverage report (*requires a Simulink Coverage™ software license*) | Click the **Run all and produce coverage** button:  

The Signal Builder block sends to the Dynamic Test Vectors chart one or more constant signal values that correspond to the driving scenarios you select. The chart uses these values to activate the appropriate test cases.

**Run the Model with Stateflow Test Vectors**

To run the `sf_test_vectors` model, follow these steps:

1. Open the model by typing `sf_test_vectors` at the MATLAB command prompt.
2. Open the Dynamic Test Vectors chart, the Signal Builder block, and the Scope block.
3. Select and simulate a driving scenario from the Signal Builder block, as described in “Select and Run Test Cases” on page 25-30.

The scope shows the interaction between speed and throttle for the selected scenario.
<table>
<thead>
<tr>
<th>Driving Scenario</th>
<th>Scope Display</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Passing Maneuver</td>
<td><img src="image" alt="Vehicle mph &amp; Throttle" /></td>
<td>Driver accelerates rapidly. At $t = 15$ seconds, steps the throttle to 100. With continued heavy throttle, the vehicle accelerates to about 100 MPH and then shifts into overdrive at about $t = 21$ seconds. The vehicle cruises along in fourth gear for the remainder of the simulation.</td>
</tr>
<tr>
<td>Gradual Acceleration</td>
<td><img src="image" alt="Vehicle mph &amp; Throttle" /></td>
<td>Driver maintains a slow but steady rate of acceleration.</td>
</tr>
<tr>
<td>Driving Scenario</td>
<td>Scope Display</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Hard Braking</td>
<td><img src="image1" alt="Scope Display" /></td>
<td>Driver accelerates until the transmission shifts to third gear, then removes foot from the gas pedal. After a short delay, moves foot to the brake pedal and pushes hard.</td>
</tr>
<tr>
<td>Coasting</td>
<td><img src="image2" alt="Scope Display" /></td>
<td>Driver accelerates until transmission shifts to highest gear, then eases up on the gas.</td>
</tr>
</tbody>
</table>
Map Fault Conditions to Actions in Truth Tables

You can use truth tables in Stateflow to map fault conditions of a system directly to their consequent actions. Truth tables implement logic design based on conditions, decisions, and actions. For more information, see “What Is a Truth Table?” on page 26-2.

This example shows how the model sf_aircraft maps the fault conditions and actions using a truth table. For details on this model, see “Fault Detection Control Logic in an Aircraft Elevator Control System”.

The fault detection system for the aircraft elevator control system has these requirements.

<table>
<thead>
<tr>
<th>Condition</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydraulic pressure 1 failure</td>
<td>While there are no other failures, turn off the left outer actuator.</td>
</tr>
<tr>
<td>Hydraulic pressure 2 failure</td>
<td>While there are no other failures, turn off the left inner actuator and the right inner actuator.</td>
</tr>
<tr>
<td>Hydraulic pressure 3 failure</td>
<td>While there are no other failures, turn off the right outer actuator.</td>
</tr>
<tr>
<td>Actuator position failure</td>
<td>While there are no other failures, isolate that specific actuator.</td>
</tr>
<tr>
<td>Hydraulic pressure 1 and left outer actuator failures</td>
<td>While there are no other failures, turn off the left outer actuator</td>
</tr>
<tr>
<td>Hydraulic pressure 2 and left inner actuator failures</td>
<td>While there are no other failures, turn off the left inner actuator.</td>
</tr>
<tr>
<td>Hydraulic pressure 3 and right outer actuator failures</td>
<td>While there are no other failures, turn off the right outer actuator.</td>
</tr>
<tr>
<td>Multiple failures on left hydraulics and actuators</td>
<td>Isolate the left outer actuator and the left inner actuator.</td>
</tr>
<tr>
<td>Multiple failures on right hydraulics and actuators</td>
<td>Isolate the right outer actuator and the right inner actuator.</td>
</tr>
<tr>
<td>Intermittent actuator failures</td>
<td>If an actuator has been switched on and off five times during operation, isolate that specific actuator.</td>
</tr>
</tbody>
</table>
Logic to satisfy these requirements is constructed using two truth tables in the chart Mode Logic; one for the right elevator (R\_switch), and one for the left elevator (L\_switch). This truth table is for the left elevator.
### Condition Table

<table>
<thead>
<tr>
<th>Description</th>
<th>Condition</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
<th>D5</th>
<th>D6</th>
<th>D7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hydraulic system 1 Low pressure (Left Outer line)</td>
<td>u.low_press[0]</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>F</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Left Outer actuator position failed</td>
<td>u.L_pos_fail[0]</td>
<td>-</td>
<td>-</td>
<td>T</td>
<td>T</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Hydraulic system 2 Low pressure (Inner line)</td>
<td>u.low_press[1]</td>
<td>F</td>
<td>-</td>
<td>F</td>
<td>-</td>
<td>T</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Left Inner actuator position failed</td>
<td>u.L_pos_fail[1]</td>
<td>F</td>
<td>-</td>
<td>F</td>
<td>-</td>
<td>-</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

Actions: Specify a row from the Action Table

### Action Table

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Default - All ok, do nothing.</td>
<td>Default:</td>
</tr>
<tr>
<td>2</td>
<td>Hydraulic System 1 Failure. Turn off Left Outer Actuator</td>
<td>send(go_off,Actuators.LO);</td>
</tr>
<tr>
<td>3</td>
<td>Left Outer Actuator Failure. Isolate Left Outer Actuator</td>
<td>send(go_isolated,Actuators.LO);</td>
</tr>
<tr>
<td>4</td>
<td>Hydraulic System 2 Failure. Turn off Left Inner Actuator</td>
<td>send(go_off,Actuators.LI);</td>
</tr>
<tr>
<td>5</td>
<td>Left Inner Actuator Failure. Isolate Left Inner Actuator</td>
<td>send(go_isolated,Actuators.LI);</td>
</tr>
</tbody>
</table>
The first requirement indicates that if a failure is only detected in the hydraulic pressure 1 system, turn off the left outer actuator. This requirement is represented in the decision D1 in the truth table. If there is low pressure in the hydraulic system 1, then D1 specifies that action 2 is performed. Action 2 sends an event go_off to the left actuator, Actuators.L0.

Similarly, the other requirements are mapped to the appropriate actions in the truth table. For example, if the left outer actuator fails, D3 causes action 3. Action 3 sends the event go_isolated to Actuators.L0 to isolate the left actuator.

The truth tables are called at entry(en) and during(du) actions for the chart so that fault checks execute at each time step.
Design for Isolation and Recovery in a Chart

In this section...

| “Mode Logic for the Elevator Actuators” on page 25-38 |
| “States for Failure and Isolation” on page 25-39 |
| “Transitions for Recovery” on page 25-40 |

Mode Logic for the Elevator Actuators

This example shows how the model sf_aircraft uses the chart Mode Logic to detect system faults and recover from failure modes for an aircraft elevator control system. For more information on this model, see “Fault Detection Control Logic in an Aircraft Elevator Control System”.

There are two elevators in the system, each with an outer and inner actuator. The Actuators state has a corresponding substate for each of the four actuators. An actuator has five modes: Passive, Active, Standby, Off, and Isolated. By default, the outer actuators are on, and the inner actuators are on standby. If a fault is detected in the outer actuators, the system responds to maintain stability by turning the outer actuators off and activating the inner actuators.
States for Failure and Isolation

Each actuator contains an Off state and an Isolated state. When the fault detection logic in one of the truth tables detects a failure, it broadcasts the event go_off or go_isolated to the failing actuator. For more information, see “Map Fault Conditions to Actions in Truth Tables” on page 25-34.
The `go_off` event instructs the failing actuator to transition to the `Off` state until the condition is resolved. The event `go_isolated` causes the failing actuator to transition to `Isolated`. Transitions to the `Isolated` state are from the superstate `L1`, which contains all the other operating modes. This state has no outgoing transitions, so that once an actuator has entered `Isolated` it remains there. Intermittent failures that cause an actuator to fail 5 or more times, also cause a transition to `Isolated`. The variable `fails` logs the number of failures for an actuator by incrementing each time a transition occurs out of `Off`.

**Transitions for Recovery**

Transitions in the substates for each actuator account for recovery requirements of the elevator system. These requirements derive from rules for symmetry and safety of the elevators such as:

- Only one actuator for an elevator must be active at one time.
- Outer actuators have priority over the inner actuators.
- Actuator activity should be symmetric if possible.
- Switching between actuators must be kept to a minimum.

For example, one requirement of the system is if one outer actuator fails, then the other outer actuator must move to standby and the inner actuators take over. Consequently, there is a transition from each `Active` state to `Standby`, and vice versa.
For the inner left actuator (LI), the transition to Active inside the L1 superstate is conditionally based on \([!LO\_act()|RI\_act()]\). This causes the left inner actuator to turn on if the outer actuator (LO) has failed, or the right inner actuator (RI) has turned on.
Another consequence if L0 fails and moves out of Active is a transition that occurs in the right outer actuator (R0). The R0 state transitions inside the L1 superstate from Active to Standby. This satisfies the requirement of the outer actuators and inner actuators to work in symmetry.
Truth Table Functions for Decision-Making Logic

- “What Is a Truth Table?” on page 26-2
- “Language Options for Stateflow Truth Tables” on page 26-4
- “Represent Combinatorial Logic Using Truth Tables” on page 26-6
- “Build Model with Stateflow Truth Table” on page 26-7
- “Program a Truth Table” on page 26-19
- “Debug a Truth Table” on page 26-42
- “Correct Overspecified and Underspecified Truth Tables” on page 26-58
- “How Stateflow Generates Content for Truth Tables” on page 26-69
- “Truth Table Operations” on page 26-77
What Is a Truth Table?

Truth table functions implement combinatorial logic design in a concise, tabular format. Typical applications for truth tables include decision making for:

- Fault detection and management
- Mode switching

Stateflow truth tables contain conditions, decisions, and actions arranged as follows:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Decision 1</th>
<th>Decision 2</th>
<th>Decision 3</th>
<th>Default Decision</th>
</tr>
</thead>
<tbody>
<tr>
<td>x == 1</td>
<td>T</td>
<td>F</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
<tr>
<td>Action</td>
<td>r = 1</td>
<td>r = 2</td>
<td>r = 3</td>
<td>r = 4</td>
</tr>
</tbody>
</table>

Each of the conditions entered in the Condition column must evaluate to true (nonzero value) or false (zero value). Outcomes for each condition are specified as T (true), F (false), or - (true or false). Each of the decision columns combines an outcome for each condition with a logical AND into a compound condition, that is referred to as a decision.

You evaluate a truth table one decision at a time, starting with Decision 1. If one of the decisions is true, you perform its action and truth table execution is complete. For example, if conditions 1 and 2 are false and condition 3 is true, Decision 3 is true and the variable r is set equal to 3. The remaining decisions are not tested and evaluation of the truth table is finished.

The last decision in the preceding example, Default Decision, covers all possible remaining decisions. If Decisions 1, 2, and 3 are false, then the Default Decision is automatically true and its action (r= 4) is executed. You can see this behavior when you examine the following equivalent pseudocode for the evaluation of the preceding truth table example:

<table>
<thead>
<tr>
<th>Description</th>
<th>Pseudocode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decision 1</td>
<td>if ((x == 1) &amp; !(y == 1) &amp; !(z == 1))</td>
</tr>
<tr>
<td>Decision 1 Action</td>
<td>r = 1;</td>
</tr>
</tbody>
</table>
### Where to Use a Truth Table

A truth table function can reside anywhere in a chart, state, or subchart. The location of a function determines its scope, that is, the set of states and transitions that can call the function. Follow these guidelines:

- If you want to call the function only within one state or subchart and its substates, put your truth table function in that state or subchart. That function overrides any other functions of the same name in the parents and ancestors of that state or subchart.
- If you want to call the function anywhere in that chart, put your truth table function at the chart level.

### See Also

**More About**

- “Build Model with Stateflow Truth Table” on page 26-7
- “Represent Combinatorial Logic Using Truth Tables” on page 26-6

---

<table>
<thead>
<tr>
<th>Description</th>
<th>Pseudocode</th>
</tr>
</thead>
</table>
| Decision 2           | **elseif** (!\(x == 1\)) & (\(y == 1\)) & !(\(z == 1\))
                     | \(r = 2;\)                                      |
| Decision 2 Action    |                                                 |
| Decision 3           | **elseif** (!\(x == 1\)) & !(\(y == 1\)) & (\(z == 1\))
                     | \(r = 3;\)                                      |
| Decision 3 Action    |                                                 |
| Default Decision     | **else**                                        |
| Default Decision Action |                                          |
|                      | \(r = 4;\)                                      |
|                      | **endif**                                      |
Language Options for Stateflow Truth Tables

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“C Truth Tables” on page 26-4</td>
</tr>
<tr>
<td>“MATLAB Truth Tables” on page 26-4</td>
</tr>
<tr>
<td>“Select a Language for Stateflow Truth Tables” on page 26-5</td>
</tr>
<tr>
<td>“Migration from C to MATLAB Truth Tables” on page 26-5</td>
</tr>
</tbody>
</table>

C Truth Tables

Using C truth tables, you can specify conditions and actions with C as the action language. C truth tables support basic C constructs and provide access to MATLAB functions by using the `ml` namespace operator or `ml` function. To use C as the action language for your truth table, it must be inside a Stateflow C action language chart.

MATLAB Truth Tables

Truth Table blocks and truth tables inside charts that use MATLAB as the action language are MATLAB truth tables. In these MATLAB truth tables, you cannot specify C as the action language. You can specify conditions and actions in MATLAB truth tables, which provides optimizations for simulation and code generation.

MATLAB truth tables offer several advantages over C truth tables:

- MATLAB as the action language provides a richer syntax for specifying control flow logic in truth table actions. It provides for loops, while loops, nested if statements, and switch statements.
- You can call MATLAB functions directly in truth table actions. Also, you can call library functions (for example, MATLAB `sin` and `fft` functions) and generate code for these functions by using Simulink Codersoftware.
- You can create temporary or persistent variables during simulation or in code directly without having to define them in the Model Explorer.
- You have access to better debugging tools. You can set breakpoints on lines of code, step through code, and watch data values tool tips.
- You can use persistent variables in truth table actions. You can define data that persists across multiple calls to the truth table function during simulation.
Select a Language for Stateflow Truth Tables

If the truth table is inside a C action language Stateflow chart, you can specify an action language for your Stateflow truth table by using the Property Inspector.

1. Double-click the truth table.
2. Open the Property Inspector by selecting View > Property Inspector.
3. Under the Properties section, select C or MATLAB as the Action Language.

**Note** If you do not have the option to change the action language, your truth table is a MATLAB truth table.

### Migration from C to MATLAB Truth Tables

When you migrate from a C truth table to a MATLAB truth table, you must verify that the code to program the actions conforms to MATLAB syntax. Between the two action languages, these differences exist.

<table>
<thead>
<tr>
<th>Action language</th>
<th>Indices</th>
<th>Expression for not equal to</th>
</tr>
</thead>
<tbody>
<tr>
<td>MATLAB</td>
<td>One-based</td>
<td><code>~=</code></td>
</tr>
<tr>
<td>C</td>
<td>Zero-based</td>
<td><code>!=</code></td>
</tr>
</tbody>
</table>
Represent Combinatorial Logic Using Truth Tables

Here is the recommended workflow for using truth tables in Simulink models.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add a truth table to your Simulink model.</td>
<td>“Build Model with Stateflow Truth Table” on page 26-7</td>
</tr>
<tr>
<td>2</td>
<td>Specify properties of the truth table function.</td>
<td>“Specify Properties of Truth Table Functions in Stateflow Charts” on page 26-9</td>
</tr>
<tr>
<td>3</td>
<td>Select an action language and program the conditions and actions in the truth table.</td>
<td>“Program a Truth Table” on page 26-19</td>
</tr>
<tr>
<td>4</td>
<td>Debug the truth table for syntax errors and for errors during simulation.</td>
<td>“Debug a Truth Table” on page 26-42</td>
</tr>
<tr>
<td>5</td>
<td>Simulate the model and check the generated content for the truth tables.</td>
<td>“How Stateflow Generates Content for Truth Tables” on page 26-69</td>
</tr>
</tbody>
</table>
Build Model with Stateflow Truth Table

Add a Stateflow Block that Calls a Truth Table Function

You can add a Stateflow Truth Table block directly to your Simulink model or you can include a truth table within a Stateflow block to your Simulink model, and then create a chart that calls a truth table function.

Once you build a model, finish it by programming the truth table with its behavior as described in “Program a Truth Table” on page 26-19.

Create a Simulink Model

To execute a truth table, you first need a Simulink model that calls a Stateflow block. Later, you create a Stateflow chart for the Stateflow block that calls a truth table function. Here, you create a Simulink model that calls a Stateflow block.

1. At the command prompt, enter:
   ```
sfnew
   ```
   An untitled model with a Stateflow block appears.

2. Click and drag the Stateflow block to the center of the model window.
3. In the model window, select View > Library Browser.
   The Simulink Library Browser window opens with the Simulink node expanded.
4. Under the Simulink node, select the Sources library.
   The right pane of the Simulink Library Browser window displays the blocks of the Sources library.
5. From the right pane of the Simulink Library Browser, click and drag the Constant block to the left of the Chart block in the model.
6 Add two more Constant blocks to the left of the Chart block, and add a Display block (from the Sinks library) to the right of the Chart block.
7 In the model, double-click the middle Constant block.
8 In the Block Parameters dialog box that appears, change **Constant value** to 0.
9 Click **OK** to close the dialog box.
10 In the model, double-click the bottom Constant block.
11 In the Block Parameters dialog box that appears, change **Constant value** to 0.
12 Click **OK** to close the dialog box.

Your model should now look something like this:

![Model diagram](image)

13 Open the Model Configuration Parameters dialog box.
14 On the **Solver** pane, set:
   - **Type** to **Fixed-step**
   - **Solver** to **discrete (no continuous states)**
   - **Fixed-step size** to 1
15 Click **OK** to accept these values and close the Model Configuration Parameters dialog box.
16 Save the model as **ex_first_truth_table**.

**Create a Stateflow Truth Table**

You created a Simulink model in “Create a Simulink Model” on page 26-7 that contains a Stateflow block. Now open the chart for the block and specify a truth table for it:
1 In your model, double-click the Chart block to open an empty chart.
2 Click the Truth Table drawing tool:

3 Move your pointer into the empty chart and notice that it appears in the shape of a box.
4 Click to place a new truth table.

A shaded box appears with the title `truthtable`.
5 Enter the signature label

   \[ r = \text{ttable}(x,y,z) \]

and click outside the truth table box.

The signature label of the truth table function follows this syntax:

\[ [\text{return\_val}_1, \text{return\_val}_2, \ldots] = \text{function\_name}(\text{arg}_1, \text{arg}_2, \ldots) \]

You can specify multiple return values and multiple input arguments. Each return value and input argument can be a scalar, vector, or matrix of values.

**Note** For functions with only one return value, you can omit the brackets in the signature label.

**Specify Properties of Truth Table Functions in Stateflow Charts**

After you add a truth table function to a chart, you can specify its properties by following these steps:

1 Right-click the truth table function box and select **Properties** from the context menu.
The Truth Table properties dialog box for the truth table function appears. It contains a **General** tab and a **Documentation** tab.

![Truth Table properties dialog box](image)

The fields in the Truth Table properties dialog box under the **General** tab are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Function name; read-only; click this hypertext link to bring the truth table function to the foreground in its native Stateflow chart.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Function Inline Option</td>
<td>This option controls the inlining of the truth table function in generated code through the following selections:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Auto</strong></td>
</tr>
<tr>
<td></td>
<td>Decides whether or not to inline the truth table function based on an internal calculation.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inline</strong></td>
</tr>
<tr>
<td></td>
<td>Inlines the truth table function as long as it is not exported to other charts and is not part of a recursion. A recursion exists if the function calls itself either directly or indirectly through another called function.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Function</strong></td>
</tr>
<tr>
<td></td>
<td>Does not inline the function.</td>
</tr>
<tr>
<td>Label</td>
<td>You can specify the signature label for the function through this field. See “Create a Stateflow Truth Table” on page 26-8 for more information.</td>
</tr>
<tr>
<td>Underspecification</td>
<td>You can control the level of diagnostics for underspecification in your Stateflow Truth Table.</td>
</tr>
<tr>
<td>Overspecification</td>
<td>You can control the level of diagnostics for overspecification in your Stateflow Truth Table.</td>
</tr>
<tr>
<td>Action Language</td>
<td>Choose between MATLAB or C as the action language for your Stateflow Truth Table. See “Differences Between MATLAB and C as Action Language Syntax” on page 13-7.</td>
</tr>
</tbody>
</table>
The fields in the Truth Table properties dialog box under the **Documentation** tab are as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Description</strong></td>
<td>Textual description/comment.</td>
</tr>
<tr>
<td><strong>Document link</strong></td>
<td>Enter a URL address or a general MATLAB command. Examples are <code>www.mathworks.com</code>, <code>mailto:email_address</code>, and <code>edit/spec/data/speed.txt</code>.</td>
</tr>
</tbody>
</table>

2. Click **OK** to close the dialog box.

**Call a Truth Table in a Stateflow Action**

In “Create a Stateflow Truth Table” on page 26-8, you created the truth table function `ttable` with the signature:

\[ r = ttable(x,y,z) \]
Now you need to specify a call to the truth table function in the chart. Later, when the chart executes during simulation, it calls the truth table.

You can call truth table functions from the actions of any state or transition. You can also call truth tables from other functions, including graphical functions and other truth tables. Also, if you export a truth table, you can call it from any chart in the model.

To call the `ttable` function from the default transition of its own chart, follow these steps:

1. From the toolbar, select the Default Transition tool:

   ![Default Transition Tool]

2. Move your pointer to a location left of the truth table function and notice that it appears in the shape of a downward-pointing arrow.

3. Click to place a default transition into a terminating junction.

   ![Default Transition Placement]

4. Click the question mark character (?) that appears on the default transition.

   A blinking cursor in a text field appears for entering the label of the default transition.

5. Enter the text

   \{d = ttable(a,b,c);\}

   and click outside the transition label to finish editing it.

   You might want to adjust the label's position by clicking and dragging it to a new location. The finished chart should look something like this:
The label on the default transition provides a condition action that calls the truth table with arguments and a return value. When the Simulink model triggers the Stateflow block during simulation, the default transition executes and a call to the truth table \texttt{ttable} occurs.

The function call to the truth table must match the truth table signature. The type of the return value \(d\) must match the type of the signature return value \(r\), and the type of the arguments \(a\), \(b\), and \(c\) must match the type of the signature arguments \(x\), \(y\), and \(z\). You ensure this with a later step in this section when you create the data that you use in the chart.

**Tip** If the formal arguments of a function signature are scalars, verify that inputs and outputs of function calls follow the rules of scalar expansion. For more information, see “How Scalar Expansion Works for Functions” on page 17-6.

6 Save the model.

**Create Truth Table Data in Stateflow Charts and Simulink Models**

When you create a truth table with its own signature, you specify data for it in the form of a return value \((r)\) and argument values \((x, y, z)\). When you specify a call to a truth table, as you did in “Call a Truth Table in a Stateflow Action” on page 26-12, you specify data that you pass to the return and argument values of the truth table \((d, a, b,\) and \(c)\). Now you must define this data for the chart as follows:

1 Double-click the truth table function.
2 In the truth table, select **Add > Edit Data/Ports**.

The Model Explorer appears.
In the Model Hierarchy pane, the node for the function ttable appears highlighted, and the Contents pane displays the output (r) and inputs (x, y, z) for ttable. By default, these data are scalars of type double. If you want to redefine these data with a different size and type, you do it in the Model Explorer. However, no changes are necessary for this example.

Notice also in the Model Hierarchy pane that the node above the function ttable is Chart, the name of the chart that contains the truth table ttable.

How do I enable the third pane in the Model Explorer?

To enable or disable the third pane in the Model Explorer, select View > Show Dialog Pane.

3 In the Model Hierarchy pane, select Chart.

Notice that Chart contains no input or output data in the Contents pane. You must add the return and argument data for calling ttable.

4 Select Add > Data.

A scalar data is added to the chart in the Contents pane of the Model Explorer with the default name data. This data matches argument x in type and size.
How do I verify type and size?

To verify that the properties match, right-click data in the Contents pane and select Properties. The property sheet shows that the type is double and the size is scalar (the default when there is no entry in the Size field).

5 In the Contents pane, double-click the entry data in the Name column.

A small text field opens with the name data highlighted.

6 In the text field, change the name to a.

7 Under Scope, click the entry Local.

A drop-down menu of selectable scopes appears with Local selected.

8 Select Input.

The scope Input means that the Simulink model provides the value for this data, which passes to the chart through an input port on the Stateflow block.

You should now see the new data input a in the Contents pane.

9 Repeat steps 4 through 8 to add the data b and c with the scope Input, and data d with the scope Output.

The scope Output means that the chart provides this data, which passes to the Simulink model through an output port on the Stateflow block.

You should now see the input and output data in the Model Explorer.
The data a, b, c, and d match their counterparts x, y, z, and r in the truth table signature in size (scalar) and type (double), but have sources outside the Stateflow block. Notice that input ports for a, b, and c, and an output port for d appear on the Stateflow block in the model.

10 Complete connections to the Simulink blocks:
Save the model.
Program a Truth Table

In this section...

| “Open a Truth Table for Editing” on page 26-19 |
| “Select an Action Language” on page 26-20 |
| “Enter Truth Table Conditions” on page 26-20 |
| “Enter Truth Table Decisions” on page 26-22 |
| “Enter Truth Table Actions” on page 26-25 |
| “Assign Truth Table Actions to Decisions” on page 26-33 |
| “Add Initial and Final Actions” on page 26-39 |

Open a Truth Table for Editing

After you create and label a truth table in a chart, you specify its logical behavior. To open the truth table, double-click the truth table function.

![Condition Table and Action Table](ex_first_truth_table.png)
By default, a truth table contains a **Condition Table** and an **Action Table**, each with one row. The **Condition Table** contains a single decision column, **D1**, and a single action row.

### Select an Action Language

If the truth table is inside a C action language Stateflow chart, you can specify the action language for your Stateflow truth table:

1. Open the Property Inspector by selecting **View > Property Inspector**.
2. Under the **Properties** section, select **C** or **MATLAB** as the Action Language.

### Enter Truth Table Conditions

Conditions are the starting point for specifying logical behavior in a truth table. You open the truth table **ttable** for editing. You start programming the behavior of **ttable** by specifying conditions.

You enter conditions in the **Condition** column of the **Condition Table**. For each condition that you enter, you can enter an optional description in the **Description** column. To enter conditions for the truth table **ttable**:

1. Click the row on the **Condition Table** that you want to append.
2. Click the **Append Row** button on the side panel twice.

The truth table appends two rows to the bottom of the **Condition Table**.

3. Click and drag the bar that separates the **Condition Table** and the **Action Table** panes down to enlarge the **Condition Table** pane.
4. In the **Condition Table**, click the top cell of the **Description** column.

   A flashing text cursor appears in the cell, which appears highlighted.

5. Enter this text:

   ```plaintext
   x is equal to 1
   ```

   Condition descriptions are optional, but appear as comments in the generated code for the truth table.

6. To select the next cell on the right in the **Condition** column, press the right arrow.
7 In the first cell of the **Condition** column, enter:

XEQ1:

This text is an optional label that you can include with the condition. Each label must begin with an alphabetic character ([a-z][A-Z]) followed by any number of alphanumeric characters ([a-z][A-Z][0-9]) or an underscore (_).

8 Press **Enter** and this text:

\[ x == 1 \]

This text is the actual condition. Each condition that you enter must evaluate to zero (false) or nonzero (true). You can use optional brackets in the condition (for example, \[x == 1\]).

In truth table conditions, you can use data that passes to the truth table function through its arguments. The preceding condition tests whether the argument \(x\) is equal to 1. You can also use data defined for parent objects of the truth table, including the chart.

9 Repeat the preceding steps to enter the other two conditions.
Enter Truth Table Decisions

Each decision column (D1, D2, and so on) binds a group of condition outcomes together with an AND relationship into a decision. The possible values for condition outcomes in a decision are T (true), F (false), and - (true or false). In “Enter Truth Table Conditions” on page 26-20, you entered conditions for the truth table ttable. Continue by entering values in the decision columns:

1. Click the column **Condition Table** that you want to append.
2. Click the **Append Column** button on the side panel twice.
3 Click the top cell in decision column D1.

A flashing text cursor appears in the cell, which appears highlighted.

4 Press the space bar until a value of T appears.

Pressing the space bar toggles through the possible values of F, T, and -. You can also enter these characters directly. Pressing 1 sets the value to T, while pressing 0 sets the value to F. Pressing x sets the value to -.

5 Press the down arrow key to advance to the next cell down in the D1 column.

In the decision columns, you can use the arrow keys to advance to another cell in any direction. You can also use the right and left arrow keys to advance left or right in these cells.

6 Enter the remaining values for the decision columns:
During execution of the truth table, decision testing occurs in left-to-right order. The order of testing for individual condition outcomes within a decision is undefined. Truth tables evaluate the conditions for each decision in top-down order (first condition 1, then condition 2, and so on). Because this implementation is subject to change in the future, do not rely on a specific evaluation order.

**The Default Decision Column**

The last decision column in the truth table, D4, is the default decision for this truth table. The default decision covers any decisions not tested for in preceding decision columns to the
left. You enter a default decision as the last decision column on the right with an entry of - for all conditions in the decision. This entry represents any outcome for the condition, T or F.

In the preceding example, the default decision column, D4, specifies these decisions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Decision 4</th>
<th>Decision 5</th>
<th>Decision 6</th>
<th>Decision 7</th>
<th>Decision 8</th>
</tr>
</thead>
<tbody>
<tr>
<td>x == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>y == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>z == 1</td>
<td>F</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>T</td>
</tr>
</tbody>
</table>

**Tip** The default decision column must be the last column on the right in the **Condition Table**.

### Enter Truth Table Actions

During execution of the truth table, decision testing occurs in left-to-right order. When a decision match occurs, the action in the **Action Table** specified in the **Actions** row for that decision column executes. Then the truth table exits.

In “Enter Truth Table Decisions” on page 26-22, you entered decisions in the truth table. The next step is to enter actions you want to occur for each decision in the **Action Table**. Later, you assign these actions to their decisions in the **Actions** row of the **Condition Table**.

This section describes how to program truth table actions with these topics:

- “Set Up the Action Table” on page 26-26 — Shows you how to set up the Action Table in truth table ttable.
- “Program Actions Using C Expressions” on page 26-27 — Provides sample code to program actions in ttable. Follow this section if you selected C as the language for this truth table.
- “Program Actions Using MATLAB Expressions” on page 26-30 — Provides sample MATLAB code to program actions in ttable. Follow this section if you selected MATLAB as the language for this truth table.
**Set Up the Action Table**

1. Click the row **Action Table** that you want to append.
2. Click the **Append Row** button on the side panel three times.
3 Program the actions using the language you selected for the truth table.

<table>
<thead>
<tr>
<th>If you selected...</th>
<th>Use this procedure...</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>“Program Actions Using C Expressions” on page 26-27</td>
</tr>
<tr>
<td>MATLAB</td>
<td>“Program Actions Using MATLAB Expressions” on page 26-30</td>
</tr>
</tbody>
</table>

**Program Actions Using C Expressions**

Follow this procedure to program your actions using C as the action language:

1 Click the top cell in the **Description** column of the **Action Table**.

   A flashing text cursor appears in the cell, which appears highlighted.

2 Enter the following description:

   set r to 1

   Action descriptions are optional, but appear as comments in the generated code for the truth table.

3 Press the right arrow key to select the next cell on the right, in the **Action** column.

4 Enter the following text:

   A1:

   You begin an action with an optional label followed by a colon (:). Later, you enter these labels in the **Actions** row of the **Condition Table** to specify an action for each decision column. Like condition labels, action labels must begin with an alphabetic character ([a-z][A-Z]) followed by any number of alphanumeric characters ([a-z][A-Z][0-9]) or an underscore (_).

5 Press **Enter** and enter the following text:

   r=1;

   In truth table actions, you can use data that passes to the truth table function through its arguments and return value. The preceding action, r=1, sets the value of the return value r. You can also specify actions with data defined for a parent object of the truth table, including the chart. Truth table actions can also broadcast or send events that are defined for the truth table, or for a parent, such as the chart itself.
**Tip** If you omit the semicolon at the end of an action, the result of the action echoes to the MATLAB Command Window when the action executes during simulation. Use this echoing option as a debugging tool.

6 Enter the remaining actions in the **Action Table**, as shown:
Now you are ready to assign actions to decisions, as described in “Assign Truth Table Actions to Decisions” on page 26-33.

<table>
<thead>
<tr>
<th>Condition Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DESCRIPTION</strong></td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>DESCRIPTION</strong></th>
<th><strong>ACTION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>set r to 1</td>
</tr>
<tr>
<td>2</td>
<td>set r to 2</td>
</tr>
<tr>
<td>3</td>
<td>set r to 3</td>
</tr>
<tr>
<td>4</td>
<td>set r to 4</td>
</tr>
</tbody>
</table>
Program Actions Using MATLAB Expressions

If you selected MATLAB as the action language, you can write MATLAB code to program your actions. Using this code, you can add control flow logic and call MATLAB functions directly. In the following procedure, you program an action in the truth table `tttable`, using the following features of MATLAB syntax:

- Persistent variables
- `if ... else ... end` control flows
- `for` loop

Follow these steps:

1. Click the top cell in the **Description** column of the **Action Table**.

   A flashing text cursor appears in the cell, which appears highlighted.

2. Enter this description:

   Maintain a counter and a circular vector of values of length 6. Every time this action is called, output r takes the next value of the vector.

   Action descriptions are optional, but appear as comments in the generated code for the truth table.

3. Press the right arrow key to select the next cell on the right, in the **Action** column.

4. Enter the following text:

   A1:

   You begin an action with an optional label followed by a colon (:). Later, you enter these labels in the **Actions** row of the **Condition Table** to specify an action for each decision column. Like condition labels, action labels must begin with an alphabetic character ([a-z][A-Z]) followed by any number of alphanumeric characters ([a-z][A-Z][0-9]) or an underscore (_).

5. Press **Enter** and enter the following text:

   persistent values counter;
   cycle = 6;
coder.extrinsic('plot');

if isempty(counter)
    % Initialize counter to be zero
    counter = 0;
else
    % Otherwise, increment counter
    counter = counter + 1;
end

if isempty(values)
    % Values is a vector of 1 to cycle
    values = zeros(1, cycle);
    for i = 1:cycle
        values(i) = i;
    end
    % For debugging purposes, call the MATLAB
    % function "plot" to show values
    plot(values);
end

% Output r takes the next value in values vector
r = values(mod(counter, cycle) + 1);

In truth table actions, you can use data that passes to the truth table function through its arguments and return value. The preceding action sets the return value r equal to the next value of the vector values. You can also specify actions with data defined for a parent object of the truth table, including the chart. Truth table actions can also broadcast or send events that are defined for the truth table, or for a parent, such as the chart itself.

Note If you omit the semicolon at the end of an action, the result of the action echoes to the MATLAB Command Window when the action executes during simulation. Use this echoing option as a debugging tool.

6 Enter the remaining actions in the Action Table, as shown:
If action A1 executes during simulation, a plot of the values vector appears:
Now you are ready to assign actions to decision.

**Assign Truth Table Actions to Decisions**

You must assign at least one action from the **Action Table** to each decision in the **Condition Table**. The truth table uses this association to determine what action to execute when a decision tests as true.
Rules for Assigning Actions to Decisions

The following rules apply when you assign actions to decisions in a truth table:

- You specify actions for decisions by entering a row number or a label in the `Actions` row cell of a decision column.

  If you use a label specifier, the label must appear with the action in the `Action Table`.

- You must specify at least one action for each decision.

  Actions for decisions are not optional. Each decision must have at least one action specifier that points to an action in the `Action Table`. If you want to specify no action for a decision, specify a row that contains no action statements.

- You can specify multiple actions for a decision with multiple specifiers separated by a comma, semicolon, or space.

  For example, for the decision column `D1`, you can specify `A1, A2, A3` or `1;2;3` to execute the first three actions when decision `D1` is true.

- You can mix row number and label action specifiers interchangeably in any order.

  The following example uses both row and label action specifiers.
- You can specify the same action for more than one decision, as shown:
Row number action specifiers in the Actions row of the Condition Table automatically adjust to changes in the row order of the Action Table.

**How to Assign Actions to Decisions**

This section describes how to assign actions to decisions in the truth table. In this example, the Actions row cell for each decision column contains a label specified for each action in the Action Table. Follow these steps:
1. Click the bottom cell in decision column D1, the first cell of the Actions row of the Condition Table.

2. Enter the action specifier A1 for decision column D1.

   When D1 is true, action A1 in the Action Table executes.

3. Enter the action specifiers for the remaining decision columns:
Now you are ready to perform the final step in programming a truth table.
Add Initial and Final Actions

In addition to actions for decisions, you can add initial and final actions to the truth table function. Initial actions specify an action that executes before any decision testing occurs. Final actions specify an action that executes as the last action before the truth table exits. To specify initial and final actions for a truth table, use the action labels INIT and FINAL in the Action Table.

Use this procedure to add initial and final actions that display diagnostic messages in the MATLAB Command Window before and after execution of the truth table:

1. In the truth table, right-click row 1 of the Action Table and select Insert Row.
   A blank row appears at the top of the Action Table.
2. Select Edit > Append Row.
   A blank row appears at the bottom of the Action Table.
3. Click and drag the bottom border of the truth table to show all six rows of the Action Table:
### Truth Table Functions for Decision-Making Logic

#### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
<tr>
<td>2 y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>3 z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
<tr>
<td>ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE</td>
<td></td>
<td>A1</td>
<td>A2</td>
<td>A3</td>
<td>A4</td>
</tr>
</tbody>
</table>

#### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2  set r to 1</td>
<td>A1: r=1;</td>
</tr>
<tr>
<td>3  set r to 2</td>
<td>A2: r=2;</td>
</tr>
<tr>
<td>4  set r to 3</td>
<td>A3: r=3;</td>
</tr>
<tr>
<td>5  set r to 4</td>
<td>A4: t=4;</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
</tbody>
</table>
4 Add the initial action in row 1 as follows:

<table>
<thead>
<tr>
<th>Truth Table Type</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Initial action:</td>
<td>INIT: ml.disp('truth table ttable entered');</td>
</tr>
<tr>
<td></td>
<td>Display message</td>
<td></td>
</tr>
<tr>
<td>MATLAB</td>
<td>Initial action:</td>
<td>INIT: coder.extrinsic('disp');</td>
</tr>
<tr>
<td></td>
<td>Display message</td>
<td>disp('truth table ttable entered');</td>
</tr>
</tbody>
</table>

5 Add the final action in row 6 as follows:

<table>
<thead>
<tr>
<th>Truth Table Type</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Final action:</td>
<td>FINAL: ml.disp('truth table ttable exited');</td>
</tr>
<tr>
<td></td>
<td>Display message</td>
<td></td>
</tr>
<tr>
<td>MATLAB</td>
<td>Final action:</td>
<td>FINAL: coder.extrinsic('disp');</td>
</tr>
<tr>
<td></td>
<td>Display message</td>
<td>disp('truth table ttable exited');</td>
</tr>
</tbody>
</table>

Although the initial and final actions for the preceding truth table example appear in the first and last rows of the Action Table, you can enter these actions in any row. You can also assign initial and final actions to decisions by using the action specifier INIT or FINAL in the Actions row of the Condition Table.
Debug a Truth Table

**In this section...**

“Check Truth Tables for Errors” on page 26-42
“Debug a Truth Table During Simulation” on page 26-42

**Check Truth Tables for Errors**

Once you completely specify your truth tables, you begin the process of debugging them. The first step is to run diagnostics to check truth tables for syntax errors including overspecification and underspecification, as described in “Correct Overspecified and Underspecified Truth Tables” on page 26-58.

To check for syntax errors:

1. Double-click the truth table.
2. In the truth table, select **Settings > Run Diagnostics**.

   For example, if you change the action for decision column **D4** to an action that does not exist, you get an error message in the Diagnostic Viewer.

Truth table diagnostics run automatically when you start simulation of the model with a new or modified truth table. If no errors exist, the diagnostic window does not appear and simulation starts immediately.

**Debug a Truth Table During Simulation**

Ways to debug truth tables during simulation include:

<table>
<thead>
<tr>
<th>Method</th>
<th>Type of Truth Tables</th>
<th>How To Do It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Stateflow debugging tools to step through each condition and action, and monitor data values during simulation.</td>
<td>C truth table</td>
<td>See “Use Stateflow Debugging Tools” on page 26-43.</td>
</tr>
<tr>
<td>Method</td>
<td>Type of Truth Tables</td>
<td>How To Do It</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use MATLAB debugging tools to step through generated code for the truth</td>
<td>MATLAB truth table</td>
<td>See “Use MATLAB Debugging Tools” on page 26-57.</td>
</tr>
<tr>
<td>table.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Use Stateflow Debugging Tools**

When you use Stateflow debugging tools to debug truth tables, you must perform these tasks:

1. Specify a breakpoint for the call to the truth table on page 26-43.
2. Step through the conditions and actions on page 26-43.

**Specify a Breakpoint for the Call to a Truth Table**

Before you debug the truth table during simulation, you must set a breakpoint for the truth table. This breakpoint pauses execution during simulation so that you can debug each execution step of a truth table.

1. In the chart, right-click the function box for the truth table.
2. Select **Set Breakpoint During Function Call**.

   A breakpoint occurs when the chart calls this truth table function during simulation.

**Step Through Conditions and Actions of a Truth Table**

After setting a breakpoint for the truth table function call, you can step through conditions and actions:

1. Begin simulation of your model.
2. Wait until the breakpoint for the call to the truth table occurs. Stateflow generates the graphical function for the truth table.
3. Add truth table data to the **Watch Data** tab of the Stateflow Breakpoints and Watch window. From the Model Explorer, select each data. On the Data Properties dialog box, select **Add to watch window**.
4. Click **Step In**, twice to advance simulation through the call to the truth table.

   The INIT action of the truth table highlights prior to execution.
## Truth Table Functions for Decision-Making Logic

### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>x is equal to 1</td>
<td>x == 1</td>
<td>T</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>y is equal to 1</td>
<td>y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>z is equal to 1</td>
<td>z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td></td>
</tr>
</tbody>
</table>

** ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE **

<table>
<thead>
<tr>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
</tr>
</thead>
</table>

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial action:</td>
<td>INIT:</td>
</tr>
<tr>
<td>Display message</td>
<td>ml.disp('truth table ttable entered');</td>
</tr>
<tr>
<td>set r to 1</td>
<td>A1:</td>
</tr>
<tr>
<td></td>
<td>r=1;</td>
</tr>
<tr>
<td>set r to 2</td>
<td>A2:</td>
</tr>
<tr>
<td></td>
<td>r=2;</td>
</tr>
<tr>
<td>set r to 3</td>
<td>A3:</td>
</tr>
<tr>
<td></td>
<td>r=3;</td>
</tr>
<tr>
<td>set r to 4</td>
<td>A4:</td>
</tr>
<tr>
<td></td>
<td>r=4;</td>
</tr>
<tr>
<td>Final action:</td>
<td>FINAL:</td>
</tr>
<tr>
<td>Display message</td>
<td>ml.disp('truth table ttable exited');</td>
</tr>
</tbody>
</table>
5 Click Step In to execute the INIT action and advance truth table execution to the first condition.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

** ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE **

<table>
<thead>
<tr>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
</tr>
</thead>
</table>

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial action: Display message</td>
<td>INIT: ml_disp(&quot;truth table table entered&quot;);</td>
</tr>
<tr>
<td>set r to 1</td>
<td>A1: r=1;</td>
</tr>
<tr>
<td>set r to 2</td>
<td>A2: r=2;</td>
</tr>
<tr>
<td>set r to 3</td>
<td>A3: r=3;</td>
</tr>
<tr>
<td>set r to 4</td>
<td>A4: r=4;</td>
</tr>
<tr>
<td>Final action: Display message</td>
<td>FINAL: ml_disp(&quot;truth table table exited&quot;);</td>
</tr>
</tbody>
</table>
6 Click Step In to evaluate the first condition and advance truth table execution to the second condition.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>3 z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td></td>
</tr>
</tbody>
</table>

#### ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE
- A1
- A2
- A3
- A4

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initial action:</td>
<td>INIT:</td>
</tr>
<tr>
<td>Display message</td>
<td>ml.disp('truth table ttable entered');</td>
</tr>
<tr>
<td>2 set r to 1</td>
<td>A1:</td>
</tr>
<tr>
<td></td>
<td>r=1;</td>
</tr>
<tr>
<td>3 set r to 2</td>
<td>A2:</td>
</tr>
<tr>
<td></td>
<td>r=2;</td>
</tr>
<tr>
<td>4 set r to 3</td>
<td>A3:</td>
</tr>
<tr>
<td></td>
<td>r=3;</td>
</tr>
<tr>
<td>5 set r to 4</td>
<td>A4:</td>
</tr>
<tr>
<td></td>
<td>r=4;</td>
</tr>
<tr>
<td>6 Final action:</td>
<td>FINAL:</td>
</tr>
<tr>
<td>Display message</td>
<td>ml.disp('truth table ttable exited');</td>
</tr>
</tbody>
</table>
7 Click Step In to evaluate the second condition and advance truth table execution to the third condition.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

**Actions:** Specify a row from the action table

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial action:</td>
<td>INIT: ml.disp('truth table ttable entered');</td>
</tr>
<tr>
<td>Display message</td>
<td></td>
</tr>
<tr>
<td>set r to 1</td>
<td>A1: r=1;</td>
</tr>
<tr>
<td>set r to 2</td>
<td>A2: r=2;</td>
</tr>
<tr>
<td>set r to 3</td>
<td>A3: r=3;</td>
</tr>
<tr>
<td>set r to 4</td>
<td>A4: r=4;</td>
</tr>
<tr>
<td>Final action:</td>
<td>FINAL: ml.disp('truth table ttable exited');</td>
</tr>
<tr>
<td>Display message</td>
<td></td>
</tr>
</tbody>
</table>
8 Click Step In to evaluate the third condition and advance truth table execution to the first decision.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td></td>
</tr>
<tr>
<td>3 z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td></td>
</tr>
</tbody>
</table>

**Actions:** Specify a row from the action table

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initial action: Display message</td>
<td>INIT: ml_disp('truth table ttable entered');</td>
</tr>
<tr>
<td>2 set r to 1</td>
<td>A1: r=1;</td>
</tr>
<tr>
<td>3 set r to 2</td>
<td>A2: r=2;</td>
</tr>
<tr>
<td>4 set r to 3</td>
<td>A3: r=3;</td>
</tr>
<tr>
<td>5 set r to 4</td>
<td>A4: r=4;</td>
</tr>
<tr>
<td>6 Final action: Display message</td>
<td>FINAL: ml_disp('truth table ttable exited');</td>
</tr>
</tbody>
</table>
9 Click Step In twice.

Because the first decision is true, truth table execution advances to its action A1.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

**ACTIONS:** SPECIFY A ROW FROM THE ACTION TABLE

<table>
<thead>
<tr>
<th>ACTIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
</tr>
<tr>
<td>A2</td>
</tr>
<tr>
<td>A3</td>
</tr>
<tr>
<td>A4</td>
</tr>
</tbody>
</table>

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial action:</td>
<td>INIT:</td>
</tr>
<tr>
<td>Display message</td>
<td>ml.disp('truth table ttable entered');</td>
</tr>
</tbody>
</table>

2. set r to 1

<table>
<thead>
<tr>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1:</td>
</tr>
<tr>
<td>r=1;</td>
</tr>
</tbody>
</table>

3. set r to 2

<table>
<thead>
<tr>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A2:</td>
</tr>
<tr>
<td>r=2;</td>
</tr>
</tbody>
</table>

4. set r to 3

<table>
<thead>
<tr>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A3:</td>
</tr>
<tr>
<td>r=3;</td>
</tr>
</tbody>
</table>

5. set r to 4

<table>
<thead>
<tr>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>A4:</td>
</tr>
<tr>
<td>r=4;</td>
</tr>
</tbody>
</table>

6. Final action: Display message

<table>
<thead>
<tr>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>FINAL:</td>
</tr>
<tr>
<td>ml.disp('truth table ttable exited');</td>
</tr>
</tbody>
</table>
10 Click Step In four times to execute action A1 and advance to the FINAL action.
## Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>x is equal to 1</td>
<td>XEQ1: x == 1</td>
<td>T</td>
<td>F</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>y is equal to 1</td>
<td>YEQ1: y == 1</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>z is equal to 1</td>
<td>ZEQ1: z == 1</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

**Actions:** Specify a row from the action table

<table>
<thead>
<tr>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
</tr>
</thead>
</table>

## Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial action:</td>
<td>INIT: ml_disp('truth table ttable entered');</td>
</tr>
<tr>
<td>Display message</td>
<td></td>
</tr>
<tr>
<td>set r to 1</td>
<td>A1: r=1;</td>
</tr>
<tr>
<td>set r to 2</td>
<td>A2: r=2;</td>
</tr>
<tr>
<td>set r to 3</td>
<td>A3: r=3;</td>
</tr>
<tr>
<td>set r to 4</td>
<td>A4: r=4;</td>
</tr>
<tr>
<td>Final action:</td>
<td>FINAL: ml_disp('truth table ttable exited');</td>
</tr>
<tr>
<td>Display message</td>
<td></td>
</tr>
</tbody>
</table>
11 Click Step In.

This step executes the final action and exits the truth table. The Display block in the model displays the number 1.

**Use MATLAB Debugging Tools**

MATLAB truth tables generate content as MATLAB code, a format that offers advantages for debugging. You can set breakpoints on any line of generated code (whereas you cannot set breakpoints directly on a truth table). You can debug code that MATLAB truth tables generate the same way you debug a MATLAB function.

For more information about how to generate content for truth tables, see “How Stateflow Generates Content for Truth Tables” on page 26-69

**See Also**

**More About**

- “How Stateflow Generates Content for Truth Tables” on page 26-69
- “Debugging a MATLAB Function Block” (Simulink)
Correct Overspecified and Underspecified Truth Tables

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Example of an Overspecified Truth Table” on page 26-58</td>
</tr>
<tr>
<td>“Example of an Underspecified Truth Table” on page 26-62</td>
</tr>
</tbody>
</table>

**Example of an Overspecified Truth Table**

An overspecified truth table contains at least one decision that never executes because a previous decision specifies it in the **Condition Table**. The following example shows the **Condition Table** of an overspecified truth table.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Condition C1</td>
<td>C1: ( x == 0 )</td>
<td>F</td>
<td>T</td>
</tr>
<tr>
<td>2</td>
<td>Condition C2</td>
<td>C2: ( y == 0 )</td>
<td>T</td>
<td>-</td>
</tr>
<tr>
<td>3</td>
<td>Condition C3</td>
<td>C3: ( z == 0 )</td>
<td>T</td>
<td>T</td>
</tr>
</tbody>
</table>

**ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE**

<table>
<thead>
<tr>
<th></th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
</tr>
</thead>
</table>

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initial Action</td>
<td>INIT: ml.disp(&quot;beginning truth table&quot;);</td>
</tr>
<tr>
<td>2 Action 1</td>
<td>A1: ( x = 1 );</td>
</tr>
<tr>
<td>3 Action 2</td>
<td>A2: ( y = 1 );</td>
</tr>
<tr>
<td>4 Action 3</td>
<td>A3: ( z = 1 );</td>
</tr>
<tr>
<td>5 Final Action</td>
<td>FINAL: ml.disp(&quot;ending truth table&quot;);</td>
</tr>
</tbody>
</table>
The decision in column D3 (-TT) specifies the decisions FTT and TTT. These decisions are duplicates of decisions D1 (FTT) and D2 (TTT and TFT). Therefore, column D3 is an overspecification.

The following example shows the Condition Table of a truth table that appears to be overspecified, but is not.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Condition C1</td>
<td>C1: x == 0</td>
<td>F</td>
<td>T</td>
<td>T</td>
<td>-</td>
</tr>
<tr>
<td>2 Condition C2</td>
<td>C2: y == 0</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>3 Condition C3</td>
<td>C3: z == 0</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>T</td>
</tr>
</tbody>
</table>

**ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE**  
A1 A2 A3 A4

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
</table>
| 1 Initial Action | INIT:  
  m1 dispensaries('beginning truth table'); |
| 2 Action 1 | A1:  
  x = 1; |
| 3 Action 2 | A2:  
  y = 1; |
| 4 Action 3 | A3:  
  z = 1; |
| 5 Action 4 | A4:  
  x = 0; y = 0; z = 0; |
| 6 Final Action | FINAL:  
  m1 dispensaries('ending truth table'); |
In this case, the decision D4 specifies two decisions (TTT and FTT). FTT also appears in decision D1, but TTT is not a duplicate. Therefore, this Condition Table is not overspecified.

**Example of an Underspecified Truth Table**

An underspecified truth table lacks one or more possible decisions that require an action to avoid undefined behavior. The following example shows the Condition Table of an underspecified truth table.
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Condition C1</td>
<td>C1: x == 0</td>
<td>T</td>
<td>T</td>
<td>F</td>
</tr>
<tr>
<td>2 Condition C2</td>
<td>C2: y == 0</td>
<td>T</td>
<td>F</td>
<td>T</td>
</tr>
<tr>
<td>3 Condition C3</td>
<td>C3: z == 0</td>
<td>F</td>
<td>T</td>
<td>T</td>
</tr>
</tbody>
</table>

**ACTIONS: SPECIFY A ROW FROM THE ACTION TABLE**

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initial Action</td>
<td>INIT: rl_disp('beginning truth table');</td>
</tr>
<tr>
<td>2 Action 1</td>
<td>A1: x = 1;</td>
</tr>
<tr>
<td>3 Action 2</td>
<td>A2: y = 1;</td>
</tr>
<tr>
<td>4 Action 3</td>
<td>A3: z = 1;</td>
</tr>
<tr>
<td>5 Final Action</td>
<td>FINAL: rl_disp('ending truth table');</td>
</tr>
</tbody>
</table>
Complete coverage of the conditions in the preceding truth table requires a **Condition Table** with every possible decision:
## Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
<th>D5</th>
<th>D6</th>
<th>D7</th>
<th>D8</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Condition C1</td>
<td>C1: (x = 0)</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>2 Condition C2</td>
<td>C2: (y = 0)</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>F</td>
<td>T</td>
<td>F</td>
</tr>
<tr>
<td>3 Condition C3</td>
<td>C3: (z = 0)</td>
<td>F</td>
<td>T</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>T</td>
</tr>
</tbody>
</table>

**Actions:** Specify a row from the action table

<table>
<thead>
<tr>
<th></th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>A4</th>
<th>A5</th>
<th>A6</th>
<th>A7</th>
<th>A8</th>
</tr>
</thead>
</table>

## Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initial Action</td>
<td><code>INIT: ml.disp('beginning truth table');</code></td>
</tr>
<tr>
<td>2 Action 1</td>
<td><code>A1: x = 1;</code></td>
</tr>
<tr>
<td>3 Action 2</td>
<td><code>A2: y = 1;</code></td>
</tr>
<tr>
<td>4 Action 3</td>
<td><code>A3: z = 1;</code></td>
</tr>
<tr>
<td>5 Action 4</td>
<td><code>A4: x = 2;</code></td>
</tr>
<tr>
<td>6 Action 5</td>
<td><code>A5: y = 2;</code></td>
</tr>
<tr>
<td>7 Action 6</td>
<td><code>A6: z = 2;</code></td>
</tr>
<tr>
<td>8 Action 7</td>
<td><code>A7:</code></td>
</tr>
</tbody>
</table>
A possible workaround is to specify an action for all other possible decisions through a default decision, named DA:
### Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Condition C1</td>
<td>C1: x == 0</td>
<td>T</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>2 Condition C2</td>
<td>C2: y == 0</td>
<td>T</td>
<td>F</td>
<td>T</td>
<td>-</td>
</tr>
<tr>
<td>3 Condition C3</td>
<td>C3: z == 0</td>
<td>F</td>
<td>T</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

**Actions:** Specify a row from the action table

### Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Initial Action</td>
<td>INIT: ml.disp('beginning truth table');</td>
</tr>
<tr>
<td>2 Action 1</td>
<td>A1: x = 1;</td>
</tr>
<tr>
<td>3 Action 2</td>
<td>A2: y = 1;</td>
</tr>
<tr>
<td>4 Action 3</td>
<td>A3: z = 1;</td>
</tr>
<tr>
<td>5 Default Action</td>
<td>DA: x = 0; y = 0; z = 0;</td>
</tr>
<tr>
<td>6 Final Action</td>
<td>FINAL: ml.disp('ending truth table');</td>
</tr>
</tbody>
</table>
The last decision column is the default decision for the truth table. The default decision covers any remaining decisions not tested in the preceding decision columns. See “The Default Decision Column” on page 26-24 for an example and more complete description of the default decision column for a Condition Table.
How Stateflow Generates Content for Truth Tables

In this section...

“Types of Generated Content” on page 26-69
“View Generated Content” on page 26-69
“How Stateflow Software Generates Graphical Functions for Truth Tables” on page 26-69
“How Stateflow Software Generates MATLAB Code for Truth Tables” on page 26-74

Types of Generated Content

Stateflow software realizes the logical behavior specified in a truth table by generating content as follows:

<table>
<thead>
<tr>
<th>Type of Truth Table</th>
<th>Generated Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Graphical function</td>
</tr>
<tr>
<td>MATLAB</td>
<td>MATLAB code</td>
</tr>
</tbody>
</table>

View Generated Content

You generate content for a truth table when you simulate your model. Content regenerates whenever a truth table changes. To view the generated content of a truth table, follow these steps:

1. Simulate the model that contains the truth table.
2. Double-click the truth table.
3. Click the View Generated Content button:

How Stateflow Software Generates Graphical Functions for Truth Tables

This section describes how Stateflow software translates the logic of a C truth table into a graphical function.
In the following example, a C truth table has three conditions, four decisions and actions, and initial and final actions.
# How Stateflow Generates Content for Truth Tables

## Condition Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>CONDITION</th>
<th>D1</th>
<th>D2</th>
<th>D3</th>
<th>D4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition C1</td>
<td>C1: x == 0</td>
<td>T</td>
<td>F</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>Condition C2</td>
<td>C2: y == 0</td>
<td>-</td>
<td>T</td>
<td>F</td>
<td>-</td>
</tr>
<tr>
<td>Condition C3</td>
<td>C3: z == 0</td>
<td>-</td>
<td>-</td>
<td>T</td>
<td>-</td>
</tr>
</tbody>
</table>

**Actions: Specify a row from the action table**

<table>
<thead>
<tr>
<th></th>
<th>A1</th>
<th>A2</th>
<th>A3</th>
<th>DA</th>
</tr>
</thead>
</table>

## Action Table

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Action</td>
<td>INIT: ml.disp('beginning truth table')</td>
</tr>
<tr>
<td>Action 1</td>
<td>A1: x = 1;</td>
</tr>
<tr>
<td>Action 2</td>
<td>A2: y = 1;</td>
</tr>
<tr>
<td>Action 3</td>
<td>A3: z = 1;</td>
</tr>
<tr>
<td>Default Action</td>
<td>DA: x = 0; y = 0; z = 0;</td>
</tr>
<tr>
<td>Final Action</td>
<td>FINAL: ml.disp('ending truth table');</td>
</tr>
</tbody>
</table>
Stateflow software generates a graphical function for the preceding truth table. The top half of the flow chart looks like this:

```
xyz

{ 'INIT':Initial Action */
  ml.disp('beginning truth table');
}

{ 'Condition C1 */
  C1 = (x == 0);
}

{ 'Condition C2 */
  C2 = (y == 0);
}

{ 'Condition C3 */
  C3 = (z == 0);
}
```

The top half of the flow chart executes as follows:

- Performs initial actions
- Evaluates the conditions and stores the results in temporary data variables

The temporary data for storing conditions is based on the labels that you enter for the conditions. If you do not specify the labels, temporary data variables appear.

The bottom half of the flow chart looks like this:
In the bottom half of the flow chart, the stored values for conditions determine which decision is true and what action to perform. Each decision appears as a fork from a connective junction with one of two possible paths:

- A transition segment with a decision followed by a segment with the consequent action

The action appears as a condition action that leads to the FINAL action and termination of the flow chart.
• A transition segment that flows to the next fork for an evaluation of the next decision

This transition segment has no condition or action.

This implementation continues from the first decision through the remaining decisions in left-to-right column order. When a decision match occurs, the action for that decision executes as a condition action of its transition segment. After the action executes, the flow chart performs the final action for the truth table and terminates. Therefore, only one action results from a call to a truth table graphical function. This behavior also means that no data dependencies are possible between different decisions.

**How Stateflow Software Generates MATLAB Code for Truth Tables**

Stateflow software generates the content of MATLAB truth tables as MATLAB code that represents each action as a *nested* function inside the main truth table function.

Nested functions offer these advantages:

• Nested functions are independent of one another. Variables are local to each function and not subject to naming conflicts.
• Nested functions can access all data from the main truth table function.

The generated content appears in the function editor, which provides tools for simulation and debugging.

Here is the generated content for the MATLAB truth table described in “Program Actions Using MATLAB Expressions” on page 26-30:

• Main truth table function

```matlab
function r = ttable(x,y,z)
    % Initialize condition vars to logical scalar
    XEQ1 = false;
    YEQ1 = false;
    ZEQ1 = false;

    % Condition #1, "XEQ1"
    % x is equal to 1
    XEQ1 = logical(x == 1);
```
% Condition #2, "YEQ1"
% y is equal to 1
YEQ1 = logical(y == 1);

% Condition #3, "ZEQ1"
% z is equal to 1
ZEQ1 = logical(z == 1);

if (XEQ1 && ~YEQ1 && ~ZEQ1) % D1
A1();
elseif (~XEQ1 && YEQ1 && ~ZEQ1) % D2
A2();
elseif (~XEQ1 && ~YEQ1 && ZEQ1) % D3
A3();
else % Default
A4();
end

• Action A1

function A1()
% Action #1, "A1"
% Maintain a counter and a circular vector of length 6.
% Every time this action is called,
% output t takes the next value of the vector.

persistent values counter;
cycle = 6;

if isempty(counter)
    % Initialize counter to be zero
counter = 0;
else
    % Otherwise, increment counter
    counter = counter + 1;
end

if isempty(values)
    % Values is a vector of 1 to cycle
    values = zeros(1, cycle);
    for i = 1:cyle
        values(i) = i;
    end
    % For debugging purposes, call the MATLAB

% How Stateflow Generates Content for Truth Tables

26-75
% function "plot" to show values
plot(values);
end

% Output r takes the next value in values vector
r = values( mod(counter, cycle) + 1);

- Actions A2, A3, and A4

function A2()
% Action #2, "A2"
% set r to 2
r=2;

function A3()
% Action #3, "A3"
% set r to 3
r=3;

function A4()
% Action #4, "A4"
% set r to 4
r=4;
Truth Table Operations

In this section...

“Append Rows and Columns” on page 26-77
“Diagnose the Truth Table” on page 26-77
“View Auto-generated Content” on page 26-77
“Edit Tables” on page 26-78
“Move Rows and Columns” on page 26-78
“Select and Deselect Table Elements” on page 26-78
“Undo and Redo Edit Operations” on page 26-79
“View the Stateflow Chart for the Truth Table” on page 26-79

Append Rows and Columns

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Append Column" /></td>
<td><strong>Append Column</strong> adds a column on the right end of the selected table.</td>
</tr>
<tr>
<td><img src="image" alt="Append Row" /></td>
<td><strong>Append Row</strong> adds a row to the bottom of the selected table.</td>
</tr>
</tbody>
</table>

Diagnose the Truth Table

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Run Diagnostics" /></td>
<td><strong>Run Diagnostics</strong> checks the truth table for syntax errors. See “Debug a Truth Table” on page 26-42.</td>
</tr>
</tbody>
</table>

View Auto-generated Content

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View Auto-generated Content" /></td>
<td><strong>View Auto-generated Content</strong> displays the code generated for the truth table. C truth tables generate graphical functions. MATLAB truth tables generate MATLAB code. For details, see “How Stateflow Generates Content for Truth Tables” on page 26-69.</td>
</tr>
</tbody>
</table>
**Edit Tables**

The default **Condition Table** and the default **Action Table** have one empty row. Click a cell to edit its text contents. To move horizontally between cells, use the up and down arrow keys.

To display only one of the two tables, double-click the header of the table that you want to display. To revert to the display of both tables, double-click the header of the displayed table.

Cells for the numbered rows in decision columns like D1 can take values of T, F, or -. After you select one of these cells, you can use the spacebar to step through the T, F, and - values. In these cells you can use the left, right, up, and down arrow keys to advance to another cell in any direction.

**Move Rows and Columns**

To move a condition or action row up or down:

1. To select the row, click the row header.
2. Drag the row to a new position.

   The truth table renumbers the rows.

To move a decision column left or right:

1. To select the column, click the column header.
2. Drag the column to a new position.

   The truth table renumbers the decision columns.

**Note** To select multiple rows or columns that you want to move, hold down the Ctrl key.

**Select and Deselect Table Elements**

<table>
<thead>
<tr>
<th>Goal</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a cell for editing</td>
<td>Click the cell</td>
</tr>
<tr>
<td>Goal</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select text in a cell</td>
<td>Click and drag your pointer over the text</td>
</tr>
<tr>
<td>Select a row</td>
<td>Click the header for the row</td>
</tr>
<tr>
<td>Select a decision column in the <strong>Condition</strong></td>
<td>Click the header for the column</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td></td>
</tr>
<tr>
<td>Deselect a selected cell, row, or column</td>
<td>Click outside of the <strong>Condition Table</strong> or <strong>Action Table</strong>.</td>
</tr>
</tbody>
</table>

**Undo and Redo Edit Operations**

To undo the effects of the preceding operation, select **Edit > Undo** or press **Ctrl+Z** *(Command+Z)*.

To redo the effects of the preceding operation, select **Edit > Redo** or press **Ctrl+Y** *(Command+Y)*.

**View the Stateflow Chart for the Truth Table**

To navigate to the Stateflow chart for the truth table, press the **Esc** key.
MATLAB Functions in Stateflow Charts

• “MATLAB Functions in a Chart” on page 27-2
• “MATLAB Functions in a Stateflow Chart” on page 27-8
• “Specify MATLAB Function Properties in a Chart” on page 27-10
• “Program a MATLAB Function in a Chart” on page 27-15
• “Debug a MATLAB Function in a Chart” on page 27-18
• “Connect Structures in MATLAB Functions to Bus Signals in Simulink” on page 27-22
• “Define Data in MATLAB Functions” on page 27-25
• “Enhance Readability of Generated Code for MATLAB Functions” on page 27-27
MATLAB Functions in a Chart

A MATLAB function in a Stateflow chart is a graphical element you use to write algorithms that are easier to perform by calling built-in MATLAB functions. Typical applications include:

- Matrix-oriented calculations
- Data analysis and visualization

This type of function is useful for coding algorithms that are more easily expressed using MATLAB instead of the graphical Stateflow constructs. This function also provides optimizations for generating efficient, production-quality C code for embedded applications.

Where to Use a MATLAB Function

A MATLAB function can reside anywhere in a chart, state, or subchart. The location of a function determines its scope, that is, the set of states and transitions that can call the function. Follow these guidelines:

- If you want to call the function only within one state or subchart and its substates, put your MATLAB function in that state or subchart. That function overrides any other functions of the same name in the parents and ancestors of that state or subchart.
- If you want to call the function anywhere in that chart, put your MATLAB function at the chart level.

When to Use Reusable Functions in Charts

State actions and transition conditions can be complicated enough that defining them inline on the state or transition is not feasible. In this case, express the conditions or actions using one of the following types of Stateflow functions:

- Flow chart — Encapsulate flow charts containing if-then-else, switch-case, for, while, or do-while patterns.
- MATLAB — Write matrix-oriented algorithms; call MATLAB functions for data analysis and visualization.
- Simulink — Call Simulink function-call subsystems directly to streamline design and improve readability.
• Truth table — Represent combinational logic for decision-making applications such as fault detection and mode switching.

Use the function format that is most natural for the type of calculation required in the state action or transition condition.

If the four standard types of Stateflow functions do not work, you can write your own C or C++ code for integration with your chart. For more information about custom code integration, see “Share Data Using Custom C Code” on page 29-26.

**Build Model with MATLAB Function in a Chart**

This section explains how to create a model with a Stateflow chart that calls two MATLAB functions, `meanstats` and `stdevstats`. `meanstats` calculates a mean and `stdevstats` calculates a standard deviation for the values in `vals` and outputs them to the Stateflow data `mean` and `stdev`, respectively.

Follow these steps:

1. Create a new model with the following blocks:

2. Save the model as `call_stats_function_stateflow`.

3. In the model, double-click the Chart block.

4. Drag two MATLAB functions into the empty chart using this icon from the toolbar:

   ![Icon](image)

   A text field with a flashing cursor appears in the middle of each MATLAB function.

5. Label each function as shown:
You must label a MATLAB function with its signature. Use the following syntax:

\[
[\text{return\_val1}, \text{return\_val2},\ldots] = \text{function\_name}(\text{arg1}, \text{arg2},\ldots)
\]

You can specify multiple return values and multiple input arguments, as shown in the syntax. Each return value and input argument can be a scalar, vector, or matrix of values.

**Note** For MATLAB functions with only one return value, you can omit the brackets in the signature label.

6 In the chart, draw a default transition into a terminating junction with this condition action:

\{
    \text{mean} = \text{meanstats}(\text{invals});
    \text{stdev} = \text{stdevstats}(\text{invals});
\}

The chart should look something like this:
**Tip** If the formal arguments of a function signature are scalars, verify that inputs and outputs of function calls follow the rules of scalar expansion. For more information, see “How Scalar Expansion Works for Functions” on page 17-6.

7 In the chart, double-click the function `meanstats` to edit its function body in the editor.

8 In the function editor, select **Tools > Model Explorer** to open the Model Explorer.
The function `meanstats` is highlighted in the **Model Hierarchy** pane. The **Contents** pane displays the input argument `vals` and output argument `meanout`. Both are scalars of type double by default.

9  Double-click the `vals` row under the **Size** column to set the size of `vals` to 4.

10  Back in the chart, double-click the function `stdevstats` and repeat the previous two steps.

11  Back in the **Model Hierarchy** pane of the Model Explorer, select **Chart** and add the following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Scope</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>invals</code></td>
<td>Input</td>
<td>4</td>
</tr>
<tr>
<td><code>mean</code></td>
<td>Output</td>
<td>Scalar (no change)</td>
</tr>
<tr>
<td><code>stdev</code></td>
<td>Output</td>
<td>Scalar (no change)</td>
</tr>
</tbody>
</table>

You should now see the following data in the Model Explorer.

After you add the data `invals`, `mean`, and `stdev` to the chart, the corresponding input and output ports appear on the Stateflow block in the model.
12 Connect the Constant and Display blocks to the ports of the Chart block and save the model.

To program the functions `meanstats` and `stdevstats`, see “Program a MATLAB Function in a Chart” on page 27-15.
MATLAB Functions in a Stateflow Chart

The following model contains a Stateflow chart with a MATLAB function.

The chart contains the following logic:

The function contains the following code:

```matlab
function stats(vals)
    %#codegen
    % calculates a statistical mean and standard deviation
    % for the values in vals.

    len = length(vals);
    mean = avg(vals, len);
    stdev = sqrt(sum(((vals-avg(vals,len)).^2))/len);
    coder.extrinsic('plot');
    plot(vals,'+-');

    function mean = avg(array,size)
    mean = sum(array)/size;
```

Note in this example that the MATLAB function can call any of these types of functions:
• Local functions

Local functions are defined in the body of the MATLAB function. In this example, \texttt{avg} is a local function.

• Stateflow functions

Graphical, truth table, and other MATLAB functions can be called from a MATLAB function in a chart.

• MATLAB toolbox functions that support code generation

Toolbox functions for code generation are a subset of the functions that you can call in the MATLAB workspace. These functions generate C code for building targets that conform to the memory and data type requirements of embedded environments. In this example, \texttt{length}, \texttt{sqrt}, and \texttt{sum} are examples of toolbox functions for code generation.

• MATLAB toolbox functions that do not support code generation

You can also call \textit{extrinsic} functions on the MATLAB path that do not generate code. These functions execute only in the MATLAB workspace during simulation of the model.

• Simulink Design Verifier functions

Simulink Design Verifier software provides MATLAB functions for property proving and test generation.

• \texttt{sldv.prove}
• \texttt{sldv.assume}
• \texttt{sldv.test}
• \texttt{sldv.condition}
Specify MATLAB Function Properties in a Chart

Set MATLAB Function Properties

To specify properties for a MATLAB function in a Stateflow chart:

1. In the Stateflow chart, right click the MATLAB function.
2. Select Properties.

In the dialog box that appears, there are tabs for both General and Documentation Properties.
Specify MATLAB Function Properties in a Chart

![MATLAB Function dialog box](image)

- **Name**: `generateOutput`
- **Function Inline Option**: `Auto`
- **Label**: `generateOutput(len)`

- **Saturate on integer overflow**

MATLAB Function `fimath`

- **Same as MATLAB**
- **Specify Other**

```matlab
fimath('RoundingMethod', 'Nearest', 'OverflowAction', 'Saturate', 'ProductMode', 'FullPrecision', 'SumMode', 'FullPrecision')
```
Specify properties for the MATLAB function.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>MATLAB function read only name. Click the link to open the function contents in the MATLAB editor.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Function Inline Option</strong></td>
<td>Determine whether the function is inlined in the generated code by choosing one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If set to Auto, internal heuristics are used to determine whether or not to inline the MATLAB function.</td>
</tr>
<tr>
<td></td>
<td>• If set to Inline, inlining of the function is forced.</td>
</tr>
<tr>
<td></td>
<td>• If set to Function, inlining of the function is prevented.</td>
</tr>
<tr>
<td><strong>Saturate on integer overflow</strong></td>
<td>Select to specify that integer overflows saturate in the generated code. For more information, see “Handle Integer Overflow for Chart Data” on page 9-52.</td>
</tr>
<tr>
<td><strong>MATLAB Function fimath</strong></td>
<td>Setting defines the fimath properties for the MATLAB function. The fimath properties specified here are associated with all fi and fimath objects constructed in the MATLAB function. Choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td>• If set to Same as MATLAB, the function uses the same fimath properties as the current global fimath. The edit box appears dimmed and displays the current global fimath in read-only form. For more information on the global fimath and fimath objects, see the Fixed-Point Designer documentation.</td>
</tr>
<tr>
<td></td>
<td>• If set to Specify Other, you can specify your own fimath object. This can be done by either of these two methods:</td>
</tr>
<tr>
<td></td>
<td>a Construct the fimath inside the edit box.</td>
</tr>
<tr>
<td></td>
<td>b Construct the fimath object in the MATLAB or model workspace and enter its variable name in the edit box.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Label</td>
<td>Text defining the label of the MATLAB function in the Stateflow chart.</td>
</tr>
<tr>
<td>Description</td>
<td>Textual description/comment.</td>
</tr>
<tr>
<td>Document link</td>
<td>Link to documentation about the MATLAB function. Enter a Web URL address or</td>
</tr>
<tr>
<td></td>
<td>a MATLAB expression that, when evaluated, displays documentation.</td>
</tr>
<tr>
<td></td>
<td>Examples are <a href="http://www.mathworks.com">www.mathworks.com</a>, mailto:email_address and edit /spec/data/</td>
</tr>
<tr>
<td></td>
<td>speed.txt.</td>
</tr>
</tbody>
</table>

4 Click **Apply**.
Program a MATLAB Function in a Chart

To program the functions \texttt{meanstats} and \texttt{stdevstats} that you created in “Build Model with MATLAB Function in a Chart” on page 27-3, follow these steps:

1. Open the chart in the model \texttt{call_stats_function_stateflow}.
2. In the chart, open the function \texttt{meanstats}.

   The function editor appears with the header:

   \begin{verbatim}
   function meanout = meanstats(vals)
   \end{verbatim}

   This header is taken from the function label in the chart. You can edit the header directly in the editor, and your changes appear in the chart after you close the editor.

3. On the line after the function header, enter:

   \begin{verbatim}
   %#codegen
   \end{verbatim}

   The \texttt{#codegen} compilation directive helps detect compile-time violations of syntax and semantics in MATLAB functions supported for code generation.

4. Enter a line space and this comment:

   \begin{verbatim}
   % Calculates the statistical mean for vals
   \end{verbatim}

5. Add the line:

   \begin{verbatim}
   len = length(vals);
   \end{verbatim}

   The function \texttt{length} is an example of a built-in MATLAB function that is supported for code generation. You can call this function directly to return the vector length of its argument \texttt{vals}. When you build a simulation target, the function length is implemented with generated C code. Functions supported for code generation appear in “Functions and Objects Supported for C/C++ Code Generation — Alphabetical List” (MATLAB Coder).

   The variable \texttt{len} is an example of implicitly declared local data. It has the same size and type as the value assigned to it — the value returned by the function \texttt{length}, a scalar \texttt{double}. To learn more about declaring variables, see “Data Definition Basics” (MATLAB Coder).

   The MATLAB function treats implicitly declared local data as temporary data, which exists only when the function is called and disappears when the function exits. You
can declare local data for a MATLAB function in a chart to be persistent by using the `persistent` construct.

6 Enter this line to calculate the value of `meanout`:

```matlab
meanout = avg(vals,len);
```

The function `meanstats` stores the mean of `vals` in the Stateflow data `meanout`. Because these data are defined for the parent Stateflow chart, you can use them directly in the MATLAB function.

Two-dimensional arrays with a single row or column of elements are treated as vectors or matrices in MATLAB functions. For example, in `meanstats`, the argument `vals` is a four-element vector. You can access the fourth element of this vector with the matrix notation `vals(4,1)` or the vector notation `vals(4).

The MATLAB function uses the functions `avg` and `sum` to compute the value of `mean`. `sum` is a function supported for code generation. `avg` is a local function that you define later. When resolving function names, MATLAB functions in your chart look for local functions first, followed by functions supported for code generation.

**Note** If you call a function that the MATLAB function cannot resolve as a local function or a function for code generation, you must declare the function to be extrinsic.

7 Now enter this statement:

```matlab
coder.extrinsic('plot');
```

8 Enter this line to plot the input values in `vals` against their vector index.

```matlab
plot(vals,'-+');
```

Recall that you declared `plot` to be an extrinsic function because it is not supported for code generation. When the MATLAB function encounters an extrinsic function, it sends the call to the MATLAB workspace for execution during simulation.

9 Now, define the local function `avg`, as follows:

```matlab
function mean = avg(array,size)
mean = sum(array)/size;
```

The header for `avg` defines two arguments, `array` and `size`, and a single return value, `mean`. The local function `avg` calculates the average of the elements in `array` by dividing their sum by the value of argument `size`. 
The complete code for the function `meanstats` looks like this:

```matlab
function meanout = meanstats(vals)
    %#codegen

    % Calculates the statistical mean for vals
    len = length(vals);
    meanout = avg(vals,len);

    coder.extrinsic('plot');
    plot(vals,'-+');

    function mean = avg(array,size)
    mean = sum(array)/size;
```

10 Save the model.

11 Back in the chart, open the function `stdevstats` and add code to compute the standard deviation of the values in `vals`. The complete code should look like this:

```matlab
function stdevout = stdevstats(vals)
    %#codegen

    % Calculates the standard deviation for vals
    len = length(vals);
    stdevout = sqrt(sum(((vals-avg(vals,len)).^2))/len);

    function mean = avg(array,size)
    mean = sum(array)/size;
```

12 Save the model again.
Debug a MATLAB Function in a Chart

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Check MATLAB Functions for Syntax Errors” on page 27-18</td>
</tr>
<tr>
<td>“Run-Time Debugging for MATLAB Functions in Charts” on page 27-19</td>
</tr>
<tr>
<td>“Check for Data Range Violations” on page 27-21</td>
</tr>
</tbody>
</table>

Check MATLAB Functions for Syntax Errors

Before you can build a simulation application for a model, you must fix syntax errors. Follow these steps to check the MATLAB function meanstats for syntax violations:

1. Open the function meanstats inside the chart in the call_stats_function_stateflow model that you updated in “Program a MATLAB Function in a Chart” on page 27-15.

   The editor automatically checks your function code for errors and recommends corrections.

2. In the Stateflow Editor, select Code > C/C++ Code > Build Model.

   If there are no errors or warnings, the Builder window appears and reports success. Otherwise, it lists errors. For example, if you change the name of local function avg to a nonexistent local function aug in meanstats, errors appear in the Diagnostic Viewer.

3. The diagnostic message provides details of the type of error and a link to the code where the error occurred. The diagnostic message also contains a link to a diagnostic report that provides links to your MATLAB functions and compile-time type information for the variables and expressions in these functions. If your model fails to build, this information simplifies finding sources of error messages and aids understanding of type propagation rules. For more information about this report, see “MATLAB Function Reports” (Simulink).

4. In the diagnostic message, click the link after the function name meanstats to display the offending line of code.

   The offending line appears highlighted in the editor.

5. Correct the error by changing aug back to avg and recompile. No errors are found and the compile completes successfully.
Run-Time Debugging for MATLAB Functions in Charts

You use simulation to test your MATLAB functions for run-time errors that are not detectable by Stateflow. When you simulate your model, your MATLAB functions undergo diagnostic tests for missing or undefined information and possible logical conflicts as described in “Check MATLAB Functions for Syntax Errors” on page 27-18. If no errors are found, the simulation of your model begins.

Follow these steps to simulate and debug the meanstats function during run-time conditions:

1. In the function editor, click the dash (-) character in the left margin of this line:

   ```
   len = length(vals);
   ```

   A small red ball appears in the margin of this line, indicating that you have set a breakpoint.

2. Start simulation for the model.

   If you get any errors or warnings, make corrections before you try to simulate again. Otherwise, simulation pauses when execution reaches the breakpoint you set. A small green arrow in the left margin indicates this pause.

3. To advance execution to the next line, select Step.

   Notice that this line calls the local function avg. If you select Step here, execution advances past the execution of the local function avg. To track execution of the lines in the local function avg, select Step In instead.

4. To advance execution to the first line of the called local function avg, select Step In.

   Once you are in the local function, you can advance through one line at a time with the Step tool. If the local function calls another local function, use the Step In tool to step into it. To continue through the remaining lines of the local function and go back to the line after the local function call, select Step Out.

5. Select Step to execute the only line in avg.

   When avg finishes its execution, you see a green arrow pointing down under its last line.

6. Select Step to return to the function meanstats.

   Execution advances to the line after the call to avg.
To display the value of the variable `len`, place your pointer over the text `len` in the function editor for at least a second.

The value of `len` appears adjacent to your pointer.

You can display the value for any data in the MATLAB function in this way, no matter where it appears in the function. For example, you can display the values for the vector `vals` by placing your pointer over it as an argument to the function `length`, or as an argument in the function header.

You can also report the values for MATLAB function data in the MATLAB Command Window during simulation. When you reach a breakpoint, the `debug>>` command prompt appears in the MATLAB Command Window (you might have to press Enter to see it). At this prompt, you can inspect data defined for the function by entering the name of the data, as shown in this example:

```matlab
debug>> len
len =
 4
debug>>
```

As another debugging alternative, you can display the execution result of a function line by omitting the terminating semicolon. If you do, execution results appear in the MATLAB Command Window during simulation.

To leave the function until it is called again and the breakpoint is reached, select **Continue**.

At any point in a function, you can advance through the execution of the remaining lines of the function with the **Continue** tool. If you are at the end of the function, selecting **Step** does the same thing.

Click the breakpoint to remove it and select **Quit Debugging** to complete the simulation.

In the model, the computed values of `mean` and `stdev` now appear in the Display blocks.
Check for Data Range Violations

To control data range checking, set Simulation range checking in the Diagnostics: Data Validity pane of the Model Configuration Parameters dialog box.

Specify a Range

To specify a range for input and output data, follow these steps:

1. In the Model Explorer, select the MATLAB function input or output of interest.

   The Data properties dialog box opens in the Dialog pane of the Model Explorer.

2. In the Data properties dialog box, click the General tab and enter a limit range, as described in “Limit range properties” on page 9-12.
Connect Structures in MATLAB Functions to Bus Signals in Simulink

In this section...

| “About Structures in MATLAB Functions” on page 27-22 |
| “Define Structures in MATLAB Functions” on page 27-22 |

About Structures in MATLAB Functions

MATLAB functions support MATLAB structures. You can create structures in top-level MATLAB functions in Stateflow charts to interface with Simulink bus signals at input and output ports. Simulink buses appear inside the MATLAB function as structures; structure outputs from the MATLAB function appear as buses.

You can also create structures as local and persistent variables in top-level functions and local functions of MATLAB functions.

Define Structures in MATLAB Functions

This section describes how to define structures in MATLAB functions.

- “Rules for Defining Structures in MATLAB Functions” on page 27-22
- “Define Structure Inputs and Outputs to Interface with Bus Signals” on page 27-23
- “Define Local and Persistent Structure Variables” on page 27-24

Rules for Defining Structures in MATLAB Functions

Follow these rules when defining structures for MATLAB functions in Stateflow charts:

- For each structure input or output in a MATLAB function, you must define a Simulink.Bus object in the base workspace to specify its type to the Simulink signal.
- MATLAB structures cannot inherit their type from Simulink signals.
- MATLAB functions support nonvirtual buses only (see “Virtual and Nonvirtual Buses” (Simulink)).
- Structures cannot have scopes defined as Constant.
Define Structure Inputs and Outputs to Interface with Bus Signals

When you create structure inputs in MATLAB functions, the function determines the type, size, and complexity of the structure from the Simulink input signal. When you create structure outputs, you must define their type, size, and complexity in the MATLAB function.

You can connect MATLAB structure inputs and outputs to any Simulink bus signal, including:

- Simulink blocks that output bus signals — such as Bus Creator blocks
- Simulink blocks that accept bus signals as input — such as Bus Selector and Gain blocks
- S-Function blocks
- Other MATLAB functions

To define structure inputs and outputs for MATLAB functions in Stateflow charts, follow these steps:

1. Create a Simulink bus object in the base workspace to specify the properties of the structure you will create in the MATLAB function.

   For information about how to create Simulink bus objects, see “Create Bus Objects with the Bus Editor” (Simulink).

2. Open the Model Explorer and follow these steps:

   a. In the Model Hierarchy pane, select the MATLAB function in your chart.
   b. Add a data object, as described in “Add Data Through the Model Explorer” on page 9-3.

      The Model Explorer adds a data object and opens a Properties dialog box in its right-hand Dialog pane.
   c. In the Properties dialog box, enter the following information in the General tab fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>What to Specify</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a name for referencing the structure in the MATLAB function. This name does not have to match the name of the bus object in the base workspace.</td>
</tr>
</tbody>
</table>
### Define Local and Persistent Structure Variables

You can define structures as local or persistent variables inside MATLAB functions. For details, see “Structures” (MATLAB Coder).
Define Data in MATLAB Functions

In this section...

“Define Enumerated Data in MATLAB Functions” on page 27-25
“Declare Variable-Size Data in MATLAB Functions” on page 27-25
“Define Temporary Data” on page 27-25

Define Enumerated Data in MATLAB Functions

Define and use enumerated data with MATLAB functions in Stateflow charts the same way as in MATLAB Function blocks in a model. For more information, see “Code Generation for Enumerations” (Simulink).

To learn how to define and use enumerated data in Stateflow charts, see “Define Enumerated Data Types” on page 19-5.

Declare Variable-Size Data in MATLAB Functions

Declare and use variable-size matrices and arrays with MATLAB functions in Stateflow charts the same way as in MATLAB Function blocks in a model. For more information, see:

• “Control Support for Variable-Size Arrays in a MATLAB Function Block” (Simulink)
• “Declare Variable-Size Inputs and Outputs” (Simulink)
• “Use a Variable-Size Signal in a Filtering Algorithm” (Simulink)

To learn how to declare variable-size data at the chart level, see “Declare Variable-Size Inputs and Outputs” on page 18-5.

Define Temporary Data

• “When to Define Temporary Data” on page 27-25
• “How to Define Temporary Data” on page 27-26

When to Define Temporary Data

In C charts, define temporary data when you want to use data that is only valid while a function executes. In charts that use MATLAB as the action language, you do not need to
define temporary function data in the Model Explorer. If a variable is used and not previously defined, then it is automatically created. The variable is available to the rest of the function.

You can define temporary data in graphical, truth table, and MATLAB functions in your chart. For example, you can designate a loop counter to have **Temporary** scope if the counter value does not need to persist after the function completes.

**How to Define Temporary Data**

To define temporary data for a Stateflow function, follow these steps:

1. Open the Model Explorer.
2. In the Model Explorer, select the graphical, truth table, or MATLAB function that will use temporary data.
3. Select **Add > Data**.

   The Model Explorer adds a default definition for the data in the Stateflow hierarchy, with a scope set to **Temporary** by default.
4. Change other properties of the data if necessary, as described in “Set Data Properties” on page 9-7.
Enhance Readability of Generated Code for MATLAB Functions

You can enhance the readability of generated code for MATLAB functions in Stateflow charts the same way as in MATLAB Function blocks in a model. For more information, see “Enhance Code Readability for MATLAB Function Blocks” (Simulink).
Simulink Functions in Stateflow Charts

• “Simulink Functions in Stateflow” on page 28-2
• “Share Functions Across Simulink and Stateflow” on page 28-6
• “Why Use a Simulink Function in a Stateflow Chart?” on page 28-8
• “Basic Approach to Defining Simulink Functions in Stateflow Charts” on page 28-15
• “How a Simulink Function Binds to a State” on page 28-18
• “How a Simulink Function Behaves When Called from Multiple Sites” on page 28-25
• “Define a Function That Uses Simulink Blocks” on page 28-27
• “Schedule Execution of Multiple Controllers” on page 28-37
Simulink Functions in Stateflow

In this section...

| “What Is a Simulink Function?” on page 28-2 |
| “Where to Define a Simulink Function in a Chart” on page 28-2 |
| “Rules for Using Simulink Functions in Stateflow Charts” on page 28-3 |

What Is a Simulink Function?

In a Stateflow chart, a Simulink function is a graphical object that you fill with Simulink blocks and call in the actions of states and transitions. This function provides an efficient model design and improves readability by minimizing graphical and nongraphical objects. Typical applications include:

- Defining a function that requires Simulink blocks, such as lookup tables (see “About Lookup Table Blocks” (Simulink))
- Scheduling execution of multiple controllers

You can call Simulink functions defined inside of a Stateflow chart from the same chart. You can also call functions defined by a Simulink Function block in the model.

Where to Define a Simulink Function in a Chart

A Simulink function can reside anywhere in a chart, state, or subchart. The location of a function determines its scope, that is, the set of states and transitions that can call the function. Follow these guidelines:

- If you want to call the function within only one state or subchart and its substates, put your Simulink function in that state or subchart. That function overrides any other functions of the same name in the parents and ancestors of that state or subchart.
- If you want to call the function anywhere in that chart, put your Simulink function at the chart level.
Rules for Using Simulink Functions in Stateflow Charts

Do not call Simulink functions in state during actions or transition conditions of continuous-time charts

This rule applies to continuous-time charts because you cannot call functions during minor time steps. You can call Simulink functions in state entry or exit actions and transition actions. However, if you try to call Simulink functions in state during actions or transition conditions, an error message appears when you simulate your model.

For more information, see “Model Hybrid Systems with Model Logic” on page 20-6.

Do not call Simulink functions in default transitions if you enable execute-at-initialization mode

If you select Execute (enter) Chart At Initialization in the Chart properties dialog box, you cannot call Simulink functions in default transitions that execute the first time that the chart awakens. Otherwise, an error message appears when you simulate your model.

Use only alphanumeric characters or underscores when naming input and output ports for a Simulink function

This rule ensures that the names of input and output ports are compatible with identifier naming rules of Stateflow charts.

Note Any space in a name automatically changes to an underscore.

Convert discontiguous signals to contiguous signals for Simulink functions

For Simulink functions inside a Stateflow chart, the output ports do not support discontiguous signals. If your function contains a block that outputs a discontiguous signal, insert a Signal Conversion block between the discontiguous output and the output port. This action ensures that the output signal is contiguous.

Blocks that can output a discontiguous signal include the Bus Creator block and the Mux block. For the Bus Creator block, the output is discontiguous only if you clear the Output as nonvirtual bus check box — that is, if the Bus Creator block outputs a virtual bus. If you select Output as nonvirtual bus, the output signal is contiguous and no conversion is necessary.

For more information, see Bus Creator, Mux, and Signal Conversion.
**Do not export Simulink functions**

If you try to export Simulink functions, an error appears when you simulate your model. To avoid this behavior, clear the **Export Chart Level Functions** check box in the Chart properties dialog box.

**Use the Stateflow Editor to rename a Simulink function**

If you try to use the Model Explorer to rename a Simulink function, the change does not appear in the chart. Edit the name in the Symbols pane or click the function box in the Stateflow Editor to rename the function.

**Do not use Simulink functions in Moore charts**

This restriction prevents violations of Moore semantics during chart execution. See “Design Rules for Moore Charts” on page 7-11 for more information.

**Do not generate HDL code for Simulink functions**

If you try to generate HDL code for charts that contain Simulink functions, an error message appears when you simulate your model. HDL code generation does not support Simulink functions.

**Set properties of input ports explicitly for a Simulink function**

The input ports of Simulink functions cannot inherit their sizes and data types. The output ports of a Simulink Function block in Simulink cannot inherit their sizes and data types. Therefore, you must set sizes and types explicitly when the inputs and outputs are not scalar data of type double.

The output ports of a Simulink function defined inside a chart can inherit sizes and data types based on connections inside the subsystem. Therefore, you can specify sizes and types of these outputs as inherited.

**Tip**
To minimize updates required for changes in input port properties, you can specify sizes and data types as parameters.
Verify that function-call expressions have inputs and outputs of correct size

If the formal arguments of a function signature are scalars, verify that inputs and outputs of function calls follow the rules of scalar expansion. For more information, see “How Scalar Expansion Works for Functions” on page 17-6.

Pass arguments by value

Passing an argument to a Simulink function by reference generates a run-time error during simulation.

See Also
Simulink Function

More About
• “Export Stateflow Functions for Reuse” on page 8-28
• “Simulink Functions in a Simulink Model” (Simulink)
• “Simulink Functions” (Simulink)
• “Share Functions Across Simulink and Stateflow” on page 28-6
Share Functions Across Simulink and Stateflow

Communicate and Share Resources with Functions

This example shows a model calling functions across Simulink® and Stateflow®. The slexPrinterExample model has three computer clients sharing a printer. Each computer creates print jobs by calling the Simulink function addPrintJob.

In this example, the Stateflow chart communicates with the model by:

- Defining and exporting a graphical function that is called by Simulink.
- Calling a Simulink function that is defined in Simulink.

```matlab
open_system('slexPrinterExample');
```

Each computer client invokes the printer server with a call to the Simulink function, `addPrintJob`. The `addPrintJob` function calls the Stateflow graphical function `queuePrintJob` to add the print job to the work load. The chart processes the work and calls the Simulink function `printerInk` to model usage of printer ink.
Call a Simulink Function from Stateflow

The function `printerInk` is defined in a Simulink Function block at the top level of the model. The function interface `printerInk(work)` defines one input argument. The Simulink Function, `printerInk`, also interacts with the model with signal lines through the `inport ink` and `outport ink'`. The state `Busy` matches the function signature for `printerInk(work)` by passing one input argument.

```matlab
open_system('slexPrinterExample/Queueing and Processing Incoming Jobs')
```

Export Stateflow Functions to Simulink

In the chart `Queueing and Processing Incoming Jobs`, the properties Export Chart Level Functions and Treat Exported Functions as Globally Visible are selected. These properties allow the Simulink function `addPrintJob` to call the chart graphical function, `queuePrintJob`.

See Also

Simulink Function

More About

- “Export Stateflow Functions for Reuse” on page 8-28
- “Simulink Functions” (Simulink)
- “Basic Approach to Defining Simulink Functions in Stateflow Charts” on page 28-15
Why Use a Simulink Function in a Stateflow Chart?

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Advantages of Using Simulink Functions in a Stateflow Chart” on page 28-8</td>
</tr>
<tr>
<td>“Benefits of Using a Simulink Function to Access Simulink Blocks” on page 28-8</td>
</tr>
<tr>
<td>“Benefits of Using a Simulink Function to Schedule Execution of Multiple Controllers” on page 28-11</td>
</tr>
</tbody>
</table>

Advantages of Using Simulink Functions in a Stateflow Chart

When you define a function that uses Simulink function-call subsystem blocks or schedule execution of multiple controllers without Simulink functions, the model requires these elements:

- Simulink function-call subsystem blocks
- Stateflow chart with function-call output events
- Signal lines between the chart and each function-call subsystem port

Simulink functions in a Stateflow chart provide these advantages:

- No function-call subsystem blocks
- No output events
- No signal lines

Benefits of Using a Simulink Function to Access Simulink Blocks

The sections that follow compare two ways of defining a function that uses Simulink blocks.

Model Method Without a Simulink Function

You define a function-call subsystem in the Simulink model (see “Using Function-Call Subsystems” (Simulink). Use an output event in a Stateflow chart to call the subsystem, as shown.
Model Method With a Simulink Function

You place one or more Simulink blocks in a Simulink function of a Stateflow chart. Use a function call to execute the blocks in that function, as shown.
In the chart, the during action in selection_state contains a function call to calc_th, which is a function that contains Simulink blocks.

This modeling method minimizes the objects in your model.
Benefits of Using a Simulink Function to Schedule Execution of Multiple Controllers

The sections that follow compare two ways of scheduling execution of multiple controllers.

Model Method Without Simulink Functions

You define each controller as a function-call subsystem block and use output events in a Stateflow chart to schedule execution of the subsystems, as shown.
Model Method With Simulink Functions

You define each controller as a Simulink function in a Stateflow chart and use function calls to schedule execution of the subsystems, as shown.
This modeling method minimizes the objects in your model.
See Also

More About
- “Benefits of Using a Simulink Function to Access Simulink Blocks” on page 28-8
- “Benefits of Using a Simulink Function to Schedule Execution of Multiple Controllers” on page 28-11
- “Schedule Execution of Multiple Controllers” on page 28-37
Basic Approach to Defining Simulink Functions in Stateflow Charts

In this section...

“Task 1: Add a Function to the Chart” on page 28-15
“Task 2: Define the Subsystem Elements of the Simulink Function” on page 28-16
“Task 3: Configure the Function Inputs” on page 28-17

Task 1: Add a Function to the Chart

Follow these steps to add a Simulink function to the chart:

1. Click the Simulink function icon in the Stateflow Editor toolbar:

2. Move your pointer to the location for the new Simulink function in your chart and click to insert the function box.

   Tip You can also drag the function from the toolbar.

3. Enter the function signature.

   The function signature specifies a name for your function and the formal names for the arguments and return values. A signature has this syntax:

   \[ [r_1, r_2, \ldots, r_n] = \text{simfcn}(a_1, a_2, \ldots, a_n) \]

   where \text{simfcn} is the name of your function, \( a_1, a_2, \ldots, a_n \) are formal names for the arguments, and \( r_1, r_2, \ldots, r_n \) are formal names for the return values.

   Note This syntax is the same as what you use for graphical functions, truth tables, and MATLAB functions. You can define arguments and return values as scalars, vectors, or matrices of any data type.

4. Click outside the function box.

   The following example shows a Simulink function that has the name \text{simfcn}, which takes three arguments (a, b, and c) and returns two values (x and y).
Note You can also create and edit a Simulink function by using API methods.

Task 2: Define the Subsystem Elements of the Simulink Function

Follow these steps to define the subsystem elements of the Simulink function:

1. Double-click the Simulink function box.
   
   The contents of the subsystem appear: input and output ports that match the function signature and a single function-call trigger port.

2. Add Simulink blocks to the subsystem.

3. Connect the input and output ports to each block.

Note You cannot delete the trigger port in the function.

The following example shows the subsystem elements for a Simulink function.
Task 3: Configure the Function Inputs

Follow these steps to configure inputs for the Simulink function:

1. Configure the input ports.
   a. Double-click an input port to open the Block Parameters dialog box.
   b. In the Signal Attributes pane, enter the size and data type.

   For example, you can specify a size of [2 3] for a 2-by-3 matrix and a data type of uint8.

2. Click OK.

Note An input port of a Simulink function cannot inherit size or data type. Therefore, you define the size and data type of an input that is not scalar data of type double. However, an output port can inherit size and data type.

See Also

More About

- “Simulink Functions in Stateflow” on page 28-2
- “Why Use a Simulink Function in a Stateflow Chart?” on page 28-8
- “Share Functions Across Simulink and Stateflow” on page 28-6
How a Simulink Function Binds to a State

Bind Behavior of a Simulink Function

When a Simulink function resides inside a state, the function binds to that state. Binding results in the following behavior:

- Function calls can occur only in state actions and on transitions within the state and its substates.
- When the state is entered, the function is enabled.
- When the state is exited, the function is disabled.

For example, the following Stateflow chart shows a Simulink function that binds to a state.
Because the function `queue` resides in state `A1`, the function binds to that state.

- State `A1` and its substates `A2` and `A3` can call `queue`, but state `B1` cannot.
- When state `A1` is entered, `queue` is enabled.
- When state `A1` is exited, `queue` is disabled.

**Control Subsystem Variables When the Simulink Function Is Disabled**

If a Simulink function binds to a state, you can hold the subsystem variables at their values from the previous execution or reset the variables to their initial values. Follow these steps:

1. In the Simulink function, double-click the trigger port to open the Block Parameters dialog box.
2. Select an option for **States when enabling**.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Reference Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>held</td>
<td>Holds the values of the subsystem variables from the previous execution</td>
<td>“How the Function Behaves When Variables Are Held” on page 28-22</td>
</tr>
<tr>
<td>reset</td>
<td>Resets the subsystem variables to their initial values</td>
<td>“How the Function Behaves When Variables Are Reset” on page 28-23</td>
</tr>
</tbody>
</table>

**Example of Binding a Simulink Function to a State**

This example shows how a Simulink function behaves when bound to a state.

The function `queue` contains a block diagram that increments a counter by 1 each time the function executes.

The Block Parameters dialog box for the trigger port appears as follows.
In the dialog box, setting **Sample time type** to **periodic** enables the **Sample time** field, which defaults to 1. These settings tell the function to execute for each time step specified in the **Sample time** field while the function is enabled.
Note If you use a fixed-step solver, the value in the Sample time field must be an integer multiple of the fixed-step size. This restriction does not apply to variable-step solvers. (For more information, see “Solvers” (Simulink).)

Simulation Behavior of the Chart

When you simulate the chart, the following actions occur.

1. The default transition to state A1 occurs, which includes setting local data u₁ to 1.
2. When A₁ is entered, the function queue is enabled.
3. Function calls to queue occur until the condition after(5, sec) is true.
4. The transition from state A₁ to B₁ occurs.
5. When A₁ is exited, the function queue is disabled.
6. After two more seconds pass, the transition from B₁ to A₁ occurs.
7. Steps 2 through 6 repeat until the simulation ends.

How the Function Behaves When Variables Are Held

If you set States when enabling to held, the output y₁ is as follows.
When state A1 becomes inactive at $t = 5$, the Simulink function holds the counter value. When A1 is active again at $t = 7$, the counter has the same value as it did at $t = 5$. Therefore, the output $y_1$ continues to increment over time.

**How the Function Behaves When Variables Are Reset**

If you set **States when enabling** to **reset**, the output $y_1$ is as follows.
When state A1 becomes inactive at \( t = 5 \), the Simulink function does not hold the counter value. When A1 is active again at \( t = 7 \), the counter resets to zero. Therefore, the output \( y_1 \) resets too.

**See Also**

**More About**

- "Simulink Functions in Stateflow" on page 28-2
- "Why Use a Simulink Function in a Stateflow Chart?" on page 28-8
How a Simulink Function Behaves When Called from Multiple Sites

If you call a Simulink function from multiple sites in a chart, all call sites share the state of the function variables. For example, suppose you have a chart with two calls to the same Simulink function at each time step.

The function $f$ contains a block diagram that increments a counter by 1 each time the function executes.

At each time step, the function $f$ is called twice, which causes the counter to increment by 2. Because all call sites share the value of this counter, the data $y$ and $y1$ increment by 2 at each time step.

**Note** This behavior also applies to external function-call subsystems in a Simulink model. For more information, see “Using Function-Call Subsystems” (Simulink).
See Also

More About

• “Simulink Functions in Stateflow” on page 28-2
Define a Function That Uses Simulink Blocks

In this section...

"Goal of the Tutorial" on page 28-27
"Edit a Model to Use a Simulink Function" on page 28-28
"Run the New Model" on page 28-35

Goal of the Tutorial

The goal of this tutorial is to use a Simulink function in a Stateflow chart to improve the design of a model named old_sf_car.

Rationale for Improving the Model Design

The old_sf_car model contains a function-call subsystem named Threshold Calculation and a Stateflow chart named shift_logic. The two blocks interact as follows:
• The chart broadcasts the output event CALC_TH to trigger the function-call subsystem.
• The subsystem uses lookup tables to interpolate two values for the shift_logic chart.
• The subsystem outputs (up_th and down_th) feed directly into the chart as inputs.

No other blocks in the model access the subsystem outputs.

You can replace a function-call subsystem with a Simulink function in a chart when:
• The subsystem performs calculations required by the chart.
• Other blocks in the model do not need access to the subsystem outputs.

**Edit a Model to Use a Simulink Function**

The sections that follow describe how to replace a function-call subsystem in a Simulink model with a Simulink function in a Stateflow chart. This procedure reduces the number of objects in the model while retaining the same simulation results.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the model.</td>
<td>“Open the Model” on page 28-29</td>
</tr>
<tr>
<td>2</td>
<td>Move the contents of the function-call subsystem into a Simulink function in the chart.</td>
<td>“Add a Simulink Function to the Chart” on page 28-30</td>
</tr>
<tr>
<td>3</td>
<td>Change the scope of specific chart-level data to Local.</td>
<td>“Change the Scope of Chart Data” on page 28-33</td>
</tr>
<tr>
<td>4</td>
<td>Replace the event broadcast with a function call.</td>
<td>“Update State Action in the Chart” on page 28-34</td>
</tr>
<tr>
<td>5</td>
<td>Verify that function inputs and outputs are defined.</td>
<td>“Add Data to the Chart” on page 28-34</td>
</tr>
<tr>
<td>6</td>
<td>Remove unused items in the model.</td>
<td>“Remove Unused Items in the Model” on page 28-35</td>
</tr>
</tbody>
</table>

**Note** To skip the conversion steps and access the new model directly, type `sf_car` at the MATLAB command prompt.
Open the Model

Type `old_sf_car` at the MATLAB command prompt. If you simulate the model, you see these results in the two scopes.
Add a Simulink Function to the Chart

Follow these steps to add a Simulink function to the shift_logic chart.

1. In the Simulink model, right-click the Threshold Calculation block in the lower left corner and select **Cut** from the context menu.
Open the shift_logic chart.

In the chart, right-click below selection_state and select Paste from the context menu.

Expand the new Simulink function so that the signature fits inside the function box.
**Tip** To change the font size of a function, right-click the function box and select a new size from the **Font Size** menu.

5 Expand the border of `selection_state` to include the new function.
**Note** The function resides in this state instead of the chart level because no other state in the chart requires the function outputs `up_th` and `down_th`. See “How a Simulink Function Binds to a State” on page 28-18.

6 Rename the Simulink function from `Threshold_Calculation` to `calc_threshold` by entering `[down_th, up_th] = calc_threshold(gear, throttle)` in the function box.

**Change the Scope of Chart Data**

In the Model Explorer, change the scope of chart-level data `up_th` and `down_th` to `Local` because calculations for those data now occur inside the chart.
**Update State Action in the Chart**

In the Stateflow Editor, change the during action in selection_state to call the Simulink function calc_threshold.

```matlab
during: [down_th, up_th] = calc_threshold(gear, throttle);
```

**Add Data to the Chart**

Because the function calc_threshold takes throttle as an input, you must define that data as a chart input. (For details, see “Add Stateflow Data” on page 9-2.)

1. Add input data throttle to the chart with a Port property of 1.

   Using port 1 prevents signal lines from overlapping in the Simulink model.
2 In the Simulink model, add a signal line for `throttle` between the inport of the Engine block and the inport of the shift_logic chart.

**Remove Unused Items in the Model**

1 In the Model Explorer, delete the function-call output event `CALC_TH` because the Threshold Calculation block no longer exists.

2 Delete any dashed signal lines from your model.

**Run the New Model**

Your new model looks something like this:

If you simulate the new model, the results match those of the original design.
See Also

More About

• “Simulink Functions in Stateflow” on page 28-2
• “Basic Approach to Defining Simulink Functions in Stateflow Charts” on page 28-15
Schedule Execution of Multiple Controllers

In this section...

“Goal of the Tutorial” on page 28-37
“Edit a Model to Use Simulink Functions” on page 28-38
“Run the New Model” on page 28-44

Goal of the Tutorial

The goal of this tutorial is to use Simulink functions in a Stateflow chart to improve the design of a model named sf_temporal_logic_scheduler.
Rationale for Improving the Model Design

The `sf_temporal_logic_scheduler` model contains a Stateflow chart and three function-call subsystems. These blocks interact as follows:

- The chart broadcasts the output events A1, A2, and A3 to trigger the function-call subsystems.
- The subsystems A1, A2, and A3 execute at different rates defined by the chart.
- The subsystem outputs feed directly into the chart.

No other blocks in the model access the subsystem outputs.

You can replace function-call subsystems with Simulink functions inside a chart when:

- The subsystems perform calculations required by the chart.
- Other blocks in the model do not need access to the subsystem outputs.

Edit a Model to Use Simulink Functions

The sections that follow describe how to replace function-call subsystem blocks in a Simulink model with Simulink functions in a Stateflow chart. This procedure reduces the number of objects in the model while retaining the same simulation results.

<table>
<thead>
<tr>
<th>Step</th>
<th>Task</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the model.</td>
<td>“Open the Model” on page 28-39</td>
</tr>
<tr>
<td>2</td>
<td>Move the contents of the function-call subsystems into Simulink functions in the chart.</td>
<td>“Add Simulink Functions to the Chart” on page 28-40</td>
</tr>
<tr>
<td>3</td>
<td>Change the scope of specific chart-level data to Local.</td>
<td>“Change the Scope of Chart Data” on page 28-42</td>
</tr>
<tr>
<td>4</td>
<td>Replace event broadcasts with function calls.</td>
<td>“Update State Actions in the Chart” on page 28-42</td>
</tr>
<tr>
<td>5</td>
<td>Verify that function inputs and outputs are defined.</td>
<td>“Add Data to the Chart” on page 28-43</td>
</tr>
<tr>
<td>6</td>
<td>Remove unused items in the model.</td>
<td>“RemoveUnused Items in the Model” on page 28-43</td>
</tr>
</tbody>
</table>
**Note** To skip the conversion steps and access the new model directly, type `sf_temporal_logic_scheduler_with_sl_fcns` at the MATLAB command prompt.

**Open the Model**

Type `sf_temporal_logic_scheduler` at the MATLAB command prompt. If you simulate the model, you see this result in the scope.

For more information, see “Schedule Subsystems to Execute at Specific Times” on page 25-22.
Add Simulink Functions to the Chart

Follow these steps to add Simulink functions to the Temporal Logic Scheduler chart.

1. In the Simulink model, right-click the A1 block in the lower right corner and select **Cut** from the context menu.
2. Open the Temporal Logic Scheduler chart.
3. In the chart, right-click outside any states and select **Paste** from the context menu.
4. Expand the new Simulink function so that the signature fits inside the function box.
Tip To change the font size of a function, right-click the function box and select a new size from the **Font Size** menu.

5 Rename the Simulink function from A1 to \( f_1 \) by entering \( y = f_1(u) \) in the function box.

6 Repeat steps 1 through 5 for these cases:
   
   • Copying the contents of A2 into a Simulink function named \( f_2 \).
   • Copying the contents of A3 into a Simulink function named \( f_3 \).
Note The new functions reside at the chart level because both states FastScheduler and SlowScheduler require access to the function outputs.

**Change the Scope of Chart Data**

In the Model Explorer, change the scope of chart-level data y to Local because the calculation for that data now occurs inside the chart.

**Update State Actions in the Chart**

In the Stateflow Editor, you can replace event broadcasts in state actions with function calls.

1. Edit the state actions in FastScheduler and SlowScheduler to call the Simulink functions f1, f2, and f3.
2 In both states, update each during action as follows.

\[ du: y = u1 - y2; \]

**Add Data to the Chart**

For the on every state actions of FastScheduler and SlowScheduler, define three data. (For details, see “Add Stateflow Data” on page 9-2.)

1 Add local data \( y1 \) and \( y2 \) to the chart.
2 Add output data \( y3 \) to the chart.
3 In the model, connect the outport for \( y3 \) to the inport of the scope.

**Tip** To flip the Scope block, right-click and select **Rotate & Flip > Flip Block** from the context menu.

**Remove Unused Items in the Model**

1 In the Model Explorer, delete output events A1, A2, and A3 and input data u2 because the function-call subsystems no longer exist.
2 Delete any dashed signal lines from your model.

Run the New Model

Your new model looks something like this:

![Diagram of a new model](image)

If you simulate the new model, the results match those of the original design.

See Also

More About

- “Simulink Functions in Stateflow” on page 28-2
- “Basic Approach to Defining Simulink Functions in Stateflow Charts” on page 28-15
Build Targets

- “Code Generation for Stateflow Blocks” on page 29-2
- “Choose a Procedure to Simulate a Model” on page 29-3
- “Integrate Custom C/C++ Code for Simulation” on page 29-6
- “Speed Up Simulation” on page 29-15
- “Generate C/C++ Code for Rapid Prototyping or Production Deployment” on page 29-17
- “Optimize Generated Code” on page 29-18
- “Command-Line API to Set Simulation and Code Generation Parameters” on page 29-19
- “Specify Relative Paths for Custom Code” on page 29-24
- “Share Data Using Custom C Code” on page 29-26
- “Parse Stateflow Charts” on page 29-33
- “Resolve Undefined Symbols in Your Chart” on page 29-34
- “Traceability of Stateflow Objects in Generated Code” on page 29-39
- “Call Extrinsic Functions in a Stateflow Chart” on page 29-40
Code Generation for Stateflow Blocks

If you have the required software license, you can generate code for models that include Stateflow blocks for these uses.

<table>
<thead>
<tr>
<th>Use</th>
<th>Required Software License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rapid prototyping</td>
<td>Simulink Coder</td>
</tr>
<tr>
<td>Production code deployment</td>
<td>Embedded Coder</td>
</tr>
</tbody>
</table>

Code Generation for Rapid Prototyping and Production Code Deployment

If you have a Simulink Coder or Embedded Coder license, you can generate C or C++ code from models that include Stateflow blocks. Simulink Coder software generates source code that you can use for real-time and nonreal-time applications, including simulation acceleration, rapid prototyping, and hardware-in-the-loop testing. Embedded Coder software generates readable, compact, and fast code for use on embedded processors, on-target rapid prototyping boards, and microprocessors used in mass production. The generated C/C++ code does not contain code to interface with other blocks in a Simulink model or the MATLAB base workspace.

See Also

Related Examples

- “Choose a Procedure to Simulate a Model” on page 29-3
- “Generate C/C++ Code for Rapid Prototyping or Production Deployment” on page 29-17
Choose a Procedure to Simulate a Model

Guidelines for Simulation

When you simulate a model, use these guidelines to choose the right procedure.

<table>
<thead>
<tr>
<th>Do this step...</th>
<th>When...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speed up simulation</td>
<td>You have a large model with many blocks.</td>
</tr>
<tr>
<td></td>
<td>See “Speed Up Simulation” on page 29-15.</td>
</tr>
<tr>
<td>Include custom code</td>
<td>You want to take advantage of legacy code that augments model capabilities and also include custom variables and functions that you share between your custom code and Stateflow generated code. See “Integrate Custom C/C++ Code for Simulation” on page 29-6.</td>
</tr>
<tr>
<td>Include custom code</td>
<td>You want to provide custom code in a portable, self-contained library for use in multiple models.</td>
</tr>
<tr>
<td>only for library charts</td>
<td></td>
</tr>
</tbody>
</table>

Choose the Right Procedure for Simulation

To choose the right procedure for simulation, find the highlighted block that describes your goal and see the corresponding section in “Integrate Custom C/C++ Code for Simulation” on page 29-6.
See Also

More About

• “Speed Up Simulation” on page 29-15
• “Set Up Your Own Target Compiler”
Integrate Custom C/C++ Code for Simulation

In C charts, to integrate custom C++ code for simulation, perform the tasks that follow.

**Task 1: Prepare Code Files**

Prepare your custom C++ code for simulation as follows:

1. Add a C function wrapper to your custom code. This wrapper function executes the C++ code that you are including.

   The C function wrapper should have this form:

   ```c
   int my_c_function_wrapper()
   {
   //C++ code
   return result;
   }
   ```

2. Create a header file that prototypes the C function wrapper in the previous step.

   The header file should have this form:

   ```c
   int my_c_function_wrapper();
   ```
The value `_cplusplus` exists if your compiler supports C++ code. The `extern "C"` wrapper specifies C linkage with no name mangling.

**Task 2: Include Custom C++ Source and Header Files for Simulation**

To include custom C++ code for simulation, you must configure your simulation target and select C++ as the custom code language:

1. Open the Model Configuration Parameters dialog box.
2. In the Model Configuration Parameters dialog box, select the **Simulation Target** pane.
3. Add your custom header file in the **Header file** subpane. Click **Apply**.
4. Add your custom C++ files in the **Source files** subpane. Click **Apply**.
5. In the Model Configuration Parameters dialog box, select the **Code Generation** pane.
6. Select C++ from the **Language** menu.
7. Click **OK**.

**Task 3: Choose a C++ Compiler**

You can change the default compiler by calling the `mex -setup` command, and following the instructions. For a list of supported compilers, see [www.mathworks.com/support/compilers/current_release/](http://www.mathworks.com/support/compilers/current_release/).

**Task 4: Simulate the Model**

Simulate your model by clicking the play button in the toolbar of the editor.

For information on setting simulation options using the command-line API, see “Command-Line API to Set Simulation and Code Generation Parameters” on page 29-19.

**Integrate Custom C Code for Nonlibrary Charts for Simulation**

In C charts, to integrate custom C code that applies to nonlibrary charts for simulation, perform the tasks that follow.

**Task 1: Include Custom C Code in the Simulation Target**

Specify custom code options in the simulation target for your model:
1. Open the Model Configuration Parameters dialog box.

2. In the Model Configuration Parameters dialog box, select the **Simulation Target** pane.

   The custom code options appear.

3. Specify your custom code in the subpanes.


   - **Source file** — Enter code lines to include at the top of a generated source code file. These code lines appear at the top of the generated `model.c` source file, outside of any function.
For example, you can include `extern int` declarations for global variables.

- **Header file** — Enter code lines to include at the top of the generated `model.h` header file that declares custom functions and data in the generated code. These code lines appear at the top of all generated source code files and are visible to all generated code.

  **Note** When you include a custom header file, you must enclose the file name in double quotes. For example, `#include "sample_header.h"` is a valid declaration for a custom header file.

Since the code you specify in this option appears in multiple source files that link into a single binary, limitations exist on what you can include. For example, do not include a global variable definition such as `int x;` or a function body such as

```c
void myfun(void)
{
    ...
}
```

These code lines cause linking errors because their symbol definitions appear multiple times in the source files of the generated code. You can, however, include `extern` declarations of variables or functions such as `extern int x;` or `extern void myfun(void);`.

- **Initialize function** — Enter code statements that execute once at the start of simulation. Use this code to invoke functions that allocate memory or perform other initializations of your custom code.

- **Terminate function** — Enter code statements that execute at the end of simulation. Use this code to invoke functions that free memory allocated by the custom code or perform other cleanup tasks.

- **Include directories** — Enter a space-separated list of the folder paths that contain custom header files that you include either directly (see **Header file** option) or indirectly in the compiled target.

- **Source files** — Enter a list of source files to compile and link into the target. You can separate source files with a comma, a space, or a new line.

- **Libraries** — Enter a space-separated list of static libraries that contain custom object code to link into the target.

4 Click **OK**.
**Tip** If you want to rebuild the target to include custom code changes, select **Code > C/C++ Code > Build Model** in the Stateflow Editor.

**Task 2: Simulate the Model**

Simulate your model by clicking the play button in the toolbar of the editor.

For information on setting simulation options using the command-line API, see “Command-Line API to Set Simulation and Code Generation Parameters” on page 29-19.

**Integrate Custom C Code for Library Charts for Simulation**

In C charts, to integrate custom C code that applies only to library charts for simulation, perform the tasks that follow.

**Task 1: Include Custom C Code in Simulation Targets for Library Models**

Specify custom code options in the simulation target for each library model that contributes a chart to the main model:

1. In the Stateflow Editor, select **Simulation > Debug > Simulation Target For MATLAB & Stateflow**.

   The Model Configuration Parameters dialog box appears.
2 Select **Use local custom code settings (do not inherit from main model)**.

This step ensures that each library model retains its own custom code settings during simulation.

3 Specify your custom code in the subpanes.

Note  See “Task 1: Include Custom C Code in the Simulation Target” on page 29-7 for descriptions of the custom code options.

4  Click OK.

Task 2: Simulate the Model

Simulate your model by clicking the play button in the toolbar of the editor.

For information on setting simulation options using the command-line API, see “Command-Line API to Set Simulation and Code Generation Parameters” on page 29-19.

Note  You cannot simulate only the Stateflow blocks in a library model. You must first create a link to the library block in your main model and then simulate the main model.

Integrate Custom C Code for All Charts for Simulation

In C charts, to integrate custom C code that applies to all charts for simulation, perform the tasks that follow.

Task 1: Include Custom C Code in the Simulation Target for the Main Model

Specify custom code options in the simulation target for your main model:

1  Open the Model Configuration Parameters dialog box.
2  In the Model Configuration Parameters dialog box, select the Simulation Target pane.

The custom code options appear.
3 Specify your custom code in the subpanes.


**Note** See “Task 1: Include Custom C Code in the Simulation Target” on page 29-7 for descriptions of the custom code options.

4 Click **OK**.

By default, settings in the Simulation Target pane for the main model apply to all charts contributed by library models.
**Tip** If you want to rebuild the target to include custom code changes, select **Code > C/C++ Code > Build Model** in the Stateflow Editor.

**Task 2: Ensure That Custom C Code for the Main Model Applies to Library Charts**

Configure the simulation target for each library model that contributes a chart to your main model:

1. In the Stateflow Editor, select **Simulation > Debug > Simulation Target For MATLAB & Stateflow**.
2. Clear the **Use local custom code settings (do not inherit from main model)** check box.
   
   This step ensures that library charts inherit the custom code settings of your main model.
3. Click **OK**.

**Task 3: Simulate the Model**

Simulate your model by clicking the play button in the toolbar of the editor.

For information on setting simulation options using the command-line API, see “Command-Line API to Set Simulation and Code Generation Parameters” on page 29-19.

**Call External Functions in Charts with MATLAB as the Action Language**

In charts using MATLAB as the action language, use `coder.ceval`. For information on calling external code from MATLAB code, see “Call C/C++ Code from MATLAB Code” (MATLAB Coder).
Speed Up Simulation

In this section...

“Improve Model Update Performance” on page 29-15
“Disable Simulation Target Options That Impact Execution Speed” on page 29-16
“Keep Charts Closed to Speed Up Simulation” on page 29-16
“Keep Scope Blocks Closed to Speed Up Simulation” on page 29-16
“Use Library Charts in Your Model” on page 29-16

Improve Model Update Performance

Stateflow uses Just-In-Time (JIT) compilation mode to improve model update performance for most charts. Stateflow applies JIT mode to charts that qualify. For a chart in JIT mode, Stateflow generates an execution engine in memory for simulation. For these charts, Stateflow does not generate C code or a MEX file to simulate the chart. JIT mode provides the best performance during the compilation of a model.

Some charts do not qualify for JIT mode, such as charts with:

• Custom C code symbols
• Signal logging
• Model coverage in Simulink Coverage

Stateflow models include debugging support for simulation. To gain optimal performance, turn off debugging by using this command:

sfc('coder_options', 'forceDebugOff', 1);

When you run this command, your Stateflow charts do not have debugging support or run-time error checking.

Note When you turn off debugging, animation is also turned off.
Disable Simulation Target Options That Impact Execution Speed

To simulate your model more quickly, in the Model Configuration Parameters dialog box, on the All Parameters tab, clear the check boxes for these parameters.

- **Echo expressions without semicolons** — To disable run-time output in the MATLAB Command Window, such as actions that do not terminate with a semicolon, clear this check box.

- **Ensure responsiveness**— To disable ability to break out of long-running execution using Ctrl+C, clear this check box.

Click OK.

Keep Charts Closed to Speed Up Simulation

During model simulation, any open charts with animation enabled take longer to simulate. If you keep all charts closed, the simulation runs faster.

Keep Scope Blocks Closed to Speed Up Simulation

During model simulation, any open Scope blocks continuously update their display. If you keep all Scope blocks closed, you can speed up the simulation. After the simulation ends, you can open the Scope blocks to view the results.

Use Library Charts in Your Model

If your model contains multiple charts that do not use JIT mode and contain the same elements, you might generate multiple copies of identical simulation code. By using library charts, you can minimize the number of copies of identical simulation code. For example, using five library charts reduces the number of identical copies from five to one.

For more information, see “Create Specialized Chart Libraries for Large-Scale Modeling” on page 23-19.
### Generate C/C++ Code for Rapid Prototyping or Production Deployment

If you have a Simulink Coder or Embedded Coder license, you can generate C or C++ code from models that include Stateflow blocks. The following table directs you to code generation information based on your goals.

<table>
<thead>
<tr>
<th>Goal</th>
<th>See the Following Information in the Simulink Coder documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate C/C++ source code</td>
<td>“Source Code Generation in Simulink Coder” (Simulink Coder)</td>
</tr>
<tr>
<td>Generate C/C++ source code and build executable</td>
<td>“Program Building, Interaction, and Debugging in Simulink Coder” (Simulink Coder)</td>
</tr>
<tr>
<td>Optimize generated code</td>
<td>“Reduce Memory Usage for Boolean and State Configuration Variables” (Simulink Coder) and “Design Tips for Optimizing Generated Code for Stateflow Objects” (Simulink Coder)</td>
</tr>
<tr>
<td>Integrate external code</td>
<td>“External Code Integration” (Simulink Coder)</td>
</tr>
<tr>
<td>Include external code only for library charts in a portable, self-contained library for use in multiple models</td>
<td>“Integrate External Code for Library Charts” (Simulink Coder)</td>
</tr>
</tbody>
</table>
Optimize Generated Code

If you have a Simulink Coder or Embedded Coder license, you can reduce memory usage of C/C++ code generated for Stateflow objects in your Simulink models.

For more information, see “Design Tips for Optimizing Generated Code for Stateflow Objects” (Simulink Coder) and “Reduce Memory Usage for Boolean and State Configuration Variables” (Simulink Coder).
Command-Line API to Set Simulation and Code Generation Parameters

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“How to Set Parameters at the Command Line” on page 29-19</td>
</tr>
<tr>
<td>“Simulation Parameters for Nonlibrary Models” on page 29-20</td>
</tr>
<tr>
<td>“Simulation Parameters for Library Models” on page 29-22</td>
</tr>
</tbody>
</table>

How to Set Parameters at the Command Line

To programmatically set options in the Model Configuration Parameters dialog box for simulation and embeddable code generation, you can use the command-line API.

1. At the MATLAB command prompt, type:
   ```matlab
   object_name = getActiveConfigSet(gcs)
   ```

   This command returns an object handle to the model settings in the Model Configuration Parameters dialog box for the current model.

2. To set a parameter for that dialog box, type:
   ```matlab
   object_name.set_param('parameter_name', value)
   ```

   This command sets a configuration parameter to the value that you specify.

For example, you can set the **Reserved names** parameter for simulation by typing:

```matlab
cp = getActiveConfigSet(gcs)
cp.set_param('SimReservedNameArray', {'abc','xyz'})
```

**Note** You can also get the current value of a configuration parameter by typing:

```matlab
object_name.get_param('parameter_name')
```

For more information about using `get_param` and `set_param`, see the Simulink documentation.
## Simulation Parameters for Nonlibrary Models

The following table summarizes the parameters and values that you can set for simulation of nonlibrary models using the command-line API.

<table>
<thead>
<tr>
<th>Parameter and Values</th>
<th>Dialog Box Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SimIntegrity</td>
<td></td>
<td><strong>Ensure memory integrity</strong>&lt;br&gt;Detect violations of memory integrity in code generated for MATLAB Function blocks and stop execution with a diagnostic.</td>
</tr>
<tr>
<td>- 'off', 'on'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SFSimEcho</td>
<td></td>
<td><strong>Echo expressions without semicolons</strong>&lt;br&gt;Enable run-time output to appear in the MATLAB Command Window during simulation.</td>
</tr>
<tr>
<td>- 'off', 'on'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimCtrlC</td>
<td></td>
<td><strong>Ensure responsiveness</strong>&lt;br&gt;Enable responsiveness checks in code generated for MATLAB Function blocks.</td>
</tr>
<tr>
<td>- 'off', 'on'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimBuildMode</td>
<td></td>
<td><strong>Simulation target build mode</strong>&lt;br&gt;Specify how you build the simulation target for a model.</td>
</tr>
<tr>
<td>- 'sf_incremental_build', 'sf_nonincremental_build', 'sf_make', 'sf_make_clean', 'sf_make_clean_objects'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimReservedNameArray</td>
<td></td>
<td><strong>Symbols &gt; Reserved names</strong>&lt;br&gt;Enter the names of variables or functions in the generated code that match the names of variables or functions specified in custom code to avoid naming conflicts.</td>
</tr>
<tr>
<td><code>string array - {}</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimParseCustomCode</td>
<td></td>
<td><strong>Parse custom code symbols</strong>&lt;br&gt;Specify whether or not to parse the custom code and report unresolved symbols for the C charts in a model.</td>
</tr>
<tr>
<td>- 'off', 'on'</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Parameter and Values</strong></td>
<td><strong>Dialog Box Equivalent</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>SimCustomSourceCode</td>
<td>Source file</td>
<td>Enter code lines to appear near the top of a generated source code file.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimCustomHeaderCode</td>
<td>Header file</td>
<td>Enter code lines to appear near the top of a generated header file.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimCustomInitializer</td>
<td>Initialize function</td>
<td>Enter code statements that execute once at the start of simulation.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimCustomTerminator</td>
<td>Terminate function</td>
<td>Enter code statements that execute at the end of simulation.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimUserIncludeDirs</td>
<td>Include directories</td>
<td>Enter a space-separated list of folder paths that contain files you include in the compiled target.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimUserSources</td>
<td>Source files</td>
<td>Enter a space-separated list of source files to compile and link into the target.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimUserLibraries</td>
<td>Libraries</td>
<td>Enter a space-separated list of static libraries that contain custom object code to link into the target.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note** If your list includes any Windows® paths that contain spaces, each instance must be enclosed in double quotes within the argument, for example, 'C:\Project "C:\Custom Files"'
# Simulation Parameters for Library Models

The following table summarizes the simulation parameters that apply to library models.

<table>
<thead>
<tr>
<th>Parameter and Values</th>
<th>Dialog Box Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SimUseLocalCustomCode 'off', 'on'</td>
<td>Use local custom code settings (do not inherit from main model)</td>
<td>Specify whether a library model can use custom code settings that are unique from the main model to which the library is linked.</td>
</tr>
<tr>
<td>SimCustomSourceCode string ''</td>
<td>Source file</td>
<td>Enter code lines to appear near the top of a generated source code file.</td>
</tr>
<tr>
<td>SimCustomHeaderCode string ''</td>
<td>Header file</td>
<td>Enter code lines to appear near the top of a generated header file.</td>
</tr>
<tr>
<td>SimCustomInitializer string ''</td>
<td>Initialize function</td>
<td>Enter code statements that execute once at the start of simulation.</td>
</tr>
<tr>
<td>SimCustomTerminator string ''</td>
<td>Terminate function</td>
<td>Enter code statements that execute at the end of simulation.</td>
</tr>
<tr>
<td>SimUserIncludeDirs string ''</td>
<td>Include directories</td>
<td>Enter a space-separated list of folder paths that contain files you include in the compiled target.</td>
</tr>
</tbody>
</table>

**Note** If your list includes any Windows paths that contain spaces, each instance must be enclosed in double quotes within the argument, for example, 'C:\Project "C:\Custom Files"'.
<table>
<thead>
<tr>
<th>Parameter and Values</th>
<th>Dialog Box Equivalent</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SimUserSources</td>
<td><strong>Source files</strong></td>
<td>Enter a space-separated list of source files to compile and link into the target.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SimUserLibraries</td>
<td><strong>Libraries</strong></td>
<td>Enter a space-separated list of static libraries that contain custom object code to link into the target.</td>
</tr>
<tr>
<td><code>string -''</code></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**See Also**

**More About**

- “Recommended Settings Summary for Model Configuration Parameters” (Simulink Coder)
Specify Relative Paths for Custom Code

Why Use Relative Paths?

If you specify paths and files with absolute paths and later move them, you must change these paths to point to new locations. To avoid this problem, use relative paths for custom code options that specify paths or files.

Search Relative Paths

Search paths exist relative to these folders:

- The current folder
- The model folder (if different from the current folder)
- The custom list of folders that you specify
- All the folders on the MATLAB search path, excluding the toolbox folders

Path Syntax Rules

When you construct relative paths for custom code, follow these syntax rules:

- You can use the forward slash (/) or backward slash (\) as a file separator, regardless of whether you are on a UNIX® or PC platform. The makefile generator returns the path names with the correct platform-specific file separators.
- You can use tokens that evaluate in the MATLAB workspace, if you enclose them with dollar signs ($...$). For example, consider this path:

  $mydir1$\dir1

  In this example, mydir1 is a variable that you define in the MATLAB workspace as 'd:\work\source\module1'. In the generated code, this custom include path appears as:
• You must enclose paths in double quotes if they contain spaces or other nonstandard path characters, such as hyphens (-).
Share Data Using Custom C Code

In this section...

| “Use Custom Code to Define Global Constants” on page 29-26 |
| “Use Custom Code to Define Global Constants, Variables, and Functions” on page 29-29 |

Use Custom Code to Define Global Constants

This example describes how to use custom C code to define constants that apply to all charts in your model.

Suppose that you have the following model:

The chart contains the following logic:
The chart contains two states A and B, along with a Simulink input named `input_data`, which you can set to 0 or 1 by toggling the Manual Switch in the model during simulation.

2. Open the Model Configuration Parameters dialog box.

3. In the Model Configuration Parameters dialog box, select the **Simulation Target** pane.

4. Select the **Header file** subpane.

   In this subpane, you can enter `#define` and `#include` statements.
In this example, you define two constants named TRUE and FALSE to move between states in your chart, instead of using the values 1 and 0. These custom definitions improve the readability of your chart actions. Note that TRUE and FALSE are not Stateflow data objects.

Because the two custom definitions appear at the top of your generated machine header file `ex_custom_code_global_constants_sfun.h`, you can use TRUE and FALSE in all charts that belong to this model.
**Use Custom Code to Define Global Constants, Variables, and Functions**

This example describes how to use custom C code to define constants, variables, and functions that apply to all charts in your model.

1. Suppose that you have the following model:

![Chart Diagram]

The chart contains the following logic:
The chart contains two states A and B, along with three data objects: input_data, local_data, and out_data. The chart accesses a custom variable named myglobal and calls a custom function named my_function.

2 Open the Model Configuration Parameters dialog box.

3 In the Model Configuration Parameters dialog box, select the Simulation Target pane.

4 Select the Header file subpane.

In this subpane, you can enter #define and #include statements.
**Note** When you include a custom header file, you must enclose the file name in double quotes.

The custom header file `ex_custom_code_global_constants_vars_fcns_hdr.h` contains the definitions of three constants:

```c
#define TRUE 1
#define FALSE 0
#define MAYBE 2
```

This header file also contains declarations for the variable `myglobal` and the function `my_function`:
extern int myglobal;
extern int my_function(int var1, double var2);

5 Select the **Include directories** subpane.

The single period (.) indicates that all your custom code files reside in the same folder as ex_custom_code_global_constants_vars_fcns.

**Tip** To direct your makefile to look for header or source files in a subfolder relative to the model folder, use this relative path name:

.\subfolder_name

6 Select the **Source files** subpane.

The custom source file ex_custom_code_global_constants_vars_fcns_src.c compiles along with the Stateflow generated code into a single S-function MEX file.

**Tip** To include a source file that resides in a subfolder relative to the model folder, use this relative path name:

.\subfolder_name\source_file.c

In this example, you define three constants, a variable, and a function via custom code options. Because the custom definitions appear at the top of your generated machine header file ex_custom_code_global_constants_vars_fcns_sfun.h, you can access them in all charts that belong to this model.

**Note** Do not share fixed-point data between your custom code and your Stateflow chart. Stateflow expects data returned from custom code to be of type `double`. 
Parse Stateflow Charts

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“How the Stateflow Parser Works” on page 29-33</td>
</tr>
<tr>
<td>“Calling the Stateflow Parser” on page 29-33</td>
</tr>
</tbody>
</table>

How the Stateflow Parser Works

The parser evaluates the graphical and nongraphical objects and data in each Stateflow machine against the supported chart notation and the action language syntax.

Calling the Stateflow Parser

When you simulate a model, build a target, or generate code for a target, Stateflow automatically parses the Stateflow machine. Additionally, you can invoke the Stateflow parser to check the syntax of your chart by selecting Chart > Parse Chart from the Stateflow Editor.

If parsing is unsuccessful, the chart automatically appears with the highlighted object that causes the first parse error. You can select the error in the diagnostic window to bring its source chart to the front with the source object highlighted. Any unresolved data or events in the chart are flagged in the Symbol Wizard.
Resolve Undefined Symbols in Your Chart

**In this section...**

| “Search for Undefined Symbols” on page 29-34 |
| “Resolve Undefined Data in the Symbols Window” on page 29-35 |
| “Define Chart Symbols with the Symbol Wizard” on page 29-35 |
| “Rules for Inferring the Scope of Unresolved Symbols” on page 29-36 |
| “Inference of Size, Type, and Complexity” on page 29-37 |

**Search for Undefined Symbols**

To search for undefined symbol errors, use one of these methods:

- View the Symbols window and look for a red error icon. When you hover your cursor over the icon, you see *Undefined symbol*.
- Parse a chart by selecting **Chart > Parse Chart**.
- Start simulation by selecting **Simulation > Run** in the model window.
- Update the model diagram by selecting **Simulation > Update Diagram** in the model window.

The parser behaves differently depending on how you set **Parse custom code symbols** in the Model Configuration Parameters dialog box, on the **Simulation Target** pane.

- For C charts, if you select the **Parse custom code symbols** check box, the parser tries to find unresolved chart symbols in the custom code. If the custom code does not define these symbols, they are flagged in the Symbol Wizard. The Symbol Wizard suggests scopes for unresolved data and event symbols. This option is not available for charts that use MATLAB as the action language.
- If you do not select the **Parse custom code symbols** check box, the parser considers unresolved data symbols in the chart to be defined in the custom code. If the custom code does not define these symbols, an error does not appear until make time.

**Note** When you parse a chart, Stateflow has access to all required information for detecting unresolved symbols, such as enumerated data types and exported graphical functions from other charts. However, there can be false alarms from data types inherited from Simulink.
For information about Simulink symbol resolution, see “Symbol Resolution” (Simulink) and “Symbol Resolution Process” (Simulink).

### Resolve Undefined Data in the Symbols Window

When you edit charts, Stateflow detects symbols in your chart that you have not added as data, events, or messages. Undefined symbols are displayed in the Symbols window with a red error icon 🔄. When you select the error icon and choose **Fix**, Stateflow defines the symbol and infers a scope, type, size, and complexity. To resolve all the undefined symbols detected in the Symbols window, select the **Resolve undefined symbols** button.

### Define Chart Symbols with the Symbol Wizard

When you parse a chart, the Symbol Wizard flags unresolved symbols in your chart. The Symbol Wizard infers the class and scope of unresolved data and events.

If the inferred scope is incorrect for any events or data, you can change the scope in the Symbol Wizard. You can also change the class of a symbol between data and event.
To accept, reject, or change the scope of a recommended item, perform one of these steps:

- To accept an item, select the check box in front of the item.
- To reject an item, clear the check box.
- To change the class or scope, select a different value from the drop-down list under **Class** or **Scope**.

After you edit the symbol definitions, click **OK** to add the symbols to the Stateflow hierarchy.

**Rules for Inferring the Scope of Unresolved Symbols**

Stateflow follows these rules for inferring the scope of unresolved data symbols.
Stateflow follows these rules for inferring the scope of unresolved event symbols.

<table>
<thead>
<tr>
<th>Unresolved Event Symbol</th>
<th>Inferred Scope</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appears only in triggers</td>
<td>Input</td>
</tr>
<tr>
<td>Appears only in <code>send</code> expressions</td>
<td>Output</td>
</tr>
<tr>
<td>Appears in both triggers and <code>send</code> expressions</td>
<td>Local</td>
</tr>
</tbody>
</table>

### Inference of Size, Type, and Complexity

When Stateflow flags unresolved data in your chart that uses MATLAB as the action language, the following properties are inferred along with the scope:

- **Size** is -1 (inherited).
- **Type** is *Inherit: Same as Simulink* or *Inherit: From definition in chart* (for local data, and function inputs and outputs).
- **Complexity** is Inherited.

### See Also

### More About

- “Add Stateflow Data” on page 9-2
- “Set Data Properties” on page 9-7
- “Use Data Types in Stateflow” on page 9-39
• “Size Stateflow Data” on page 9-47
• “Detect Unused Data in the Symbols Window” on page 9-5
• “Trace Data, Events, and Messages Through the Symbols Window” on page 31-7
• “Parse Stateflow Charts” on page 29-33
Traceability of Stateflow Objects in Generated Code

Traceability comments provide a way to:

- Verify generated code. You can identify which Stateflow object corresponds to a line of code and keep track of code from different objects that you have or have not reviewed.
- Include comments in code generated for large-scale models. You can identify objects in generated code and avoid manually entering comments or descriptions.

To enable traceability comments, you must have Embedded Coder or HDL Coder software. For C/C++ code generation, comments appear in the generated code for embedded real-time (ert) based targets only.

For more information about traceability and generated C/C++ code, see “Trace Stateflow Elements in Generated Code” (Embedded Coder). For more information about traceability and generated HDL code, see “Navigate Between Simulink Model and HDL Code by Using Traceability” (HDL Coder).

See Also

More About
- “Trace Simulink Model Elements in Generated Code” (Embedded Coder)
Call Extrinsic Functions in a Stateflow Chart

To use extrinsic functions that are not supported for code generation within a chart that uses MATLAB as the action language, you must use `coder.extrinsic`. When you declare a function with `coder.extrinsic('function_name')` Stateflow creates a call to the function during simulation. In a Stateflow chart, you only declare `coder.extrinsic` once. You cannot declare reserved keywords with `coder.extrinsic` (see Rules for Naming Stateflow Objects).

For charts that include atomic subcharts, you must separately declare functions that are not supported for code generation individually with `coder.extrinsic` within the atomic subchart.

To create a call for the extrinsic function `heaviside`, the following model uses `coder.extrinsic`.

The chart contains two parallel states, A and B, and one graphical function block, `foo`. State A declares the function `heaviside`, which is not supported for code generation, using `coder.extrinsic`. State B and the graphical function block also use `heaviside` without `coder.extrinsic`.

The input for state A is `u1`, a sine wave, and the input for state B is `u2`, a cosine wave. The graphical function `out` outputs the `heaviside` of any input `in`. 
You only need to declare `heaviside` once in your chart using `coder.extrinsic`. After this you can use the `heaviside` function anywhere within your chart without `coder.extrinsic`. When generating code the functions that you declare using `coder.extrinsic` will have a call to the extrinsic function, and that function will not appear in the generated code.

To visualize the result of this chart, open the scope.
See Also

coder.extrinsic | heaviside
More About

- "Generate Code for Global Data" (MATLAB Coder)
- "Functions and Objects Supported for C/C++ Code Generation — Alphabetical List" (Simulink)
Debug and Test Stateflow Charts

- “Debugging Charts” on page 30-2
- “Animate Stateflow Charts” on page 30-3
- “Set Breakpoints to Debug Charts” on page 30-5
- “Manage Stateflow Breakpoints and Watch Data” on page 30-12
- “Control Chart Execution from the Stateflow Editor” on page 30-19
- “Debug Run-Time Errors in a Chart” on page 30-22
- “Common Modeling Errors Stateflow Can Detect” on page 30-26
- “Guidelines for Avoiding Unwanted Recursion in a Chart” on page 30-32
- “Watch Stateflow Data Values” on page 30-34
- “Change Data Values During Simulation” on page 30-38
- “Monitor Test Points in Stateflow Charts” on page 30-43
- “What You Can Log During Chart Simulation” on page 30-47
- “Basic Approach to Logging States and Data” on page 30-48
- “Access Signal Logging Data” on page 30-54
- “View Logged Data” on page 30-58
- “Log Data in Library Charts” on page 30-59
- “How Stateflow Logs Multidimensional Data” on page 30-64
- “Commenting Stateflow Objects in a Chart” on page 30-65
Debugging Charts

You can perform most debugging tasks directly from the Stateflow Editor:

- Set breakpoints to stop execution in specific objects, such as charts, states, transitions, graphical functions, truth table functions, local events, and input events.
- Enable, disable, and set conditions on breakpoints in the Breakpoints and Watch window.
- Add data that you want to monitor during simulation in the Breakpoints and Watch window.
- After execution stops at a breakpoint, step through the simulation.

In addition, during simulation, you can display and change the values of Stateflow data in the MATLAB Command Window.

See Also

More About

- “Set Breakpoints to Debug Charts” on page 30-5
- “Watch Stateflow Data Values” on page 30-34
- “Manage Stateflow Breakpoints and Watch Data” on page 30-12
- “Control Chart Execution from the Stateflow Editor” on page 30-19
- “Change Data Values During Simulation” on page 30-38
Animate Stateflow Charts

Set Animation Speeds

During simulation, animation provides visual verification that your chart behaves as you expect. Animation highlights active objects in a chart as execution progresses. You can control the speed of chart animation during simulation, or turn animation off. In the Stateflow editor, select Simulation > Stateflow Animation, then select:

- Lightning Fast
- Fast
- Medium
- Slow
- None

Lightning Fast animation provides the fastest simulation speed by buffering the highlights. During Lightning Fast animation, the more recently highlighted objects are in a bolder, lighter blue. These highlights fade away as simulation time progresses.

The default animation speed, Fast, shows the active highlights at each time step. To add a delay with each time step, set the animation speed to Medium or Slow.

Maintain Highlighting

To maintain highlighting of active states in the chart after simulation ends, select Simulation > Stateflow Animation > Maintain Highlighting.

Disable Animation

Animation is enabled by default in Stateflow charts. To turn off animation for a chart, in the Stateflow editor, select Simulation > Stateflow Animation > None.

Animate Stateflow Charts as Generated Code Executes on a Target System

If you have a Simulink Coder license, you can use external mode to establish communication between a Simulink model and generated code downloaded to and
executing on a target system. Stateflow software can use the external mode communication channel to animate chart states. Also, you can designate chart data of local scope to be test points and view the test point data in floating scopes and signal viewers.

For more information, see “External Mode Simulation with TCP/IP or Serial Communication” (Simulink Coder).
Set Breakpoints to Debug Charts

Types of Breakpoints

You enable debugging for a chart when you set a breakpoint. A breakpoint indicates a point at which Stateflow halts execution of a chart that you are simulating. You can then view Stateflow data and the MATLAB workspace to examine the status of the chart.

Depending on the type of object, you can set different breakpoints.

<table>
<thead>
<tr>
<th>Object Type:</th>
<th>Breakpoint Type:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Charts</td>
<td><strong>On Chart Entry</strong> — Stop execution before entering the chart.</td>
</tr>
<tr>
<td>States</td>
<td><strong>On State Entry</strong> — Stop execution before performing the state entry actions.</td>
</tr>
<tr>
<td></td>
<td><strong>During State</strong> — Stop execution before performing the state during actions.</td>
</tr>
<tr>
<td></td>
<td><strong>On State Exit</strong> — Stop execution after performing the state exit actions.</td>
</tr>
<tr>
<td>Transitions</td>
<td><strong>When Transition is Valid</strong> — Stop execution after the transition tests valid, but before taking the transition.</td>
</tr>
<tr>
<td></td>
<td><strong>When Transition is Tested</strong> — Stop execution before testing the transition to see if it is a valid path. If no condition exists on the transition, this breakpoint is not available.</td>
</tr>
<tr>
<td>Graphical or truth table functions</td>
<td><strong>During Function Call</strong> — Stop execution before calling the function.</td>
</tr>
<tr>
<td>Events</td>
<td><strong>Start of Broadcast</strong> — Stop execution before broadcasting the event.</td>
</tr>
<tr>
<td></td>
<td><strong>End of Broadcast</strong> — Stop execution after a Stateflow object reads the event.</td>
</tr>
</tbody>
</table>

Breakpoints appear as a circular badge in the associated object. For example, the following chart contains breakpoints on state *On* and the transition from *On* to *Off*. 
The badge can represent one or more breakpoints on an object. Hover your cursor over the badge to see which breakpoints are set. For example, the badge on state On represents two breakpoints: On State Entry and During State.
Set a Breakpoint for a Stateflow Object

To set a breakpoint on the entry to a chart, right-click inside the chart and select Set Breakpoint on Chart Entry.

To set a breakpoint on a graphical object in a chart:

1. Right-click the object.
2. Select Set Breakpoints.
3. Choose the breakpoint type.

To set breakpoints for an event, use the Properties dialog box.

1. Open the Properties dialog box for the event.
2 Choose the breakpoint type, and select the check box.

Clicking the breakpoint badge opens the Breakpoints dialog box. You can add or clear breakpoints by selecting the check box next to the breakpoint type.

![Breakpoint Dialog Box](image)

Selecting **Manage breakpoints** opens the Stateflow Breakpoints and Watch window. In this window, you can manage conditions for all breakpoints. For each breakpoint, you can:

- Set conditions
- Enable the breakpoint
- Disable the breakpoint
- Clear the breakpoint
- View the hit count, or number of times a breakpoint has been encountered during simulation.

For more information, see “Manage Stateflow Breakpoints and Watch Data” on page 30-12.

**Visual Indication of Execution at Breakpoints**

When simulation stops at a breakpoint, the chart provides visual indicators of active elements and the currently executing object. The chart highlights active elements in blue and the currently executing object in green. For example, the following chart contains a breakpoint on entry in the HIGH state, a substate of On.
When simulation stops at the breakpoint:

- The active On state appears highlighted in blue.
- The currently executing HIGH substate appears highlighted in green, along with an execution status badge ☐, indicating execution stopped at state entry.
When you hover the cursor over the badge, a tooltip is displayed, indicating:

- Where execution stopped
- Simulation time
- Current event, if the chart is processing a local or input event
Manage Stateflow Breakpoints and Watch Data

Set Conditions on Breakpoints

In the **Breakpoints** tab of the Stateflow Breakpoints and Watch window, you can enter a MATLAB expression as a condition on a Stateflow breakpoint. Simulation then pauses on that breakpoint only when the condition is true. You can use any valid MATLAB expression as a condition. This condition expression can include numerical values and any Stateflow data that is in scope at the breakpoint.

**Note** You cannot use message data in a breakpoint condition expression.

This example shows setting a conditional breakpoint in the model **sf_car**. It shows how you can see speed increasing leading up to the car upshifting. First, set a breakpoint on the transition from **steady_state** to **upshifting** of type **When Transition is Tested**.
Without a condition on this breakpoint, simulation pauses every time the transition is tested, even when the value of `speed` is far below `up_th`. To inspect the chart just before the transition is taken, you want the software to pause simulation only when the value of `speed` is approaching the value of `up_th`. When you set the condition `speed > up_th - 2` on the breakpoint, then simulation pauses only when the value of `speed` reaches within 2 of the value of `up_th`.
When simulation pauses, you can view the values for the variables speed and up_th in the Watch tab. To add each variable to the Watch tab:

1. In the chart, right-click the transition from steady_state to upshifting.
2. Select Add to Watch Window.
3. Choose the data variable name.

For more information, see “Watch Stateflow Data Values” on page 30-34.
Disable and Enable Breakpoints

Disable breakpoints to prevent them from affecting chart execution. The breakpoint conditions are not deleted. The conditions are restored when you enable the breakpoint. To disable an individual breakpoint, in the Breakpoints tab of the Stateflow Breakpoints and Watch window, clear the check box next to the breakpoint name. For example, the following chart shows a disabled breakpoint on the state steady_state.
If all the breakpoints for a graphical object are disabled, its badge changes from red to gray.

If there is at least one breakpoint enabled for an object, then the breakpoint badge remains red.

To enable the breakpoint, select the box next to the breakpoint name.

To disable and enable all Stateflow breakpoints, clear or check the box at the top of the check box column.

**View Breakpoint Hits**

In the **Breakpoints** tab, you can view the number of **Hits** for each breakpoint. This is the number of times simulation has paused on each breakpoint. The breakpoints **Hits** numbers resets to zero each time simulation for the model starts from the beginning, or when the condition is changed.
Clear Breakpoints and Watch Data

You can clear Stateflow breakpoints and watch data from the Stateflow Breakpoints and Watch window. Clearing a breakpoint removes it from the chart. Hover your cursor over the name of the breakpoint or watch data. Click the icon that appears to the right of the name.

To add breakpoints and watch data, see “Set Breakpoints to Debug Charts” on page 30-5 and “Watch Stateflow Data Values” on page 30-34.

Format Watch Display

You can change the format of watch data. Select the gear icon, . From the drop-down list, choose the desired MATLAB format for each data type.
For more information on the floating point and integer formats, see `format`. For more information on fixed-point formats, see `storedInteger` and `double`.

**Save and Restore Breakpoints and Watch Data**

Breakpoints and watch data persist during a MATLAB session. When you close a model, breakpoints and watch data remain in the Stateflow Breakpoints and Watch window. During one MATLAB session, if you reopen a model, any breakpoints and watch data for that model are restored.

You can save a snapshot of the breakpoints and watch data list, and then reload it at any point in the current or subsequent MATLAB session. To save a snapshot, click the save icon, 📋, and name the snapshot file. To restore a snapshot, click the restore icon, 📁, and choose the snapshot file.
Control Chart Execution from the Stateflow Editor

When you set breakpoints on chart objects, you can control chart execution directly from the Stateflow Editor. For more information, see “Debugging Charts” on page 30-2.

1 In the Stateflow Editor, start simulation by clicking the Run icon or by selecting Simulation > Run.

When simulation stops at a breakpoint, the MATLAB command prompt changes to debug>> and an execution status badge appears in the graphical object where execution pauses.

<table>
<thead>
<tr>
<th>Badge</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Badge" /></td>
<td>Execution stopped before entering a chart or state.</td>
</tr>
<tr>
<td><img src="image" alt="Badge" /></td>
<td>Execution stopped in a state's during action, graphical function, or truth table function.</td>
</tr>
<tr>
<td><img src="image" alt="Badge" /></td>
<td>Execution stopped after exiting a state.</td>
</tr>
<tr>
<td><img src="image" alt="Badge" /></td>
<td>Execution stopped before transition is tested.</td>
</tr>
<tr>
<td><img src="image" alt="Badge" /></td>
<td>Execution stopped before taking a valid transition.</td>
</tr>
</tbody>
</table>

2 To see execution status, point to the badge. A tooltip indicates:
   - Where execution stopped.
   - Simulation time.
   - Current event, if the chart is processing a local or input event.

3 To view data values in the chart, point to a chart object. A tooltip displays the value of the data and messages used by the selected object.

4 From the Stateflow Editor tool bar, the Simulation menu, or at the MATLAB command prompt, select options for continuing chart execution.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Command</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Continue</td>
<td>dbcont</td>
<td>Continue simulation to the next breakpoint.</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Icon</td>
<td>Option</td>
<td>Command</td>
<td>Description</td>
<td>Keyboard Shortcut</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><img src="image" alt="Play" /></td>
<td>Step Forward</td>
<td></td>
<td>Advance to the next state, pause simulation, and exit debug mode.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Step Over" /></td>
<td>Step Over</td>
<td>dbstep</td>
<td>From a state or transition, advance to the next state or transition.</td>
<td>F10</td>
</tr>
<tr>
<td><img src="image" alt="Step In" /></td>
<td>Step In</td>
<td>dbstep in</td>
<td>From a state or transition containing a function call, advance to the first executable statement in the function. Otherwise, step over to the next state or transition. From a statement in a function containing another function call, advance to the first executable statement in the second function. Otherwise, step over to the next executable statement.</td>
<td>F11</td>
</tr>
</tbody>
</table>

### Debug and Test Stateflow Charts

- **Step Forward**
  - **Command**: dbstep
  - **Description**: Advance to the next state, pause simulation, and exit debug mode.

- **Step Over**
  - **Command**: dbstep
  - **Description**: From a state or transition, advance to the next state or transition. From a statement in a function, advance to the next executable statement in the function. From the end of a function, advance to the state, transition, or statement after the call to the function.

- **Step In**
  - **Command**: dbstep in
  - **Description**: From a state or transition containing a function call, advance to the first executable statement in the function. Otherwise, step over to the next state or transition. From a statement in a function containing another function call, advance to the first executable statement in the second function. Otherwise, step over to the next executable statement.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Option</th>
<th>Command</th>
<th>Description</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Step Out</td>
<td>dbstep out</td>
<td>From a state or transition, advance to the next breakpoint. From a statement in a function, advance to the end of the function. From the end of a function, advance to the state, transition, or statement after the call to the function.</td>
<td>Shift+F11</td>
</tr>
<tr>
<td><img src="image" alt="icon" /></td>
<td>Stop</td>
<td>dbquit</td>
<td>Stop simulation of the model and exit debug mode.</td>
<td>Ctrl+Shift+T</td>
</tr>
</tbody>
</table>

### See Also

### More About
- “Set Breakpoints to Debug Charts” on page 30-5
- “Change Data Values During Simulation” on page 30-38
- “Debug Run-Time Errors in a Chart” on page 30-22
Debug Run-Time Errors in a Chart

In this section...

| “Create the Model and the Stateflow Chart” on page 30-22 |
| “Debug the Stateflow Chart” on page 30-23 |
| “Correct the Run-Time Error” on page 30-24 |

Create the Model and the Stateflow Chart

In this topic, you create a model with a Stateflow chart to debug. Follow these steps:

1. Create the following Simulink model:

   ![Simulink model diagram]

2. Add the following states and transitions to your chart:
3 In your chart, add an event Switch with a scope of **Input from Simulink** and a **Rising** edge trigger.

4 Add a data Shift with a scope of **Input from Simulink**.

The chart has two states at the highest level in the hierarchy, **Power_off** and **Power_on**. By default, **Power_off** is active. The event Switch toggles the system between the **Power_off** and **Power_on** states. **Power_on** has three substates: **First**, **Second**, and **Third**. By default, when **Power_on** becomes active, **First** also becomes active. When Shift equals 1, the system transitions from First to Second, Second to Third, Third to First, for each occurrence of the event Switch, and then the pattern repeats.

In the model, there is an event input and a data input. A Sine Wave block generates a repeating input event that corresponds with the Stateflow event Switch. The Step block generates a repeating pattern of 1 and 0 that corresponds with the Stateflow data object Shift. Ideally, the Switch event occurs at a frequency that allows at least one cycle through **First**, **Second**, and **Third**.

**Debug the Stateflow Chart**

To debug the chart in “Create the Model and the Stateflow Chart” on page 30-22, follow these steps:

1 Right-click in the chart, and select **Set breakpoint on Chart Entry**.
2 Start the simulation.

Because you specified a breakpoint on chart entry, execution stops at that point.

3 Click the Step In button, 🔄.

The Step In button executes the next step and stops.

4 Continue clicking the Step In button and watching the animating chart.

After each step, watch the chart animation to see the sequence of execution.

Single-stepping shows that the chart does not exhibit the desired behavior. The transitions from First to Second to Third inside the state Power_on are not occurring because the transition from Power_on to Power_off takes priority. The output display of code coverage also confirms this observation.

**Correct the Run-Time Error**

In “Debug the Stateflow Chart” on page 30-23, you step through a simulation of a chart and find an error: the event Switch drives the simulation but the simulation time passes too quickly for the input data object Shift to have an effect.

Correct this error as follows:

1 Stop the simulation so that you can edit the chart.

2 Add the condition \[ t > 20.0 \] to the transition from Power_on to Power_off.
Now the transition from `Power_on` to `Power_off` does not occur until simulation time is greater than 20.0.


4. Click the Step In button repeatedly to observe the new behavior.
Common Modeling Errors Stateflow Can Detect

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“State Inconsistencies in a Chart” on page 30-26</td>
</tr>
<tr>
<td>“Data Range Violations in a Chart” on page 30-27</td>
</tr>
<tr>
<td>“Cyclic Behavior in a Chart” on page 30-28</td>
</tr>
</tbody>
</table>

State Inconsistencies in a Chart

Definition of State Inconsistency

States in a Stateflow chart are inconsistent if they violate any of these rules:

- An active state (consisting of at least one substate) with exclusive (OR) decomposition has exactly one active substate.
- All substates of an active state with parallel (AND) decomposition are active.
- All substates of an inactive state with either exclusive (OR) or parallel (AND) decomposition are inactive.

Causes of State Inconsistency

An error occurs at compile time when the following conditions are all true:

- A transition leads to a state that has exclusive (OR) decomposition and multiple substates. There are no default paths that lead to the entry of any substate. This condition results in a state inconsistency error. (However, if all transitions into that state are supertransitions leading directly to the substates, there is no error.)
- The state with multiple substates does not contain a history junction.

You can control the level of diagnostic action that occurs due to omission of a default transition in the Diagnostics > Stateflow pane of the Model Configuration Parameters dialog box. For more information, see the documentation for the “No unconditional default transitions” (Simulink) diagnostic.

State Inconsistency Example

The following chart has a state inconsistency.
In the absence of a default transition indicating which substate is to become active, the chart has a state inconsistency error.

Adding a default transition to one of the substates resolves the state inconsistency.

**Data Range Violations in a Chart**

**Types of Data Range Violations**

Stateflow detects the following data range violations during simulation:

- When a data object equals a value outside the range of the values set in the **Initial value**, **Minimum**, and **Maximum** fields specified in the Data properties dialog box.

  See “Set Data Properties” on page 9-7 for a description of the **Initial value**, **Minimum**, and **Maximum** fields in the Data properties dialog box.
When the result of a fixed-point operation overflows its bit size

See “Detect Overflow for Fixed-Point Types” on page 21-9 for a description of the overflow condition in fixed-point numbers.

When you select **Saturate on integer overflow** for your chart, Stateflow does not flag any cases of integer overflow during simulation. However, Stateflow continues to flag out-of-range data violations based on minimum-and-maximum range checks. For more information, see “Impact of Saturation on Error Checks” on page 9-55.

**Detect Data Range Violations**

To enable data range violation checking, set **Simulation range checking** in the **Diagnostics: Data Validity** pane of the Configuration Parameters dialog box to **error**.

**Data Range Violation Example**

The following chart has a data range violation.

![Diagram of a chart with state A and transitions](image)

Assume that the data a has an **Initial value** and **Minimum** value of 0 and a **Maximum** value of 2. Each time an event awakens this chart and state A is active, a increments. The value of a quickly becomes a data range violation.

**Cyclic Behavior in a Chart**

**What Is Cyclic Behavior?**

Cyclic behavior is a step or sequence of steps that is repeated indefinitely (recursive). Stateflow uses cycle detection algorithms to detect a class of infinite recursions caused by event broadcasts.

**Detect Cyclic Behavior During Simulation**

Cyclic behavior checking is enabled by default. To detect cyclic behavior during a simulation:
1 Build the target with debugging enabled.
2 Confirm **Simulation > Debug > MATLAB & Stateflow Error Checking Options > Detect Cycles** is checked.
3 Start the simulation.

To turn off cyclic behavior checking, uncheck **Simulation > Debug > MATLAB & Stateflow Error Checking Options > Detect Cycles**.

**Cyclic Behavior Example**

This chart shows how an event broadcast can cause infinite recursive cycles.

When the state C during action executes, event E1 is broadcast. The transition from state A . A1 to state A . A2 becomes valid when event E1 is broadcast. Event E2 is broadcast as a condition action of that transition. The transition from state B . B1 to state B . B2 becomes valid when event E2 is broadcast. Event E1 is broadcast as a condition action of the transition from state B . B1 to state B . B2. Because these event broadcasts of E1 and E2 are in condition actions, a recursive event broadcast situation occurs. Neither transition can complete.

**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the send operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.
You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the **Diagnostics** > **Stateflow** pane and set the **Undirected event broadcasts** diagnostic to none, warning, or error. The default setting is warning.

**Flow Cyclic Behavior Not Detected Example**

This chart shows an example of cyclic behavior in a flow chart that Stateflow cannot detect.

The data object \( i \) is set to 0 in the condition action of the default transition. \( i \) increments in the next transition segment condition action. The transition to the third connective junction is valid only when the condition \([i < 0]\) is true. This condition is never true in this flow chart, resulting in a cycle.

Stateflow cannot detect this cycle because it does not involve recursion due to event broadcasts. Although Stateflow cannot detect cycles that depend on data values, a separate diagnostic error does appear during simulation, for example:

**Junction is part of a cycle and does not have an unconditional path leading to termination.**

For information on fixing cyclic behavior in flow charts, type the following at the MATLAB command prompt:

```
sfhelp('cycle_error')
```
Noncyclic Behavior Flagged as a Cycle Example

This chart shows an example of noncyclic behavior that Stateflow flags as being cyclic.

State A becomes active and i is initialized to 0. When the transition is tested, the condition \([i < 5]\) is true. The condition actions that increment i and broadcast the event E are executed. The broadcast of E when state A is active causes a repetitive testing (and incrementing of i) until the condition is no longer true. Stateflow flags this behavior as a cycle, but the so-called cycle breaks when i becomes greater than 5.

**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the send operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.

You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the **Diagnostics > Stateflow** pane and set the **Undirected event broadcasts** diagnostic to none, warning, or error. The default setting is warning.
Guidelines for Avoiding Unwanted Recursion in a Chart

Recursion can be useful for controlling substate transitions among parallel states at the same level of the chart hierarchy. For example, you can send a directed event broadcast from one parallel state to a sibling parallel state to specify a substate transition. (For details, see “Directed Event Broadcasting” on page 12-52.) This type of recursive behavior is desirable and efficient.

However, unwanted recursion can also occur during chart execution. To avoid unwanted recursion, follow these guidelines:

Do not call functions recursively

Suppose that you have functions named \( f \), \( g \), and \( h \) in a chart. These functions can be any combination of graphical functions, truth table functions, MATLAB functions, or Simulink functions.

To avoid recursive behavior, do not:

- Have \( f \) calling \( g \) calling \( h \) calling \( f \)
- Have \( f \), \( g \), or \( h \) calling itself

Do not use undirected local event broadcasts

Follow these rules:

- Use directed local event broadcasts with the syntax \( \text{send} \left( \text{event}, \text{state} \right) \). The \text{event} is a local event in the chart and the \text{state} is the destination state that you want to wake up using the event broadcast.
- If the source of the local event broadcast is a state action, ensure that the destination state is \textit{not} an ancestor of the source state in the chart hierarchy.
- If the source of the local event broadcast is a transition, ensure that the destination state is \textit{not} an ancestor of the transition in the chart hierarchy.

Also, ensure that the transition does not connect to the destination state.

If you have \textit{undirected} local event broadcasts in state actions or condition actions in your chart, a warning appears by default during simulation. Examples of state actions with undirected local event broadcasts include:
• entry: send(E1), where E1 is a local event in the chart

• exit: E2, where E2 is a local event in the chart

You can control the level of diagnostic action for undirected local event broadcasts in the Diagnostics > Stateflow pane of the Configuration Parameters dialog box. Set the Undirected event broadcasts diagnostic to none, warning, or error.
Watch Stateflow Data Values

In this section...

| “Watch Data in the Stateflow Breakpoints and Watch Window” on page 30-34 |
| “Watch Data in the Stateflow Chart” on page 30-34 |
| “Watch Stateflow Data in the MATLAB Command Window” on page 30-36 |

Watch Data in the Stateflow Breakpoints and Watch Window

In the **Watch** tab of the Stateflow Breakpoints and Watch window, you can view current data and messages when simulation pauses. The **Watch** tab displays a list of watch data, and highlights the values that changed since the last time simulation paused. In the **Watch** tab, you can expand a message to view the message queue and message data values. To add Stateflow data or messages to the watch data list:

1. In the chart, right-click an object that uses the data or message.
2. Select **Add to Watch Window**.
3. Choose the data or message.

To add active state data and truth table data to the watch list, from the Model Explorer, open the Data Properties dialog box. Select **Add to Watch Window**.

You can choose the display format for each data type. For more information, see “Format Watch Display” on page 30-17.

Watch Data in the Stateflow Chart

During simulation you can hover over objects in the chart to view the value of data or message used by the selected object. Hovering over objects in the chart provides the following information:

<table>
<thead>
<tr>
<th>For:</th>
<th>Tooltip Shows:</th>
</tr>
</thead>
<tbody>
<tr>
<td>States and transitions</td>
<td>Values of data and messages used by the object</td>
</tr>
<tr>
<td>Graphical, truth table, and MATLAB functions</td>
<td>Values of local data, messages, inputs and outputs in the scope of the function</td>
</tr>
</tbody>
</table>
For example, the following chart stops execution before entering the Debounce state. Hovering over the transition from the Normal state to the On state shows that the value of \(sw\) is 3.6333.

Because the value of \(sw\) is greater than zero, the chart takes the transition from Normal to enter the Debounce state.
Watch Stateflow Data in the MATLAB Command Window

When simulation reaches a breakpoint, you can view the values of Stateflow data in the MATLAB Command Window. In the following chart, a default transition calls a MATLAB function:

A breakpoint is set at the last executable line of the function:

```matlab
function stats(vals)
    %#codegen

    % calculates a statistical mean and standard deviation
    % for the values in vals.

    len = length(vals);
    mean = avg(vals, len);
    stdev = sqrt(sum(((vals-avg(vals,len)).^2))/len);
    coder.extrinsic('plot');
    plot(vals,'-+');  % Breakpoint set at this line
```

When simulation reaches the breakpoint, you can display Stateflow data in the MATLAB Command Window.

1. At the MATLAB prompt, press **Enter**.
   
   A `debug>>` prompt appears.

2. Type **whos** to view the data that is visible at the current scope.

3. Enter the name of data array `vals` at the prompt to display its value.

4. Enter `vals(2:3)` to view specific values of that array.

The Command Line Debugger provides these commands during simulation:
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dbstep</td>
<td>Advance to next executable line of code.</td>
</tr>
<tr>
<td>dbstep [in/ out]</td>
<td>When debugging MATLAB functions in a chart:</td>
</tr>
<tr>
<td></td>
<td>• dbstep [in] advances to the next executable line of code. If that line contains a call to another function, execution continues to the first executable line of the function.</td>
</tr>
<tr>
<td>dbcont</td>
<td>Continue execution to next breakpoint.</td>
</tr>
<tr>
<td>dbquit (ctrl-c)</td>
<td>Stop simulation of the model. Press <strong>Enter</strong> after this command to return to the command prompt.</td>
</tr>
<tr>
<td>help</td>
<td>Display help for command-line debugging.</td>
</tr>
<tr>
<td>print var</td>
<td>Display the value of the variable <code>var</code>.</td>
</tr>
<tr>
<td></td>
<td>...or...</td>
</tr>
<tr>
<td>var</td>
<td></td>
</tr>
<tr>
<td>var (i)</td>
<td>Display the value of the i\text{th} element of the vector or matrix <code>var</code>.</td>
</tr>
<tr>
<td>var (i:j)</td>
<td>Display the value of a submatrix of the vector or matrix <code>var</code>.</td>
</tr>
<tr>
<td>save</td>
<td>Saves all variables to the specified file. Follows the syntax of the MATLAB <code>save</code> command. To retrieve variables in the MATLAB base workspace, use the <code>load</code> command after simulation has ended.</td>
</tr>
<tr>
<td>whos</td>
<td>Display the size and class (type) of all variables in the scope of the halted MATLAB function in your chart.</td>
</tr>
</tbody>
</table>

You can issue any other MATLAB command at the `debug>>` prompt but the results are executed in the Stateflow workspace. For example, you can issue the MATLAB command `plot(var)` to plot the values of the variable `var`.

To issue a command in the MATLAB base workspace at the `debug>>` prompt, use the `evalin` command with the first argument `'base'` followed by the second argument command, for example, `evalin('base','whos')`.

**Note** To return to the MATLAB base workspace, use the `dbquit` command.
Change Data Values During Simulation

In this section...

“How to Change Values of Stateflow Data” on page 30-38
“Examples of Changing Data Values” on page 30-38
“Limitations on Changing Data Values” on page 30-41

How to Change Values of Stateflow Data

When your chart is in debug mode, you can test the simulation by changing the values of data in the chart. After the debug>> prompt appears, as described in “Watch Stateflow Data in the MATLAB Command Window” on page 30-36, you can assign a different value to your data. To change a data value, enter the new value at the prompt using the following format:

\[ \text{data\_name} = \text{new\_value} \]

For a list of data that you cannot change, see “Data That Is Read-Only During Simulation” on page 30-41. You cannot change message data values at the command line.

Examples of Changing Data Values

Scalar Example

Suppose that, after the debug>> prompt appears, you enter who at the prompt and see the following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>airflow</td>
<td>1x1</td>
<td>1</td>
<td>uint8 array</td>
</tr>
<tr>
<td>temp</td>
<td>1x1</td>
<td>8</td>
<td>double array</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To change...</th>
<th>To this value...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>airflow</td>
<td>2</td>
<td>airflow = uint8(2)</td>
</tr>
<tr>
<td>temp</td>
<td>68.75</td>
<td>temp = 68.75</td>
</tr>
</tbody>
</table>
If you try to enter `airflow = 2`, you get an error message because MATLAB interprets that expression as the assignment of a `double` value to data of `uint8` type. For reference, see “Cases When Casting Is Necessary” on page 30-42.

**Multidimensional Example**

Suppose that, after the `debug>>` prompt appears, you enter `whos` at the prompt and see the following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>ball_interaction</td>
<td>16x16</td>
<td>256</td>
<td>int8 array</td>
</tr>
<tr>
<td>last_vel</td>
<td>16x2</td>
<td>256</td>
<td>double array</td>
</tr>
<tr>
<td>stopped</td>
<td>16x1</td>
<td>16</td>
<td>int16 array</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To change...</th>
<th>To this value...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The element in row 8, column 8 of <code>ball_interaction</code></td>
<td>1</td>
<td><code>ball_interaction(8,8) = int8(1)</code></td>
</tr>
<tr>
<td>The element in row 16, column 1 of <code>last_vel</code></td>
<td>120.52</td>
<td><code>last_vel(16,1) = 120.52</code></td>
</tr>
<tr>
<td>The last element in <code>stopped</code></td>
<td>0</td>
<td><code>stopped(16) = int16(0)</code></td>
</tr>
</tbody>
</table>

One-based indexing applies when you change values of Stateflow data while the chart is in debug mode.

**Variable-Size Example**

Suppose that, after the `debug>>` prompt appears, you enter `whos` at the prompt and see the following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>1x1</td>
<td>8</td>
<td>double array (variable sized: MAX 16x16)</td>
</tr>
<tr>
<td>y2</td>
<td>1x1</td>
<td>8</td>
<td>double array (variable sized: MAX 16x4)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To change...</th>
<th>To...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>y1</td>
<td>A 10-by-5 array of ones</td>
<td><code>y1 = ones(10,5)</code></td>
</tr>
<tr>
<td>y2</td>
<td>A 6-by-4 array of zeros</td>
<td><code>y2 = zeros(6,4)</code></td>
</tr>
</tbody>
</table>
Changing the dimensions of variable-size data works only when the new size does not exceed the dimension bounds.

**Fixed-Point Example**

Suppose that, after the `debug>>` prompt appears, you enter `whos` at the prompt and see the following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>y_n1</td>
<td>1x1</td>
<td>2</td>
<td>fixpt (int16 array (2^-10)*SI)</td>
</tr>
<tr>
<td>x_n1</td>
<td>1x1</td>
<td>2</td>
<td>fixpt (int16 array (2^-12)*SI)</td>
</tr>
</tbody>
</table>

Both `y_n1` and `x_n1` have signed fixed-point types, with a word length of 16. `y_n1` has a fraction length of 10 and `x_n1` has a fraction length of 12.

<table>
<thead>
<tr>
<th>To change...</th>
<th>To this fixed-point value...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>y_n1</code></td>
<td>0.5410</td>
<td><code>y_n1 = fi(0.5412,1,16,10)</code></td>
</tr>
<tr>
<td><code>x_n1</code></td>
<td>0.4143</td>
<td><code>x_n1 = fi(0.4142,1,16,12)</code></td>
</tr>
</tbody>
</table>

For more information about using `fi` objects, see the Fixed-Point Designer documentation.

**Enumerated Example**

Suppose that, after the `debug>>` prompt appears, you enter `whos` at the prompt and see the following data:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Bytes</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentRadioMode</td>
<td>1x1</td>
<td>4</td>
<td>int32 array</td>
</tr>
<tr>
<td>MechCmd</td>
<td>1x1</td>
<td>4</td>
<td>int32 array</td>
</tr>
</tbody>
</table>

Assume that `CurrentRadioMode` and `MechCmd` use the enumerated types `RadioRequestMode` and `CdRequestMode`, respectively.
You must include the enumerated type explicitly in the assignment. Otherwise, an error appears at the `debug>>` prompt.

### Limitations on Changing Data Values

#### Data That Is Read-Only During Simulation

You cannot change data of the following scopes while the chart is in debug mode:

- Constant
- Input

#### Limitations on Changing Type and Size

The following data properties cannot change:

- Data type
- Size

However, for variable-size data, you can change the dimensions of the data as long as the size falls within the dimension bounds. For example, `varsizedData = ones(5,7);` is a valid assignment for a variable-size 10-by-10 array.

#### Limitations for Fixed-Point Data

- Do not assign a value that falls outside the range of values that the fixed-point type can represent. Avoid selecting a value that causes overflow.
- Sign, word length, fraction length, slope, and bias cannot change.

#### Limitations for Structures

- You cannot change the data type or size of any fields.

<table>
<thead>
<tr>
<th>To change...</th>
<th>To this enumerated value...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>CurrentRadioMode</td>
<td>CD</td>
<td><code>CurrentRadioMode = RadioRequestMode.CD</code></td>
</tr>
<tr>
<td>MechCmd</td>
<td>PLAY</td>
<td><code>MechCmd = CdRequestMode.PLAY</code></td>
</tr>
</tbody>
</table>
• Addition or deletion of fields does not work because the size of the structure cannot change.

**Cases When Casting Is Necessary**

When you change a data value, you must explicitly cast values for data of the following built-in types:

- `single`
- `int8`
- `uint8`
- `int16`
- `uint16`
- `int32`
- `uint32`

For example, the following assignments are valid:

- `my_data1 = uint8(2)`
- `my_data2 = single(5.3)`

Casting is not necessary when you change the value of data that is of type `double`.
Monitor Test Points in Stateflow Charts

This example shows you how to specify data or states as test points that you can plot with a floating scope or log to the MATLAB® base workspace during simulation.

About Test Points in Stateflow Charts

A Stateflow® test point is a signal that you can observe during simulation - for example, by using a Floating Scope block. You can designate the following Stateflow objects as test points:

- States
- Local data that is:
- Size - scalar, one-dimensional, or two-dimensional
- Data type - Any except ml
- Descendant of a Stateflow chart

You can specify individual data or states as test points by setting their TestPoint property via the Stateflow API, in the Property Inspector, or in the Model Explorer.

Set Test Points for Stateflow States and Data with the Property Inspector

You can explicitly set individual states, local data, and output data as test points in the Model Explorer. The following procedure shows how to set individual test points for Stateflow states and data.

1. Open the model.

The Stateflow chart contains state A and its substate X are entered on the first tic event. State A and substate X stay active until 10 tic events have occurred, and then state B is
entered. On the next event, state A and substate X are entered and the cycle continues. The data data belongs to substate X. The entry and during actions for substate X increment data while X is active for 10 tic events. When state B is entered, data reinitializes to zero, and then the cycle repeats.

2. Open the Property Inspector, View > Property Inspector.

3. Select state A. Then, in the Logging section of the Property Inspector, select Test Point. 4. Repeat this for state X and B. 5. Open the Symbol viewer, View > Symbol. 6. Select the data data. Then, in the Logging section of the Property Inspector, select Test Point.

You can also log these test points. For instructions, see “Log Multiple Signals At Once” on page 30-50.

**Monitor Data Values and State Self Activity Using a Floating Scope**

In this section, you configure a Floating Scope block to monitor a data value and the self activity of a state.

1. Open the model.
2. Double-click the Floating Scope block. 3. In the Floating Scope window, select **Simulation > Signal Selector**. 4. In the **Model hierarchy** pane, select the chart and in the **List contents**, select the signals.

5. Simulate the model.
When state A.X is active, the signal value is 1. When that state is inactive, the signal value is 0. Because this value can be very low or high compared to other data, you might want to add a second Floating Scope block to compare the activity signal with other data.
What You Can Log During Chart Simulation

When you simulate a chart, you can log values for local data, output data, and state self activity into Simulink objects. After simulation, you can access these objects in the MATLAB workspace and use them to report and analyze the values.

When you log a state, its value is 1 when active and 0 when inactive.

Logging Stateflow data and state self activity follows the same general guidelines as for logging signals in Simulink models.

See Also

- “Export Signal Data Using Signal Logging” (Simulink).
- “About Active State Data” on page 23-31
Basic Approach to Logging States and Data

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Enable Signal Logging” on page 30-48</td>
</tr>
<tr>
<td>“Configure States and Data for Logging” on page 30-49</td>
</tr>
<tr>
<td>“Limitations on Logging Data” on page 30-52</td>
</tr>
</tbody>
</table>

The workflow for logging chart local data, output data, and state self activity is similar to the workflow for logging signals in a model:

1. Enable signal logging for the chart and choose a logging format.
   

2. Configure states and data for signal logging, which includes controlling how much output the simulation generates.
   
   See “Configure States and Data for Logging” on page 30-49.

3. Simulate the chart.

4. Access the logged data.
   
   See “Access Signal Logging Data” on page 30-54.

You can also use active state output to view or log state activity data in Simulink. For more information, see “About Active State Data” on page 23-31.

Enable Signal Logging

The following procedure explains how to enable signal logging for any model. For example, try the procedure with the `sf_semantics_hotel_checkin` model, which uses a chart to simulate a hotel check-in process. To open the model, type `sf_semantics_hotel_checkin` at the MATLAB command prompt.

1. Open the Model Configuration Parameters dialog box.

2. Select **Data Import/Export**.

3. In the Signals pane, select the **Signal logging** check box to enable logging for the chart.
Signal logging is enabled by default for models and charts. To disable logging, clear the check box.

4 Optionally, specify a custom name for the signal logging object.

The default name is `logsout`. Using this object, you can access the logging data in a MATLAB workspace variable.

5 Click **OK**.

**Configure States and Data for Logging**

- “Properties to Configure for Logging” on page 30-49
- “Choose a Configuration Method for Logging” on page 30-49
- “Log Individual States and Data” on page 30-50
- “Log Multiple Signals At Once” on page 30-50
- “Log Chart Signals Using the Command-Line API” on page 30-51

**Properties to Configure for Logging**

You can configure the same properties for logging states, local data, and output data in a chart as you can for logging signals in a model:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log signal data (for data) or Log self data (for states)</td>
<td>Saves the signal or state’s value to the MATLAB workspace during simulation.</td>
</tr>
<tr>
<td>Logging name</td>
<td>Name of the logged signal. Defaults to the original name of the state or data. To rename the logged signal, select Custom and enter a new name. For guidance on when to use a different name for a logged signal, see “Specify Signal-Level Logging Name” (Simulink).</td>
</tr>
<tr>
<td>Limit data points to last</td>
<td>Limits the amount of data logged to the most recent samples.</td>
</tr>
<tr>
<td>Decimation value</td>
<td>Limits the amount of data logged by skipping samples. For example, a decimation factor of 2 saves every other sample.</td>
</tr>
</tbody>
</table>

**Choose a Configuration Method for Logging**

There are several ways to configure states and data for logging:
### Log Individual States and Data

The following procedure explains how to log individual states, local data, and output data for any chart. For example, try the procedure with the `sf_semantics_hotel_checkin` model, which uses a chart to simulate a hotel check-in process. To open the model, type `sf_semantics_hotel_checkin` at the MATLAB command prompt.

1. Open the properties dialog box for the state or data.

   **For:**
   - States
   - Local or output data

   **Do This:**
   - Right-click the state and select **Properties**.
   - Right-click the state or transition that uses the data and select **Explore > (data) variable_name**.

2. In the properties dialog box, click the **Logging** tab.

3. Modify properties as needed.

   For example, from the Hotel chart of the `sf_semantics_hotel_checkin` model:

   1. Open the properties dialog box for the service local data and select the **Log signal data** check box.
   2. Open the properties dialog box for the Dining_area state, select the **Log self activity** check box, and change the logging name to **Dining_Room**.

### Log Multiple Signals At Once

The following procedure explains how to log multiple signals at once for any chart. For example, try the procedure with the `sf_semantics_hotel_checkin` model, which uses a chart to simulate a hotel check-in process. To open the model, type `sf_semantics_hotel_checkin` at the MATLAB command prompt.
In the chart, select **Simulation > Output > Log Chart Signals**.

The Stateflow Signal Logging dialog box opens, showing all states, local, and output data. These chart objects are the signals you can log.

Select the check box next to each signal you want to log.

The **Log signal data** check box is selected automatically for each signal you log. For example, in the Hotel chart of the `sf_semantics_hotel_checkin` model, log the `Check_in.Checked_in.Executive_suite.Dining_area` state and local variable service:

For each signal you select, modify the properties of what gets captured in the log.

For example, change the logging name of `Check_in.Checked_in.Executive_suite.Dining_area` to `Dining_Room`.

**Log Chart Signals Using the Command-Line API**

The following procedure explains how to log chart signals from the command line.
1 Open the model that contains the chart.

For example, open the sf_semantics_hotel_checkin model, which has a chart called Hotel.

2 Get the states whose activity you want to log.

For example, get the Dining_area state in the Hotel chart:

```matlab
rt = sfsroot;
da_state = rt.find('-isa','Stateflow.State','Name','Dining_area');
```

Get the data you want to log.

For example, get the service local data in the Hotel chart:

```matlab
svc_data = rt.find('-isa','Stateflow.Data','Name','service');
```

3 Enable logging for states and data.

For example, enable logging for the Dining_area state and the service data:

```matlab
da_state.LoggingInfo.DataLogging = 1;
svc_data.LoggingInfo.DataLogging = 1;
```

4 Modify logging properties as needed.

For example, change the logged name of the Dining_area state. By default, the logged name is the hierarchical signal name, which is Check_in.Checked_in.Executive_suite.Dining_area. To assign the shorter, custom name of Dining_Room:

```matlab
% Enable custom naming
da_state.LoggingInfo.NameMode = 'Custom';
% Enter the custom name
da_state.LoggingInfo.LoggingName = 'Dining_Room';
```

**Limitations on Logging Data**

If you enable active state output for a state, then logging through Stateflow is unavailable. The state activity data is output to Simulink, and it can be logged in Simulink instead. For more information, see “About Active State Data” on page 23-31 and “Export Signal Data Using Signal Logging” (Simulink).

If you log state activity or data from a chart with Fast Restart enabled, any run after the first run duplicates the first logged data point. When you run algorithms that process these data points, you must account for this duplication.
See Also

Related Examples
•  “Configure a Signal for Logging” (Simulink)

More About
•  “Logging and Accessibility Options” (Simulink)
Access Signal Logging Data

In this section...

<table>
<thead>
<tr>
<th>“Signal Logging Object” on page 30-54</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Access Logged Data” on page 30-54</td>
</tr>
</tbody>
</table>

Signal Logging Object

During simulation, Stateflow saves logged data in a signal logging object, which you can access in the MATLAB workspace. The signal logging object is a Simulink.SimulationData.Dataset object.

The default name of the signal logging object is logsout.

See Also

- “Enable Signal Logging” on page 30-48 to learn how to change the name of the signal logging object
- Simulink.SimulationData.Dataset reference page

Access Logged Data

The following procedure explains how to access signal logging data in for a chart. For example, try the procedure with the sf_semantics_hotel_checkin model, which uses a chart to simulate a hotel check-in process. To open the model, type sf_semantics_hotel_checkin at the MATLAB command prompt. Enable logging as described in “Configure States and Data for Logging” on page 30-49.

1 View the signal logging object in the MATLAB environment.

   For example:

   a Start simulating the sf_semantics_hotel_checkin model using the Dataset signal logging format.

   b When the Front_desk state becomes active, check in to the hotel by toggling the first switch.

   c When the Bedroom state in the Executive_suite state becomes active, order room service multiple times, for example, by toggling the second switch 10 times.
d  Stop simulation.

e  Enter:

    logsout

Result:

    Simulink.SimulationData.Dataset
    Package: Simulink.SimulationData

    Characteristics:
        Name: 'logsout'
        Total Elements: 2

    Elements:
        1: 'Dining_Room'
        2: 'service'

The output indicates:

- `logsout` is a Simulink object of type `SimulationData.Dataset`.
- Two elements were logged.

2  Use the `getElement` method to access logged elements by index and by name.

For example:

- To access logged activity for the `Check_in.Checked_in.Executive_suite.Dining_area` state:

<table>
<thead>
<tr>
<th>By</th>
<th>Enter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td><code>logsout.getElement(1)</code></td>
</tr>
<tr>
<td>Name</td>
<td><code>logsout.getElement('Dining_Room')</code></td>
</tr>
</tbody>
</table>
### By: Block path
#### Enter:
```
logsout.getElement(1).BlockPath
```
Returns:
- **Block Path**: 'sf_semantics_hotel_checkin/Hotel'
- **SubPath**: 'Check_in.Checked_in.Executive_suite.Dining_area'

```python
bp = Simulink.BlockPath('sf_semantics_hotel_checkin/Hotel');
bp.SubPath = 'Check_in.Checked_in.Executive_suite.Dining_area';
logsout.getElement(bp)
```

The result is a `Stateflow.SimulationData.State` object:

```plaintext
Stateflow.SimulationData.State
Package: Stateflow.SimulationData
Properties:
  Name: 'Dining_Room'
  BlockPath: [1x1 Simulink.SimulationData.BlockPath]
  Values: [1x1 timeseries]
```
- To access logged activity for the service local data:

### By: Index
#### Enter:
```
logsout.getElement(2)
```

### By: Name
#### Enter:
```
logsout.getElement('service')
```
### By: Enter:

<table>
<thead>
<tr>
<th>Block path</th>
<th>logsout.getElement(2).BlockPath</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Returns:</td>
</tr>
<tr>
<td></td>
<td>• Block Path: 'sf_semantics_hotel_checkin/Hotel'</td>
</tr>
<tr>
<td></td>
<td>• SubPath: 'service'</td>
</tr>
<tr>
<td>b</td>
<td><code>bp = Simulink.BlockPath('sf_semantics_hotel_checkin/Hotel');</code></td>
</tr>
<tr>
<td>c</td>
<td><code>bp.SubPath = 'service';</code></td>
</tr>
<tr>
<td>d</td>
<td><code>logsout.getElement(bp)</code></td>
</tr>
</tbody>
</table>

The result is a `Stateflow.SimulationData.Data` object:

```
Stateflow.SimulationData.Data
Package: Stateflow.SimulationData

Properties:
  Name: 'service'
  BlockPath: [1x1 Simulink.SimulationData.BlockPath]
  Values: [1x1 timeseries]
```

The logged values for `Stateflow.SimulationData.State` and `Stateflow.SimulationData.Data` objects are stored in the `Values` property as Simulink objects of type `Timeseries`.

3. Access logged data and time through the `Values` property.

   For example:

```
<table>
<thead>
<tr>
<th>For:</th>
<th>Enter:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td><code>logsout.getElement(1).Values.Data;</code></td>
</tr>
<tr>
<td>Time</td>
<td><code>logsout.getElement(1).Values.Time;</code></td>
</tr>
</tbody>
</table>
```

4. View the logged data.

   See “View Logged Data” on page 30-58.
View Logged Data

You can view logged data in a figure window, for example, by using the plot function.

You can also view logged data in a spreadsheet. For example, pass a numeric, cell, or logical array of logged values to the xlswrite function.

Try this approach with the sf_semantics_hotel_checkin model, which uses a chart to simulate a hotel check-in process. To open the model, type sf_semantics_hotel_checkin at the MATLAB command prompt. Enable logging as described in “Configure States and Data for Logging” on page 30-49 and simulate the model.

View logged activity over time in Dataset format for the Check_in.Checked_in.Executive_suite.Dining_area state:

1. Assign logged Dining_Room time and data values to an array A:

   ```matlab
   A = [logsout.getElement('Dining_Room').Values.Time ...
       logsout.getElement('Dining_Room').Values.Data];
   ```

2. Export the data to an Excel® file named dining_log.xls:

   ```matlab
   xlswrite('dining_log.xls',A);
   ```

3. Open dining_log.xls in Excel.
Log Data in Library Charts

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“How Library Log Settings Influence Linked Instances” on page 30-59</td>
</tr>
<tr>
<td>“Override Logging Properties in Chart Instances” on page 30-59</td>
</tr>
<tr>
<td>“Override Logging Properties in Atomic Subcharts” on page 30-59</td>
</tr>
</tbody>
</table>

How Library Log Settings Influence Linked Instances

Chart instances inherit logging properties from the library chart to which they are linked. You can override logging properties in the instance, but only for signals you select in the library. You cannot select additional signals to log from the instance.

Override Logging Properties in Chart Instances

To override properties of logged signals in chart instances, use one of the following approaches.

<table>
<thead>
<tr>
<th>Approach</th>
<th>How To Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simulink Signal Logging Selector dialog box</td>
<td>See “Override Logging Properties with the Logging Selector” on page 30-59</td>
</tr>
<tr>
<td>Command-line interface</td>
<td>See “Override Logging Properties with the Command-Line API” on page 30-61</td>
</tr>
</tbody>
</table>

Override Logging Properties in Atomic Subcharts

This example uses sf_atomic_sensor_pair. This model simulates a redundant sensor pair as atomic subcharts Sensor1 and Sensor2 in the chart RedundantSensors. Each atomic subchart contains instances of the states Fail, FailOnce, and OK from the library chart sf_atomic_sensor_lib.

Override Logging Properties with the Logging Selector

1. Open the example library by typing sf_atomic_sensor_lib at the MATLAB command prompt.
Unlock the library by selecting **Diagram > Unlock Library**.

In the SingleSensor chart, select **Simulation > Output > Log Chart Signals**.

In Stateflow Signal Logging dialog box, set the following logging properties, then click **OK**.

<table>
<thead>
<tr>
<th>For Signal:</th>
<th>What to Specify:</th>
</tr>
</thead>
</table>
| Fail        | • Select the **Log signal data** check box.  
  • Change **Logging name** to the custom name LogFail.  
  • Click **Apply**. |
| FailOnce    | • Select the **Log signal data** check box.  
  • Change **Logging name** to the custom name LogFailOnce.  
  • Click **Apply**. |
| OK          | • Select the **Log signal data** check box.  
  • Change **Logging name** to the custom name LogOK.  
  • Click **Apply**. |

Open the model that contains instances of the library chart by typing **sf_atomic_sensor_pair** at the MATLAB command prompt.

Open the Model Configuration Parameters dialog box.

In the **Data Import/Export** pane, click **Configure Signals to Log** to open the Simulink Signal Logging Selector.

In the **Model Hierarchy** pane, expand **RedundantSensors**, and click **Sensor1** and **Sensor2**.

Each instance inherits logging properties from the library chart. For example:

9. Now, override some logging properties for **Sensor1**:
   
a. In the **Model Hierarchy** pane, select **Sensor1**.

b. Change **Logging Mode** to **Override signals**.

   The selector clears all **DataLogging** check boxes for the model.
Enable logging only for the Fail and FailOnce states in Sensor1:

Select DataLogging for these two signals. Leave DataLogging cleared for the OK signal.

Append the text Sensor1 to the logging names for Fail and FailOnce:

Double-click the logging names for signals Fail and FailOnce, and rename them LogFailSensor1 and LogFailOnceSensor1, respectively.

The settings should look like this:

Override Logging Properties with the Command-Line API

1 Open the example library by typing sf_atomic_sensor_lib at the MATLAB command prompt.

2 Log the signals Fail, FailOnce, and OK in the SingleSensor chart using these commands:

```matlab
% Get states in the SingleSensor chart
rt=sfroot;
states = rt.find('-isa', 'Stateflow.State');

% Enable logging for each state
for i = 1: length(states)
    states(i).LoggingInfo.DataLogging = 1;
end
```

3 Open the model that contains instances of the library chart by typing sf_atomic_sensor_pair at the MATLAB command prompt.

4 Create a ModelLoggingInfo object for the model.

This object contains a vector Signals that stores all logged signals.

```matlab
mi = Simulink.SimulationData.ModelLoggingInfo. ...
createFromModel('sf_atomic_sensor_pair')
```

The result is:
The `Signals` vector contains the signals marked for logging in the library chart:

- Library instances of `Fail`, `FailOnce`, and `OK` states in atomic subchart `Sensor1`
- Library instances of `Fail`, `FailOnce`, and `OK` states in atomic subchart `Sensor2`

5. Make sure that `LoggingMode` equals `'OverrideSignals'`.

6. Create a block path to each logged signal whose properties you want to override.

To access signals inside Stateflow charts, use `Simulink.SimulationData.BlockPath(paths, subpath)`, where `subpath` represents a signal inside the chart.

To create block paths for the signals `Fail`, `FailOnce`, and `OK` in the atomic subchart `Sensor1` in the `RedundantSensors` chart:

```plaintext
failPath = Simulink.SimulationData. ... BlockPath('sf_atomic_sensor_pair/RedundantSensors/Sensor1','Fail')

failOncePath = Simulink.SimulationData. ... BlockPath('sf_atomic_sensor_pair/RedundantSensors/Sensor1','FailOnce')

OKPath = Simulink.SimulationData. ... BlockPath('sf_atomic_sensor_pair/RedundantSensors/Sensor1','OK')
```

7. Get the index of each logged signal in the `Simulink.SimulationData.BlockPath` object.

To get the index for the signals `Fail`, `FailOnce`, and `OK`:

```plaintext
failidx = mi.findSignal(failPath);  
failOnceidx = mi.findSignal(failOncePath);  
OKidx = mi.findSignal(OKPath);  
```

8. Override some logging properties for the signals in `Sensor1`:

   a. Disable logging for signal `OK`:

      ```plaintext
      mi.Signals(OKidx).LoggingInfo.DataLogging = 0;
      ```

   b. Append the text `Sensor1` to the logging names for `Fail` and `FailOnce`:
% Enable custom naming
mi.Signals(failidx).LoggingInfo.NameMode = 1;
mi.Signals(failOnceidx).LoggingInfo.NameMode = 1;

% Enter the custom name
mi.Signals(failidx).LoggingInfo.LoggingName = 'LogFailSensor1';
mi.Signals(failOnceidx).LoggingInfo.LoggingName = 'LogFailOnceSensor1';

9 Apply the changes:
    set_param(bdroot, 'DataLoggingOverride', mi);

See Also

• Simulink.SimulationData.ModelLoggingInfo
• Simulink.SimulationData.BlockPath
How Stateflow Logs Multidimensional Data

Stateflow logs each update to a multidimensional signal as a single change. For example, an update to a 2-by-2 matrix $A$ during simulation is logged as a single change, not as four changes (one for each element):

<table>
<thead>
<tr>
<th>Update</th>
<th>Is Logged As</th>
</tr>
</thead>
<tbody>
<tr>
<td>$A = 1;$</td>
<td>A single change, even though the statement implies all $A[i] = 1$</td>
</tr>
<tr>
<td>$A[1][1] = 1;$</td>
<td>Two different changes</td>
</tr>
<tr>
<td>$A[1][2] = 1;$</td>
<td></td>
</tr>
</tbody>
</table>
Commenting Stateflow Objects in a Chart

In this section...

“Comment Out a Stateflow Object” on page 30-65
“How Commenting Affects the Chart and Model” on page 30-65
“Add Text to a Commented Object” on page 30-67
“Limitations on Commenting Objects” on page 30-67

Comment Out a Stateflow Object

Commenting out a Stateflow object excludes it from simulation. To comment out a Stateflow object, right-click the object and select Comment Out. Use commenting to:

• Debug a chart by making minor changes between simulation runs.
• Test and verify the effects of objects on simulation results.
• Create incremental changes for rapid, iterative design.

How Commenting Affects the Chart and Model

A commented object is not visible to the rest of the chart and the model. Commented objects in a chart are excluded from:

• Simulation
• Logging
• Code generation
• Animation
• Debugging
• Active state output

When a chart is parsed, references to commented functions or states result in errors.

When you explicitly comment out a Stateflow object with Comment Out, the object appears gray with a badge % . The software implicitly comments out some associated objects. Implicitly commented objects also appear gray, but do not have a badge. For example, if you explicitly comment out a state or junction, all incoming and outgoing
transitions are implicitly commented out. In the image of sf_car below, steady_state is explicitly commented. The transitions in and out of steady_state are implicitly commented.

<table>
<thead>
<tr>
<th>Explicitly Commented Stateflow Object</th>
<th>Implicit Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>States</td>
<td>All incoming and outgoing transitions, and child objects are implicitly commented out.</td>
</tr>
<tr>
<td>Transitions</td>
<td>None</td>
</tr>
<tr>
<td>Junctions</td>
<td>All connected transitions are implicitly commented out.</td>
</tr>
<tr>
<td>Functions</td>
<td>The software cannot invoke a commented function from any chart or model.</td>
</tr>
</tbody>
</table>
Explicitly Commented Stateflow Object | Implicit Results
--- | ---
Data | You cannot explicitly comment out data. If you comment out the parent object, then the software cannot reference the data.
Events | You cannot explicitly comment out events. If you comment out the parent object, then the software cannot reference the event.

To uncomment an object, right-click the commented object and select Uncomment. All implicitly commented objects are restored as well. Implicitly commented objects cannot be uncommented directly.

**Add Text to a Commented Object**

Add a note to the commented object by clicking the badge 📝. Hover your cursor over a badge to see the associated comments. You cannot add notes to implicitly commented objects.

**Limitations on Commenting Objects**

When you comment out an atomic subchart, the objects inside the chart do not appear implicitly commented. However, a commenting badge is displayed in the lower-left corner of the chart.
Explore and Modify Charts

- “Manage Stateflow Data, Events, and Messages in the Symbols Window” on page 31-2
- “Add and Modify Data, Events, and Messages in the Symbols Window” on page 31-5
- “Trace Data, Events, and Messages Through the Symbols Window” on page 31-7
- “Use the Model Explorer with Stateflow Objects” on page 31-11
- “Use the Search & Replace Tool” on page 31-17
Manage Stateflow Data, Events, and Messages in the Symbols Window

In the Symbols window, you can view and manage data, events, and messages while working in the Stateflow editor. To open the Symbols window, select View > Symbols. From the Symbols window you can:

- Add and delete data, events, and messages.
- Set the object type and scope.
- Change the port number.
- Edit the name of an object and update all instances of the object name in the chart.
- Undo and redo changes in type, name, and port number.
- Detect unused objects.
- Detect and fix unresolved objects.
- Trace between objects in the window and where the objects are used in the chart.
- View and edit object properties in the Property Inspector.
The rows in the Symbols window display object hierarchy. Expand an object in the window to see data, events, and messages parented by that object. By default, all the nongraphical objects in a chart are listed in the window. To view only the objects that are used at the current level of hierarchy and below, select the icon. To search for specific symbols, type in the Filter search box.

See Also

More About

- "Add and Modify Data, Events, and Messages in the Symbols Window” on page 31-5
- "Trace Data, Events, and Messages Through the Symbols Window” on page 31-7
• “Detect Unused Data in the Symbols Window” on page 9-5
• “Set Data Properties” on page 9-7
• “Resolve Undefined Symbols in Your Chart” on page 29-34
• “Best Practices for Using Data in Charts” on page 9-66
• “Configure Data Properties by Using the Model Data Editor” (Simulink)
Add and Modify Data, Events, and Messages in the Symbols Window

To add a nongraphical object to a Stateflow block, in the Symbols window:

1. Select one of these icons.

<table>
<thead>
<tr>
<th>Object</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data</td>
<td>![Data Icon]</td>
</tr>
<tr>
<td>Event</td>
<td>![Event Icon]</td>
</tr>
<tr>
<td>Message</td>
<td>![Message Icon]</td>
</tr>
</tbody>
</table>

2. In the row for the new object, under **TYPE**, choose the object type.
3. Edit the name of the object.
4. For input and output objects, under **PORT**, choose a port number.
5. To view the object in the Property Inspector, right-click the object and select **Inspect**.
6. In the Property Inspector, modify the object properties.

After you add objects through the Symbols window, the objects appear as unused until you reference them in your Stateflow design.

In the Symbols window, you can modify the name, type, and port number of Stateflow objects. Edit the name of objects in the **NAME** field. When you rename an object, select **Shift+Enter** to rename all instances of the object throughout the state machine. To change the type or port number of an object, click the corresponding field and select from the available options. To delete an object from the state machine, right-click the object and select **Delete**. To either undo or redo these changes, use the **Edit** menu.

**Symbols Window Limitations**

You cannot add the types of objects listed in the table via the Symbols window. To add these types of objects, use the Model Explorer. As a best practice, avoid using machine-parented data.
<table>
<thead>
<tr>
<th>Object</th>
<th>Via Symbols Window</th>
<th>Visible in Symbols Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data, events, and messages parented by a state</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Data, events, and messages inside a function</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Data and events parented by the state machine</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Additional limitations:

- When you modify the code in a MATLAB function, the changes are not updated in the Symbols window until after you save the MATLAB function.
- You cannot undo or redo changes to input and output for MATLAB functions.
- You cannot recover deleted data, events, or messages from a state transition table.
- You cannot undo scope changes to data parented by graphical functions, MATLAB functions, and truth tables.
- You cannot undo renaming an object for truth tables.
- When you delete data for objects contained in a Simulink based state, the object remains in your Simulink based state and the data symbol is shown as undefined in the Symbols window.

**See Also**

**More About**

- “Manage Stateflow Data, Events, and Messages in the Symbols Window” on page 31-2
- “Trace Data, Events, and Messages Through the Symbols Window” on page 31-7
- “Configure Data Properties by Using the Model Data Editor” (Simulink)
- “Model Editing Environment” (Simulink)
Trace Data, Events, and Messages Through the Symbols Window

Stateflow provides traceability between the state machine and nongraphical symbols. When you select a symbol in the Symbols window, Stateflow highlights sections of the chart that use that symbol. When you select an object in your chart, Stateflow highlights the symbols that the object uses.

To control when the objects and symbols are highlighted, select the preference button. A drop-down menu appears.

For Stateflow to highlight symbols in the Symbols window that an object uses, select **Highlight used symbols**. For Stateflow to highlight objects in the chart that use an symbol, select **Highlight uses on diagram**. With **Highlight uses on diagram** you can choose to highlight:

- All uses of the symbol in your chart.
- Objects from where the symbol is read.
- Objects to where the symbol is written.

For example, open the model `sf_tetris2` and double-click the chart `TetrisLogic`. In the Symbols window, when you select constant `ARENA_HEIGHT`, the states and functions that use `ARENA_HEIGHT` are highlighted. If the chart does not use an object, the symbol appears in the window with a yellow warning icon 🔄.

---

**Trace Data, Events, and Messages Through the Symbols Window**

Stateflow provides traceability between the state machine and nongraphical symbols. When you select a symbol in the Symbols window, Stateflow highlights sections of the chart that use that symbol. When you select an object in your chart, Stateflow highlights the symbols that the object uses.

To control when the objects and symbols are highlighted, select the preference button. A drop-down menu appears.

For Stateflow to highlight symbols in the Symbols window that an object uses, select **Highlight used symbols**. For Stateflow to highlight objects in the chart that use an symbol, select **Highlight uses on diagram**. With **Highlight uses on diagram** you can choose to highlight:

- All uses of the symbol in your chart.
- Objects from where the symbol is read.
- Objects to where the symbol is written.

For example, open the model `sf_tetris2` and double-click the chart `TetrisLogic`. In the Symbols window, when you select constant `ARENA_HEIGHT`, the states and functions that use `ARENA_HEIGHT` are highlighted. If the chart does not use an object, the symbol appears in the window with a yellow warning icon 🔄.
To see the uses of the constant ARENA_HEIGHT, open the function freeze.
You can also select a graphical object such as a state, transition, or function in the chart and view the symbols that the object uses. For example, in the chart TetrisLogic, expand the symbol MainArea in the Symbols window. If you select the state FreezeShape in the chart, then the local data shape and the function freeze() are highlighted in the Symbols window. This highlighting indicates that those objects are used inside the state FreezeShape.
See Also

More About

- “Detect Unused Data in the Symbols Window” on page 9-5
- “Manage Stateflow Data, Events, and Messages in the Symbols Window” on page 31-2
- “Add and Modify Data, Events, and Messages in the Symbols Window” on page 31-5
- “Resolve Undefined Symbols in Your Chart” on page 29-34
Use the Model Explorer with Stateflow Objects

<table>
<thead>
<tr>
<th>In this section...</th>
</tr>
</thead>
<tbody>
<tr>
<td>“View Stateflow Objects in the Model Explorer” on page 31-11</td>
</tr>
<tr>
<td>“Edit Chart Objects in the Model Explorer” on page 31-13</td>
</tr>
<tr>
<td>“Add Data and Events in the Model Explorer” on page 31-13</td>
</tr>
<tr>
<td>“Rename Objects in the Model Explorer” on page 31-13</td>
</tr>
<tr>
<td>“Set Properties for Chart Objects in the Model Explorer” on page 31-13</td>
</tr>
<tr>
<td>“Move and Copy Data and Events in the Model Explorer” on page 31-14</td>
</tr>
<tr>
<td>“Change the Port Order of Input and Output Data and Events” on page 31-15</td>
</tr>
<tr>
<td>“Delete Data and Events in the Model Explorer” on page 31-16</td>
</tr>
</tbody>
</table>

**View Stateflow Objects in the Model Explorer**

You can use one of these methods for opening the Model Explorer:

- In the Stateflow Editor, select **View > Model Explorer**.
- Right-click an empty area in the chart and select **Explore**.

The Model Explorer appears something like this:
The main window has two panes: a **Model Hierarchy** pane on the left and a **Contents** pane on the right. When you open the Model Explorer, the Stateflow object you are editing appears highlighted in the **Model Hierarchy** pane and its objects appear in the **Contents** pane. This example shows how the Model Explorer appears when opened from the chart.

The **Model Hierarchy** pane displays the elements of all loaded Simulink models, which includes Stateflow charts. A preceding plus (+) character for an object indicates that you can expand the display of its child objects by double-clicking the entry or by clicking the plus (+). A preceding minus (-) character for an object indicates that it has no child objects.

Clicking an entry in the **Model Hierarchy** pane selects that entry and displays its child objects in the **Contents** pane. A hypertext link to the currently selected object in the **Model Hierarchy** pane appears after the **Contents of:** label at the top of the **Contents** pane. Click this link to display that object in its native editor. In the preceding example, clicking the link `sfbus_demo/Chart` displays the contents of the chart in its editor.
Each type of object, whether in the Model Hierarchy or Contents pane, appears with an adjacent icon. Subcharted objects (states, boxes, or graphical functions) appear altered with shading.

The display of child objects in the Contents pane includes properties for each object, most of which are directly editable. You can also access the properties dialog box for an object from the Model Explorer. See “Set Properties for Chart Objects in the Model Explorer” on page 31-13 for more details.

**Edit Chart Objects in the Model Explorer**

To edit a chart object that appears in the Model Hierarchy pane of the Model Explorer:

1. Right-click the object.
2. Select Open from the context menu.

   The selected object appears highlighted in the chart.

**Add Data and Events in the Model Explorer**

To add data or events using the Model Explorer, see the following links:

- “Add Data Through the Model Explorer” on page 9-3
- “Add Events with the Model Explorer” on page 10-5

**Rename Objects in the Model Explorer**

To rename a chart object in the Model Explorer:

1. Right-click the object row in the Contents pane of the Model Explorer and select Rename.

   The name of the selected object appears in a text edit box.
2. Change the name of the object and click outside the edit box.

**Set Properties for Chart Objects in the Model Explorer**

To change the property of an object in the Contents pane of the Model Explorer:
1 In the **Contents** pane, click in the row of the displayed object.
2 Click an individual entry for a property column in the highlighted row.

- For text properties, such as the Name property, a text editing field with the current text value overlays the displayed value. Edit the field and press the **Return** key or click anywhere outside the edit field to apply the changes.
- For properties with enumerated entries, such as the Scope, Trigger, or Type properties, select from a drop-down combo box that overlays the displayed value.
- For Boolean properties (properties that are set on or off), select or clear the box that appears in place of the displayed value.

To set all the properties for an object displayed in the **Model Hierarchy** or **Contents** pane of the Model Explorer:

1 Right-click the object and select **Properties**.

   The properties dialog box for the object appears.
2 Edit the appropriate properties and click **Apply** or **OK**.

To display the properties dialog box dynamically for the selected object in the **Model Hierarchy** or **Contents** pane of the Model Explorer:

1 Select **View > Show Dialog Pane**.

   The properties dialog box for the selected object appears in the far right pane of the Model Explorer.

**Move and Copy Data and Events in the Model Explorer**

**Note** If you move an object to a level in the hierarchy that does not support the **Scope** property for that object, the **Scope** automatically changes to **Local**.

To move data and event objects to another parent:

1 Select the data or event to move in the **Contents** pane of the Model Explorer.

   You can select a contiguous block of items by highlighting the first (or last) item in the block and then using **Shift** + click for highlighting the last (or first) item.
2 Click and drag the highlighted objects from the Contents pane to a new location in the Model Hierarchy pane to change its parent.

A shadow copy of the selected objects accompanies the mouse cursor during dragging. If no parent is chosen or the parent chosen is the current parent, the mouse cursor changes to an X enclosed in a circle, indicating an invalid choice.

To cut or copy the selected data or event:

1 Select the event or data to cut or copy in the Contents pane of the Model Explorer.
2 In the Model Explorer, select Edit > Cut or Edit > Copy.

If you select Cut, the selected items are deleted and then copied to the clipboard for copying elsewhere. If you select Copy, the selected items are left unchanged.

You can also right-click a single selection and select Cut or Copy from the context menu. The Model Explorer also uses the keyboard equivalents of Ctrl+X (Cut) and Ctrl+C (Copy) on a computer running the UNIX or Windows operating system.

3 Select a new parent object in the Model Hierarchy pane of the Model Explorer.
4 Select Edit > Paste. The cut items appear in the Contents pane of the Model Explorer.

You can also paste the cut items by right-clicking an empty part of the Contents pane and selecting Paste from the context menu. The Model Explorer also uses the keyboard equivalent of Ctrl+V (Paste) on a computer running the UNIX or Windows operating system.

**Change the Port Order of Input and Output Data and Events**

Input data, output data, input events, and output events each have numerical sequences of port index numbers. You can change the order of indexing for event or data objects with a scope of Input to Simulink or Output to Simulink in the Contents pane of the Model Explorer as follows:

1 Select one of the input or output data or event objects.
2 Click the Port property for the object.
3 Enter a new value for the Port property for the object.

The remaining objects in the affected sequence are automatically assigned a new value for their Port property.
Delete Data and Events in the Model Explorer

Delete data and event objects in the Contents pane of the Model Explorer as follows:

1. Select the object.
2. Press the Delete key.

You can also select Edit > Cut or Ctrl+X from the keyboard to delete an object.
Use the Search & Replace Tool

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Open the Search &amp; Replace Tool” on page 31-17</td>
</tr>
<tr>
<td>“Refine Searches” on page 31-19</td>
</tr>
<tr>
<td>“Specify the Search Scope” on page 31-21</td>
</tr>
<tr>
<td>“Use the Search Button and View Area” on page 31-22</td>
</tr>
<tr>
<td>“Specify the Replacement Text” on page 31-25</td>
</tr>
<tr>
<td>“Use Replace Buttons” on page 31-26</td>
</tr>
<tr>
<td>“Search and Replace Messages” on page 31-26</td>
</tr>
</tbody>
</table>

Open the Search & Replace Tool

To open the Search & Replace dialog box:

1. Open a chart.
2. Select **Edit > Find & Replace in Chart**.
The Search & Replace dialog box contains the following fields:

- **Search for**
  Enter search pattern text in the Search for text box. You can select the interpretation of the search pattern with the Match case check box and the Match options field (unlabeled and just to the right of the Search in field).

- **Match case**
  If you select this check box, the search is case sensitive and the Search & Replace tool finds only text matching the search pattern exactly.

- **Replace with**
Specify the text to replace the text found when you select any of the Replace buttons (Replace, Replace all, Replace all in this object). See “Use Replace Buttons” on page 31-26.

- **Preserve case**

  This option modifies replacement text. For an understanding of this option, see “Replacing with Case Preservation” on page 31-25.

- **Search in**

  By default, the Search & Replace tool searches for and replaces text only within the current Stateflow chart that you are editing in the Stateflow Editor. You can select to search the machine owning the current Stateflow chart or any other loaded machine or chart by accessing this selection box.

- **Match options**

  This field is unlabeled and just to the right of the Search in field. You can modify the meaning of your search text by entering one of the selectable search options. See “Refine Searches” on page 31-19.

- **Object types** and **Field types**

  Under the Search in field are the selection boxes for Object types and Field types. These selections further refine your search and are described below.

- **Search** and **Replace** buttons

  These are described in “Use the Search Button and View Area” on page 31-22 and “Use Replace Buttons” on page 31-26.

- **View Area**

  The bottom half of the Search & Replace dialog box displays the result of a search. This area is described in “A Breakdown of the View Area” on page 31-24.

### Refine Searches

Enter search pattern text in the Search for text box. You can use one of the following settings to further refine the meaning of the text entered.

- **Match case**

  By selecting the Match case option, you enable case-sensitive searching. In this case, the Search & Replace tool finds only text matching the search pattern exactly.
By clearing the **Match case** option, you enable case-insensitive searching. In this case, search pattern characters entered in lower- or uppercase find matching text with the same sequence of base characters in lower- or uppercase. For example, the search entry "AnDrEw" finds the matching text "andrew" or "Andrew" or "ANDREW".

**Preserve case**

This option modifies replacement text and not search text. For details, see “Replacing with Case Preservation” on page 31-25.

**Contains word**

Select this option to specify that the search pattern text is a whole word expression used in a Stateflow chart with no specific beginning and end delimiters. In other words, find the specified text in any setting.

Suppose that you have a state with this label and entry action:

```
throt_fail
entry: fail_state[THROT] = 1;
```

Searching for the text fail with the **Contains word** option finds two occurrences of fail.

**Match whole word**

Select this option to specify that the search pattern in the **Search for** field is a whole word expression used in a Stateflow chart with beginning and end delimiters consisting of a blank space or a character that is not alphanumeric and not an underscore character (_).

In the previous example of a state named throt_fail, if **Match whole word** is selected, searching for fail finds no text within that state. However, searching for "fail_state" does find the text "fail_state" as part of the second line since it is delimited by a space at the beginning and a left square bracket ([) at the end.

**Regular expression**

Set the **Match options** field to **Regular expression** to search for text that varies from character to character within defined limits.

A regular expression is text composed of letters, numbers, and special symbols that defines one or more candidates. Some characters have special meaning when used in a
regular expression, while other characters are interpreted as themselves. Any other character appearing in a regular expression is ordinary, unless a back slash (\) character precedes it.

If the **Match options** field is set to **Regular expression** in the previous example of a state named `throt_fail`, searching for "fail_" matches the "fail_" text that is part of the second line, character for character. Searching with the regular expression "\w*\_" also finds the text "fail_". This search uses the regular expression shorthand "\w" that represents any part-of-word character, an asterisk (*) that represents any number of any characters, and an underscore (_) that represents itself.

For a list of regular expression meta characters, see “Regular Expressions” (MATLAB).

**Specify the Search Scope**

You specify the scope of your search by selecting from the field regions discussed in the topics that follow.

**Search in**

You can select a whole machine or individual chart for searching in the **Search in** field. By default, the current chart in which you opened the Search & Replace tool is selected.

To select a machine, follow these steps:

1. Select the down arrow of the **Search in** field.
   
   A list of the currently loaded machines appears with the current machine expanded to reveal its Stateflow charts.

2. Select a machine.

To select a Stateflow chart for searching, follow these steps:

1. Select the down arrow of the **Search in** field again.
   
   This list contains the previously selected machine expanded to reveal its Stateflow charts.

2. Select a chart from the expanded machine.

**Object Types**

Limit your search by deselecting one or more object types.
**Note** You cannot search in state transition tables with this tool.

**Field Types**

Limit your search by deselecting one or more field types.

Available field types are as follows.

**Names**

Machines, charts, data, and events have valid Name fields. States have a Name defined as the top line of their labels. You can search and replace text belonging to the Name field of a state in this sense. However, if the Search & Replace tool finds matching text in a state's Name field, the rest of the label is subject to later searches for the specified text whether or not the label is chosen as a search target.

**Note** The Name field of machines and charts is an invalid target for the Search & Replace tool. Use the Simulink model window to change the names of machines and charts.

**Labels**

Only states and transitions have labels.

**Descriptions**

All objects have searchable Description fields.

**Document links**

All objects have searchable Link fields.

**Use the Search Button and View Area**

This topic contains the following subtopics:

- “A Breakdown of the View Area” on page 31-24
- “The Search Order” on page 31-24

Click **Search** to initiate a single-search operation. If an object match is made, its text fields appear in the **Viewer** pane in the middle of the Search & Replace dialog box. If the
object is graphical (state, transition, junction, chart), the matching object appears highlighted in a Portal pane below the Viewer pane.
A Breakdown of the View Area

The view area of the Search & Replace dialog box displays matching text and its containing object, if viewable. In the previous example, taken from the sf_pool model, a search for the word "friction" finds the **Description** field for the state **TotalDynamics**. The resulting view area consists of these parts:

**Icon**

Displays an icon appropriate to the object containing the matching text. These icons are identical to the icons in the Model Explorer that represent Stateflow objects displayed in “View Stateflow Objects in the Model Explorer” on page 31-11.

**Full Path Name of Containing Object**

This area displays the full path name for the object that contains the matching text:

\[
(<\text{type}>) <\text{machine name}>/<\text{subsystem}>/<\text{chart name}>.[p_1]...[p_n].<\text{object name}> (<\text{id}>)
\]

where \( p_1 \) through \( p_n \) denote the object's parent states.

**Viewer**

This area displays the matching text as a highlighted part of all search-qualified text fields for the owner object. If other occurrences exist in these fields, they too are highlighted, but in lighter shades.

To invoke the properties dialog box for the owner object, double-click anywhere in the Viewer pane.

**Portal**

This area contains a graphic display of the object that contains the matching text. That object appears highlighted.

To display the highlighted object in the Stateflow Editor, double-click anywhere in the Portal pane.

**The Search Order**

If you specify an entire machine as your search scope in the **Search in** field, the Search & Replace tool starts searching at the beginning of the first chart of the model, regardless of the Stateflow chart that appears in the Stateflow Editor when you begin your search.
After searching the first chart, the Search & Replace tool continues searching each chart in model order until all charts for the model have been searched.

If you specify a Stateflow chart as your search scope, the Search & Replace tool begins searching at the beginning of the chart. The Search & Replace tool continues searching the chart until all the chart objects have been searched.

The search order when searching an individual chart for matching text is equivalent to a depth-first search of the Model Explorer. Starting at the highest level of the chart, the Model Explorer hierarchy is traversed downward from parent to child until an object with no child is encountered. At this point, the hierarchy is traversed upward through objects already searched until an unsearched sibling is found and the process repeats.

**Specify the Replacement Text**

The Search & Replace tool replaces matching text with the exact (case-sensitive) text you entered in the **Replace With** field unless you selected the **Preserve case** option.

**Replacing with Case Preservation**

If you choose the **Preserve case** option, matching text is replaced based on one of these conditions:

- **Whisper**

  Matching text has only lowercase characters. Matching text is replaced entirely with the lowercase equivalent of all replacement characters. For example, if the replacement text is "ANDREW", the matching text "bill" is replaced by "andrew".

- **Shout**

  Matching text has only uppercase characters. Matching text is replaced entirely with the uppercase equivalent of all replacement characters. For example, if the replacement text is "Andrew", the matching text "BILL" is replaced by "ANDREW".

- **Proper**

  Matching text has uppercase characters in the first character position of each word. Matching text is replaced entirely with the case equivalent of all replacement characters. For example, if the replacement text is "andrew johnson", the matching text "Bill Monroe" is replaced by "Andrew Johnson".

- **Sentence**
Matching text has an uppercase character in the first character position of a sentence with all other sentence characters in lowercase. Matching text is replaced in like manner, with the first character of the sentence given an uppercase equivalent and all other sentence characters set to lowercase. For example, if the replacement text is "andrew is tall.", the matching text "Bill is tall." is replaced by "Andrew is tall.".

If the matching text does not follow any of these patterns, then the text and case replacement match the user input.

**Use Replace Buttons**

You can activate the replace buttons (Replace, Replace all, Replace all in this object) only after a search that finds text.

**Replace**

When you select the Replace button, the current instance of text matching the text in the Search for field is replaced by the text you entered in the Replace with field. The Search & Replace tool then searches for the next occurrence of the Search for text.

**Replace all**

When you select the Replace all button, all instances of text matching the Search for field are replaced by the text entered in the Replace with field. Replacement starts at the point of invocation to the end of the current Stateflow chart. If you initially skip through some search matches with the Search button, these matches are also skipped when you select the Replace all button.

**Replace all in this object**

When you select the Replace all in this object button, all instances of text matching the Search for field are replaced by text you entered in the Replace with field everywhere in the current Stateflow object regardless of previous searches.

**Search and Replace Messages**

Informational and warning messages appear in the Full Path Name Containing Object field along with a defining icon.
- Warnings

The following messages are informational:

**Please specify a search string**

A search was attempted without search text specified.

**No Matches Found**

No matches exist in the selected search scope.

**Search Completed**

No more matches exist in the selected search scope.

The following warnings refer to invalid conditions for searching or replacing:

**Invalid option set**

The object types and field types that you selected are incompatible.

**Match object not currently editable**

The matching object is not editable by replacement due to one of these problems.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>A simulation is running.</td>
<td>Stop the simulation.</td>
</tr>
<tr>
<td>You are editing a locked library block.</td>
<td>Unlock the library.</td>
</tr>
<tr>
<td>The current object or its parent has been</td>
<td>Unlock the object or its parent.</td>
</tr>
<tr>
<td>manually locked.</td>
<td></td>
</tr>
</tbody>
</table>

The following warnings appear if the Search & Replace tool must find the object again and its matching text field. If the original matching object is deleted or changed before an ensuing search or replacement, the Search & Replace tool cannot continue.

**Search object not found**

If you search for text, find it, and then delete the containing object, this warning appears if you continue to search.
**Match object not found**

If you search for text, find it, and then delete the containing object, this warning appears if you perform a replacement.

**Match not found**

If you search for text, find it, and then change the object containing the text, this warning appears if you perform a replacement.

**Search string changed**

If you search for text, find it, and then change the **Search For** field, this warning appears if you perform a replacement.
Semantic Rules Summary
Summary of Chart Semantic Rules

<table>
<thead>
<tr>
<th>In this section...</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>“Enter a Chart” on page A-2</td>
<td></td>
</tr>
<tr>
<td>“Execute an Active Chart” on page A-2</td>
<td></td>
</tr>
<tr>
<td>“Enter a State” on page A-2</td>
<td></td>
</tr>
<tr>
<td>“Execute an Active State” on page A-3</td>
<td></td>
</tr>
<tr>
<td>“Exit an Active State” on page A-3</td>
<td></td>
</tr>
<tr>
<td>“Execute a Set of Flow Charts” on page A-4</td>
<td></td>
</tr>
<tr>
<td>“Execute an Event Broadcast” on page A-5</td>
<td></td>
</tr>
</tbody>
</table>

Enter a Chart

The set of default flow paths execute (see “Execute a Set of Flow Charts” on page A-4). If this action does not cause a state entry and the chart has parallel decomposition, then each parallel state becomes active (see “Enter a State” on page A-2).

If executing the default flow paths does not cause state entry, a state inconsistency error occurs.

Execute an Active Chart

If the chart has no states, each execution is equivalent to initializing a chart. Otherwise, the active children execute. Parallel states execute in the same order that they become active.

Enter a State

1. If the parent of the state is not active, perform steps 1 through 4 for the parent.
2. If this state is a parallel state, check that all siblings with a higher (that is, earlier) entry order are active. If not, perform steps 1 through 5 for these states first.

Parallel (AND) states are ordered for entry based on whether you use explicit ordering (default) or implicit ordering. For details, see “Explicit Ordering of Parallel States” on page 3-90 and “Implicit Ordering of Parallel States” on page 3-91.
3 Mark the state active.
4 Perform any entry actions.
5 Enter children, if needed:
   a If the state contains a history junction and there was an active child of this state at some point after the most recent chart initialization, perform the entry actions for that child. Otherwise, execute the default flow paths for the state.
   b If this state has children that are parallel states (parallel decomposition), perform entry steps 1 through 5 for each state according to its entry order.
   c If this state has only one child substate, the substate becomes active when the parent becomes active, regardless of whether a default transition is present. Entering the parent state automatically makes the substate active. The presence of any inner transition has no effect on determining the active substate.
6 If this state is a parallel state, perform all entry steps for the sibling state next in entry order if one exists.
7 If the transition path parent is not the same as the parent of the current state, perform entry steps 6 and 7 for the immediate parent of this state.

**Execute an Active State**

1 The set of outer flow charts execute (see “Execute a Set of Flow Charts” on page A-4). If this action causes a state transition, execution stops. (Note that this step never occurs for parallel states.)
2 During actions and valid on-event actions are performed.
3 The set of inner flow charts execute. If this action does not cause a state transition, the active children execute, starting at step 1. Parallel states execute in the same order that they become active.

**Exit an Active State**

1 If this is a parallel state, make sure that all sibling states that became active after this state have already become inactive. Otherwise, perform all exiting steps on those sibling states.
2 If there are any active children, perform the exit steps on these states in the reverse order that they became active.
3 Perform any exit actions.
4  Mark the state as inactive.

**Execute a Set of Flow Charts**

Flow charts execute by starting at step 1 below with a set of starting transitions. The starting transitions for inner flow charts are all transition segments that originate on the respective state and reside entirely within that state. The starting transitions for outer flow charts are all transition segments that originate on the respective state but reside at least partially outside that state. The starting transitions for default flow charts are all default transition segments that have starting points with the same parent:

1  Ordering of a set of transition segments occurs.

2  While there are remaining segments to test, testing a segment for validity occurs. If the segment is invalid, testing of the next segment occurs. If the segment is valid, execution depends on the destination:

   **States**

   a  Testing of transition segments stops and a transition path forms by backing up and including the transition segment from each preceding junction until the respective starting transition.

   b  The states that are the immediate children of the parent of the transition path exit (see “Exit an Active State” on page A-3).

   c  The transition action from the final transition path executes.

   d  The destination state becomes active (see “Enter a State” on page A-2).

**Junctions with no outgoing transition segments**

Testing stops without any state exits or entries.

**Junctions with outgoing transition segments**

Step 1 is repeated with the set of outgoing segments from the junction.

3  After testing all outgoing transition segments at a junction, backtrack the incoming transition segment that brought you to the junction and continue at step 2, starting with the next transition segment after the backtrack segment. The set of flow charts finishes execution when testing of all starting transitions is complete.
Execute an Event Broadcast

Output edge-trigger event execution is equivalent to changing the value of an output data value. All other events have the following execution:

1. If the receiver of the event is active, then it executes (see “Execute an Active Chart” on page A-2 and “Execute an Active State” on page A-3). (The event receiver is the parent of the event unless a direct event broadcast occurs using the send() function.)

   If the receiver of the event is not active, nothing happens.

2. After broadcasting the event, the broadcaster performs early return logic based on the type of action statement that caused the event.

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Early Return Logic</th>
</tr>
</thead>
<tbody>
<tr>
<td>State Entry</td>
<td>If the state is no longer active at the end of the event broadcast, any remaining steps in entering a state do not occur.</td>
</tr>
<tr>
<td>State Exit</td>
<td>If the state is no longer active at the end of the event broadcast, any remaining exit actions and steps in state transitioning do not occur.</td>
</tr>
<tr>
<td>State During</td>
<td>If the state is no longer active at the end of the event broadcast, any remaining steps in executing an active state do not occur.</td>
</tr>
<tr>
<td>Condition</td>
<td>If the origin state of the inner or outer flow chart or parent state of the default flow chart is no longer active at the end of the event broadcast, the remaining steps in the execution of the set of flow charts do not occur.</td>
</tr>
<tr>
<td>Transition</td>
<td>If the parent of the transition path is not active or if that parent has an active child, the remaining transition actions and state entry do not occur.</td>
</tr>
</tbody>
</table>
Semantic Examples
Categories of Semantic Examples

The following examples show the detailed semantics (behavior) of Stateflow charts.

“Transition to and from Exclusive (OR) States” on page B-4
  • “Transition from State to State with Events” on page B-5
  • “Transition from a Substate to a Substate with Events” on page B-8

“Control Chart Execution Using Condition Actions” on page B-10
  • “Condition Action Behavior” on page B-10
  • “Condition and Transition Action Behavior” on page B-11
  • “Create Condition Actions Using a For-Loop” on page B-12
  • “Broadcast Events to Parallel (AND) States Using Condition Actions” on page B-13
  • “Avoid Cyclic Behavior” on page B-14

“Control Chart Execution Using Default Transitions” on page B-16
  • “Default Transition in Exclusive (OR) Decomposition” on page B-16
  • “Default Transition to a Junction” on page B-17
  • “Default Transition and a History Junction” on page B-18
  • “Labeled Default Transitions” on page B-19

“Process Events Using Inner Transitions” on page B-22
  • “Process One Event in an Exclusive (OR) State” on page B-22
  • “Process a Second Event in an Exclusive (OR) State” on page B-23
  • “Process a Third Event in an Exclusive (OR) State” on page B-24
  • “Process the First Event with an Inner Transition to a Connective Junction” on page B-25
  • “Process a Second Event with an Inner Transition to a Connective Junction” on page B-26
  • “Inner Transition to a History Junction” on page B-27

“Use Connective Junctions to Represent Multiple Paths” on page B-29
• “If-Then-Else Decision Construct” on page B-30
• “Self-Loop Transition” on page B-31
• “For-Loop Construct” on page B-32
• “Flow Chart Notation” on page B-34
• “Transition from a Common Source to Multiple Destinations” on page B-35
• “Transition from Multiple Sources to a Common Destination” on page B-38
• “Transition from a Source to a Destination Based on a Common Event” on page B-39
• “Control Chart Execution Using Event Actions in a Superstate” on page B-42
• “Broadcast Events in Parallel (AND) States” on page B-43
  • “Broadcast Events in Parallel States” on page B-43
  • “Broadcast Events in a Transition Action with a Nested Event Broadcast” on page B-45
  • “Broadcast Condition Action Event in Parallel State” on page B-48
• “Directly Broadcast Events” on page B-52
  • “Directed Event Broadcast Using Send” on page B-52
  • “Directed Event Broadcast Using Qualified Event Name” on page B-53
Transition to and from Exclusive (OR) States

Label Format for a State-to-State Transition

The following example shows the general label format for a transition entering a state.

A chart executes this transition as follows:

1. When an event occurs, state S1 checks for an outgoing transition with a matching event specified.
2. If a transition with a matching event is found, the condition for that transition ([condition]) is evaluated.
3. If the condition is true, condition_action is executed.
4. If there is a valid transition to the destination state, the transition is taken.
5. State S1 is exited.
6. The transition_action is executed when the transition is taken.
7. State S2 is entered.
Transition from State to State with Events

The following example shows the behavior of a simple transition focusing on the implications of whether states are active or inactive.

Process a First Event

Initially, the chart is asleep. State On and state Off are OR states. State On is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. A valid transition from state On to state Off is detected.
2. State On exit actions (exitOn()) execute and complete.
3. State On is marked inactive.
4. The event E_one is broadcast as the transition action.

This second event E_one is processed, but because neither state is active, it has no effect. If the second broadcast of E_one resulted in a valid transition, it would preempt the processing of the first broadcast of E_one. See “Early Return Logic for Event Broadcasts” on page 3-97.

5. State Off is marked active.
6. State Off entry actions (entOff()) execute and complete.
The chart goes back to sleep.

This sequence completes the execution of the Stateflow chart associated with event E_one when state Off is initially active.

**Process a Second Event**

Using the same example, what happens when the next event, E_one, occurs while state Off is active?

Initially, the chart is asleep. State Off is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one.
   
   A valid transition from state Off to state On is detected.

2. State Off exit actions (exitOff()) execute and complete.

3. State Off is marked inactive.

4. State On is marked active.

5. State On entry actions (entOn()) execute and complete.

6. The chart goes back to sleep.

This sequence completes the execution of the Stateflow chart associated with the second event E_one when state Off is initially active.
Process a Third Event

Using the same example, what happens when a third event, E_two, occurs?

Notice that the event E_two is not used explicitly in this example. However, its occurrence (or the occurrence of any event) does result in behavior. Initially, the chart is asleep and state On is active.

1. Event E_two occurs and awakens the chart.

   Event E_two is processed from the root of the chart down through the hierarchy of the chart.

2. The chart root checks to see if there is a valid transition as a result of E_two. There is none.

3. State On during actions (durOn()) execute and complete.

4. The chart goes back to sleep.

This sequence completes the execution of the Stateflow chart associated with event E_two when state On is initially active.

**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the `send` operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.
You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the Diagnostics > Stateflow pane and set the Undirected event broadcasts diagnostic to none, warning, or error. The default setting is warning.

**Transition from a Substate to a Substate with Events**

This example shows the behavior of a transition from an OR substate to an OR substate.

Initially, the chart is asleep. State A.A1 is active. Condition C_one is true. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. There is a valid transition from state A.A1 to state B.B1. (Condition C_one is true.)
2. State A during actions (durA()) execute and complete.
4. State A.A1 is marked inactive.
5. State A exit actions (exitA()) execute and complete.
6. State A is marked inactive.
7. The transition action, A, is executed and completed.
8. State B is marked active.
9. State B entry actions (entB()) execute and complete.
10. State B.B1 is marked active.
11 State B.B1 entry actions (entB1()) execute and complete.
12 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one.
Control Chart Execution Using Condition Actions

In this section...

“Condition Action Behavior” on page B-10
“Condition and Transition Action Behavior” on page B-11
“Create Condition Actions Using a For-Loop” on page B-12
“Broadcast Events to Parallel (AND) States Using Condition Actions” on page B-13
“Avoid Cyclic Behavior” on page B-14

Condition Action Behavior

This example shows the behavior of a simple condition action in a transition path with multiple segments. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A is active. Conditions C_one and C_two are false. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. A valid transition segment from state A to a connective junction is detected. The condition action A_one is detected on the valid transition segment and is immediately executed and completed. State A is still active.
2 Because the conditions on the transition segments to possible destinations are false, none of the complete transitions is valid.
3 State A during actions (durA()) execute and complete.
   State A remains active.
4 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one when state A is initially active.

**Condition and Transition Action Behavior**

This example shows the behavior of a simple condition and transition action specified on a transition from one exclusive (OR) state to another.

Initially, the chart is asleep. State A is active. Condition C_one is true. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1 The chart root checks to see if there is a valid transition as a result of E_one. A valid transition from state A to state B is detected. The condition C_one is true. The condition action A_one is detected on the valid transition and is immediately executed and completed. State A is still active.
2 State A exit actions (exitA()) execute and complete.
3 State A is marked inactive.
4 The transition action $A_{\text{two}}$ is executed and completed.
5 State B is marked active.
6 State B entry actions ($\text{entB()}$) execute and complete.
7 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event $E_{\text{one}}$ when state A is initially active.

**Create Condition Actions Using a For-Loop**

Condition actions and connective junctions are used to design a for loop construct. This example shows the use of a condition action and connective junction to create a for loop construct. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

See “For-Loop Construct” on page B-32 to see the behavior of this example.
Broadcast Events to Parallel (AND) States Using Condition Actions

This example shows how to use condition actions to broadcast events immediately to parallel (AND) states. The chart uses implicit ordering of parallel states (see “Implicit Ordering of Parallel States” on page 3-91).

See “Broadcast Condition Action Event in Parallel State” on page B-48 to see the behavior of this example.

**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the `send` operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.
You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the Diagnostics > Stateflow pane and set the Undirected event broadcasts diagnostic to none, warning, or error. The default setting is warning.

Avoid Cyclic Behavior

This example shows a notation to avoid when using event broadcasts as condition actions because the semantics results in cyclic behavior.

Initially, the chart is asleep. State On is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one.

   A valid transition from state On to state Off is detected.

2. The condition action on the transition broadcasts event E_one.

3. Event E_one is detected on the valid transition, which is immediately executed. State On is still active.

4. The broadcast of event E_one awakens the chart a second time.

5. Go to step 1.

Steps 1 through 5 continue to execute in a cyclical manner. The transition label indicating a trigger on the same event as the condition action broadcast event results in unrecoverable cyclic behavior. This sequence never completes when event E_one is broadcast and state On is active.

Tip Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the send operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.
You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the **Diagnostics > Stateflow** pane and set the **Undirected event broadcasts** diagnostic to none, warning, or error. The default setting is warning.
Control Chart Execution Using Default Transitions

In this section...

| “Default Transition in Exclusive (OR) Decomposition” on page B-16 |
| “Default Transition to a Junction” on page B-17 |
| “Default Transition and a History Junction” on page B-18 |
| “Labeled Default Transitions” on page B-19 |

Default Transition in Exclusive (OR) Decomposition

This example shows a transition from an OR state to a superstate with exclusive (OR) decomposition, where a default transition to a substate is defined.

Initially, the chart is asleep. State A is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. There is a valid transition from state A to superstate B.
2. State A exit actions (exitA()) execute and complete.
3. State A is marked inactive.
4. The transition action, A, is executed and completed.
5. State B is marked active.
State B entry actions (entB()) execute and complete.

State B detects a valid default transition to state B.B1.

State B.B1 is marked active.

State B.B1 entry actions (entB1()) execute and complete.

The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one when state A is initially active.

**Default Transition to a Junction**

The following example shows the behavior of a default transition to a connective junction. The default transition to the junction is valid only when state B is first entered, not every time the chart wakes up.

---

For this example, initially, the chart is asleep. State B.B1 is active. Condition [C_two] is true. An event occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. State B checks to see if there is a valid transition as a result of any event. There is none.
2. State B during actions (durB()) execute and complete.
3. State B1 checks to see if there is a valid transition as a result of any event. There is none.
4. State B1 during actions (durB1()) execute and complete.
This sequence completes the execution of this Stateflow chart associated with the occurrence of any event.

**Default Transition and a History Junction**

This example shows the behavior of a superstate with a default transition and a history junction. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A is active. A history junction records the fact that state B4 is the previously active substate of superstate B. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one.

   There is a valid transition from state A to superstate B.
State A exit actions (exitA()) execute and complete.
State A is marked inactive.
State B is marked active.
State B entry actions (entB()) execute and complete.
State B uses the history junction to determine the substate destination of the transition into the superstate.

The history junction indicates that substate B.B4 was the last active substate, which becomes the destination of the transition.

State B.B4 is marked active.
State B.B4 entry actions (entB4()) execute and complete.
The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one.

**Labeled Default Transitions**

This example shows the use of a default transition with a label. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
Initially, the chart is asleep. State A is active. Event $E_{\text{one}}$ occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of $E_{\text{one}}$.

   There is a valid transition from state A to superstate B. The transition is valid if event $E_{\text{one}}$ or $E_{\text{two}}$ occurs.

2. State A exit actions execute and complete ($\text{exitA()}$).

3. State A is marked inactive.

4. State B is marked active.

5. State B entry actions execute and complete ($\text{entB()}$).

6. State B detects a valid default transition to state B.B1. The default transition is valid as a result of $E_{\text{one}}$.

7. State B.B1 is marked active.

8. State B.B1 entry actions execute and complete ($\text{entB1()}$).
9 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one when state A is initially active.
Process Events Using Inner Transitions

In this section...

“Process Events with an Inner Transition in an Exclusive (OR) State” on page B-22
“Process Events with an Inner Transition to a Connective Junction” on page B-25
“Inner Transition to a History Junction” on page B-27

Process Events with an Inner Transition in an Exclusive (OR) State

This example shows what happens when processing three events using an inner transition in an exclusive (OR) state.

Process One Event in an Exclusive (OR) State

This example shows the behavior of an inner transition. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A is active. Condition [C_one] is false. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1  The chart root checks to see if there is a valid transition as a result of E_one. A potentially valid transition from state A to state B is detected. However, the transition is not valid, because [C_one] is false.
2  State A during actions (durA()) execute and complete.
3  State A checks its children for a valid transition and detects a valid inner transition.
4 State A remains active. The inner transition action $A_{\text{two}}$ is executed and completed. Because it is an inner transition, state A's exit and entry actions are not executed.

5 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event $E_{\text{one}}$.

**Process a Second Event in an Exclusive (OR) State**

Using the previous example, this example shows what happens when a second event $E_{\text{one}}$ occurs. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A is still active. Condition $[C_{\text{one}}]$ is true. Event $E_{\text{one}}$ occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1 The chart root checks to see if there is a valid transition as a result of $E_{\text{one}}$.

   The transition from state A to state B is now valid because $[C_{\text{one}}]$ is true.

2 State A exit actions ($\text{exitA()}$) execute and complete.

3 State A is marked inactive.

4 The transition action $A_{\text{one}}$ is executed and completed.

5 State B is marked active.

6 State B entry actions ($\text{entB()}$) execute and complete.

7 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event $E_{\text{one}}$. 
Process a Third Event in an Exclusive (OR) State

Using the previous example, this example shows what happens when a third event, $E_{\text{two}}$, occurs. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State B is now active. Condition $[C_{\text{two}}]$ is false. Event $E_{\text{two}}$ occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of $E_{\text{two}}$.
   
   A potentially valid transition from state B to state A is detected. The transition is not valid because $[C_{\text{two}}]$ is false. However, active state B has a valid self-loop transition.

2. State B exit actions (exitB()) execute and complete.
3. State B is marked inactive.
4. The self-loop transition action, $A_{\text{four}}$, executes and completes.
5. State B is marked active.
6. State B entry actions (entB()) execute and complete.
7. The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event $E_{\text{two}}$. This example shows the difference in behavior between inner and self-loop transitions.
Process Events with an Inner Transition to a Connective Junction

This example shows the behavior of handling repeated events using an inner transition to a connective junction.

Process the First Event with an Inner Transition to a Connective Junction

This example shows the behavior of an inner transition to a connective junction for the first event. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A1 is active. Condition [C_two] is true. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition at the root level as a result of E_one. There is no valid transition.
2. State A during actions (durA()) execute and complete.
3. State A checks itself for valid transitions and detects that there is a valid inner transition to a connective junction.

The conditions are evaluated to determine whether one of the transitions is valid. Because implicit ordering applies, the segments labeled with a condition are
evaluated before the unlabeled segment. The evaluation starts from a 12 o'clock position on the junction and progresses in a clockwise manner. Because \([C_two]\) is true, the inner transition to the junction and then to state A.A2 is valid.

4 State A.A1 exit actions (exitA1()) execute and complete.
5 State A.A1 is marked inactive.
6 State A.A2 is marked active.
7 State A.A2 entry actions (entA2()) execute and complete.
8 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one when state A1 is active and condition \([C_two]\) is true.

**Process a Second Event with an Inner Transition to a Connective Junction**

Continuing the previous example, this example shows the behavior of an inner transition to a junction when a second event E_one occurs. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

![Diagram](image)

Initially, the chart is asleep. State A2 is active. Condition \([C_two]\) is true. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1 The chart root checks to see if there is a valid transition at the root level as a result of E_one. There is no valid transition.
2 State A during actions (durA()) execute and complete.
3 State A checks itself for valid transitions and detects a valid inner transition to a connective junction.

The conditions are evaluated to determine whether one of the transitions is valid. Because implicit ordering applies, the segments labeled with a condition are evaluated before the unlabeled segment. The evaluation starts from a 12 o'clock position on the junction and progresses in a clockwise manner. Because [C_two] is true, the inner transition to the junction and then to state A.A2 is valid.

4 State A.A2 exit actions (exitA2()) execute and complete.
5 State A.A2 is marked inactive.
6 State A.A2 is marked active.
7 State A.A2 entry actions (entA2()) execute and complete.
8 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one when state A2 is active and condition [C_two] is true. For a state with a valid inner transition, an active substate can be exited and reentered immediately.

**Inner Transition to a History Junction**

This example shows the behavior of an inner transition to a history junction.

Initially, the chart is asleep. State A.A1 is active. History information exists because superstate A is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:
The chart root checks to see if there is a valid transition as a result of \textit{E\_one}. There is no valid transition.

State A during actions execute and complete.

State A checks itself for valid transitions and detects that there is a valid inner transition to a history junction. Based on the history information, the last active state, A\_A1, is the destination state.

State A\_A1 exit actions execute and complete.

State A\_A1 is marked inactive.

State A\_A1 is marked active.

State A\_A1 entry actions execute and complete.

The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event \textit{E\_one} when there is an inner transition to a history junction and state A\_A1 is active. For a state with a valid inner transition, an active substate can be exited and reentered immediately.
Use Connective Junctions to Represent Multiple Paths

In this section...

“Label Format for Transition Segments” on page B-29
“If-Then-Else Decision Construct” on page B-30
“Self-Loop Transition” on page B-31
“For-Loop Construct” on page B-32
“Flow Chart Notation” on page B-34
“Transition from a Common Source to Multiple Destinations” on page B-35
“Resolve Equally Valid Transition Paths” on page B-36
“Transition from Multiple Sources to a Common Destination” on page B-38
“Transition from a Source to a Destination Based on a Common Event” on page B-39
“Backtrack in Flow Charts” on page B-39

Label Format for Transition Segments

The label format for a transition segment entering a junction is the same as for transitions entering states, as shown in the following example. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Execution of a transition in this example occurs as follows:
1 When an event occurs, state S1 is checked for an outgoing transition with a matching event specified.
2 If a transition with a matching event is found, the transition condition for that transition (in brackets) is evaluated.
3 If condition_1 evaluates to true, the condition action condition_action (in braces) is executed.
4 The outgoing transitions from the junction are checked for a valid transition. Since condition_2 is true, a valid state-to-state transition from S1 to S2 exists.
5 State S1 exit actions execute and complete.
6 State S1 is marked inactive.
7 The transition action transition_action executes and completes.
8 The completed state-to-state transition from S1 to S2 occurs.
9 State S2 is marked active.
10 State S2 entry actions execute and complete.

**If-Then-Else Decision Construct**

This example shows the behavior of an if-then-else decision construct. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A is active. Condition [C_two] is true. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:
1 The chart root checks to see if there is a valid transition as a result of \( E_{\text{one}} \). A valid transition segment from state \( A \) to the connective junction exists. Because implicit ordering applies, the transition segments beginning from a 12 o'clock position on the connective junction are evaluated for validity. The first transition segment, labeled with condition \([C_{\text{one}}]\), is not valid. The next transition segment, labeled with the condition \([C_{\text{two}}]\), is valid. The complete transition from state \( A \) to state \( C \) is valid.

2 State \( A \) exit actions \((\text{exit}\text{A}())\) execute and complete.

3 State \( A \) is marked inactive.

4 State \( C \) is marked active.

5 State \( C \) entry actions \((\text{ent}\text{C}())\) execute and complete.

6 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event \( E_{\text{one}} \).

**Self-Loop Transition**

This example shows the behavior of a self-loop transition using a connective junction. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
Initially, the chart is asleep. State A is active. Condition \([C_{\text{one}}]\) is false. Event \(E_{\text{one}}\) occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of \(E_{\text{one}}\). A valid transition segment from state A to the connective junction exists. Because implicit ordering applies, the transition segment labeled with a condition is evaluated for validity. Because the condition \([C_{\text{one}}]\) is not valid, the complete transition from state A to state B is not valid. The transition segment from the connective junction back to state A is valid.
2. State A exit actions (\texttt{exitA()}) execute and complete.
3. State A is marked inactive.
4. The transition action \(A_{\text{two}}\) is executed and completed.
5. State A is marked active.
6. State A entry actions (\texttt{entA()}) execute and complete.
7. The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event \(E_{\text{one}}\).

**For-Loop Construct**

This example shows the behavior of a for loop using a connective junction. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
Initially, the chart is asleep. State A is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. There is a valid transition segment from state A to the connective junction. The transition segment condition action, \( i = 0 \), executes and completes. Of the two transition segments leaving the connective junction, the transition segment that is a self-loop back to the connective junction evaluates next for validity. That segment takes priority in evaluation because it has a condition, whereas the other segment is unlabeled. This evaluation behavior reflects implicit ordering of outgoing transitions in the chart.

2. The condition \([i < 10]\) evaluates as true. The condition actions \(i++\) and a call to \(\text{func1}\) execute and complete until the condition becomes false. Because a connective junction is not a final destination, the transition destination is still unknown.

3. The unconditional segment to state B is now valid. The complete transition from state A to state B is valid.

4. State A exit actions (exitA()) execute and complete.

5. State A is marked inactive.
6 State B is marked active.
7 State B entry actions (entB()) execute and complete.
8 The chart goes back to sleep.

This sequence completes the execution of this chart associated with event E_one.

**Flow Chart Notation**

This example shows the behavior of a Stateflow chart that uses flow chart notation. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).

Initially, the chart is asleep. State A.A1 is active. The condition \([C\_one()]\) is initially true. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. There is no valid transition.
2. State A checks itself for valid transitions and detects a valid inner transition to a connective junction.
3. The next possible segments of the transition are evaluated. Only one outgoing transition exists, and it has a condition action defined. The condition action executes and completes.
The next possible segments are evaluated. Two outgoing transitions exist: a conditional self-loop transition and an unconditional transition segment. Because implicit ordering applies, the conditional transition segment takes precedence. Since the condition \( C_{\text{one}}() \) is true, the self-loop transition is taken. Since a final transition destination has not been reached, this self-loop continues until \( C_{\text{one}}() \) is false.

Assume that after five iterations, \( C_{\text{one}}() \) is false.

The next possible transition segment (to the next connective junction) is evaluated. It is an unconditional transition segment with a condition action. The transition segment is taken and the condition action, \{d=my\_func()\}, executes and completes. The returned value of \( d \) is 84.

The next possible transition segment is evaluated. Three outgoing transition segments exist: two conditional and one unconditional. Because implicit ordering applies, the segment labeled with the condition \( d < 100 \) evaluates first based on the geometry of the two outgoing conditional transition segments. Because the returned value of \( d \) is 84, the condition \( d < 100 \) is true and this transition to the destination state \( A.A1 \) is valid.

State \( A.A1 \) exit actions (\texttt{exitA1()}) execute and complete.

State \( A.A1 \) is marked inactive.

State \( A.A1 \) is marked active.

State \( A.A1 \) entry actions (\texttt{entA1()}) execute and complete.

The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event \( E_{\text{one}} \).

**Transition from a Common Source to Multiple Destinations**

This example shows the behavior of transitions from a common source to multiple conditional destinations using a connective junction. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
Initially, the chart is asleep. State A is active. Event E_two occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_two. A valid transition segment exists from state A to the connective junction. Because implicit ordering applies, evaluation of segments with equivalent label priority begins from a 12 o'clock position on the connective junction and progresses clockwise. The first transition segment, labeled with event E_one, is not valid. The next transition segment, labeled with event E_two, is valid. The complete transition from state A to state C is valid.

2. State A exit actions (exitA()) execute and complete.
3. State A is marked inactive.
4. State C is marked active.
5. State C entry actions (entC()) execute and complete.
6. The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_two.

**Resolve Equally Valid Transition Paths**

**What Are Conflicting Transitions?**

Conflicting transitions are two equally valid paths from the same source in a Stateflow chart during simulation. In the case of a conflict, Stateflow software evaluates equally valid transitions based on ordering mode in the chart: explicit or implicit.
• For explicit ordering (the default mode), evaluation of conflicting transitions occurs based on the order you specify for each transition. For details, see “Explicit Ordering” on page 3-67.

• For implicit ordering in C charts, evaluation of conflicting transitions occurs based on internal rules described in “Implicit Ordering” on page 3-67.

**Example of Conflicting Transitions**

The following chart has two equally valid transition paths:

![Diagram of a state machine with transitions from A to B and C, and from B to C.]

**Conflict Resolution for Implicit Ordering**

For implicit ordering, the chart evaluates multiple outgoing transitions with equal label priority in a clockwise progression starting from the twelve o'clock position on the state. In this case, the transition from state A to state B occurs.

**Conflict Resolution for Explicit Ordering**

For explicit ordering, the chart resolves the conflict by evaluating outgoing transitions in the order that you specify explicitly. For example, if you right-click the transition from state A to state C and select **Execution Order > 1** from the context menu, the chart evaluates that transition first. In this case, the transition from state A to state C occurs.

**How the Transition Conflict Occurs**

The default transition to state A assigns data a equal to 1 and data b equal to 10. The during action of state A increments a and decrements b during each time step. The
transition from state A to state B is valid if the condition \[a > 4\] is true. The transition from state A to state C is valid if the condition \[b < 7\] is true. During simulation, there is a time step where state A is active and both conditions are true. This issue is a transition conflict.

**Transition from Multiple Sources to a Common Destination**

This example shows the behavior of transitions from multiple sources to a single destination using a connective junction.

Initially, the chart is asleep. State A is active. Event \text{E\_one} occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of \text{E\_one}. A valid transition segment exists from state A to the connective junction and from the junction to state C.
2. State A exit actions (\text{exitA()}) execute and complete.
3. State A is marked inactive.
4. State C is marked active.
5. State C entry actions (\text{entC()}) execute and complete.
6. The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event \text{E\_one}.
Transition from a Source to a Destination Based on a Common Event

This example shows the behavior of transitions from multiple sources to a single destination based on the same event using a connective junction.

Initially, the chart is asleep. State B is active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. A valid transition segment exists from state B to the connective junction and from the junction to state C.
2. State B exit actions (exitB()) execute and complete.
3. State B is marked inactive.
4. State C is marked active.
5. State C entry actions (entC()) execute and complete.
6. The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one.

Backtrack in Flow Charts

This example shows the behavior of transitions with junctions that force backtracking behavior in flow charts. The chart uses implicit ordering of outgoing transitions (see “Implicit Ordering” on page 3-67).
Initially, state A is active and conditions c1, c2, and c3 are true:

1. The chart root checks to see if there is a valid transition from state A.
   - There is a valid transition segment marked with the condition c1 from state A to a connective junction.
2. Condition c1 is true and action a1 executes.
3. Condition c3 is true and action a3 executes.
4. Condition c4 is not true and control flow backtracks to state A.
5. The chart root checks to see if there is another valid transition from state A.
   - There is a valid transition segment marked with the condition c2 from state A to a connective junction.
6. Condition c2 is true and action a2 executes.
7. Condition c3 is true and action a3 executes.
8. Condition c4 is not true and control flow backtracks to state A.
9. The chart goes to sleep.

The preceding example shows the unexpected behavior of executing both actions a1 and a2. Another unexpected behavior is the execution of action a3 twice. To resolve this problem, consider adding unconditional transitions to terminating junctions.
The terminating junctions allow flow to end if either c3 or c4 is not true. This design leaves state A active without executing unnecessary actions.
Control Chart Execution Using Event Actions in a Superstate

The following example shows the use of event actions in a superstate.

Initially, the chart is asleep. State A.A1 is active. Event E_three occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_three. No valid transition exists.
2. State A during actions (durA()) execute and complete.
3. State A executes and completes the on event E_three action (A_one).
5. State A1 during actions (durA1()) execute and complete.
6. The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_three.
Broadcast Events in Parallel (AND) States

In this section...

| Broadcast Events in Parallel States” on page B-43 |
| “Broadcast Events in a Transition Action with a Nested Event Broadcast” on page B-45 |
| “Broadcast Condition Action Event in Parallel State” on page B-48 |

Broadcast Events in Parallel States

This example shows the behavior of event broadcast actions in parallel states. The chart uses implicit ordering of parallel states (see “Implicit Ordering of Parallel States” on page 3-91).
Initially, the chart is asleep. Parallel substates A.A1.A1 and A.A2.A2a are active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition at the root level as a result of E_one. No valid transition exists.
2. State A during actions (durA()) execute and complete.
3. The children of state A are parallel (AND) states. Because implicit ordering applies, the states are evaluated and executed from left to right and top to bottom. State A.A1 is evaluated first. State A.A1 during actions (durA1()) execute and complete. State A.A1 executes and completes the on E_one action and broadcasts event E_two. The during and on event_name actions are processed based on their order of appearance in the state label:
   a. The broadcast of event E_two awakens the chart a second time. The chart root checks to see if there is a valid transition as a result of E_two. No valid transition exists.
   b. State A during actions (durA()) execute and complete.
   c. State A checks its children for valid transitions. No valid transitions exist.
   d. State A's children are evaluated starting with state A.A1. State A.A1 during actions (durA1()) execute and complete. State A.A1 is evaluated for valid transitions. There are no valid transitions as a result of E_two within state A1.
   e. State A1a's during actions (durA1a()) execute.
   f. State A.A2 is evaluated. State A.A2 during actions (durA2()) execute and complete. State A.A2 checks for valid transitions. State A.A2 has a valid transition as a result of E_two from state A.A2.A2a to state A.A2.A2b.
   g. State A.A2.A2a exit actions (exitA2a()) execute and complete.
   h. State A.A2.A2a is marked inactive.
   i. State A.A2.A2b is marked active.
   j. State A.A2.A2b entry actions (entA2b()) execute and complete.
4. The processing of E_one continues once the on event broadcast of E_two has been processed. State A.A1 checks for any valid transitions as a result of event E_one. A valid transition exists from state A.A1.A1a to state A.A1.A1b.
7 State A.A1.A1b is marked active.
8 State A.A1.A1b entry actions (entA1b()) execute and complete.
9 Parallel state A.A2 is evaluated next. State A.A2 during actions (durA2()) execute and complete. There are no valid transitions as a result of E_one.
10 State A.A2.A2b during actions (durA2b()) execute and complete.

State A.A2.A2b is now active as a result of the processing of the on event broadcast of E_two.
11 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one and the on event broadcast to a parallel state of event E_two. The final chart activity is that parallel substates A.A1.A1b and A.A2.A2b are active.

Tip Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the send operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.

You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the Diagnostics > Stateflow pane and set the Undirected event broadcasts diagnostic to none, warning, or error. The default setting is warning.

Broadcast Events in a Transition Action with a Nested Event Broadcast

This example shows the behavior of an event broadcast transition action that includes a nested event broadcast in a parallel state. The chart uses implicit ordering of parallel states (see “Implicit Ordering of Parallel States” on page 3-91).
Start of Event E_one Processing

Initially, the chart is asleep. Parallel substates A.A1.A1a and A.A2.A2a are active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. There is no valid transition.
2. State A during actions (durA()) execute and complete.
3. State A's children are parallel (AND) states. Because implicit ordering applies, the states are evaluated and executed from left to right and top to bottom. State A.A1 is evaluated first. State A.A1 during actions (durA1()) execute and complete.
4 State A.A1 checks for any valid transitions as a result of event E_one. There is a valid transition from state A.A1.A1a to state A.A1.A1b.
6 State A.A1.A1a is marked inactive.

**Event E_two Preempts E_one**

1 The transition action that broadcasts event E_two executes and completes:
   a The broadcast of event E_two now preempts the transition from state A1a to state A1b that event E_one triggers.
   b The broadcast of event E_two awakens the chart a second time. The chart root checks to see if there is a valid transition as a result of E_two. No valid transition exists.
   c State A during actions (durA()) execute and complete.
   d State A's children are evaluated starting with state A.A1. State A.A1 during actions (durA1()) execute and complete. State A.A1 is evaluated for valid transitions. There are no valid transitions as a result of E_two within state A1.
   e State A.A2 is evaluated. State A.A2 during actions (durA2()) execute and complete. State A.A2 checks for valid transitions. State A.A2 has a valid transition as a result of E_two from state A.A2.A2a to state A.A2.A2b.
   f State A.A2.A2a exit actions (exitA2a()) execute and complete.
   g State A.A2.A2a is marked inactive.
   h State A.A2.A2b is marked active.
   i State A.A2.A2b entry actions (entA2b()) execute and complete.

**Event E_one Processing Resumes**

1 State A.A1.A1b is marked active.
2 State A.A1.A1b entry actions (entA1b()) execute and complete.
3 Parallel state A.A2 is evaluated next. State A.A2 during actions (durA2()) execute and complete. There are no valid transitions as a result of E_one.
4 State A.A2.A2b during actions (durA2b()) execute and complete.

State A.A2.A2b is now active as a result of the processing of event broadcast E_two.
5 The chart goes back to sleep.
This sequence completes the execution of this Stateflow chart associated with event E\_one and the event broadcast on a transition action to a parallel state of event E\_two. The final chart activity is that parallel substates A.A1.A1b and A.A2.A2b are active.

**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the send operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.

You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the **Diagnostics > Stateflow** pane and set the **Undirected event broadcasts** diagnostic to none, warning, or error. The default setting is warning.

### Broadcast Condition Action Event in Parallel State

This example shows the behavior of a condition action event broadcast in a parallel (AND) state. The chart uses implicit ordering of parallel states (see “Implicit Ordering of Parallel States” on page 3-91).
Initially, the chart is asleep. Parallel substates A.A1.A1a and A.A2.A2a are active. Event E_one occurs and awakens the chart, which processes the event from the root down through the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of E_one. No valid transition exists.

2. State A during actions (durA()) execute and complete.

3. State A's children are parallel (AND) states. Because implicit ordering applies, the states are evaluated and executed from top to bottom, and from left to right. State A.A1 is evaluated first. State A.A1 during actions (durA1()) execute and complete.

also exists. The condition action event broadcast of E_two executes and completes. State A.A1.A1a is still active:

a The broadcast of event E_two awakens the Stateflow chart a second time. The chart root checks to see if there is a valid transition as a result of E_two. There is no valid transition.

b State A during actions (durA()) execute and complete.

c State A's children are evaluated starting with state A.A1. State A.A1 during actions (durA1()) execute and complete. State A.A1 is evaluated for valid transitions. There are no valid transitions as a result of E_two within state A1.

d State A1a during actions (durA1a()) execute.

e State A.A2 is evaluated. State A.A2 during actions (durA2()) execute and complete. State A.A2 checks for valid transitions. State A.A2 has a valid transition as a result of E_two from state A.A2.A2a to state A.A2.A2b.

f State A.A2.A2a exit actions (exitA2a()) execute and complete.

g State A.A2.A2a is marked inactive.

h State A.A2.A2b is marked active.

i State A.A2.A2b entry actions (entA2b()) execute and complete.


6 State A.A1.A1a is marked inactive.

7 State A.A1.A1b is marked active.

8 State A.A1.A1b entry actions (entA1b()) execute and complete.

9 Parallel state A.A2 is evaluated next. State A.A2 during actions (durA2()) execute and complete. There are no valid transitions as a result of E_one.

10 State A.A2.A2b during actions (durA2b()) execute and complete.

State A.A2.A2b is now active as a result of the processing of the condition action event broadcast of E_two.

11 The chart goes back to sleep.

This sequence completes the execution of this Stateflow chart associated with event E_one and the event broadcast on a condition action to a parallel state of event E_two. The final chart activity is that parallel substates A.A1.A1b and A.A2.A2b are active.
**Tip** Avoid using undirected local event broadcasts, which can cause unwanted recursive behavior in your chart. Use the `send` operator for directed local event broadcasts. For more information, see “Broadcast Events to Synchronize States” on page 12-52.

You can set the diagnostic level for detecting undirected local event broadcasts. In the Model Configuration Parameters dialog box, go to the **Diagnostics > Stateflow** pane and set the **Undirected event broadcasts** diagnostic to `none`, `warning`, or `error`. The default setting is `warning`. 
Directly Broadcast Events

<table>
<thead>
<tr>
<th>In this section…</th>
</tr>
</thead>
<tbody>
<tr>
<td>“Directed Event Broadcast Using Send” on page B-52</td>
</tr>
<tr>
<td>“Directed Event Broadcast Using Qualified Event Name” on page B-53</td>
</tr>
</tbody>
</table>

Directed Event Broadcast Using Send

This example shows the behavior of directed event broadcast using the `send(event_name, state_name)` syntax on a transition. The chart uses implicit ordering of parallel states (see “Implicit Ordering of Parallel States” on page 3-91).

Initially, the chart is asleep. Parallel substates A.A1 and B.B1 are active, which implies that parallel (AND) superstates A and B are also active. The condition `[data1==1]` is true. The event `E_one` belongs to the chart and is visible to both A and B.

After waking up, the chart checks for valid transitions at every level of the hierarchy:
1 The chart root checks to see if there is a valid transition as a result of the event. There is no valid transition.

2 State A checks for any valid transitions as a result of the event. Because the condition \[ \text{data1==1} \] is true, there is a valid transition from state A.A1 to state A.A2.

3 The action \text{send(E_one,B)}\) executes:
   a The broadcast of event E_one reaches state B. Because state B is active, that state receives the event broadcast and checks to see if there is a valid transition. There is a valid transition from B.B1 to B.B2.
   b State B.B1 exit actions (exitB1()) execute and complete.
   c State B.B1 becomes inactive.
   d State B.B2 becomes active.
   e State B.B2 entry actions (entB2()) execute and complete.

4 State A.A1 exit actions (exitA1()) execute and complete.

5 State A.A1 becomes inactive.

6 State A.A2 becomes active.

7 State A.A2 entry actions (entA2()) execute and complete.

This sequence completes execution of a chart with a directed event broadcast to a parallel state.

**Directed Event Broadcast Using Qualified Event Name**

This example shows the behavior of directed event broadcast using a qualified event name on a transition. The chart uses implicit ordering of parallel states (see “Implicit Ordering of Parallel States” on page 3-91).
The only differences from the chart in “Directed Event Broadcast Using Send” on page B-52 are:

- The event `E_one` belongs to state `B` and is visible only to that state.
- The action `send(E_one,B)` is now `send(B.E_one)`.

Using a qualified event name is necessary because `E_one` is not visible to state `A`.

After waking up, the chart checks for valid transitions at every level of the hierarchy:

1. The chart root checks to see if there is a valid transition as a result of the event. There is no valid transition.
2. State `A` checks for any valid transitions as a result of the event. Because the condition `[data1==1]` is true, there is a valid transition from state `A.A1` to state `A.A2`.
3. The action `send(B.E_one)` executes and completes:
   - The broadcast of event `E_one` reaches state `B`. Because state `B` is active, that state receives the event broadcast and checks to see if there is a valid transition. There is a valid transition from `B.B1` to `B.B2`.

B-54
b State B.B1 exit actions (exitB1()) execute and complete.
c State B.B1 becomes inactive.
d State B.B2 becomes active.
e State B.B2 entry actions (entB2()) execute and complete.
4 State A.A1 exit actions (exitA1()) execute and complete.
5 State A.A1 becomes inactive.
6 State A.A2 becomes active.
7 State A.A2 entry actions (entA2()) execute and complete.

This sequence completes execution of a chart with a directed event broadcast using a qualified event name to a parallel state.
<table>
<thead>
<tr>
<th><strong>Glossary</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>actions</strong></td>
</tr>
<tr>
<td><strong>API (application programming interface)</strong></td>
</tr>
<tr>
<td><strong>atomic box</strong></td>
</tr>
<tr>
<td><strong>atomic subchart</strong></td>
</tr>
<tr>
<td><strong>box</strong></td>
</tr>
<tr>
<td><strong>chart instance</strong></td>
</tr>
<tr>
<td><strong>condition</strong></td>
</tr>
<tr>
<td><strong>connective junction</strong></td>
</tr>
</tbody>
</table>
efficient code. Connective junctions provide different ways to represent desired system behavior.

See “Connective Junctions” on page 2-39 for more information.

data

Data objects store numerical values for reference in the Stateflow chart.

decomposition

A state has a decomposition when it consists of one or more substates. A chart that contains at least one state also has decomposition. Rules govern how you can group states in the hierarchy. A superstate has either parallel (AND) or exclusive (OR) decomposition. All substates at a particular level in the hierarchy must have the same decomposition.

• Parallel (AND) State Decomposition

  Parallel (AND) state decomposition applies when states have dashed borders. This decomposition describes states at that same level in the hierarchy that can be active at the same time. The activity within parallel states is essentially independent.

• Exclusive (OR) State Decomposition

  Exclusive (OR) state decomposition applies when states have solid borders. This decomposition describes states that are mutually exclusive. Only one state at the same level in the hierarchy can be active at a time.

default transition

Primarily used to specify which exclusive (OR) state is to be entered when there is ambiguity among two or more neighboring exclusive (OR) states. For example, default transitions specify which substate of a superstate with exclusive (OR) decomposition the system enters by default in the absence of any other information. Default transitions can also specify that a junction should be entered by default. The default transition object is a transition with a destination but no source object.
| **events** | Events drive chart execution. All events that affect the chart must be defined. The occurrence of an event causes the status of states in a chart to be evaluated. The broadcast of an event can trigger a transition to occur or an action to execute. Events are broadcast in a top-down manner starting from the event's parent in the hierarchy. |
| **Finder** | Tool to search for objects in Stateflow charts on platforms that do not support the Simulink Find tool. |
| **finite state machine (FSM)** | Representation of an event-driven system. FSMs are also used to describe reactive systems. In an event-driven or reactive system, the system transitions from one mode or state to another prescribed mode or state, provided that the condition defining the change is true. |
| **flow chart** | Set of decision flow paths that start from a transition segment that, in turn, starts from a state or a default transition segment. |
| **flow path** | Ordered sequence of transition segments and junctions where each succeeding segment starts on the junction that terminated the previous segment. |
| **flow subgraph** | Set of decision flow paths that start on the same transition segment. |
| **graphical function** | A chart function whose logic is defined by a flow chart. See “Reuse Logic Patterns Using Graphical Functions” on page 8-26. |
| **hierarchy** | Hierarchy enables you to organize complex systems by placing states within other higher-level states. A hierarchical design usually reduces the number of transitions and produces neat, more manageable charts. See “Stateflow Hierarchy of Objects” on page 1-7 for more information. |
### history junction
Specifies the destination substate of a transition based on historical information. If a superstate has a history junction, the transition to the destination substate is the substate that was most recently active. The history junction applies only to the level of the hierarchy in which it appears.

See the following sections for more information:
- “History Junctions” on page 2-46
- “Default Transition and a History Junction” on page B-18
- “Labeled Default Transitions” on page B-19
- “Inner Transition to a History Junction” on page B-27

### inner transitions
Transition that does not exit the source state. Inner transitions are useful when defined for superstates with exclusive (OR) decomposition. Use of inner transitions can greatly simplify chart layout.

See “Inner Transitions” on page 2-31 and “Inner Transition to a History Junction” on page B-27 for more information.

### library link
Link to a chart that is stored in a library model.

### library model
Stateflow model that is stored in a Simulink library. You can include charts from a library in your model by copying them. When you copy a chart from a library into your model, you create only a link to the library chart. You can create multiple links to a single chart. Each link is called a chart instance. When you include a chart from a library in your model, you also include its Stateflow machine. Therefore, a Stateflow model that includes links to library charts has multiple Stateflow machines.

When you simulate a model that includes charts from a library model, you include all charts from the library model even if links exist only for some of its models. You can simulate a model that includes links to a library model...
only when all charts in the library model are free of parse and compile errors.

**machine**

Collection of all Stateflow blocks defined by a Simulink model. This collection excludes chart instances from library links. If a model includes any library links, it also includes the Stateflow machines defined by the models from which the links originate.

**MATLAB function**

A chart function that works with a subset of the MATLAB programming language.

**Mealy machine**

An industry-standard paradigm for modeling finite-state machines, where output is a function of both inputs *and* state.

**Model Explorer**

Use to add, remove, and modify data, event, and target objects in the Stateflow hierarchy. See “Use the Model Explorer with Stateflow Objects” on page 31-11 for more information.

**Moore machine**

An industry-standard paradigm for modeling finite-state machines, where output is a function *only* of state.

**notation**

Defines a set of objects and the rules that govern the relationships between those objects. Stateflow chart notation provides a way to communicate the design information in a Stateflow chart.

Stateflow chart notation includes:

- A set of graphical objects
- A set of nongraphical text-based objects
- Defined relationships between those objects

**parallelism**

A system with *parallelism* can have two or more states that can be active at the same time. The activity of parallel states is essentially independent. Parallelism is represented with a parallel (AND) state decomposition.

See “State Decomposition” on page 2-9 for more information.
<table>
<thead>
<tr>
<th><strong>S-function</strong></th>
<th>When you simulate a Simulink model containing Stateflow charts, you generate an <em>S-function</em> (MEX-file) for each Stateflow machine. This generated code is a simulation target.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>semantics</strong></td>
<td><em>Semantics</em> describe how the notation is interpreted and implemented behind the scenes. A completed Stateflow chart communicates how the system will behave. A chart contains actions associated with transitions and states. The semantics describe in what sequence these actions take place during chart execution.</td>
</tr>
<tr>
<td><strong>Simulink function</strong></td>
<td>A chart function that you fill with Simulink blocks and call in the actions of states and transitions. This function provides an efficient model design and improves readability by minimizing the graphical and nongraphical objects required in a model. In a Stateflow chart, this function acts like a function-call subsystem block of a Simulink model.</td>
</tr>
<tr>
<td><strong>state</strong></td>
<td>A <em>state</em> describes a mode of a reactive system. A reactive system has many possible states. States in a chart represent these modes. The activity or inactivity of the states dynamically changes based on transitions among events and conditions. Every state has hierarchy. In a chart consisting of a single state, the parent of that state is the Stateflow chart itself. A state also has history that applies to its level of hierarchy in the chart. States can have actions that execute in a sequence based upon action type. The action types are <em>entry</em>, <em>during</em>, <em>exit</em>, or <em>on event_name</em> actions.</td>
</tr>
<tr>
<td><strong>Stateflow block</strong></td>
<td>Masked Simulink model that is equivalent to an empty, untitled Stateflow chart. Use the Stateflow block to include a chart in a Simulink model. The control behavior modeled by a Stateflow block complements the algorithmic behavior modeled in Simulink block diagrams. By incorporating Stateflow</td>
</tr>
</tbody>
</table>
blocks into Simulink models, you can add complex event-driven behavior to Simulink simulations. You create models that represent both data and decision flow by combining Stateflow blocks with the standard Simulink and toolbox block libraries.

**Stateflow chart**
A Stateflow chart is a graphical representation of a finite state machine where *states* and *transitions* form the basic building blocks of the system. See “Stateflow Charts and Simulink Models” on page 1-4 for more information.

**Stateflow Finder**
Use to display a list of objects based on search criteria you specify. You can directly access the properties dialog box of any object in the search output display by clicking that object.

**subchart**
Chart contained by another chart. See “Encapsulate Modal Logic Using Subcharts” on page 8-5.

**substate**
A state is a *substate* if it is contained by a superstate.

**superstate**
A state is a *superstate* if it contains other states, called substates.

**supertransition**
Transition between objects residing in different subcharts. See “Move Between Levels of Hierarchy Using Supertransitions” on page 8-10 for more information.

**target**
A container object for the generated code from the Stateflow charts in a model. The collection of all charts for a model appears as a Stateflow machine. Therefore, target objects belong to the Stateflow machine.

The code generation process can produce these target types: simulation, embeddable, and custom.

**transition**
The circumstances under which the system moves from one state to another. Either end of a transition can be attached to a source and a destination object. The *source* is where the transition begins and the *destination* is where the transition ends. Usually, the occurrence of an event causes a transition to take place.
<table>
<thead>
<tr>
<th><strong>transition path</strong></th>
<th>Flow path that starts and ends on a state.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>transition segment</strong></td>
<td>A state-to-junction, junction-to-junction, or junction-to-state part of a complete state-to-state transition.</td>
</tr>
<tr>
<td><strong>truth table function</strong></td>
<td>A chart function that specifies logical behavior with conditions, decisions, and actions. Truth tables are easier to program and maintain than graphical functions.</td>
</tr>
</tbody>
</table>